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chapter i About Performer

Performer is a powerful MIDI sequencer designed
for the music professional. It provides a
comprehensive MIDI recording, playback, and
editing environment for a large variety of
applications. Its speed, accuracy and flexibility
make it the sequencer of choice for working
musicians the world over.

Performer™
Figure 1-1: The Performer program icon.

Mail in the Registration Card
Take a moment now to fill in and mail the
registration card found at the very beginning of
this manual. Doing so entitles you to: 

■ A free backup master disk

■ Free, unlimited technical support

■ Free newsletters and software updates

■ Announcements about major software upgrades
and new products

Leave the rest of the cardboard page in the manual
for your future reference. Since Mark of the
Unicorn can provide customer service only to
registered users, please be sure to send the card in
immediately after purchase.

To use Performer, you must have a Macintosh
computer, a MIDI interface and a MIDI instrument
(most likely a synthesizer). This is the minimal
setup you will need, although Performer can
support any configuration of MIDI instruments,
including NuBus devices such as the MacProteus™,
SampleCell™, and SampleCell II™. Performer 

works well with all MIDI instruments and is
capable of handling the most complex MIDI
situations. It is compatible with any
MIDI-equipped device, such as synthesizers, drum
machines, hardware sequencers, synchronization
devices and more. If all you need to do is play back,
you don’t even need any MIDI hardware! Instead,
you can use the built-in sound capabilities of your
Macintosh. And Performer is accelerated for Power
Macintosh to take full advantage of the speed boost
offered by native RISC processing.

A MIDI sequencer is like a cross between a tape
recorder and a player piano: the physical actions
you make when playing the keyboard or other
MIDI controller instruments are stored not as
audio signals (as your tape machine would record)
but as numerical information that represents music
(pitches, attacks, releases, pitch bends and more).
The nuances in your musical performance are
analyzed and its components encoded and stored.
When played back, the synthesizer recreates your
original performance. In this way, the recorded
sequence is more like a player piano roll, telling the
instrument exactly how to play itself. One nice
thing about MIDI is that you can use any
compatible instrument for playback. You can also
edit the individual elements of your sequence, such
as a single bad note in an otherwise flawless
performance. MIDI sequencing provides you with
a way to manipulate virtually any parameter of a
musical performance.

Performer is loaded with features, structured in a
layered fashion such that you can use the ones you
want and not worry about the others. This is
helpful for those of you who are new to the
program, as well as experienced users who need 



functional power without unnecessary complexity.
The rest of this chapter provides a brief description
of some of Performer’s salient features.

The basic recording and playback functions are
very straightforward, modeled after tape deck
functions. They are located in Performer’s Control
Panel:

Figure 1-2: Performer's Control Panel.
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Music recorded with Performer is played back
exactly as entered: the resolution of 480 ticks per
quarter note assures accuracy. As many tracks as
you need for recording and playback are available
to you. Several tracks can be recorded simulta­
neously from multiple MIDI channels. Both the
modem and printer ports can be used simulta­
neously for input and output of data as well as
timing information. Performer’s Patch Thru utility
allows you to either echo incoming data directly or
channelize it. Any track can be assigned to play
back from one or more of sixteen channels on
either port, giving you 32 separate channels for
playback. If you have a multi-port interface such as
the MIDI Time Piece II or MIDI Express,
Performer provides as many channels as the
interface allows (128 or 96, respectively). Since
many of Performer’s operations can be done while
the sequence is playing back or recording, you
don’t have to stop the music to get things done.

A flexible step-recording mode precisely enters
passages too fast or complex to be recorded in real
time, plus there are several auto-locator features
such as punch-in/out and auto stop/rewind to
make real-time recording easier.

Once you’ve recorded, there is a great deal of
editing power at your fingertips — you can change
anything in your sequence, from a single event to a
whole region of data. Single events or entire regions
of data can be edited or inserted anywhere in the
sequence. The basic cut and paste operations and
the region editing commands allow you to edit and
create data: you can transpose whole sections,
change controller values smoothly, create new
pitch bend data, control velocity to create dynamic
effects, create echo effects and more, each in only a
few steps. State-of-the-art quantizing features such
as Humanize and Groove Quantize help you
perfect the rhythmic nuance in your sequences.

To access the data that makes up your sequence,
Performer offers three powerful event-editing
environments on top of standard Event List
window editing: the Graphic Editing window, the
Notation Editing window, and the QuickScribe
Notation window. All windows support single­
event and region editing as described above, and
every track in your sequence can be viewed and
edited in either window at any time.

The Graphic Editing window plots the elements of
your sequence on a scrolling, piano-roll graph that
makes melodies, chords, dynamics and tempo
changes easy to recognize and adjust. As in the
Event List window, you can choose from measure,
real, or SMPTE time display, and edit any visible
event from your Macintosh or MIDI controller.
Unlike the Event List, however, to edit events or
groups of events you simply drag them to a new
location in time, pitch (or controller value), or
both. You can even create continuous data by
drawing the desired curve on screen.

The QuickScribe Notation Editing window displays
as many tracks as you want together in one
window, formatted on a page exactly as it will print.
The notation can be edited with all of Performer’s
powerful editing commands. You can drag notes 
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vertically and horizontally to change pitch,
location and duration. You can also step-enter
notes directly in the notation window.

Performer has extensive synchronization
capabilities, including Tap tempo. This type of
sync allows you not only to control the tempo of an
existing sequence as it plays back, but to create a
tempo map in real time before, during, or after
recording — all by simply tapping the tempo on
your MIDI controller. For example, you can tap
along to a prerecorded acoustic performance,
creating a precise tempo map complete with
accelerandos, ritards, and rubato passages, then
sync your Performer sequence to the recording.
Once you’ve got a tempo map, the powerful Scale
Tempos command provides you with every
conceivable way of tweaking your tempo map,
including scaling tempos to fit time.

Since its inception, Performer has supported
standard MIDI clock signals, allowing you to sync
to FSK or SMPTE time code. SMPTE locations can
be referenced and displayed directly on screen, and
lockup is simple and clean. Performer can serve as
an intelligent master or slave because it sends and
receives Song Position Pointer. Coupled with its
flexible tempo features, Performer’s synchroni­
zation capabilities make it the sequencer of choice
for musicians working in the film/video medium.

Performer has expanded the art of sequencing with
powerful Chunking™ and cueing functions. The
Chunks window introduces a whole new type of
sequence: the song. Songs allows you to create
simple or complex arrangements of multiple
Chunks (sequences and other songs). Chunks can
be graphically arranged in any order, vertically and
horizontally to quickly build entire songs with
other sequences and songs.

Sequences and songs can be automatically chained,
cued up, or skipped to in real time using the Chain
Chunks, Cue Chunks, and Skip buttons. These 

convenient controls come in handy—especially
during live performance, where you need quick
response and complete flexibility in choosing the
next song.

To further enhance Performer’s Chunking
capabilities, the Remote Controls window allows
you to trigger any Performer transport function or
song select procedure, such as play, pause, stop,
etc., from your MIDI controller. Now you can
control Performer from your MIDI instrument—
without ever going near your Macintosh!

Performer’s Mixing Board window provides a
virtual, automated mixing environment. Use pan
knobs and volume faders to automate your entire
mix. Based on familiar mixing board design,
Performer’s Mixing Board can be customized to fit
your computer screen and your mixing needs.
Instantly show and hide tracks, and even hide
cross-sections of the console that you aren’t using
at the moment. You can save custom board layouts
as well. Fader groups can be created. Real time
MIDI effects processing inserts can be applied to
any track — up to five at a time. The Mix menu
allows you create multiple mixdowns, which store
all of the pan and volume data for the entire
sequence under one name. You can create an
unlimited number of multiple mixdowns.

Performer’s custom consoles can be completely
customized to fit your sequencing needs. You can
build a console from scratch, adding buttons,
knobs, sliders, LCD readouts, and more. And you
can program them to generate any type of MIDI
data, including sysex. Other professional mixing
console features include flexible grouped and
master controls, as well as adjustable fader null
points.

Performer offers sophisticated rhythmic correction
(quantizing) features. It is possible to vary the
degree of effectiveness of quantization, allowing
you to preserve the “free” quality of your 
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performance while putting the critical notes on the
beat. In addition, special metric effects such as beat
shifting and doubling attacks can be done. The
powerful Humanize command can produce more
human feel in a part that may have been over­
quantized. In fact, most of Performer’s powerful
editing commands provide humanization options
that can loosen up the feel just right.

Performer takes full advantage of Mark of the
Unicorn’s MIDI operating system, FreeMIDI.
FreeMIDI provides an intuitive, convenient, and
consistent way for you to interact with the
hardware in your MIDI studio. Together,
Performer and FreeMIDI provide you with many
benefits, such as intuitive pop-up menus for device
selection, and the ability to select patches on your
synths by name from within Performer, as well as
other FreeMIDI-compatible applications. Perhaps
the most important benefit is sound management:
FreeMIDI provides built-in librarian support for
many popular synths. FreeMIDI’s PatchList
Manager™ program can get a bulk dump and
automatically display the patch names that are
currently available in the synth. The patch names
appear as a convenient pop-up menu directly in
Performer, and it all happens automatically.

For more powerful sound management, Performer
provides full integration with Mark of the
Unicorn’s new, state-of-the-art universal editor and
librarian software, Unisyn™. Performer can play
back in the background when you switch into
Unisyn to select sounds, edit a patch, etc. Also,
Unisyn automatically provides up-to-date patch
lists for FreeMIDI, so that patch names in
Performer are always accurate.

Performer also provides convenient printing
capabilities for both list windows and music
notation. The Print command prints the contents
of Performer’s list windows, such as the Tracks List,
Markers window, and Event Lists. The QuickScribe
notation window displays any combination of 

tracks as music notation on screen exactly as it will
print out. Select any region to display, from a single
measure to an entire piece. QuickScribe is ideal for
lead sheets, instrument parts, or scores, which can
be printed on any Macintosh-compatible printer.

If you want to transfer your sequence to a dedicated
notation program, such as Mark of the Unicorn’s
Mosaic® software, simply save your work as a
standard MIDI file. The process transferring is
simple and fast.

Performer can be customized to fit your needs
more than ever before. In the Tracks window, each
track has a bar-graph style meter that indicates
MIDI activity during playback and recording.
Configure the meters to display either data density
or note velocities. You can drag tracks window
columns left or right to place them in any order you
wish. Double-click (or option-click) the column
headings to show/hide any column. Even basic
features like soloing can be customized to fit your
exact needs. For example, Partial Solo mode brings
muted tracks down part way instead of totally
muting them, so you can focus on a certain musical
element while still referencing others.

Version 5.5, as with its predecessors, is filled with
our obsessive attention to detail. You’ll enjoy
features like pop-up menus in title bars to quickly
switch tracks, a customizable Tracks window, a
scrolling highlight in tracks overview to indicate
the current playback location, double-clicking in
any time ruler to auto-locate, and more.

We hope you enjoy using Performer’s state-of-the-
art sequencing environment!

About this manual
This manual provides a complete explanation for
all of Performer’s features. For an introduction to
Performer, refer to the Getting Started booklet that
accompanies this manual.

ABOUT PERFORMER



chapter 2 On-Line Help

Performer’s On-Line Help provides you with brief,
on-screen explanations of each feature in the
program. You can get help on any item in
Performer, including menu items, greyed out
(unavailable) menu items, mini-menus, windows,
and buttons simply by clicking the item with
Performer’s Help cursor.

About the Performer Help file
The Help information in Performer is stored
separately in a special file called the Performer Help
file. This file is automatically installed in the same
folder as Performer, and no further preparation is
necessary on your part.

Performer™ Help
[HELP]

Figure 2-1: The Performer Help file icon.

<•“ The Performer Help file must be present on
your hard disk in order for you to be able to get help
when running Performer. If it is not present for
some reason, you can run the installer on the
Performer master disk to make a copy of it on your
hard disk.

Using the Help cursor
When you are running Performer, you can get help
on anything on Performer’s screen with the Help
cursor. To turn the arrow cursor into Performer’s
Help cursor, hold down the command, option, and
shift keys together. When you release the keys, the
cursor will turn back into an arrow.

Figure 2-2: Performer's Help cursor.

To get help on something, just click it with the Help
cursor. If it’s a menu item, select it from the menu
with the Help cursor. When you release the mouse
button, a help window will appear that briefly
explains the item.

To make the help window disappear, click
anywhere.

All major features in Performer have a help item.
Some specific items do not and are explained
within the description of a corresponding feature.
If you can’t get help on something, consult the
index in this manual.

What should you click on to get help?
In general, click directly on the item you wish to get
help on. For things like buttons, pop-up menus,
and text boxes, click directly on the button itself
rather than its label or associated text. If you don’t
get a help window the first time, try a few more
times, as you might miss the “hot spot” the first
time.

The basic rule of thumb is: click all over the
place with the help balloon cursor. You are bound
to get a useful help balloon eventually, and it
doesn’t hurt to click as many times as you are
inclined to.

For mini-menus in windows, click anywhere in the
title bar of the window.



Getting help on menu commands and dialog
boxes
For general information about menu commands,
choose the command from the menu with the help
cursor. For specific information about the menu
command, choose it with the arrow cursor first to
open its dialog box, and then click specific buttons,
text boxes, pop-up menus, and other items in the
dialog box with the help balloon cursor.

Loading the Help file
If you click with the Help cursor, you may get the
dialog box shown below:

Figure 2-3: If Performer can't find the Help file, it will ask you to locate
it.

This means that the Performer Help file is not in
the same folder as Performer, and Performer is
asking you to locate and open the Help File. To do
so:

1 Press the directory pop-up menu to open the
folder that you installed the Help file in.

The directory pop-up menu is the button labelled
“Music Folder” in the picture above. The window
below shows the contents of the Folder listed on
that button. Select the bottom item in the menu to
work your way back to the top level of your hard
disk. If you are working with floppy disks, click the
Drive button to look on another disk.

2 If you can’t find the Help file or have not
installed it yet, click Cancel, Quit Performer, and
follow the procedure above for installing the Help
File.

3 If you can find the Help file, click its name in the
list to highlight the name and click the Open
button.

Performer will remember the location of the Help
file so that you won’t have to find it each time you
click the Help cursor. However, in some cases
Performer may forget the location, so we
recommend that you place the Help file icon in the
same Folder as Performer so that Performer can
always find it.

The Help menu
The Help menu contains three items, as shown
below:

About Balloon Help...

Show Balloons

flbout Help...

Figure 2-4: The Help menu.

Choosing About Help opens a help window that
describes how to use the On-line Help feature. You
can choose About Help anytime—even when the
Help file or a Performer file is not currently open.

Choosing Show Balloons makes the arrow cursor
turn into the Help cursor without holding down
any keys. This is convenient when you would like to
browse several features. In Show Balloons mode,
any item that you click on or select from a menu
will open a help window.

In Show Balloons mode, you can temporarily turn
the cursor back into the arrow by holding down the
command-option-shift key combination.

12 L
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To permanently turn the cursor back into the
arrow, choose Hide Balloons from the Help menu.

To toggle the Show/Hide Balloons command from
the Macintosh extended keyboard, press the Help
key.

Getting help on greyed menu items
Greyed menu items are commands that are not
currently available for one reason or another. For
example, Region menu items are greyed unless a
region has been selected. If a region is selected,
they become black.

To get help on a greyed menu item, simply hold
down the command-option-shift key combination
while selecting the item from the menu. The item
will not highlight as you select it, but a help window
will appear anyway.

A word to the wise
Help descriptions do not take the place of the
Performer manual. Unfortunately, there is not
enough space to cover all the intricacies of every
Performer feature in the space of a Help window.
Therefore, we strongly recommend that you refer to
your Performer manual and update documentation
fora complete explanation of features that you would
like to learn more about. Then you won’t miss
things that the Help window doesn’t cover, and you
will get the most out of Performer.

I ON-LINE HELP
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chapter 3 Working With Files

A single Performer file can contain one or more
sequences and songs. It is represented in the
Macintosh Finder by the Performer file icon.

Figure 3-1: Performer's various file icons.

OPENING A NEW FILE
To open a new file, you must first start Performer.

1 Double-click on the Performer program icon.

You can also click once on the Performer icon and
choose Open from the File menu. If you see a new
file appear on the screen, with the tape-deck style
Control Panel and Tracks window, you are ready to
go-

2 If you see the standard Macintosh dialog box for
opening files, click the New button (or press
command-N).

If you are already in Performer:

1 Choose New from the File menu.

If a file is currently open, Performer will close it
first. If you have modified the data in the file,
Performer asks if you would like to save changes
before closing it. The various windows will
disappear and the file will close.

A new file will be created and the Control Panel
appears, along with the Tracks window. (You can
customize the file that the New command produces
with the Save as ‘New’ Template, described later in
this chapter).

Opening a new file automatically opens a new
sequence. This sequence is ready to record into
right away. You can create other new sequences by
choosing Add Sequence from the Chunks window
mini-menu or by choosing New Sequence from the
Tracks window sequence pop-up menu.

Opening an existing file
To open an existing file from the Finder:

1 Double-click on the file icon.

You can also click once on the file and choose Open
from the File menu. This will start Performer and
bring up the selected file.

To open an existing file from within Performer:

1 Choose Open from the File menu.

If a file is already open, you are given the option of
saving changes in this file. The Performer windows
will all disappear and the file will close.

A dialog box will appear, containing a list of files on
the selected disk. To see the files on a disk in a
different drive, click on the Desktop button. To 



view files on another disk which is not currently in
a drive, click on the Eject button and insert the
other disk.

Mosaic’s File menu. Once the file is saved in the
MIDI file format, you can then open it in
Performer.

|€3 Performer Files *»• |
help.too

CD Home
§ House Grooue

<>

IE'S Home Grooue. 2 '6 1 ■

ggHouse Grooue.MIDI
BJ9C

Jim’s file
jZjKImon Grooue

a PowerPC

1 £)<«> 1
[ Desktop )

[ New )

[ Cancel )

Figure 3-2: Opening a file in Performer.

2 Click the name of the file you wish to open.

3 Click Open.

The file you selected will be opened. Double­
clicking on the name of the file will also open the
file.

Opening files in other formats
Performer can open files in the Professional
Composer® and MIDI file formats. It can also
open Digital Performer 1.6 and 1.71 files (without
any audio data in them, however). To open a file in
one of these formats, simply select it from the Open
dialog box as normal. A message will appear
informing you that Performer is converting file
formats. The file will open as a Performer file; if you
want to save it back into the Professional Composer
or MIDI file format you must use the procedure
described later in this chapter.

In addition, files created in older versions of
Performer can be opened in the new version;
simply select the old file from the Open dialog box
as normal.

Performer cannot open Mosaic files directly. To
open a Mosaic file, save it as a MIDI file from
within Mosaic using the Save As command in
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LOADING A CHUNK FROM ANOTHER FILE
Once you have opened a file, the Load command in
the File menu lets you load Chunks (sequences and
songs) from other files directly into the open file
without closing it.

Your Macintosh must have enough RAM available
to support the load operation. Be sure to open and
watch the Memory window, available in the
Windows menu, whenever you load Chunks or
Remote Controls. Try to have at least 100K
available at all times.

To load a Chunk into an open file:

1 Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2 Click the file containing the Chunk you wish to
load, then click Open.

Alternately, you can double-click the file name.
Performer’s Load dialog box appears, displaying
the file name at the top.

® Load Chunks
©Data
OUnk

V Seq-3
txl Song-1
S3 Song-2

Seq-4

® Remote Controls
® Consoles
® Device Groups
® Transpose Maps

Custom Scales
[?3 Humanize Styles
(■} Random Pitch t taps

Chunks
list

Figure 3-3: Loading a sequence or song (chunk) from another file into
the currently open file.

3 Make sure the Load Chunks option is checked.
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If it is not, click its check box. The Chunks list
displays all Chunks in the selected file.

4 Choose the Data sub-option.

5 Select the Chunk(s) you wish to load.

Click the Chunk name to select it. If you wish to
load more than one Chunk, drag to select
contiguous Chunks and shift-click to select
discontiguous Chunks.

6 Optional: If you wish to load any other items
from the selected file, select the appropriate option.

7 Click OK to confirm your choice or Cancel to
withdraw the Load command.

Clicking OK causes the selected Chunk(s) to be
placed in the Chunks window. You can change each
Chunk’s position in the Chunks list by dragging its
Type icon.

Loading a song Chunk automatically loads its
component Chunks. For example, you choose to
load Song-1, which contains Seq-1, Seq-2, and
Song-2. Song 2 contains Seq-3 and Seq-4. When
you execute the Load command, all six Chunks
(two songs and four sequences) will be loaded in
and added to the Chunks list of the open file.

Linking sequence chunks from another file
A memory-saving option in the Load command is
to Link a sequence Chunk instead of actually
loading it. A Link serves as a reference to a Chunk
in a different file. Since a Link requires far-less
memory than the Chunk it references, you can
build an extensive list of Chunks without running
out of memory in your Macintosh.

Because a song in Performer is a collection of
Chunks, song Chunks cannot be linked. Instead,
just load the song using the procedure described in
the previous section. Performer will automatically
load the song’s component Chunks. Alternately, 

you could open that song’s file and use the Merge
Chunks to Sequence command to transform the
song into a sequence. The new sequence could then
be linked. For more information about converting
a song into a sequence, please refer to the chapter
The Song Window.

To link a Chunk from another file:

1 Choose Load from the File menu.

The standard Macintosh Open dialog box appears.
If necessary, click the Drive button repeatedly to
view each drive present.

2 Click the file containing the sequence you wish
to link, then click Open.

Alternately, you can double-click the file name.
Performer’s Load dialog box appears, displaying
the file name at the top.

3 Make sure the Load Chunks option is checked.

If it is not, click its check box. The Chunks list
displays all Chunks in the selected file.

4 Choose the Link sub-option.

Any song Chunks in the windowbecome italicized,
indicating that they cannot be linked.

5 Click the sequence(s) you wish to link.

If you wish to Link more than one sequence, you
can drag to select contiguous Chunks and shift­
click to select discontiguous sequences.

6 Optional: If you wish the Chunk’s Remote
Controls assignments to be loaded with the Chunk,
choose the Load Remote Controls option.

Deselecting this option links only the Chunk’s song
or sequence data.
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7 Click OK to confirm your choice(s) or Cancel to
withdraw the Load command.

Clicking OK places a Link to each selected Chunk
in the Chunks window and a corresponding
Chunk Select control in the Remote Controls
window.

After you have linked a Chunk, its name appears
italicized in the Chunks window of the current file.
The Link’s Comment field displays the file from
which the Linked Chunk will be loaded. When the
Link is play-enabled, Performer will take a few
moments to load it; the amount of time this takes
depends on the size of the Chunk.

SAVING FILES
Please read this section carefully! When you open a
file from a disk, Performer makes a copy of that file
and puts it in the Macintosh’s temporary memory
(called Random Access Memory, or RAM). When
you work with the file, you are actually working
with the copy that is in RAM, not the original file
on the disk. If you choose Save from the File menu,
Performer writes the changes you have made into
the original file on the disk. If you do not save, the
changes you have made are never written to the
disk. For example, if you quit without saving
changes, the work you have done is not saved on
the disk and is permanently deleted from the
computer’s memory.

This is why files should be saved frequently. If
Performer or your Macintosh should malfunction,
all of the work you have accomplished since you
last saved may be lost! However, if the file was
recently saved, you can retrieve the latest version
from the disk and proceed without having lost
much work.

Always be sure that the disk you are saving the file on
has enough room! Files can be saved to any disk
with sufficient space for the file. They can also be
saved with different names.

Here’s the basic procedure to save a file:

1 Choose the Save command from the File menu.

Your file is saved on the disk in its current state,
replacing the old version with the same name. If
you want to keep the old version, use the Save As
command on the File menu (see below) instead to
save the current version under a different name.

If you are saving the file for the first time, a dialog
box will appear prompting you for a name:

Saue the current state as
| Eddie M/stree Mi>(

File format: | Normal

|€3 EDDIE M Protect^* 2 3 * * * 7

Neddie m
ghEDDIE M.jim

Figure 3-4: Saving a Performer file.

2 Type in the name of your file.

You can’t use a colon in the name; all other
characters are permitted, including spaces. If you
enter a name that is already in use, a dialog box will
ask you to confirm your choice.

3 Click on the Save button.

Pressing the Return key will do the same as clicking
on the Save button. If you want to save the file to a
different disk, click on the Eject button, insert a
new disk and, after typing in the name, press the
Save button. Pressing Cancel withdraws the Save
command.

Saving a file under a different name
The Save As command is used to save a file under a
different name or to a different disk:
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1 Choose Save As from the File menu.

The Save As dialog box will appear.

2 Type in the new name for the file.

You can’t use a colon in the name; all other
characters are permitted, including spaces. If you
enter a name that is already in use, a dialog box will
ask you to confirm your choice.

3 Click on the Save button.

Your file is saved on the disk in its current state
under the new name.

Saving a file to a disk not currently in a drive
To save a file to a disk not currently in a drive:

1 Choose the Save As command from the File
menu.

2 The Save As dialog box will appear.

3 Click on Eject.

The disk that is currently displayed in the dialog
box window will be ejected. If you want to use the
other drive, click on Drive before clicking on Eject.

4 Insert the disk you wish to save the file on.

5 Click on the Save button.

The file is saved on the disk you selected.

Performer saves almost every attribute of your file,
including open windows and their screen
positions, the on/off status of such features as
Audible Mode and Patch Thru, your current choice
of Event Editing display, your Chunk Start Times,
and many others. If you find that your files often
have very similar setups, use the Save As ‘New’
Template command, described later in this chapter,
to customize your new files.

Saving a sequence in another format
Performer can save sequences in several other file
formats:

■ Standard MIDI file

■ Performer Version 2.41 and 5.5 files

■ Digital Performer 1.6,1.7,2.0 and 2.1

■ Professional Composer™ file

Only sequences can be saved in these other file
formats. If you wish to save a song, you can do so
by converting it into a sequence beforehand. Please
refer to the Chunks Window chapter later in this
manual for information about converting a song
into a sequence.

To save a Performer sequence in a different file
format:

1 Play-enable the sequence that you wish to save.

Do so by clicking the play-enable button next to the
sequence in the Chunks window.

2 If you are saving a MIDI file, and you want the
tempo and meter map of the sequence to be saved
with the MIDI data, choose Conductor Track from
the Metronome tempo control pop-up menu in the
Control Panel.

Do so by choosing Conductor Track in the Tempo
Control pop-up menu in the Metronome.

3 Choose Save As from the File menu.

The Save As dialog box appears with the options
shown below.
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|<3 Mg Performer files |

Sane the current state as
| Mg Performer file

Professional Composer •x

Digital Performer 2.1
Digital Performer 2.0
Digital Performer 1.?
Digital Performer 1.6
Performer 5.5
Performer 2.41

Figure 3-5: Using the Save As command to save a file in a differen t file
format.

4 Click the desired file format.

5 Click Save to activate the conversion.

6 If you are saving a standard MIDI file, the MIDI
File Options dialog box appears.

See the next section for an explanation of these
options.

Saving as a standard MIDI file
Use the procedure explained in “Saving a sequence
in another format” on page 19. Music saved in the
MIDI file format can be opened with any program
that also reads and writes MIDI files—even
programs that run on other types of computers.

My Song
Figure 3-6: The file icon for a standard MIDI file created by Performer.

MIDI File Format options
When you save a file as a standard MIDI file, the
following dialog box appears:

T MIDI File Options

File format:
<t> Format 1 - separate tracks
O Format 0 - one multi-channel track
O Format 0 - tempo/meter map only

□ Save track names as plain text
3 Expand loops and print effects

End file at time: | 49|1|000]

Figure 3-7: Performer's options for saving a standard MIDI file.

■ Format 1: separate tracks with tempo and meter
information as the first track

■ Format 0: one multi-channel track with tempo/
meter information at the beginning

■ Format 0: tempo/meter map only

Save track names as plain text
When selected, the Save track names as plain text
option causes only plain text events, such as track
names, to be saved. No special text events, such as
track comments, are saved. This option is
necessary when transferring files to programs that
do not support special text events. If you discover
inconsistencies when transferring text in MIDI
files, try using this option.

Expand Loops and print effects
Standard MIDI files cannot contain loops or real­
time MIDI effects processing. The Expand loops
and print effects option addresses this problem by
converting each loop into a region of repeated data
in the same way as Performer’s Repeat command.
The End file at time option allows you to specify the
end time of the sequence in the box provided. For
convenience, the box appears with the sequence’s
current end time. Similarly, all real-time effects
processing is written permanently to the data as it
is exported.
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Performer automatically opens MIDI files. For
more information, see “Opening files in other
formats” on page 16.

Saving as a Performer 2.41 or 5.5 file
Performer’s file format is constantly developing as
new features are added. Due to these changes, files
saved in the current format cannot be loaded into
earlier versions of Performer. If for some reason
you need to work with a file in an earlier version of
Performer (2.41 or later), Performer lets you save
sequences in the version 2.41 or 5.5 format. Just use
the procedure described in “Saving a sequence in
another format” on page 19.

When you Save As 2.41, songs in the file will not be
saved. This is because Version 2.41 does not
support songs. Therefore, any songs in the file you
save will not be present in the 2.41 version of the
file. If you don’t want to lose the song when
converting to the 2.41 format, you can easily
convert it into a sequence, which will get saved in
the 2.41 file. To do so, open the song’s Song
window, Select All, and choose Merge Chunks to
sequence from the mini-menu. A new sequence,
which is identical to the song, will appear at the
bottom of the Chunks window list and get saved in
the 2.41 file.

Saving as a Professional Composer file
A Performer sequence can be converted into a
format that is readable by Professional
Composer®, an earlier score editing software
package from Mark of the Unicorn.

To save a file in the Professional Composer file
format, use the procedure described in “Saving a
sequence in another format” on page 19. Make sure
that you quantize both attacks and releases of all
the notes in the sequence beforehand. Otherwise,
the transcription in Professional Composer will be
filled with unwanted 32nd and 64th notes and
rests. See “Smart Quantize” on page 233.

Once you have converted the file, quit Performer,
start up Professional Composer, and open the
newly created Composer file.

Transferring a sequence to Mosaic™
To transfer a sequence to Mosaic, Mark of the
Unicorn’s latest notation software package, save it
as a Format 1 MIDI file. No quantization or other
preparation is necessary because Mosaic does its
own quantizing when you open the MIDI file in
Mosaic. See “Saving as a standard MIDI file” on
page 20 for information about saving standard
MIDI files.

Saving as a Digital Performer file
Use these file format options to transfer a sequence
to Digital Performer. Since Performer can also
open Digital Performer 1.6,1.7,2.0 and 2.1 files,
you can freely exchange files back and forth
between them and Performer.

REVERTING TO A PREVIOUSLY SAVED
VERSION OF THE FILE
If you’ve made unwanted changes to a file, you can
undo the changes you’ve made by returning to the
last saved version. This operation is identical to
closing the file and opening it from the disk again.

1 Choose Revert to Saved from the File menu.

A dialog box asks you to confirm this choice.

2 Click on OK to confirm the action, Cancel to
withdraw it.

Reverting to the last saved version of the file means
that all changes you’ve made since you opened or
last saved the file will be lost.

Reverting to a previously saved version is useful
when experimenting with a file. You can quickly
remove any changes by using this command. Make
sure that you save the file in the state you want it
before beginning to experiment.
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SAVING A FILE AS A'NEW'TEMPLATE
The Save As ‘New’ Template command, found in
the File menu, allows you to customize your copy
of Performer. You control what appears on the
screen when you open a new file, by creating your
own New file template. A template is a “skeleton”
file, a framework designed to save you time when
building your files.

For example, let’s say you typically work in files
with one sequence, the same number of tracks,
Auto Channelize, measure time and SMPTE
displays in the Counter window, and a Sequence
Start Time of -1. In addition, you arrange
Performer’s windows to suit your screen size and
style of working.

You can use the Save As ‘New’ Template command
to give your ‘New’ files all of these characteristics
automatically.

When you choose Save As ‘New" Template from the
File menu, Performer remembers the exact state of
the file and reproduces it next time you request a
new file. The New command, also in the File menu,
will produce an untitled, empty new file identical
to the source file.

To use the Save As ‘New’ Template command:

1 If you aren’t already in a Performer file, open
one or choose New from the File menu.

2 Configure Performer’s windows, their contents,
and any other features as you find most useful.

This file will be your template source file:
Performer will remember your exact track setup,
window layout, Patch Thru setting, and so on.

3 Choose Save As ‘Nev/ Template from the File
menu.

A dialog box will ask you to confirm or cancel your
request.
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4 Click OK to confirm the command, Cancel to
withdraw it.

If you confirm the command, Performer redefines
your‘New’ template based on the current file. All
attributes specific to the current file, except for
MIDI and Conductor track data, now comprise a
New file in the copy of Performer you are using.

To see the effects of Save as ‘New’ Template, close
the current file and choose New from the File
menu. A new, empty, untitled file will appear,
identical to the last file you saved as ‘New’.

Hints for using Save As'New'Template
Remember that the Save As ‘New’ Template
command customizes only the copy of Performer in
which it is used. Every copy of the program has its
own template; a fresh copy of Performer will yield
the default New file setup.

For this reason, make a spare copy of your template
source file using the Save As command described
earlier in this chapter. Pick a suitably descriptive
name for the file, like “Perf Template”. This way you
can retrieve your preferred setup into any copy of
Performer by opening “Perf Template” and
immediately choosing Save As ‘New’ Template
from the File menu.

Redefining your New file template is easy. For
example, you’ve used the Save As ‘New’ Template
command in a file that contains only one track.

To quickly add more tracks to your template:

1 If you are in a Performer file, choose Close from
the File menu to close it.

If you’ve made any changes to the file, you’ll be
prompted to save them.

2 Choose New from the File menu.
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A new file will open, identical to the file you saved
as New.

3 Activate the Tracks window if it is not already
active.

Click anywhere in the window to activate it.

4 Hold down the Option key on your Macintosh
keyboard and choose Add from the Tracks window
mini-menu.

A small dialog box will prompt you for the number
of tracks to be added. Type in the desired number.

5 Choose Save As ‘New’ Template from the File
menu.

The existing file will become the new template.

QUITTING PERFORMER
Quitting Performer returns you to the Finder.

Choose Quit from the File menu.

A dialog box may appear asking you if you want to
save changes made to the file. To save the changes,
press Yes. If you don’t want to save changes, press
No. To withdraw the Quit command and return to
your Performer file, press Cancel.

SETTING PERFORMER'S STARTUP
PREFERENCES
When Performer first opens, you have three
choices for what it can do:

■ Open a new file

■ Present you with the Open file dialog box, which
lets you open either an existing file or a new file
with the “New” button

■ Neither of the above, which lets you either
choose Open or New from the file menu

To set this preference, choose Preferences from the
File menu and choose the desired setting. This
setting is stored in the Performer Preferences file in
the Preferences Folder inside the System Folder on
your hard disk.

FILE AND DISK ERRORS
The following are a few file and disk errors that
commonly occur. Always keep plenty of up-to-date
backups of your important files as you work. Almost
any software problem is survivable as long as you
have kept backups of your work. See Appendix A,
“Troubleshooting and Customer Support”
page (527) for more information about problems
you may encounter with Performer files.

There isn’t enough room on the disk. Your disk is too
full. Eject the disk and insert one with plenty of free
space on it. Note: If Performer runs out of disk
space while saving a file, the file on disk will be
damaged. If this happens, immediately use the Save
As command to save the file to a disk with more space
available. If you fail to do this, and you have not
made a backup file, you will have lost an entire file.
As a rule, before opening an existing file, be sure
the disk on which it is stored has enough free
memory to hold the information you expect to
add.

An error occurred while writing the file. This is a
dangerous situation. In all probability, the existing
copy of the file on the disk has already been erased
so that the new copy could be saved. Because of the
error, any partial file that has been saved cannot be
read. At this point, the only good copy of the file is
in memory. Immediately try to save the file on
another disk. Do not attempt to use the Revert to
Saved command on the File menu; the saved copy
is damaged and you will lose the file in memory.

You tried to open a Professional Composerfile made
by using the Save as Composer command in
Performer and didn’t get what you expected. If the
file has all sorts of very small note values, try 
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quantizing the Performer file to a larger note value.
Make sure that you quantize both attacks and
release of all the notes. To confirm that you have
successfully quantized, check attack times and
durations of notes in the Event Editing window of
each track. If correctly quantized, all durations will
be rounded values such as 1/000 (quarter note), or
0/240 (eighth note). See “Smart Quantize” on
page 233 for details. Once you have successfully
quantized the sequence, save it as a Professional
Composer file and try opening it in Professional
Composer again.

The computer ran out of memory. Either the data
you were recording filled up memory or you edited
the file quite a bit. Try recording smaller segments
and saving the file more often.

The disk is locked. Unlock the disk by sliding the
small tab on the back of the disk in the upper left­
hand corner down so that it covers the small hole.

The disk can’t be read. The disk itself may be
damaged. Return to the Finder and try inserting
the disk again. If it still can’t be read, it may be
irretrievable.

HELPFUL FILE AND DISK HINTS
File menu commands cannot be used during
playback. To use a command in the File menu,
press the stop button beforehand.

Save your file as often as possible.Ton should use the
Save command after every significant change to
your file.

Always keep backup copies of your important  files.
We cannot emphasize enough the importance of
this. At the end of a working session, copy to a
backup disk all of the files you recorded and edited.
This way, if anything should happen to your
original, you will have fully updated backup of the
file.

Saving a file under a different name while working
can be useful when you want to keep a record of
earlier versions.

When saving files during a working session, it is a
good idea to save alternately under different file
names; if something should happen to one of the
files, the other will be a recent version. For
example, a file can first be saved under the name
“Session 1”. The next time it is saved, choose the
Save As command from the File menu and save it as
“Session2”. The following time, it is saved as
“Session 1 ” again, then “Session2” and so forth. To
be even more careful, save a file to different disks
during a working session.

Be sure to backup your files as often as is bearable,
at least at the end of every working session and
several times during the session if possible. The
consequences of not making backups are severe: if
your hard disk is damaged, some or all of the files
may be lost forever.

Using System 7's stationery feature
Performer supports System 7’s “Stationery pad”
feature in the Get Info window for a file as shown
below:

Figure 3-8: Stationery pad option in the Get Info window.
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When this option is checked, the file can be
opened, but System 7 will prevent you from
modifying the original file by forcing you to Save
As when you attempt to save the file. This option is
great for preserving files that you do not want to
modify and that you use regularly as a “template”
from which to build other files. For more
information about the Stationery pad option,
consult your System 7 documentation.

WORKING WITH FILES
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chapter 4 Performer's User Interface

The user interface encompasses everything that
you do to interact with the program: what you see
on the screen and how you use the mouse,
keyboard and peripheral devices. In this section
you’ll find information about Performer’s
windows, dialog boxes, mouse and keyboard
actions and how to specify and locate regions using
units of time. This section also describes
Performer’s enhancements to the standard
Macintosh user interface.

The examples of Performer’s windows that
you see in this manual are what you see when you
are running Performer on a Macintosh with a color
monitor (in either 16-level grayscale or 256-
colors). If you have a black and white monitor, what
appears on your screen will be somewhat different
than what you see printed in this book.

Before using Performer, please review the standard
Macintosh user interface conventions. If any of
them seem unfamiliar, please refer to the
Macintosh owner’s manual for a full explanation.
Be sure you are familiar with the following:

■ How to use the mouse and keyboard

■ How to open, copy and delete files from the
Finder

■ How to choose commands from menus

■ How to select options using push buttons, radio
buttons and check boxes

■ How to respond to dialog boxes

■ How to use Command key shortcuts for menu
commands

■ How to enter and edit text

Windows
To start with, an example of a Performer window is
shown in Figure 4-1.

The Close button is shaped differently from the
standard one but works just the same: click in it to
close the window.

The Scroll Bar works exactly the same as the
standard one: to move directly to a desired location
in the window, drag the Scroll tab to the desired 

Window mini-menu

Window title

•giaiflisifltiiwj.Close button
Scroll tabilttooo o

Solo button.

Full Organ

Scroll bar

1|I|I5Q A«10 164

Grow box

Zoom button

Audible mode
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111 j300 A»6_J2___________________
2111012 >04 i 100*83 1|253 2121265

>83 1109*50 11302 2121314
2111020 >E3 i 100 *88 6|185 3131203
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Pushdown button

(Seq-’t

Figure 4-1: A Performer window.



location. Press on the arrows to scroll continuously,
or click once on them to scroll one line at a time;
click in the grey region to scroll a screenful at a
time.

The Window Mini-Menu resembles the standard
menus on the top of the screen. It contains
commands pertinent to that particular window. To
pull it down, press on the menu icon and then
select a menu option as you would on a standard
menu at the top of the screen.

Figure 4-2: A Performer mini-menu.

Window title shows the name of the window, and
often the track or sequence that it pertains to.
Command-click the title to switch to a different
track, sequence, etc.

Mini-menu button

Figure 4-3: Command-click the window title to switch to a different
track or sequence.

Conductor!

irucK-z "
Track-3
Track-4
Track-5
Track-6

The Pushdown Button will put the window behind
all other windows on the screen. This is useful
when you are finished with a window but don’t
want to close it.

The Zoom Button will enlarge or shrink the
window. Clicking in the zoom box will enlarge a
window to a larger size; clicking in the zoom box a
second time will return it to its original size.

The Grow Box lets you adjust the size of the
window. Dragging the grow box will continuously
adjust the size of the window. Note that it is
possible to have names or other information
extend past the right edge of the window; if you
need to see this information use the grow box to
expand the window appropriately.

The active window
Most of the time, the window in which you are
currently working is the active window. The active
window is indicated by fully detailed borders;
when a window is inactive its top border and scroll
bar are blank. To activate a window so that you can
work in it, simply click anywhere on it. Performer’s
main Control Panel is always active; it is not
necessary to click on it before using it.

A single click on an inactive window makes that
window active, and in addition, the item in the
window that was clicked responds, except for
clicking the title bar, scroll bar or re-size button.
This speeds up working with Performer because
less clicks are necessary.

The Windows menu
The Windows menu is important because it gives
you access to many of Performer’s most important
features.

The Open hierarchical menu lets you open
sequence-specific windows like the Tracks window,
and various edit windows for the tracks in the
sequence (event list, graphic editing, notation
editing, etc.) It also lets you open the Markers
window. All of these windows can also be opened
using their corresponding button in the main
Control Panel.

30
PERFORMER’S USER INTERFACE



The Close command closes the top-most window.

The Next/Last Edit window commands cycle
through all of the currently open edit windows. You
can also use their keyboard shortcuts:
command-tilde (‘) and command-shift-tilde.

The Window Sets hierarchical menu lets you
capture and save your favorite window layouts,
assign them to hot keys on your Mac keyboard, and
recall them whenever you want. For details, see
chapter 38, “Window Sets” (page 383).

The Clippings hierarchical menu lets you store bits
of data in clippings windows. For details, see
chapter 25,“Clippings” (page 315).

The Consoles hierarchical menu lets you create
and open saved custom control consoles. For
details, see chapter 45, “Custom Control Consoles”
(page 429).

Closing all edit windows
Performer provides several shortcuts for closing all
open edit windows (Event Lists, Graphic Editing
windows, and QuickScribe notation window):

■ Press command-option-W.

■ Option-click the close triangle in any edit
window.

■ Press the option key and the Close command in
the Windows menu changes to Close All Edit
windows.

Closing all windows
To close all open windows (except the control
panel), press command-control-W. If you hold
down the command and control keys when
choosing the Close command in the Windows
menu, it changes to Close All Windows.

Dialog boxes
Performer’s dialog boxes look more three
dimensional than the standard Macintosh ones:

Three dimensional radio
buttons and check boxes.

When you press the “OK" button,
playback will begin automatically.
During playback you must set beats
in the sequence by playing notes on
your MIDI input device. When you
stop playback. Performer will
adjust tuning in the sequence and
then return to normal operation.

Three dimensional OK
and Cancel buttons.

Drag the title bar of the
dialog box to move it on
the screen—in case you
need to see something
behind it before closing it.

Figure 4-4: A Performer dialog box.

Even though these buttons look different, they act
like standard Macintosh check boxes, radio
buttons, and push buttons. For example, the text
labels for radio button and check box options can
be clicked to check the box or push the button. In
addition, if you type in a text box, its
corresponding radio button selects automatically.

Clicking shortcuts
Option-click: If you hold down the option key and
click on a check box, all check boxes will be
unchecked except for the one you Option-clicked
on.

Command-click: If you hold down the command
key and click on a check box, all check boxes will be
checked except for the one you clicked.

PERFORMER'S USER INTERFACE
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Mouse techniques
Here are the mouse actions you’ll use in Performer:

To click, move the mouse to position the arrow
cursor on the object then press and quickly release
the mouse button. Single clicks are generally used
to select an action, confirm a selection or to select
something for editing.

To double-click, move the mouse to position the
arrow cursor on the object then click the mouse
button twice in quick succession. The interval
between the two mouse clicks can be set on the
Control Panel on the Apple menu (refer to your
Macintosh owner’s manual about this). Double­
clicking is generally used for opening things such
as windows.

To press, move the mouse to position the arrow
cursor on the object, press the mouse button and
hold it down.

To drag, move the mouse to position the arrow
cursor on the object, press the mouse button and,
holding it down, move the mouse in the desired
direction. Dragging is used to increase the size of a
window, to move indicators (such as the tempo
slider in the Metronome panel), to select multiple
names, events or objects, or to select a region.

To scroll, press on the scroll box in the scroll bar
and drag it in the desired direction. Scrolling can
also be done by clicking or pressing on the arrows
on the top and bottom of the scroll bar.

To learn more about mouse actions, consult the
Macintosh Owner’s manual.

Keyboard and mouse actions
Some actions are done with the mouse and
keyboard in conjunction:

To Shift-click, hold down the shift key, move the
mouse to position the arrow cursor on the object
and click the mouse. Shift-clicking is used for 
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selecting non-contiguous items; for example, you
would use Shift-click to select several independent
events in an Event Editing window.

To Shift-drag, hold down the shift key while
dragging. Doing so extends the current selection
— with one exception: in the Graphic Editing
window note grid, shift-dragging one or more
notes constrains dragging vertically or
horizontally.

To Option-click, hold down the option key, move
the mouse to position the arrow cursor on the
object and click the mouse. Option-click is used to
edit the name of a track, sequence, song or marker
for editing. After editing, the new entry can be
confirmed by pressing the Return key.

To Option-drag, hold down the option key while
dragging. Doing so makes a copy of what you are
option-dragging.

To Command-click, hold down the command key,
move the mouse to position the arrow cursor on
the object and click the mouse. Command-click
toggles the current grid snapping setting. For
example, if grid snapping is turned on, holding
down the command key temporarily disables it.

Keyboard commands
The following keyboard commands are applicable
to dialog boxes and pop-up boxes.

Pressing on the return key is the same as clicking on
OK: it confirms the selection in the dialog box.

Pressing on the enter key will also OK a dialog box.
It is also used when editing a list of names or data,
confirming the current one and moving to the
next.

Pressing the command and period keys together is
the same as clicking on the Cancel button: it
cancels the selection and leaves the previous
settings/values unchanged.
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Figure 4-5: Typing command-period cancels the current dialog box
or operation.

Pressing the escape key is the same as clicking a
Cancel button and pressing command-period (.).

Changing values in text boxes by dragging up
ordown
You can change number or note values in text edit
boxes throughout Performer by pressing on the
text box and dragging up or down. You can also
edit text box values in the usual ways (by typing,
etc.)

Pressing the tab key will confirm the current entry
field, then move to the next field in the box or list
and highlight it. Pressing Shift-tab does the same
thing, only it moves to the previous field or box.

The up arrow will move through a list of names or
events, confirming the current selection and
moving to the previous one.

The down arrow will move through a list of names
or events, confirming the current selection and
advancing to the next one.

The left and right arrows move from field to field in
the event list, confirming the current selection and
advancing to the next one in the arrow direction.

In addition to these, there are many shortcut
keyboard commands that will allow you to choose
commands from menus very quickly. They are
indicated on the menus to the right of the
commands themselves and can be used instead of
pulling down the menu and selecting the
command. To use a shortcut command, hold down
the Command key and press the indicated key. For
example, command-X is the shortcut for the Cut
command. Instead of pulling down the Edit menu
and selecting Cut, hold down the Command key
and press the X key.

Cut 36H
Copy KC
Paste sen
Erase MB
Repeat... 3CN
Merge 36M

Figure4-6: Examples of command-key equivalents for menu
commands in Performer.

•to) I O=D|:eH:eO -J
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17111000 ! | Party 1

iq1,1000 ii Party II
H looo; | Brfdao w/party
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Figure 4-7: Examples of editing quickly text in Performer by dragging
up and down.

Specification of time units
In Performer, you will always be dealing with time
specifications. Performer gives you the option of
using measure time (measure|beat|tick), real time
(minutes:seconds.hundredths) and frame time
(hours:minutes:seconds:frames).Full
understanding of the time specifications you are
using is essential. Below is a concise explanation of
each of them:

Measure time (measure|beat|tick): A specification
of measure-oriented musical location. The number
of beats in the measure depends on the specified
meter: 4/4 will define 4 beats per measure, for
example. Subdivisions of the beat vary, according
to the 480-ticks-per-quarter note constant. Thus, a
beat in 6/8 time (an eighth note) will have 240 tick
subdivisions, a beat in 2/2 time (a half note) will
have 960 tick subdivisions and so forth. Measure
time is useful since it is the most musical.
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I TOggs
Figure 4-8: Specifying time in measures, beats, and ticks.

Real time (minutes:seconds.hundredths):
Measurement in standard clock time. This is a
simple, already familiar method for location. 

I gw.gg*
Figure 4-9: Specifying real time in minutes, seconds, and hundredths.

Frame time (hours:minutes:second:frames):
Frame time is a special type of real-time
measurement. With it, you can synchronize
Performer (via a SMPTE to MIDI converter) to a
device that uses SMPTE time code as a time
reference. Unlike measure time, frame time is used
when absolute time location is necessary.

I omigw*
Figure 4-10: Specifying SMPTE time in hours, minutes, seconds and
frames.

SMPTE stands for Society of Motion Picture and
Television Engineers. Although SMPTE time code
is used mostly in film and video work, it is
increasingly used for audio applications. One
SMPTE frame corresponds to one film or video
frame. The number of frames per second depends
on the equipment you are working with; Performer
supports 24,25,30 drop frame, and 30 frames per
second. SMPTE is useful as a standardized location
scheme when synchronizing to production devices
such as a tape deck or video deck. See chapter 39,
“Receive Sync” (page 387) for a more detailed
explanation.

Durations used in specifying note lengths
Times used in Event Editing windows and
elsewhere to specify durations are displayed in
quarter notes and ticks. Since Performer allows

I

different meters in a sequence, it is necessary to use
a comprehensible, easily divisible format to insure
clarity and a lack of confusion. The quarters|ticks
format fulfills this requirement, making it easy to
understand durations without having to specify a
measure value. For instance, a whole note is 41000
(four quarter notes and no ticks), and a dotted
quarter note is 11240 (one quarter and 240 ticks).

2121000 /az >55 tea QII2Q 2121120

U2 000 J-G3 i55 183 01240 1121240
112 240 JG3 155 18-8 0J24O 1131000

1 1

2|1 000 /Eb3 153 188 1|0DO-<- — Quarter note

Figure 4-11: Specifying note durations in beats and ticks.

3111000 >C3 *55 *63 41000 _^4J 11000
------JIXUXIIUIII

3111240 /FZ 155 *63 01240
1—J

—-Whole note
3121000 JF3 J 55 *63 01240 312J240
3121240 J“F3 155 163 01240 3131000 &
16|2|000 «T’B2 155 tea 01240 18131000 —

Editing the Counter directly
The current playback location can be changed at
any time by editing the Counter directly (as
apposed to using one of the other numerous ways
of cueing Performer). You can edit the counter even
while the sequence is playing back. There are
several ways to edit the current Counter location in
Performer, as described below.

By Typing
To edit the counter by typing:

1 Click on the field in the time display to highlight
it.

2 Type in a new time value.

While a field is highlighted, just type in a new
value. Use the backspace key to erase an incorrect
entry.
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Pressing the Tab or the decimal key on the keypad
will cycle through each field of a time display,
highlighting each so that you can type in a value.
For example, to enter the time 0:07.13 as shown in
the example above:

1 Click on the minute field to highlight it.

2 Press 0.

3 Press the Tab or decimal key.

4 Press 0 and 7.

5 Press the Tab or decimal key.

6 Press 1 and 3.

7 Press the Return key.

As a shortcut, you can press the decimal key on the
Macintosh keypad. To cancel the edit, press
command-period.

By Dragging
This is a great short cut for quickly “yanking” the
counter:

1 Press on the desired measure, beat, or tick field
(or hour, minute, second, or frame field if you are
working with SMPTE).

| .. 0=0J,I3«

2 Drag up or down.

Editing during playback
Many of Performer’s features, such as windows,
dialog boxes, edit region selection, edit commands,
and other features can be used during playback.
For example, you can open another window or use
the Transpose command while the music is playing
back; you do not have to press the stop button
beforehand. So, the next time you are listening to 
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your music and would like to make a change, don’t
reach for the stop button. Just execute the
command while the music is playing.

Here are some examples of things you can do
during playback:

■ Select a region for editing (in an Event List,
Tracks Window, etc.).

■ Edit a region with the Edit or Region menu
commands

■ Rearrange Chunks in the Song window

a Cut, copy, drag, option-drag (copy), etc. notes
and data in Graphic Editing and QuickScribe
notation windows

□ Reassign the playback channel for a track

n Add, delete, rename, or reposition a track

□ Access a mini-menu command such as Add
MIDI Track

During playback and recording, the Counter and
other displays may become irregular and seem to
skip beats. This is due to Performer’s primary
obligation which is to receive and output MIDI
data on time. Performer may have to devote all of
the computer’s resources towards this end and thus
may not be able to keep the screen display
completely smooth and current. The Click will
provide an accurate determination of the tempo. In
addition, editing commands may sometimes take
longer due to the amount of processor time
required to deal with playback.

Some features, because of their nature, cannot be
accessed during playback. These features are either
greyed out (unaccessible) during playback or will
have no effect unless you press the Stop button
before using them. Examples are:

■ Using the MIDI Interface dialog box

■ Save or close a file
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chapter 5 The Control Panel

Performer’s Control Panel contains all the
functions that make Performer “go”: buttons to
record, play, rewind, set tempo, and more. The
main transport controls look and act just like the
transport controls for a tape recorder. Additional
buttons provide immediate access to many of
Performer’s significant features. To open it, choose
Control Panel from the Windows menu.

To conserve screen space, the Control Panel does
not have a title bar. To move the panel, hold down
the shift key and drag. If the panel is behind other
windows, choose Control Panel from the windows
menu to bring it to the front.

QUICK REFERENCE
Tempo Slider: Lets you control the tempo of the
sequence. When the Tempo Control pop-up menu
is set to Tempo Slider, drag the triangular indicator
or press on the plus/minus buttons to change the
tempo (+ to increase the tempo, - to decrease it).

Current Meter: Displays the meter at the current
location in the Chunk. To change the meter, you
must use the Change Meter command on the
Change menu or insert a Meter change event in the
Conductor track.

Current Beat Value: Displays which note value gets
the beat in the beats-per-minute tempo indicator.
Click on it to change it.

Current Tempo: Displays the current tempo in
beats per minute. Click on it and type in a new
tempo or drag the Tempo slider. If you work with
film, you can use the Display Preferences in the File
menu to display tempos in frame-dicks.

Tempo Control: Selects the current source of the
tempo from a pop-up menu. Tempo can be
controlled from the Tempo slider, the Conductor
track, or remotely from a MIDI controller such as a
mod wheel. Tempo control can be changed during
playback.

Main Counter

Status Strip

Countoff Event list

Start time button

Tempo
Slider

Chunks
Window

Chain
Chunks

Overdub
record

Current
Meter

Markers
Window

Auto
Rewind

Skip
buttons

QuickScribe
Notation

Memory
Cycle

Time format selec­
tion buttons

Currentbeat
value

Main Transport
Controls

Current Tempo control
Tempo

Position bar

Metronome Mixing Board Opens Free
click window MIDI Setup

Auto Stop Cue Chunks Auto Record Wait Tracks window Graphic

editing

Set loop

Figure 5-1: Performer's Control Panel.
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Skip buttons: If you have more than one sequence
or song in the file, these buttons skip to the next or
previous one, much like the skip buttons on a CD
player. To view sequences and songs, open the
Chunks window.

Main Transport Controls: These are Performer’s
main controls for playback, recording, etc.

Position bar: Indicates the current playback
location with a scrolling arrow. Scroll buttons on
either side of the bar provide fast forwarding and
rewinding.

Start time button: Opens a dialog box which allows
you to set the start time for the Main Counter’s
three time formats: measure time, SMPTE time,
and real time.

Main Counter: Displays the current playback
position in one of Performer’s three time formats:
measures|beats|ticks, real time, or SMPTE time.
Click the time format icon to the right to cycle
through the three formats. Click the numbers and
type to change the playback location. For more
information about editing times in the Main
Counter, refer to the Counter Window chapter.

Time format buttons: Cycles the display in the
counter through Performer’s three time formats:
measures|beats|ticks, real time, or SMPTE time.

Set Loop button: Select a region and click this
button to create a loop. At least one track name or
track segment must be highlighted to create a loop
with this button.

QuickScribe Notation Window button: Opens the
QuickScribe Notation window for the currently
selected track(s) in the Tracks List or Tracks
Overview. At least one track name or track segment
must be highlighted to open Notation Editing with
this button. Provides notation editing and
printing.
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Graphic Editing Window button: Opens the
Graphic Editing window for the currently selected
track(s) in the Tracks List or Tracks Overview. At
least one track name or track segment must be
highlighted to open Graphic Editing with this
button.

Event List Window button: Opens the Event List
window for the currently selected track(s) in the
Tracks List or Tracks Overview. At least one track
name or track segment must be highlighted to
open Event List with this button.

Tracks Window button: Opens the Tracks window
or brings it to the front if it is already open.

Overdub record button: Toggles overdub record
mode, in which newly recorded data merges with
existing data instead of replacing it.

Wait button: Causes Performer to wait for a
keystroke (or any other MIDI event) from a MIDI
or Macintosh keyboard as a signal to start playing
back or recording. Wait can also be used together
with Countoff to create an indefinite countoff.

Countoff button: Causes a number of measures to
countoff before playback or recording. The button
denotes the number of measures, which can be set
by double-clicking the button.

Auto-Record button: Causes automatic punch in
and punch out during recording at the start and
end times specified in the Auto Record Bar.

Chain Chunks button: When highlighted, starts
playback of the next Chunk in the list after the
current playback Chunk reaches its End time.

Cue Chunks button: When highlighted, it play­
enables the next Chunk in the Chunks list after the
current playback Chunk reaches its End time and
stops. To begin playback of the next Chunk, press
the Play button, or a remote control for the Play
button.
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Memory-cycle button: Causes the region between
the Memory Start and Stop points to seamlessly
repeat. In the Tracks overview, repeat barlines
appear in the time ruler to indicate the repeat
points.

Auto-Rewind button: Causes automatic rewinding
to the Memory Start location any time playback is
stopped (for any reason).

Auto-Stop button: Causes playback or recording to
automatically stop at the Stop location in the
Memory Bar.

FreeMIDI button: Opens the FreeMIDI setup
program, in which you can make changes to
FreeMIDI’s representation of your current MIDI
studio setup.

Markers Window button: Opens the Markers
window for the currently play-enabled Chunk or
brings it to the front if it is already open.

Custom Consoles Window button: Opens the
Sliders window or brings it to the front if it is
already open.

Chunks Window button: Opens the Chunks
window, which displays all of the sequences and
songs currently stored in the file.

Metronome click button: Turns the audible
metronome click on or off.

Status Strip: Displays the name of the currently
open file and currently play-enabled Chunk. Also
displays the Memory bar, which allows you to set
start and stop times for the Auto-Stop, Auto­
Rewind, and Memory-cycle functions.

MAIN TRANSPORT CONTROLS
The Main Transport Controls are the buttons that
make Performer “go”: with them you can record,
play, rewind and more. The Main Transport
Controls are enabled by clicking on them. When a 

button is enabled, it is highlighted and its function
is active: the Record button records, the Pause
button pauses, etc. Most buttons can be disabled by
clicking a second time. To disable the Play and
Record buttons, press the Stop button. In some
situations (when in external sync, for instance)
buttons may turn grey signifying that they cannot
be used.

Think of Performer’s motion controls as similar to
tape recorder transport controls. But Performer’s
motion controls are more flexible than their
hardware counterparts in that they are
programmable via the Memory buttons (on the left
of the window), utility buttons (on the right) and
menu commands.

The Play button and playback
Clicking on the Play button starts playback of the
currently play-enabled sequence or song. Playback
will begin from the current time specified in the
Counter. Playback can be delayed by the Countoff
button and held by the Pause and Wait buttons.

Figure 5-2: Performer's play button.

The Play button is highlighted while the sequence
is playing. It flashes (or turns gray on a black and
white display) when waiting for synchronization in
the External Sync mode or when the wait button is
on.

The Position Bar arrows can be used to quickly
advance or rewind the current location while in
playback. If Audible Mode is turned on, these
arrows will “scrub” the music. For more
information, see “Scrubbing” on page 91.

.. ■ ^--"1

Figure 5-3: Performer's Position Bar arrows.
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If you start playback in the middle of a sequence,
you may not hear exactly what you expect. This is
because Performer moves forward through the
stream of data stored in each track, sending each
event that it encounters, such as note-on and note-
off commands. If you start playback in the middle
of a sequence, notes which are sustaining at that
point will not sound because their note-on
occurred before the point at which playback began.
Performer has a specially designed feature called
Event Chasing to avoid this problem. To learn how
to enable Event Chasing, see “Event Chasing” on
page 89.

During playback, some Performer features become
unaccessible, such as the Save command in the File
menu. Many other features, however, including all
editing commands, can be used even during
playback. As a general rule, commands that cannot
be used will either appear greyed out during
playback or they will have no effect.

The Rewind button
Clicking on the Rewind button sets the current
location to the start of the sequence. If the Memory
Bar is showing, clicking on the Rewind button will
rewind to the Memory Start location. Double­
clicking the button will always rewind to the start
of the sequence or song.

Figure 5-4: Performer's Rewind button.

If the Rewind button is clicked during playback,
playback is held for a moment while the sequence
rewinds. Playback then resumes from the rewind
location.

If the Rewind button is clicked during recording,
the record button is turned off. The sequence
rewinds normally and resumes in playback mode.

Although Performer rewinds much faster than a
tape deck, long sequences may take one or two
seconds to rewind.

Using the Auto-Rewind function is a fast way of
locating a frequent rewind location. See “The
Auto-Rewind button” on page 42.

The Stop button
Clicking on the Stop button stops playback and
recording. It also turns off the Pause button. All
notes sounding when the Stop button is clicked will
cease. If the Auto-Rewind feature is on, Performer
will rewind to the Memory Start location when the
Stop button is clicked.

r
Figure 5-5: Performer's Stop button.

The Pause button
Clicking on the Pause button once turns it on;
clicking on it a second time turns it off. The Pause
button is highlighted when it is on.

Figure 5-6: Performer's Pause button.

Turning the Pause button on during playback will
cause playback to be suspended without turning
any notes off. Turning it off will cause playback to
resume.

If the Pause button is turned on before playback,
playback will be suspended until the Pause button
is turned off.

While the Pause button is on, you can use the
Rewind button, Position Bar, and Counter window
to adjust the current playback location. You may
also set times in the Edit, Memory, and Auto­
Record bars.

40 |_____________________________________________________________________________________
THE CONTROL PANEL



The Record button and recording
Clicking on the Record button turns it on and
begins recording in the currently play-enabled
sequence from the current location in the counter.
When it is on, the Record button is highlighted and
can be turned off by clicking on it again. This
disables the record function while continuing
playback. You can also turn on and off the record
button during playback for manual punch-in and
punch-out. A more general way to think of the
Record button is as an on/off toggle switch that you
control manually.

Figure 5-7: Performer's Record button.

At least one track must be record-enabled before
the record button is pressed. This is done by
clicking on the Record-Enable button for the
desired track (or tracks). Record-enabling a track
makes it the destination for incoming recorded
data.

If the Auto-Record button is enabled, the Record
button will flash when clicked on (or turn grey on a
black and white display). It will then turn red (or
black on a black and white display) when the
Punch In location is reached. When the Punch Out
location is reached, the Record button returns to
“record-ready” mode.

If the Record button is enabled and grey due to
Auto Record, clicking on it will turn it off,
cancelling the punch-in.

When slaved to external sync, stopping or
rewinding the master device will turn off the
record button except in the case of Tap tempo sync,
which requires that you click the Stop button.

Overdub record mode
If you click the Overdub button, Performer goes
into Overdub record mode. Overdub mode causes
all recorded data to merge with, instead of replace,
pre-existing data on the record-selected track. The
pre-existing data on the track is not erased.

Figure 5-8: Performer's Overdub Record mode button.

The word overdub is used in a very specific sense in
Performer: real-time merging of incoming data
with data already on a track. It works as if you
recorded one track, recorded a second track to go
along with it and then merged the two. You can use
the Overdub mode in conjunction with memory
cycle to build patterns in multiple passes over a
region. This method is similar to that used with
many drum machines. (Overdub does not
function on the Conductor Track; specifically,
recording on the Conductor Track while slaved to
Tap tempo sync always erases existing tempo
events.)

Undo Record
By choosing Undo Record from the Edit menu, the
track you recorded into will be restored to its state
before recording. The Redo command returns the
track to its state after recording. Going back and
forth between the two states allows you to do A/B
comparisons. Note that only the last command can
be undone; if you edit your data after recording you
will no longer be able to undo the Record
command.

THE POSITION BAR
The Position Bar indicates the current position in
the sequence. The indicator can be moved to
change the location: left to rewind, right to
advance. The far left is the beginning of the
sequence, the far right is the end.
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Figure 5-9: The Position Bar.

To change the current position in the sequence,
drag the scroll triangle to the desired location. If
you press on the grey bar, the scroll triangle will
move to that spot. If you keep pressing, you can
drag it to a new location.

The position bar can be used during playback as
well as when the sequence is stopped.

The same applies to the Position Bar Arrows. Using
them during playback is called “cueing”. The right
set of arrows cues forward in time, the left set cues
backwards. The smaller arrows cue slowly, the
larger ones cue faster. The left arrows cause
playback to pause while cueing backwards until the
arrow is released. If used during recording, the
Record button will be turned off before cueing. The
Position Bar can also be used while the Pause
button is on during playback. If Audible Mode is
turned on, these arrows will “scrub” the music. For
more information, see “Scrubbing” on page 91.

The Position Bar can be used to find a relative
location in a sequence. It may not be useful for
finding exact locations (use the Counter or
Markers instead) but is perfectly suited for finding
the beginning and end of a sequence: simply drag
the scroll triangle to the far left or right.

Use the Position Bar to move short distances
quickly in a sequence. Since forward cueing is
audible, you can use it to accurately locate a
particular note event or region.

THE MEMORY BUTTONS
The Memory buttons (Auto-Rewind, Auto-Stop
and Memory-cycle) allow you to automate the
primary motion controls. By using the Memory
buttons, you can program the motion controls to
activate at times specified in the Status Strip.

The Auto-Stop button
Enabling the Auto-Stop button causes playback of
the sequence to automatically stop at the Stop
location on the Memory Bar. Clicking on the Auto­
Stop button enables it; when enabled, it is
highlighted.

Figure 5-10: The Auto-stop button.

Clicking on the Auto-Stop button causes the
Memory Bar to appear if it is not already present.

The Memory-cycle button and the Auto-Stop
button cannot be enabled at the same time.

The Auto-Rewind button
Enabling the Auto-Rewind button causes the
sequence to automatically rewind to the Start
location on the Memory Bar. This occurs when the
Stop button is pressed or when playback reaches
the end position in the Memory Bar in Auto-stop
mode. Clicking on the Auto-Rewind button
enables and highlights it.

Figure 5-11: The Auto-rewind button.

Clicking on the Auto-Rewind button causes the
Memory Bar to appear if it is not already present.

Auto-Rewind is useful for returning to a particular
location after stopping. It saves you from having to
stop and rewind manually.

THE MEMORY-CYCLE BUTTON
The memory-cycle button is a cycle-playback and
cycle-recording feature that causes a region of the
entire sequence to be played repeatedly until the
stop button is pressed, just like drum machines and
hardware sequencers. Cyclic playback begins when
the sequence reaches the specified Memory-cycle
region. When the Counter reaches the end of the 
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region, it seamlessly returns to the beginning and
will continue to do so until you press the stop
button, unhighlight the Memory-cycle button, or
cue past the end time.

Figure 5-12: The Memory-cycle button allow you to seamlessly cycle
any portion of a sequence or song.

Use Memory-cycle for multiple consecutive
playbacks of a particular region. This can be very
useful for cycle-recording a loop section or drum
pattern, mixdowns, rehearsing a part that you plan
to record, or for scrutinizing a particular region of
a performance.

When cycle-recording, you add a new part to the
loop with each consecutive pass. Before doing so,
be sure Performer is in overdub record mode so
that each new pass doesn’t erase the last one.

You can also record successive takes when cycling.

If you want to permanently loop a region in one or
more tracks and specify the number of times the
loop will repeat, insert a loop as described in
chapter 30, “Looping”.

Click on the Memory-cycle button to enable it.
This highlights it, and causes the start and end
times to appear in the Memory Bar if they are not
already present. The next section discusses several
ways to set the start and end times.

The Memory-cycle button and the Auto-Stop
button cannot be enabled at the same time.

Viewing Memory-Cycle points graphically
When Memory Cycle is enabled, the start and end
times appear numerically in the Memory bar just
below the Memory buttons. They also appear
graphically as repeat barlines in the Time Ruler of
the Tracks Overview and Graphic Editing windows
at the start and end time as shown Figure 5-13.

Playback cycles between these points seamlessly.
You can drag the repeat barlines left and right with
the mouse to change the cycle points. If the edit
resolution check box is checked, the barlines snap
to the current resolution setting (such as 8th notes,
for example) as you drag them. For an explanation
of edit resolution, see “The Edit Resolution Box”
on page 160.

o

Chunk:*.

Edit resolution

.3 4„i

Memory-cycle
button is activated. 

Set Start to Counter
Set End to Counter

Memory bar start and end times are
displayed here.You can change them by
typing, dragging their values up/down,
or by loading times with the pop-up

menu shown to the right. ------------------

Repeat barlines are displayed in all time rulers.They can be 
dragged left and right; when you drag them in the Graphic
Editing, they snap to the current edit resolution.
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Figure5-13:Playback and recording loop seamlessly between the
Memory-cycle start and end markers, which you can drag with Edit
Resolution ('snapping') turned on or off.

I THE CONTROL PANEL
43



You can adjust the cycle points at any time, even
during playback. This lets you build patterns and
other tasks without ever having to stop the music.

Setting Memory-cycle points
The Memory-cycle region is defined by the start
and end times in the Memory Bar. You can set these
points by:

■ typing (use the tab key as usual)

a dragging on the numbers vertically

■ choosing the desired command from the
Memory Bar pop-up menu

■ using several clicking shortcuts

■ loading them with remote controls

■ loading them with the Remembered Times
remote control

These same techniques are also used in the
Selection Bar, and they are described in detail
“Using the Selection Bar” on page 74.

Figure5-14:Setting Memory-cycle points with the shortcuts in the
Memory Bar pop-up menu.

SIM
| Memory :|2|1|000 14111000 1? 1 Chunk: V«.

EWSsflSllSliSES!!
Set to Chunk Bounds
Set Stirt to Counter
Set End to Counter

To set the times to the current selection bounds:

1 Set the Edit resolution in the time ruler.

If you want the end points to land directly on beat
or measure boundaries, the easiest way to do so is
to set the edit resolution to an appropriate value,
such as eighth notes or quarter notes. If you want to
be able to set the loop points with no constraints
whatsoever, uncheck the edit resolution box.

2 Drag over the desired region in any time ruler.

3 Highlight the Memory-cycle button if it is not
already highlighted.

4 Choose “Set to Selection Bounds” from the
Memory bar pop-up menu.

The region is loaded into the Memory start and
end times. In addition, the Memory-cycle repeat
barlines appear in the time rulers at the beginning
and end of the region you highlighted. Now
Performer will cycle between them during
playback and recording.

Selecting the Memory-cycle region for editing
If you would like to quickly select the region within
the Memory-cycle repeat barlines to insert a loop,
quantize, or any other editing operation, click one
of the two repeat barlines.

*», BatstU
ICj Start: 2|l|000 End: 4111000 | lj Uml » J

Figure 5-15: Selecting what is being cycled by clicking one of the
Memory-cycle markers.

THE COUNTOFF BUTTON
Enabling the Countoff button causes a countoff of a
specified number of measures before playback or
recording. The Counter does not move forward
until after the countoff. Clicking on the Countoff
button enables and highlights it. You must enable
the Click (in the Basics menu) to hear the countoff.

2
BARS

Figure 5-16: The Countoff button produces any number of bars of
countoff that you wish.

To set the number of countoff measures, either
double-click or Option-click on the Countoff
button. A dialog box appears in which you can
enter the number of measures and specify whether
the countoff should occur only when recording. If 
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the Countoff only when recording option is chosen,
there will be a countoff before recording, but not
before playback or any other function.

The countoff bars are in the same meter as the first
measure of the sequence. See chapter 28, “Change
Meter” (page 331) for information on changing
meters.

Use the Countoff button to give yourself time to
adjust to the current tempo and prepare for
recording. Using the Countoff and Wait buttons
allows ample preparation for a recording pass; this
is particularly useful in situations where the
computer and keyboard are not adjacent.

For an indefinite countoff (the countoff keeps
going until you start playing), turn on the Wait
button (discussed in the next section) at the same
time as the countoff button.

THE WAIT BUTTON
Enabling the Wait button causes Performer to wait
until it receives a keystroke (or any other MIDI
event) from a MIDI or Macintosh keyboard before
playback or recording.

Figure 5-17: The Wait button causes Performer to wait for a keystroke
(from either a computer or MIDI keyboard) before it begins to play or
record.

To enable the Wait button, click on it; it will
highlight. Then, press either the Record or Play
buttons. The wait button will then begin to flash,
signaling that it is waiting for a keystroke. To start
playback or recording, press a key on the
Macintosh keyboard or your MIDI controller
instrument. If recording is enabled, the MIDI event
you send to turn off Wait will be recorded.

The Wait button will remain enabled until it is
clicked off. Thus, it will be in effect every time the
Record or Play button is clicked on.

Use Wait to give yourself a moment to ready
yourself at your keyboard or other input
instrument before recording. Using Countoff and
Wait together allows you as much time as you need
to prepare for recording.

While the Wait button is on, you can use the
Rewind button, Position Bar, and Counter window
to adjust the current playback location. You may
also set times in the Edit, Memory, and Auto­
Record bars.

If you turn on the Wait button together with the
Countoff button, you create an indefinite countoff
— the countoff keeps going until you start playing.

THE AUTO-RECORD BUTTON
Auto-Record causes recording to automatically
turn bn and off in a specific region. This allows you
to record without having to manually enable and
disable the Record button.

Figure 5-18: The Auto-Record button allows you to precisely program
punch-in and punch-out points for recording.

Clicking on the Auto-Record button enables and
highlights it. Clicking on the Auto-Record button
also causes the Auto Record punch in and punch
out times to appear in the Status Strip. Punch in
and punch out times are specified in the Auto
Record Bar: Punch in is the time where recording
begins; Punch out is where recording ends. Auto­
Record can be used while Performer is slaved to
external sync; see chapter 39, “Receive Sync”
(page 387) for details on recording while slaved to
each type of sync.

The Auto-Record button will remain on until you
click on it again to disable it. Remember to disable
it when you finish using it.
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Viewing the punch-in and punch-out points
graphically
When Auto-Record is enabled, the punch-in and
punch-out times are displayed graphically as
arrows in the time ruler of the Tracks Overview, as
well as the time ruler in any Graphic Editing
window as shown in Figure 5-19.

You can drag the arrows left and right with the
mouse to change the punch-in and punch-out
points. If the edit resolution check box is checked,
the arrows snap to the current resolution setting
(such as 8th notes, for example) as you drag them.
For an explanation of edit resolution, see “The Edit
Resolution Box” on page 160.

You can adjust the arrows at any time, even during
playback or recording. This lets you adjust punch­
in and punch-out on the fly without having to stop
the music.

Setting the punch-in and punch-out points
The Auto-Record region is defined by the in and
out times in the Auto-Record Bar. You can set these
points by:

■ typing (use the tab key as usual)

■ dragging on the numbers vertically

■ choosing the desired command from the Auto­
Record Bar pop-up menu

■ using several clicking shortcuts

■ loading them with remote controls

■ loading them with the Remembered Times
remote control

These same techniques are also used in the
Selection Bar, and they are described in detail
“Using the Selection Bar” on page 74.

Quickly selecting what you have recorded
You can quickly select the region between the
punch points by clicking one of the arrows. This is
a handy shortcut for editing what you have just
recorded with auto-record.

Auto-record button
is activated.

Auto Red:13111000 17111000 F I

Set tc> Chunk Sounds
Set Start to Counter
Set End to Counter

Auto-record bar start and stop times are
displayed here.You can change them by
typing,dragging their values up/down, or
by loading times with the pop-up menu ■
shown to the right.

Figure 5-19: Punch-in and Punch-out points are depicted graph­
ically with the Auto-Record markers, which you can drag with
Edit Resolution ("snapping") turned on or off
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THE CHUNK CONTROL BUTTONS
The Skip Forward and Backwards buttons play­
enable the next or previous Chunk (sequence or
song) listed in the Chunks window. The Cue
Chunks button play-enables the next Chunk in the
list after the current Chunk plays to its end time
and stops. The Chain Chunks button causes the
next Chunk in the list to automatically begin
playing when the current Chunk finishes playback.

Chaining using the Controls window
The Chunk cueing buttons in the Controls window
allow automatic and real-time cueing of Chunks,
and automatic playback of cued Chunks. The Cue
Chunks, Chain Chunks, and Skip Forward and
Backwards buttons let you play Chunks from the
Chunks window, moving up or down the list at
your command.

Chunk cueing does not yield seamless transitions
between Chunks. Use them for cueing situations
where a pause between Chunks—either brief or
indefinite—is acceptable or preferred.

For example, the Chunk Controls buttons are
perfect for live performance. Before a set, you
could organize the Chunks list in the order you
wish for the set. Then, before you begin, you could
enable the Wait button. To begin the set, you simply
press play. When the first song ends, the next song
automatically cues up, and you can trigger it at
your leisure from your MIDI keyboard. Or,
without the Wait button, you can have Performer
go right into the next song without waiting.

It is also possible to cue and play Chunks remotely
from your MIDI controller. For more information,
please refer to The Remote Controls Window
chapter.

the current Chunk will stop playing and the next
Chunk will be cued. This time appears
automatically when a Chunk is cued; it
corresponds to the Chunk’s End time in the
Chunks window.

You can edit the Memory Bar time by clicking it,
but this change lasts only until the next Chunk is
enabled. If you wish a different End time to appear
in the Memory Bar automatically for a particular
Chunk, pop-edit the End time in the Chunks
window. Simply click the Chunk name and choose
Auto/manual end time from the Chunks window
mini-menu. The time becomes bold and editable.
Remember that the End time only affects a sequence’s
playback length when using the Chunk control
buttons, not when the Chunk is played as part of a
song.

The Cue Chunks button
The Cue Chunks button, when highlighted, play­
enables the next Chunk in the Chunks list after the
current playback Chunk reaches its End time and
stops.

Figure 5-20: The Cue Chunks button makes Performer play-enable
the next sequence or song in the Chunks window when it reaches the
end of the current one.

To begin playback of the next Chunk, press the Play
button, or a remote control for the Play button.

The Chain Chunks button
The Chain Chunks button, when highlighted,
starts playback of the next Chunk in the list after
the current playback Chunk reaches its End time.
This is a simple way of automatically chaining
Chunks in their Chunks list order.

Clicking either the Cue Chunks or Chain Chunks
button causes the Memory Bar to appear in the
Status Strip. The Stop time displayed in the
Memory Bar indicates the measure time at which

Figure 5-21: The Chain Chunks button makes Performer cue up and
start playing the next sequence or song in the Chunks window when
it reaches the end of the current one.
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Chaining with this button does not yield seamless
transitions between Chunks. Use it for cueing
situations where a brief pause between Chunks is
acceptable or preferred. For seamless chaining,
assemble Chunks in a Song window. For more
information, please refer to the Song window
chapter.

Viewing the Chunk End Time
When the Cue Chunks or Chain Chunks button is
highlighted, the end time of the sequence is
graphically displayed as a final barline in the time
ruler of the Tracks Overview or any Graphic
Editing window.

ot>
Figure 5-23: When you have multiple sequences in Performer file, the
Skip buttons work like the skip buttons on a CD player: the play­
enable the next or previous sequence or song in the file.

THE STATUS STRIP
The Status Strip has three segments that display
information. The left-hand segment displays the
name of the file. The middle segment contains the
Memory and Auto record bars, which contain
locations for Memory functions and Auto-Record.
The right-hand segment displays the currently
play-enabled Chunk.

The Skip Forward and Backwards buttons
The Skip buttons enable the next or previous
Chunk for playback. Clicking these buttons is
similar to pressing the skip buttons on a typical
compact disc player: Performer stops playback of
the current Chunk and starts playback of the next
or previous Chunk. Chaining Chunks in this
manner does not yield seamless transitions
between Chunks. To chain Chunks seamlessly,
chain them inside a song as described in the Song
Window chapter.

The Memory and Auto Record Bars
The Memory and Auto-Record bars appear in the
Status Strip when you click one of the memory
buttons or the Auto-Record button. These bars are
displayed only when their respective function is
enabled. For example, the Auto-Record bar is only
visible when Auto-Record is enabled. If both are
enabled, both bars will appear in the Status Strip.

Figure 5-22: When either the Cue Chunks or Chain Chunks
button is activated the end of the sequence is graphically
depicted with the end barline marker, which you can drag
with Edit Resolution ("snapping") turned on or off.
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The Memory Bar
The Memory Bar displays the start and stop times
for Auto-Stop, Auto-Rewind, and Memory-cycle
(see above). To deactivate the Memory Bar, turn off
the currently enabled Memory button by clicking
it.

| Memory : HJ11000 | 5|1|000 £1 |

Figure 5-24: The Memory Bar.

For details about editing the start and end times in
the Memory bar, see “Setting Memory-cycle
points” on page 44.

The Rewind button works differently when the
Memory Bar is visible: clicking on the Rewind
button once will rewind to the Start time in the
Memory Bar; clicking on it again will rewind to the
beginning of the sequence.

Memory bar times can also be loaded by selecting
the region graphically. See “Setting Memory-cycle
points” on page 44.

The Auto Record Bar
The Auto Record Bar will appear when the Auto
Record button is enabled. When it is visible, Auto
Record is in effect.

[ Auto Rod;[2|11000 |4|1|000 £] |

Figure5-25: The Auto-record bar lets you set precise, automated
punch-in and punch-out points during recording.

You can enter the start and end times numerically
in the Auto Record Bar. See “The Memory and
Auto Record Bars” on page 48. You can also set
them up graphically. “Viewing the punch-in and
punch-out points graphically” on page 46.

The Remember Times remote control (control-R),
allows you to save any time range selection, so that
you can load it into the Auto-Record bar later on.
You can also load remembered times into the

Selection bar and the Memory-Cycle bar. For
complete information, see “The'Remember Times’
Remote” on page 212.

MACINTOSH KEYBOARD CONTROLS
The main Controls window functions can be
operated from the numeric keypad on the
Macintosh extended keyboard.

In addition, the space bar acts as a play/stop toggle.
These key assignments are provided for your
convenience. However, you can create your own
customize key assignments using the Remote
Controls window. Please refer to the chapter called
The Remote Controls Window for more
information.
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THE METRONOME PANEL
The Metronome panel displays the tempo and
meter of the currently play-enabled Chunk
(sequence or song).

beat Tempo control
value button

I J
Tempo control: Tempo slider

E4E J| = | 133.12 bpm| -.
Cunent I Current

meter Tempo slider Tempo

Figure 5-27: Performer's Tempo Controls give you real time control of
the tempo, as well as tempo programming (via the Conductor Track)
and remote control of tempos from any MIDI source, such as the mod
wheel on your con trailer keyboard.

The Tempo Control button
Tempo can be controlled by one of three possible
sources: 

■ The Tempo slider

■ The Conductor track

■ By remote control from an external MIDI
controller, such as a modulation wheel

The Tempo Control button displays the current
tempo source. Press on it to change it. You can
change the tempo source at any time, even during
playback, and the tempos you set in each mode are
remembered. In addition, the tempo control
settings are saved with each Chunk.

Tempo slider
When the Tempo Control is set to Tempo Slider,
you can change tempo by entering a value in the
tempo box in the Metronome window or by
dragging the slider with the mouse or by pressing
the + and - buttons. Tempo is expressed in beats
per minute (bpm). Any programmed tempo
changes (the tempo map) are ignored. You control
the tempo directly with the tempo box and slider.

This mode is useful for Chunks with one constant
tempo or for temporarily adjusting tempos when
working on a Chunk.

Conductor Track
When the Tempo Control is set to Conductor
Track, you cannot use the tempo box or slider to set
the tempo. Instead, the tempo map in the
Conductor track takes control of the Chunk. In this
mode, the tempo slider is merely an indicator of the
current tempo; the plus/minus buttons become
disabled and you cannot change the tempo or beat
value directly.

To hear tempo changes that you create with the
Change Tempo command or by using Tap tempo
sync, set the Tempo Control to Conductor Track,
where programmed tempo changes and tempo
maps are stored.

Remote control of the tempo
When the Tempo Control is set to Remote Control,
the tempo slider can be controlled from an external
MIDI source such as a modulation wheel on a
MIDI keyboard, or any other source of continuous
controller data.

To set up the Tempo slider for external MIDI
control:

1 Choose Remote Control from the Tempo
Control pop-up menu.

2 Choose Set Remote Source from the Tempo
Control pop-up menu.

A dialog box appears.
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Figure 5-28: The Set Remote Source feature allows you to control
Performer's tempo dynamically, during playback or recording, with
an external MIDI source, such as the mod wheel on a keyboard.

3 Select the MIDI device from which the external
control data will be received from the pop-up
menu provided.

4 Select which type of MIDI data will be used to
control the slider.

Modulation wheels send controller #1.

5 Click OK to confirm your choice or Cancel to
withdraw the command.

The current meter display
The meter at the current location is displayed for
your reference. To change meter, you must use the
Change Meter command on the Change menu.

The beat value
The beat value is the note duration that “gets the
beat” in a given meter. In 4/4, for example, the
quarter note usually gets the beat: in this case, the
beat value is a quarter note. In 6/8, the beat
generally falls on the first and fourth eighth notes
in the measure, thus the dotted quarter is the beat
value.

The beat value you set does not necessarily
correspond to the value you set for the metronome
click. The metronome click value is set when
specifying the meter with the Change Meter
command on the Change menu. For example, in 6/
8 meter, you may set a tempo of an eighth note =
220, but, set the metronome click to a dotted 

quarter note (standard in 6/8 time). Quite often
though, the beat value will be the same as the meter
denominator (the lower number of the meter
marking).

The tempo slider
When the Tempo Control pop-up menu is set to
Tempo Slider, the tempo slider is used to display
and change the tempo. To change tempo, drag the
triangular indicator along the slider: to the left
decreases the tempo, to the right increases it. You
can also use the plus/minus buttons at either end of
the slider: the + (plus) button increases the tempo
and the - (minus) button decreases it.

When the Tempo Control pop-up menu is set to
Conductor track, the tempo slider serves only as an
indicator of the current programmed tempo; it
cannot be dragged with the mouse.

The current tempo
By default, tempos are displayed in beats per
minute (bpm). The beat value can be any standard
musical duration between a sixteenth and whole
note. All beat values can be dotted. A dotted value
is equivalent to one and a half times the value of the
duration. (A dotted quarter note is equivalent to
one and a half quarter notes, for example.) Tempos
are displayed and entered with an accuracy of a
hundredth of a beat per minute. This allows you to
specify tempos with two numbers to the right of
the decimal point, e.g. 104.78 beats per minute. In
addition to providing you with a high degree of
resolution, this also allows you to easily enter
tempos that match standard frame click
metronome values.

When the tempo slider is controlling tempo, you
can enter the tempo directly into the Current
tempo box. To change the tempo, click the current
tempo box to edit the tempo. If necessary, click the
current beat value to change it.
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Displaying and typing in frame-click tempos
If you write music for film, you might be
accustomed to expressing tempos in frame-clicks
as well as beats per minute. In Performer, you can
type in tempos using either format. If you enter a
frame click tempo, such as 12-6, Performer will
automatically convert it to beats per minute—at an
extremely high degree of resolution (well beyond a
hundredth of a bpm). You can freely switch
between the two formats. If you prefer to view
frame-click tempos throughout Performer, you can
do so by setting the Display Preferences in the File
menu accordingly.

i empo snaer . i tJinpu s-nuer

^*112.94 bpm

Figure 5-29: You can type in tempos in Performer in frame dicks
(using either a dash or a slash). Performer will convert the click tempo
to beats per minute at a very high degree of resolution. Use the
Display Preferences in the File menu if you want to see frame clicks all
the time.

Pitch Display
® Standard pitch (middle C = ’C3’)
O Alternate pitch (middle C = ’C4‘)
O MIDI key number (middle C = ’60')

Tempo Display
® Beats per minute (120 bpm = ’120.00')
O Frame click with slash (120 bpm = T 2/0’)
O Frame click with dash (120 bpm «* ’12-0')

SJl&'lflt |fs|.Conductor (Seq-1)
1111390 J = 14-3
1121020 J = 12-7

m
s_

__
__

__
_

Lu1121060 J = 12-4
1121120 J ° 11-7
1|2|I6O J = 11-5
1l2|220 J 11-2
1121260 J = 10-7
1121300 J = 10-5
1121360 J = 10-3
1121420 J = 10-0
1121460 J = 9-6
1131020 J = 9-5
113’030 J = 9-3
IBU60 J =9-2
113)220 J » 9-0
1131260 J = 8-7
ii;ix?.o j.e-s__________________________________

Figure 5-30: Set the Display Preferences (in the File menu) as desired
to determine how tempos are displayed throughout Performer.

Tempo Control during external
synchronization
When Performer is slaved to external sync using
the Standard MIDI beat clocks mode, the master
device generates the tempo. The tempo slider acts
solely as an indicator in this case: the master device
(drum machine, a hardware sequencer, etc.) has
complete control over Performer’s tempo, and the
tempo control displays the phrase MIDI Sync to
remind you that the Tempo slider is disabled
because tempos are being generated externally by
the master device:

Tempo control: MIDI Sync

~ I ~ bPm

Figure 5-31: When Performer is slaved to external sync via MIDI Beat
Clocks, the Tempo Control menu, slider handle and current tempo
settings are temporarily hidden to indicate that tempo is being
controlled by the incoming MIDI sync data.

When synchronizing to time code (such as
SMPTE) using the Indirect or Direct lock modes,
Performer follows its own internal tempo. Set the
desired tempo in the normal fashion, or set the
Tempo Control pop-up menu to Conductor track to
use a tempo map you have programmed into the
Conductor track.

When synchronizing to Tap tempo sync, you
control the tempo in real time by tapping (sending
a MIDI event to Performer), using any MIDI
controller. For details on creating a tempo map
using Tap tempo sync, refer to the chapter Receive
Sync. When you choose Tap tempo and check the
Slave to external sync command in the Basics
menu, the Tempo slider is disabled and it reminds
you why:
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Tempo control: Tap Tempo

jJ-I “bpm

Figure 5-32: When Performer is slaved to external sync via Tap Tempo,
the Tempo Control menu, slider handle and current tempo settings
are temporarily hidden to indicate that tempo is being controlled by
the incoming Tap Tempo events.

Performer automatically adjusts real time and
frame locations when the current tempo is
changed.

THE COUNTER
The Counter displays the current playback
position in the currently play-enabled Chunk
(sequence or song), expressed in three different
forms: measure time (measure|beat|tick), real time
(minutes:seconds.hundredths) and frame time
(hours:minutes:seconds:frames). Two of these
formats can be displayed at the same time: one as a
main counter and the other as an auxiliary counter.
These time standards are explained in detail in the
next few sections.

You can edit the counter fields to change the
current location. You can change which time
formats are displayed by clicking the time format
icons.

Measure Time
Measure time is the most musical of the time
formats. Locations are displayed in standard
measures and beats, with an additional unit called
the tick. Unless you are doing film or video work, it
is probably the only time representation you will
need (though you may want to use real time for an
objective measurement of the length of your
sequence) .The three units are separated by vertical
bars. The example shown below shows measure 4,
beat 3, tick 130.

r 4Bn3a»

Performer uses a resolution of480 ticks per quarter
note. Events can thus be recorded and played back
with an accuracy of 1/480 of a quarter note.

Real Time
Real time is clock time, i.e. time expressed in
minutes:seconds.hundredths of a second. Real
time is useful to measure elapsed time for your
sequence. By default, the sequence begins at time
0:00.00; this can be changed with the Set Sequence
Start command described later in this chapter.

I . owH
Frame Time
Frame time is a visual display of SMPTE (Society of
Motion Picture and Television Engineers) time
code. It is generally used in film and video work,
but is increasingly used for synchronization in
audio production. It is displayed similarly to real
time, in hours, minutes, seconds, and frames.
Frames are subdivisions of a second. The first
frame number in a second is zero. Performer
supports four frame formats: 24 frames per second
(fps), 25 fps, 30 fps, and 30 drop frame.

rasaSSS
When synchronizing to an external time code
source, the counter will always display the same
frame time that is being received from the external
source. You may specify the SMPTE location at
which the first measure of the sequence or song
starts.

Using the Counter to change the current
playback location
The current playback location is the position where
the Chunk will next play or record from. You can
edit the counter fields to change the current
location.
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You can change the current location in the
currently play-enabled Chunk (sequence or song)
by editing the counter numbers. This can be done
while the Chunk is stopped or playing. If you edit
the counter while the Chunk is playing, it will
continue to play while you enter the values and will
cue to the new location after you confirm your edit.
To edit the counter:

1 Click on the time value you wish to change.

The number field will highlight.

Setting the Counter Display
To change which time format is shown in the Main
or Auxiliary Counter, click the time format button
in the right-hand side of the Counter.

E

Figure5-33: Use the Time Format buttons to choose which of
Performer's three time formats you would like to display in the
counter.

2 Enter the number you want.

You can only enter valid values (e.g. you can’t enter
27 frames if you’ve chosen a 25-frame standard).
Use the Tab key to move from one value field to the
next. The decimal point on the keypad can also be
used to cycle through fields. If you make a mistake
in entering a value, press the delete key or click on
the field again and re-enter the value.

3 Click outside the highlighted number field or hit
the Return key.

Using the decimal key or Command-T to edit
SMPTE main counter
The decimal key on the Mac keypad will now
highlight the main counter, even if it is SMPTE
time or Real time.

There is a shortcut for setting the measure time:
using command-T or the decimal point on the
keypad will select the measure field and set the beat
field to 1 and the tick field to 000. You may then
enter the number of the measure you want to move
to. As soon as you click outside the highlighted field
or press the Return key, the specified value will be
entered.

These keys will always edit the main counter, even
when it is set to SMPTE time or Real time.

The Counter displays dashes when no sequence or
song is play-enabled in the file. To display
numbers, play-enable a Chunk in the Chunks
window.

During playback, the measure time counter is
updated each time a metronome click would occur.
If the click value is set to a half note in 4/4 time,
only beats 1 and 3 will display in each measure. The
click value can be set with the Change Meter
command on the Change menu.

Setting the start time
The start time of the sequence is what you see in the
counter when you rewind to the very beginning.
Normally, the default start time for a sequence or
song is measure time 1111000, real time 0:00.00 and
frame time 0:00:00:00.

You can, however, use the Start Time button to
change these start times to anything you want.

Figure 5-34:The Start Time button allows you to choose the start
time at the beginning of the sequence for all of Performer's time
formats.
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If you are synchronizing Performer to SMPTE time
code, you’ll need to set the SMPTE start time
according to SMPTE frame at which you want the
Performer to begin playing. For example, you may
want the downbeat of the first measure in the
sequence to begin playing when the time code
reaches 1:00:20:00.

The following are other examples of situations in
which you might want to change the sequence start
time:

■ You would like to create one or more pickup
measures before measure 1 (1| l|000).

■ Your sequence should begin with a measure time
other than measure 1 to match its location in a
song. (For more information, see “Matching chunk
start times with their location in a song” on
page 313.)

The start times you enter for measure and real time
are arbitrary and only affect the display of time
locations. The SMPTE time code start time,
however, determines the frame at which the
sequence will actually begin playing while
Performer is slaved to external time code.

To set the start times of a sequence or song:

1 If you have more than one sequence or song in
the file, make sure it is the currently play-enabled
chunk.

To do so, look at the current chunk indicator in the
Control Panel. If you need to switch sequences, use
the Skip buttons.

i | Chunk: Seq-1

/ . - - - ■ ■ ■

JC4
A#7 <d>

Figure 5-35: The current sequence name is always displayed in the
information bar.

2 Click the Start Time button in the main counter.

A dialog box appears. The current Chunk name is
displayed near the top of the dialog box.

Figure 5-36: The Set Chunk Start dialog lets you choose completely
different start times for each of Performer's three time formats. This is
where you determine the sequence's SMPTE start time (offset).

3 Click on the value(s) you wish to change.

4 Enter the new value(s).

You may enter a value for each of the three time
formats. Measure values range from -9999 to 9999.
Real time ranges from 0:00.00 to 59:59.99. Frame
time ranges from 0:00:00:00 to 23:59:59:30.

5 Click on OK to confirm your choice or Cancel to
cancel it.

Using SMPTE timecode bits
In addition to the start frame, you may offset the
SMPTE start time by a number of bits. There are 80
bits per frame. Although Performer does not have
single bit time resolution, it does offer sub-frame
time resolution. Use the bit offset to finely adjust
the start time.
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Setting the SMPTE frame rate
The SMPTE frame rate can be set with Receive
Sync command in the Basics menu. See “Slaving to
SMPTE with MTC, DTE, or DTLe”on page 391.

Creating pickup measures before 1111000
Normally, when you rewind Performer back to the
beginning of the sequence, the measure counter
reads 1111000. But sometimes you may have several
pickup beats (or measures) in your music, and you
may still want the music at measure 1 to remain at
measure 1. If so, you can create as many pickup
measures before 1111000 as you need.

To create a pickup measure:

1 As described in the previous section, set the
measure start time of the sequence to 0 to create 1
pickup measure.

If you need two pickup measures, set the Measure
start time to -1. If you need 4 bars, set it to -3.

2 Now, when you press Rewind back to the
beginning of the sequence, the Counter window
will read 0| 11000.

If you set up two or four pickup measures instead of
only one, the counter would read -1111000 or -
3| 11000 respectively.

3 If you already had data recorded in the
sequence, shift the data back to its original
location.

When you change the Measure start time, data that
used to be at 111|000 is now at 0| 11000, and so on.
All data has changed to match the new start time.
To restore all data to its original position before you
changed the start time, use the Shift command to
shift it back to where it was before.

4 Highlight all track names in the Tracks window
and double-click the word “Selection ” in the
Selection bar.

This selects the entire sequence.

5 Choose Shift from the Edit menu.

6 Choose the Later option and type in the number
of pickup measures that you previously added.

If you added 1 pickup measure by setting the start
time to 0| 11000, shift by 1 measure here.

7 Click OK.

You have now successfully restored all data back to
its original location before changing the measure
start time, and you also have several empty pickup
measures in which to record.

The accuracy of the counter display
Performer’s first priority is to keep up with the flow
of MIDI data. If it encounters a great deal of data, it
selectively ignores its graphic display until the
microprocessor load decreases. This may keep the
counters from updating and they may skip beats
during these times. This is Performer’s way of
keeping up, and does not necessarily mean that
MIDI data is being transmitted inaccurately.

A side effect of this is that the counter may not
always be accurate. It should therefore not be used
as a metronome. In general, the counter display
should not be used as a visual indication of tempo.

Controlling how often the counter updates
During playback, the measure time counter is
updated each time a metronome click would occur.
For example, if the click value of the current meter
in the sequence is set to a half note in 4/4 time, only
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beats 1 and 3 will display in each measure. The
click value can be set with the Change Meter
command on the Change menu.

Negative numbers in the counter display
When using an external sync source, Performer
may run for a little while before the sequence
actually starts. During this time, you may see
negative bar numbers. These increase in value
(towards zero) until the start measure is reached.
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chapter 6 The Tracks Window

The Tracks window is one of the most important
features in Performer: it allows you to define and
organize the contents of each sequence in your
Performer file. It is also perhaps the most powerful
and flexible window in Performer. The Tracks List
portion of the window allows you to create tracks,
assign MIDI devices for recording and playback,
select regions for editing, customize track names,
add comments, and more. The Tracks Overview
portion allows you to view, select, and edit the data
in each track.

QUICK REFERENCE
Tracks List: Displays the track names and
important information about each track: the play
channel or output device assignment, the play and 

record buttons, the current patch setting, and
comments. Option-click the track name to pop­
edit it.

Tracks Overview: Displays the contents of all the
tracks. Time is measured in one-bar columns, but
they can also be zoomed to show as much as 16
measures per segment or as little as 30 ticks.
Phrases of MIDI data are shown as blocks that
display a miniature representation of the data. The
blocks of data can be selected, dragged, duplicated,
and otherwise edited as a single object. To view the
data in a phrase, double-click, command-double­
click, or option/command-double-click to open
the Event List, Graphic Editing, or QuickScribe
notation window.

Tracks List Tracks Overview

Mvriitwttci try irmi outhit

Mg.WFOI

Uerse

Memory-cycle
end point

Track

names
Window
divider

Time zoom
buttons

Phrase of MIDI
data

Phrase of tempo

events

Solo Play-enable Selection Locate
button buttons bar menu

Selection Conductor Time Marker
pop-up track Ruler

Default patch

(sound)

Playback Sequence Marker
and scrub name well

Wiper

Sequence Audible
menu mode

button

Vivaldian
MuteGtr-GM
MellowRhodes
Deep Bass
Patch 40

Move Loop Record- MIDI Activity Output
handle Indicator enable meters devices pop-up

> | K2500-2 11 | Horns
> | 0S6-4 11 | Strings

MR-Rack-4|1

9 Accel!Verse 1

buttons menus

Figure 6-1: Performer's Tracks window and Tracks Overview.



Sequence menu: Lets you switch between
sequences. When you choose a sequence from this
menu, the Tracks List displays the tracks of the
sequence.

Audible Mode button: Turns on Audible Mode,
which makes notes play when you click them and
also makes the playback wiper “scrub” the music
when you drag it.

Solo Button: Enabling this button by clicking it
puts Performer into Solo mode. Option-click the
button to bring up the Solo Setup dialog (a
shortcut for choosing Solo Setup from the mini­
menu.)

Play-Enable button: Enables or disables a track for
playback. To toggle its play status, simply click the
button. Any number of tracks may be play-
enabled. Most commonly, all tracks will be play-
enabled. When solid blue, the track is play-enabled
and will be audible. If gray, the track will be muted
or silent. (On a black and white monitor, the colors
are black and hollow, respectively.) If muted, the
data for the track is still there; you are just “turning
off” the track during playback.

Selection Bar: Determines the start and end times
of the current selection region in any tracks whose
names are currently highlighted. Click the values to
edit them, or click the Start and End buttons to
load the current counter location into them.
(Double-click the buttons to load the beginning or
end of the sequence.) Use the pop-up menu just to
the right of the end time as a shortcut for loading
various common edit times, such as the current
counter location. There are also Remote Controls
that will load the current counter location into the
start and end time by pressing a key on your
Macintosh keyboard or keypad.

Selection pop-up menu: Contains shortcuts for
loading various useful selection regions into the
selection bar start and end times.

Set to Selection Bounds
Set to Chunk Bounds
Set St*rt to Counter
Set End to Counter i

Locate menu: Lets you jump to any marker, or
other significant points in the sequence, such as the
Memory-Cycle points or the Auto-Record punch­
in location.

Conductor Track: A special track that contains the
tempo map, meter changes, and key signatures for
the sequence. The Conductor track also contains
Markers. Data in the Conductor track can be
edited just like MIDI data in regular tracks.

Time Ruler: Displays the location of each segment
in any combination of Performer’s three time
formats: measures|beats|ticks, SMPTE time, or real
time. Double-click anywhere in the time ruler to
instantly jump playback to that location. Or move
the cursor to the top edge of the ruler and click
once. Drag horizontally to select a region. Shift­
drag to extend the selection.

Marker: An indicator that you can create to identify
an important point in the music, such as the
beginning of a section or a SMPTE hit point.
Create markers by dragging them from the marker
well at the top of the vertical scroll bar on the right.
Drag markers to move them. Command-drag
them to freely move them without snapping to
columns. Option-click or double-click the name to
change it. Option-click the marker icon to toggle
whether it is locked or not. To delete a marker, drag
it downwards until the cursor turns into a trash can
icon.

Memory-cycle loop points: These repeat barline
icons indicate the points where the entire sequence
will loop when the Memory-cycle button is
highlighted. Command-drag them to override
column snapping.
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Playback and scrub wiper: Shows the current
playback location. Double-click anywhere in the
time ruler to make the wiper instantly jump to that
location. Or move the cursor to the top edge of the
ruler and click once. Drag the wiper to “scrub” the
music (Audible Mode button in the Tracks window
title bar must be turned on for scrubbing).

Sequence Name: Displays the name of the
sequence. A Performer file can contain any number
of sequences, each with their own Tracks window.
Command-click to switch between sequences.

Marker well: Allows you to drag and drop an
unlimited number of markers anywhere into the
Time Ruler. Option-click the marker name to
rename it. Drag it left and right to move it. Drag
makers downwards until the cursor turns into a
track can to delete them.

Time Zoom Buttons: Zooms in the Time Ruler so
that each segment represents a smaller or larger
duration. For example, in the Quick Reference
diagram, each segment currently represents one
measure of music. Clicking the Zoom In button
will cause each segment to represent one quarter
note (480 ticks). Other zoom-in levels are: 240,120,
60, and 30 ticks per segment. Other zoom-out
levels are: 4,8, and 16 measures per segment.
Option-clicking zooms all the way. Command­
clicking toggles between the last two zoom settings.

Phrase of tempo events: A stream of tempo events
that creates a smooth tempo change.

Phrase of MIDI data: A series of related MIDI
events are displayed as a block so they can easily be
dragged, copied, duplicated and otherwise edited
as a single object.

Window Divider: Separates the Tracks list from the
Tracks Overview. Drag the divider left to see more
of the Tracks Overview or right to see more of the
Tracks List, comments, etc.

Default patch: Displays the name of the patch that
will initially be called up when the sequence starts
playing. This is saved with the file.

Track names: Click a track name to select the track
(or a portion of it) for editing. Option-click a track
name to rename it. Double-click or command-
double-click it to open editing windows for it. Drag
over adjacent tracks to select several at a time.
Shift-click to select tracks that aren’t next to each
other.

Take pop-up menus: Each track can have an
unlimited number of takes. A take stores the
contents of the track. If you want to keep what is
already in a track, but you want to try an alternative
version of it (either recorded from scratch or based
on the current take), choose New Take or Duplicate
Take from the Take pop-up menu. The original
data is preserved in its own take, which you can
always return to by choosing it by name from the
Take menu.

Output device: Each track has an output device (or
a combination of several devices), which can be
selected from a pop-up menu by clicking in this
column next to the track. Devices in the menu are
provided by FreeMIDI. For audio tracks, this
column displays the built-in audio outputs of your
Macintosh.

MIDI Activity Meters: Indicate the intensity of
MIDI playback coming from the track. They
monitor either note-on velocities or amount of
data. When monitoring amount of data, level
meters monitor any type of data.

Record-Enable button: Selects a track for
recording. In normal recording mode
(MultiRecord off), only one track may be recorded
into at once; when you record-enable a track, the
previous record-enabled track will be
automatically disabled. Record-Enable buttons are 
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only present if the sequence is selected for playback
in the Chunks window or it is record-enabled in a
Song window.

Loop Indicator: Shows whether a loop exists in the
track.

Move Handle: Drag up or down to change the
position of a track in the tracks list.

Track Comments: Display remarks that you can
type in for the track. To enter or change a
comment, simply click on it and enter or edit the
text. Press OK or the Enter key to confirm your
entry, or press the up or down arrow keys to
confirm your entry and move to adjacent tracks, or
press Cancel or command-period to cancel it.

TRACKS WINDOW MINI-MENU

Md MIDI Track
Add Audio Track ►
Add Similar Tracks
Duplicate Tracks

Solo Setup...
Level Meter Setup...
Columns Setup...
Phrase Setup...
Set Rulers..
Open Edit Windows...

Goto Counter
Goto...

MultiRecord
Clear Default Patch

Delate

Figure 6-2: The Tracks window mini-menu.

Add MIDI Track: Adds a track to the track list.
There is no limit to the number of tracks you can
add. Hold down the option key while choosing
Add to add more than one track at a time. New
tracks are added to the bottom of the list or just
below the currently highlighted track name.

Add Audio Track: Adds an audio track or master
fader to the track list. There is no limit to the
number of audio tracks you can add, although you
can only play back eight at a time. Hold down the
option key while choosing Add to add several
audio tracks at once. New tracks are added to the 

bottom of the list or just below the currently
highlighted track name. For complete information
on audio tracks, see the Performer Audio Guide.

Add Similar Tracks: Selecting a track or multiple
tracks and choosing this command makes a copy
of the selected tracks and their playback
assignments — but without the data in the track.
The word copy is appended to each new track’s
name. This command does not copy the data in the
track; instead, it copies only the track’s name,
playback destination and other track assignments
(default patch, etc.). Use the option key while
selecting the command to make more than one
duplicate copy.

Duplicate Tracks: Selecting one or more tracks and
choosing this command makes a copy of the
selected tracks and their playback assignments —
along with all the data in the track(s). The word
copy is appended to each new track’s name. This
command makes an exact copy of a track,
including all its data. Use the option key while
selecting the command to make more than one
duplicate copy.

Solo Setup: Calls up a dialog box that lets you
configure solo mode. Solo mode can be configured
so that muted tracks are not muted all the way.
Instead, their volume is brought down part way by
reducing their note-on velocities by a percentage
that you choose. See “‘Partial-solo’ mode” on
page 72 for details.

Level Meter Setup: Provides several different ways
to configure the level meters. See “Configuring the
MIDI Level Meters” on page 82.

Columns Setup: Lets you choose which columns to
show and hide in the Tracks list.
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Phrase Setup: Lets you choose how phrase blocks
are displayed in the Tracks Overview, and gives you
several options for speeding up Tracks Overview
redrawing.

Set Rulers: Allows you to configure the Time Ruler
in any combination of Performer’s three time
formats: measures|beats|ticks, SMPTE time, or real
time. The main ruler is displayed lowest.

Open Edit Windows: This is the same as double­
clicking a track to open its Event List window (or
whatever Edit window you’ve chosen in the
Preferences command).

Goto Counter: Scrolls the graphic display to the
time currently displayed in the Counter. The
counter location will appear at the left-most
position in the window.

Goto: Scrolls the graphic display to a time you
specify, which will appear at the left-most position
in the window.

MultiRecord: Enables MultiRecord mode. In
MultiRecord, more than one track can be record
enabled at a time with a separate record channel for
each one. To disable MultiRecord mode, choose
the MultiRecord menu item to uncheck it.

Clear default patch: Removes the default patch
assignment in the Default patch column for the
currently selected tracks.

Delete: Removes the currently selected tracks from
the Tracks window.

TRACKS WINDOW BASICS
A track in Performer stores a series of MIDI events
within a sequence. Each sequence contains its own
set of tracks. Performer allows you create as many
tracks as you like, each holding a separate stream of
MIDI events. The only limitation to the number of 

tracks is the amount of random access memory in
your computer. (We’ve seen some sequences with
over 300 tracks!)

The Tracks window can also have audio tracks,
which store any audio signal recorded using the
built-in sound hardware in your Macintosh. For
more information about recording audio, see the
Performer Audio Guide.

The Conductor Track is the exception; it stores
meter, key, tempo, and marker information. For
more information, see the chapter 26, “The
Conductor Track” (page 319).

In Performer, MIDI data is stored in the track
without channel information. Instead, each track
in Performer can be assigned to one or more MIDI
channels. During playback, or while recording
using the auto-channelize Patch Thru feature, the
MIDI data in the track is sent out through the
assigned channels. Any MIDI instrument that is
listening to (receiving on) that same channel will
respond to the MIDI information it receives.

In summary, a sequence is a set of tracks that are
displayed in the Tracks window. Each track has a
MIDI channel assignment consisting of one or
more channels. The data in the track is played on
whatever the playback channels the track is
assigned to.

Making the Tracks Window Display a Different
Sequence
You can create an unlimited number of sequences
in a Performer file. (The next section explains how
to create them.) You can make the Tracks window
display any sequence you want by choosing it from
the Sequence pop-up menu show below. Doing so
causes Performer to display the sequence’s tracks in
the list; in addition, the sequence name is displayed
in the title bar of the Tracks window. It also play-
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enables the sequence being viewed. If the Tracks
window is displaying a sequence that is not play-
enabled, then this pop-up will appear blank.

The Sequence

pop-up menu

V|!6|£ 1 S|th|'S I j

Seq-1 1 *r| Verse 1 t-|
Selection: Start![ 1111000 ’ End] i 138111000 Xl

fi

Fl7!”

LEV 1 FLIW] CUTFUT________| THKCI HACK NAME |
_ 1__ |__________ |1__ | Conductor
1—| >|X5DR-1___ 11 j Hammond
s—I >IK2500-7 11

_2j^dxlrzl.

Figure 6-3: The Sequence pop-up menu lets you display a different
sequence in the Tracks window.

Using the Title Bar to Switch Sequences
You can also use the Tracks window title bar to
change which sequence is displayed. To do so, just
command-click the sequence name, in the Title bar
as shown below. Note, however, that this method of
switching sequences is slightly different than using
the Sequence pop-up menu as described above
because it doesn’t play-enable the sequence; it only
switches the display. If you want to hear the
sequence you are switching to, use the Sequence
pop-up menu.

Uerse 11
int •Zlntro 1

Chorusr. 1

If 1 Uerse zj
1

Figure 6-4: You can also switch the sequence being displayed in a
Tracks window by command-clicking the title bar.

Creating New Sequences in the Tracks Window
When you first open a new file in Performer by
selecting New from the File menu, it contains a
single empty sequence named “Seq-1 ”, which is
displayed in the Tracks window. You can use the
Sequence pop-up menu to create other new
sequences. Just choose either New Sequence or
Copy Selection to New Sequence from the
sequence pop-up menu. (Also see “Separating Out
Data Into Its Own Sequence” on page 81.)
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Figure 6-5: The Sequence menu also provides commands for creat­
ing, naming, and deleting sequences, as well as copying the current
selection to its own, new sequence.

Renaming and deleting a sequence in the
Tracks window
The Sequence pop-up menu shown above lets you
also rename or delete any sequence. Just choose the
sequence by name from the menu, and then choose
the desired command.

Opening two or more Tracks windows at once
As mentioned earlier, you can freely switch which
sequence is displayed in the Tracks window. If
you’d like, you can also open multiple Tracks
windows so that you can view two or more
sequences at the same time.

If you wish to open a Second Tracks window:

1 Open the Chunks window by choosing Chunks
from the Windows menu.

The Chunks window appears:

vial.mi Chunks
TVFtl fltf ‘ fHOTIMK i r»**« i coMMnqs
Wl ! 62U1000 _J.SlEl._J_____________ ft

2 Double-click the name of the new sequence you
wish to open.

A new Tracks window will appear for that
sequence. The name of the sequence will appear in
the title bar of the window.
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The Locate Pop-up Menu
The Locate menu, as shown in Figure 6-6, contains
markers and other significant locations in the
sequence. Use it to conveniently and instantly
locate to any location in the sequence.

marker, Memory-cycle loop point or Auto-Record point.

THE TRACKS LIST & OVERVIEW
The Tracks window is divided into two portions, as
shown in Figure 6-7: the Tracks List on the left and
the Tracks Overview on the right. This section
discusses the Tracks List. For the Tracks Overview,
see “The Tracks Overview” on page 77.

Tracks List Quick Reference
The Tracks List provides a list of all the tracks in the
sequence. In addition, it provides useful
information about each track, such as what MIDI
devices the track is playing on. This information is
shown in the same row as the track, as shown in
Figure 6-8.

Hiding Columns in theTracks List
Even though The Tracks List has a lot of columns of
information in it, you can completely customize
the display to suit your tastes. You can hide
columns you don’t need to look at, and you can

Tracks list Tracks Overview

Figure 6-7: The Tracks window shows the tracks list on the left and
the Tracks Overview on the right.
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' Track Columns Setuprearrange the order of the columns. For example, if
you don’t have any comments, you don’t need to
display the column.

To hide or show columns in the Tracks List:

1 Choose Columns Setup from the Tracks
window mini-menu.

As a shortcut, you can double-click any column
heading instead. The column Setup window
appears.

3 Audio voice
3 Hirne
3 Patch
3 Dofault Patch
3 Controllers Display
3 Comment

Uncheck the columns you want to hide:
3 Move trask
3 Loop
3 Record
3 Levels
3 Phy-enable

3 Output
3 Take

Figure6-9:The Tracks window is completely customizable. By
double-clicking the column headings in the Tracks list, you can open
this dialog box, which lets you show and hide columns as you wish.

2 Uncheck the columns you want to hide, and
check the ones you want to see.

3 Click OK.
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Figure 6-8: The Tracks list.
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Rearranging the order of the columns
You can rearrange the order of the columns simply
by dragging the title of the column left or right.

V<rg» 1 | _Jnfro_______
111 |OOO_ " fl ?

JLl.'jJj.; JtJ—!_______ IL 1
; J I til—I »|X5PR-1 <•

Figure6-10:You can completely customize the Tracks list. Drag
column headings to rearrange the order of the columns as desired.

See “Customizing the Tracks Window” on page 82
for an example of a more compact, customized
Tracks List.

The Move Handle
The Move Handle allows you to shift the position
of a track in the tracks list. Use it to rearrange the
tracks in an order that is most useful to you. To use
the Move Handle, press on it and drag the track
where you want it to go. A dotted outline of the
track will follow your mouse movements. The
track will be moved to the position in the tracks list
where you release the mouse. If you drag the track
above the top or below the bottom of the Tracks
List, it will scroll until it reaches the top or bottom
of the list.

The Loop Indicator
This column displays a loop icon if the track
contains one or more loops.

Activity Meters
The Activity Meters act very much like the level
meters on a tape deck: when there is signal on the
channel, the level meter registers the signal.
Similarly, at the moment the track is playing MIDI
data, the MIDI activity meter registers the
outgoing MIDI data. Level meters also register level
for audio tracks.

You can configure how the level meters operate. For
details, see “Configuring the MIDI Level Meters”
on page 82.

The Record-Enable Button
The Record-Enable button selects a track for
recording. In normal recording mode
(MultiRecord off), only one track may be recorded
into at once; when you record-enable a track, the
previous record-enabled track will be
automatically disabled. Record-Enable buttons are
only present if the sequence is selected for playback
in the Chunks window or it is record-enabled in a
Song window.

You can click a record-enable button to turn it on
or off. Or you can drag —“glide”— over the record
button column to choose the track you want to
record into. In MultiRecord mode, which allows
more than one track to be record-enabled at a time,
you can glide over the record buttons to toggle
several tracks at a time.

The Conductor Track has a record-enable button,
which is used to record tempo information while
slaved to Tap tempo synchronization. See
chapter 39, “Receive Sync” (page 387) and
chapter 40, “Tap Tempo While Slaved To Tape”
(page 401) for details on using Tap tempo to record
a tempo map in real time.

The Record Device/Audio track input
Normally, a record-enabled MIDI track will record
data from all channels. In MultiRecord mode (set
in the Tracks window mini-menu), you can record
from individual MIDI device on a particular MIDI
channel into a particular track. This lets you record
into several independent tracks from several
independent sources all at once. Each track has its
own incoming MIDI device and channel number
displayed next to its Record-Enable button.
Recording channel assignments are only present in
MultiRecord mode. See “MultiRecord Mode” on
page 97 for details.

The Recording Channels display consists of a
device name followed by a channel number. Click
them to change them. If the record device is blank, 
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click in the blank space next to the record button to
open a pop-up menu of devices. You can select only
one device and channel for each track.

For audio tracks, the Input column shows one of
the two audio inputs of your Macintosh’s built-in
audio hardware. For more information, see the
Performer Audio Guide.

The Play-Enable Button
The Play-Enable button readies a track for
playback. To toggle its play status, simply click the
button. To toggle the status of several tracks at one
time, just drag — “glide” — over their play buttons.
This is a great shortcut for toggling many tracks
quickly. Any number of tracks may be play-
enabled. Most commonly, all tracks will be play-
enabled. When blue (or solid black on a black and
white screen), the track is play-enabled and will be
audible. If gray (or hollow on a black and white
screen), the track will be muted or silent. If muted,
the data for the track is still there; you are just
“turning off” the track during playback. The Play-
Enable button turns grey when the track is
temporarily muted due to Solo mode. The
Conductor track contains no standard MIDI data,
therefore it has no Play-Enable button.

To Play-enable all tracks except for one, command
click its play-enable button. To play-enable only
one track and unplay-enable all others, option­
click the track’s play-enable button. This
convention also applies to track record-enable
buttons in Multi-record mode, the Sliders window
record-enable buttons, and the Lock icons in the
Markers window.

The Output Device(s)/Audio track outputs
The Output device consists of the name of one of
the MIDI devices in your studio followed by a dash
and a MIDI channel number (between 1 and 16). It
can also consist of several devices.

For information about how to change playback
assignments, see “Choosing a device for playback”
on page 86.

For information about how to assign a track to
more than once device at a time, see “Choosing
multiple playback devices for a single track” on
page 86.

For information about how to add, remove, or
rename devices in the list, see “Changing your
playback device list” on page 88.

For information about setting audio track outputs,
see the Performer Audio Guide.

TheTake Column
A take stores the contents of the track. Each track
can have an unlimited number of takes. If you want
to keep what is already in a track, but you want to
try an alternative version of it (either recorded
from scratch or based on the current take), choose
New Take or Duplicate Take from the Take pop-up
menu. The original data is preserved in its own
take, which you can always return to by choosing it
by name from the Take menu. Takes are great for
cycle-recording. If you’d like to try recording again
the next time through the loop, just choose New
Take from the pop-up menu. Your previous take is
saved, and a new, empty take is ready to be
recorded into. After you are done, you can either
pick the best take, or even build a final composite
take made of the best parts of several takes by
cutting and pasting.

Takes can be used with both MIDI and audio
tracks.
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Figure6-11:A take stores the entire contents of a track. Takes are
great for recording multiple versions of the track. You can create an
unlimited number of takes for each track.

The Take column pop-up menus have several
commands to help you manage your takes:

New Take
Creates a new, empty take for the track.

Rename Take
Let’s you rename the current take. The current take
is the one with the check mark next to it in the top
portion of the menu.

Duplicate Take
Creates an exact duplicate of the current take,
including all of the data in the track. The current
take is the one with the check mark next to it in the
top portion of the menu.

Delete Take
Gets rid of the current take.

Delete all except‘current take’
Gets rid of all takes except the current take.

Takes Interact with Multiple Mixdowns
See “How mix mode impacts your sequencing” on
page 136 for an important discussion about how
working with Multiple mixdowns in the Mixing
Board interacts with takes.

Conductor Track Takes
The conductor Tracks holds tempo changes, meter
changes, key changes and Markers. However,
switching takes on the Conductor Track only
affects tempo data. Meter changes, key changes, 

and markers are not affected by takes. For example,
if you have a meter change at bar 3, as well as a
number of tempo change events, and you choose
New Take from the Conductor Track take menu,
the tempo events will disappear from the track (as
part of Take 1, which is being replaced by Take 2),
but the meter change at bar 3 will remain.

Audio Track Voice
Audio tracks can be assigned to one of eight
possible audio voices in Performer. If you have
several tracks assigned to the same voice, only one
of them will play at any given time. For details on
managing audio track voices, see the Performer
Audio Guide.

The Track Name
To change the name of a track, click it while
holding down the Option key. A box will pop up:
click in it and use the Macintosh keyboard to edit
the name. To confirm your change, press the
Return key. To cancel the change, press the
Command and period keys. You can also click
outside the box to confirm your edit. Use the Enter
or down arrow key to OK the name change and
move to the next track in the list. Use the up arrow
key to OK the name change and move to the
previous name in the list. The Conductor Track’s
name cannot be changed.

The ConductorTrack
The conductor track contains meter changes,
tempo changes, key changes, and markers. See
chapter 26,“The Conductor Track” (page 319) for
more information.

The Current Patch
This column displays the name of the currently
selected patch for the Device that is assigned to the
track. If a patch has not been selected, no patch
name appears in the column.
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The FreeMIDI option called Monitor Patch
Changes in the FreeMIDI Setup Preferences
command affects this column. When the option is
turned on, this column will show the current patch
change sent by any FreeMIDI application. If it is
unchecked, it will not give you a running update of
the current patch, even with patch changes sent
from Performer.

To select a patch for a track, click in the patch
column next to the track and select the desired
patch from the pop-up menu provided. Its name
then appears in the column.

If you have patch changes in the track, the Device
Patch column will update during playback to show
the current patch (and the Monitor Patch Changes
command is turned on in FreeMIDI Setup).

The list of patches you see in the pop-up menu in
this column is provided by FreeMIDI. By default,
the factory default sounds names for most popular
synths are provided. In some cases, patches are
given the generic name “Patch-1”, “Patch-2”, etc.
However, you can use the PatchList Manager
program, Unisyn, or any other FreeMIDI
compatible librarian software to provide the actual
names of the sounds in each one of your MIDI
instruments. See chapter 53, “PatchList Manager”
(page 503) for details.

The Default Patch
The Default patch is the patch the track always
begins with. It is remembered when you save the
Performer file so that the next time you open the
file and press play, the default patch is called up
from the synthesizer before playback begins so that
the track will play with the correct sound.

To select a default patch for a track, click in the
default patch column next to the track and select
the desired patch from the pop-up menu provided.
Its name then appears in the default patch column.

The list of patches in the pop-up menu is provided
by FreeMIDI. As mentioned in the previous
section, this list can display the actual sound names
in the synth if you use PatchList Manager, Unisyn,
or any other FreeMIDI-compatible librarian
software.

The Controller Display
The controller display column lets you display
controller levels superimposed on top of each track
in the Tracks Overview. Press on the ” in this
column to open the pop-up menu below, which
allows you to choose what controller to display.

Figure 6-12: Displaying controllers in the Tracks Overview.

The Comment
The Comment is a remark that you can display for
the track. It is simply a space for text that you can
use for whatever purposes you wish. To enter or
change a comment, click on it and enter or edit the
text. Press OK or the Enter key to confirm your
entry, or press Cancel or command-period to
cancel it. As much of the comment as possible is
displayed in the Tracks window. If you wish to see
the entire comment, click on it. The comment box
will appear. Press the Enter key to get rid of the box.
When entering or editing a comment, the Return
key starts a newline of text instead of approving the
changes as usual in Performer’s user interface.

You can edit the comments for each track in
succession: after bringing up a comment box, press
the down arrow key to approve the changes you’ve 
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made and move to the comment for the next track.
The up arrow key likewise moves to the comment
for the previous track.

The Scroll Bar
The horizontal scroll bar allows you to scroll the
Track List display when part of it is obscured by the
Tracks Overview.

The vertical scroll bar allows you to scroll up and
down through the Tracks List. Clicking or pressing
the Scroll Arrows scrolls by single tracks. Clicking
the grey part of the bar scrolls by several tracks at
once. Use the scroll box to move to a particular
location in the track list.

The Window Divider
The Window Divider separates the Tracks List
from the Tracks Overview. You can then drag the
divider handle (at the bottom) left or right to resize
each portion of the window proportionally. If you
drag all the way to the right, the scroll bar
disappears (the divider remains).

The Grow Box
The Grow Box allows you to resize the Tracks
window. It works just like a regular Macintosh
window grow box: press and drag it to change the
size of the window.

Soloing Tracks
Soloing tracks allows you to isolate tracks for
playback. This is a quick way to temporarily mute
or unmute many tracks at once without having to
click on the Play-Enable buttons of each. Think of
soloing as a second, independent play-enable state
for all tracks. Any combination of tracks can be
play-enabled when solo is turned on — even tracks
that have been muted when solo is off!

The color of the play-enable button tells you its play
status:

■ Blue — means the track will play in the current
mode (soloed or unsoloed)

■ Gray — means the track is muted and will not
play

■ Orange — means that the track is muted when
soloing is on but play-enabled (blue) when soloing
is turned off

On black and white monitors, the colors are black,
white (hollow), and gray, respectively.

Click a play-enable button to change its status at
any time, regardless of whether solo is turned on or
off.

Solo is turned on and off by pressing the solo
button in the Tracks window title bar; its status can
be changed during playback. You may mute and
unmute tracks at any time during playback.

Both the soloed play state and the unsoloed play
state are remembered until you change them, and
both are also saved with the file.

If the Solo front-most edit window option is checked
in the Solo Setup dialog, individual tracks can be
soloed when their edit window is open (Event List,
Graphic Editing, or QuickScribe notation
window) by pressing the solo button in the title bar.
See “‘Partial-solo’ mode” below for details.

When tracks are muted during soloing, Performer
continues to process the MIDI data contained in
them. This allows tracks to be soloed and unsoloed
during playback without pauses or glitching. If you
want to entirely turn off tracks during playback,
deselect their Play-Enable buttons.

To solo tracks:

1 Press the Solo button in the Tracks window title
bar.

The Solo button becomes highlighted.

2 Play-enable the tracks you wish to solo by
clicking their play buttons.
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To toggle the state of several tracks in a row, drag
over their play buttons.

3 To turn Solo off, click the Solo button again.

'Partial-solo'mode
The solo command (and button) provides an
additional capability: “partial solo mode”. In this
mode, tracks that are being muted are not muted
all the way. Instead, their volume is brought down
part way by reducing their note-on velocities by a
percentage that you choose.

To enable partial-solo mode:

1 Option-click the “S” button in any Edit window
title bar, or choose “Solo Setup” from the Tracks
window mini-menu.

The Solo Setup dialog appears.

Figure 6-13: Solo Setup allows muted tracks to actually play softly at
any percentage that you choose. It also lets you choose whether edit
windows solo a track when they are in front—or whether solo status
in the Tracks window is maintained at all times.

2 Choose a percentage from the pop-up menu.

The value you choose is the percent that note
velocities in each muted track will be reduced to
when muted. (Velocities are not permanently
changed; they are only modified temporarily
during playback.)

3 If desired, check the “Solo front-most edit
window” option.

This option determines what is soloed when you
are editing a track in an event editing window (i.e.
an Event List, Graphic Editing, or QuickScribe
notation window is open and active). When this
check box is checked, the track you are editing is
soloed by itself. When this option is unchecked,
which tracks are soloed is determined by the
(soloed) play-enable buttons in the Tracks
overview and the solo buttons in the Mixing Board
window.

4 Click OK.

Now, when you click the solo button, muted tracks
will be lowered in volume instead of being totally
silenced. To bring them back up, just unmute.

To disable “partial-solo” mode, option-click the
solo button and set the pop-up menu to “Off”.

As a shortcut, you can bring up the Solo Setup
dialog by option-clicking the Solo button in the
title bar of the Tracks Overview or any edit window.

Adding Tracks
You can add as many tracks as you wish to the track
list. When a track is added, its name will be “Track-
n”, n being a number.

To add a new, empty track, simply choose Add
MIDI Track from the Tracks window mini-menu
and the new track will appear on the track list. To
add several tracks at once, hold down the Option
key while choosing Add. You will be prompted for
the number of tracks to add.

When you use the Add MIDI Track mini-menu
command in the Tracks window, Performer adds
the new item to the bottom of the list. However, if
you would like to add an item to a spot in the
middle of the list, simply highlight an item in the
list first. When you use Add MIDI Track, the new
item will be added just beneath the highlighted
item.
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Duplicating Track Layouts
You can add new, empty tracks by duplicating
existing tracks. To duplicate one or more tracks:

1 Select the desired track(s).

See “Selecting Tracks” on page 73.

2 Choose Add Similar Tracks from the Tracks
window mini-menu.

The duplicate track appears in the Tracks window
with the word copy is appended to its name. This
command does not copy the data in the track;
instead, it copies only the track’s name and
playback assignment.

If you would like to make more than one duplicate,
hold down the option key while choosing Add
Similar Tracks from the mini-menu. A dialog asks
you how many duplicates you would like. Enter the
desired number and click OK (or press return).

Duplicating tracks
You can duplicate one or more existing tracks,
including the contents of the tracks with the
Duplicate Track command.

1 Select the track(s) you wish to duplicate.

See “Selecting Tracks” on page 73.

2 Choose Duplicate Tracks from the Tracks
window mini-menu.

The duplicate track appears in the Tracks window
with the word copy is appended to its name.

If you would like to make more than one duplicate,
hold down the option key while choosing
Duplicate Tracks from the mini-menu. A dialog
asks you how many duplicates you would like.
Enter the desired number and click OK (or press
return).

Selecting Tracks
If you want to select a region in a track or delete a
track, you must first select the track. There are
several methods for selecting tracks:

To select a single track, click on its name. It will
highlight.

To select several adjacent tracks, press on a track
name and drag over the desired names. All tracks
dragged over will highlight.

To select several non-adjacent tracks, hold down the
Shift key and click on the names of the tracks you
wish to select. They will highlight.

To deselect tracks when more than one are
highlighted, hold down the Shift key and click on
the tracks you wish to deselect. They will
unhighlight.

Selecting Tracks for Editing
The track selection techniques are also used to
select data inside the tracks for editing with
Performer’s powerful Edit and Region menu
commands. For complete details, see “Selecting a
Time Range Using the Tracks List”on page 210.

Deleting Tracks
To delete a track, select it by clicking on its name
and choose Delete from the Tracks window mini­
menu. The track will disappear from the track list.
Delete several tracks at once by selecting them all
before choosing the Delete command. When a
track is deleted, all of its data is gone. You can undo
the Delete command.

Looping Tracks
Each track can be looped independently. If there
are loops in a track, the looping indicator is visible
in the Tracks Overview. For a detailed discussion of
loops, see chapter 30, “Looping” (page 347).
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Opening an Event Editing Window for a Track
The Event Editing windows contain a display of all
events in a track. Each track has four event editing
environments to choose from: the Event List
window, the Graphic Editing window, the Notation
Editing window, and the QuickScribe notation
window. In these windows the time, event type and
specific event information (on and off velocities,
controller values, duration, etc.) for each event are
expressed numerically, graphically, or as music
notation. You can edit, add and delete events in
these windows as well as select regions of events to
be modified by commands from the Region menu.

To open an Event Editing window from the Control
Panel: highlight the track name and click the Event
List, Graphic Editing, or QuickScribe notation
button in the Control Panel to open the desired
window. Or click a track name or track segment as
follows:

Do this To open this

Double-click Opens whatever edit window
you’ve chosen in the Prefer­
ences command (the event list
by default)

Option double-click Event list

Command double-click Graphic Editing window

Control double-click QuickScribe Notation window

Control-option double-click Notation Editing window

For your convenience, the Preferences command in
the File menu lets you decide which window opens
when you double-click a track. For more
information, see “Preferences” on page 477.

For a detailed explanation of event editing in the
Event List, Graphic Editing, and QuickScribe
notation windows, see chapter 1 l,“The Event List”

(page 139), chapter 12,“Graphic Editing”
(page 153), and chapter 14,“QuickScribe
Notation” (page 191).

Using the Selection Bar
The Selection Bar holds the start and end times for
any region that you wish to edit in any currently
highlighted tracks. You can set these times by:

q typing (use the tab key as usual)

■ dragging on the numbers vertically to change
them

□ choosing the desired command from the
Selection Bar pop-up menu

□ clicking or double-clicking the Start and End
buttons

□ using several clicking shortcuts

□ loading them with remote controls

□ loading them with the Remember Times remote
control

□ making a time range selection in another
window and then switching to the Tracks window

These techniques are discussed in the following
sections.

Selection bar
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Figure 6-14: The selection bar lets you set the start and end times for
the current selection. It also displays the start and end time of a selec­
tion you make elsewhere in Performer's edit windows.

Editing the Selection Bar Numbers Directly
To enter a start or end time, click in a field and enter
a value. You can use the Tab key (or decimal point
key on the keypad) to cycle through the 
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measure|beat|tick fields. Or you can simply press
on any field and drag up or down to change its
value.

Using the Selection Menu Shortcuts
This menu holds several great shortcuts for loading
times into the Selection Bar:

Set to Selection Bounds
Set to Chunk Bounds
Set Start to Counter
Set End to Counter

Figure6-1S:The selection pop-up menu provides several useful
shortcuts for entering start and end times in the Selection bar.

■ Set to Selection Bounds — loads the beginning
and end of the currently selected region into the
Selection Bar

■ Set to Chunk Bounds — loads the very
beginning and end of the entire sequence

■ Set Start to Counter — loads the current counter
location into the start time

■ Set End to Counter — loads the current counter
location into the end time

For the last two commands, Performer loads the
counter location at the time you click menu, not
when you actually choose the command. This
helps you load start and end times on the fly during
playback. Click the menu at the desired instant,
and then take as much time as you need to choose
either “Set Start...” or “Set End... ”,

Clicking the Start and End Buttons
The Start and End buttons in the Selection Bar let
you load times as follows:

Click the button to load the current counter
location.

Double-click the button to load the beginning or
end of the sequence into the start time or end time,
respectively.

Using Clicking Shortcuts
Here is a summary of shortcuts for loading times
into the Selection Bar:

Do this To accomplish this

Option-click anywhere
on the start or end time

To set it to the current playback
location in the main counter — even
on the fly during playback.

Command-click any­
where on the start or end
time

To set it to the beginning or end of
the sequence.

Control-click anywhere
on the start or end time

To set it to the current remembered
time (previously retrieved from a
selection with the Remember Times
remote control).

Double-click the word
Selection

To select the entire sequence.

Click the word Selection To load the remembered times (pre­
viously retrieved from a selection
with the Remember Times remote
control).

For example, you can option-click the Start and
End times to set them to the current playback
location—even on the fly during playback. You can
also command-click them to automatically load
the beginning or end of the sequence.

The Selection Bar Remote Controls
There are two remote controls for loading the
current counter location into the Selection bar start
and end times as shown below. By default, they are
assigned to the F5 and F6 keys on your Macintosh
keyboard. You can change these key assignments if
you like. You can also program the remotes to
respond to any MIDI device, so that you can
actually load counter times from an external MIDI
device. See chapter 44, “Remote Controls”
(page 421) for details.
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Figure 6-16: The selection remotes provide keyboard shortcuts for
loading Selection Bar times.
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The “Remember Times” Remote
The Remember Times remote control (control-R),
allows you to save any time range selection, so that
you can load it into the Selection bar later on. You
can also load remembered times into the Memory
Bar and the Auto-Record Bar. For complete
information, see “The ‘Remember Times’ Remote”
on page 212.

Making a Selection in Another Window
You can make a Time Range selection in another
window to set the Selection Bar edit times. For
example, you could click one of the Memory-cycle
markers in the Graphic Editing window to select
the Memory-Cycle region.When you switch back
to the Tracks window (make it the active window),
the selection is automatically loaded into the
Selection Bar.

Selecting a Region Using the Tracks List
This method of region selection allows you to
select a region containing several tracks at once.

1 Click the Tracks window of the sequence you
wish to modify to activate it.

2 Enter the Start time of the region in the
Selection bar.
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See “Using the Selection Bar” on page 74 for details
on entering the Start time in the Selection Bar.

3 Enter the End time of the region in the Selection
Bar.

See “Using the Selection Bar” on page 74 for details
on entering the End time in the Selection Bar.

4 Decide if you want to turn on the Smart
Selections command in the Edit menu and either
check it or uncheck it as desired.

See chapter 15,“Selecting” (page 207) for details.

5 Select the track or tracks that contain the region.

See “Selecting Tracks” on page 73 for the details
about track selection. The region is now selected in
all the highlighted tracks.

The ConductorTrack
The Conductor track is a special track containing
markers, meter, tempo and key change
information. Every sequence always has a
Conductor track; it cannot be deleted. In the
Tracks window, the Conductor track has a Move
Handle and Comments. The Conductor track
cannot be looped. Certain editing commands can
be used on the Conductor track. For more
information, see the chapter called The Conductor
Track.

Using the Instant Locate Pop-up Menu
The Instant Locate pop-up menu above the Tracks
list lets you quickly jump to any marker, memory
cycle point, or other significant locations in the
sequence.

Tracks List Tip
It is easier to split drum and percussion parts into
separate tracks because you can quickly and easily
select them individually. If all the drums are in one
track, you have to go into the Graphic Editing
window to select individual drum parts (snare, 
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bass, high hat, etc.) By splitting them into separate
tracks, you can simply highlight the track name
and do your editing. You can split them easily
either during recording or afterwards with the Split
Notes command.

THE TRACKS OVERVIEW
The Tracks Overview portion of the Tracks
window provides you with a global view of the
MIDI data in a sequence. It is useful for arranging
parts among tracks, using edit commands such as
Cut and Paste, and other region operations that
affect more than one track at a time. It allows you to
view and edit the data in your sequence all at once
instead of one track at a time.

Basics
The Tracks Overview displays phrases of MIDI
data, which are shown as blocks containing a
miniature representation of the data inside the
block. The blocks of data can be selected, dragged,
duplicated, and otherwise edited as a single object.

The Time Ruler displays time as regularly spaced
columns. By default, each column is one measure
(regardless of meter). However, the columns can be
zoomed to show as much as 16 measures per
column or as little as 30 ticks.

Segments can be selected for editing by commands
from the Edit and Region menus. In addition,
Event Editing windows can be opened from the
segment by clicking as described in the next
section.

The Time Ruler
The Time Ruler displays time as regularly spaced
columns labeled in any one of Performer’s three
time formats. By default, one column equals one
measure of music (regardless of meter). You can,
however zoom the columns with the +/-
magnifying glass buttons in the horizontal scroll
bar to show as much as 16 bars per column (for an 

even greater overview) or as little as 30 ticks (for
microscopic precision). To change time formats,
choose Set Rulers from the mini-menu.

The Time Ruler can also display markers. See
“Working with Markers in the Time Ruler” on
page 80.

The Phrase Display
The phrase display shows MIDI data grouped into
“blocks” of data that can be moved and editing as
single phrases of music. Performer automatically
determines how to group data into blocks. Purple
bars inside a block represent notes. Green bars near
the bottom of the block represent controller data.
You can drag blocks anywhere. You can click them
to select the data that they represent.

Block of Tempo data in the Controller
data conductor track data

Figure6-17:The Tracks Overview automatically and musically
groups data into singular blocks that you can view and edit as units.
It is designed to give you a 'bird's-eye'view of your music. Controller
data is shown as a green line at the bottom of a block.

Customizing the Phrase Display
The Phrase setup command in the Tracks window
mini-menu lets you customize the way that data is
phrased in the Tracks overview.
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Figure 6-18: Phrase Setup, which can be found in the Tracks window
mini-menu, lets you customize the way that data is grouped into
phrase blocks in the Tracks Overview.

Phrase Setup settings are saved with the file, which
allows you to choose different settings for different
files. You can also choose the desired settings for
your new file template. (See “Saving a file as a ‘New’
template”on page 22 for details.)

Dynamic Phrase Parsing
This is Performer’s special algorithm for
determining how data should be grouped into
phrase blocks. Dynamic Phrase Parsing does much
more than just separate blocks of data by a certain
minimum amount of empty time. It looks at overall
data density and takes a number of factors into
account. The result is a more musical organization
of data.

Break Phrases After  Ticks
This option give s you a simple, straightforward
way of controlling where phrases begin and end.
The number of ticks that you enter determines how
much space there must be for a phrase to end and
another one to begin.

Phrase Detail
The term Phrase Detail refers to the miniature
representation of the MIDI data you see inside each
phrase block. The Phrase Detail menu lets you
gives you several choices for how this detail is
displayed so that you can control the trade-off
between a high degree of detail versus the Track

Overview’s responsiveness when scrolling,
zooming and other redraw operations. Here is a
summary of the three possibilities:

Phrase
detail
setting Explanation

On Phrase detail is always computed before any
redrawing happens. This setting produces the
best-looking results, but it is also the slowest in
redrawing. If you are running Performer on
fairly slow Macintosh, you will probably find
one of the other two options to be more conve­
nient.

On Demand Phrase blocks are initially shown by their outline
when redrawing, and detail is filled in after you
stop scrolling, zooming or otherwise redrawing
the Overview. This setting is definitely faster
than above, but it is not quite as elegant.

Off Phrase detail is completely turned off. Instead,
phrase blocks are filled with a generic pattern.
This setting definitely produces the fastest
redraws, but it is, of course, missing all detail.

Modifier Key Shortcuts in the Tracks Overview
Here is a summary of modifier key shortcuts that
will save you time when using the Tracks
Overview:

To do this Use this shortcut

Extend the current selection Hold down the shift key while
clicking or dragging

Quickly copy selected data (or
a time range selection)

Option-drag the selected data
or time range

Override the current grid
snapping setting

Hold down the command key
while dragging (in combination
with any of the above modifiers,
if desired)

Using the Time Ruler to Locate Playback
You can double-click any location in the time ruler
to make Performer jump to that location for
playback. Alternately, you can move the cursor to
the top edge of the ruler (just below the marker
area) until it changes into the “opposite arrows”
cursor, and then click to locate. You can do so when
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Performer is stopped or during playback. This is an
ideal way to quickly locate to a desired point with
the mouse.

Scrolling the Tracks Overview During Playback
The Auto-Scroll command in the Basics menu can
make the Tracks Overview window scroll during
playback. In addition, the window will
automatically open to the current playback
location of the sequence. A scrolling “wiper” can be
displayed in the time ruler as well to indicate the
current playback location. Please refer to the Auto­
Scrolling section in the Playback chapter for more
information.

When auto-scrolling is turned on, you can
temporarily override it simply by clicking
anywhere in the Tracks overview or by scrolling the
window manually. The window will stop for a
moment before it resumes auto-scrolling. This lets
you view or edit things quickly without having to
stop playback.

Scrubbing with the Playback Wiper
You can “scrub” playback with the Tracks Overview
playback wiper by dragging the wiper left and right
(when Audible Mode is turned on.) For more
information, see “Scrubbing” on page 91.

Nudging with the Arrow Keys
You can “nudge” a selection in the Tracks Overview
with the left and right arrow keys on the Macintosh
keyboard. Just make a selection, and use the keys as
desired. Nudging snaps to columns.

Opening an Event Editing Window From the
Tracks Overview
The contents of a phrase in the overview can be
viewed with any of Performer’s three Event Editing
windows. To open a window, double-click the
phrase the as shown below:

Control-option double-click Notation Editing window

Do this To open this

Double-click Opens whatever edit window
you’ve chosen in the Prefer­
ences command (the Event List
by default)

Option double-click Event List

Command double-click Graphic Editing window

Control double-click QuickScribe Notation window

For your convenience, the Preferences command in
the File menu lets you decide which window opens
when you double-click a track. For more
information, see “Preferences” on page 477.

Zooming
Zooming the Time Ruler in the Tracks Overview
changes the amount of time shown in each column.
If you zoom out, each column represents more
time, resulting in a more global view of the
sequence. If you zoom in, each segment represents
less time, allowing for more detailed work.

The Tracks Overview window defaults to showing
one measure per column. Zoom-Out levels zoom
up to 2,4,8, and 16 measures per column
(regardless of meter). Zoom-In levels zoom from 1
measure down to a quarter note (480 ticks), an
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eighth note (240 ticks), a sixteenth note (120 ticks),
a thirty-second note (60 ticks), and a sixty-fourth
note (30 ticks).

Working with Markers in the Time Ruler
The Time Ruler lets you display and edit Markers.
Here is a summary:

To zoom in, click once (or repeatedly) on the
magnifying glass with the plus sign ( + ). To zoom
out, click once (or repeatedly) on the magnifying
glass with the minus sign ( -). Option-click to
zoom all the way in or out.

Zooming keyboard shortcuts are: command-left-
arrow (zoom out) and command-right-arrow
(zoom in).

Making Selections for Editing in the Tracks
Overview
To edit data, you must first select it. The Tracks
Overview provides several graphically intuitive
ways to make selections. Once you’ve made a
selection, you can apply Performer’s many
powerful Edit menu and Region menu commands
on whatever is in the selected region. For
information about selecting in the Tracks
Overview, see:

■ “Making a Data Selection in the Tracks
Overview” on page 209

■ “Selecting a Time Range in the Tracks
Overview” on page 210.

For general information about selecting, see
chapter 15,“Selecting” (page 207).

To accomplish this Do this

Create a new marker Click on the “marker well” to the right
of the Time Ruler and then drag and
drop a marker onto the Time Ruler.
The marker will “snap” to the nearest
column. If you want to override snap­
ping so you can place the marker any­
where, hold down the command key
while you drag and drop.

Marker
well

i_____________ X-------
QMarker-1

1? a? i?
2

'III]

Delete a marker Drag its icon downwards until the cur­
sor turns into a trash can.

Rename a marker Double-click or option-click its name
to pop-edit it.

Move a marker Drag its icon left or right.

Move a marker with­
out “snapping” to col­
umns

Command-drag its icon left or right.

i_____________________ !
^Marker-1

Select everything from Click the icon of the first marker. Shift-
one marker to the next click to extend the selection.
one

Lock (or unlock) a
marker

Option-click its icon.

Marker-1
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Using the View Filter
The View Filter (in the Basics menu) allows you to
choose what types of MIDI events are displayed in
the Tracks Overview. For example, if you would
momentarily like to see patch changes only, you
can open the View Filter and option-click the patch
change check box (to select it and deselect all
others). Then, only patch changes will be displayed
in the overview (and event edit windows). As you
can see, the View Filter can be an effective tool for
working with only a few types of data at a time. The
View Filter affects all Event Editing windows as well
as the Tracks Overview.

The View Filter also determines which types of
events are affected by Edit menu commands. Here’s
a simple rule to remember: if you can see data, it
will be affected by edit commands.

When using the View Filter, keep these rules in
mind: The View Filter settings you select will stay in
effect until you change them. They affect all open
Event Editing windows. The View Filter settings
will affect all edit operations done in the Event
Editing windows.

For more information about using the View Filter,
see “Setting the View Filter” on page 217.

Setting a Loop in the Tracks Overview
To set a loop in the Tracks Overview:

1 Select the area that you wish to loop.

See “Selecting a Time Range in the Tracks
Overview” on page 210 for details about how to do
this.

2 3 4 15 6
I 1 til I

2 Choose Set Loop from the Change menu or
click the Loop button in the Control Panel.

The Set Loop dialog box appears.

3 Choose the number of times that you would like
the loop to repeat.

4 Click OK to create the loop or Cancel to
withdraw the loop command.

Figure 6-19: Creating a loop in the Tracks Overview by making a
selection and then choosing Set Loop from the Change menu.

SEPARATING OUT DATA INTO ITS OWN
SEQUENCE
The Copy Selection to New Sequence command in
the Tracks window Sequences menu (as shown in
Figure 6-5 on page 64) takes selected segments in
the Tracks Overview and turns them into their own
sequence Chunk in the Chunks List window.

The Copy Selection to New Sequence command
makes it easy to break up a sequence into separate
pieces (Chunks) in order to rearrange them more
freely in a Song window. For example, let’s say that
you have built several phrases that are a few bars
long in a Sequence. But now you want to rearrange
them and try different combinations. To do so, you
can select the segments of a phrase and choose
Copy Selection to New Sequence from the mini­
menu for each one. Then, you can drag the
resulting sequence Chunks from the Chunks list
window into an empty Song window to try
different orders and combinations.

Once you have arranged the Song as you like, you
can even convert it back into a sequence using the
Song window mini-menu command called Merge
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Chunks to Sequence. This command takes the
separate Chunks inside the Song window and
reduces them to a single sequence Chunk.

At any time, you can take your music freely back
and forth from Sequence form to Song form with
these two commands to help you create your
music.

To create a sequence Chunk from the Tracks
Overview window:

1 Select the Segments that you wish to be in the
Chunk.

Alternately, you can select the region from the
Tracks List by highlighting track names and setting
a region in the Selection bar.

2 Choose Copy Selection to New Sequence from
the Sequence pop-up menu.

A dialog box appears.

3 Type in a name for the Chunk.

4 Type in an End Time to determine the length of
the Chunk.

By default, the end time is determined by the
length of the selected region.

5 (Optional) Type in any other information you
wish about the Chunk.

6 Press OK to confirm your choice or Cancel to
withdraw the command.

CUSTOMIZING THE TRACKS WINDOW
The Tracks window can be completely customized.
This allows you to set it up in the way that best suits
the way you work. The diagram below summarizes
what you can do.

Configuring the MIDI Level Meters
The MIDI level meters in the Tracks window can be
configured in several ways. To set these options,
double-click any level meter (or choose Level
Meters Setup from the mini-menu) to open the
Level Meters Setup dialog box shown below.
Settings in this dialog box are global across files
and are automatically saved in the Performer
Preferences file in the System Folder.

leter Setup J

Show
O MWi Activity
® Velocity

Level Decay Time (0-9$):

Monitor During:
® Playback
@ Recording

Figure 6-20: The Level Meter setup feature lets you customize the
behavior of the MIDI activity meters in Tracks list.

Showing MIDI activity or velocity
Level meters can show either MIDI activity or
velocity. With MIDI activity, the meter is triggered
every time a MIDI event is played back from the
track. It can be any type of MIDI data, including
notes, controllers, pitch bend, sysex data, etc. With
velocity, the level meter reflects the note-on
velocity of each note at the instant the note is
triggered during playback.

•" MIDI level meters do not function like audio
level meters. For both MIDI activity and velocity,
the MIDI level meter is triggered by a MIDI data
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Double-click the column headings
to open the dialog box shown to the
left (or choose'Columns Setup"
from the mini-menu), which lets
you choose the columns you want to
see. Below, only the record-enable
buttons, playback assignment,track
names,and MIDI level meters are
displayed.The rest of the columns
are being hidden. Reorder the
columns by dragging the column
heading left or right.

MIDI level meters display degree
of MIDI activity or note-on veloci­
ties in each track during playback.
To configure the meters in the
setup dialog shown to the right
choose'level Meter Setup"from
the mini-menu, or double-click
any level meter.

Phrase setup lets you control how music is
grouped into phrases.lt also gives you several
choices for phrase detail to help with redraw
speed on slower computers.

For details about these options,see
■Configuring the MIDI Level Meters'
on page 82.
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byte, such as a note-on event or controller, at the
time it is played back. The level does not sustain
during the duration of the note.

Monitoring
Level meters can monitor MIDI data being played
back, recorded, or both. With both options
checked, the meters monitor playback when you
are playing back, and they monitor recorded
material on the current record-enabled track
during recording. If you are in overdub record
mode, both recording and playback are monitored
at the same time for the record-enabled track.

We recommend using both options because this
gives you the greatest amount of feedback about
what is going on in your tracks.

Level Decay Time
Level Decay Time refers to how quickly the meters
return to zero. The decay amount is expressed as an
arbitrary value between zero and 99. For music that
consists mostly of sixteenth notes, eighth notes,
quarter notes, and longer, try level decay time
values between 5 and 20 at tempos between
approximately 80 and 160 bpm. If the tempos are
extreme, or if notes are particularly dense or
sparse, you might find it helpful to use level decay
times below 5 or above 20.

In general, shorter decay times are better for fast
tempos and/or dense passages of notes. Longer
decay times are better for slower tempos and/or 

sparse passages. If you find that the meters don’t
stay up long enough for you to see them, try a
higher value; lower the decay time if levels go up
and then don’t change very much. Decay times
above 30 are very slow and would probably only be
useful in extreme cases (very slow music, lighting
control sequences, etc.)

HIDING LEVEL METERS TO REDUCE
OVERHEAD
Performer goes to great lengths to preserve the
integrity of MIDI playback. Screen display takes a
back seat to the more important function of
playing back the sequence with as accurate timing
as possible. However, the level meters do require
some effort from Performer. In some situations,
such as running Performer on a slower Macintosh,
it may be desirable to hide the level meters to
ensure the highest playback performance.

To hide the level meters, double-click the track
column heading above the level meters (labelled
“LEV”) to open the Track Columns Setup dialog
box as shown on page 82. Uncheck the Levels
option.

If you’d rather not hide the meters, another
overhead-reducing tactic is to monitor MIDI
activity instead of velocities because MIDI activity
monitoring requires less effort. Open the Level
Meters Setup dialog as explained on page 82 and
select the MIDI Activity option.
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chapter 7 Playback

PLAYBACK BASICS
When Performer is “playing” music, it is sending
out stored MIDI data at specified times to MIDI-
equipped instruments. These instruments use the
data as instructions for when to turn notes on and
off, etc. Conceptually, it is similar to a player piano
which uses a set of recorded data (the piano roll) to
control its “instrument” (the piano mechanism).
The synthesizer or sound module produces the
actual sound, and Performer tells it when and how
to do so.

To play a sequence or a song:

1 Open a Performer file.

Choose Open from the File menu. A dialog box will
appear. Select the file you wish to open by clicking
on it and pressing the Open button.

2 Choose Chunks from the Windows menu.

The Chunks window will open or, if it is already
open, come to the front.

3 Play-enable the Chunk you wish to play back.

Since a file can contain several Chunks (sequences
or songs), you must play-enable the one you want.

4 Set the location from which you want playback
to begin.

To simply rewind to the beginning of the sequence,
click the Rewind button. To choose a general
location, drag the Position Bar below the main
transport controls; to start at a specific location
other than the beginning, type in the location in
the main counter. Or double-click at the desired
playback location inside the time ruler in a Graphic
Editing window. You can double-click in the Tracks
overview time ruler as well.

5 Play-enable the tracks you wish to play back.

If you are playing a sequence, double-click its name
to open its Tracks window and click the Play­
enable button to the left of the track name(s) you
wish to hear. If the track is not play enabled, you
will hear nothing from the track. If you are playing
a song, play-enable the tracks in each sequence that
the song contains.

6 Choose a MIDI playback device for each track.

A track can be assigned to one channel on a single
MIDI device. It can also be assigned to several
different MIDI devices simultaneously. Devices
can be set by clicking on the play destination in the
Tracks window next to the track name. A pop-up
menu appears. The devices in the list are provided
by FreeMIDI. If a device you want is not present in
the list, use the FreeMIDI Setup program to add
the device to your MIDI configuration.
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Figure 7-1-.Selecting a playback device from the pop-up menu in the
Device column next to the track name.

You can change a track’s playback channel or
Device at any time—even while the sequence is
playing back.

7 Choose a sound from the track’s patch list by
clicking in the Patch column next to the track name
as shown below.

Performer provides a pop-up
list of the factory-default
sounds in the instrument.

Figure 7-2: Choosing a MIDI instrument sound from the pop-up
patch menu. If you see generic names like 'Patch 1, Patch 2" etc., you
can go ahead and use them anyway, as long as you know what
sounds correspond with each patch change number. Or you can
modify the list so that it shows the actual sound names. For details,
see chapter 53, “PatchLIst Manager"(page 503).

8 Press the Play button.

The sequence will begin to play. The Counter
advances.

9 When finished playing back, press the Stop
button.

When the sequence is finished, Performer will keep
playing indefinitely until you press the Stop button.
(This doesn’t endanger your sequence, though it is
best to stop playback when the sequence is done.)

Choosing a device for playback
To choose a playback device, choose it from the
pop-up menu provided in the Device column next
to the track name as shown in Figure 7-1 on
page 86. You can also do so from your Mac
keyboard. See “Switching MIDI devices, channels
and patches” on page 426.

Choosing multiple playback devices for a
singletrack
To assign a track to multiple playback devices, you
need to assign it to a device group. You can either
choose an existing device group as shown in
Figure 7-1 on page 86, or create a new one by
choosing New Device Group, which opens the
Device Groups window (described in the next
section). A device group can contain up to ten
MIDI channels from any combination of devices in
your MIDI setup. To create a device group, read the
next section.

<•" Hint: if a track is currently assigned to a device
group, and you want to make changes to the device
group, option-click the device group name in the
Tracks window next to the track and the Device
Groups window will automatically open and scroll
to the group. You can then make whatever changes
you want.
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Creating a device group
A device group is a collection of individual
FreeMIDI devices—or more specifically, MIDI
channels from FreeMIDI devices. For example, a
device group called Massive Siring Pad might
include the following device channels: Kurzweil
K2000 channel I,Korg 01/W channel 5,Akai
S1000 channel 3, and Proteus/2 channel 13. As a
result, the device group produces a combination of
the sounds currently playing on each of these MIDI
channels. A device group can contain up to 10
MIDI channels.

Devices groups appear in the same pop-up list as
all the rest ofyour FreeMIDI configuration devices,
and they are used to assign multiple MIDI channels
to a single track in the Tracks window.

To create a device group:

1 Choose Device Groups from the Windows
menu to open the Device Groups window.

Click this expand/ Click the check Click the expand/compress icon
compress icon to boxes to quickly again to return to the normal
togglethedieck box add MIDI channels display, which allows you to a
display shown here, to the device group, default patch for each channel.

Figure 7-3: The Device Groups window allows you to quickly assign a
track to playback on multiple MIDI channels — and even separate
instruments.

2 Choose Add Device Group from the mini­
menu.

If you would like to add more than one at a time,
hold down the option key while selecting the
command from the mini-menu.

Here is a summary what you can do in this
window:

To do this Do this

Change the device group
name

Option-click the name to pop­
edit it.

Add a device to the group Click the pop-up menu arrow
beneath the device group name
and choose the desired device
and MIDI channel from the
pop-up menu.

Add several devices quickly Click the Expand/Compress
icon below the device group
name to open up a display of all
the devices in you studio. Then
click the check boxes that corre­
sponds to the MIDI channels
you want to add to the group.

Close the check box display Click the Expand/Compress
icon below the device group
name again.

Remove a device Click the device and choose
None from the pop-up menu.

Set a default patch for a device If the device is currently
expanded, close it first oy click­
ing the Expand/Compress icon
below the device group name.
Then click in the default patch
column to the right of the device
and choose the desired patch
from the pop-up menu.

Clear a default patch Click the device name to select it
and choose Clear Default Patch
from the mini-menu.

Remove a device or device
group from the list

Click the name to select it and
choose Delete from the mini­
menu.

Duplicate a device group Click the name to select it and
choose Duplicate from the
mini-menu.



Changing your playback device list
Performer relies on FreeMIDI for an up-to-date list
of the MIDI devices connected to your Macintosh.
If a device is connected to the MIDI OUT of your
MIDI interface, and the connection is accurately
reflected in your FreeMIDI configuration, then the
device shows up in the pop-up list with the same
name it has been given in FreeMIDI. To make any
changes to the playback device list, choose Edit
FreeMIDI Configuration from the Basics menu.
This command automatically opens FreeMIDI
Setup, which lets you make changes to your device
configuration.

Editing during playback
Many of Performer’s features, such as windows,
dialog boxes, edit region selection, edit commands,
and other features can be used during playback.
For example, you can open another window or use
the Transpose command while the music is playing
back; you do not have to press the stop button
beforehand. So, the next time you are listening to
your music and would like to make a change, don’t
reach for the stop button. Just execute the
command while the music is playing.

Here are some examples of things you can do
during playback:

■ Select a region for editing (in an Event List,
Tracks Window, etc.)

■ Edit a region with the Edit or Region menu
commands

■ Rearrange Chunks in the Song window

■ Cut, copy, drag, option-drag (copy), etc. notes
and data in Graphic Editing and QuickScribe
notation windows

■ Reassign the playback channel for a track

■ Add, delete, rename, or reposition a track

■ Access a mini-menu command such as Add
MIDI Track
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During playback and recording, the Counter and
other displays may become irregular and seem to
skip beats. This is due to Performer’s primary
obligation which is to receive and output MIDI
data on time. Performer may have to devote all of
the computer’s resources towards this end and thus
may not be able to keep the screen display
completely smooth and current. The click provides
an accurate determination of the tempo. In
addition, editing commands may sometimes take
longer due to the amount of processor time
required to deal playback.

Some features, because of their nature, cannot be
accessed during playback. These features are either
greyed out (unaccessible) during playback or will
have no effect unless you press the Stop button
before using them. Examples are:

■ Using the MIDI Interface dialog box

■ Save or close a file

Soloing tracks
Using Solo allows you to easily select a subgroup of
tracks to be heard during playback. This allows you
to focus your attention on one or more tracks
without disrupting playback in any way. The solo
tracks group can be changed during playback,
making it possible to hear many combinations of
tracks without having to stop playback. The
procedure for soloing tracks is described in detail
in The Tracks Window chapter.

Looping playback
Playback of the entire sequence can be looped
seamlessly between any two points. For
information see “The Memory-cycle button” on
page 42.

Playing the current selection
To play back the current selection, choose Play
Selection from the Basics menu.
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EVENT CHASING
Event chasing addresses a common problem with
playback: hearing the wrong patch (sound) when
you begin playback in the middle of your sequence.
This happens because MIDI data consists of a
stream of single events. If a patch change occurs
early in the stream, say at measure five, but you
start playback later on, say at measure twenty, the
patch change will not be played and your synth will
not be set to the proper sound.

Here’s how event chasing fixes this problem: every
time you begin playback, Performer searches
backward in each track for the last patch change,
volume controller, and so on. If it finds one, it
transmits the event before playback begins, setting
the synth to the correct patch, volume, etc.

Performer can chase all types of data, including
notes which may be playing at the current location.

Enabling Event Chasing
Performer allows you to choose which types of
MIDI data will be chased. To enable Event Chasing:

1 Choose Set Event Chasingfrom the Basics menu.

The Set Event Chasing dialog appears.

Figure 7-4: Event Chasing ensures that you get what you expect to
hear, no matter where you start playback in your sequence or song.

2 Select the types of data you wish Performer to
chase.

Click Set All to enable chasing of all MIDI events.
Deselecting unnecessary types reduces chase time
after the Play button is clicked.

3 Click OK to confirm your choice or Cancel to
cancel it.

To disable Event Chasing, click Clear to deselect all
data types for chasing.

In general, it is best to chase only types of data that
need to be chased.

Inserting Initial Controllers into Each Track
Especially when you are using Event Chasing, it is a
good idea insert controllers at the beginning of
each track that set an initial value. This ensures that
you’ll hear what you expected to hear from the
beginning of playback, regardless what song you
were last playing on your MIDI equipment, which
might have very different settings since the last
time you played the current sequence you are
working on.

Initial controllers also give Performer’s Event
Chasing feature something to chase to — with
values that you have chosen.

Tip: the Snapshot button in the title bar of the
Mixing Board window is a convenient way to insert
initial volume and pan settings. Just rewind to the
beginning of the sequence, show all tracks (or hide
ones you don’t want to affect), and click the
snapshot button.

When Initial Controllers Are Missing...
If you don’t have initial controllers in a track,
Performer’s Event Chasing feature generates its
own default controllers when you start playback
before the first event of a given type in a sequence.
For example, if the first pitch bend event in a track
is at bar 5, and you rewind to bar 3 and start
playback, a default pitch bend event of zero (no 
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bend) will be sent by Performer. (This only
happens for controller event types that actually
exist somewhere in the track.)

This feature usually works well with synthesizers,
but may not be what you want for devices that use
controllers for non-standard purposes, such as
mixers, tape decks, lighting rigs etc. Setting the
Does not play notes property in FreeMIDI for a
given device disables the generation of default
controller events. If Does not play notes is turned
on, the only events that Performer will send (and
chase to) are the ones actually in the track.

Event chasing and loops
Event chasing even recognizes loops. If you have
loops in a track, and the loops contain patch
changes or other data that you are chasing, you will
get the same results starting anywhere in the
middle of the track as you would playing it straight
through from the beginning.

Event chasing in songs
Event chasing also works in a sequence when it is
placed inside a song. In the example below, starting
at bar 7 (in the middle of seq-2) will cause seq-2 to
chase its own tracks, just like it would if you were
playing it individually.

Figure 7-5: Sequences do event chasing, even when they are playing
back inside a song.
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AUTO-SCROLLING
With the Auto-Scroll command in the Basics
menu, windows with the ability to scroll will
update during playback or recording. You can
choose whether all windows on the screen will 

scroll, or only the top window. In addition, you can
choose what kinds of Performer windows will
scroll.

When Performer windows scroll, they “page” along
with the music. That is, when playback reaches the
last measure or event in the current window, the
window jumps to the next windowful of data, just
like clicking in the grey area of a scroll bar.

You can temporarily override scrolling in any
window simply by clicking in it or by scrolling the
window manually. The window will stop for a
moment before it resumes auto-scrolling. This lets
you view or edit things quickly without having to
stop playback. Auto scrolling resumes after you
leave the window alone for about 5 seconds. You
can manually resume auto scrolling by clicking the
window’s title bar.

With Auto-Scrolling enabled, windows will update
any time you change playback location, even when
Performer is not playing back or recording. For
example, if Performer is stopped and you press
Rewind, all Auto-Scrolling windows will scroll to
the new location indicated in the Counter window.
Auto-Scrolling occurs when pressing the cueing
buttons, dragging the arrow in the position bar,
typing a new location into the Counter window, or
cueing to a marker in the Markers window.

When Auto-Scroll is enabled, Graphic Editing,
QuickScribe notation, and Event List windows
open to the current playback location.

Auto-scrolling will only occur in windows related
to the currently play-enabled Chunk. For example,
if a Song window is open, it will not Auto-Scroll
unless the song is play-enabled in the Chunks
window. Windows associated with Chunks inside
the song will not scroll when the song is play-
enabled. Only the Song window and its Markers
window will scroll.



To enable Auto-Scrolling:

1 Choose Auto-Scroll from the Basics menu.

The Auto-Scroll dialog box appears.

0 AD widows O Top window only

Window: Cursor:
[aJ Event LUU
S Graphic Editing windows ®
® Song windows
S Markers window
(3 notation Editing windows ®
® Tracks windows @
(3 QuickScribe windows ® _

I S«t All | | Clear | | OK | | Cancel |

Figure 7-6: The Auto Scroll command allows you to choose what
windows will and will not scroll during recording and playback.

2 If you would only like the top window to scroll,
click the Top window only option.

This option causes only the top window to scroll
when you have more than one window open on the
screen. This option also reduces Performer’s
processing load. If you have a slow computer, or if
your sequences tend to contain large amounts of
dense MIDI data, this option will ensure accurate
playback and responsive scrolling.

3 Choose which types of windows you prefer to
Auto-Scroll.

Click the check box next to the window type to
select it. Use the Set All and Clear buttons to select
or deselect all window types.

4 If you would like a scrolling cursor, select the
cursor option(s).

The scrolling cursors display the current playback
location as shown in the main counter. They can
also be dragged left or right to change the current
playback location. They can be dragged when
Performer is stopped or while it is playing back.
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Figure 7-7: With the Cursor option checked, a "wiper" appears in the
Graphic Editing, Notation Editing, QuickScribe Notation, and Tracks
Overview windows to show the currently playback location of the
sequence. This wiper scrolls during playback and can be dragged to
change the playback location. You can also double-click inside the
time ruler at any location to make the cursor jump to that location.

5 Click OK.

To disable Auto-Scrolling:

1 Choose Auto-Scroll from the Basics menu.

The Auto-Scroll dialog box will appear.

2 Click the Clear button.

This deselects all window types.

3 Click OK.

SCRUBBING
Scrubbing refers to the act of controlling playback
manually, forwards or backwards, by dragging the
mouse left or right. Scrubbing allows you to play
the music forwards or backwards in non-real time,
where you control the tempo by how quickly you
drag. Scrubbing is great for zeroing in on wrong
notes or other artifacts that you hear during
playback.
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Scrubbing only happens in Performer when
Audible mode is turned on. To turn on Audible
Mode, click the button with the speaker icon in the
Title bar of the Tracks window or any Edit window.

You can scrub playback by using any of the
following techniques:

■ Drag the Tracks Overview playback wiper

■ Drag the Graphic Editing window playback
wiper

■ Drag the Notation Editing window playback
wiper

■ Drag the QuickScribe window playback wiper

■ Drag Movie Window slider

■ Press the fast forward/rewind buttons or slow
forward/rewind buttons in the Control Panel

Scrubbing respects the solo states of tracks, and in
general, plays the same tracks that you would hear
if you pressed the play button. This can be used in
conjunction with Partial Solo Mode to only scrub
the Edit window you are currently viewing. See
“‘Partial-solo’ mode” on page 72 for details.

Scrubbing always chases:

■ patch changes

■ notes

■ pitch bend

■ volume controllers

■ sustain pedal controllers

While scrubbing, however, only the following
event types are played back:

■ notes

■ pitch bend

■ sustain pedal
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Figure 7-8: Here are the many ways you can "scrub” MID! data in
Performer.
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chapter 8 Recording

Performer records very much like a multi-track
tape deck: you make the right connections, specify
the tracks onto which to record and push the
record button. Performer, however, has a great deal
more flexibility than a tape deck. There are many
options you can use while recording that affect
which types of data are recorded and the time span
in which recording takes place.

Recording is the main method by which MIDI data
is input into the sequence. There are two types of
recording: real-time recording and step recording.
This chapter describes the basics of both methods
and discusses real-time recording; the next chapter
describes step recording in detail.

REAL-TIME RECORDING
Real-time recording has two modes: standard and
MultiRecord. In standard mode you can record on
one track at a time. Data incoming on all channels
(or the one you specify) is sent to this track.
MultiRecord mode allows you to record on several
tracks simultaneously, each receiving data from a
different incoming MIDI channel.

Before recording in either mode, you should do the
following things:

1 Make sure your MIDI instruments are
connected and configured the way you want them.

Set the correct patches on your controller and
playback instruments.

2 (Optional) Check to make sure that Patch Thru
is turned on so that you’ll record the track with the
same sound as it will play back with.

Patch Thru echoes incoming data to any device you
choose in your MIDI studio. This is essential when
using a separate MIDI controller instrument: it
allows you to hear what you are playing while it is
being recorded. Patch Thru is also useful to check
whether your instruments are working and
connected correctly.

3 Set the Input Filter, if needed.

If you wish to filter out some MIDI data when
recording or record only from one specific channel,
use the Input Filter from the Basics menu. The
Input Filter defaults to notes, velocities, pitch bend,
patch and song changes, and controller data
checked.

4 If you have more than one sequence or song in
the file, make sure it is the currently play-enabled
chunk.

To do so, look at the current chunk indicator in the
Control Panel. If you need to switch sequences, use
the Skip buttons.

100=00:00:00

I| Chunk: Stq-1

Figure 8-1: The current sequence or song.

If the sequence is inside a song, open the song’s
window by double-clicking on the song, highlight
the sequence, and choose Set Record Sequence from
the Song window mini-menu.

5 (Optional) Choose the starting meter or set up a
meter map.



A meter map is the layout of meters for the entire
sequence. If you have a number of meter changes in
your sequence, it is a good idea to set these up
beforehand; it will make recording much smoother
and more musical. A meter map can be made with
the Change Meter command on the Change menu.
Consult the Change Meter chapter for more on this
command.

6 (Optional) Set the tempo with the metronome
in the Control Panel.

To set the tempo manually, choose Tempo Slider
from the Tempo Control pop-up menu and drag
the tempo slider to the desired tempo. Using the
tempo slider is handy for quickly setting a straight
tempo. A tempo map is the layout of all tempo
changes for the entire sequence. If you have a
number of tempos in your sequence, especially
ones that change over time (such as an
accelerando), you may prefer to set these up before
actually recording any MIDI data. A tempo map
can be made with the Change Tempo command on
the Change menu. Consult the Change Tempo
chapter for more on this command. Tap Tempo is a
way to tap the tempo manually while you record,
such as with a foot pedal. For more information,
please refer to the Tap Tempo section in the chapter
called Receive Sync.

7 Record-enable the track(s) you wish to record
on.

To do this, open the Tracks window of the sequence
you are recording into by double-clicking its name.
In the Tracks window, click the Record-Enable
button next to the track. If the button is red (or
black on a black and white screen), the track is
record-enabled. In standard record mode, only
one track can be record-enabled. In MultiRecord
mode, several maybe record-enabled (more on
this below).

8 Select the playback device(s) for the track being
recorded.

See “Choosing a device for playback” on page 86
for details.

9 Select a location at which to begin recording.

If you are recording into a new sequence, you’ll
probably want to start at the beginning of the
sequence. To do so, click the Rewind button. To
start at a specific location other than the beginning,
type in the location in the Counter window.

10 (Optional) Select the Wait and Countoff
features.

The Wait feature holds recording until you hit a key
on your MIDI keyboard or the Macintosh
keyboard. Countoff gives you a number of
measures of countoff in the starting tempo before
recording begins. Wait and Countoff can be
activated in the Consolidated Controls window.
See chapter 5, “The Control Panel” (page 37) for
specific details.

11 To begin recording, press the Record button in
the main transport controls.

The Record button will turn solid black, signalling
that Performer is recording in real-time. You can
also trigger recording by pressing the 3 key on the
Macintosh keypad or, if you have already set up a
MIDI remote control, by sending a MIDI event
from your controller. For more information about
setting up MIDI remote controls, please refer to the
chapter called The Remote Controls Window.

12 To stop recording, press the Stop button.

Or, press the zero key on the Macintosh keypad.
Stop can also be mapped to a MIDI remote control.
To hold recording, you can press the Wait or Pause
button.
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The above steps are used for standard recording
mode. MultiRecord mode requires a few additional
steps.

PUNCH-IN/PUNCH-OUT RECORDING
Auto-Record causes recording to automatically
turn on and off at precise punch-in and punch-out
points. This allows you to record without having to
manually enable and disable the Record button.

REC

Figure 8-2: The Auto-Record button allows you to precisely program
punch-in and punch-out points for recording.

Clicking on the Auto-Record button (below the
main transport controls) enables and highlights it.
Clicking on the Auto-Record button also causes the
Auto Record punch in and punch out times to
appear in the Status Strip. Punch in and punch out
times are specified in the Auto Record Bar: Punch
in is the time where recording begins; Punch out is
where recording ends. Auto-Record can be used
while Performer is slaved to external sync; see
chapter 39,“Receive Sync” (page 387) for details
on recording while slaved to each type of sync.

| Auto Red :]2|11000 14|11000 xl |

Figure8-3: The Auto-record bar lets you set precise, automated
punch-in and punch-out points during recording.

The Auto-Record button will remain on until you
click on it again to disable it. Remember to disable
it when you finish using it.

To use Auto-Record:

1 Activate the Tracks window by clicking in it.

2 ‘Click on the Record-Enable button of a track.

3 Press the Auto-Record button, which is located
below the transport controls.

The button highlights to signify that Auto-Record
is on.

4 Enter the Punch In and Punch Out locations.

The Punch In location is where Recording will
begin. The Punch Out location is where Recording
will end. You can enter them in numerically in the
Auto Record Bar. You can also set them up
graphically. See “The Memory and Auto Record
Bars” on page 48 and “Viewing the punch-in and
punch-out points graphically” on page 46.

5 Move to a location in the sequence before the
Punch In point.

This location should be a spot that will give you
plenty of time to prepare to enter the new material,
anywhere from a whole section to a few bars before
the Punch In point.

6 Get ready to record.

7 Press the Record button.

The sequence plays from the current location in the
Counter. The Record button is initially flashing (or
grayed out on a black and white screen). When the
Punch In time is reached, the button becomes
highlighted. When this happens, Performer is
recording and you can enter the new material.
When the Punch Out time is reached, the Record
button will revert to flashing (or being gray on a
black and white screen).

8 Press the Stop button when you are finished.

If Performer starts recording while a pre-existing
note is sustaining, it does not cut off that note. Only
notes with attack times after the punch in time are
erased. For example, the two notes represented by
light grey bars begin within the punch in region,
but the sustained note represented by the dark grey
bar begins before the punch in point:
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Punch-in Punch-out
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Figure 8-4: A passage of notes before Auto-Recording.

After recording, the notes that began before punch
in remain, but the notes that begin within the
recorded region are replaced by the new material:

TTTZZZZZZZZZZZ^
I .....-I

I ...............................=]
Figure 8-5: The same passage of notes after Auto-Recording, with the
newly recorded material displayed as the bar with the diagonal
pattern.

Anything you play while the Record button is grey
is not recorded. This allows you to play along with
the sequence and only record between the Punch
In and Out times.

CYCLE-RECORDING
Several of Performer’s features can be combined to
provide comprehensive cycle-recording, complete
with spot-erase and erasing the last pass. To get
basic cycle-recording going:

1 Click the Memory-cycle and Overdub record
buttons in the Consolidated Controls panel.

The memory-cycle button causes Performer to
loop a section indefinitely. To prevent accidental
erasure of the previous record pass, Performer falls
out of record mode when it hits the cycle end point,
unless overdub mode is enabled.

5] falBL&l M £.[£| Hi
Mlq M<mor;(ITl1IOOO fsjflood | C1

Memory-cycle Overdub

2 Set the start and end times of the region you
want to loop in the Memory bar.

For a two bar loop, make the stop time 3| 11000. For
a four bar loop, make the stop time 5| 11000. Stop
time is always the downbeat of the measure after
the last one in the loop. You can set the loop points
graphically by dragging the loop repeat barlines in
the Tracks overview as shown below.

Memory-cycle start and end points (can be dragged)

3 Check Auto Scroll in the Basics menu to make
sure that the cursor option is checked for the
Tracks Overview.

This option provides a scrolling “wiper” to show
you where playback is during looping.

4 Set the tempo in the tempo slider.

5 If needed, make sure that the Click is enabled in
the Basics menu.

6 Cue Performer to the beginning of the loop
region.

7 Click the record button in the main transport
controls and begin recording.

MIDI data appears immediately during
recording
In Performer, recorded data appears immediately
as you record it, before you press the Stop button.
This allows you to edit the data (erase, transpose,
quantize, etc.) without stopping cycle-recording.
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Erasing the last pass and spot-erasing
You can easily accomplish common cycle­
recording tasks such as erasing the last pass and
spot-erasing by opening an event editing window
while cycle-recording. As you record, notes appear
in the window right away, so you can do whatever
you want to them without having to press the stop
button. You can even insert notes by hand in the
looped region, as well as continuous controllers
such as volume controllers.

To quickly erase the last pass while recording a
drum track, open the Graphic Editing window and
double-click the key on the pitch ruler that
corresponds to the note you just recorded. Doing
so selects all the notes of that pitch in the track.
Then hit the delete key.

To spot-erase graphically, click the note and hit
delete.

Spot-erasing from your MIDI controller
A set of cycle-record remote controls, including a a
spot-erase function, is included in the Remote
Controls window. These controls help further
provide drum-machine style loop recording by
providing the ability to spot erase from your MIDI
controller while cycle-recording. See “Spot-erase”
on page 426 for more information.

Changing the MIDI channel or patch on the fly
While you are cycle-recording, you can change the
device, MIDI channel, or current default patch on
the fly while recording as follows:

Next/Previousitem Key to press

Device Shift up-arrow
Shift down-arrow

MIDI channel Option up-arrow
Option down-arrow

Default patch (sound) Command up-arrow
Command down-arrow

You can also map these remote controls to MIDI
keys on your MIDI controller, so that you can do
everything from your MIDI controller during
recording. See chapter 44,“Remote Controls” for
details.

Creating a permanent loop
Once you are satisfied with the loop, you can make
it permanent by inserting a loop into one or more
tracks. To insert a loop over all the tracks, double­
click one of the two repeat barline loop points in
the Tracks Overview to select the loop region and
choose Set Loop from the Change menu. To insert
a loop over only one track, select the appropriate
track segments in the Tracks Overview before
choosing Set Loop.

MULTIRECORD MODE
MultiRecord mode is used to record from several
devices simultaneously; each channel may be
recorded on a separate track. This is very useful in
transferring data from another sequencer or when
recording from several MIDI instruments simulta­
neously. MultiRecord is also useful for recording
music while slaved to Tap tempo. Refer to the
chapter Receive Sync for more information on Tap
tempo synchronization.

In addition to the steps listed in Real-time recording
above, you need to do the following to prepare for
recording in MultiRecord mode:

1 Find out what the current transmit channel is on
your controller keyboard(s) or devices.

If you are recording from multiple sources, you
may want to set each instrument or source
sequencer track to transmit on a different channel.
This helps avoid accidently merging them.

2 Choose MultiRecord from the Tracks window
mini-menu to check the menu item.

The INPUT column appears.
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3 Record-Enable the tracks that you wish to
record on.

Click on the Record-Enable button next to the
track. To toggle the record status of several tracks at
one time, just drag —“glide” — over their record
buttons. This is a great shortcut for toggling many
tracks quickly.

4 Select the input device and channel for each
track from the pop-up menus provided in the
INPUT column.

Specify the transmit channel of the
controller by choosing the appropriate
channel from this pop-up menu.

Seq-1____________

MIDI Controller devices are
provided by FreeMIDI in a
pop-up menu here.
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5 Get ready to record.

If you are sending data from another sequencer or
a time-based MIDI device, you will probably want
Performer to synchronize with it. To put Performer
in External Sync mode, see chapter 39, “Receive
Sync” (page 387). Also refer to this chapter for
information on recording while slaved to Tap
tempo sync.

STEP RECORDING
In step recording, MIDI note events are input one
at a time, not in real-time. Step recording is done
with the Step Record command on the Basics
menu. Step recording is very useful for entering
music which is too fast or complex to play
accurately in real time. It is also useful when
entering a score to be converted to music notation
programs. For details about step recording, see the
chapter 9,“Step Record” (page 101).
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THE INPUT FILTER
The Input Filter allows you to specify what types of
MIDI information are recorded.

To use the Input Filter:

1 Choose Set Input Filter from the Basics menu.

A dialog box appears.

Figure 8-6: The Input Filter allows you to control what types of data
Performer will record.

2 Choose the types of data to be input by clicking
on the corresponding check box(es).

You can choose multiple types of data. You can
choose all types of data at once by clicking on the
Set All button. You can uncheck all the check boxes
by clicking on the Clear button. Use Option-click
to check only the check box you click on,
unchecking all others; use Command-click to
check all boxes except the one you click on.

3 Press OK to confirm your choice or Cancel to
cancel it.

<•" Caution! The types of data you select will stay
in effect until you change the filter setting. The Input
Filter setting will affect all data recorded. Be
especially careful when muting types of data that
you normally don’t filter. If you don’t remember to
turn them back on afterwards, you may lose
valuable data in the future during recording.
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Specifying Controller Numbers in the Input
Filter
The buttons under the Controllers check box in the
Input Filter allow you to quickly choose which
controller data to record. Click in the Controllers
check box, click on the type of option you wish,
and then enter the controller numbers if necessary.

All: Information from all controllers will be
recorded.

All except: Information from all controllers except
the controller numbers you enter will be recorded.

Only: Only information from the controller
numbers you enter will be recorded.

To enter controller numbers for the All except and
Only options, click in the text boxes next to the
option and type in the numbers. You can use the
Tab key to move between boxes in the same option.

The'Input from MMC Devices'option
This option, when checked, allows Performer to
record MIDI data from MIDI Machine Control
devices (devices in your FreeMIDI configuration
that have the MIDI Machine property checked).
For example, you may have an MMC device such as
an automated mixer, and you may need to record
data from it, such as mix automation data. Just
keep in mind, however, that it may re-transmit
MMC commands back to Performer, which will
appear in whatever track you are recording into —
although you could avoid this by using Multi­
record. If you don’t need to record MIDI from your
MMC device(s),you can save yourself the hassle of
having to worry about recording unnecessary
MMC commands by unchecking this option.

RECORDING IN EXTERNAL SYNC
When recording in external sync other than Tap
tempo, the Record button is turned off every time
the master device stops or rewinds. This is a safety
precaution, to prevent accidental erasure of 
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previously recorded data. To record in external
sync, start the master device, wait for Performer to
lock up, and then press the record button. Refer to
the Receive Sync chapter for details on recording
while slaved to each type of external sync.

Recording while still-framed
If you are slaving to video with a VITC converter
such as Mark of the Unicorn’s Video Time Piece,
Performer allows you to remain in record mode
while the video parked on a SMPTE frame. To do
so, check the Record while still framed option in the
Receive Sync dialog box in the Basics menu.

INPUT QUANTIZE
Performer’s Input Quantize feature quantizes notes
during recording in the same fashion as a standard
drum machine. Notes get quantized immediately
as they are being received and appear quantized in
the track afterwards. If you are loop recording, the
notes will play back quantized the next time
through the loop.

NON-DESTRUCTIVE OUTPUT QUANTIZE
As an alternative to input quantizing, you can
instead apply non-destructive quantizing on
playback with the Quantize effects processor. This
preserves the original performance you record in
the track, while at the same time playing it back
quantized. The advantage to this scenario is that
you can remove the quantization at any time to
return to the original performance in the track, if
desired.

For more information, please refer to the Input
Quantize section in the Region Commands 1
chapter.
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chapter 9 Step Record

Step Record, available in the Basics menu, is an
alternative to real-time recording. It waits for you
to enter notes one at a time and allows you to
specify the duration of each. With it, you can enter
passages too complex for real-time entry. Whatever
you enter in Step Record will be rhythmically
accurate (it won’t need quantizing). This is
particularly useful for entering music for
conversion to music notation by Mosaic or other
music notation software.

QUICK REFERENCE

Current Current Dot and Motion
record step
track

double-dot buttons
duration
buttons

Figure 9- 1:TheStep Record window lets you input notes one at a time
in non-real time. You can hear the rest of the sequence play on each
step, if you like, and notes appear in the track immediately as you
record. There are also randomization settings to ‘humanize"your
step-record performance as you enter it.

The Current record track is selected from this pop-up
menu and displayed for reference. This is the track
that is being recorded into.

The Step Duration buttons allow you to set the
duration for the step.

The Dot and Double Dot buttons extend the duration
chosen with the step duration boxes by one half or
three quarters of the selected value, respectively.

The Tick box displays the duration in ticks for the
step. You can enter the duration for the step directly
by clicking in this box and typing in the number of
ticks.

The Tuplet duration box allows you to enter any kind
of tuplet: triplets, quintuplets, etc.

The Backstep button erases the previous step.

The Step button records the current step with the
chosen duration.

The Beat button records the current step and
advances you to the next beat.

The Measure button records the current step and
advances you to the next measure.

Checking the Auto Step check box causes the current
step to be recorded each time a key is let up on the
MIDI controller.

Checking the Speaker click button causes a click to
sound when a step is recorded.

The Transport lock button connects or disconnects
the Step Record window to or from the main
transport controls and counter. When connected,
Performer plays all tracks as you step, and the main
Counter follows the current step. When
disconnected, the Step Record window steps
independently of the main Counter. While
disconnected, you can step record while Performer
is playing back.

The Duration box sets the duration of the notes
being entered, where 100% is the length of the
current step.



The Offset box shifts the attack time of the note
being entered earlier or later than the current step.

The Solo Playback check box option solos the track
being step-recorded into. When unchecked, all
play-enabled tracks will play as you step.

Step Record Mini-menu
Note Durations: lets you assign a MIDI controller
such as a modulation wheel to control note
durations as you enter them.

Note Offset: Lets you assign a MIDI controller such
as a pitch bend wheel to control the note offset as
you enter notes.

Clear MIDI Events: Clears any events that are
currently shown in the step bar.

BASICS
Step Record is primarily used to enter notes and
rests. For information about how to step record
controllers, pitch bend, and patch changes, see
“Step Recording Controllers, Patch Changes, or
Pitch Bend” on page 109 in this chapter.

Step Recording Notes and Rests
A step consists of a particular duration (an eighth
note, for example). In addition, a step can contain
one or more notes that are being held over from
previous steps. All notes in a step last for the
complete duration of that step.

A step recorded passage contains a series of
adjacent steps. Each step has a duration specified
by the user. A step can contain:

■ nothing: i.e. a rest

■ struck notes: Notes with attacks at the beginning
of the step. Unless held into the next step, these will
be released at the end of the step.

■ held notes: Notes with attacks in a previous step.
Unless held into the next step, these will be released
at the end of the current step.

In Step Record, the time at the beginning of a step
is represented in measure time. In 4/4 time, a
quarter note beginning at 1121000 will last for 480
ticks, ending just before 1131000. If a second
quarter note direcdy follows the first, it will begin
on 113|000. Two eighth notes following just after
will begin on 114[000 and 1141240, respectively.

A rest is a step containing no notes. It is an “empty”
duration. Although rests are registered in the Step
Record window, they do not appear in the Event
Editing windows: they are the spaces between note
events.

Velocity information is recorded in Step Record
unless specifically disabled by the Input Filter
available from the Basics menu.

GETTING READY
Before selecting Step Record, you should do the
following:

1 Select a sequence to record into.

Play-enable the sequence in the Chunks window. If
the sequence is inside a song, open the song’s
window by double-clicking on the song, highlight
the sequence, and choose Set Record Sequence from
the Song window mini-menu.

2 Select the track you wish to record on just as you
would for real-time recording.

To do this, open the Tracks window of the sequence
you are recording into by double-clicking its name.
In the Tracks window, click the Record-enable
button next to the track. When the button is
highlighted (solid black), the track is record-
enabled. In MultiRecord mode, the first record-
enabled track in the track list will receive incoming
data. You cannot step-record into the Conductor
Track.
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3 (Optional) Open the Event List, Graphic
Editing, or QuickScribe notation window for the
track on which you are recording.

You can open all three, if you like. We highly
recommend doing so because it allows you to see
what you are step recording as you go.

4 If you are using the Graphic Editing or
QuickScribe notation windows, choose Auto Scroll
from the Basics menu.

Select the appropriate option. We also recommend
that you choose the cursor option, which produces
a scrolling cursor in the window, which clearly
indicates the current step location.

5 Set the Counter to the time you wish to start
recording.

If you want to start at the beginning of the
sequence, set the Counter to 1111000.

Track-1
n
H

Figure 9-2:The Step Record window, along with the Event List, Graphic Editing, and
QuickScribe notation windows for the track being step recorded into. Notice that since
Auto Scroll has been enabled In the Basics menu, the windows are scrolling as notes are

131
0
rsi

IS

Score (Seq-1 J

entered. Also notice that the Graphic and QuickScribe notation windows have the scroll­
ing cursor to indicate the current step location.
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[£|
Figure 9-3: The Overdub Record mode button lets you record data
into a track without erasing what is already there.

6 If you don’t want to erase pre-existing music on
the track and want to merge new material with old,
click the Overdub record mode button located just
below the main transport controls.

If there are meter changes in the passage you are
about to record, create them with the Change
Meter command.

7 If you want to include key signatures in the
passage you are about to record, create them with
the Change Key command.

Note that key signatures do not affect the actual
data; they only affect the display.

8 Select Step Record from the Basics menu.

The Step Record window appears.

The current step indicator in the Step Record
window displays the starting location for the first
step; this is automatically set to the current Counter
location.

When you are finished setting up, you will see the
Step Record window, along with one or more of the
event editing windows for the track. The notes that
you step record will appear in the event editing
windows as you proceed with step recording.

Setting Step Durations
The duration buttons are used to set step durations.
Clicking on a duration button will highlight it and
assign that duration to the step. Durations remain
set until changed, allowing you to enter a stream of
notes with the same duration very quickly.

To select more than one duration box at once, hold
down the shift key while clicking on the desired
duration box(es). When more than one box is
selected, the step duration is equal to the sum of the
selected values.

You can also select durations using the Macintosh
extended keypad. To do so, press the caps lock key
to toggle the keypad from its standard transport
functions to the step-record note-duration
functions. (You can customize how this is done in
the Remote Controls window if you like.) Press one
of the number keys to select a duration. It remains
selected until you deselect it. To deselect it, press it
again.

Setting Dotted Durations
The dot and double dot boxes can be used to
modify the selected step duration. If the dot box is
selected, it signifies a dotted step duration, i.e. one
and one half the value of the highlighted
duration(s). If an eighth note and dot are selected,
the step duration will be a dotted eighth note, i.e. a
metrical value of an eighth plus a sixteenth. If the
double-dot box is selected, it signifies a double­
dotted step duration, i.e. one and three quarters the
value of the highlighted durations. If a quarter note
and double dot are selected, the step duration will
be a double-dotted quarter note, i.e. a metrical
value of a quarter plus an eighth plus a sixteenth.
Only one of the dot boxes may be active at a time.

Entering a Tuplet Duration
The tuplet box can be used to set the step duration
to a tuplet value, allowing you to enter triplets,
quintuplets, septuplets, etc. These values are
expressed in the standard way, x in the time of/
durations. The tuplet box, when active, actually
modifies the duration you choose in the duration
boxes (including the dot and double dot
modifiers). For example, an eighth note duration is
equivalent to 240 ticks. If the tuplet box is set to “3 
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in the time of 2”, step duration (displayed in the
tick box) becomes 160 ticks, one third of a quarter
note.

To set the tuplet value:

1 Click on the Tuplet check box next to the word
“Tuplet”.

2 Enter the number of tuplet notes to be entered in
the first box.

This is the box to the left of the words “in the time
of”.

3 Enter the number of regular notes the tuplet
replaces in the second box.

Eighth note triplets, for example, are three equal
duration notes in the time of two eighth notes.
Quintuplet sixteenth notes are five equal notes in
the time of four sixteenth notes.

The tuplet box is active when the check box next to
the word “Tuplet” is highlighted. Make sure to
deselect it when you have finished entering the
tuplet values. You may enter any number of notes in
the space of any other number. Performer does all
the necessary calculations for the proper durations;
you needn’t worry about the exact number of ticks
a single tuplet duration will require.

Specifying an Exact Number of Ticks for a Step
Performer computes the number of ticks for each
duration automatically when you click on the
boxes. You can directly specify the exact number of
ticks for a step by eliciting on the tick box. The
equals sign will disappear and all duration boxes
will be deselected to indicate that you are entering
the number of ticks directly. At this time, you can
type in a new duration value. Click on any duration
box to return to specifying durations as note
values.

Choosing a Note Duration
Normally, the duration of the note being
step-entered is 100%, which makes it exactly as
long as the step itself. For example, if the step was a
quarter note, the note would be 480 ticks long.

Often, however, you might want to choose a
different duration than the length of the step. For
example, you might want to enter staccato quarter
notes: the step duration is 480 ticks, but the
duration of the notes should be much shorter—say
around 60 ticks.

To set a duration that is longer or shorter than the
current step duration, type in a percentage below
or above 100%.

The duration can be controlled on the fly using a
pitch bend or modulation wheel. For more
information, see “Step Record Remote Controls”
on page 110.

Generating Random Note Durations within a
Range
Note durations can be generated randomly within
a range. To do so:

1 Choose Note Durations from the Step Record
mini-menu.

2 In the duration range, enter the lowest and
highest percentage that you would like to use.

100% equals the current step duration, so if you’d
like to be able to enter notes longer than the step
duration, make the top value be above 10096.

3 Check the “Randomize Durations within a
range” option.

4 Click OK.
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Setting Default Step-Record Durations
Performer allows you to control the duration of the
notes that you are step-entering independently of
the step duration. For example, if you are entering
quarter notes, the step duration is 480 ticks.
However, if you would like the quarter notes to be
played in a staccato fashion, you would probably
set the duration to approximately 120 ticks or some
other value less than 480 ticks.

One way to control the duration is with the
duration option described in the section called
“Choosing a Note Duration” on page 105.

Often, however, you might like to select a different
duration for each type of note (quarter note, half
note, whole note, sixteenth, etc.). For example, you
might want quarter notes to be 80% of their step
duration, half notes to be 100%, and sixteenth
notes to be 65%, where each duration has an
independent duration.

You can set up default durations for each note
duration as follows:

1 Double-click the duration button that you
would like to set.

A dialog box appears in which you can set the
default duration for that note.

Figure 9-4: The Default Note Duration window (which you open by
double-clicking a duration button in the Step Record window) lets
you choose a duration for each note length that is different than its
step size. For example, you may want to enter a lengthy passage of
staccato sixteenth notes. I this case, their step size is still 120 ticks, but
you would want to make their duration shorter, perhaps 60 ticks.

2 Type in the desired duration.

You can either type a percentage or a number of
ticks. In either case, the other text box will update
to reflect the value you enter. For example, if you
entered 509b in the box above, the tick value box
would change automatically to 240.

3 Click OK.

4 Repeat this procedure for each desired duration.

Choosing a Note Offset
Normally, step entered notes are inserted exactly at
the tick location of the current step. The offset
option allows you shift their entry a few ticks
before or after the current step location. Offset is
ideal for passages in which you’d like to push or lay
back the feel.

To place notes a certain number of ticks before the
current step location, type in a negative number of
ticks in the offset text box.

To place the notes a certain number of ticks after
the current step location, type in a positive number
of ticks.

The offset can be controlled on the fly using a pitch
bend or modulation wheel. For more information,
see “Step Record Remote Controls” on page 110.

Generating Random Note Offsets within a
Range
Note offsets can be generated randomly within a
range. To do so:

1 Choose Note Offsets from the Step Record
mini-menu.

2 In the offset range, enter the earliest and latest
offset that you would like to use.

Use a negative number to indicate the earliest
offset, such as -15.
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3 Check the “Randomize Durations within a
range” option.

4 Click OK.

Soloing the Record Track
Normally, all play-enabled tracks play along with
you as you step record. However, if you want to
mute all other tracks in order to solo the one being
recorded into, click the Solo Playback check box.

PERFORMING STEP ENTRY
After setting the step duration, you are ready to
enter notes. When entering them, you can proceed
to each next step automatically (with the Auto Step
option checked) or manually (with the option
unchecked).

Stepping Automatically
Enter one or more enter notes with Auto Step in the
following manner:

1 Hold down one or more notes on your MIDI
controller.

2 Release the note(s) to enter the step.

When Auto Step is enabled, a step is automatically
recorded when you release a key on your MIDI
input keyboard, just as if you had pressed the Step
button. This makes entry quick and easy.

For example, using Auto Step, you could enter an
eighth note scale without using the step button: just
set the duration to an eighth note and play the scale
on your MIDI keyboard.

When using Auto Step, be aware of the following
things:

Play staccato: make sure that the notes for each step
are attacked and released crisply, with clean gaps
between the notes. If the release of a note overlaps
with the attack of the next one, you may get two 

notes in a step in which only one was intended.
Don’t worry about the duration. Remember, it is
determined by the duration option.

Wrong notes will be recorded automatically. If you
hit a wrong note, you must use the Backstep button
to erase it and re-enter the note or chord. This
differs from manual step mode in which you can
replay the notes as many times as you like before
you click on the Step button, and only those notes
being played at the moment you click on the button
are recorded.

Stepping Manually
At times, you may wish to choose when to proceed
to the next step, such as when you are holding a
note or chord through several steps. To do so:

1 Hold down one or more notes on your MIDI
input keyboard.

2 Click on the Step button.

3 Release the note(s).

This will cause one step to be recorded containing
the notes you played. Clicking on the Step button
will record those notes which are being held down
on the controller keyboard. The step will not be
completed until you press the Step button. If you
continue to hold the same notes down and press
the Step button again, the notes will be recorded as
“held” since they were not released in the previous
step.

You can use the space bar on the Macintosh
keyboard instead of pressing the Step button.

If you play a wrong note, simply play the correct
one before pressing the Step button.
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Entering Rests
Rests are entered by pressing the step, beat, or
measure buttons with no notes held down. This
records a step with no notes for the chosen
duration.

Hearing a Click After Each Step
Click the speaker click button to highlight it. When
highlighted, it causes a click to sound every time a
step is entered. This is highly recommended when
using Auto Step, as it is a useful indicator of step
completions. The volume of this click can be
adjusted with the Speaker Volume feature on the
Control Panel desk accessory; any adjustment to
the click volume must be made from the Finder.

Figure 9-5: The speaker dick button in the Step Record window title
bar produces a click every time a step is entered.

Listening to What You Have Recorded
When you are finished step recording, and you’d
like to hear what you have done, press Rewind, or
cue to the desired start measure. Then press Play.

Disconnecting the Counter From Step Record
Notice that when you rewind and play back, or do
just about anything else besides step-recording, the
Transport Lock button in the title bar of the Step
Record window unhighlights. (You can also
unhighlight it by clicking it.) This indicates that the
main Counter in the Controls Window is no longer
locked to the current step location in the Step
Record window.

Figure 9-6: The Lock button is important:it engages (and disengages)
step recording from Performer's main transport controls. If you don't
want the rest of the sequence to play as you are step-recording, turn
the lock button off.

In this mode, the Step Record window acts entirely
independently of Performer’s main transports
(play, stop, rewind, etc.), as well as the main

Counter. Thus, you can play, rewind, fast forward,
stop, and otherwise cue around in the sequence
completely independently of where you are step
recording.

In this mode, other tracks do not play along with
the track that you are step recording into. To get
them to play along, click the Transport Lock button
again to highlight it. Doing so locks the transports
to Step Record.

Connecting the Main Counter to Step Record
If, as you Step Record, you would like other tracks
to step along with you, highlight the Transport
Lock button before you begin. Doing so causes
Performer’s main Counter to follow the current
step indicator in the Step Record window. All play-
enabled tracks will play as you step through the
sequence.

(O
Figure 9-7: Turning on the Lock button engages the Step Record step
buttons to Performer's main transport controls so that the entire
sequence plays as you step record.

Changing the Current Step Location
To change the current step location:

1 Click the Current Step location to edit it.

2 Type in the desired location.

3 Press the return key.

4 If you wish to connect the main Counter to the
new Step Record location, highlight the Transport
Lock button.
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Doing so causes the main Counter to follow you as
you step, and all play-enabled tracks will play with
you as you step.

Displaying Notes as You Step Enter
Notes that you step enter appear in the event
editing windows of the track as you enter them. To
view them either during or after entry, open the
Event List, Graphic Editing, and/or QuickScribe
notation window for the track on which you are
recording. See on page 103.

Erasing the Last Step with the Backstep Button
Pressing the Backstep button will erase the step you
just entered (the one displayed just above the
current step bar). After pressing the Backstep
button, the time in the current step bar will be the
exact starting time of the step erased with the
Backstep button.

Stepping to the Next Beat or Measure
The Beat and Measure buttons are special step
advance buttons. They compute the duration
necessary to get to the next beat or measure: the
step is recorded using that duration and you are
advanced to the next beat or measure for the next
step. For example, if the current step is on 2| 11212
and the meter is 4/4, when the Beat button is
pressed, a step of 268 ticks will be recorded and the
next step will be entered at 2|2|000. If the Measure
button is pressed, a step of 2|268 (2 quarter notes
and 268 ticks) will be entered and the next step will
be entered at 3| l|000.

Changing the Current Record Track
To change the current record track, click the
“Recording on...”pop-up menu and select a
different track.

Figure 9-8: Choosing a track to step-record into.

Adding to Existing Material in a Track
You can add to existing material in a track as long
as you first turn on Overdub record mode with the
Overdub record button in below the main
transport controls. Otherwise, the newly step
recorded data will replace existing data in the track.

Step Recording Controllers, Patch Changes, or
Pitch Bend
To step record a controller event, patch change, or
pitch bend event:

1 Play the event.

The event appears in the current step bar.

| Current St»p: 1|3|240 ~ 0

2 Press the Step button or any other motion
button to record the event.

Events, such as patch changes, controllers, and
pitch bend do not trigger auto step. In these cases,
play the event and proceed to the next step by
pressing the Step button (or any other motion
control button.)
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STEP RECORDING DURING PLAYBACK
Step recording can be done during playback. For
example, you can step record notes into a loop and
have Performer play back the loop in real time as
you build the loop. This can be ideal for building
drum loops with Step Record.

To Step Record into a loop during playback:

1 Choose Step Record from the Basics menu and
unhighlight the Transport Lock button in the title
bar of the Step Record window.

This disconnects the main Counter from Step
Record.

2 Set up a loop in a track.

If necessary, you can initially make the loop repeat
infinitely while you are building it and later on
change it to the desired number of repetitions.

3 Choose the track with the loop from the
“Recording on” pop-up menu in the Step Record
window.

4 Click the Overdub record button located just
below the main transport controls to enable
Overdub record mode.

This allows you to step record over the same region
in the loop without erasing existing material in the
region.

£
5 Set up any other Step Record options as desired,
such as Solo Playback and Auto Step.

6 Press the Play button to begin Playback.

As the sequence plays, notice that the Current Step
in the Step Record window remains where you
begin.

7 Pop-edit the current step counter to set it to the
location where you want to begin step-recording.

8 Begin Step Recording as desired.

9 When you reach the end of the loop, pop-edit
the current step indicator to step record the next
pass through the loop.

As Performer keeps playing, you can repeat this
step as many times as necessary as you build the
loop. As you build it, you will continue to hear it
playback.

10 When you are finished, press Stop.

STEP RECORD REMOTE CONTROLS
All of the functions in the Step Record window are
available as remote controls in the Remote
Controls window. This allows you to map them to
your MIDI controller so that you can perform the
entire step recording process from in front of your
MIDI instrument, rather than in front of your
computer screen.

Figure 9-9: The Step Record remote controls.
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Important note! Be careful about the other
Remote Controls, such as the Transport controls or
the Chunk Select controls. Be sure that you have
either disabled them (with their group master) or
remapped them so that they do not interfere with
the notes that you are step recording. See
chapter 44,“Remote Controls” (page 421) for
information about how to remap and disable
groups of remote controls.

Controlling Duration with a MIDI Controller
You can set up Step Recording such that a mod
wheel or other continuous controller controls the
duration of the notes being inserted.

To assign a pitch bend wheel, mod wheel, or data
slider to the duration: 

1 Choose Note Durations from the Step Record
window mini-menu.

□ Ust MIDI Remott Control
□ Randomize durations within ranae

Duration Range: |1 __ | to |1OO J’S

Mtt>l Remote Control
|A«1 | Range[O___ __ | to |127 J

Figure 9-10: The Note Durations feature lets you adjust on the fly the
durations of the notes you are step-recording with an external MIDI
controller, such as the pitch bend wheel on your controller keyboard.

2 For duration range, enter the lowest and highest
percentage that you would like to use.

100% equals the current step duration, so if you’d
like to be able to enter notes longer than the step
duration, make the top value be above 100%. The
maximum value you can enter is 200%.

3 For the MIDI Remote Control, enter the
controller type, and enter a range of controller
values that will be mapped to the duration range
you specified above.

For example, if you specify a duration range of 50%
to 150%, and you specify a controller range of 0 to
100, when you move the mod wheel (pitch bend
wheel, or data slider) to 100, the duration will be
set to 150%. Likewise, if you move the controller to
0, the duration value will be set to 50%. You can
enter any of the above values by highlighting the
text box with the tab key and moving the controller
wheel or slider.

Tip: use your pitch bend wheel so that you can
always “snap” back to each note’s normal duration.

4 To enable MIDI Remote Control, click the MIDI
Remote Control check box.

5 If you wish notes to be assigned a random
duration within the duration range you’ve chosen,
click the “Random Duration within range” check
box.

6 Click OK to confirm your choices.

Now you can control the duration with your mod
wheel. As you move the wheel, notice that the
duration value changes in the Step Record window.

Controlling the Offset with a MIDI Controller
You can set up Step Recording such that a mod
wheel or other continuous controller controls the
offset of the notes being inserted.

To assign a pitch bend wheel, mod wheel, or data
slider to the offset:

1 Choose Note Offset from the Step Record
window mini-menu.
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MIDI Remote Control *"“
I- | Pvngel-0192 | to |8191 |

a Subtract offset from durations j
□ Use MIDI Remote Control
□ Randomize offset within ranns

Figure 9-11: The Offset feature lets you adjust on the fly the place­
ment of the notes you are step-recording with an external MIDI
controller, such as the pitch bend wheel on your controller keyboard.

2 For the offset range, enter the earliest and latest
value over which you would like to set the offset.

Type a negative tick value in the first text box for
the earliest value; type a positive tick value in the
second box for the latest value.

3 For the MIDI Remote Control, enter the
controller type, and enter a range of controller
values that will be mapped to the offset range you
specified above.

For example, if you specify an offset range of -15 to
15, and you specify a controller range of 0 to 100,
when you move the mod wheel (pitch bend wheel,
or data slider) to 100, the offset will be set to 15.
Likewise, if you move the controller to 0, the offset
value will be set to -15. You can enter any of the
above values by highlighting the text box with the
tab key and moving the controller wheel or slider.
The minimum is -240 ticks and the maximum is
240 ticks.

4 If you would like the note’s duration to be
maintained, check the “Subtract offset from
durations” option.

5 To enable MIDI Remote Control, click the “Use
MIDI Remote Control” check box.

6 If you wish notes to be assigned a random offset
within the range you’ve chosen, click the
“Randomize offset within range” check box.

7 Click OK to confirm your choices.

Using the Macintosh Keypad
In addition, the step record commands are mapped
to the Macintosh keypad as shown below. The caps
lock key must be down to use these key
assignments. Pressing the key performs the same
actions as pushing the buttons in the Step Record
window, with one exception: a duration remains
selected until you press it again; pressing a different
duration does not deselect currently selected
durations. This allows you to easily specify a
composite duration (such as an eighth and a
quarter). To clear all durations, use the Clear key
on the keypad.

Figure9-12:The Macintosh extended keypad assignments for
Performer's Step Record controls.These assignments are activated by
pressing the Caps Lock key.
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BE CAREFUL
Step recording will record over previously
recorded material in the same time span in the
track. Use Overdub record in the Consolidated
Controls Panel if you want to merge your step
recorded material with what is already on the track
in that time span.

If you enter notes or backstep quickly, the display
might temporarily be suspended in order to
accurately process the events. Don’t worry: as soon
as you slow down or stop entering or backstepping,
the display will catch up.

You may find that velocities recorded in step record
are uneven. If this occurs, you can edit them by
selecting the step recorded region and using the
Change Velocity command in the Region menu to
set all velocities to the desired values.

Be sure to uncheck the tuplet box as soon as you are
through with it; otherwise, subsequent durations
will be incorrect.

HINTS
If you discover that you’ve left out a note after step
recording, use the Shift command on the Edit
menu to remove or add extra space to avoid having
to re-enter the entire passage again.

To enter a chord with staggered releases, use
manual stepping.

You can enter chords with more than five notes
(one hand’s worth) by making two or more
recording passes, for instance, one for each hand of
a piano part. This can be done by recording on
separate tracks or by using overdub record to
merge in the second part.

If there are a number of duration changes in a step
record passage, it may be easier to choose the
smallest common duration value and hold notes
through steps to create longer durations. For

I step Record

example, a half note can be entered by holding an
eighth note over four steps. If the passage you are
entering is rhythmically complex, it may be best to
use manual stepping (Auto Step off) in order to
keep track of each step entered.
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chapter io Mixing

Performer’s Mixing Board window provides a
powerful integrated mixing environment for both
MIDI and, if you are working with Digital
Performer, audio tracks. It also provides access to
real-time effects processing for both MIDI and
digital audio tracks, including access to
Digidesign’s powerful TDM mixing and effect
environment, as well as the built-in EQ capabilities
of Audiomedia II and non-TDM Pro Tools
systems.

The Mixing Board will seem familiar because it is
modeled after standard hardware consoles.
Lurking under the hood, however, are many
powerful features, as well as many time-saving
shortcuts. This chapter covers them all.

Here is an overview of the main topics covered in
this chapter:

■ “Quick Reference” on page 116

■ “Mini-menu” on page 118

■ “Mixing Board window basics” on page 119

■ “Track strips” on page 121

■ “Automated mixing” on page 124

■ “Mixing in real time” on page 125

■ “Grouping” on page 125

■ “Remote control” on page 126

■ “The Effects window” on page 127

■ “The MIDI Effects Processors” on page 129

If you are working with Digital Performer, also see
the Guide to Digital Audio for important special
information about mixing digital audio tracks.



QUICK REFERENCE

Track Insert
Section

MIDI effects processors

Tracks

Solo/mute/Auto

Pan

Mix Mode menu

Turn Mix Mode Off j

Nev/ Mix
Rename Mix
Duplicate Mix

Mb: 1 2

Delete Mix

Track'

Figure 10-1: The Mixing Board gives you a fully
automated mixing environment.
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Track list: Click or drag over the names of the
tracks in this list to show or hide them in the
Mixing board. Option-click to hide all except the
track you click; command-click to show all except
the track you click.

Snapshot button: Takes a snapshot of the current
settings for all visible pan and volume controls in
the mixing board for every track currently being
displayed. Command-click to include all tracks
(even ones not currently displayed). The snapshot
inserts controller events in each track at the current
main counter location. This can be done while
Performer is stopped or playing back.

Show/Hide Track list: Shows and hides the list of
tracks at the left side of the window.

Track Insert Section: Displays real-time
processing inserts for MIDI and, if you are working
with Digital Performer, audio tracks. Choose the
desired effect from the insert pop-up menu, or
click a menu to open an effects window for the
insert. MIDI track inserts consist of MIDI
processing effects such as the transposer and
velocity compressor. Audio inserts consist of TDM
plug-in effects, such as EQ, dynamics, reverbs,
delays, and any TDM-compatible plug-ins you
currently have installed in your system. Built-in EQ
is also provided on Audiomedia II and non-TDM
Pro Tools systems.

MIDI effects processors: MIDI effects processors
are non-destructive, real-time output processors
that affect the track’s playback. The choices are:
Shift, Quantize, Transpose, Velocity Compressor,
and Echo. These effects only affect playback and
can be changed or turned off (bypassed) at any
time. They do not modify the original data in the
track.

I MIXING

Audio effects processors: If you are using Digital
Performer, these are real-time, non-destructive
audio processing inserts that can be applied to
audio tracks. Choices depend on your audio
hardware.

Solo/Mute/Auto: These buttons perform standard
soloing and muting functions. When the Auto
button is turned off, volume and pan automation
data in the track is temporarily disabled. “Glide”
horizontally across these buttons with the mouse to
quickly toggle several tracks at once.

Pan: For MIDI tracks, the pan knob generates
standard MIDI pan controller data (controller
#10). Typically, this controls the panning of the
MIDI track across the main stereo outputs of the
MIDI synthesizer, although this depends entirely
on the instrument. If you are working with Digital
Performer, the pan knob pans an audio track
across its pair of outputs, as assigned in the Tracks
list window. For example, if a track is assigned to
outputs 3 and 4, pan left sends the track to output
3; pan right sends it to 4. For MIDI tracks, these
pan pots generate standard MIDI panning data.
Double-click the pan knob to go to pan center. If
automation data has been recorded, knobs animate
during playback (when the Auto button is
enabled).

Faders: Control volume for each MIDI and, if you
are working with Digital Performer, audio track by
generating MIDI and audio volume events, which
can be recorded into the track for automation. If
automation data has been recorded, faders animate
during playback (when the Auto button is
enabled).

Level Meters: If you are working with Digital
Performer, the level meters display the audio
output level for each audio track as determined by
the soundbite velocities and volume controller data
in the track. For MIDI tracks, the level meters
indicate MIDI note-on velocities.
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Tracks: Each strip in the Mixing Board represents a
MIDI or audio track in the currently play-enabled
sequence. Show or hide them as desired using the
Show/Hide track list (described above). Drag the
track strip name horizontally to re-order them.

Mix Mode menu: Lets you create and manage
multiple mixes for a sequence. A mix consists of all
of the volume and pan automation data in all
tracks, as well as all of the current effects insert
assignments and their settings. You can duplicate a
current mix and then modify it, or start from
scratch by creating a new, blank mix. Volume and
pan automation data for the current mix is
recorded into tracks as usual with the Mixing
Board controls, or with the other continuous
controller features in Performer. Once you’ve
created more than one mix, you can instantly
switch between mixes by choosing them from this
menu.

MINI-MENU
The top section of the mini-menu displays
checkable menu items that show and hide each
section of the console. Checked items are visible.
Unchecked items are hidden. Hold down the
option key to hide all sections except the one you
choose; use the command key to show all sections
except the one you choose. If the Auto Resize
command is checked, the console window will
automatically resize itself when sections are shown
or hidden.

Auto Resize: When checked, this menu item causes
the Mixing Board window to resize itself when
sections or tracks are shown or hidden.

Load Board Layout: Redraws the window with the
mixing board layout that you choose from the sub­
menu. A layout consists of which tracks and
sections are currently showing in the window.
There are several preset layouts, such as Show
Everything, which shows all tracks and sections.
You can also load a layout that you have previously 

created with the Save Board Layout command. A
shortcut for this command is to option-click the
title bar of the Mixing Board window.

Save Board Layout: Saves the tracks and mixer
sections currently being shown in the window as a
customized board layout, which you can name,
save, and recall at later time using the Load Board
Layout command described above.

Delete Board Layout: Discards the customized
board layout that you choose.

Edit Group: Lets you add or remove faders or pan
knobs from an existing group.

Create Group: Lets you create and name a group of
volume faders and/or pan pots that will move
together when you move any member of the group.
To add or remove items from the group, choose the
Edit Group command after creating it.

Delete Group: Discards a fader or knob group that
you created.

Attach MIDI Controller: Lets you connect a mixing
board fader or knob to an external MIDI
controller, such as a mod wheel.

Clear MIDI Controller: Removes the connection to
an external controller from the knob or fader that
you select with the cursor.

Auto Punch-In/Out: A special record mode for
volume faders and pan pots which causes them to
record data into their track only when the control
item is moved, either with the mouse or an external
source.

Auto Punch-Out Delay: Allows you to adjust the
delay before punch-out when you are in Auto
Punch-In/Out mode and are controlling a control
item from an external MIDI source. The Punch-
Out time is the amount of time (in tenths of a 
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second) after the last event is received by a control
item from its external source before the control
item drops out of Record.

Min Time and Value Change: Allows you to set the
minimum amount of time between volume and
pan events that the mixing board controls will
generate when you move them. Also lets you
choose the minimum value change. Raising these
values can prevent unnecessarily high data density.
But raising them too high can result in zipper
noise, or audible “stepping” during smooth
changes.

MIXING BOARD WINDOW BASICS
The mixing board is a track-based mixing console
for all MIDI and, if you are working with Digital
Performer, audio tracks. It has one strip for each
track in the sequence.

Opening the Mixing Board
To open the Mixing Board, choose the Mixing
Board command from the Windows menu. If you
have tracks selected at the time, the mixing board
will appear with only those tracks showing. If you
have multiple sequences in the file, it chooses the
sequence to open by the front-most window on the
screen, or alternately, by which sequence is
currently play-enabled.

Showing and hiding tracks
To choose which tracks you want to display, click
the track list button in the title bar as shown below
to open the track list. Then just click tracks to
either show them or hide them. Option-click to
hide all except the track you click; command-click
to show all except the track you click.

Figure 10-1: Showing and hiding tracks.

Changing the order of the track strips
To move tracks left or right, drag them by their
name at the bottom of the strip.

Showing and hiding sections
Use the section names at the top of the Mixing
Board window mini-menu to show and hide
console sections, such as the Inserts section.
Checked items are visible. Unchecked items are
hidden. This allows you to optimize the console
appearance for your screen size. Hold down the
option key to hide all sections except the one you
choose; use the command key to show all sections
except the one you choose. If the Auto Resize
command is checked, the console window will
automatically resize itself when sections are shown
or hidden.
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Figure 10-2: A simplified mixing board layout with several sections
hidden, including inserts.

Saving custom board layouts
If you have favorite board layouts that you use
frequently, you can save them and later recall them
by name. To create a custom board layout:

1 Using the window’s show/hide track list, show
the tracks you want to include in the layout; hide
tracks you don’t.

2 Using the show/hide section mini-menu
commands, show the sections you want to include
and hide the ones you don’t.

3 Choose Save Board Layout from the mini­
menu.

4 Type in a name for the layout and click OK.

Switching board layouts
There are several ways to change board layouts:

■ Choose the layout you want from the Load
Board Layout mini-menu command

■ Option-click the Mixing Board window title bar
and choose the layout you want from the pop-up
menu
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Figure 10-3: Saving and loading customized board layouts.

Renaming board layouts
To rename a board layout, choose the Rename
Board Layout sub-menu item from the Load Board
Layout mini-menu command.

Manually resizing the Mixing Board window
You may notice that the mixing board window
automatically resizes itself when you add or remove
tracks, show or hide sections, or switch board
layouts. This is because the Auto Resize mini-menu
command is checked. If you would prefer to resize
the window manually using the grow box in the
lower right corner, uncheck Auto Resize.

Switching sequences
To quickly switch the sequence you are looking at
in the Mixing Board window, command-click the
window’s title bar and choose the desired sequence
from the pop-up menu. The tracks shown in the
Mixing Board will change when you change the
play-enabled sequence.

mixing |



TRACK STRIPS
Each MIDI and audio track strip has the sections
shown below.

Solo /Mute /Auto

Pan and pan readout

Volume fader

Inserts

Figure 10-4: A Mixing Soard track strip.

Inserts
An insert is a real-time effect that is non-
destructively applied to the data in the track on
playback. MIDI tracks can be processed with a
Velocity Compressor, Transposer, Shift, Quantize,
and Echo. If you are working with Digital
Performer, audio tracks can be processed by built-
in EQ (with audio hardware that supports it) or by
TDM plug-ins (with hardware that supports TDM)
such as reverb, dynamics, delays, or any TDM-
compatible plug-ins you currently have installed in
your system.

Each insert in the track is represented as a pop-up
menu from which you can choose the desired
affect. Up to 5 inserts can be simultaneously
applied to an individual track. When you select the
desired processor type from a pop-up menu, the

Effects window opens to display the selected
processor’s parameters. See “The Effects window”
on page 127 for more information.

Selecting audio effects during playback causes
audio playback to pause while the change is being
made. This is normal.

The signal for a track passes through the inserts
from top to bottom. Accordingly, inserts are
labelled A, B, C, etc. from top to bottom. Similar to
hardware mixing consoles, the order in which
effects are applied makes a difference, so keep this
in mind when employing multiple inserts.

If you are working with Digital Performer, Audio
effects are applied pre-fader, so it is possible to
accidentally cause clipping if you boost insert gains
too high. Be careful when setting insert levels in the
Effects window.

Insert settings apply globally to the entire track and
are remembered until you change them, even if you
open the file using a non-TDM system and then re­
open it again on a TDM system.

Effects cannot yet be automated in Performer 5.5.
Look for this feature in a future version.

Solo and Mute buttons
Solo and Mute buttons perform standard soloing
and muting functions for each track. In fact, they
correspond directly to the soloing and muting
features in the Tracks List window. For example,
when you mute a track in the Mixing Board, its
play-enable button becomes disabled in the Tracks
List window.
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When soloing and muting, the volume fader
background color changes to indicate the playback
state of the track as follows:

Fader background color Meaning

Color screen Black & white

Blue Dark gray Track can play

Orange Light gray Track cannot play because at
least one other track is soloed

Gray White Track is muted

Auto buttons
When the Auto button is turned off, volume and
pan automation data in the track — including
controller chasing — is temporarily disabled,
allowing you to override the automation data with
the current pan knob and volume fader setting.

Auto buttons cannot be turned on and off
during playback or recording.

Button shortcuts
The table below describes several shortcuts for the
Solo, Mute, and Auto buttons:

To do this

To solo or mute all tracks except
the one you click

Do this

Command-click the
track’s solo or mute but­
ton

To unsolo or unmute all tracks
except the one you click

Option-click the track’s
solo or mute button

Drag across the buttons
horizontally with the cur­
sor

To change the solo, mute, or
auto setting for several adjacent
tracks quickly

Panning
For MIDI tracks, Pan knobs generate standard
MIDI panning controller data (controller #10).
The data range for MIDI tracks is zero to 127,
where zero is hard left. The data range for audio
tracks is <64 (hard left) to 63> (hard right).

If you are working with Digital Performer, these
pan pots pan an audio track across its pair of
outputs, as assigned in the Tracks list window. For
example, if a track is assigned to outputs 3 and 4,
pan left sends the track to output 3; pan right sends
it to 4.

Figure 10-5: Gliding across the Solo, Mute, and Auto buttons. You can combine gliding
with the command and option key modifiers as described in the table above.
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Below is a summary of techniques for pan knobs:

Do thisTo dothis

Change panning
smoothly over time

Drag the pan knob up and down or
left and right, or clicK on the num­
ber in the value readout and drag
up or down

Go directly to pan
center

Double-click the knob

Increment or decre­
ment the pan setting
by one

Click the left or right arrow button

Volume faders
The volume faders control the output level for each
MIDI and audio track by generating MIDI and
audio volume events, which can be recorded into
the track for automation. If automation data has
been recorded, faders will animate during playback
(when the Auto button is enabled).

The background color of volume faders changes
depending on the solo and mute state of the track.
See “Solo and Mute buttons” on page 121 for
details.

Below is a summary of mousing techniques for
changing the values of Mixing Board volume
faders:

Drag the handles to
change the slider's
value smoothly.

Drag up and down on
these arrows to change
the number smoothly.

Drag up and down on
the fader value to
change the number
smoothly.

Press the+/-buttons to
move the slider smoothly.

Click anywhere on
the bar to snap the
slider to that
position.

Click the fader value
directly to type in a
number.

Click the+/-buttons to
move the slider by one.

Figure 10-6: The many ways to control a fader.

Controlling pan and volume from an external
MIDI controller
To control a volume fader or pan knob from an
external MIDI controller such as a mod wheel on a
keyboard, use the Attach MIDI Controller
command in the Mixing Board window mini­
menu as described later in this chapter in “Remote
control” on page 126.

Level meters
For MIDI tracks, the level meters indicate MIDI
note-on velocities only (the fader indicates
controller #7 MIDI volume).

For audio tracks, the level meters display the audio
output level for the track as determined by the
volume controller data in the track. The Set Level
Meter Range mini-menu command in the Audio
Monitor window controls the dynamic range
displayed in the Mixing Board level meters.

Making the Mixing Board look like a meter
bridge
Option-selecting the level meter mini-menu
command in the Mixing Board window creates a
meter bridge, which you can save as a custom
board layout.
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Track name
Track names appear here, with an ellipsis for long
names, if necessary. You can drag a name
horizontally to reposition its channel strip in the
Mixing Board window.

AUTOMATED MIXING
The Mixing Board is a powerful environment in
which to automate the combined mix of your MIDI
and audio tracks. This section explains how to
accomplish basic mixing tasks with the Mixing
Board.

Most of these procedures are identical to
working with sliders in Performer’s custom console
feature.

The importance of event chasing
Automated mixing in Performer is heavily
dependent on event chasing. Event chasing causes
Performer to always scan tracks for MIDI and
audio controller events to make sure that playback
levels are correct, regardless of where you start
playback. (For complete information, see “Event
Chasing” on page 89.)

For a consistency during the mixing process, it is
best to enable event chasing for MIDI controllers
and, if you are using Digital Performer, audio
volume and audio pan. To do so, choose the Set
Event Chasing command from the Basics menu and
make sure that these items are checked.

Setting initial levels with the Mixing Board
Regardless of whether you plan to automate your
mixing directly in Performer or externally using an
automated mixing console or other hardware
automation system, it is always best to set initial
volume and pan settings in all of your tracks. This
ensures consistency in your mix, gives Performer
an initial setting to chase to, and gives you a basis
for any changes made later in each track.

In Performer’s MIDI tracks, there is no default
volume or pan setting per se, which means that
when you first open a new or existing Performer
file, the pan and volume settings for each track will
be in whatever state they were last left in the MIDI
device itself. Setting initial levels takes care of the
consistency problems that arise from this situation.

In audio tracks, Digital Performer defaults to pan
center and unity gain. For example, if you open a
new file, open the mixing console, and press play,
the volume faders for the audio tracks will snap to
their maximum position (assuming that their Auto
buttons and event chasing haven’t been turned off).
Obviously, you’ll want to set initial lower levels so
that you have room to mix.

The procedure for setting initial values is simple:

1 Open the Mixing Board.

2 Show all tracks you wish to initialize; hide ones
you don’t.

Use the show/hide track list as shown in Figure
10-1 on page 119. Tracks don’t actually have to be
visible on the screen, just selected in the track list.

3 Rewind Performer to the beginning of the
sequence (or locate to wherever you’d like to place
the initial settings).

4 Make the desired volume and pan settings for
each track.

5 Click the Snapshot button in the Mixing Board
window title bar.

Command-click the button to capture all controls,
including ones that are not currently showing in
the window.



Figure 10-7:TheSnapshotbutton.

If you change your mind, you can undo the
snapshot.

Making snapshots elsewhere in the mix
You can make snapshots as described above
anywhere in your Performer mix.

Changing initial levels (or any snapshot)
You can change your initial settings at any time, or
any snapshot for that matter, by queuing to the
same tick location in the main counter and
repeating the procedure described earlier in
“Setting initial levels with the Mixing Board”. The
snapshot feature will never duplicate controller
data on the same tick, replacing existing data with
the new snapshot value if data already exists at that
location. Just make sure the main counter is exactly
at 1111000 (or wherever your initial settings are
located).

MIXING IN REALTIME
Once you have set initial levels, you have
established a basis from which to create automated
changes in the mix by recording in real time. The
next few sections explain how to do so.

Turn off all track record-enable buttons before
you start recording a mix
When the Mixing Board window is the front-most
(active) window, Performer allows you to start
recording without having a track record-enabled.
But be sure to turn off all record-enable buttons in
the Tracks window before you begin recording a
mix to avoid accidentally erasing notes,
soundbites, or other data.

After doing so, click the Mixing Board window title
bar (or choose it by name from the Windows
menu) to make it the active window.

Recording fader moves
Once you’ve made the above preparations, you are
ready to record. Just press the record button in the
Control panel and drag faders as desired. All of
your moves will be recorded in real time, including
entire fader groups when you move them.

Faders automatically punch in when you drag them
and punch out when you release them, so you can
punch in on top of existing automation data on the
fly.

Controlling data density
The Min Time and Value Range mini-menu
command in the Mixing Board window lets you
control the density of the automation data events
generated by the Mixing Board faders and knobs.
Higher minimum values produce lower density,
which generally ensures smoother playback
performance. But densities that are too low can
cause zipper noise or “stair-stepping”. When
experimenting with data density, factors such as
playback tempo also come into play.

Editing your mix graphically
Keep in mind that all of the procedures above
describe the mixing process from the standpoint of
the Mixing Board. You can also edit your mix
graphically in the Graphic Editing windows for
both MIDI and audio tracks (if you are using
Digital Performer).

GROUPING
The Mixing Board allows you to create an
unlimited number of fader and/or knob groups.
Once a group is created, dragging any fader within
the group moves all members of the group, scaling 
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them proportionally to their current values.
Option-dragging temporarily overrides the group
to adjust a control relative to the group.

Creating a new group or modifying an existing
one
To create a fader group or modify an existing one:

1 If you are creating a new group, first choose
Create Group from the Mixing Board mini-menu,
type in a name for the group, and click OK.

2 If you are modifying an existing group, choose
Edit Group from the Mixing Board mini-menu and
select the group you just created from the sub­
menu.

After either step 1 or 2, the cursor turns into a plus
sign to indicate that you are now ready to add (or
remove) faders and/or knobs from the group.
Existing faders in the group display a flashing green
(or black) box.

3 Click the faders (and/or knobs) you want to
add.

A flashing green (or black) box appears around the
fader to indicate that it has been added to the
group.

4 To remove faders (and/or knobs) from the
group (ones that already have a flashing box), click
them.

5 When you are finished adding and removing
items, press the return or enter key to confirm the
group, or double-click the last item you want to add
or remove.

To cancel, press command-period, the escape key
(esc), or click elsewhere in the window (such as the
title bar).

Temporarily overriding the group on the fly
To temporarily override a group when moving a
fader, option-drag it. This allows you to adjust a
tracks level relative to the rest of the group.

Deleting and renaming groups
To delete or rename a group, use the Delete Group
and Edit Group/Rename Group mini-menu
commands.

Temporarily disabling automation
You can temporarily disable the automation data in
a track by turning off the track’s Auto button in the
Mixing Board (shown in Figure 10-4 on page 121)
or the Audio Graphic Editor.

REMOTE CONTROL
You can control any of the faders or knobs in the
Mixing Board from any external source that can
generate MIDI controller data, such as a mod
wheel on your controller keyboard, a MIDI fader
box such as JL Cooper’s FaderMaster™, or a battery
of faders on a MIDI-controlled mixing console
such as Yamaha’s ProMix 01™.

Attaching a MIDI controller to faders and
knobs
Use the Attach MIDI Controller command to set up
external control of faders and knobs as follows:

1 Choose Attach MIDI Controller.

The cursor changes to a plus sign.

2 Click the fader or knob you wish to control
externally.

A red box appears around the control indicating
that Performer is waiting for an incoming MIDI
controller event.

3 Transmit the data from your MIDI Controller
and the box flashes green.
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Only MIDI continuous controller data can be used;
pitch bend, note-ons, etc. cannot.

4 (Optional) Click another fader or knob, or use
the arrow keys to move the flashing box around to
attach other controls in a similar fashion.

5 When you are done attaching controllers, press
return or enter, or double-click the last item you
attached.

To cancel, press command-period, the escape key
(esc), or click elsewhere in the window (such as the
title bar).

Clearing MIDI controllers
Use the Clear MIDI Controller command to
display all controls that have MIDI controllers
attached. They all flash green. Click a control to
detach it from the controller. Type Return or Enter
to confirm the detachment or command-period to
cancel.

Setting the punch-out delay
When you record a fader or knob via remote
control, it punches in and out in much the same
fashion as when you grab it with the mouse. To
punch in, the fader or knob waits to receive an
event from its external controller. When it does, it
punches in. Punch out, however, is done
automatically by Performer and is determined by
the amount of time after the last event was received
from the controller. Since controllers send data
with different degrees of sensitivity, you may find
that punch out occurs too frequently. To avoid
stuttering the punch out, you can lengthen the
delay before Performer punches out with the Auto
Punch-Out Delay command in the Mixing Board
window mini-menu.

THE EFFECTS WINDOW
The Effects window is a like a virtual effects rack
for Performer’s real-time, non-destructive MIDI
and (if you are using Digital Performer) audio
processing effects. It displays all of the controls for
a given effect on a given insert on a certain track.
You can quickly and easily switch the effect, insert,
and track you are viewing in the Effects window at
any time.

The effects window settings modify the track’s
playback only. The original data in the track is not
changed. As a result, effects settings can be
adjusted or turned off (bypassed) at any time.

MIDI, audio, and TDM effects
The Effects window provides velocity
compression, transposition, time shifting,
quantizing, and echoing for MIDI tracks. If you are
using Digital Performer, built-in EQ is available for
hardware configurations that support it. For
example, AudioMedia II has one EQ, and Pro Tools
has two. The Effects window also provides access to
all TDM-compatible plug-ins installed in your
system for audio hardware systems that support
TDM.

How effects settings apply to a track
Effects settings apply globally to the entire track
and are remembered until you change them, even
if, when using Digital Performer, you open the file
using a non-TDM system and then re-open it again
on a TDM system.

Effects cannot be automated in Performer 5.5.
Look for this feature in a future version.

MIXING
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Effects can be applied to Patch Thru
MIDI Effects processors can be applied to any
musical input that you are Patching Thru. To real­
time process a patched thru signal:

1 Assign the desired MIDI Effects insert to a track
in the Mixing Board window insert section.

2 Record-enable the track in the Tracks window.

3 Play your controller.

Performer does not have to be playing back for the
effects processor to be applied to your input signal.

Opening the effects window
There are several ways to open the effects window:

■ Choose an effect from any insert pop-up menu
in the Mixing Board window

■ Click an insert pop-up menu that already has an
effect

■ Choose Effects from the Windows menu

Quick reference
Below are the basic controls in the effects window.
The controls for each specific effect will, of course,
vary.

The rack

menu

The
Insert

menu

Effect

menu

The Effects window with no
effect currently being displayed.

Use the pop-up
menus to switch
the track, insert,
and/or effect
being displayed.

Figure 10-8: Digital Performer's Effects window.

Choosing a new effect for an insert
To choose an effect for an insert, select the desired
effect from the insert pop-up menu. When creating
a new effect, Performer uses the most recent
settings for that effect. For example, if you tweak
quantize parameters on one track until they are
just right, adding the quantize effect to another
track will initially apply the same settings.

Opening an existing effect on an insert
To open an existing effect on an insert, click the
insert pop-up menu.
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Copying and pasting parameters from one
insert to another
You can copy and paste effects parameters from
one insert to another. Just choose Copy from the
Edit menu while a specific insert’s effect is being
displayed, switch to a different insert with that
same effect, and choose Paste.

Effects settings are remembered
Effects settings are saved with the file. In addition,
the settings for each insert and track are
remembered even if you temporarily remove the
effect and re-apply later on. In Digital Performer,
settings are also remembered if you switch audio
hardware. For example, if you add TDM effects,
switch to a non-TDM system and save the file, the
TDM effects remain saved with the file, so that they
will still be there when you switch back to a TDM
system.

THE MIDI EFFECTS PROCESSORS
Performer currently provides five MIDI effects,
which are described in the following sections:

■ Velocity compressor

□ Transposer

■ Quantize

n Shift

■ Echo

Velocity compressor
The graph shows the result of the compression
settings. A diagonal line from lower left to upper
right represents no compression. The higher the
ratio, the higher compression. Gain allows you to
raise or lower the overall level while compressing.
Threshold sets a cutoff value, below which no
compression will occur.

This diagonal line repre­
sents no compression.

Currentcompression
settings

Oto 127grid

Figure 10-9: The Velocity compressor effects processor.

Transposer
Choose the type of transposition you would like:
either by a single interval or using a custom
transpose map you have created with Transpose
command in the Region menu. With interval
transposition, enter any interval you like in the
value boxes provided by editing the pitch text box
(type, drag up/down, or use MIDI entry). The
specific pitches do not matter: the interval between
them determines the degree of transposition. For
example, to transpose an octave up or down,
choose C4 or C2, respectively.

The Harmonize option causes the newly
transposed data to be combined with the original
data, so that the both play simultaneously.

Figure 10-10: The Transposer effects processor.

Quantize
The Quantize effects processor is identical to the
Quantize command in the Region menu, except, of
course, that it has no permanent effect on the data
in the track. Since it only affects data upon 
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playback, it can be adjusted and even turned off
(bypassed) at any time. For details on Quantize
options, see “Quantize” on page 227.

Figure 10-11: The Quantize effects processor.

Shift
The Time Shift effects processor is identical to the
Shift command in the Edit menu, except, of course,
that it has no permanent effect on the data in the
track. Since it only affects data upon playback, it
can be adjusted and even turned off (bypassed) at
any time. For details on Shift, see “Shift” on
page 223.

Figure 10-12: The Time Shift effects processor.

Echo and Arpeggiator
The Echo effect is similar to a traditional digital
delay. It remembers material played in, then repeats
it later on. There are some interesting differences,
though. You are not restricted to simple fixed
delays. In fact the “rhythmic pattern” used by the
Echo for regenerating the material is completely
customizable. Additionally, each repetition of the
material can be sent to a different output
assignment. Furthermore, a transpose effect is
hooked into the Echo’s feedback loop, allowing you
to transpose on each repetition.
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The Arpeggiator watches what notes are sounding
(being held) and then arpeggiates them (plays
them one at a time). The Arpeggiator gives you
complete control over the rhythm and order in
which the notes are played back. In addition, each
arpeggiated note can be sent to a different output
assignment.

Rhythmic patterns
Both the Echo and Arpeggiator effects are built
around a flexible rhythmic architecture. In the
Echo effect the Rhythm section determines how
each event will be delayed. In the Arpeggiator it
determines the rhythm that will be used for each
arpeggiated note. Rhythms can be set up using one
of three modes: Grid, Custom and Raw Ticks.

Grid: You will notice that the Grid mode settings
are almost identical to the Quantize effects grid
settings. They function in a similar fashion. You
can set up rhythms consisting of any metric
subdivision. You can “swing” the grid, and you can
offset the entire grid by an arbitrary number of
ticks. (For more info, see the section on the
Quantize effect.) Rather than a check box for
“Tuplets”, there is a popup menu. This menu lets
you turn off the tuplet feature, turn it on (select
Tuplet) or put the grid into “poly rhythm” mode
(select Poly). The “Off” and “Tuplet” settings are
identical in effect to checking or un-checking the
Tuplet box in the Quantize effect. The Poly mode
combines both sides of the tuplet expression (you
will notice that the words“in the time of” change to
“against”) to create a standard rhythmic
interference pattern. For example if you pick Poly
and choose 3 against 2 (eight notes) you will hear
both a straight eight note pulse and a “3 in the time
of 2” pulse. Try different values to create interesting
textures (5 against 3 is an interesting one).

Custom: This setting lets you define your own
rhythmic patterns based on selected notes. You can
make “Groove Echos”, arpeggiations based on
melodic patterns, bizarre multi-tap echo effects — 
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the sky’s the limit. To create a rhythmic pattern,
just select some notes in a single track, enter a
name, and press Learn.

When a pattern is learned, it is the time between
note events that is remembered. Thus, if you select
4 notes, only 3 grid spaces will be learned (the
distance from note 1 to note 2,2 to 3 and 3 to 4).
With this in mind, you may need to add an extra
note at the end of your selection to delineate the
final grid span.

Rhythmic patterns created in the Echo effect
can also be used with the Arpeggiator effect.
Rhythms can be loaded into Performer from other
files.

Raw Ticks: Simply lets you specify the echo or
arpeggiation in raw ticks. This is handy for creating
rhythms that are “off” from the main pulse of the
music.

Echo Settings
Here is a brief explanation of each setting for the
Echo effect:

Figure 10-13: The Echo effect.

Num Repeats: Sets how many times each event will
be repeated. The number includes the first time
you hear the note. (If you enter 4, and play a note,
you will here that note a total of 4 times.)
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Decay: An amount that will be subtracted from the
velocities of note events each time they are
regenerated. This lets you create echos that sound
like they are fading out. You should coordinate this
setting with Num Repeats so that the note stops
repeating around the same time it finally fades out,
otherwise you will be echoing almost silent notes.

Cycle through device group assignments: If you
check this box and assign the track’s output to a
Device Group, each repetition of each event will be
sent to a different assignment in the device group.
For example, let’s say that you have a track assigned
to a device group with two devices in it, SC7
channel 1 andSC7 channel 2. And you have “Num
Repeats” set to 4. When you play a note, the first
repeat will go to SC7 channel 1, the second will go
to SC7 channel 2, the third will go to SC7 channel
1, and the fourth will go to SC7 channel 2. There
are many ways to use this feature. Here are a few
examples.

Create true echos including controller data.
Normally, controllers and pitch bend are not
echoed. This is because overlapping streams of
controller data almost always lead to unpleasant
results. (Try overdubbing some pitch bend on top
of itself in cycle record mode for an example of
this.) “Cycle through device group assignments”,
however, lets you send each instance of the echo to
a different MIDI channel, circumventing this
problem. To use the echo in this way, set up a device
group containing the same number of assignments
(on the same device) as number of repeats. (For
example, if you wanted a 4-repeat echo, you could
make a device group on your SC7 on channels 1,2,
3 and 4.) Each assignment should have the same
patch set as its default. (You can create panning
echo effects by setting the pan differently on each
channel in the group. To do this, add a track
assigned to each channel in the group (SC7 1, SC7
2, etc.), open the Mixing Board, show only those
tracks, set the pan knobs appropriately, rewind to 
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measure 1 and take a snapshot.) In this way, each
echo goes to a different channel, and none of the
controller information collides with previous data.

Create weird rhythmic and “cannon” effects by
setting things up the same way as above, but then
give each device in the group a different patch. You
can have a Sax echo your piano line or a murky
voice echo your synth lead. Adding percussion
assignments creates interesting rhythmic accents to
your echos. Experiment!

Feedback Transpose: Each time the echo processor
regenerates a note event, it passes it through the
Feedback Transpose effect. (If the Transpose Effect
is set to “unity transpose”, i.e. C3 to C3, it has no
affect.) You can use this to create all sorts of
cascading note effects. Since the Transpose effect
can use arbitrary Custom Maps, any sort of
transpose is possible. For example, you could have
your echos cascade up, while remaining in key. Or
have each repetition of the echo jump to any
arbitrary pitch. (Twisted!) Watch out for the
Harmonize option, though. It can really chew
through your polyphony in a hurry; it is best used
only with short delays. See the section on the
Transpose Effect for more info.

Arpeggiator Settings
Here is a brief explanation of each setting for the
Arpeggiator:

Figure 10-14: The Arpeggiator effect.

Duration: This sets the length of each arpeggiated
note as a percentage of time until the next note.
100% makes each note last until the next note
begins. 1% makes each note very short. Try using
sustain pedal for legato effects.

Cycle through device group assignments: This is
similar to the Echo effect setting, but it has no affect
over controllers. The Arpeggiator always sends all
controllers to all output assignments in the device
group. When this option is checked, each
arpeggiated note will be sent to a different output
assign. You can create all sorts of interesting effects
with this. The tricks with panning mentioned in
the Echo section also apply here. Try a Device
Group with several slightly different guitar patches
for a “League of Crafty Guitarists” in a box. Try a
group consisting of several different horn patches,
or percussion instruments. Great fun.

Melodic Pattern: This setting determines the order
in which the held notes are played back. There are
several built-in patterns. You can also define your
own custom patterns.
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Built-in patterns: In each of the following
examples, assume a 6 note chord, with each note
numbered 1 to 6,1 being the lowest and 6 being the
highest.

Up: plays the notes in order, starting with the
lowest, and moving to the highest. Note order:
1,2,3,4,5,6.

Down: Plays the notes in order, starting with the
highest and moving to the lowest. Note order:
6,5,43,2,1.

Up - Down: First plays Up, then plays Down: Note
order 1,23,4,5,6,6,5,4,3,2,1

Down - Up: First plays Down, then plays Up: Note
order 6,5,4,3,2,1,1,23,4,5,6

Staircase Up: Walks up the notes in a zig-zag
pattern: Note order 13,2,4,3,5,4,6

Staircase Down: Walks down the notes in a zig-zag
pattern: Note order 6,4,53,4,2,3,1.

Staircase Up - Down, Staircase Down - Up: Same
idea as Up - Down and Down - Up.

Spiral In: Starting at the outside edges alternately
walks into the center. Note order 1,6,2,53,4.

Spiral Out: Starting in the middle, alternately walks
to the edges. Note order 43,5,2,6,1.

Spiral In and Out, Spiral Out and In... You get the
idea.

Random: Randomly picks the note order.

Custom Melodic Patterns: When custom is
selected, the window expands to show controls
similar to those for creating and picking Custom
Rhythmic Patterns. To create a Custom Melodic
Pattern, select some notes in a single track, enter a
name, and press “Learn”. The Arpeggiator analyzes 
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the selected note data and remembers the order
that the pitches are in. This order is then applied to
the notes that you hold down. Note that the built in
patterns work well no matter how many notes you
are holding down. This is not as true of Custom
Melodic Patterns. Custom patterns work best if you
play the same number of notes as were in the
learned pattern. (Note: There currently is no way to
edit or retrieve the patterns after-the-fact, so you
should save your source notes somewhere so you
can tweak and relearn later on.) You can use
Custom Melodic Patterns to mimic all sorts of
finger picking, and even strumming styles.

Applying the echo and arpeggiator effects as
Region menu commands
Both the Echo and arpeggiator effects are available
as MIDI effects plug-ins in the Region menu, which
allows you to “print” the effect permanently to a
track. This is great for editing the effect further. For
details, see “MIDI Effects Plug-ins” on page 249.

Fun things to do with the Echo and
Arpeggiator effects
Add a Transpose effect before the Arp effect.
(Apply Transpose in Insert A and Arpeggiator in
Insert B). Set the Transpose effect to Harmonize
and transpose an octave up or down. This doubles
the notes sent to the Arp effect, and gives it more
notes to play with.

Learn bits of your song, both as melodic patterns,
and as rhythmic patterns. Mix and match for
Arpeggiator and Echo effects that compliment the
rhythm and melodies of your music.

Use the Arpeggiator with a drum kit. Set the
rhythm to a Poly 3 against 2. Hold down a big
clump of drum notes... Try using different melodic
patterns. (Random works great.)

Echo your Arpeggiator. Add an Echo effect after
the Arpeggiator, and set it for a long delay. Set the
Arpeggiator to play with a grid that has an
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interesting rhythmic relationship to the echo. For
example, set the Arpeggiator to a straight eight
note grid an the Echo to Tuplets, 3 in the time of 2
[quarter note]. Now, set the Echo effect to 2
repeats, and transpose up an octave (C3 to C4)
with the Feedback Transpose section.

The Arpeggiator effect uses the velocities of the
notes that you played in its arpeggiation. This can
be used to great effect. Play a clump of notes with a
medium velocity, then strike a new note with force.
The new note will stand out in the arpeggiation in
an interesting fashion. If desired, add a Velocity
Compressor effect after it to keep the velocities in a
normalized range.

ADDITIONAL MIXING TECHNIQUES
In addition to the powerful features in the Mixing
Board, Performer provides a host of other
techniques to handle mixing tasks. The following
sections provide an overview, along with references
to further information elsewhere in this manual.

Using velocities to control volume
Note have on-velocities that affect their volume.
The range is from zero to 127. You can edit
velocities individually in the Event Editing
windows, or you can use the Change Velocity
command in the Region menu to edit a region of
them.

Keep in mind, however, that velocity only affects
the initial volume of the note and offers no way to
change the note’s volume while it’s playing.
Performer provides volume controller events to
give you continuous control of volume and pan, as
described in the next section.

Creating volume changes volume controllers
Performer provides continuous volume control
with MIDI volume controller events (controller#?)
to create smooth changes and crossfade effects in
your MIDI tracks.Volume controllers can be 

inserted, generated, drawn, reshaped, and
recorded using the Mixing Board. MIDI volume
controllers have a range from zero to 127.

Unlike note-on velocities, which only affect the
initial volume of the note, volume controllers affect
volume at any time while a note is playing.

lEaigiEiaragmi

Figure 10-15: MIDI volume controllers. This smooth volume curve is
shown in both the graphic editing window and the event list.
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Inserting volume controllers
You can insert volume controller events into a track
using the methods summarized below. If you need
more information about them, refer to the
Performer MIDI sequencing reference manual.

Inserting an individual audio volume event
You can insert an individual volume event in the
event list using the insert menu in the Event List
window title bar. Or you can do so in the Graphic
Editor as described “Inserting a Single Continuous
Data Event” on page 177.

Drawing volume curves
You can draw volume curves in the Graphic Editing
window as explained in “Inserting a Continuous
Data Curve” on page 178 and “Reshaping a
Continuous Data Curve” on page 178.

Generating volume curves
You can generate volume curves using the Create
Continuous Data command in the Region menu.
Be sure to select the region over which you’d like to
generate the events first. This method gives you
precise numerical control over the curve.

Create Continuous Data
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Figure 10-16: You can create numerically precise volume changes
with the Create Continuous Data command.

Recording volume changes with volume faders
As described earlier in this chapter, you can easily
record volume changes for MIDI tracks using the
faders in the Mixing Board window. Record fader
moves in real time or in instantaneous snapshots
using the console.

Controlling pan
MIDI pan controllers are similar to volume
continuous controllers. They can be identified as
continuous controller #10 icon in the event list.

A MIDI pan controller

Cass
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A«7 .115 "
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zillOOO /ESO 1117 01472

Pan events usually control the output of the track
across the two corresponding pair of left/right
main audio outputs on your synthesizer. But this
depends on your hardware. Each pan controller
can have a value between 0 and 127, where 64 is
dead center, 0 is pan left, and 127 is pan right. Pan
controllers can be used one at a time to make a
sudden change, or as an stream of events changing
gradually to create smooth panning effects, just
like all continuous MIDI controllers.

You can insert, draw, generate, edit, and otherwise
handle pan controllers in the same manner as
volume controllers. See:

■ “Inserting a Single Continuous Data Event” on
page 177

□ “Inserting a Continuous Data Curve” on
page 178

■ “Reshaping a Continuous Data Curve” on
page 178

WORKING WITH MULTIPLE MIXES
The Mixing Board window has a very powerful
feature called the Mix Mode pop-up menu, which
is located in the lower left-hand corner of the 
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window as shown below. This feature allows you to
create an unlimited number of independent mixes
in a sequence.

What is a mix?
A mix consists of all of the volume and pan data in
all tracks in the sequence, as well as all of the
current effects insert assignments and their
settings. The Mix Mode menu allows you to create,
save, and recall any number of mixes. Each mix can
be completely different than the others. You can
also create alternative mixes that are slightly
different from each other by starting with the
Duplicate Mix command. You can even copy and
paste data between mixes by simply switching
between them.

How mix mode impacts your sequencing
When Mix Mode is off, volume and pan data
“belongs” to the Track and Take in which it was
recorded or inserted. If you switch takes, the
volume and pan data switches along with the take,
just lilce the rest of the data in the take. (For an
explanation of takes, see “The Take Column” on
page 68.)

When Mix Mode is on, however, volume and pan
data “belongs” to the current mix. If you switch
takes, the volume and pan data in the track remains
behind as part of the current mix. If, however, you
switch to a different mix, the current volume and
pan data goes along with the mix, temporarily 

disappearing from all tracks. (You can restore the
data, of course, simply by reselecting the Mix from
the Mix Mode pop-up menu.)

Creating a new or duplicate mix
To create a new, empty mix (with no volume or pan
data in any of the tracks), choose New Mix from the
Mix Mode pop-up menu (as shown in Figure 10-17
on page 136). Or you can choose Duplicate Mix to
create a new mix based on the current mix (that is,
the current volume and pan in all tracks, as well as
the current effects insert assignments in the Mixing
Board).

Renaming or deleting a mix
To rename or delete a mix, choose it by name from
the Mix Mode pop-up menu and then choose
either Rename Mix or Delete Mix from the same
menu.

Recalling a mix
To recall a mix, just choose it by name from the Mix
Mode pop-up menu Figure 10-17 on page 136.

Copying and pasting data between mixes
You can easily copy and paste data between mixes
by switching between them (as described in
“Recalling a mix” above). Copy data from the
desired tracks in one mix, recall a different mix,
and paste into the same or different tracks in the
second mix.

HINTS AND TIPS
The following sections briefly give you suggestions
for mixing in Performer.

Volume and pan data can "belong" to a mix
If you are working with multiple mixes in the
Mixing Board window as described in “Working
with multiple mixes” on page 135, the volume and
pan data in the tracks “belongs” to the current mix.
This means that if you switch to a different mix, all
the volume and pan data in all tracks switches, too.
If Mix mode is off, on the other hand, volume and
pan data “belongs” to the current take in the track.

136 [
MIXING



If you switch takes, the volume and pan data
remains with the take in which it was recorded,
along with the rest of the data in the take.

Volume and pan controllers are channel­
specific
Volume and pan controllers affect the MIDI
channel on which they are being transmitted. This
means that they will affect all other tracks that are
assigned to the same MIDI channel. If you have
multiple tracks assigned to the same channel, only
record volume and pan automation in one of them.
Otherwise, you’ll have multiple tracks competing
on the same MIDI channel.

Inserting initial volume and pan settings
It is useful to insert volume and pan events at the
beginning of each audio track to initialize their
values. This ensures that each time you play back
the track, it begins with the pan and volume
settings that you want. If you enable event chasing
(described in the next section), inserting an initial
value gives Performer a level and pan setting to
which it can always chase. See “Setting initial levels
with the Mixing Board” on page 124.

Don’t record over these initial controllers after
inserting them. Use Overdub record mode to avoid
doing so.

Event Chasing
If you always want audio tracks to play at the
proper volume and pan setting, no matter where
you begin playback in the sequence, use Event
Chasing.

To enable Event Chasing:

1 Choose Set Event Chasing from the Basics
menu.

2 Turn on the Controllers option.

3 Click OK.
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chapter 11 The Event List

Performer provides four ways to display and edit
the data in each track of a sequence: the Event List
window, the Graphic Editing window, the Notation
Editing window, and the QuickScribe notation
window, together referred to as the Event Editing
windows. All of these windows can be open at the
same time for a track, and any number of tracks
can have windows open at any time. This chapter
describes the Event List window. See the next few
chapters for information on the Graphic Editing
and QuickScribe notation windows.

The Event List window displays the MIDI data and
other information in a track as a chronological list
of“events”. Examples of events are notes, controller
data, and program (patch) changes. Other
information that occurs in specific time locations
can be displayed in an Event List as well: markers,
meter changes, key changes, tempo changes, and
loop points. The Event List window can be used to
edit individual events or select a region of events
for editing with menu commands. Event List
windows for different tracks can be open at one
time. Event List windows can be opened, scrolled,
and edited during playback.

QUICK REFERENCE

Pop-upMini­
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Solo Event
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Figure 11-1: Performer's event list window givesyou a precise, numer­
ical look at the MIDI data in a track.

Event: A row of information concerning a single
MIDI message or Performer command. Events at
different locations are separated by a dotted line.
The information displayed for an event depends on
its type; see “The Event List Display” on page 141
for more information.

Mini-menu: Choose items from the mini-menu in
the same way as regular menus. The Event List
mini-menu contains commands for inserting,
controlling the display, and more. See “Mini-menu
Quick Reference” on page 140 for more
information.

Audible Mode speaker icon: Click on this button to
activate Audible Mode. Audible Mode plays back
notes one at a time as you click on them in the
Event List. An entire phrase can be played back by
highlighting a region and choosing Play Selection
from the Basics menu.

Insert button: Inserts MIDI events into the Event
List. Pressing this button produces a menu of items
the can be inserted.

Solo Button: Turns soloing on and off.

Pop-up box: A box that appears when you double­
click or option-click on a field of an event. You can
enter a new value for the field.

Grow box: Drag this box to resize the Event List
window.



Mini-menu Quick Reference
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Figure 11-2:The Event Listwindow mini-menu.

Goto Counter: Automatically scrolls to the time
currently displayed in the Counter.

Goto: Automatically scrolls the Event List display to
a time you specify.

Reinsert: Inserts an event of the same type that you
last inserted.

Legend: Opens a window that shows what each
kind of MIDI event looks like in the Event List.

Graphic Editing: Opens the Graphic Editing
window for the track.

Notation Editing: Opens the notation editing
window for the track.

QuickScribe Notation: Opens the QuickScribe
notation window for the track.

Measures/Real time/Frames: These checkable
entries control the types of time displayed in the
Event List.

Opening an Event List Window
If the Event List is already open for a track, you can
simply click on it to activate it. If not, you’ll want to
open one.

To open an Event List window for a track:

1 Open or activate the Tracks list window
containing the track you wish to edit.

To open a Tracks window, choose Tracks from the
Windows menu. To activate a window already
open, click on it.

2 Select the track and press the Event List button
in the Control Panel.

The track’s Event List window will appear.

You can also open the Event List window by
choosing Event List from the Graphic or Notation
Editing window mini-menus.

Switching to a Different Track Using the Title
Bar Pop-up Menu
If you have an event list window open for a track,
you can switch to a different track in the same
window. To do so:

1 Command-click the track name in the title bar.

A pop-up menu appears as shown below.

Conductor^

3111000 474 click J_________
5111000 QVerge 1______________
5121016 /B2 1119120 01240

VlBia|ia|Qi|.g l.'SI C’?Bass (Seq-ll
111I000 Phira — —

321236

Vlalal.SI&fllS.I Bassl^/Bass
1|1[jOO Q Intro Plano
3111000 4/4 click J Strings
5111000 ©Verse 1
5121016/B2 »119!20 01240 5 bullar
5121256 7D3 .11511021(243 5 Guitar FH
5141084 7B2 *1151110CJ207 5 Bongos
5141244 / 03 1115110431351 6
8I3I246 /B2 1117195 01233 8 MIDI perc

Figure 11-3: Command-dick the track name in the title bar to use the
pop-up menu to move from track to track within the same editing
window.

814)010 /A2 195 152 01234 0’41244
EI4I244 4*02 199 197 01162 3141406
9111472 /D2 1115*111 01109 9121191
9121236 /03 1117196 11202 9131438

2 Choose the desired track.

The contents of the window changes to the track
you select.
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THE EVENT LIST DISPLAY
The Event List window displays MIDI data and
other events sequentially. There is one event per
line in the display. Events which occur at the same
time (such as notes in a chord) will be grouped
together between horizontal dotted lines. The
starting time is listed only for the first event of these
groups. Each note is defined by its attack time,
pitch, on velocity, off velocity, duration and end
time.

Chord

Duration EndAttack Pitch
time time

v____ ;
6J4I476 /Ao 1102 84 3|41S 71414'15
7111000 /F”

/D3
/B2

1102’96 31421 7141421
J107 T104 31421 7141421
1111’75 31390 7141390

9IH019 ZA3 198 79 31335 9141354
9111021 /D3 1105’95 31390 9141411
9)11025 /Fn3 193 91 3136* 9M13S9
9141473 /E3 1102199 3141C 10141403

Figure 11-4: This example shows eight notes.

In addition to MIDI note events, there are other
types of events that are displayed in the Event List
as well. These events include other MIDI
commands, like patch changes, and events unique
to Performer, like markers and tempo changes.

The next example shows several different types of
events. Some are MIDI data, like the patch change
event, notes, and pitch bend. Others are
Performer-related events, like the marker, key
change, and meter change.

: II! 1000 t? Prtlud* -«----------- - -------------------- i
CI ................................................
6/8 click J. -«------------------------------

"60 60 French Hwn -<----------------
Omni off -------------- -——---------- -—

12141000 /GJ '177 190 0K40 12F5lbdd“
12151000 /GJ 477 !90 D|240 12161000
12161000 /GJ *7? !90 0J240 ‘ 13|1l00d'‘
13111000 /GJ 177 !90 1(000 13131000
13151000 /EbJ 177 190 1|000 14|l'1000'

/Et-2 177 190 11000 14|l|000
14)31000 /GJ 177 ’ 90 11000 14|5|000

/G2_ 177 ’ 90 11000 14|5|000
14(31002 * 0-<-------------------------—------------- --

Marker
Key change
Meter change
Patch change
Mode change

Notes

Pitch bend

Figure 11-5: Examples of several different types of data events
displayed in the Event List.

Looping points are also displayed on the Event List.
Events within loop boundaries are indented.
Events that will not be played due to the duration of
a previous loop are in italics. See chapter 30,
“Looping” (page 347) for details.

H4IUUU urz«u
1151000 /EL 3 199 <90 ‘ 2«3OO
211 |0u0 until 2|1|000~' 14 Hnwi

2|4|OOO /F3_ 199 TOO 01240
2QOOO /F3 199 ’90 0J24O

’ _2561000 /F3 199 190 C1240 '
! Etiuxo jej
S&tXi) JEM J F? fSW Q!W___
EjiitxxjJEM tea

; jem y*?'

Loop

Notes in
the loop

Notes that won't play
because of the loop

Figure 11 -6: A loop in the Event List window.

Event locations can be displayed in
measure|beat|tick, real time, or frame time
formats. Any combination of the three types of
times can be displayed simultaneously. To display a
certain type of time, simply check its menu entry
on the Event List window mini-menu. To turn off a
format, reselect it from the mini-menu.

cjiK>i2’oc3otro-coooco/f*3 i&s ic? 3419 si-tr-oi ’0-0993.0 coos2a
511J0I4;0 03.01 I0C0C3C0 a A3 ICS *79 37J53 5)41367!00303'003 032$
5)1)01610 03 01 10.0003 00 -7C2 195 177 Z|57t 51438710 U9 30’0 CO U9-27
5HK>19'0-C3 02100303.00 A 03 476 TSO <:i?7 34)4451009 96 i0C3 09 23
641476 TO 11 9910 CO 1109 AA3 1102134 31419 7)4)415'0 13 93'000.13 27
7|1KC0;0t12O0l0O0.1203

/t>3
/B2

1102’96 ZH21
4107 f 104 31421
4111173 31390

7)4)421 .0.15.95'0C0.15 23
7M1421 (0-1595.0 C0-I523
7M1590'0-13.901 OOO 13 27

H1HJI9 10:16X1210.00.1603 A A3 490 *79 3335 S14IZ54 10 17X6'003.17.26
911)021 10-16021 000-16 00 4t>3 IIDS'95 31590 9)4(411.0-1792:020 1727

Figure 11-7: Any combination of Performer's several time formats
can be displayed in the Event List. For notes, both the attack time and
end time of the note are displayed in the chosen time formats.

Scrolling During Playback
The Auto-Scroll command in the Basics menu can
make the Event List window scroll during
playback. In addition, the window will
automatically open to the current playback
location of the sequence. Please refer to the Auto­
Scrolling section in the Playback chapter for more
information.

When auto-scrolling is turned on, you can
temporarily override it simply by clicking
anywhere in the Event List or by scrolling the
window manually. The window will stop for a 
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moment before it resumes auto-scrolling. This lets
you view or edit things quickly without having to
stop playback.

Selecting Events in the Event List Window
The following actions select events:

To select a single event, click once on it.

To select several adjacent events, drag over the
desired events. All events dragged over will
highlight.

To select several non-adjacent events, hold down the
Shift key and click on the events you wish to select.
They will highlight.

To deselect events, hold down the Shift key and click
on the event(s) you wish to deselect. They will
unhighlight.

To extend the currently selected region, Command­
click or Command-drag at the desired end
location.

To edit an event, double-click or Option-click on
the field you want to modify. A pop-up box appears
in which you can edit the value in the field.

Tab approves the change you made and moves to
the next field in the same event.

Shift tab does the same, except that it moves to the
previous field.

Return approves and completes the changes you
made. Or you can click outside the box.

Enter approves the changes you make and moves to
the same field in the next event.

the up or down arrow keys approve the changes you
make and move to the same field in the next or
previous event.

the left or right arrow keys move from field to field
in the event box.

The Event List View Filter
The Event List View Filter allows you to specify
what types of MIDI information are displayed in
the Event Editing windows. You can open the Event
List View Filter from the Basics menu. The Event
List View Filter is actually the same window as the
Global View Filter. The only difference is that the
menu at the top of the window switches between
Global View Filter settings and Event List View Filter
settings.

The Event List settings only affect the event list
window.

The Global View Filter affects all other windows
that display MIDI data and Conductor Track data.

Both View Filter settings determine which types of
events are affected by Edit menu commands when
the data is selected in the Event Editing window.
Here’s a simple rule to remember: if you can see an
event in the Event Editing window, it will be
affected by edit commands.

For details about using the View Filter, see “Setting
the View Filter” on page 217.

Goto Counter
Choosing Goto Counter automatically scrolls the
Event List to the location currently displayed in the
Counter window. This command is a quick and
useful tool for locating specific events in an Event
List. For example, if you hear a wrong note in your
music during playback, stop playback at that point,
and then select Goto Counter in the Event List for
the track. This immediately scrolls the Event List to
the point where you stopped, allowing you to find
and correct the mistake quickly.
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To use the Goto Counter command:

1 Activate the Event List window for the desired
track by clicking on it.

2 Choose Goto Counter from the Event List
window mini-menu.

The list will automatically scroll to the event closest
to the time in the Counter window.

Goto
The Goto command on the Event List window
mini-menu scrolls the Event List display to the
specified location. It is a quick way to locate a
region of events without having to manually scroll
through the Event List.

To use the Goto command:

1 Activate the Event List window for the desired
track by clicking on it.

2 Choose Goto from the Event List window mini­
menu.

You will be prompted for a location to scroll to.

3 Enter a time location to scroll to.

4 Press OK.

The list will automatically scroll so that the event
closest to the time you entered will be at the top.

Reinsert
The Reinsert command inserts an event of the type
last chosen with the Insert command. It works
exactly like the Insert button except that you don’t
need to select a type of event from a menu. For
example, if you insert a patch change with the
Insert button, the next Reinsert command will
insert a patch change as well. For more
information, see “Inserting events with the insert 

button” on page 147. As a shortcut for choosing
Reinsert from the mini-menu, option-click the
Insert button.

Legend
The legend window can be opened by choosing
Legend from the Event List mini-menu. The legend
window defines each icon found in the Event List.

Figure 11-8: The Legend window provides a handy reference for
learning the icons that represent each type of data in the Event List.

Graphic and Notation Editing
The Graphic Editing and Notation Editing
commands open the Graphic Editing or
QuickScribe notation windows. Data in the track
can be viewed in any one of these three windows.
Editing in a window will affect the data in the track,
regardless of which window you have activated. For
example, if you edit a note while in the Event List
window, the change will be displayed in the
Graphic Editing window as well.

TYPES OF EVENTS
There are several types of events displayed in the
Event List window. Most are MIDI data; some are
events internal to Performer such as tempo and
meter changes. The type of each event is identified
by a small icon. The following section describes the
appearance and parameters of each type of event.

Notes
A note event comprises a start time, a pitch, an on
velocity, an off velocity a duration and an end time.
The pitch is expressed as a note name and an
octave, e.g. C#4. C3 is middle C on a keyboard, 

_______________________________________________ I 143
THE EVENT LIST



although with some patches it might sound in
another octave. The spelling of the note name is
determined by the key signature you choose.

>C3

On velocity is a value that represents how hard a
note is struck. The harder you strike a note, the
faster you are pressing it down, hence the term
“velocity”. Off velocity is a value that represents the
speed at which a note is released. Many
synthesizers don’t respond to off velocities, but
some use this information to determine envelope
decay parameters or other effects. Values of on and
off velocities range from zero to 127. You can omit
on and off velocities from the Event List display by
unchecking them in the View Filter.

Duration is the time between the attack and release
of the note. It is displayed in quarter notes and
ticks, e.g. 3|240. Note that this is different from
measure time, displayed in measures, beats and
ticks. There are 480 ticks per quarter note. A note
must have a minimum duration of one tick (01001).

End time is the location at which the note stops
playing — where it cuts off. Like note attack times,
the end time is displayed in whatever time formats
you choose from the Event List mini-menu.

Pitch Bend
A pitch bend event comprises a start time and a
value. Pitch bend data causes the pitch of notes
being played to change. When a stream of pitch
bend data occurs, a smooth pitch change can be
approximated. A value of zero signifies no bend,
increasing values bend the pitch up, and decreasing
values bend it down. Values are in the range -8192
to 8191.

*1132

There is no specific MIDI standard for how much
of a bend specific pitch bend data causes: each
synthesizer may be different. Also, some
synthesizers do not respond to all 16,384 values;
adjacent values may produce the same result.

Patch Change
A patch change event has a start time and a patch
change number. When a synthesizer receives a
patch change, it changes to the patch specified by
that number.

■j 39

Patch changes are generally in the range 0 to 127.
Some MIDI devices use the range 1 to 128. In such
cases, the patch number displayed in Performer
may be one less than the number on the MIDI
module. Performer thus would display a zero when
a 1 was sent, a 9 when a 10 was sent, etc.

Some MIDI instruments have more than 128
patches. Since MIDI only allows for 128 different
patch values to be sent, there is no direct way to
access patches above the 127th one. In this case,
there is usually some way to set up banks (groups)
of patches and switch banks via a “bank select”
MIDI command. If this is the case, and the device
has been set up with bank select messages in
FreeMIDI, patch change messages for the device
appear with the appropriate bank select number as
shown below. The bank number automatically
appears in tracks assigned to a device that was
given the bank select property in FreeMIDI Setup.
(See “Setting up bank select devices in FreeMIDI”
on page 517.) If the track is assigned to a non-bank
select device, no bank number is shown.
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number
Patch (sound)

pop-up list

Bank number
(Could be one or two numbers,
depending on the MIDI device.)

Figure 11-9: If a MIDI instrument supports bank select, the bank
selection numbers (controller 0 and/or 32)

Song Change
Song changes, also called song select, select songs
(a collection of rhythmic patterns) on drum
machines. They have a value range of zero to 127.
Song changes have no channel number when sent
over MIDI: all connected instruments receive
them.

1|1|000 Song *127

Mono Key Pressure
Also known as aftertouch or channel pressure, this
is actually a special kind of controller. A mono key
pressure event has a start time and a value between
zero and 127. If you continue to press down a key
after you play a note, mono key pressure
information is sent. The harder you press, the
higher the value. Mono key pressure can be used
for such things as changing the timbre (tone
quality) of a sound or controlling the amount and
depth of vibrato.

± 56

Mono key pressure data can be voluminous, filling
up memory very quickly. If you aren’t using mono
key pressure information, it is best to use the Input
Filter to filter it out while recording. Because of its
great volume, mono key pressure data can
sometimes cause the playback speed to slow down
when output with a fair amount of other MIDI
data.

Poly Key Pressure
This is similar to mono key pressure except that
each key can generate its own pressure information
instead of one pressure level for the whole
instrument. This allows for much more subtle and
complicated effects using aftertouch. A poly key
pressure event has a start time, a pitch and a value
between zero and 127.

£±119

Controllers
A controller event has a start time, a controller
number which identifies the device being used (on
the MIDI input keyboard), and a value.
Continuous controllers (such as wheels and
sliders) are generally numbered in the range zero to
63. These have value ranges from zero to 127.
Switch controllers (on/off types like a sustain
pedal) are numbered from 64 to 93 and have values
of either On or Off. Controllers from 93 to 127 are
reserved for future definitions.

A *64

Each MIDI device can interpret controller data
differently. Thus, data from the same controller
might be used differently on two different
synthesizers. To determine how a controller
behaves on a particular unit, consult the owner’s
manual, and see “Hints” on page 150.

System Exclusive
System exclusive data can be used for a variety of
purposes. Each musical instrument manufacturer
defines special kinds of data that are particular to
specific instruments: patch dumps, drum machine
patterns, tuning information, sample data and so
forth. System exclusive data begins with an ID code
specifying the manufacturer followed by the actual
data.

□ FO 43 01 05 70 28 32 F7

THE EVENT LIST

J 145



Performer lets you view and edit system exclusive
data in hexadecimal (base 16) notation. See
chapter 46,“System Exclusive”(page451) formore
information.

Tune Request
The tune request is used for analog synthesizers,
prompting them to tune their oscillators. It has no
value and does not have a channel number when
sent over MIDI: all connected MIDI instruments
will respond to it if applicable.

Tune request

Mode Changes
MIDI modes are used to set synthesizers to
respond to MIDI data in different ways. Not all
synthesizers respond to all MIDI modes

Omni on
Omni off
Mono mode
Poly mode
Local control on
Local control off
All notes off

Omni Mode
A synthesizer is always in either omni on or omni
off mode. In omni on, a synthesizer responds to all
data on any channel, i.e. all 16 channels at once. In
omni off, a synthesizer responds to data only on its
assigned channel. Usually, you can change this
mode on the synthesizer’s front panel. Some
synthesizers allow you to change this mode via
MIDI.

Mono Mode
In mono mode with omni off, a synthesizer splits
itself into a number of independent monophonic
synthesizers, each responding to one channel. The
assigned channel number of the synthesizer
determines the channels it responds to. If you had
an eight-voice synthesizer assigned to channel 2, it
would respond to data on channels 2,3,4,5,6,7,8,
and 9.

In mono mode with omni on, a synthesizer
receives data from all channels but acts as a single
voice synthesizer. This combination is not very
useful.

Local Control
A synthesizer is always in either local control on or
local control off mode. In local control on mode,
the synthesizer works normally: notes pressed on
the keyboard are played by the synthesizer unit. In
local control off mode, the keyboard is
disconnected from the synthesizer unit. The
keyboard sends out data directly through MIDI;
the synthesizer only plays data received over MIDI.
This allows you to use a synthesizer as a controller
while simultaneously using its synthesizer unit to
play something else.

All Notes Off
The all notes off message causes all notes that are
currently sustaining to be shut off.

Markers
Markers are displayed for reference in the Event
Editing windows for all tracks in a sequence. They
cannot be edited in the Event Editing windows for
normal tracks. Markers can be edited in the
Conductor track, Markers window and Tracks
Overview Time Ruler. Locked markers can only be
edited in the Markers window.

Bridge

Meter Changes
Meter changes are displayed for reference in the
Event Editing windows for all tracks in a sequence.
They can only be edited in the Event Editing
windows for the Conductor track. Meter change
events display the time signature (the number of
beats per bar, over the duration value which gets
the beat) and the click value (the duration value
between metronome clicks). See chapter 28,
“Change Meter” (page 331) for more information.
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Tempo Changes
Tempo changes can be displayed and edited in the
Event Editing windows for the Conductor track.
Tempo change events display the duration value for
the tempo marking, i.e. which value the tempo is
measured in (quarter note = 90 for example), and
the tempo value itself, which signifies the number
of beats per minute. See chapter 29, “Change
Tempo” (page 337) for more information.

1|2[000 J = 172.66

Key Changes
Key changes are displayed for reference in the Event
Editing windows for all tracks in a sequence. They
can onlybe edited in the Event Editing windows for
the Conductor track. Key change events display the
name of the key. See chapter 27, “Change Key”
(page 327) for more information.

1111000 C Minor;

Loops
The loops for each track are displayed in the Event
Editing windows for that track. A loop event
displays the start and end time of the loop and the
number of times the loop is played. A loop event
can be edited in the Event Editing windows for the
track that contains it. Events within loops are
indented to the right for clarity. See chapter 30,
“Looping” (page 347) for more details.

2| 1 lOOO until 411 lOOO ; infinite

EDITING IN AN EVENT LIST
Commands in the Edit and Region menus work on
events in Event List windows. This gives you the
ability to precisely specify which events to modify.
Using the Event List window to edit events allows
you to work with one track at a time.

THE EVENT LIST

To edit events in an Event List window, you must
first select them, and then execute an edit or region
command. For information on selecting events,
refer to the Quick Reference section at beginning of
this chapter. Selected events turn black to indicate
that they are selected. Here are a few important
things to remember when editing in the Event List.

■ Only highlighted events will be affected by the
command. Also, events not visible due to the View
Filter setting will not be affected.

■ Use the View Filter to display and edit only those
events you wish to edit. This is a great way to hide
data you are not concerned with at the moment —
especially lengthy streams of controllers or pitch
bend.

■ The Paste and Merge commands on the Edit menu
work as follows: If one or more events are
highlighted, the contents of the Clipboard are
pasted at the time of the first highlighted event. If
no events are highlighted, you will be asked for the
time at which the contents of the Clipboard should
be inserted.

■ The Snip, Repeat, and Retrograde commands do not
affect highlighted events. When using these
commands, you must use the Selection Bar in the
Tracks window to select events.

■ Markers, key changes, meter changes, and tempo
changes can be edited only in the Conductor track. They
are not affected when highlighted or when you
attempt to edit them directly in normal Event Lists.
This allows you to select large regions of events
without having to worry about excluding these
events.

Inserting events with the insert button
The Insert button on the Event List window title
bar inserts an event of the specified type. To insert
an event:

1 Activate the Event List window for the desired
track by clicking on it.
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2 Press the insert button in the title bar.

A menu will appear containing the different types
of events you can insert.

up Insert menu. The pop-up menu will change to
display the options for Mode changes; select the
desired command and continue as described
above.

Figure 11-W: Inserting events in the Event List window.

VIL41)£117jJ5: <l l<sl Track-1 (Seq-1)

Note
Pitch bend
Patch change
Controller
Mono prtss ure
Foty pressure
System exolusiv*
Mod* chenges...
Song change
Tune request
Loop

_______
N

d

3 Choose the type of event you wish to insert.

An event will pop up in front of the Event List.

4 Specify the time at which the event is to be
inserted.

If you wish to change other values for the event, use
the Tab or the left and right arrow keys to move
between the value fields. For example, tabbing 3
times in the above example moves the active field as
shown below.

I 1111000 i-Cl llooo 1121000 |

5 To enter the event, press Return.

The event will be inserted into the Event List. If you
will be inserting another event of the same kind,
press the Enter key instead of Return. This will
insert the event and present you with another to be
inserted. Press command-period or the escape key
to cancel the Insert.

See chapter 46,“System Exclusive” (page 451) for
information on inserting this type of data. See
chapter 27,“Change Key” (page 327) for
information on inserting key changes.

Editing Individual Events
To edit any parameter field of an event in the Event
List window, hold down the Option key and click
on the field. You can also double-click on the field.
In most cases, a pop-up box will appear
surrounding that field in which you can enter the
value you want; some events display a dialog box.

511 012 /F»3 i89 »39 31419 5)4)431
5)1 014 J-A3 186 179 31353 5141367
5II 016 J-B2 195 ’77 31371 5141387
511 019 J'Do 176 too 31427 1141446
6)4 476 J-Ao 1102’84 31419 7)4)415
711 000 1FW3 1102’96 31421 7MI421____

Once you begin to edit events by using pop-up
boxes, you can use the Tab, Enter, and arrow keys to
move between fields and events.

Here is a list of the keys you can use when a pop-up
box is present:

■ Return enters the value and closes the pop-up
box — as does clicking anywhere outside the box.

■ Command-period cancels the entry.

■ The Enter and Down Arrow keys enter the value
and highlight the same field in the next event.

■ The Up Arrow key enters the value and highlights
same field in the previous event.

■ Tab and the Right and Left Arrow keys move
through each field of an event.

When inserting Mode changes, or System
Exclusive data, extra steps are required. To insert a
Mode change, select Mode changes from the pop-
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Changing Event Values from a MIDI Controller
You can use your MIDI input keyboard to enter
values for events. When a pop-up box is present for
a parameter field, if you send an event over MIDI of
the same type as the parameter, it will be entered
into the field. For example, if the pitch field of a
note event is highlighted, playing a note on your
MIDI controller will set the corresponding pitch
for the event in Performer.

This technique is particularly useful when you are
uncertain of a value. For example, you can set an on
velocity for a note by double-clicking on the on
velocity field so that it pops up, then hitting a key
on your controller until the note velocity sounds
correct. Each time you hit the key, the new velocity
appears in the pop up box; when you hear the one
you want, simply press the Return key to save the
value in the Event List.

AUDIBLE MODE
Audible Mode allows you to listen to notes one at a
time, or phrase by phrase, as you highlight them in
a Performer track. This feature appears as a speaker
icon in the title bar of each track’s Event Editing
windows. Audible Mode provides an easy, intuitive
way to see and hear an individual note or phrase
while you are working in Performer’s editing
windows. Notes can be played back one at a time by
clicking on them individually or as a phrase by
highlighting a region.

Audible Mode playback is similar to pressing the
Play button in the Control Panel, including MIDI
channel assignment and velocity information. If
you click on a note and don’t hear anything when
Audible Mode is activated, make sure that your
MIDI connections are set up properly and that
your synthesizer is ready to receive MIDI data. If
MIDI data in a track plays back correctly when you
press the Play button in the Control Panel, it will
play back properly in Audible Mode as well.

Enabling Audible Mode
To enable Audible Mode:

1 Open the Event List or Graphic Editing window
for a track.

Either double-click on the track name in the Tracks
window, or click on the track name once and chose
Open Edit Windows from the mini-menu.

2 To turn on Audible Mode, click once on the
speaker icon in the title bar.

The icon will highlight to indicate that Audible
Mode is activated. When Audible Mode is
activated, it affects all Event Editing windows.

3 To turn off Audible Mode, click on the speaker
icon again.

The icon will deselect to indicate that Audible
Mode is turned off.

Playing Individual Notes
When Audible Mode is enabled and you click on a
note in the Event Editing Window, the note will
simultaneously select and play back on your MIDI
instrument. The note will sustain for as long as you
hold down the mouse button. When you release the
mouse, the note will stop. If you click on a note and
drag up or down to highlight adjacent notes, each
note will play individually as it highlights. Notes
will play in the same fashion when you shift-dick
to highlight discontiguous (non-adjacent) notes. If
you shift-click to deselect an already highlighted
note, the note will play when it unhighlights. In
general, when you highlight or unhighlight a note,
it will play back for as long as you hold down the
mouse.
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] 149



Playing Phrases
Using the Play Selection command in the Basics
menu, it is also possible to play a group of notes that
are highlighted in the Event List.

To play a selection:

1 Highlight one or more MIDI events in the Event
List window.

You can highlight the events by clicking and
dragging, or by shift-clicking on discontiguous
events.

2 Choose Play Selection from the Basics menu, or
press command-space bar.

Alternately, you can option-click the Audible Mode
speaker icon in the Event List window title bar. The
speaker icon does not have to be highlighted.
Option-clicking—even if Audible Mode is not
currently enabled—will cause the highlighted
events to play back.

When you play the current selection, all MIDI data
that are currently highlighted will play back with
the proper duration and velocities. The tempo of
the phrase is determined by the current tempo
slider setting in the Metronome panel. Playback
can be stopped at any time by clicking the mouse or
striking a key on the Macintosh keyboard.

The phrase can be a contiguous (adjacent) group of
notes that you have highlighted by clicking and
dragging or a discontiguous group of notes that
you have selected by shift-clicking. Notes that are
not highlighted will not play.

Playing Chords
Audible Mode allows you to hear chords one note
at a time, all at once, or only with selected notes. To
listen to a chord one note at a time, enable Audible
Mode by clicking on the speaker icon. Click on the
first note of the chord and drag downward while 

holding down the mouse button. Or you can start
on the last note and drag upward. Each note in the
chord will play as it highlights.

J111000 /C3 177 t£4 CI120 1111120
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Figure 11-11: Playing chords with the Play Selection command.

To hear the entire chord at once, highlight all of the
notes and choose Play Selection from the Basics
menu (or option-click on the Audible Mode
speaker icon in the Event List window title bar). To
hear only selected notes within the chord, highlight
only the notes you wish to hear.

Playing MIDI Data Other Than Notes
Only notes will play back when you highlight them
in Audible Mode. Other MIDI events such as
controllers or pitch bend can be played with the
play-phrase feature. For example, to send a patch
change to a synthesizer directly from the Event List,
highlight the patch change and option-click on the
Audible Mode speaker icon. System exclusive data
cannot be played back in Audible Mode. To play
back a system exclusive event, press the Play button
in the Control Panel.

HINTS
You can use the Event List to find out useful
information about the way your MIDI instruments
output data. For example, you can use the Event
List window to determine the controller number
for a wheel, slider, foot pedal, etc. Make sure that
the MIDI output from the device in question
connects to the MIDI input of your interface; then:

1 Locate a controller event in an Event Edit
window.

If you can’t find one, insert one.

2 Option-click on the controller number field to
make a pop-up box appear.
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3 Move the controller on your input keyboard.

The controller number will be displayed in the
pop-up box.

4 Press the Return key to save the event, or the
Command and period keys to close the pop-up
box without making any changes.

You can use a similar technique to find the patch
numbers that correspond to each preset on a MIDI
module. Make sure that the MIDI output from the
device in question connects to the MIDI input of
your interface; then:

1 Find a Patch Change event in an Event List
window.

If you can’t find one, insert one.

2 Option-click on the patch number field to make
a pop-up box appear.

3 Select the preset or patch on the MIDI module.

The patch number box in Performer will display
the MIDI patch number corresponding to the
preset.

4 Press the Return key to save the event, or the
Command and period keys to close the pop-up
box without making any changes.

You can insert multiple events of the same type
quickly by first inserting the event, selecting a
region including the event by setting the Selection
Bar in the Tracks window, and then choosing
Repeat from the Edit menu. This will effectively
duplicate the event the specified number of times.
You can then go back and edit the locations and
values of each event.

I THE EVENT LIST
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chapter 12 Graphic Editing

Each track in a Performer sequence can be viewed
with the Graphic Editing window. The Graphic
Editing window plots notes, velocities, and MIDI
controller data on a scrolling, piano-roll graph that
makes melodies, chords, dynamics, and tempo
changes easy to recognize. Graphic editing is
provided as a visual alternative to the numeric
display in Performer’s Event List window. All tracks
can be viewed with either window at any time.

The Graphic Editing window clearly organizes
information by displaying MIDI data in the center
of the window and then surrounding the data with
descriptive information such as loop indicators,
markers, key changes, and meter changes. MIDI
data is placed on two grids flanked by rulers that
precisely measure location and value. Best of all,
Performer’s Graphic Editing window lets you see
all types of data—notes, controllers, and pitch
bend—in one window.



QUICK REFERENCE

Figure 12-1: The Graphic Editing window provides a powerful, “piano­
rail’style environment for viewing and editing your music.

Information bar: Displays precise information
about mouse pointer location, currently selected
MIDI data, and editing resolution. The bar is
divided into three boxes: the Pointer Coordinates
Box, the Event Information Box, and the Edit
Resolution Box.

Pointer Coordinates Box: Displays the mouse
pointer’s current location with respect to the Time,
Pitch and Continuous Data rulers.

Insert Button: Pops up the Insert menu when
clicked, from which any type of MIDI event can be
chosen for insertion.

Reshape Button: Changes the mouse pointer to a
cross hair that reshapes continuous data curves
when you drag over them in the Continuous Data
Grid.

Solo button: Turns soloing on and off for the
currently play-enabled sequence.
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Event Information Box: Displays the currently
selected note as it would appear in the Event List
window. If a region is selected by dragging in the
Time Ruler, this box shows the region’s start and
end time. If a group of events is selected, this box
displays information about the last event that was
selected. If a continuous data event is selected,
events of that data type can be viewed alone by
clicking the Quick-Filter check box.

Edit Resolution Box: Displays the current time
resolution for editing. When the check box is
selected, notes and data will ‘snap’ to locations that
correspond to the resolution displayed. If the check
box is deselected, data will not‘snap to grid’. Edit
resolution can be changed by typing in a different
number of beats|ticks, or by clicking on the note
and selecting a duration from the resulting pop-up
menu. The current edit resolution setting can be
manually overridden by holding down the
command key while dragging.

Time Ruler: Measures time in any combination of
Performer’s three time formats:
measures|beats|ticks, SMPTE time, and real time.
The Time Ruler can zoom in and out to enlarge or
reduce the Note Grid and Continuous Data Grid.

Main Ruler Selector: Changes an auxiliary ruler
into the main ruler. The main ruler is the lowest
ruler displayed and determines the time format for
editing. Auxiliary rulers are for visual reference
only.

Marker Strip: Displays markers, meter changes,
key changes, and loops. Loops can be edited in this
strip. Markers and meter changes must be edited in
the Conductor track or Markers window. No MIDI
data appears in the Marker Strip.

Note Grid: Displays notes as horizontal bars on a
time vs. pitch grid. Only notes are displayed on this
grid. Pitch is determined vertically by the pitch
ruler on the left. Location and duration are 

measured by the Time Ruler above, with duration
determined by the length of the bar. Notes can be
edited with the mouse one at a time, in a group, or
by region.

Selected Note: When a note is selected, it
highlights. Complete information about the
selected note will automatically appear in the Event
Information box at the top of the window. Drag the
end of the note to change its duration.

Median Strip: Displays discrete MIDI events such
as patch changes, mode changes, switch controllers
like #64 (sustain), and system exclusive events.
Each type is displayed as an icon, defined by the
Legend window. The Median Strip serves as a
border between the Note Grid and the Continuous
Data grid; it can be dragged up and down with the
handles at either end to proportionally resize the
grids.

Median Strip Move Handle: Moves the Median
Strip up or down. Dragging up will shrink the Note
Grid and enlarge the Continuous Data Grid;
dragging down will enlarge the Note Grid and
shrink the Continuous Data Grid.

Continuous Data Grid: Displays continuous data as
small icons on a time vs. value grid. Pitch bend, key
pressure, controllers, and note velocities are
displayed simultaneously on this grid. An event’s
location is measured by the Time Ruler at the top of
the window. Value is determined by the
Continuous Data Ruler on the left. Each type of
continuous data has a unique icon.

Continuous Data Ruler: Measures continuous data
events. This ruler can be toggled between three
scales: a controller scale from 0 to 127, whose
origin rests at the bottom of the window; a pitch
bend scale from -8192 to 8191, whose origin
appears in the middle of the grid; and a 
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combination scale that shows both pitch bend and
controller data at once on a -80 to 127 scale. Toggle
among the three scales by clicking on the ruler.

Pitch Ruler: Measures pitch along the vertical axis
with a standard keyboard format. Each C-natural
indicates the octave. For clarity, dotted lines extend
to the right from each key: a heavy dotted line for
black keys and a light dotted line for white keys.
With the Pitch Zoom icons, this ruler can zoom in
or out to increase or decrease the number of visible
octaves.

Pitch Zoom Icon: Zooms the pitch ruler in or out.
Click on the large keys to zoom in; click on the
smaller keys to zoom out. Four pitch zoom settings
are available. Zooming out allows you to see more
octaves at once. Zooming in allows you to focus on
a particular pitch range. The keyboard shortcuts
for these zoom buttons are command-up arrow
and command-down arrow.

Time Zoom Icon: Zooms the Time Ruler in or out.
Click the plus symbol ( + ) to zoom in; click the
minus symbol (-) to zoom out. Eight time-zoom
levels are available. Zooming out gives you an
overview; zooming in focuses on a shorter period
of time at higher resolution. Editing can be done at
any zoom level.

<*■ You can zoom to a selection by holding down
the option key and selecting a range of music in the
note grid or the time ruler.

BASICS
Graphic Editing is available in all tracks, including
the Conductor Track. The piano-roll display of
notes and the Continuous Data Grid allows you to
manipulate MIDI data using many of the
conventions established by Macintosh paint
programs. For example, you can drag a note to
change its location; you can lengthen the note by
dragging its handle. If the Edit Resolution feature is
enabled, the note, when moved, will ‘snap’ to a time 

grid. You can select a group of notes by dragging a
selection box over them. When you release the
mouse, notes inside the box will become selected.
Most of the features described in this chapter can
be used during playback.

Viewing Data three different ways
Each track in a Performer sequence contains MIDI
data. This data can be viewed with the Event List
window, the Graphic Editing window, or the
QuickScribe notation window. The data in the
track is the same regardless of which window you
use. For example, if you edit data in the Graphic
Editing window, the changes you make will be
immediately reflected in the track’s Event List
window.

Opening the Graphic Editing Window
To open the Graphic Editing window for a track:

1 Activate the Tracks window that contains the
track you wish to edit.

Click once on the Track window to activate it.

2 Click the desired track name, and click the
Graphic Editing window button in the Control
Panel.

The Graphic Editing window will appear.

You can also open the Graphic Editing window by
choosing Graphic Editing from the Event List
window mini-menu.

GRAPHIC EDITING
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Figure 12-2: Opening the Graphic Editing window from the Event List
window mini-menu.

Displaying More Than One Event Editing
Window at a Time
All three types of Event Editing windows for a
single track can be open at the same time. Changes
in one window are immediately reflected in the
other. The current position of each window is
remembered when you save the file.

i r i ■'11 — > ■ > >
|jaf5iF!E9i9iaiaiai

Clarinet iSeq-
311000 until 4(11000 12 times

2-E2 i£4 164 0:350
A«64 lOff

3121120 ^05 *64 01360
37|120 /C3 ’64 OIJEO

Figure 12-3: You can open as many edit windows at a time as you
want.

liJ 3BI12O ZC3 164 164 01360 | fj Unit = C| 120 beats

1.. I...I Ii3 I.,j...i..,r
tltr * — 7- - |

i —

Scrolling During Playback
The Auto-Scroll command in the Basics menu can
make the Graphic Editing window scroll during
playback. In addition, the window will
automatically open to the current playback
location of the sequence. Please refer to the Auto­
Scrolling section in the Playback chapter for more
information.

When auto-scrolling is turned on, you can
temporarily override it simply by clicking
anywhere in the Graphic Editing window or by
scrolling the window manually. The window will

stop for a moment before it resumes auto-scrolling.
This lets you view or edit things quickly without
having to stop playback.

Scrubbing with the playback wiper
You can “scrub” playback with the Graphic Editing
playback wiper by dragging the wiper left and
right. For more information, see “Scrubbing” on
page 91.

Switching to a Different Track Using the Title
Bar Pop-up Menu
If you have an event editing window open for a
track, you can switch to a different track in the
same window. To do so:

1 Command-click the track name in the title bar.

A pop-up menu appears as shown below.

Conductor
Flute
Oboe

Gossoon
Homs
Trumpets
Timpani
Uiolin I
Utolin II
Biola
Cello
Bass

>. Clarinet (Seq;t)
| |J Unit = J 01120 Sats

. I. ■ .aii, ■ I , .. I. , , I . . ■ I

>eats
1______________________ IL.

1 r ■ . 1 , ■■ 1 . ■ , 1 ,

Figure 12-4: Command-click the track name in the title bar to use the
pop-up menu to move from track to track within the same editing
window.

2 Choose the desired track.

The contents of the window changes to the track
you select.
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GRAPHIC EDITING WINDOW MINI-MENU
This menu is available in the title bar of every
track’s Graphic Editing window.

B____
Goto Counter
Goto...
Reinsert..
Reshape
Legend...
Set Ruler*..
Cont. Data Icons...
Set Ptr. Coords..

MIDI Edit
Switches Are Cont. Data

Event List
Notation Editing
QuickScnbe Notation

v'E: Measures
©Real time
■■ Frames

Goto Counter: Automatically scrolls the graphic
display to the time currently displayed in the
Counter. The counter location will appear at the
left-most position in the window.

Goto: Automatically scrolls the graphic display to a
time you specify, which will appear at the left-most
position in the window.

Reinsert: Inserts an event of the same type that you
last inserted. This is the same as the Insert
command but you are not prompted for the type of
event. This command can also be invoked by
option-clicking on the Insert (I) button on the
Graphic Editing window title bar.

Reshape: Changes the mouse pointer to a cross
hair that reshapes selected continuous data curves
when you drag over them in the Continuous Data
Grid. This command can also be invoked by
clicking the Reshape button in the title bar.

Legend: Produces a window that shows the icon
representing each type of MIDI event.

Set Rulers: Allows you to configure the Time Ruler
in any combination of Performer’s three time
formats: measures|beats|ticks, SMPTE time, and
real time. The main ruler is displayed lowest and
determines the time format for editing.

Cont. Data Icons: Opens the Continuous Data
Icons window, which displays icons for each type of
continuous data. This window also allows you to
reassign controller icons.

Set Ptr. Coords...(Set Pointer Coordinates): Allows
you to choose what time and pitch formats will be
displayed in the Pointer Coordinates Box.

MIDI Edit: Allows data in the graphic editing
window to be edited from a MIDI controller.

Switches are Cont. Data: Causes all controllers,
including switch controllers #64 and above, to be
displayed and edited as continuous controllers.
This is useful for MIDI devices, such as MIDI-
controlled lighting consoles, that use all MIDI
controllers as continuous controllers.

Event List: Opens the track’s Event List window.

Notation Editing: Opens the track’s Notation
Editing window.

QuickScribe Notation: Opens the QuickScribe
notation window with the track displayed in it by
itself.

Measures|Real time|Frames: These checkable
entries control which time formats are displayed in
the Information Bar and Event List.

THE INSERT BUTTON
The Insert button appears in the title bar of the
Graphic Editing window. It only appears when the
window is in Graphic Editing mode. When the
Insert button is clicked, the Insert menu appears, 
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from which you can choose the desired event to be
inserted by clicking once on the event type. An
event will pop up to be inserted.

Option-clicking the Insert button is just like
choosing Reinsert from the mini-menu.

THE RESHAPE BUTTON
The Reshape button appears next to the Insert
button. When the Reshape button is clicked, the
mouse pointer changes to a cross hair. When you
drag the cross hair over a selected curve in the
Continuous Data Grid, the curve will reshape as
you drag. For more information about reshaping
continuous data, see “Reshaping a Continuous
Data Curve” on page 178.

THE INFORMATION BAR
The Information Bar at the top of the Graphic
Editing window appears just below the title bar and
is divided into three sections separated by doubled
lines. The sections display precise, numeric
information about cursor location, currently
selected data, and minimum editing resolution.
MIDI data in the bar is displayed as it would appear
in the Event List window.
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Figure 12-5: The Information Bar provides information about the
current cursor location, the current selection (if any), and the Edit
Resolution (grid snapping while dragging).

Sometimes, information in each box may extend
beyond the space provided and will be clipped on
the right side of the box. If so, enlarge the
Information Bar by dragging the window’s grow
box to the right.
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The Pointer Coordinates Box
The Pointer Coordinates box is the left-most
section in the Information Bar. It displays the
current location of the mouse pointer with respect
to the Time, Pitch and Continuous Data rulers.
Values in this box are continually updated as the
mouse pointer moves over the Note Grid and
Continuous Data grid, giving you immediate,
numerical accuracy when manipulating data with
the mouse.

The pointer’s horizontal coordinate can be
expressed in measures|beats|ticks,SMPTE time, or
real time. Which time formats are shown is
determined by the Set Pointer Coordinates menu
item in the Graphic Editing window mini-menu.

To set the Pointer Coordinates box display:

1 Choose Set Ptr. Coords... from the Graphic
Editing window mini-menu.

A dialog box appears.

Figure 12-6: The Pointer Coordinates feature lets you customize the
information provided in the cursor coordinates display.

2 Check the time and pitch formats you prefer.

You can select any time format combination,
independent of the Time rulers that are displayed.

3 Click OK to confirm your choice or Cancel to
cancel it.

| 214126010:00:03:23 Bb2 • SB

Figure 12-7: Here, the cursor coordinates are being displayed in
mensural time, SMPTE time, pitch name, and MIDI note number.

159



The pointer’s time and pitch coordinates will be
expressed in each selected format. For example, if
both Measures and Frames are checked in the
mini-menu, the mouse position will be displayed
in both measures and SMPTE time.

The pointer’s vertical coordinate depends on its
location: if it is in the Note Grid, the vertical
coordinate may be expressed as a pitch, such as C3,
and its MIDI note number, 60.

.Trrr*
C3 * 60 11

Figure 12-8: In the note grid, the vertical position of the cursor can be
displayed as both a note name and its MIDI note number.

If the pointer is in the Continuous Data Grid, the
vertical coordinate is expressed as a continuous
data value on one of three scales: 0 to 127, -8192 to
8191, or -80 to 127, depending which is currently
displayed by the Continuous Data Ruler.

| 1|4|280 • 100
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Figure 12-9: If the cursor is in the continuous data grid, its value is
express on one of the three continuous data scales.

If the pointer is in the Median Strip, no vertical
coordinate is shown.

The Event Information Box
The Event Information box displays numerical
information about a single event or region that has
been selected. This box displays data in the same
way as it appears in the Event List window. For
example, a selected note will appear with its
measures|beats|ticks location, pitch, on and off
velocity, and duration.

Figure 12-10: When you click a note, its numerical information can be
displayed and edited in the information bar.
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If more than one event is selected by shift-clicking
or dragging, the box displays information about
the event that was last clicked.

When the Quick-Filter check box is checked, it
causes all other data types to temporarily disappear
from the Continuous Data Grid; the selected type
remains visible. For example, if you select a
controller #3 event and click the Quick-Filter check
box, all controller #3’s will remain visible and other
data types, such as pitch bend and velocities, will
disappear. To make the other data types reappear,
uncheck the check box.

NMlgl
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Figure 12-11: The Quick-Filter check box lets you quickly “solo"
(visually) the type of continuous data currently selected.

Information displayed in the Event Information
box can be pop-edited by clicking an item. As
normal, the Tab key and arrow keys move from
field to field. Press Return to confirm any changes
you have made, and the event’s graphic display will
change to reflect the modifications.

Sometimes, information in this box may extend
beyond the space provided and will be clipped on
the right side of the box. If so, enlarge the
Information Bar by dragging the window’s grow
box to the right.

The Edit Resolution Box
The Edit Resolution box determines the minimum
time unit for editing. The minimum time unit
consists of a duration, such as 240 ticks, or one
eighth note. MIDI events, note durations, loops,
region boundaries, Memory-cycle repeat barlines,
or any object that can be dragged horizontally will
only move in time increments equal to the value of
the edit resolution unit. Edit resolution only affects
MIDI data when the data is moved horizontally
with the mouse.
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The Edit Resolution box can be enabled or disabled
with the check box provided. When the check box
is selected, the current resolution unit is shown as a
note duration accompanied by a number of beats
and ticks. When disabled, the Unit = and beats
indicators become greyed out and editing occurs at
maximum resolution, which is either one tick, one
frame, or one screen pixel depending on the time
zoom setting.

You can change the edit resolution at any time. To
change the edit resolution:

1 Click on the note icon displayed in the Edit
Resolution box.

A pop-up menu will appear that displays note
durations.

2 Select a note duration from the pop-up menu
and release the mouse.

The duration you chose will now be displayed in
the box. Note also that the number of beats and
ticks now equals the note duration.

OR

3 Click on the beats|ticks values.

A pop-up box will appear.

4 Type in a number of beats and ticks in the box
provided and press Return to confirm your choice.

Note that when you type in a number of beats and/
or ticks, the note displayed next to the ticks box will
grey out if the tick value does not equal a standard
duration, such as 120 or 240 ticks.

Also note that when you zoom in the Time ruler,
Edit Resolution may cause data to seem like it is
“stuck”; that is, data will not move when you try to
drag it. This is because the Edit Resolution is larger
than the distance you are dragging. To “unstick” 

the data, deselect the Edit Resolution check box, or
hold down the command key while dragging.
Doing so overrides the edit resolution temporarily.
The command key temporarily overrides the
current setting of the Edit Resolution check box.
The command key also toggles the current Edit
Resolution setting while making selections.

The Edit Resolution box affects all Graphic Editing
windows. It does not affect the Event List window.

THE TIME RULER
The Time Ruler measures time horizontally for all
MIDI data in the Note Grid, the Median Strip, and
the Continuous Data Grid.
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Figure 12-12: The Time Ruler gives you a visual indication of where
data is. It can display time in measures and beats, real time, and/or
SMPTE time.

The Time Ruler consists of a main ruler, which
appears just above the Marker Strip. Auxiliary
rulers that display other time formats can also be
displayed above the main ruler.

To help line up MIDI events with the ruler, vertical
grid lines extend downwards from the main ruler,
through both grids and the Median Strip, to the
bottom of the window. These hairlines are placed at
regular intervals such that they remain a similar
distance apart between zoom levels.

To help align the mouse pointer with the Time
Ruler, a dotted hairline inside the Time Ruler
indicates the current position of the mouse.

Using the time ruler to select a playback point
You can double-click a segment in the time ruler to
make Performer jump to that location for playback.
You can do so when Performer is stopped or during
playback. This is an ideal way to quickly locate to a
desired point with the mouse.
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Choosing Time Formats
The Time Ruler can display time in any
combination of Performer’s three time formats:
measures|beats|ticks, SMPTE, and real time. You
can choose which formats to display with the Set
Rulers dialog box.

To choose the time format(s) for the Time Ruler:

1 Choose Set Rulers from the Graphic Editing
window mini-menu.

The Set Rulers dialog box appears.

Figure 12-13:The Set Rulers feature lets you customize what time
formats are displayed in the Time Ruler.

2 Choose a main ruler and any auxiliary rulers
that you prefer.

The main ruler appears lowest and determines the
time format for editing. Auxiliary rulers appear
above the main ruler. If the Tempo Control setting
is currently set to the Conductor track, only
Measures can be displayed as the main time ruler.

3 Click OK to confirm your choice or Cancel to
cancel it.

Changing an Auxiliary Ruler into the Main
Ruler
To quickly switch an auxiliary ruler into the Main
Ruler: 

■ Click the auxiliary ruler’s time format icon in the
Main Ruler Selector.
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The ruler will become the main ruler and appear at
the bottom. If the Tempo Control setting is
currently set to the Conductor track, only
Measures can be displayed as the main time ruler.

Zooming theTime Ruler
The Time Ruler can be zoomed in or out with the
Time Ruler Zoom icon to the left of the ruler.
Zooming out gives you an overview by
compressing greater amounts of time into the
window; zooming in focuses on a shorter period of
time at higher resolution. You can also option-drag
in the time ruler to zoom time only. See the
following section called Zooming for more
information.

ZOOMING
The Time Zoom and Pitch Zoom icons allow you
to‘zoom’ the time and pitch rulers in and out.
Zooming in Performer is similar to the
magnification feature found in most Macintosh
graphics programs. When zooming in, objects
become larger as the display magnifies a portion of
the screen. When zooming out, objects shrink as
the display encompasses a larger region.

|E|g)Ellg|
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Performer’s zoom feature is based on the same
idea; however, the Time and Pitch Zoom icons
allow the time and pitch axes to zoom indepen­
dently. For example, you can zoom out the Time
Ruler to see more measures at one time, and zoom
in the Pitch Ruler to focus on a specific pitch range.

Because pitch and time zooming are exclusive from
one another, notes on the Note Grid will not
magnify or shrink in the same manner as a
standard zoom feature. In addition, the grid lines
remain approximately the same distance apart,
regardless of the zoom setting.
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Zooming the Time Ruler
The Time Zoom icons zooms the Time Ruler. They
appear just to the left of the Time Ruler. Zooming
out gives you an overview by compressing more
measures into the window; zooming in focuses on
a shorter period of time at a higher viewing
resolution. The dotted hairlines extending from the
Time Ruler remain approximately the same
distance apart, regardless of the zoom setting.

The Time Ruler provides 8 zoom levels if the main
ruler is displaying measures and beats or real time.
It provides 7 zoom levels when the main ruler
displays SMPTE time. When zooming out, notes
with extremely short durations will remain visible.

Editing is allowed at any time zoom setting.
However, the current zoom level may affect the
resolution at which events can be edited. For
example, let’s say that the edit resolution unit is set
to 20 ticks in the Edit Resolution box. If you zoom
the Time Ruler out as far as it can go, you will not
be able to drag a note by only 20 ticks because one
screen pixel, which is the smallest unit of
movement on the Macintosh screen, will equal a
time value greater than 20 ticks. So, even if you
move the note as little as possible, you will still have
moved it more than 20 ticks.

In the example above, Performer handles the
situation by constraining location to multiples of 20
ticks. When you move the note, its new location
will become the nearest multiple of 20 ticks, such as
80,140, or 420 ticks.

Zoom in

To zoom out, click once (or repeatedly) on the
magnifying glass icon with the minus sign (-). To
zoom in, click once (or repeatedly) on the
magnifying glass icon with the plus sign ( + ).

Zooming the Pitch Ruler
The Pitch Zoom icon zooms the pitch ruler and
provides four zoom settings. Zooming out reduces
the size of the keys on the ruler, allowing you to see
more octaves at once; zooming in enlarges the keys,
allowing you to focus on a particular pitch range.

111E
When the Pitch Ruler is zoomed in, notes become
larger and the grid displays a smaller pitch range:

When the Pitch Ruler is zoomed out, notes become
slightly smaller and the grid displays several
octaves:

To see smaller notes and larger pitch range, click
once (or repeatedly) on the small keys in the icon.
To see larger notes (and a smaller pitch range),
click once (or repeatedly) on the large keys in the
icon.
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Smaller notes
(larger pitch range)

Zooming shortcuts
Here are some zooming shortcuts:

Larger notes

Do this To zoom as follows

Option-drag in the time ruler
or in the note grid

To fill the window with the
region you select

Option-drag a selection in the
note grid

To zoom time and pitch simul­
taneously

Option-click the zoom out
button

To zoom all the way out

Option-click the zoom in but­
ton

To zoom all the way in

Command-click the zoom
buttons

To toggle between the last two
zoom levels

Press command-left arrow or
command-right arrow

To zoom the time ruler out and
in, respectively

Press command-up arrow or
command-down arrow

To zoom the pitch ruler

The time ruler zoom buttons in the Graphic
Editing and Notation Editing window, as well as
the pitch ruler zoom buttons, have the keyboard
shortcuts as shown below.

command-right arrow

command-down arrow

command-left arrow

GRAPHIC EDITING BASICS
All of Performer’s powerful editing features are
available in the Graphic Editing window. Most
editing can be done with the mouse using familiar
actions like clicking, dragging, and shift-dragging.

Such actions can shift data, change note pitch and
duration, reshape continuous data curves, and
more.

The sections below describe basic features that you
will find helpful when working in Performer’s
graphic environment.

Using the Shift Key to Constrain Dragging
If you hold down the Shift keyjust before you begin
to drag a note (or group of selected notes), the
pointer’s movement on the screen will be
constrained to either the horizontal or vertical axis,
depending on the initial direction of movement.
For example, if you click the mouse, hold down the
shift key, and drag upwards, the mouse will only
move up or down: it will not stray left or right.

Constraining mouse movement in this way is often
extremely helpful. For example, if you want to
modify just the pitch of a note without changing its
location, the Shift key allows you to do so by
preventing the mouse from moving left or right.

To constrain the movement of the mouse:

1 Hold down the Shift key.

2 Drag the note (or selected notes) in the
direction you wish.

If you drag up or down, the mouse will only move
on a vertical axis. If you drag left or right, the
mouse will only move on a horizontal axis.
Movement will be constrained until you release the
mouse.

Option-dragging to Make Copies
Similar to Macintosh graphics programs, option­
dragging a note (or several selected notes) in the
Graphic Editing window leaves the original data
unchanged and places a copy of the data at the
destination. Option-dragging is a convenient
shortcut for copying and pasting.
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'*■ Option-dragging in the grid is different: doing
so zooms the window to fit the selection you make
while option-dragging

Shift-clicking to Select Non-adjacent Events
Holding down the Shift key also serves as a useful
way to select more than one event. For example, if
you have already selected a note and you want to
select another, scroll to the other note (if
necessary) and shift-click on it (but don’t drag). It
will highlight, and the first note will remain
highlighted.

Dragging Multiple Data Types
The shift-click method of selection allows you to
simultaneously select and drag multiple data types
horizontally in the Note grid, Continuous Data
grid, Median strip, and Marker strip.

For example, to move a loop containing notes,
pitch bend data, and a patch change, select all four
data types by shift-clicking and drag them to a new
location.

Using Edit Resolution
When the Edit Resolution check box is selected,
MIDI data that is moved or inserted will ‘snap’ to
positions corresponding to the edit resolution unit
shown in the box. For example, if the current edit
resolution unit is 240 ticks, events that are moved
with the mouse will snap to eighth note positions
(every 240 ticks) on the grid. If the Edit Resolution
check box is not checked, events will move freely.
You can temporarily override the current grid
setting by holding down the command key as you
drag. For more information about the Edit
Resolution box, please refer to the section earlier in
this chapter called The Edit Resolution Box.

Selecting a Time Range Using theTime Ruler
In the Graphic Editing window, a region can be
selected by dragging to the left or right in the Main
Time Ruler. See “Time Ruler Selection Techniques”
on page 212.
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Using the Undo Command
The Undo command in the Edit menu will undo
the last action you executed in the Graphic Editing
window. For example, if you move a note and then
change your mind, you can choose Undo Move
from the Edit menu and the note will pop back to
its original position. The Undo command is also
useful when drawing or redrawing continuous data
curves. If you modify a curve and are not satisfied
with the results, simply choose Undo from the Edit
menu or press command-Z and try again.

THE VIEW FILTER
In the Graphic Editing window, the View Filter
serves two useful functions. It allows you to control
what types of data you can see and edit in the
window. In essence, the View Filter acts like an edit
filter: if a type of data, such as pitch bend, is visible
in the window, it will be affected by editing
commands. If the data type is not visible in the
window, it cannot be edited.

For information about using the View Filter, see
“Setting the View Filter” on page 217.

THE MARKER STRIP
The Marker Strip appears just below the Time
Ruler. It displays markers, meter changes, key
changes and loops. It is always visible and is not
affected by vertical scrolling.

Figure 12-14: Performer's Marker strip shows markers, loops, and
Conductor track items like meter changes.

I 165
GRAPHIC EDITING



The Marker Strip shares the Time Ruler with the
Note Grid, the Median Strip, and the Continuous
Data Grid. Therefore, the location of items in the
Marker Strip will correspond with MIDI data
displayed below.

Markers, meter changes, and key changes often
occur very close together or at the same location.
In the first example to the left, the meter change is
preceded by a marker, which appears as a bar just
to its left. If you would like to see the entire marker,
press it, and the marker will highlight and pop to
the front. If the marker and meter change occur
exactly at the same tick, they are displayed with a
list icon, shown in the second example. If you
would like to see the list, press the list icon, drag
downwards and a pull-down menu will pop open.

|^12/8| —> |^Marker-31

[J Marker-3

12/8 click J)

Figure 12-15: When items in the Marker Strip occur very close to one
another (or even on the same exact tick), Performer displays the pop­
up menu icons shown here on the left. Clicking them lets you see
what the events are, and you can also select them by choosing them
from the menu.

Markers
In the Marker Strip, a marker appears as a pointer,
followed by the marker’s name. The pointer
indicates the marker’s exact location. If the marker
is locked, a lock icon will appear between the
pointer and the marker name.

Markers cannot be edited in the Marker Strip;
instead, they can be edited in the Conductor track
or the Markers window. Please refer to the chapter
on the Markers window for more information
about editing markers.

In the Conductor track, markers are displayed in
the Median Strip. Please refer to the section later in
this chapter called Graphic Editing in the Conductor
Track for more information.

Meter and Key Changes
Meter and key changes appear in the Marker Strip
in much the same way as they do in the event list
window. (Tempo changes are not displayed in the
Marker Strip.) Similarly, they can only be edited in
the Conductor track. Please refer to the section
later in this chapter called Graphic Editing in the
Conductor Track for more information.

Loops
Loops appear in the Marker Strip as a loop icon
followed by a line that ends in a bracket. The loop
icon indicates the beginning of the loop; the line
and bracket represent the duration and end of the
loop.

Following the loop, the Marker Strip contains a
greyed-out region that represents the time during
which the loop plays. Just like italicized notes in the
Event List display, MIDI data within the greyed-out
region will not play back because data inside the
loop plays instead. Data within the greyed-out
region can, however, be edited normally.
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Figure 12-16: Loops are also displayed in the Marker Strip.

When a loop is selected, the Marker Strip area
inside of the loop will highlight, indicating that the
loop is selected. Numerical data about the loop will
be displayed in the Event Information bar. When
loops are nested inside one another, the outer-most
loop appears above the loops nested inside it.

Working with Loops
Loops can be edited by dragging the loop icon in
the Marker Strip with the mouse or by editing the
numbers displayed in the Information Bar.

To insert a Loop
To insert a loop:
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1 Press on the Insert button in the title bar of the
Graphic Editing window and choose Loop from
the menu.

The mouse pointer turns into a cross hair.

2 Click at the desired start location in the Marker
Strip, drag to the right to draw the desired length,
and release the mouse at the end location.

A loop will appear. Use the dotted hairlines in the
Time Ruler to align the beginning and end of the
loop while inserting it. Information about the loop
will appear in the Information bar.

To Edit a Loop
To change the location of a loop:

1 Click the loop icon in the Marker Strip and drag
left or right to advance or delay the loop.

The entire loop, from beginning to end, will move
when you drag the loop icon in this fashion. You
can align the start or end point of the loop by
watching the hairlines provided in the ruler.

To change the length of a loop:

1 Select the loop by clicking on its loop icon in the
Marker Strip.

The loop will highlight.

2 Click the end bracket of the loop and drag left or
right to shorten or lengthen the loop.

Align the end bracket by watching the hairline
provided in the ruler.

THE NOTE GRID
The Note Grid is the region in the Graphic Editing
window between the Marker Strip and the Median
Strip. It is flanked by the Pitch Ruler on the left and
a vertical scroll bar on the right.

Basics
The Note Grid functions like a standard graph.
Time extends horizontally from left to right and
pitch stands vertically. Thus, the higher the pitch of
a note is, the higher it will appear on the grid. The
later a note occurs, the farther to the right it will
appear on the grid.

The time and pitch axes are measured with a Time
Ruler above the grid and a Pitch Ruler to the left of
the grid. The rulers indicate the exact location and
pitch of notes. Grid hairlines extend from each
ruler to aid you in determining a note’s position.

Scrolling in the Note Grid
Because the size of the Graphic Editing window is
restricted, the Note Grid usually displays only a
portion of the track at one time. The horizontal
scroll bar at the bottom of the window moves the
Note Grid to the left and right. The vertical scroll
bar just to the right of the Note Grid moves the
pitch axis up and down over the entire MIDI note
range. By scrolling, you can view any region of the
track at any pitch range.

Controlling the Dimensions of the Note Grid
The size of the Note Grid is controlled by the
Graphic Editing window grow box in the lower
right hand corner of the window, and by the
Median Strip just below the Note Grid. Drag the
grow box to resize the entire window. Drag the
Median Strip up or down with the move handles
provided at either end to decrease or increase the
size of the Note Grid and Continuous Data Grid
respectively. For example, if you drag the Median
Strip down as far as it will go, you will see just the
Note Grid:
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Figure 12-17: Here, the Median Strip handle on the left has been
dragged all the way down to hide the continuous data grid and
maximize the note grid.

Displaying Notes
Only notes are displayed on the Note Grid, and
they appear as horizontal bars. The vertical
position of the bar indicates pitch. The left end of
the bar indicates where the note begins, and the
right end indicates where the note releases. The
length of the bar represents the note’s duration. All
of these characteristics can be determined by the
Time Ruler above the grid and the Pitch Ruler to
the left.

When the Pitch Ruler is zoomed in, each bar tapers
at the ends to distinguish it from adjacent notes.
When the Pitch Ruler is zoomed out, notes become
smaller and do not taper. Sometimes, adjacent
notes of the same pitch will look like one long note.
The example below shows two adjacent notes when
the Pitch Ruler is zoomed out. When zoomed in,
the notes are easily distinguished, as shown to the
right:

Two notes, zoomed out The same notes, zoomed in

Displaying On and OffVelocities
The on and off velocities of notes are not displayed
in the Note Grid. Instead, they are displayed in the
Continuous Data Grid directly below the note. An
onvelocityappearsasasmall'v ’’directlybelowthe

beginning of the note bar, and an off velocity
appears as a small“A” directly below the release. If
a note is selected, its velocity icons will be selected
with the note.

Selected velocity

Selected note

Note-on velocity

Note-off velocity

Figure I2-I8:How note velocities are displayed in the continuous
controller grid.

Displaying on-velocities in this manner allows you
to edit them in the same ways as continuous data.
For example, you can create a crescendo or
decrescendo simply by editing on-velocities in the
Continuous Data Grid. See “Editing Continuous
Data” on page 175 called for more information.

Off-velocities are displayed in the continuous data
grid for reference only; they cannot be graphically
edited. On-velocities can be fully edited.

Controlling the Display of Notes with the View
Filter
The View Filter, found in the Basics menu, allows
you to choose whether or not notes are displayed in
the Note Grid. If you have MIDI data in a track, but
you cannot see the notes in the Note Grid, check
the View Filter and make sure that the Notes check
box is selected.

The View Filter also controls whether on and off
velocities will be displayed. For example, if the On
Velocities check box is deselected in the View Filter,
the“v ’’iconswillnotappearontheContinuous
Data Grid.

For more information about using the View Filter,
see “Setting the View Filter” on page 217.
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THE PITCH RULER
The Pitch Ruler lies vertically to the left of the Note
Grid and measures pitch. It resembles a standard
piano keyboard. Because the entire ruler cannot fit
in the window at once, a vertical scroll bar is
provided to the right of the note grid to allow you
to scroll up and down through the entire MIDI
pitch range. Octaves are indicated on each C-
natural key.

To help align notes to the ruler, hairlines extend to
the right from each note, a heavier line for black
keys and a lighter line for white keys.

To help align the mouse pointer with the Pitch
Ruler, a moving dotted hairline inside the Pitch
Ruler follows the current position of the mouse.

Listening to the Pitch Ruler
When the Audible Mode button (labelled with the
speaker icon) is pressed in the title bar of the
Graphic Editing window, the keys on the pitch
ruler play their pitch over MIDI when you click on
them. When you click on a Pitch Ruler key, a MIDI
note with that pitch is transmitted from Performer
to the MIDI channel(s) that the track is assigned to.

Figure 12-19: When Audible Mode is turned on (the speaker icon in
the title bar), you can “play” the pitch ruler by clicking the keys and
dragging over them.

Playback from a track’s Pitch Ruler has the same
requirements as regular playback: the track must
be assigned to a MIDI channel and a synthesizer
must be set up to receive MIDI on that channel. If
you click on a Pitch Ruler key and don’t hear
anything, make sure that your MIDI connections
are set up properly and that your synthesizer is
ready to receive MIDI data. If MIDI data in the 

track plays back properly when you press the Play
button in the Control Panel, the Pitch Ruler keys
will play back properly as well.

If you are having trouble getting the Pitch Ruler
keys to play, refer to the Getting Started booklet that
accompanies this reference guide.

Zooming the Pitch Ruler
The Pitch Ruler can be zoomed in or out with the
Pitch Zoom icon, which provides four zoom
settings. Zooming out reduces the size of the keys
on the pitch ruler, allowing you to see more octaves
at once. Zooming in enlarges the keys, allowing
you to focus on a particular pitch range.

For more information about zooming the Note
Grid with the Pitch Ruler, please refer to the section
earlier in this chapter called Zooming.

Lengthening the Pitch Ruler
The pitch ruler only displays as many keys as will fit
in the window at the current zoom setting. If you
wish to see more keys, resize the Graphic Editing
window and drag the Median Strip down.

You can also view more keys at a time by zooming
out the pitch ruler as described in the previous
section.

INSERTING NOTES
To insert a note:

1 If you’d like to be able to hear the pitch as you
insert the note, make sure Audible mode is turned
on in the title bar.

GRAPHIC EDITING
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Figure 12-20:The Audible Mode speaker button in the Graphic
Editing window title bar.

2 If desired, set the edit resolution.

*>_ Trock-I (Seq-II
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3 From the insert menu in the title bar, choose
Note.

4 Press on the grid at the desired location, and
then drag up and down to specify the pitch and
drag to the right to specify the duration.

Keep dragging until you get the pitch and duration
you want.

5 When you have got the pitch and duration you
want, release the mouse to insert the note.

Note insertion always starts with the last duration
you inserted.

If you want to insert multiple notes quickly, hold
down the shift key when you first click on the grid
each time. This preserves the note insertion cross­
hair cursor rather than switching back to the arrow
cursor.

Inserting a Note Using a MIDI Controller
To determine the pitch of a note by playing the note
when you insert it:

1 Make sure that MIDI Edit is checked in the
Graphic Editing Window mini-menu.

If it is not checked, choose it.

170 L

2 Press on the Insert button in the title bar of the
Graphic Editing window,

3 Choose Note from the menu.

The menu will disappear and the pointer will turn
into a cross hair.

4 Click at the desired time location on the Note
Grid, drag to the right to draw the desired
duration, and release the mouse.

You do not need to be careful about pitch location,
which is taken care of in the next step.

5 With the inserted note still selected, press any
key on your MIDI controller.

The inserted note will pop to the pitch that you
choose. The inserted note must still be selected
from the previous step for this step to work. If you
press the wrong note, try again. You can keep
changing the note’s pitch in this fashion as long as
the note remains selected.

Inserting a Chord Using a MIDI Controller
To insert a chord:

1 Press the Insert button in the Graphic Editing
window title bar.

2 Choose Note from the menu.

The Cursor will turn into a cross-hair.

3 If you would like to insert more than one chord,
either hold down the shift key, or push down the
caps lock key.

This will keep Performer in insertion mode after
you insert the chord.

4 Play the chord you wish to insert on your MIDI
controller and, while holding the chord, click
where you want the chord to begin and drag from
left to right to the appropriate duration.
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2 Release the mouse.

The vertical position of your click is not important;
the notes are determined by what you play on your
controller. Only the attack and release of the chord
is affect by the cross-hair.

Only events whose attack occurs inside the
selection box will select.

As long as you remain in insertion mode, you can
enter chords in this fashion for as long as you like.
You can even alternate between entering notes with
the mouse only or the mouse with a MIDI
controller.

i

Using the Shift Key to Extend Selections
You can add to the current selection by holding

SELECTING NOTES
This section describes how to select notes on the
Note Grid. To learn how to select an entire region
by dragging in the Time Ruler, refer the section
earlier in this chapter called Selecting a Region
Using the Time Ruler.

down shift key when selecting individual notes or
groups of notes as described in the previous two
sections.

Selecting all Notes of a Single Pitch
You can quickly select all notes of a specific pitch in
the note grid by double-clicking a key on the Pitch
ruler. Shift-double-click multiple keys to select

Selecting a Single Note
To select a note on the Note Grid:

discontiguous pitches. Shift-double-clicking
selects or deselects without deselecting other

1 Click once on the note to select it. events.

This feature is extremely handy when working with

<— > drum tracks. For example, if you would like to
select all snare drum notes in a track:

The note becomes highlighted to indicate that it is
selected.

1 Click the Audible Mode button.

2 Click the pitch keys on the Pitch Ruler to locate
Selecting a Group of Notes
To select a group of events:

the key that corresponds to the snare drum.

3 Once you find the snare drum sound, double-
1 Drag out a selection box over the events to be
selected.

click the key.

All the snare drum notes will highlight in the track.
A highlighted box indicates the selection area. You can then delete them, copy them, drag them up

or down to a different note (sound), etc.

EDITING NOTES
---- The pitch, duration, and location of notes can be

*
1 ”1.1. .

modified on the Note Grid in much the same way
as objects in a graphics program. Note velocities
can be edited in the Continuous Data Grid.

GRAPHIC EDITING
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Changing a Note's Pitch or Location
To change a note’s pitch or location:

1 Click the note.

2 Drag the note to a different position and release
the mouse.

When you begin dragging, an outline of the note
will appear in place of the mouse pointer. Dragging
the note vertically changes its pitch. Dragging the
note horizontally changes its time location.
Duration is not affected when dragging the entire
note. When you release the mouse, the note will
pop to the new location.

To help position the note in time, hairlines appear
in the Time Ruler that show the attack and release
of the selected note. In addition, the Pitch Ruler key
that corresponds to the note’s current pitch
highlights as you move.

If you hold down the shift key before you drag, the
mouse will be constrained either vertically or
horizontally, depending on which way you drag
first. This allows you to change the note’s pitch
without changing its location.

Nudging Notes with the Left/Right Arrow Keys
Once a note or group of notes have been selected,
you can nudge them earlier or later in the track
using the left and right arrow keys. Nudging is
affected by the current edit resolution setting. For
example, if the Edit Resolution is turned on and set
to a quarter note grid, pressing the arrow keys will
move notes one quarter note at a time. If Edit
Resolution is turned off, notes are nudged 20 ticks
at a time.

Changing a Note's Duration
To change the duration of a note:

1 Position the cursor near the right-hand tip of
the note.

2 Drag left or right to shorten or lengthen the
note.

Changing a Note's Pitch Using a MIDI
Controller
To change the pitch of a note with your MIDI
controller:

1 Make sure that MIDI Edit is checked in the
Graphic Editing Window mini-menu.

If it is not checked, choose it.

2 Click the note once to select it.

A handle appears at the end of the note to indicate
that it is selected.

3 Press any note on your MIDI controller.

The selected note will change to the pitch you play.
This can also be done with more than one note
selected. This is a quick way to convert a group of
different notes to the same pitch.

Editing a Group of Notes
Editing a group of notes is similar to editing a
single note.

1 Select the notes that you wish to edit.

To select them, drag out a selection box or shift­
click each note.

2 Click one of the notes and drag it to a new
position.

All of the notes will move together. When you
begin dragging, an outline of the notes will appear
in place of the mouse pointer. Dragging notes
vertically changes their pitch. Dragging notes 
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horizontally changes their time location. When
you release the mouse, the notes will pop to their
new locations.

To help position the notes in time, hairlines appear
in the Time Ruler to indicate the attack of the first
selected note and the release of the last selected
note. In addition, the Pitch Ruler key
corresponding to the note you click highlights. If
notes of more than one pitch are selected, the Pitch
Ruler keys that correspond to the highest and
lowest selected notes appear greyed.

Converting More Than One Note to the Same
Pitch
To convert a group of selected notes to the same
pitch:

1 Make sure that MIDI Edit is checked in the
Graphic Editing Window mini-menu.

If it is not checked, choose it.

2 Select the notes.

You can select a group of notes by shift-clicking
each one or by dragging out a selection box. A
square handle will appear at the end of each note to
indicate that it is highlighted.

3 Press any note on your MIDI controller.

The selected notes will change to the pitch you play.

USING AUDIBLE MODE
In the Graphic Editing window, Audible Mode
functions similarly to the Event List Window: if the
speaker icon is highlighted and you click a note, the
note will play back over MIDI.

If you select a group of notes or other MIDI data
and option-click the Audible Mode button, the
selected data will play back as a phrase. Or you can
choose Play Selection from the Basics menu.

Audible mode also allows you to scrub with the
playback wiper. For more information about
Audible Mode, see “Audible Mode” on page 149.

THE CONTINUOUS DATA GRID
The Continuous Data Grid is the region at the
bottom of the Graphic Editing window below the
Median Strip and above the horizontal scroll bar. It
is flanked by the Continuous Data Ruler on the left
and an empty margin on the right.

Basics
The Continuous Data Grid displays MIDI
controllers, pitch bend, mono and poly key
pressure, and note-on/off velocities. The grid
functions like a standard X and Y coordinate
graph, in which time lies on the horizontal axis and
value along the vertical axis. The higher the value
of a continuous data event is, the higher it will
appear on the grid. The later the event occurs, the
farther to the right it will appear on the grid.
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Location and value are measured with the Time
Ruler and the Continuous Data Ruler respectively.
Grid lines extend from the Time ruler to help in
determining an event’s position.

The Continuous Data Grid has no vertical scroll
bar. Instead, the grid automatically compresses or
expands to fit in the current space between the
Median Strip and the bottom of the window. The
grid can be stretched (or compressed) vertically by
dragging the Median Strip up (or down). To make
more room for both the Continuous Data Grid and
Note Grid, simply enlarge the entire window with
the grow box.

A continuous data event is displayed on the grid as
a small icon, such as a square or a circle. Pitch bend
data, aftertouch, velocities, and controllers each
have a unique icon. The icons are defined in the
Continuous Data Icons window, which can be
opened from the Graphic Editing window mini­
menu.

Eight different icons are available for the display of
Controllers. Controllers can be assigned to icons in
the Continuous Data Icons window. For more
information, see “The Continuous Data Icons
Window” on page 181.

Viewing Continuous Data Types One at a Time
The expression continuous data type refers to a kind
of continuous data. For example, pitch bend is one
kind of continuous data. MIDI controllers between
0 and 63 are each considered a continuous data
type.

Continuous data types can be viewed simulta­
neously in the Continuous Data Grid. Sometimes,
however, you may wish to see only one type (or
several) at a time. Performer offers several ways to
temporarily isolate continuous data types for
viewing and editing.

To view pitch bend data by itself, click on the
Continuous Data Ruler. Doing so toggles the ruler
among three displays, one which displays pitch
bend data by itself. For more information about
this feature, refer to the next section called The
Continuous Data Ruler.

To view a controller data type by itself, click an
event of that type and click the Quick-Filter check
box that appears in the Information Bar next to the
event’s numerical data. Clicking the Quick-Filter
box causes all other data types to temporarily
disappear until you click it again. For more
information, refer to the section later in this
chapter called Editing Continuous Data.

The Quick-Filter is useful for temporarily isolating
continuous data types. However, data types can
also be filtered with the View Filter in the Basics
menu. Data types that are selected in the View
Filter will be displayed; ones that are not selected
will not be displayed. To view all data types, click
the Set All button in the View Filter.

Like the Quick-Filter, the View Filter affects
selecting and editing. For example, if note velocity
data has been filtered from the display, it cannot be
selected for editing. All visible data types can be
selected for editing.

For information about editing continuous data, see
“Editing Continuous Data” on page 175.

The Continuous Data Ruler
All continuous MIDI data has a value range from 0
to 127 except pitch bend, which has a value range
from -8192 to 8191. Because of these two separate
scales, the Continuous Data Ruler provides three
different scales:

1. a controller scale from 0 to 127, whose origin rests
at the bottom of the window:

2. a pitch bend scale from -8192 to 8191, whose
origin appears in the middle of the window:
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3. a combination scale from -80 to 127, which
combines the above two scales and whose origin
appears just below the middle of the window.

Controller
scale

Combination
scale

To switch from one scale to another, click in the
ruler. Doing so toggles from the current scale to the
next. Each scale displays data appropriate to that
scale. The controller scale (0 to 127) displays
controller data only. The pitch bend scale (-8192 to
8191) displays pitch bend only. The combination
scale (-80 to 127) displays controller data and pitch
bend together. Note velocities, if selected in the
View Filter, appear in the controller and
combination scales. The pitch bend scale displays
pitch bend even if it is deselected in the View Filter.

All three scales provide numbered marks in the
ruler and an origin line extending to the right that
indicates where zero is on the ruler.

Controlling the Length of the Continuous Data
Ruler
The entire Continuous Data Ruler is always visible.
If you resize the grid using the Median Strip or the
Graphic Editing window’s grow box, the
Continuous Data Ruler will compress or expand to
fit in the available space. The data within the grid
will also compress or expand to conform to the
ruler.
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If you wish to enlarge the view of the Continuous
Data Grid, resize the Graphic Editing window and
drag up the Median Strip. If you move the Median
Strip all the way up, the Continuous Data Grid will
occupy the entire window.

Zooming the Continuous Data Grid
The Continuous Data Grid can be zoomed along
the time (horizontal) axis. Time zooming has the
visual effect of expanding or compressing a
continuous data curve in the window. If you zoom
in, the curve spreads out:

If you zoom out, the same curve compresses:

The data that comprises the curve does not change
between these two views: only its appearance
changes. Time zooming allows up to eight different
settings. For more information about zooming the
Time Ruler, refer to the section earlier in this
chapter called Zooming.

Editing Continuous Data
The Continuous Data Grid displays more than one
type of continuous data at a time. For example, the
grid can display pitch bend, controller #7, and
mono key pressure all at once. Each type is
distinguished by the shape of its icon.
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Because data types are displayed simultaneously,
they can be selected and edited together.
Sometimes, however, you may wish to edit only
one type (or several) at a time. Performer provides
two ways to isolate continuous data types for
viewing and editing. For example, if the
Continuous Data Grid currently displays the three
types of data mentioned above, you can filter out
pitch bend and key pressure to view controller #7
data by itself.

The most convenient way to filter data is with the
Quick-Filter check box. To view controller number
#7 s only, click any controller #7 event to select it
and click the Quick-Filter check box next to the
event’s numerical data in the Information Bar. All
other data types will temporarily disappear, and
you can then easily select controller #7’s without
inadvertently selecting other data types. To make
other data types reappear, click the Quick-Filter
check box again.

The regular View Filter, found in the Basics menu,
also filters data types. In the View Filter dialog box,
select the continuous data type(s) you wish to see
and deselect all others. Only visible data can be
selected for editing.

When a continuous data event is selected, a line
extends from the icon to the origin line on the
continuous data grid. Once events are selected,
they can be edited.

The diagram below shows three deselected
controller events on the left. To the right the events
are selected: a line extends to the origin line;
selected events can be edited.

Deselected Selected

Events selected in this fashion can be edited with
the following commands in the Edit menu: Cut,
Copy, Paste, Erase, Merge, Splice, and Shift. To
Snip or Repeat, you must select a region by
dragging in the Time Ruler.

Quick-Filtering Data Types
To view certain continuous data types and quickly
filter the rest:

1 Select an event of each data type that you want
to see.

I naoeo a°i hop

Quick Filter
check box

Click the event, or drag a selection box over it. To
select more than one data type, shift-dick an event
of each type.

2 Click the Quick-Filter check box that appears
next to the numerical data in the Information Bar.

All data types will disappear except those that you
selected. To make all data types reappear, click the
Quick-Filter check box again. You can toggle freely
between filtered and unfiltered mode.

Selecting a Single Continuous Data Event
To select an event:

1 Click the event.

The event will become selected. The selected event
displays a vertical line extending from its icon to
the origin line.

Selecting a Group of Continuous Data Events
To select a group of continuous data events:

1 Drag a selection box over the events and release
the mouse.
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When you release, any events inside the dotted
selection box will be selected. All other highlighted
events will deselect. If other events are selected
before you drag and you want them to remain
selected, hold down the shift key before you drag
out the selection box.

Drag out a selection box... .. .and release.

To select all events of a single data type:

1 Double-click an event of that type.

All events of that type will become selected. All
events of other types will deselect. If events of other
types are selected beforehand and you want them
to remain selected, shift-double-click and the other
events will remain selected.

To deselect all events of a single data type:

1 Shift-double-click a selected event of that type.

All events of that type will deselect.

Inserting a Single Continuous Data Event
To insert an event on the Continuous Data Grid:

1 Press the Insert button in the title bar of the
Graphic Editing window,

2 Choose the type of event you wish to insert from
the menu.

The mouse pointer will turn into a cross hair. For
some types of data, an additional box may appear
requesting further information.

3 Click the cross hair once at the desired time
location and value.

The event will appear where you click, and the
mouse will switch back to an arrow. If you wish to
insert multiple events, press the shift key before
you click and the cursor will remain a cross hair.

Editing a Single Continuous Data Event
To change the value or location of a single
continuous data event:

1 Click the event and drag it to a different position
or value.

Drag vertically to change its value. Drag
horizontally to change its location. Press the shift
key to constrain the mouse vertically or
horizontally. For exact positioning, refer to the
Pointer Coordinates Box and the rulers.

Editing the Value of an Event Using a MIDI
Controller
To change the value of an event with your MIDI
controller:

1 Make sure that MIDI Edit is checked in the
Graphic Editing Window mini-menu.

If it is not checked, choose it.

2 Click the event to select it.

3 Transmit a corresponding event from your
MIDI controller.

For example, if you have selected pitch bend event,
move the pitch bend wheel on your controller and
the event will change to the new value you set with
the wheel.

4 When you have entered the value you wish,
press the Return key or the mouse to confirm the
new value.
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Working With Continuous Data Curves
A continuous data curve is a group of many
individual events. Events that form a curve can be
edited together in much the same way as a single
event. The only difference is that more than one
event is selected.

Selecting a Continuous Data Curve
To select a continuous data curve:

1 Filter other data types, if necessary.

Click an event in the curve you wish to select and
click the Quick-Filter check box in the Information
Bar. Filtering is only necessary if the region that the
curve occupies contains other data types that you
do not want to select.

2 Drag a selection box over the curve and release
the mouse.

The portion of the curve inside the selection box
will become selected. All other events will deselect.
If you want other events to remain selected, press
the shift key while you drag out the selection box.

To select all events of a continuous data type:

1 Double-click an event of the desired type.

To deselect all, shift-double-click a selected event.

Shift-double-clicking selects or deselects all
without affecting the status of other types.

Inserting a Continuous Data Curve
To insert a curve of continuous data:

1 Press the Insert button in the title bar of the
Graphic Editing window.

2 Choose the type of event you wish to insert from
the menu.

The mouse pointer will turn into a cross hair. For
some types of data, an additional box may appear
requesting further information.

3 Click on the grid where you want the curve to
begin and drag the desired shape of the curve over
the region.

Events will appear at regular intervals as you drag
the mouse. The events will be spaced according to
the current edit resolution. The value of events is
determined by the vertical position of the mouse. If
you wish to insert multiple curves, press the shift
key before you drag; the cross hair will remain,
indicating that you are still in Insert mode.

OR

4 Option-drag from the start point to the end
point of the curve.

A straight line will appear with handles on either
end and a handle at its midpoint. This line
represents a curve to which continuous data events
will be fitted. You can adjust the location and shape
of the line by dragging its handles. The end-point
handles can be dragged both vertically and
horizontally to position the start and end point of
the curve. The middle handle sets the curvature.

5 Once you have adjusted the line as you wish,
click anywhere else on the screen or press the
Return key.

The line will disappear and events creating a curve
with the same shape as the line will appear.

Reshaping a Continuous Data Curve
To reshape a continuous data curve:

1 Select the curve you wish to reshape.

You can either double-click an event of that type to
select all or drag out a selection box over a portion
of the curve. If the curve intermingles with other 
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visible data types, use the Quick-Filter before
selecting to avoid inadvertently selecting events of
other types.

2 Click the Reshape button in the title bar of the
Graphic Editing window or choose Reshape from
the Graphic Editing window mini-menu.

In both cases, the mouse pointer will turn into a
cross hair.

3 Drag above or below the selected events to
change their values to the position of the mouse.

Each event will snap to the position of the mouse as
the mouse passes over it. The location of events will
not change. If you like, you can deselect the Quick-
Filter before dragging to view other data types
while dragging. If you wish to remain in Reshape
mode, press the shift key before you drag; the cross
hair will remain when you finish dragging,
indicating that you are still in Reshape mode.

OR

4 Option-drag along the selected region of the
curve.

A straight line will appear with handles on either
end and a handle at its midpoint. This line
represents a curve to which continuous data events
will be fitted. You can adjust the location and shape
of the line by dragging its handles. The end-point
handles can be dragged both vertically and
horizontally to position the start and end point of
the curve. The middle handle can be dragged to set
the curvature.

GRAPHIC EDITING

5 Once you have adjusted the line as you wish,
click anywhere else on the screen or press the
Return key.

The line will disappear and selected events above
or below the line will adjust their values to match
the shape of the line.
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Offsetting or Scaling a Continuous Data Curve
You can offset a continuous data curve by dragging
it in any direction. Offsetting modifies events in the
curve by a constant amount: dragging up or down
changes events’ values; dragging left or right
changes their location. For example, dragging a
curve up by a value of 30 will add that amount to all
events in the curve.

You can scale a continuous data curve by control­
dragging it in any direction. Scaling modifies
events in the curve proportionally: dragging up or
down scales values proportionally; dragging left or
right scales time. For example, when a bell-shaped
curve is scaled up, the start and end points of the
curve remain at zero, and the slopes become
steeper as the top of the curve rises. Scaling is a
useful way to exaggerate or diminish a curve’s
musical effect without changing its fundamental
nature. For example, you can scale an existing
crescendo so that it swells in the same manner but
ends at a softer volume.

To offset or scale a continuous data curve:

1 Select the curve you wish to modify.

You can either double-click an event of that type to
select all or drag a selection box over a portion of
the curve.
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2 Click (to offset) or control-click (to scale) a
selected event and drag in the direction you wish.

Press the shift key if you wish to constrain motion
horizontally or vertically. As usual, horizontal
position (location) is constrained by the current
edit resolution.

Cancelling Lengthy Editing Operations
A wristwatch icon may appear when Performer
executes a continuous data edit operation. To
cancel an operation in progress, press command­
period (command-.). The operation will abort.
Data modification that occurred before cancelling
will not be undone unless you choose Undo from
the Edit menu.

Summary of Continuous Data Editing Features
This section summarizes features available when
working with the Continuous Data Grid.

Selecting
Select a single event by clicking it.

Select several events by dragging a selection box
over them.

Select all events of a single data type by double­
clicking an event of that type.

Select all events of several types by shift-double­
clicking an event of each type.

Select all continuous data by choosing Select All
from the Edit menu or pressing command-A. All
other MIDI events in the track will become
selected as well, including notes and data in the
Median Strip.

Deselecting
Deselect a single event by shift-clicking it.

Deselect all events of a single data type by shift­
double-clicking a selected event.

Deselect all continuous data by clicking in an
empty area on the Continuous Data Grid.

Quick-Filtering
Quickly isolate a data type by clicking an event of
that type and then clicking the Quick-Filter check
box in the Information Bar. Isolate more than one
type by shift-clicking an event of each type before
clicking the Quick-Filter check box. To unfilter,
deselect the Quick-Filter check box.

Offsetting
Offset the location or value of selected events by
dragging horizontally or vertically.

Offset the location of a copy of all selected events by
pressing the option key and dragging horizontally.

Scaling
Scale the time or value of selected events by
pressing the control key and dragging horizontally
or vertically.

Constraining
Constrain the movement of the mouse vertically or
horizontally while scaling or offsetting by pressing
the shift key while dragging.

Inserting and Reshaping
Click the Insert and Reshape buttons (or choose
Insert or Reshape from the mini-menu) to change
the mouse cursor to a cross hair.

Insert events or Reshape existing selected events in
any shape you wish by dragging the cross hair.

Insert or Reshape events against an adjustable curve
outline by pressing the option key before dragging
the cross hair. A straight line with moveable
handles will appear to which events will be fitted
when you click elsewhere on the grid.

Remain in Insert or Reshape mode by pressing the
shift key before dragging the cross hair.
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The Continuous Data Icons Window
The Continuous Data Icons window serves as a
legend for the icons you see in the Continuous Data
Grid. In addition, it allows you to assign controller
data types to eight unique icons to help
differentiate between them on the grid.

To open the Continuous Data Icons window,
choose Cont. Data Icons from the Graphic Editing
window mini-menu. The window remains until
you click its close box and serves as a handy
reference when working with continuous data.

Assigning Icons to Controllers
The Continuous Data Icons window offers eight
different icons to represent controllers. Because
more than eight types of controllers exist, the most
commonly used controllers have been assigned to
icons by default. However, you can change which
controller an icon represents. For example, a
square can represent controller #7 or controller
#38. All controllers that have not been assigned to
one of the first seven icons are automatically
assigned to the last“u”-shaped icon. The icons for
pitch bend, velocity, and key pressure cannot be
changed and are displayed for reference.

To assign a controller to an icon:

1 Open the Continuous Data Icons window.

Select Cont. Data Icons from the Graphic Editing
window mini-menu.

2 Click in the box to the right of the icon of your
choice.

The box will highlight.

3 Type in the controller number that you wish to
assign to that icon.

The number you type must be between 0 and 63.
Controllers 64 through 127 are switch controllers
and will appear in the Median Strip.

4 Press the Return key or click anywhere to
confirm your choice.

The Continuous Data Grid will reflect any changes
you have made.

THE MEDIAN STRIP
The Median Strip separates the Note Grid from the
Continuous Data Grid. It contains only the
following discrete MIDI events: patch changes,
mode changes, switch controllers like #64 (sustain
pedal), tune requests, song changes, and system
exclusive events. Notes and continuous data do not
appear in the Median Strip.

Figure 12-21: The Median Strip shows MIDI data events that aren't
notes and are not continuous, such as patch change events and
switch controllers like Sustain Pedal (#64).

Moving the Median Strip
The Median Strip serves as the border between the
Note Grid and the Continuous Data Grid. It can be
dragged up and down by grabbing the handles at
either end. Moving the Median Strip resizes the
Note Grid and the Continuous Data Grid propor­
tionally. For example, if you drag the Median Strip
down as far as it will go, you will see only the Note
Grid. If you drag the Median Strip all the way up,
you will see only the Continuous Data Grid.

The Median Strip is a convenient way to quickly
adjust the size of one grid or the other to suit your
immediate needs.

Working with Discrete MIDI Events in The
Median Strip
Events in the Median Strip do not have durations.
Each event is therefore displayed as a single item
inside a small box. Patch changes, system exclusive
events, and controllers are displayed with their 
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event list icon; mode changes are displayed as text,
such as “Poly” or “Omni on”. An event may be pop-
edited in the Information bar in the same fashion
as in the event list window. Location is determined
by the Main Time Ruler. To indicate time location,
the vertical grid lines from the Main Ruler extend
through the Median Strip.

Inserting an Event in the Median Strip
Discrete MIDI events that are not continuous data,
such as patch changes, mode changes, switch
controllers like #64 (sustain pedal), and system
exclusive events, appear in the Median Strip. To
insert such an event;

1 Press the Insert button in the title bar of the
Graphic Editing window.

2 Choose the type of event you wish to insert from
the menu.

The mouse pointer will turn into a cross hair. For
system exclusive events, an additional box will
appear requesting further information.

3 Click once at the desired time location in the
Median Strip.

The event will appear where you clicked.

Editing an Event in the Median Strip
Events in the Median Strip can be pop-edited in the
Information bar. For example, to select such an
event, click it and the event will highlight. Click the
event in the Information bar and a pop-up box will
appear that you can type in. When system exclusive
events are pop-edited in this manner, a dialog box
will appear.

Dragging an event in the Median Strip left or right
will change its location.

If two or more events occur at the same time, they
will overlap in the Median Strip. Overlapping
events are displayed as shown in the example
below:

In this example, the Omni on message occurs near
two other events. The other events are indicated by
boxes preceding the Omni on box. To see the other
events, click their box. To select the second event
displayed in the example above, click the second
rectangle. The event will pop to the front and
become highlighted:

If two or more events occur at the exact same
location, a list icon appears. If you press on it and
drag downwards, a small pull-down menu shows
all events at that location. Events in the pull-down
menu can be selected and then edited. For
example, if you select the third item in the menu,
the list icon becomes highlighted. If you then drag
the list icon left or right, you will only drag the
third item that you had selected. To select more
than one item in the menu, shift click to select each
item.

GRAPHIC EDITING IN THE CONDUCTOR
TRACK
The Conductor Track Graphic Editing window is
similar to a regular track but has several
differences. It does not have a Note Grid because
the Conductor Track cannot contain notes. In
addition, the Median Strip is wider and fixed at the
top of the window just below the Time Ruler.

182 L
GRAPHIC EDITING



Finally, the Conductor Track has a Tempo Change
Grid similar to the Continuous Data Grid that
displays tempo changes only.

Meter changes, key changes, and markers are
displayed in the Median Strip.

The ConductorTrack Median Strip
The Median Strip in the Conductor Track
functions much like the Median Strip in a regular
track. Each meter change, key change, and marker
is displayed as a single item. The Conductor Track
Median Strip is wide enough to accommodate all
three kinds of events without overlapping them.

Editing in the Conductor Track Median Strip
works the same as editing MIDI data in a regular
track’s median strip: click an item to make it appear
in the Information bar and click in the Information
bar to pop-edit its value(s); drag the item left or
right to change its location.

Inserting a Meter/Key Change or Marker
To insert a meter change, key change, or marker:

1 Press the Insert button in the Conductor Track
title bar,

2 Choose the item you wish to enter.

The pointer will turn into a cross hair.

3 Click in the median strip at the location you
desire.

The event will appear at the location.

Editing the Location of a Meter Change, Key
Change, or Marker
To change the location of an item in the median
strip:

1 Click the item you wish to move and drag left to
advance it or drag right to delay it.

The event will move to the new location when you
release the mouse.

The Tempo Change Grid
Tempo changes are displayed and edited on the
Tempo Change grid in the same fashion as
continuous data. Each tempo change event is
displayed on the grid as a small icon. When the
tempo change event is selected, a line extends from
its icon to the origin at the bottom of the grid. A
tempo change ruler on the left measures events on
the grid. Tempo changes can be selected and edited
in the same way as an active continuous data type.
For more information, “Editing Continuous Data”
on page 175.

Zooming theTempo Ruler
The Tempo ruler in the Conductor track can be
zoomed in for more precise tempo editing.
Clicking the Tempo ruler toggles quickly between
your custom zoom scale and the normal scale.

To zoom the Tempo ruler, drag over the range of
values you wish to zoom. The Tempo ruler will
zoom in on the range that you select. Then click the
Tempo ruler to toggle between your custom zoom
scale and the normal scale.

Figure 12-22: You can zoom in the Tempo Ruler to get better resolu­
tion when editing tempos. Just drag over the range you want to zoom
in on, and then click the ruler to toggle between the zoomed in range
and the normal range.
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Changing tempo on-the-fly during playback
You can insert and edit tempos with these graphic
editing techniques without stopping playback.
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chapter 13 Notation Editing

Performer offers four windows in which to edit
data in a track: the Event List, Graphic Editing,
Notation Editing, and QuickScribe notation. To
open the Notation Editing window, hold down the
command and option keys and double-click the
track name. Or choose Notation Editing from the
Event List or Graphic Editing window mini­
menus. You can also option-click the Notation
button in the Control Panel.

The Notation Editing window provides a scrolling
window of a single track, very similar to the
Graphic Editing window. This chapter covers
features unique to the Notation Editing window. To
display several tracks, use QuickScribe notation as
described in chapter 14, “QuickScribe Notation”
(page 191).

QUICK REFERENCE
Display Resolution: Determines the shortest
duration that will be used to display note data on
the Grand Staff. Actual attack and release times are
not affected by Display Resolution.

Selected Note: Click once to select the note. While
the note is selected, its information will appear in
the Information Box above. Shift-click or drag a
selection box to select more than one. Drag the
note up or down to change pitch; drag left or right
to change time location.

Grand Staff: Displays notes on standard treble and
bass clef staves. By default, middle C between the
staves is C3. Click the Octave Up/Down buttons to
change middle C to a different octave to place notes
in higher or lower octaves on the staff.

Figure 13-1: The Notation Editing window.



Time Zoom Buttons: Contract or expand the Time
Ruler, Grand Staff, and Continuous Data Grid to
display more or less measures at a time. The left
button zooms out (more measures), and the right
button zooms in closer (less measures).

Octave Up/Down Buttons: Transpose the display of
notes on the Grand Staffby octaves. When
untransposed, middle C on the Grand Staff is C3.
For example, in a bass track, low notes are
displayed many ledger lines below the staff. To
distinguish the pitches, click the Octave Down
button; middle C will become C2 and the bass
notes will be displayed an octave higher on the
grand staff. The octave indicator in the Staff
Margin indicates the degree of transposition.

Octave Indicator: Indicates the octave being
displayed on the Grand Staff.

Staff Margin: A non-scrolling region of the Grand
Staff that displays clefs, key signature, and meter.

Continuous Data Grid: Displays continuous data in
the same manner as the Graphic Editing window.

Notation Editing Window Mini-menu
Goto Counter: Automatically scrolls the graphic
display to the time currently displayed in the
Counter. The counter location will appear at the
left-most position in the window.

Goto: Automatically scrolls the graphic display to a
time you specify, which will appear at the left-most
position in the window.

Reinsert: Inserts an event of the same type that you
last inserted. This is the same as the Insert
command but you are not prompted for the type of
event. This command can also be invoked by
option-clicking the Insert (I) button in the
Notation Editing window title bar.
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Reshape: Changes the mouse pointer to a cross
hair that reshapes selected continuous data curves
when you drag over them in the Continuous Data
Grid. This command can also be invoked by
clicking the Reshape button in the title bar.

Legend: Produces a window that shows the icon
representing each type of MIDI event.

Set Rulers: Allows you to configure the Time Ruler
in any combination of Performer’s three time
formats: measures|beats|ticks, SMPTE time, and
real time. The main ruler is displayed lowest and
determines the time format for editing.

Cont. Data Icons: Opens the Continuous Data
Icons window, which displays icons for each type of
continuous data. This window also allows you to
reassign controller icons.

Set Ptr. Coords...(Set Pointer Coordinates): Allows
you to choose what time and pitch formats will be
displayed in the Pointer Coordinates Box.

MIDI Edit: Allows data in the graphic editing
window to be edited from a MIDI controller.

Switches are Cont. Data: Causes all controllers,
including switch controllers #64 and above, to be
displayed and edited as continuous controllers.
This is useful for MIDI devices, such as MIDI-
controlled lighting consoles, that use all MIDI
controllers as continuous controllers.

Event List: Opens the track’s Event List window.

Graphic Editing: Opens the track’s Graphic Editing
window.

QuickScribe Notation: Opens the QuickScribe
Notation window.

Measures|Real time|Frames: These checkable
entries control which time formats are displayed in
the Information Bar and Event List.
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BASICS
The Notation Window is similar to the Graphic
Editing window. It has a Time Ruler, a Markers
Strip, a Median Strip, and a Continuous Data Grid,
features that are identical to those found in the
Graphic Editing window. Instead of a pitch ruler
and note grid, however, the Notation Editing
window displays notes on a grand staff in standard
music notation. Octave Up/Down buttons are
provided to center any octave on the grand staff,
and a non-scrolling staff margin on the left displays
clefs, key signature, and meter.

For further information about the Time Ruler,
Markers Strip, Median Strip, and Continuous Data
grid, refer to chapter 12, “Graphic Editing”
(page 153) in the Reference Manual.

Features that are unique to the Notation Editing
window are discussed below.

Display Resolution
Internally, Performer accurately records the attack
and release times of notes at a resolution of 480
ticks per quarter note. For example, a quarter note
that you attempted to play on beat two of measure
three, 3|21000, may have actually occurred a split
second after the beat at 3|2|073, which is 73 ticks
after the downbeat:

13I2I07S 4>G3 *64 t64 11000 3131075 I

Even though the note is a little late, it may sound
like it is right on the beat because of the sound
used, the nature of the music, etc.

If Performer tried to take into account the 73 ticks
when displaying the note in standard music
notation, the result would be many 64th and 128th
rests followed by lots of tied 64th and 128th notes-
-certainly not a recognizable quarter note!
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Instead, Performer internally sets up an evenly
spaced grid of note durations, finds the nearest
grid location, and displays the note as if it began at
the grid location. For example, at a quarter-note
grid resolution, the above note at 312|073 is
displayed on the nearest downbeat at 312|000 (as a
much more recognizable quarter note!)

Even though the note actually occurs after the
downbeat, it gets displayed on the downbeat,
which is the nearest grid location.

The Display Resolution box allows you to choose at
which grid resolution notes will be displayed. If the
note above is displayed with a sixteenth note
display resolution, which sets up a grid every 120
ticks, the note will be notated as a sixteenth rest
followed by a dotted eighth note because its attack
is closer to 3121120 than it is to 312|000:

As you can see, the Display Resolution box
determines the shortest duration that will be used
to display notes and rests in the track. In general, a
shorter duration produces a more accurate (but
maybe not as conventional) notational display of
the notes in the track.

Display Resolution does not affect the actual location
or playback of the notes. Don’t worry about
affecting the notes in the track when using the
Display Resolution: it only affects their display. If
you would like to make the note data more
rhythmically accurate, use the Quantize or Smart
Quantize commands.

Octave Up/Down Buttons
The Octave Up and Octave Down buttons change
the octave of middle C, the pitch directly between
the treble and bass staves. By default, middle C is
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MIDI note number 60, or C3. If the notes in the
track fall well below middle C, they will be
displayed on ledger lines below the grand staff. To
raise the display of the notes and make them more
legible, click the Octave Down button:

The result is that the entire Grand Staff display is
transposed, as indicated above the treble clef, and
the notes are displayed within the staff. Only the
display gets transposed; the actual notes maintain
their original pitches.

USING THE NOTATION WINDOW
The following sections describe basic procedures
in the Notation Editing window.

Inserting Notes
To insert a note on the grand staff:

1 Choose a Display Resolution.

To do so, click the Display Resolution note and
choose the desired duration. The Display
resolution affects the resolution at which you can
insert the note.

2 Click the Insert button in the title bar or choose
Insert from the mini-menu.

In both cases, the Insert menu will appear.

3 Choose Note from the menu.

The menu will disappear and the mouse pointer
will turn into a cross hair.

4 (Optional) Press the Shift key.

This is only necessary if you wish to insert more
than one note.

5 Click at the desired pitch and location on the
Grand Staff, drag to the right to draw the desired
duration, and release the mouse.

The note’s attack will begin at the nearest grid
location. The duration is shown as a grey bar
extending to the right. As you drag to the right, the
duration of the note increases in increments of the
display resolution. For example, to enter a half­
note with 16th note resolution, drag eight
increments to the right as shown below.
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To insert a note,drag to the right...

If you press the shift key to insert multiple notes,
simply click on the desired pitch to insert another
note of the same duration. To insert a note with a
different duration, click and drag a new duration.
You will remain in insert mode as long as you hold
down the Shift key.

Inserting a Chord Using a MIDI Controller
To insert a chord:

1 Choose “Note” from the Insert button pop-up
menu in the title bar.

The Cursor will turn into a cross-hair.

2 If you would like to insert more than one chord,
either hold down the shift key, or push down the
caps lock key.

This will keep Performer in insertion mode after
you insert the chord.

3 Play the chord you wish to insert on your MIDI
controller and, while holding the chord, click
where you want the chord to begin and drag from
left to right to the appropriate duration.

The vertical position of your click is not important;
the notes are determined by what you play on your
controller. Only the attack and release of the chord
is affect by the cross-hair.

As long as you remain in insertion mode, you can
enter chords in this fashion for as long as you like.
You can even alternate between entering notes with
the mouse only or the mouse with a MIDI
controller.

Selecting Notes for Editing
Selecting notes on the Grand Staff works the same
way as selecting notes in the Graphic Editing
window. To select a single note for editing, just
click the note. The notehead will invert to indicate
that the note is selected. To select several notes,
shift-click each one. Or, drag a selection box over
them. Shift-click to select non-contiguous notes.
To select all notes in the track, double-click any
note.

Dragging Notes
To change the location or the pitch of a note, simply
drag the note to the desired pitch or location. This
can also be done with more than one note selected.
As usual, option-dragging will produce a copy of
the originally selected notes, which can be used to
quickly generate repeated phrases or chords.

To copy notes,option-drag...

If a note is displayed as several tied notes, you must
click the first of the tied notes.

Editing Durations
To change the duration of a note:

1 Command-click the note.
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If the note consists of several tied notes, you must
click the first of the tied notes. A grey bar will
appear to indicate the current duration of the note
with respect to the Time Ruler.

2 Drag the handle of the grey bar to the left to
shorten the note or to the right to lengthen it.

The grey bar will show you the change in duration.

To change the duration of more than one note,
select them and command-drag any one of them.

When changing a duration in the Notation Editing
window, the new duration maintains any
differences between its actual length and its
displayed length. For example, if a quarter note
ends 17 ticks after beat 2, and you lengthen it by
one beat to beat 3, the release will still be 17 ticks
after beat 3.

Scrolling During Playback
The Auto-Scroll command in the Basics menu can
make the Notation Editing window scroll during
playback. In addition, the window will
automatically open to the current playback

location of the sequence. Please refer to the Auto­
Scrolling section in the Playback chapter for more
information.

When auto-scrolling is turned on, you can
temporarily override it simply by clicking
anywhere in the Notation Editing window or by
scrolling the window manually. The window will
stop for a moment before it resumes auto-scrolling.
This lets you view or edit things quickly without
having to stop playback.

Scrubbing with the playback wiper
You can “scrub” playback with the Notation Editing
playback wiper by dragging the wiper left and
right. For more information, see “Scrubbing” on
page 91.

Zooming Shortcuts

Do this To zootn as follows

Option-drag in the Time
Ruler

To fill the window with the
region you select

Option-click the zoom out
button

To zoom all the way out

Option-click the zoom in but­
ton

To zoom all the way in

Command-click the zoom
buttons

To toggle between the last two
zoom settings

Press command-left arrow or
command-right arrow

To zoom out and in, respec­
tively
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chapter 14 QuickScribe Notation

This chapter explains how to use Performer’s
QuickScribe™ notation window. The notation
window allows you to view and edit any number of
tracks as standard music notation.

Performer interprets unquantized MIDI data,
notating it in a readable fashion without
permanently quantizing the data, so your original
performance is always preserved. In fact, the
notation transcription engine used in Performer
has been recognized by industry experts as the best
available in any music software program. Music is
displayed and edited on a page on the screen
exactly as it will print on your
Macintosh-compatible printer.

Notes can be inserted with the mouse, Macintosh
keyboard, or via MIDI step entry. You can also
transpose and edit using all of Performer’s
powerful commands in the Edit and Region
menus.

The QuickScribe window provides intuitive text
entry for preparing title pages, headers, footers,
and page numbers. It lets you adjust system
margins, staff spacing, measure spacing, and other
formatting.

QUICKSCRIBE WINDOW BASICS
Performer provides one QuickScribe notation
window per sequence (and you can have an
unlimited number of sequences in a Performer
file). The QuickScribe window can display any
combination of tracks in the sequence, and you can
easily change what is displayed. Page formatting is
preserved, even if you decide to change what is
displayed in the window. The QuickScribe window
is ideal for quickly printing scores and parts.

Unlike the Notation Editing window, the
QuickScribe notation window uses engraver
spacing so that the notation looks more natural for
printing. The contents of the QuickScribe notation
window can be printed at any time. This chapter
explains all about preparing the appearance of the
score. For information about printing it, see
chapter 31, “Printing” (page 353).
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Notation window Quick Reference

Status strip: displays current cursor coordinates and information
about the currently selected note.

a
Notes being selected

Insertion cursor for
Macintosh
keyboard entry and
MIDI step record­
ing.

Tool palette: lets you insert notes, triplets, and

text.

Page number box:click in this box and type in a number to
go the desired page

Figure 14-1: The QuickScribe notation gives you a “what
you see is what you get" notation window in which you
can view, edit, and print your music.
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Choosing what tracks to display
The QuickScribe notation window can display any
combination of tracks. To choose what to display in
the QuickScribe notation window:

1 Select one or more tracks in the Tracks window.

2 Click the QuickScribe notation window button
in the Control Panel or choose QuickScribe from
the Windows menu.

Alternately, you can choose the QuickScribe
Notation mini-menu command from any edit
window.

<■1100:00=00:00 -i

JQukkScribe notation window button

Figure 14-2: To open QuickScribe, select the tracks you want to see
and then click the QuickScribe notation button, or choose Quick­
Scribe from the Windows menu.

3 The Notation window appears.

4 To make adjustments to the formatting, use the
Score Options, Tracks options, and other mini­
menu commands.

In particular, you may want to change the way the
music is spaced, which has a large impact on the
efficiency of editing, as well as how good the music
looks. For details, see “Measure spacing” on
page 197.

5 To add a title, use the Text tool in the palette.

For more information, see “Working with text” on
page 203.

Changing what is displayed
To change what tracks are displayed in the
QuickScribe notation window:

1 Switch to the Tracks window and select the
track(s) you want to see in the QuickScribe
window.

QUICKSCRIBE NOTATION

2 Click the QuickScribe notation window button
in the Control Panel or choose QuickScribe from
the Windows menu.

The View Filter
The View Filter in the Basics menu affects whether
notes are displayed in QuickScribe. For more
information about using the View Filter, see
“Setting the View Filter” on page 217.

You don't need to quantize tracks to get good­
looking notation
Performer does an admirable job of notating
music, even though the music may not be
quantized. Performer accurately records the attack
and release times of notes at a resolution of 480
ticks per quarter note. For example, a note that you
attempted to play on beat two of measure three,
312|000, may have actually occurred a split second
after the beat at 3121073, which is 73 ticks after the
downbeat:

3|2|073 JG3 164 164 11000 3131075

Even though the note is a little late, it may sound
like it is right on the beat because of the sound
used, the tempo, and so on.

If Performer tried to take into account the 73 ticks
when displaying the note in standard music
notation, the result would be many 64th and 128th
rests followed by lots of tied 64th and 128th notes-
-certainly not a recognizable quarter note!

Instead, Performer intelligently analyses the music
with a sophisticated notation transcription engine,
and then rounds the note to the nearest beat (or
subdivision of a beat) that makes the most sense
musically. For example, the above note at 3|21073 is
displayed on the nearest downbeat at 3|21000 (as a
much more recognizable quarter note!)
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Even though the note actually occurs slightly after
the downbeat in the track, it gets displayed on the
downbeat, which is the nearest grid location. As a
result, you get the best of both worlds: your original
performance of the music is preserved, and
Performer makes the notation display look
readable.

Even with music that is perfectly quantized,
Performer may choose a slightly different way of
transcribing it. One way of thinking about
Performer’s notation transcription algorithm is
this: it tries to write the music just like it sounds —
perhaps like you might write it down if you listened
to a tape of it and tried to transcribe it yourself by
ear. Transcription is not an exact science, and
QuickScribe does it’s best to take precisely
recorded MIDI data (which is often played much
differently than the way it is written), make
“human” judgements about how it might be
written, and then turn it into readable notation.

Floating split points and multiple voices
Performer’s QuickScribe notation transcription
engine is quite sophisticated. For example, it
employs floating split points when notating a track
on a grand staff, intelligently deciding whether
notes should be written on the treble or bass clef
staves. QuickScribe can also notate multiple voices
on a single staff — that is, notes that have different
rhythms happening at the same time in the same
bar. But you don’t really need to know any of this;
the result of it all is that you get some of the best
automated notation transcription available in
music software.

properly displayed, try quantizing the data with the
tuplet option in the Quantize command. Try
experimenting with Strength settings less that
10096, as the tuplet does not need to be fully
quantized for Performer to recognize it.

The scrolling playback wiper
With the Auto-Scroll command in the Basics
menu, you can display a scrolling playback “wiper”
in the QuickScribe window to indicate the current
playback location. This wiper can be dragged to
scrub MIDI and to change Performer’s current
playback location in the main counter. You can
drag it left or right; you can also drag it up and
down to jump from system to system.

When auto-scrolling is turned on, you can
temporarily override it simply by clicking
anywhere in the QuickScribe overview or by
scrolling the window manually. The window will
stop for a moment before it resumes auto-scrolling.
This lets you view or edit things quickly without
having to stop playback.

Double-clicking anywhere on a staff to make the
playback wiper jump immediately to that location.
To turn off the wiper, uncheck it in the Auto Scroll
command in the Basics menu.

Scrubbing with the playback wiper
You can “scrub” playback with the playback wiper
by dragging the wiper left and right. For more
information, see “Scrubbing” on page 91.

Displaying triplets and tuplets
In addition to being able to properly display
unquantized data, Performer automatically detects
triplets and tuplets and displays them with the
appropriate bracket and note spacing. In some
cases, the placement of the notes in the tuplet may
not be accurate enough for Performer to properly
detect the tuplet. If you’d like to see the tuplet
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Figure 14-3: The playback wiper shows the current playback location,
and you can grab it to "scrub" the music.

Getting around in the QuickScribe window
Use the commands in the QuickScribe notation
window mini-menu to scroll through each page
and go to the first or last page.

The mini-menu commands have the following
keyboard shortcuts:

Last page

Mini-menu command Keyboard shortcut

Next page n

Previous page p

First page f

You can also jump to a particular page by using the
page number box at the bottom of the window.

Figure 14-4: Pop-edit the page number display to go to any page.

To scroll up and down by one windowful (instead
of an entire page), use option-page up and option-
page down.

Setting the Score Options
Choose Score Options from the QuickScribe
window mini-menu to open the Score Options
dialog box:

Figure 14-5: The Score options command in the mini-menu gives you
many choices for laying out your score.

All print option settings are saved with the file, and
they can be included in your New file template.

Creating a title page
The “First page is title page” option allows the first
page of music to be formatted differently from the
rest of the body pages. Its system margins can be
adjusted separately from other pages to allow for a
title, subtitle, composer, and other text. Text can be
inserted on the title page without having it be
displayed on other pages.

Full part names/Abbreviated part names
Two options are provided for displaying staff
names, which appear between left margin and the
left edge of the staff. In both cases, the staff name is
derived from the track name. Check the first
option, called “Show Full Part Names before first
System”, to display the full track name to the left of
the first staff. Check the second option, called
“Show abbreviated part names before other 
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systems”, if you would like an abbreviated name to
appear next to each staff after the first one. The
abbreviation is the first four letters of the staff
name. If you don’t want staff names, uncheck both
options.

The Abbreviation maximum length option lets you
choose the maximum length of abbreviated staff
names.

To set the font, style, size, etc. of all staff names,
click any staff name and choose the desired text
settings from the Text menu. The settings you
choose will affect all staff names and abbreviations.

Making more space between staves and staff
systems
In addition to the space created above and below
individual staves by their ledger line settings, you
can make more space between staves and staff
systems globally with the “Extra spacing” options.
When you are printing a single track, use either
option to increase the amount of space between the
staves. If you are printing several tracks at the same
time, they are grouped together into a staff system.
Use the staff spacing option to increase space
within the system; use the system spacing option to
increase space between systems.

Markers
Markers can be displayed in the score at their
location in the sequence. The marker text can
appear above or below the staff, and you can
control the distance from the staff by typing in a
number of ledger lines in the box provided.

You can also choose to show the exact location of
markers along with their name in any combination
of Performer’s three time formats. Just check the
box next to the time format you wish.

To set the font, style, size, etc. of all markers, click
any marker name and choose the desired text
settings from the Text menu. The settings you
choose will affect all markers.

System Bracket/Grand Staff Brace options
These two options let you choose whether to show
a system bracket and grand staff braces.

Show rests in empty measures
You may choose whether or not to show a whole
rest in empty measures (measures with no note
data in them).

Show tempo marking above first measure
Performer takes the tempo for the metronome
marking from the tempo setting in the first
measure displayed in the score. The tempo number
is taken from the current settings in the
metronome panel. For example, if the tempo
control is set to the tempo slider, the current tempo
slider setting is used. If tempo control is set to the
Conductor track, the current tempo setting in the
Conductor track is used.

Straighten Swing
When you check the Straighten Swing option,
QuickScribe automatically writes swung eighth
notes as straight eighths, instead of writing them as
triplets with a triplet bracket. Only the display of
the notes is affected. The actual MIDI data remains
unmodified, so it will still play back with the 
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original feel. This option is a great way to instantly
clean up any score that was recorded with a swing
feel.

Ignore mistakes
These options let you decide how short and how
soft a note is before QuickScribe will hide it entirely
from the notation display. The result is a much
cleaner transcription. These options can be
especially helpful when viewing performances
with lots of grace notes or lead-ins.

Measure numbers
The Measure numbers mini-menu command,
shown below, sets the frequency and position of
measure numbers in the score.

Measure spacing
The measure spacing mini-menu command lets
you determine the number of measures per line or
the overall spacing of notes.

O Space measures [EM] per line

Sp&ct-m«aJur(-3 aulomjlfcallij
Uss dense <„. ... denser

I t I I I 11 I I I

Space measures___per line
This option lets you choose a certain number of
measures per line, such as 4 or 5. You can type in
the desired number. With this option, each bar is
the same size no matter what notes are in the
measures.

Performer can format pages much faster when
measure spacing is fixed. As a result, fixed measure
spacing is preferable over natural spacing if you
plan to do a lot of cutting and pasting in the
QuickScribe notation window because pages need
to be reformatted every time you cut or paste data.
On the other hand, if measures have lots of notes in
them, use automatic spacing for best results.

Space measures automatically
This option lets Performer decide how many
measures to put on each line, depending on how
many notes are in them. You can tighten or expand
the overall spacing of measures by adjusting the
slider. Its range depends on the music: don’t
hesitate to experiment with its full range.

In many cases (depending on the music itself),
automatic spacing produces the best-looking
results. It can, however, make cut and paste
operations slow because these operations require
page reformatting, and page reformatting takes
longer with automatic spacing. In addition, you’ll
often need to manually repaginate the score after
cutting and pasting to properly format the music. If
you plan to use the QuickScribe notation window
for cut and paste editing, you’ll find it to be much
faster to use fixed measure spacing (discussed in
the previous section).

The effect measure spacing has on scrolling
Another thing you may notice when using
automatic measure spacing is that a progress
window may appear when you are scrolling around
in the file. This happens when Performer has not
yet calculated the pagination for all of the pages.
Once the pagination has been calculated, scrolling
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from page to page is virtually instantaneous and
you will no longer see the “Preparing to display
page” progress window. If you make changes to
your music that change the pagination, Performer
will need to recalculate the page breaks again. If
you would like to avoid this process entirely, and
you would always like to be able to jump around
instantaneously, use fixed measure spacing.

Track options
When displaying a track in the QuickScribe
notation window, the Track options mini-menu
command lets you specify how you want it to be
displayed, such as whether to display the track on a
single staff or a grand staff.

Track: Default______________

Type of Staff:

O Single Staff
O Grand Staff
<f) Utt Single Staff unless it requires

more than | 4) ledgers
^Inter-Staff Spacing:

Ledgers between staves of Grand Staff: Q

o

\ n^ l SEED

i: leave space for
pledgers above
3] ledgers below

Track pop-up menu
Choose each track one at a time from this pop-up
menu and, below, give it the settings you want.
Each track can have its own settings, and the
settings are remembered. You can change them at
any time. The “Default” item in this pop-up menu
has its own settings, too; they are applied to any
track for which you have checked the Use Default
option (see below).

Use Default
This check box causes the track to use the default
settings. To change the default settings, choose
Default from the Track pop-up menu at the top of
the dialog box.

I_________________________

Type of staff
The Single staff option causes the track to be
displayed on its own staff, regardless of what notes
are in the track. When using a single staff,
Performer automatically chooses either a bass clef
or treble clef in an effort to place most of the notes
inside the staff and to avoid lots of ledger lines.

The grand staff option causes each track to be
displayed on a grand staff, regardless of the notes in
the track. Hand splitting is taken care of
dynamically by Performer’s transcription engine.

Use single staff unless it requires more than___
ledgers
This option causes Performer to use a grand staff
for the track if notes exist more than the specified
number of ledger lines above or below a single staff.
Use the ledger line option to control when a grand
staff will be used instead of a single staff. Raise the
number if you want to avoid using the grand staff
very often.

Inter-staff spacing
These options give you control over the amount of
space above and below the staff. This spacing is
specific to the one track you are making settings
for. To change the spacing of all staves, see “Making
more space between staves and staff systems” on
page 196.

Controlling page size
The size of the page in the QuickScribe notation
window is controlled by the Page Setup command
in the File menu. Custom page sizes are not
supported.

Adjusting system margins
System margins can be adjusted graphically by
choosing the Show System margins mini-menu
command in the QuickScribe notation window.
Doing so causes system margins to appear on each
page. The adjustments you make on any page will
automatically be reflected on all other pages,
except for the title page if there is one. If the “First 
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page is title page” option is checked under the
Score options mini-menu command, the title page
margins can be adjusted separately from the rest of
the pages to allow for title text. In this case, you can
adjust the system margins of the other pages by
scrolling to any page besides the title page.

Setting the cursor coordinates
The Set Pointer Coordinates mini-menu command
lets you set the display for the cursor coordinates
shown in the status bar at the top of the
QuickScribe notation window. Choose the desired
time formats and pitch representation.

Cursor coordinates----------cs» s4

1631

Repaginating
The Repaginate mini-menu command completely
reformats the music on each page to achieve the
most appropriate-looking layout of the measures.
If you have made any changes to the music that
require it to be re-spaced or reformatted in anyway
on the page, the reformatting takes place when you
choose this command (or close and then reopen
the window).

Repaginate is especially useful after you copy and
paste sections of music to restore appropriate
measure spacing. If you plan to do a lot of cutting
and pasting in the QuickScribe notation window,
you may want to try using the fixed measure
spacing option instead of natural spacing. Cutting
and pasting can be much faster with fixed spacing.
When you are done editing, you can return to
using natural spacing.

THE TOOL PALETTE
The QuickScribe window tool palette allows you to
insert notes, text, and tuplets. The Tools in this
palette are explained at length in the rest of this
chapter.

Arrow cursor

Page number tool

Note durations

Dot and double-dot tools

U

WORKING WITH NOTES
The QuickScribe notation window allows you to
do basic sequencing tasks, including inserting,
step-recording, transposing, and editing notes.
The following sections describe what you can do in
this window.

In the QuickScribe notation window, you can
insert notes with:

■ The mouse

■ The Macintosh keyboard

■ A MIDI keyboard

All three methods involve using the tool palette.

Rests are automatic
Rests are handled automatically by Performer’s
transcription algorithms. You do not need to enter
them.
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Inserting notes with the mouse
Insert notes and other symbols with the mouse as
follows:

To insert this Do this

A note Click the desired note duration in the
tool palette. Press anywhere in the
measure where you want to insert the
note. With the mouse still held down,
drag to the desired pitch and loca­
tion. Watch the cursor coordinates to
help determine the beat location.

A note with an acci­
dental

Same as above.

A dotted note Click both the desired note duration
and the dot in the palette. Then insert
the same as above.

A chord Insert the first note as described
above. Click directly above or below
the first note to add more notes to the
chord.

A triplet Click a note duration in the tool pal­
ette and click the triplet tool. Both are
now selected. Insert each note in the
triplet as described above.

To add a dot to a
note

Click the dot tool and then click on
the notehead you want to add it to.

To change the dura­
tion of a note

Click the desired duration in the pal­
ette and click the note.

To change several
notes to the same
duration

Select the notes with the arrow cur­
sor. Command-click the desired
duration or dot in the tool palette.
Note: to scale durations (to double or
halve them, for example) use the
Scale Time command in the Region
menu.

To change the loca­
tion or pitch of one
or more existing
notes

Click the arrow cursor and then drag
the note as desired. To drag multiple
notes, select them before dragging.

Inserting notes with the Macintosh keyboard
To insert notes and other symbols with the
Macintosh keyboard:

1 Click the arrow cursor tool in the palette.

2 Click on the staff at the desired pitch and
location for the symbol.

A blinking insertion cursor appears on the staff.

3 Once you have a blinking insertion cursor on
the staff, refer to the following table:

To do this Do this

To move the cursor Use the arrow keys.

To determine the exact
beat location and pitch
of the insertion cursor

Use the cursor coordinates dis­
play in the status bar at the top of
the window.

To select a duration Use the open bracket ([) and
closed bracket (]) keys to choose
the next highest and lowest dura­
tion. Or use the extended keypad
(see “Selecting durations witn the
extended keypad” on page 200).
Or click the desired duration in
the palette.

To insert a note Press return.

To insert a note with an
accidental

Press the + or - key on the
extended keypad.

To insert the first note of
a chord

Press the enter key. (Enter inserts
the note without advancing the
insertion cursor.)

To insert the second,
third, fourth, etc. note in
a chord

Press the enter key.

To insert a tuplet Press the t key to turn on the
tuplet tool, and use the bracket
keys as described above to select
any note duration. Press t again
to toggle off the tuplet tool.

To delete a note or
chord

Position the insertion cursor to
the right of the note and press the
delete (backspace) key.

Selecting durations with the extended keypad
The following keys can be used on the Macintosh
extended keypad to select durations in the
QuickScribe tool palette. These are the same
duration keys used for the Step Record command
in the Basics menu. Note that they require the caps
lock key to be depressed. Without the caps lock
key, they keypad will provide the usual transport
functions.
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If you are inserting notes from the Macintosh
keyboard, as well as choosing durations from the
keypad, you’ll notice that you have to press the caps
lock key to choose durations from the keypad, but
then release the caps lock key to use the arrow keys
to position the insertion cursor. You may find it
more convenient to leave the caps lock key released
and use the left and right bracket keys to choose
durations. When inserting notes with the mouse,
however, the keypad is convenient because you can
leave the caps lock key depressed.

Using the keyboard when the QuickScribe
window is active
When the QuickScribe window is active (the front-
most window), several keys on the Macintosh
keyboard change their function to features that are
specific to the QuickScribe window.

For example, the up and down arrow keys, which
normally change the currently record-enabled
track in the Tracks window (unless you
programmed them for something else in the
Remote Controls window), move the note
insertion cursor up and down instead (if the cursor
is active).

To temporarily suspend the QuickScribe key
bindings and return to the normal bindings (in the
Remote Controls window), hold down the shift
key, or press caps lock. If you use caps lock, the
shift key temporarily switches back to the
QuickScribe key bindings.

Hearing notes while inserting them with the
mouse
To hear notes played back on a MIDI device as you
insert them, click the Audible mode button in the
title bar of the QuickScribe notation window.
Notes are played on the instrument that the staff
(track) is currently assigned to in the Tracks
window.

Step Recording notes with a MIDI controller
To insert notes with a MIDI controller:

1 Click the arrow cursor tool in the palette.

2 Click on the staff at the location where you
would like to begin entering notes.

A blinking insertion cursor appears on the staff.
Use the cursor coordinates to determine the exact
location in the measure. If necessary, use the left
and right arrow keys to move the cursor.

QUICKSCRIBE NOTATION
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3 Select a note duration.

There are several ways to select a duration: 1) click
the desired note duration in the tool palette, 2)
press the open bracket ([) and closed bracket (])
keys on the Macintosh keyboard repeatedly, or 3)
use the extended keypad as described in “Selecting
durations with the extended keypad” on page 200.
The currently selected duration is displayed in the
tool palette.

4 Play the desired note or chord on your MIDI
controller.

Notes appear when you release the keys, so be
careful not to slur notes together. It’s best to play in
a staccato fashion to avoid accidentally inserting
two notes when you only want to enter one. If you
would like to hold one note while inserting others,
just keep holding it down while inserting the other
notes.

5 Play in as many notes and chords as you’d like.

Change durations as needed. Step Recording uses
many of the same keyboard actions as Macintosh
keyboard entry, so you may want to review the
section “Inserting notes with the Macintosh
keyboard” on page 200.

Getting the arrow cursor temporarily
While working with the tools in the palette, you
may want to temporarily restore the arrow cursor
for selecting or some other purpose. To do so, press
the option key. While you hold it down, the cursor
turns into an arrow. When you release the option
key, the cursor switches back to whatever it was.

Selecting notes for editing
Below is a summary of how to select notes for
editing in the QuickScribe notation window. Notes
are selected with the arrow cursor.

To select this Do this

A single note Click the item once.

Several notes that are not next
to one another

Shift-click each item.

The notes in several measures Drag a selection box over the
measures.

A region of notes Drag a selection box over them.

if a note is displayed as several tied notes, you
can click any notehead to select the entire note.

Selected notes

When a single note is selected, its information
appears in the info bar. This information can be
edited as usual.

I 91121240 F4 • 77l 91I2I2S0 404 J95 t64 01101

Cutting, copying & pasting notes
Once notes are selected as described in the
previous section, they can be cut, copied, and
pasted using the commands in the Edit menu. To
paste notes you have either cut or copied, click the
staff with the arrow cursor on the location at which
you would like to paste the material. Watch the
cursor coordinates box (see “Notation window
Quick Reference” on page 192) to specify the exact
beat location at which you will paste. You can copy
and paste between other editing windows as well.
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!*~ Cutting and pasting can be slow if you are
using natural measure spacing. You can used fixed
measure spacing to speed things up. See “Measure
spacing” on page 197 for more information.

After cutting and pasting, you can reformat the
pages using the Repaginate mini-menu command
to clean up the display.

Using Region menu commands
Similar to the Edit menu commands mentioned
above, Any Region menu command can be applied
to notes you have selected. This includes
quantizing, transposing, and any other command
from the Region menu.

Changing note durations
To change a note duration, click the desired
duration from the tool palette and click on the note
you wish to change. To change several notes at
once, select them and then command-click the
desired duration in the tool palette.

WORKING WITH TEXT
The QuickScribe window Tool palette has several
text items that let you enter titles and other text on
the page, including page numbers and metronome
markings.

Text is handled in a similar fashion to standard
Macintosh graphics programs. Text is placed on
the page inside text boxes, which can be cut,
copied, pasted, and otherwise edited. A text box is
a resizable, transparent box in which you can type
and edit text. If you have worked with MacDraw,
SuperPaint, or similar graphics software, you are
already familiar with how to use text boxes in
Performer.

Inserting text
To insert text:

1 Scroll to the page on which you’d like to insert
the text.

If you are inserting title page text, scroll to the title
page. If you’d like the text to appear on body pages,
scroll to any body page.

2 Click the Text tool in the Tool palette.

-Text Tool

3 Drag out a text box on the page.

Choose the desired font, point size, stylejustifica­
tion, and display properties from the Text menu.
For details about the Display text attribute, see
“Making titles, headers, and footers” on page 203.

1 Choose the desired text attributes from the Text
menu.

2 Type the desired text.

3 Click anywhere outside the text box to complete
the text entry.

Making titles, headers, and footers
Titles, headers, and footers are inserted in the
manner described in the previous section. Just
choose the appropriate Display attribute in the Text
menu as shown below.
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Size P
Style ►
Justify ►

| Display >| This page only 1

fluant Garde
0 fluant Garde Demi
B Clearface Bold
B Futura Bold
B Goramond Bold

y'Title page only .
Body pages only * 1
Both title O' body pages

If the Title page only and Body pages only menu
items are grayed out, check the First page is title
page option in the Score options command located
in the notation view mini-menu. For more
information about this option, see “Creating a title
page” on page 195.

Making page numbers
Page numbers are inserted using the page number
tool in the tool palette.

 Page number toolI
E
E

Using this tool, insert them in the same manner as
described in “Inserting text” on page 203. The page
number automatically appears in the text box. Be
sure to choose the appropriate Display attribute
(Body pages only or Both title & body pages'). See
“Making titles, headers, and footers” on page 203
for more information.

Displaying the current date
The current date can be inserted using the Date
Tool in the Tool palette.

Current date tool

A
£1
£
a

_____________

204 L

Using this tool, insert the date in the same manner
as described in “Inserting text” on page 203. The
current date (as specified by your Macintosh)
automatically appears in the text box. Be sure to
choose the appropriate Display attribute (Body
pages only or Both title & body pages).

Selecting text
To select an entire block of text, click it once.
Handles appear to indicate that it is selected.

 

Title
 

To select individual words within a text box:

1 Double-click the text box to edit it.

2 Select the desired text by dragging over it.

Play very fast

Once text is selected, it can be cut, copied, or
deleted. You can also change the font, style, and
other attributes of the text.

Typing and editing text inside a text box
To edit text, double-click it to get an insertion
cursor inside the text box. Once you have an
insertion cursor inside the text box, use the
following actions to edit the text:

Select several words or sen- Drag over them inside the text
tences box

To do this Do this

Move the text cursor within
the text box

Press the arrow keys

Delete a character Position the cursor to the right
of it and press the delete key

Select a word Double-click the word

QUICKSCRIBE NOTATION



3 Choose the desired text attribute from the Text 

Cut, copy, and paste text Select the text and choose the
within the text box desired command from the Edit

menu.

Change the font, point size or Select the text and choose the
style of some text in the text desired font, size, and style in
box the Text menu

Justify the text to the left mar­
gin, to the right margin or to
the center

Choose Justify from the Text
menu and select the desired jus­
tification

Finish inserting or editing the
text

Click anywhere outside the text
box

Cancel text editing Type command-period

Pasting text into Performer from other
programs
You can copy text from a text editing program such
as Microsoft Word and then paste it into a text box
in the QuickScribe notation window. Just copy the
text from the other program, switch into
Performer, double-click or insert a text box, and
then paste.

Changing text attributes
Text attributes like point size, style (bold, italic,
etc.), justification (left, center, or right), and
display properties (title page only, etc.) can be
changed after text has been entered.

To change the attributes of an entire text box, click
the text once to select all of the text in the box. Then
choose the desired attributes in the Text menu.
This works for staff names, staff abbreviations, and
marker text as well.

To change the attributes of individual words within
a text box:

1 Double-click the text box to edit it.

2 Select the desired text by dragging over it

Phy very fast

menu.

4 Click anywhere outside the text box to complete
the text entry.

Play very fast

Installing fonts in the Text menu
The fonts that you see in the Text menu are the
fonts that you have installed in your Macintosh
system. If you are not familiar with how to install
text fonts in your Macintosh system, refer to your
Macintosh documentation.

When troubleshooting font problems in
Performer, determine if the problem occurs in your
word-processing software, or other programs that
deal with text. For example, if you can’t find a font
that should be in the list, check the font list in your
word processor. Most likely, it will be missing
there, too, and you then know that the problem lies
somewhere in the Macintosh system.

Printing a track as a single instrument part
To print a track as a single instrument part:

1 Select the track in the Tracks window.

If you need help with this, see “Choosing what
tracks to display” on page 193.

2 Click the QuickScribe notation button to open
the notation window.

3 As described in this chapter, add text to the title
page and set the Score Options in the mini-menu
as desired.

4 To display the track name in front of the staff as
the instrument name, use the Part Names option in
the Score Options mini-menu command.

5 If you are printing several instrument parts,
repeat this procedure for each track.
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You won’t need to change the Score options
because the formatting is remembered when you
change tracks. Just close the current part, select the
next track and click the QuickScribe notation
window button to view and print the next part.

If you want to preserve the notation window
separately for each track, you can do so by copying
each track into its own separate sequence. Since
each sequence has its own separate QuickScribe
notation window, each part will be preserved.

Printing a keyboard part on a piano staff
Use the procedure in the previous section to print a
keyboard part (which is in a single track). To
display the track on a grand staff:

1 Choose Track Options in the QuickScribe
notation window mini-menu).

2 Choose the track that contains the keyboard
part from the pop-up list.

3 Uncheck the Use Default check box, if
necessary.

4 Choose the Grand Staff option.

5 Set the spacing options as desired and click OK.

Printing a score
When you select multiple tracks, Performer places
them together in the same staff system. So, to print
a score, select all the tracks you want to include in
the staff system for the score, and then open the
QuickScribe notation window. To adjust the
spacing between the staves in the system, as well as
the spacing between systems, choose Score
Options (score window mini-menu).

Creating blank staff paper
To create blank staff paper:

Select as many empty tracks as you’d like staves in
the systems on the page.

2 Open QuickScribe notation window.

Controlling note spellings
Accidentals in the QuickScribe window are
governed by the current key signature in the
Conductor track. To change the way notes are
spelled, use the Change Key command in the
Change menu. For more information, see
chapter 27,“Change Key” (page 327).

1 Select empty tracks.
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chapter 15 Selecting

To edit MIDI data and conductor track data, you
must first select it. Performer provides many useful
and powerful ways to make selections. Once you’ve
made a selection, you can apply Performer’s many
powerful Edit menu and Region menu commands
to whatever is selected.

This chapter shows you the many powerful ways to
select data in Performer.

SELECTION BASICS
There are three ways to make selections in
Performer:

■ Data selection — Selects specific MIDI data
events or conductor track events

■ Time range selection — Selects a region of time,
regardless of what is in the region

■ Use the Search command to make selections
based on time- and data-based search criteria

Selecting Data Events
Data selection involves clicking (or dragging over)
actual data events themselves in one Performer’s
track edit windows. The events become
highlighted to indicate they are selected, and they
can then be edited by any Edit or Region menu
command.

Selecting a Time Range
A time range selection spans a certain period of
time in one or more tracks, regardless of what data
is in the region. In fact, time range selections can
even be empty. For example, you could select four
empty measures and actually copy them into the

Clipboard — perhaps to splice the empty space
somewhere in a track. Or, you could select two
empty measures at the beginning of a track and
then use the Snip command to remove them and
move up everything else in the track to replace
them.

Time range selections are always affected by
Performer’s Smart Selections feature, which has an
important impact on what happens when you
make selections. So be sure to read “‘Smart’
Boundaries on Time Range Selections” on
page 213.

Using the Search Command
For information about using the Search command,
see chapter 32,“Searching” (page 357).

Edit Commands That Require Time Range
Selection
There are a few commands in the Edit menu and
Region menu that require time range selection:
Snip, Repeat, and Retrograde. These commands
wouldn’t be able to do anything useful without a
clearly defined end time for the selection, which
data event selections don’t provide. Therefore, the
Snip, Repeat, and Retrograde commands do
nothing if the current selection is a data selection.
To use them, make a time range selection as shown
later on in “Selecting a Time Range” on page 210.

The 'Smart Selections' Command Affects Time
Range Selections
Performer’s Smart Selections command in the Edit
menu has a important impact on edits that you
apply to Time Range Selections. The effects are 
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automatic, but you should definitely know about
them so that you can use them to your benefit. For
a summary, see “Smart Selections” on page 212.

Selections Are Global
Once you have made any type of selection, the
selection remains in effect until you either deselect
or make another selection. The current selection
appears in all four edit windows for the track, as
well as the Tracks window. For example, if you
highlight a few notes in a track’s event list window,
and then open the Graphic Editing window for the
same track, the notes will be highlighted in the
Graphic Editing window, too.

The current selection remains in effect even if
you close all edit windows and the Tracks window.
So be careful not to inadvertently edit a hidden
data selection. Always be certain about what the
current selection is before using Edit and Region
menu operations.

Data remains selected even after you apply an edit
operation to it. This lets you easily apply successive
edits to the same data.

Playing the Current Selection
To play back the current selection, choose Play
Selection from the Basics menu.

SELECTING DATA EVENTS
The following topics show you how to select
specific MIDI data events and Conductor track
data events. For time range selection techniques,
see “Selecting a Time Range” on page 210. Also see
“Edit Commands That Require Time Range
Selection” on page 207 to learn about a few
commands in Performer that can’t be applied to
data selections.

Data selections are not affected by the Smart
Selections feature in the Edit menu, even when it is
turned on. For more information, see “Smart
Selections” on page 212.

Making a Data Selection in the Event List
Window
To make a data event selection in the Even List
window:

1 Click on the track name containing the region to
highlight it.

This selects the track.

2 Open the event list for the track.

3 Select the events you wish to change.

Below is a summary of how to select events in the
Event List.

To select this Do this

A single event Click on it.

Several adjacent events Drag over the desired events. All
events dragged over will high-
light.

Several non-adjacent events Hold down the Shift key and
click on the events you wish to
select. They will highlight.

Deselect events Hold down the Shift key and
click on the event(s) you wish to
deselect. They will unhighlight.

Extend the currently selected
region

Command-click or Command­
drag at the desired end location.

The specific data events you select with the above
techniques will become highlighted to show that
they are selected. You can then apply any command
on the Edit or Region menus (except for Snip,
Repeat, and Retrograde. For details about these
commands, see “Edit Commands That Require
Time Range Selection”on page 207).

SELECTING



Figure 15- 1:An example of a data event selection, shown here in the
Event List window.

Making a Data Selection in Graphic Editing
There are a number of techniques for selecting
individual data events in the Graphic Editing
window. For complete information, see “Selecting
Notes” on page 171 in the Graphic Editing chapter.

Figure 15-2:Making a data selection (notes, in this case) in the
Graphic Editing window.

Making a Data Selection in QuickScribe
Notation
For information about selecting notes in the
QuickScribe notation window, see “Selecting notes
for editing” on page 202.

Making a Data Selection in theTracks Overview
This section explains how to make data event
selections using the Tracks Overview. However, the
Tracks Over is also a great way to make time range
selections. For details, see “Selecting a Time Range
in the Tracks Overview” on page 210.

To make a data selection in the Tracks Overview: 

1 Place the cursor in the middle of a data phrase
“block” so that the cursor turns into an arrow
(instead of a cross-hair).

Be sure you use the arrow cursor. The cross-hair
cursor is for selecting a time range (see the next
section).

Figure 15-3: Put the cursor over the very center of a data block to
produce the arrow cursor shown here.

2 Click the phrase with the arrow cursor to select
it.

The data events displayed inside the phrase
becomes selected, showing a gold highlight and
outline. This is similar to selecting the data events
in the event list. In fact, if you open the track’s Event
List, you’ll see the events highlighted in the list.

selected by
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Figure 15-4: Clicking a block in the Tracks Overview with the arrow
cursor as shown here produces an event selection, if you look in the
track's event list,you'll see the selected events, also shown.
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SELECTING A TIME RANGE
The following topics show you the many ways to
select a time range. For data event selection
techniques, see “Selecting Data Events” on
page 208.

Time range selections are affected by Performer’s
Smart Selections feature, which has an important
impact on what happens when you make
selections. See “Smart Selections” on page 212 for
more information.

Selecting a Time Range Using theTracks List
This method of time range selection allows you to
make a selection containing any combination of
tracks. It lets you specify the region numerically,
which gives you a high degree of precision. It works
with all Edit menu and Region menu commands.

1 Activate the Tracks window for the sequence
you wish to modify by clicking on it.

The title bar of the window will activate.

2 Enter the desired start and end times in the
selection bar.

To learn some great shortcuts for entering start and
end times, see “Using the Selection Bar” on
page 74.

Selection bar-

_______ ________________________,

Seq-1____________ Verse 1___________ ^-|
Selection: End]ITfeffldOO~~ Z1

WEILfiOFIFECI LEV |"lPLftVl CUTPU7_______ |TRIT|TP.WIHftHE |
r-| >.bl'l____ I____I_____________ 11 | Conductor

~ I|l—| >p{5t>R-1 |1 | Hammond

3 Select the track or tracks that contain the region.

To learn track selection techniques, see “Selecting
Tracks” on page 73.

You now have a time range selection that includes
all of the tracks you highlighted. Notice that the
Tracks Overview reflects the selection as well, as do
the event edit windows of the selected tracks.

The current selection always
appears in theTracks Overview.

Highlighted
tracks

Selection bar Start time
and end time

Figure 15-5: When you make a time range selection using the Tracks
list (by selecting tracks and setting the selection start and end times),
the selection appears as a highlighted region in the Tracks Overview.

Selecting a Time Range in the Tracks Overview
The Tracks Overview is a graphical and intuitive
way to select time ranges. Time range selections are
made by clicking or dragging the cross-hair cursor
in the Tracks overview. When you place the cursor
over an empty portion of the overview, it always
turns into a cross-hair.

When you place the cursor over a block of data,
you can get the cross-hair cursor (instead of an
arrow cursor) by moving it to the top or bottom
edge of the phrase block. This lets you make time­
range selections independently of phrase blocks.
For example, this is how you would select only a
portion of a data block in the Tracks overview.
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Placing the cursor over an empty portion of the
grid always produces a cross-hair, which makes a
time range selection when you drag.

** Placing the cursor over the center of a block
> produces an arrow cursor, which creates a data
 selection when you click.

You can get the cross hair cursor (for a time
range selection) over data blocks by moving
the cursor near the edge of the block

Figure 15-6: Selection cursors in the Tracks Overview.

Below is a summary of time range selection
techniques in the Tracks Overview:

To accomplish this

To get a cross-hair cursor
over a block of data

Do this

Move the cursor to the top or
bottom edge of the block.

To select a single measure
(or a single column segment
at any other zoom level)

Click it with the cross-hair.

2
1

3
1

4
1

To select several adjacent
measures
(or column segments at any
other zoom level)

Drag over them with the cross­
hair cursor — diagonally if the
segments are in several adjacent
tracks.

To select non-adjacent mea­
sures (or column segments at
any other zoom level)

Shift-click and/or shift-drag
over them with the cross-hair
cursor.

To add or remove measures
from the current selection
(or column segments at any
other zoom level)

Shift-dick and/or shift-drag
over them with the cross-hair
cursor.

To quickly select a single mea­
sure in all tracks (or a single
column at any other zoom
level)

Click in the Time Ruler above
the column.

To select any time range in all
tracks

Drag in the Time Ruler.

To select any time range with­
out “snapping" to columns

Use the command key along
with any of the techniques men­
tioned above.

To select everything between
two markers

Click the first marker in the time
ruler.

To select everything between
the auto-record punch in/out
points

Click either the punch-in or
punch-out arrow marker in the
time ruler.

To deselect all current selec­
tions

Click in the area below the over­
view.
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Time Ruler Selection Techniques
There are several time-saving techniques for
selecting data in the Graphic Editing window Time
Ruler and the Tracks Overview Time Ruler:

■ Drag horizontally in the Time ruler at the top of
the window. (If Edit Resolution is turned on,
dragging will “snap” to the Edit Resolution grid.)

The'RememberTimes' Remote
The Remember Times remote control (control-R),
allows you to save a time range selection, so that
you can load it into the Selection bar later on. You
can also load remembered times into the Memory
Bar and the Auto-Record Bar.

To use Remember Times:

-Edit
Resolution

*», Clarinet \
• 60|{j Start:2|11000 End: 4111000 | |j UqH » J 11

^Marker-1 ____________...— ••••-■■■I

■ Click one of the Memory-cycle markers (to
select the region between them).

■ Click the Auto-Record punch-in or punch-out
marker (to select the region between them).

■ Click any marker in the Tracks overview (to
select the region between it and the next marker).

1 Make any selection.

2 Press Control-R.

The start and end time of the current selection is
stored by Remember Times.

To load the Remember Times into the Selection
Bar, Memory Bar, or Auto-Record Bar, click the
word Selection, Memory, or Auto-Record.
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Figure 15-7:Loading Remembered Times into the Selection Bar,
Memory Bar, or Auto-Record Bar.

Selecting Chunks in the Song Window
A Chunk in a song window can be selected by
clicking it once. To select several adjacent Chunks,
either drag over them or shift-click each one. To
select non-adjacent Chunks, shift-click each one.

SMART SELECTIONS
The Smart Selections command in the Edit menu is
a checkable menu item that can be either turned on
(checked) or off (unchecked). When it is turned
off, it has no effect on selections. When it is turned
on, it affects Time Range Selections. (For an
explanation of what a Time Range selection is, see
“Selection Basics” on page 207.)

What does the Smart Selections command do
when it is turned on? Generally speaking, it makes
Time Range selecting and editing operations give 
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you results that are more musical and intuitive. In a
way, turning on Smart Selections is like telling
Performer,“Do what I mean, not what I say'.'

Performer accomplishes this “musical intelligence”
in a combination of separate, but related, ways.
Below is a summary of Smart Selection features,
followed by several sections explaining each feature
in further detail.

■ “Smart boundaries” on time range selections —
this means that events that are a few ticks before or
after the selection boundaries are either included
or excluded, depending on what makes sense
musically.

■ Measure-relative pasting — allows you to place
the playback wiper (or main counter) anywhere in
the measure you want to paste into and data will be
pasted at its original location within the bar. With
Smart Selection turned off, data would be pasted at
the exact tick location displayed in Performer’s
main counter.

■ Controller and pitch bend effects are maintained
when cutting and pasting — this means that when
controller and pitch bend data is added to or
removed from a track via time range selection
copying and pasting, Performer maintains the
effect of the controllers before and after the selected
region by automatically generating and inserting
new controller events into the track as needed.

■ Barline placement is preserved when cutting and
pasting in the Conductor track — allows you to
freely cut, copy, and paste time range selections in
the conductor track, even when it has lots of meter
changes in it, without barlines getting out of
alignment with existing music in the tracks.

'Smart' Boundaries on Time Range Selections
If the Smart Selections command in the Edit menu
is checked, Performer automatically allows for a bit
of musically determined “slop” before and after the
boundaries of a time range selection to account for 

notes and other events that occur a few ticks on
either side of the selected region’s boundaries (as
shown in on page 214). If Smart Selections is
turned off, the selection bar start and end times are
hard and fast — an event that is even 1 tick outside
the region is not included.

If you want precision, turn Smart Selections off. If
you want musical results without fussing with
details, turn Smart Selections on.

Smart Selection must be turned on or off as desired
before you make a selection. Turning it on or off
does not affect current selections.

The Smart Selections feature affects all of the Time
Range selection methods discussed in this chapter;
it has no effect on data selections.

Measure relative pasting
In general, when you paste, Performer pastes at the
location currently displayed in the main counter
(and also indicated by the playback wiper in
windows that have it) — along with one additional
condition: if Performer’s Smart Selections feature is
turned off, material is pasted at the exact tick
location shown in the counter. If Smart Selections
is turned on, material is pasted measure relative,
which means that it is placed in the measure at its
original location within the bar so that you don’t
have to worry about exact placement of the
counter, as shown below. Just get the counter
anywhere into the measure you want and paste.
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Smart Selections turned on

This is a two-bar selection made
with grid snapping turned on from
measure 4 to measure 6.

These notes actually occur at 314 478—just before
measure 4. But Smart Selections correctly includes them.

These notes actually occur at 514|460—just before
measure 6. But Smart Selections correctly omits them.

Smart Selections turned off

Notice that when Smart Selections
is turned off,notes at the beginning
are incorrectly omitted,and notes
at the end are incorrectly included.

Figure 15-8: An example of how the Smart Selections feature affects time range selections.
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In this example,the
data In the Clipboard
originated on beat 4.

With Smart Selections
turned on,the note is
pasted at beat 4 of the
measure, regardless of
where the playback wiper
(and main counter) is in the

measure.
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, ' 1. Echo Drops (Seq-1)
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With Smart Selections
turned off,the note is
pasted at the wiper (and
main counter) location,
which, in this example, is
4|2|157.

Figure 15-9: Measure relative pasting is a great convenience when
you are working fast.

Pitch Bend and Controller Effects Are
Preserved
Whenever you insert a controller or pitch bend
event into a track, it affects all notes after it for the
rest of the track — or until the next controller in
the track. Similarly, when you cut and paste pitch
bend or controllers, you are removing from or
adding them to the track, which will have an
impact on all notes after the cut or paste area.

When Smart Selections is turned on, however,
Performer preserves all pitch bend and controller
values after the cut or paste region, automatically

adding pitch bend or controller events after the edit
region as necessary to do so, as shown in
Figure 15-10.

The end result is that you will never be surprised:
the portion of the track after your edits will always
sound the same as it did before your edits.

Barlines Are Preserved in the ConductorTrack
If Smart Selections is turned off, cutting and
pasting time regions in the Conductor Track can
get tricky — especially if you have meter changes in
the area you are editing. For example, if you cut a
meter change, you may find that barlines after the
removed meter change are no longer correctly
aligned with the notes they are supposed to be
aligned with.

Smart Selections takes care of problems like these
by making sure that meter changes you introduce
by cutting or pasting will preserve subsequent
measures and meter changes in the Conductor
Track to ensure that nothing gets out of alignment
by mistake. If you are cutting and pasting the
Conductor Track, be sure to turn on Smart
Selections.

I SELECTING
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Figure 15-10: Smart Selections causes controllers to be
automatically generated where necessary to preserve their
effects after cut and paste operations.
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chapii6 Edit Commands

After you’ve recorded your music, Performer’s
editing commands are at your disposal to add,
remove, and otherwise rearrange data in a
sequence or song. You can edit any amount of data
from single events to large regions.

Editing During Playback
Almost all of the editing operations discussed in
this chapter can be done while the music is playing
back so that you don’t have to stop and start the
music to hear the result. For example, you could
Transpose while the sequence is playing and then
use the Undo/Redo command as the music
continues playing to compare the original and
modified data.

Selecting
To edit anything in Performer, you must first select
it. Performer provides many useful ways to make
selections. Once you’ve made a selection, you can
apply Performer’s many powerful Edit menu
commands to whatever is selected. Be sure to learn
all of the ways to make selections by reading
chapter 15, “Selecting”. It contains many shortcuts
that will speed up your work.

Edit Menu Commands and the Song Window
The following Edit commands can be used in the
Song window: Cut, Copy, Paste, Erase, and Select
All. Other Edit commands such as Snip, Splice and
Repeat have no effect on Chunks in the Song
window.

SETTING THE VIEW FILTER
The View Filter (in the Basics menu) allows you to
specify what types of MIDI information are
affected by commands from the Edit menu. Using
this feature, you can extract different types of
information from a region without having to
laboriously edit out events that you don’t want. For
example, if you wanted to copy only patch changes
and aftertouch from a track, you could select only
those items in the View Filter. Only the selected
data would be copied to the clipboard. As another
example, if you were editing Tempo changes in the
Conductor track, you could set the View Filter for
Tempo changes only. You could then cut and paste
Tempo changes without erasing or in any way
affecting meter and key changes in the same
region. Remember, the View Filter setting you
make will affect all the commands from the Edit
menu, and all editing from the tracks window. You
should therefore make sure to change it back after
doing a specific editing task since it may cause
unwanted effects the next time you use the Edit
commands.

The View Filter window actually represents two
separate Filters: the Global View Filter and the
Event List View filter. Each has a corresponding
command in the Basics menu. Once you have the
window open, however, you can switch between
them with the menu at the top of the window.

To set the View Filter:

1 Choose Set View Filter or Set Event List View
Filter from the Basics menu.

A window appears.



Figure 16-1: The View Filter lets you control what you see and what
will be affected by edit operations. Use the menu at the top of the
window to switch between the Global View Filter and the Event List
View Filter.

2 Choose the types of data to be edited by
checking the check box for each.

You can choose multiple types of data. You can
choose all types of data at once by clicking on the
“Set All” button. You can uncheck all the check
boxes by clicking on the “Clear” button. Using
option-click will check only the check box you
click on, unchecking all others; using command­
click will check all boxes except the one you click
on. Use the Controllers box and its options buttons
to select which controllers are affected by Edit
operations.

3 If you want to make separate view filter settings
for event lists, choose Event List View Filter from
the menu at the top of the window and repeat this
procedure as desired for the event list settings.

When using the View Filter, keep these rules in
mind: The View Filter settings you select will stay in
effect until you change them, and they affect all
Editing operations. When you are done using the
View Filter, you should reset it.
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Specifying Controller Numbers in the View
Filter
The buttons under the Controllers check box in the
View Filter allow you to quickly choose which
controller data to include in Edit operations. Click
in the Controllers check box, click on the type of
option you wish and then enter the controller
numbers if necessary.

■ All: All controllers will be affected by Edit
operations.

■ All except: All controllers except the controller
numbers you enter will be affected by Edit
operations.

■ Only: Only the controller numbers you enter will
be affected by Edit operations.

To enter controller numbers for the All except and
Only options, click in the text boxes next to the
option and type in the numbers. You can use the
Tab key to move between boxes in the same option.

The View Filter window mini-menu
The View Filter window mini-menu has
commands in it that let you name, save, recall and
edit your favorite View Filter settings.

Saving View Filter settings
To save a View Filter setting, make the settings you
want and then choose Save Settings from the mini­
menu. A window appears to let you name it. Type
in a name and click OK. Saved settings are
independent of Global Filter and the Event List
filter. In other words, it doesn’t matter which filter
is active in the window when you save filter
settings.

Enter a nime for this Filter Preset;
(Notes only| |

Figure 16-2: Saving a view filter setting.
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Recalling saved settings
To recall a saved setting, choose it by name from
the lower portion of the View Filter mini-menu.
When you recall saved filter settings, they are
restored as you saved them for whichever filter is
currently displayed.

Renaming, Deleting, & Re-ordering Settings
To rename, delete or change the order in which the
filter settings are listed in the mini-menu, choose
Edit Settings from the View Filter mini-menu.
Click the setting you wish to rename or delete.
Drag the handle to its left to move it up or down in
the list. The order they appear in this list is the
order they appear in the mini-menu.

Figure 16-3: Renaming, deleting and re-ordering filter settings.

V7 *>. Uleu> Filters I
Save Settings...
Edit Settings...

Controllers only
Conductor track info

Data 1 never use
Data 1 alvays use
Pitch Bend only

□ i Mono presw

THE CLIPBOARD
The Clipboard is a temporary storage place that
holds data that is cut or copied. All data that is cut
or copied is put on the Clipboard. When you paste,
the data to be pasted comes from the Clipboard.

The Clipboard retains data until a new cut or copy
action is made. This means that you can cut or copy
a region of data once and paste this same
information as many times as you like. The
Clipboard retains its data between files. You can
therefore copy data from one file and paste it into
another.

To view the Clipboard, choose the Show Clipboard
command from the Edit menu. To close the
Clipboard, choose the Hide Clipboard command
from the Edit menu.

Performer’s Clipboard also lets you cut, copy and
paste text between Performer and other programs.
For example, if you write some text in a word
processing application, and you would like to
display it on a page in QuickScribe notation just
open both programs at the same time, copy the text
from the word processor, switch to a text box in
Performer’s QuickScribe window (or any other text
box in Performer), and paste.

UNDO/REDO
The Undo command will undo the effects of both
real-time and step recording. Undo will also undo
the effects of most commands and actions that add,
delete, move, or otherwise modify data.

The Undo command will change to reflect the
name of the command just invoked. For example, if
Transpose were chosen from the Region menu,
Undo Transpose would be displayed on the Edit
menu when next pulled down.

When the Undo command is used, it will generally
change to Redo. Redo will reinstate the recording or
changes to the data you have made. This allows you 
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to effectively undo the Undo, that is, return the
sequence to its state before the Undo command
was invoked.

You can go back and forth between the Undo and
Redo commands as many times as you like. This
allows you to make A/B comparisons between the
original and modified versions of the region.

CUT
The Cut command removes data in the selected
region and places it on the Clipboard. This does
not remove the time region specified; instead, it
leaves the measures blank (silent), without MIDI
events. The type of information that is cut is
determined by the View Filter. The Cut command
is undoable.

Before measure 3 is cut:

Track-1L——I 2 I 3 1 4 ’"g"1 Clipboard

After measure 3 is cut:
(The length of the music is the same.)

Track-11 I ]
1 2 3

Clipboard |--------- 1

3

COPY
The Copy command copies the data from the
selected region and places it on the Clipboard. The
original data is not affected at all. The type of
information that is copied is determined by the
View Filter. The Copy command is undoable.

Before measure 3 is copied:

PASTE
The Paste command inserts the contents of the
Clipboard (i.e. whatever was most recently cut or
copied) into a track at the location that you specify.
When you paste, you need to tell Performer where
you want the Clipboard data to go. Performer
needs to know:

■ What track (or tracks)

■ What time in the track (or tracks)

Choosing a track (or tracks) to paste into
To choose the track you want to paste into, you can
either open an event edit window for the track (see
“Opening an Event Editing Window for a Track” on
page 74) or click the track’s name in the Tracks
window to highlight it. To paste into several tracks
at once, highlight their names (see “Selecting
Tracks for Editing” on page 73).

Indicating the time at which you want to paste
There are several useful ways to choose the time at
which you want to paste:

■ If there is already a current selection in any track,
Performer will use the beginning of the selection
(either the first event of a data selection or the start
time of a time range selection) to determine where
it pastes.

■ If there is no current selection, Performer pastes
into the measure currently displayed in the main
counter (and also indicated by the playback wiper
in windows that have it) — along with one
additional condition: if Performer’s Smart
Selections feature is turned off, material is pasted at
the exact tick location shown in the counter. If
Smart Selections is turned on, material is pasted
measure relative, which means that it is placed in
the measure at its original location within the bar
so that you don’t have to worry about exact
placement of the counter. Just get the counter
anywhere into the measure you want and paste.
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Choosing tracks and location at the same time
You can use any of the selection techniques in the
Tracks Overview to choose the track and the
location at which you want to paste with one easy
selection. See “Making a Data Selection in the
Tracks Overview” on page 209 and “Selecting a
Time Range in the Tracks Overview” on page 210.

What happens when you paste
The length of the pasted region is exactly that of the
data in the Clipboard (including any blank space at
the beginning and end of the region that was placed
on the Clipboard).

Pasting data always replaces what was previously
there — unless you have temporarily hidden it with
the View Filter. The types of information pasted
from the Clipboard are determined by the View
Filter. In addition, only the types of data selected in
the View Filter are replaced; all other data is
unaffected. The Paste command is undoable.

Measure 3 from Track-1 is copied into the clipboard:

Track-11 1 I I I T
1 2 3 4 5

Clipboard

Track-2 before measure 3 is pasted:

Track-2CSZESZESZ £$□
8 9 10 12

Track-2 after measure 3 is pasted:

Track-2K \ X \ K \ 1 K \~l
8 9 10 12

ERASE
The Erase command works like the Cut command
except that no data is put on the Clipboard: all data
in the selected region is removed and the region is
left blank. The types of data erased are determined
by the View Filter setting. The Erase command is
undoable.

Before measure 3 is erased:

Track-1I 1 : i i 1
1 2 3 4 5

After measure 3 is erased:
(The clipboard remains empty.)

Track-1| | ZZJ I I I
1 2 3 4 5

REPEAT
The Repeat command makes an internal copy
(which does not go on the Clipboard) of the data in
the selected region, then pastes, splices or merges
this data repetitively immediately following the
selected region. For example, repeating bars 1-3
three times places a copy of bars 1-3 in bars 4-6,7-
9, and 10-12. Regardless of the events in the region,
the entire selected region is repeated. In the above
example, the start and end locations in the
Selection bar would be set to 1| 11000 and 4| 11000,
respectively. The entire three bar region is
repeated, with each repetition starting on the down
beat of the following measure. In most cases, it is
best to select entire measures or groups of
measures to repeat; this ensures that the repetitions
will line up correctly with measure boundaries.

Figure 16-4: The Repeat command.

The Repeat command requires a time range
selection instead of a data selection. For a further
explanation, see “Edit Commands That Require
Time Range Selection” on page 207.

Using the Paste option in the Repeat dialog box, the
repeated data replaces the data in the repeated
region: the pre-existing data is erased. Using the
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Merge option in the Repeat dialog box, the
repeated data is merged with the data in the
repeated region. Using the Splice option in the
Repeat dialog box, the repeated data moves the
pre-existing data to a later time in order to make
room for the data in the repeated region. The types
of data repeated are determined by the View Filter
setting, as are the types replaced by the Paste
option and shifted by the Splice option.

MERGE
The Merge command combines the contents of the
clipboard with pre-existing data in the selected
tracks. The new data is inserted at the Start time in
the Tracks window, mixing together the data
already in the region and the new material. You
need only specify a Start time in the Selection Bar
of the Tracks window; the End time has no effect.
The types of data merged from the Clipboard are
determined by the View Filter setting. The Merge
command is undoable.

Since Performer allows unlimited tracks assigned
to one channel, the Merge command isn’t always
necessary. You should use it only when you are
certain that data in two tracks should be merged
together (this is often true when you create a track
during editing for the express purpose of merging
it with another track later). Once tracks are
merged, they cannot be separated later.

Track-1 lx\\\X\\l\\\\T
1 2 3 4 5

Track-2! 7 7\77 7 7 7 7 A/7\
1 2 3 4 5

Merged TrackKXKXXXXXXEZX]
1 2 3 4 5

SNIP
The Snip command removes data in the selected
region and places it on the Clipboard. The time
region containing the data is removed as well,
closing up the gap between the beginning and end
of the region: events at the End time are moved to 

the Start time. The types of data snipped are
determined by the View Filter setting. The Snip
command is undoable.

The Snip command requires a time range selection
instead of a data selection. For a further
explanation, see “Edit Commands That Require
Time Range Selection” on page 207.

Before measure 3 is snipped:

SPLICE
The Splice command inserts data on the Clipboard
in the selected region, making a gap for the new
data and moving pre-existing data later in time to
make room for the new material. The event just
after the Start time moves forward the amount of
time of the region on the Clipboard. Thus, if a one-
measure section is copied to the Clipboard and
spliced at measure 3, the old events starting at
measure 3 shift to measure 4. The types of data
spliced from the Clipboard are determined by the
View Filter setting, as are the types shifted to make
room. The Splice command is undoable.

Before measure A is spliced:

Track-1 X XIX XI I I
1 2 3 4 5

Clipboard mil
A

After measure A is spliced:
(Measures 3 & 4 are shifted to 4 & 5.)

Track-11 XXXTII 111 I ~1
1 2 3(A) 4 5

Clipboard 11| || || |

__________
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SHIFT
The Shift command moves the selected region
ahead or back in time. The shift distance can be
specified in one of two ways:

■ Shift by amount — lets you specify a number of
measures and/or a quarter notes|ticks duration,
entered into a dialog box. Measures are computed
based upon the meter marking at the start point of
the selected region.

■ Shift to time — lets you specify an exact
location, in any time format you wish, to which you
would like to move the data.

Figure 16-5: The Shift command.

O Earlier
© Later

me as. beatslticks
® | o||L-.aooo]E:

by O | o:oo.oo|Q
O | O:OO:OO:OO]tW

Shift by amount v |

□ Preser

To move the region ahead, choose Earlier, to move
it back, choose Later. The region will be shifted in
time by the amount you enter. The types of data
shifted are determined by the View Filter setting.
The Shift command is undoable.

The Preserve realtime performance option, when
checked, will shift the selected data to the new
location based on the first selected event. All of the
rest of the selected events will be shifted relative to
the first in a manner that preserves the realtime
performance at their original location. This allows
you, in effect, to shift material without changing
how it plays due to differences in tempo between
the original and new locations.

SHOW/HIDE CLIPBOARD
Choosing Show Clipboard from the Edit menu
brings up a window which describes the contents
of the Clipboard (in text). When the Clipboard is
showing, the menu entry changes to Hide
Clipboard. When you choose this, the Clipboard
window is closed. For a description of the
Clipboard, see “The Clipboard” on page 219.
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SELECT ALL
This command generally selects all items in the
active window. If a Tracks window is active,
choosing Select All will select all the tracks (thus
highlighting all track names). If an Event List
window is active, choosing Select All will select all
events in it.

EDITING BETWEEN SEVERAL TRACKS
You can use the Edit commands to move or change
data from one or more original tracks to one or
more target tracks (even in another file). The
number of original and target tracks have to be the
same. If they are unequal, Performer tells you how
many tracks are currently in the Clipboard and
asks you to select the same number of tracks.

HINTS
The following examples illustrate some creative
uses of the Edit commands.

Removing a Specific Type of Data From a Track
This works for removing one or more particular
kinds of data from a track such a mono key
pressure, patch changes, etc.

1 Choose Set View Filter from the Basics menu.

2 Check only the check box for the type of data
you wish to remove.

Option-click on the check box for the type of data
to be removed; all other check boxes will uncheck.

3 Select the track with the data to be removed.

Click on the track name; it will highlight.

4 Enter the Start and End times of the region in
the Selection bar.

5 Choose Erase from the Edit menu.

If you want to save this information for possible
future use, cut it instead of erasing it, and paste the
information into a new and separate storage track.
You can later merge it back into the original track if
you like.

Here’s an alternate method for removing a specific
kind of data using the Event List window:

1 Open the Event List window for the track with
the data to be removed.

This is done by clicking on the track name and
choosing Edit from the Tracks window mini­
menu.

2 Choose Set View Filter from the Basics menu.

3 Choose Event List View Filter from the menu at
the top of the window.

4 Check only the check box for the type of data
you wish to remove.

This will display only that type of data in the Event
List window. Option-click on the check box for the
type of data to be removed; all other check boxes
will uncheck.

5 Select a region of events.

Click on the first event and drag over the rest of
them.

6 Choose Erase from the Edit menu.

Creating an Echo Effect with a Track
Here’s a method for "echoing” a track: all of the data
in a track is copied to another track and shifted just
slightly in time. The effect is a slight delay or echo.

1 Activate the Tracks window for the sequence
that contains the track to be echoed.

Click anywhere in the Tracks window.
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2 Choose Add from the Tracks window mini­
menu.

A new track appears in the track list.

3 Name the new track.

Option-click on the name. A pop-up box will
appear into which you can type the new name.

4 Select the original track by clicking on it.

The track name will highlight.

5 Enter the Start and End times of the region in
the Selection bar.

6 Choose Copy from the Edit menu.

The data in the selected region is placed on the
Clipboard.

7 Select the new track by clicking on it.

The track name will highlight.

8 Choose Paste from the Edit menu.

The contents of the Clipboard are pasted into the
new track. It now contains a copy of the original
track.

9 Choose Shift from the Edit menu.

10 Select the Delay option and enter zero bars and
0|240 duration.

This will delay the data in the new track by an
eighth note.

A few variations on the above:

Before selecting Paste to paste the data into the new
track, you could set the Start time in the Selection
bar in the Tracks window to 240 ticks later. This
would save you having to use the Shift command to 

shift the data by 240 ticks. You could use the
Change Velocity command on the Region menu to
decrease the velocities on the echo part to make it
softer than the original. You could assign the echo
part to another synthesizer or voice with a different
patch or the same patch, panned in stereo.

The Repeat Command vs. Looping
The Repeat command is useful for repeating
sections of music, creating the same effect as
looping. The advantage of using the Repeat
command over looping is that you can make each
of the repeats slightly different. Loops take less
memory (which is an advantage on their side) and
each copy is exactly the same. Choose between
them according to your needs at the time.

Repeat can also be used to create trills (by
repeating just two very short notes) or drum rolls
(by repeating just one drum note).

The Shift Command and Attack Times
You may find that certain patches on your
synthesizers have quicker attack times than others.
You can play two notes at exactly the same time on
two different synthesizers (with two different
patches) and hear them not sounding together: one
seems to “play” first and the second takes a longer
time to come to full volume. The Shift command is
useful for lining up attacks in situations like this
one. By shifting a track forward or backwards just
slightly (try a value of less than 100 ticks to start
with),you can make all instruments sound as if
they are attacking notes at the same time. You may
want to leave some of the disparity between attack
times: let your ear guide you.
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chapter 17 Region Commands 1

Editing During Playback
Almost all of the editing operations discussed in
this chapter and the next can be done while the
music is playing back so that you don’t have to stop
and start the music to hear the result. For example,
you could change note velocities in a track while
the music is playing and then use the Undo/Redo
command as the music continues playing to
compare the original and modified data.

Selecting a Region
The commands in this chapter act on the a selected
region in the Tracks List, the Tracks Overview, or
one of Performer’s four track edit windows.
Without a selected region, the commands in this
chapter do nothing. So be sure to learn how to
select a region by reading chapter 15,“Selecting”. It
contains many powerful shortcuts that will speed
up your work.

Region Commands Are Windows That Can Stay
Open
All of the Region menu commands open as a
window that can stay open, unlike Edit menu
commands, which are dialog boxes that must be
okayed or cancelled before you can do anything
else. By staying open, Region menu commands let
you apply their effect without revisiting the menu
each time. For example, if you are quantizing a
number of tracks, you can leave the Quantize
window open while you successively select
different tracks and apply different quantize
settings to them.

Because of the way Region menu windows interact
with global selection, only one Region menu
window can be open at a time. If you have one 

already open, and you choose a different command
from the Region menu, the current window is
replaced with the new one.

When you open a Region menu window, its
location on your computer screen is remembered
when you close it and reopen it. In addition, all
Region menu windows share this location, so they
will always open in the same spot.

Choosing What Happens When You Apply
Region Commands
The mini-menu in each Region command window
lets you choose one of the following three options:

Apply closes window: Causes the window to close
when you click the Apply button or press the Enter
key.

Apply sends window to back: Causes the window
to go to the back when you click the Apply button
or press the Enter key.

Apply with Enter key sends window to back:
Causes the window to stay in front when you click
the Apply button and go to the back when you
press the Enter key.

TRANSPOSE
The Transpose command transposes or
harmonizes all notes in the selected region. For
information about the Transpose command, see
chapter 19, “Transpose” (page 265).

QUANTIZE
Quantizing changes the attack and release times of
note events to make them more rhythmically
precise. Attacks and releases are aligned with a
grid, a set of locations that occur on the beat and its
subdivisions. Quantize is useful in correcting 
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perceived rhythmic inaccuracies after your
sequence is recorded. It does a rhythmic “cleaning
up” based upon your specifications.

Some Inaccuracy is Good
Quantizing is, in its simplest form, a way to make
all note events in your sequence occur on a beat or
one of its subdivisions, eliminating inaccuracies.
But inaccuracy is far from undesirable. In fact,
inaccuracy is what gives a piece of music its “feel”,
its particular rhythmic profile. If you always
aligned all attacks and releases with grid locations,
your music might have a mechanical, inhuman
quality to it. You’ll find that you’ll often want to
preserve some of the rhythmic nuances of your
playing. Therefore, Performer allows you to
quantize selectively and specify the degree of
quantizing you want. The Sensitivity and Strength
options accomplish this. In addition, you might
want to shift the occurrences of the beat slightly
ahead or behind the metronome beats in a
particular track or section. The Grid Offset option
allows you to do this.

Basics
Quantize will only alter the locations and durations
of note events. All other data in the selected region
will be unmodified.

Quantizing a region sets up a grid of equally spaced
locations. Notes are then moved from their original
locations to the nearest grid location.

You can choose to change the attack times and/or
release times of notes. There is an added option to
leave the note durations unaltered. Choosing to
change attack times causes them to be moved to the
nearest grid location; release times are left
unchanged. Choosing to change release times
causes them to be moved to the nearest grid
location; attack times are left unchanged. Both of
these operations cause an automatic change in note
durations.

Original music

13 Attacks  Releases
3 Don't change durations

0 Attacks 3 Releases
 Don’t change durations

Figure 17-1: An example of quantizing with and without quantizing
the releases.

You can choose not to change the original
durations. This prevents durations from being
truncated, which may cause the notes to sound
chopped.

Note that if you choose to change both the attack
and release times, the Don’t Change Duration
option is automatically disabled. This is due to the
nature of the operation: if you change both the
attack and release times of a note, the durations
will automatically be modified.

To Quantize
To Quantize a region:

1 Select the region you wish to quantize.

See chapter 15,“Selecting” (page 207) for complete
details about how to do this.

2 Choose Quantize from the Region menu.

The Quantize window appears.

228 I
REGION COMMANDS 1



Figure 17-2: Performer's quantize command provides many powerful
options for quantizing.

3 Select Attacks, Releases or both to be quantized.

If you selected Attacks or Releases (not both),
select the Don’t change durations option if you wish
to keep the original durations the same. If you did
select both Attacks and Releases, this option will be
disabled.

4 Select a grid value.

Select any note value from a 128th note to a breve
(a double whole note). Select the dot or Tuplet
option if necessary.

5 Set Offset, Sensitivity or Strength options.

Optional: see the descriptions below on these
features.

6 Press Apply.

Choosing the Grid's Duration Value
The grid value is the distance between grid
locations. For example, if you select an eighth note
as the grid value, each grid location is an eighth
note apart. This means that the note attacks and/or
releases will be moved to the nearest eighth note
location.

The grid is aligned such that it begins on the first
beat of the first measure of the selected region. If a
meter change occurs in the selected region, the grid
is realigned at the point of the meter change to
begin on the first beat of the meter change.

Generally, you should choose a grid value that is
the smallest note value in the region. For instance,
if you are quantizing a region with lots of sixteenth
notes and a few quarter notes, choose a grid value
of a sixteenth note.

The grid value can be modified with the dot and/or
tuplet boxes. When the dot is selected, it adds one
half of the selected duration to the grid value. For
example, if the quarter note and dot are selected,
the grid value is a dotted quarter, equivalent to
three eighths. If the tuplet box is selected, the tuplet
specification is applied to the selected duration.
This is similar to the way the tuplet box works in
the Step Record window. Example: you have three
eighth notes in the time of two specified and the
tuplet box is checked.

0 Tuplet in time of |2 |

The quantize grid will be set to triplet eighth notes.
Each triplet grid location will have a duration of
160 ticks, which is equal to a third of a quarter note
(480 ticks). To specify a tuplet grid value:

1 Select the base duration you want.

Click on one of the note symbols.

2 Check the tuplet check box.

3 Enter the number of tuplets in the left text box.

4 Enter the number of regular note values that the
tuplet replaces in the right text box.
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Grid Offset
The start of the grid may be offset from its standard
position on the first beat of the selected region by a
number of ticks. This is done by clicking in the
check box next to Offset by n ticks and entering a
number of ticks to offset the grid by. Positive values
offset the grid forward in time (after the beat),
negative values offset it backward (before the beat).

If you enter an offset greater than the distance (in
ticks) between grid locations, the number will be
scaled down to be less than the distance of the grid
value. For example, if you are using a grid value of
a quarter note (480 ticks) and you enter an offset of
500 ticks, it will be reduced to an offset of 20 ticks,
that is 500 minus 480. Offset values range from -
9999 to 9999.

Swing
The Swing option delays every other grid point to
create a swing feel.

6rM

wBJUJosI-
□ Tupkl • |3 | in tirnfr of |2 |

□ Offset grid by | | ticks

(fl Swing; {710^%

The Swing option defaults to 100%, which
produces straight swing. For example, an eighth
note grid produces a grid point every 240 ticks.

The swing option, at 100%, will delay every other
grid point 80 ticks to 320, which is the attack time
of the third eighth note in an eighth note triplet.

swing

A larger percentage such as 120% would delay
every other grid point to 336 ticks, creating a
“loose” swing feel. A smaller percentage such as
80% would advance every other grid point to 304
ticks, creating more of a straight swing feel. The
percentage can be any value between 0% and
300%. 0% does nothing and is the same as
quantizing without the swing option. 300% delays
every other offbeat all the way to the next grid
point.

Sensitivity
Each grid location has a “field of effectiveness” in
which note events can be moved by the Quantize
command. Normally, this field extends from one
grid location halfway to the next, affecting all note
events. The center of each field is the grid location:
each field actually extends out in either direction
from the grid location.

100%
Sensitivity

Figure 17-3:1001b Sensitivity reaches all the way from one grid
location to the next, as shown here by the gray background.

Sensitivity is the size of this field. The default
sensitivity (without the Sensitivity options
selected) is 100%, i.e. extending continuously
between grid locations. This field is actually split 
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into 50% before the grid location and 50% after the
grid location. If you select Sensitivity and enter a
value of 50%, the quantizing field will be reduced:

Figure 17-4:50% Sensitivity reaches only part way (25%) on both
sides of each grid location, as shown here by the gray regions.

50%
Sensitivity

Note that 50% means 25% before the grid location
and 25% after it (i.e. 50% of the way to the
midpoint between grid locations). Any notes not in
the field would not be quantized.

As illustrated, a positive Sensitivity value quantizes
notes surrounding a grid location. In contrast,
negative Sensitivity values quantize notes
surrounding the midpoints between grid locations.

With positive Sensitivity values, the field of
effectiveness extends outward from the grid
location. In the case of negative sensitivity, the field
extends inward from the midpoints on either side
of the grid location. As with positive sensitivity, the
field is split on either side of the midpoint. So if you
enter a Sensitivity value of negative 20%, notes
from about 41 to 50% before the grid location and
about 41 to 50% after would be moved to the grid
location:

Midpoints

Field of effectiveness
for-20% sensitivity

Direction of quantizing
from midpoint

What’s most important is the effect that different
Sensitivity values will have on your music. To
summarize:

■ Positive sensitivities clean up the down beats
without affecting ‘swung’ or freely played notes in
between.

■ Negative sensitivities catch major inaccuracies
while retaining the music’s ‘feel’.

To use the Sensitivity option:

1 Check the check box next to the Sensitivity
option.

2 Enter a number between -100 and 100 for the
Sensitivity value.

Strength
Another way to preserve some of the rhythmic
character of your music while making it more
rhythmically accurate is to use the Strength option.
Without any options chosen, Quantize will move
all note events so that they align perfectly with grid
locations. Since this can result in an overly precise
effect, you might want to leave some of the original
inaccuracy in the passage. The Strength option
does this by not moving the note events all the way
to the grid locations. Rather, they are moved a
percentage of the way toward the grid points. Use
the Strength option to tighten up a passage without
losing its “feel”.

The Strength value specifies the amount that note
events move toward grid locations when
quantized. A Strength value of 100% (the default)
moves them all the way to the nearest grid
locations. A value of 0% leaves them where they
are. A value of 50% moves them halfway to the grid
locations.

Original Music

Quantize Attacks
with 50% Strength
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Consider this example: there is a note event
occurring at 10| 3 [450. The grid duration is a
quarter note, the Strength option is selected and a
value of 40% is entered. When Quantize is okayed,
the note will move to 10|3|462. If no strength
option were selected, it would have moved to
10141000, a distance of 30 ticks. A Strength value of
40% moved it that percentage of the distance (40%
of 30 ticks = 12 ticks) to 10|3|462.

To use the Strength option:

1 Click in the check box next to the Strength
option.

2 Enter a number between 0 and 100 for the
Strength value.

Randomize
Unlike all of the other Quantize options, which try
to make notes more rhythmically precise, the
Randomize option does just the opposite: it
modifies the quantization randomly to make the
notes as rhythmically imprecise as you like. 100%
randomization causes note attacks (and/or
releases) to be placed entirely randomly. A value of
less that 100% reduces the range over which the
notes will be randomized, and the grid point sits in
the middle of the range. For example, if you choose
a 16th note grid (a grid point every 120 ticks), and
a randomize value of 50%, the range is 60 ticks,
extending 30 ticks before and after each grid point.
Thus, a note attack (and/or release) would be
randomly placed within 30 ticks of its nearest grid
point.

Area of randomization

Figure 17-5:50% Randomization on a 16th note grid produces a
region of 30 ticks on either side of each grid point: notes will be placed
randomly within this region around each grid point.

Emphasis
This sub-option causes the tendency of the
randomization to be earlier or later within the
specified range. Thus, if you wish to randomize the
note placement within a certain range, but you
wish to push the beat by tending to make the notes
occur a little bit early, use a negative emphasis; use
a positive emphasis if you wish them to tend to be
laid back—that is, after the beat. A value of zero
equals no emphasis, which causes the
randomization to occur evenly within the range.

Hints
If you’re trying to simply line up all notes with the
beat and its subdivisions, selecting Attacks and
Don’t change duration will most likely yield the
results you want. If you select both Attacks and
Releases, all notes will begin and end at grid
locations. This may make them too precise,
sounding chopped, inhuman, or just wrong.

If you are trying to get the notes of a chord to line
up to make the attack precise, consider using the
DeFlam command on the Region menu instead of
Quantize. It will line up the attacks but will not
move the notes to a grid location.

If you want to quantize a region containing a
mixture of sixteenth, eighth, and quarter notes
which contains just two or three thirty-second
notes, set the grid value to sixteenths for 
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quantizing. You can subsequently change the
thirty-seconds back individually. Otherwise, if you
choose too small a duration value, many notes may
move to undesirable locations. Choose a grid value
that reflects the general rhythmic profile of the
region in its most active, complex areas.

Performer is very capable, but it can’t read your
mind; you’ll find that there are some notes that just
don’t get moved to the locations you want them to
be. This is due to the original location of the note
not being within the quantize field for the desired
grid location. The quickest way to fix this is to
change them individually in the Event Editing
Window for the track they are in.

You can use the Offset command to do some very
fancy quantizing that may not, at first glance, even
seem like quantizing. For example, suppose you’ve
just entered your sequence in 4/4 time and you
decided that you’d like to make notes that fall on
the third beat of every measure slightly late. First,
set the grid value to the whole note. Grid locations
will occur only once per measure, on the first beat.
Choose the Offset option and enter a value of 980
ticks. Since 960 ticks constitute one half note, 980
ticks is 20 ticks after the third beat. Now choose the
Sensitivity option and enter a value of 20%. This
limits quantization to those notes near the third
beat already (if you didn’t use the Sensitivity
option, all notes would end up quantized to the
third beat). You may have to experiment with the
percentage. Use a larger percentage if some notes
don’t get quantized that should; use a smaller
percentage if some notes get quantized that
shouldn’t.

The Offset option was not designed for the mass
shifting of notes in a region. If you want to move a
section of your sequence forward or backward in
time, use the Shift command on the Edit menu.

SMART QUANTIZE
Smart Quantize is especially designed for
quantizing data that will be transferred to music
notation software, with the exceptions noted
below.

Performer’s built-in QuickScribe™ notation
window does not require quantization of any kind;
it will notate original, unquantized MIDI data.

*■ Our latest notation software package,
Mosaic™, does not require Smart Quantize
because it uses its own quantizing algorithms when
transcribing MIDI data.

Smart Quantize is great for quantizing large
sections of music when you don’t want to have to
decide what the quantize grid value should be. For
example, if a sixteenth note grid wouldn’t be
appropriate for the music, nor would any other
particular quantize value, try Smart Quantize. It
uses a floating grid depending on the music, and it
even recognizes tuplets.

Smart Quantize also greatly enhances the
transcription of the music when it is transferred to
programs like Professional Composer, which do
not have sophisticated transcription algorithms
like those employed in Performer’s QuickScribe
notation window or in Mark of the Unicorn’s
Mosaic notation software, neither of which
requires Smart Quantize. Using a specially-
designed, floating quantize grid, Smart Quantize
quantizes both attacks and releases to ensure that
notes are notated on the correct beat with the
proper duration. Triplets and tuplets will be
properly quantized, along with notes in straight
time.

Smart Quantize also provides several options to
optimize the transcription of your musical
performance.
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. **.« Smart quantize

O Qutntte* titackj and duralfonz

<£• Quantize attacks cnly
® Preserve duration
O Preserve release two

To use Smart Quantize:

1 Select the region that contains the music you
will transcribe.

If you are transcribing an entire sequence, select all
the tracks in the tracks window and set the Edit
Start and End times in the Selection Bar to include
the entire sequence.

2 Choose Smart Quantize from the Region menu.

3 Set the options as desired.

4 Click Apply.

Because Smart Quantize does so many things at
once, it may take longer than regular quantizing.
Expect to wait for a moment if you have quantized
a large region.

INPUT QUANTIZE
The Input Quantize feature quantizes notes during
recording in the same fashion as a standard drum
machine. Notes get quantized immediately as they
are being received and appear quantized in the
track afterwards. If you are loop recording, the
notes will playback quantized the next time
through the loop.

Opening the Input Quantize Window
To open the Input Quantize window, choose Input
Quantize from the Windows menu:

S7|£1| ..........Input Quantize
3 Enable input quantization

Vhat to quantize:
SJ Attacks  Releases

IS] Don't change fariMw

 Tupht:|3 | in time of [2 |

 Offset grid by |o | ticks
 Sving |o

Options:
 Sensitivity: |lOO |?o

(3 Strength: |75 |$Z

 Randomize: |25 |$g
Emphasis: |o I(-9 to +9)

This is a standard Performer window that can be
left open while you play back, record, edit, and use
Performer’s other windows and features. This
allows you to make changes to Input Quantize
during recording.

Turning Input Quantize On and Off
To turn on Input Quantize, check the Enable input
quantization box. When Input Quantize is turned
on, all incoming notes are quantized according to
the options shown in the Input Quantize window.
To turn off Input Quantize, simply uncheck the
box.

Setting the Input Quantize Options
Input Quantize offers the same type of
quantization as the regular Quantize command in
the Region menu. The only differences are that 1)
the quantization occurs in real time as data is being
recorded, and 2) the options for each type of input
quantization are set in the Input Quantize window
rather than the Quantize window. But Input
Quantize options behave the same way as their
counterparts in the Region menu.

For more information about the Input Quantize
options, see “Quantize” on page 227.
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Changing Options During Recording
Any option in the Input Quantize window can be
changed at any time, even during recording. For
example, you can record several bars with
quantization turned on and then turn it off on the
fly as you record the next several bars. As another
example, you might check the triplet check box
while recording triplets and uncheck it as you
switch back to straight time.

Loop Recording
For information about how to use input quantize
while loop recording, see chapter 30, “Looping”
(page 347).

HUMANIZE
The Humanize command lets you add a “random”
element—or “humanized” feel—to your music.
With this command, you can randomize any
combination of the following elements of your
music:

■ Note placement

■ Note durations

■ Velocities

■ Pitches

■ Tempo

In addition, you can create a unique blend of these
randomization elements and save it as a
randomization style, which you can recall and use
at any time. You can use the Humanize command
to create arpeggiation effects, hi-hat (or other
percussion instrument) grooves, and other
dramatic musical effects.

pj.ffj_______ ________ . ___ .- ___ ___ Humanize
tfhjt to hw-Hitw-

ct) flcto ptoetmvfit
O by i 1 10,38 cf durttton
(•> withh ± ( 0|060|
Emphaxls. ( O|(-9 to ♦?)

M tXritfoni
O ty | IO|<o uf current valu#
<•> wtfhtft A | 0|060|
EmphatU • | o] (-9 to +9)

aV>!ocltWi @4 Oft Q t Off
O vtthtft * | 127|of cvrrwit

within a
from | l| to | 127|

Emphijir. | o| (-9 to *9)

(iti Pitch»5 CMl otjdiin_______ -J

, ....------------ Mr- 1

□ Temp*
O ty I 1of current value
® vitoln t1 S.00|t;m

| o| (-9 to +9>

Select a Hmanke Style.
Hl Mat Crccve<-j

Style ram?:______________
{Hi Hat Groove |

The Humanize command combines the randomize
options of the following commands: Quantize,
Change Duration, Change Velocity, and Scale
Tempo. It also adds the randomization of note
pitches.

For even further control over the feel of your music,
be sure to check out chapter 20, “Groove
Quantize”.

Choosing What to Humanize
Each type of musical element is a check box option
in the Humanize window. To randomize that
element, check its box. If you don’t want to
randomize it, uncheck it. For example, if you want
to randomize velocities, but not note placement,
uncheck note placement.

Humanize Sub-options
Each element has sub-options which affect how it
randomizes. These sub-options are discussed
briefly below. All of the elements have an Emphasis
sub-option, which is discussed in a separate
section. The last section explains how to save and
recall Humanize styles.

Note Placement
The Note Placement sub-option randomizes the
attack times of notes within a range (in ticks) of the
note’s current location. You can specify the range as 
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a number of ticks, or as a percentage of the note’s
duration, in which case longer notes have a larger
range and shorter notes have a smaller range.

Durations
The Durations sub-option randomizes durations
within a range of the current duration, which you
specify in the box provided. This range can be
specified as a absolute number of ticks, or by a
percentage of the current duration.

Velocities
The Velocities sub-option lets you choose between
on (attack) or off (release) velocities. In addition, it
lets you randomize the velocity within a range of its
current value, or within an absolute range.
Randomizing within a range of its current value
lets you preserve the overall contour of the
velocities, while still mixing them up a little bit.
Randomizing within an absolute range lets you
limit them to a certain range of values.

Pitches
The pitches sub-option allows you to randomize
the pitch of each note within the region. You can
randomize to:

■ Any pitch

■ A range of pitches

■ Certain pitches within a range

In addition, you can assign weight to each pitch
within a range so that it is used more or less often
during the randomization process. For example, if
you are creating a humanize style that generates a
hi-hat part, you can assign more weight to the
closed hi-hat pitch and less weight to the open
hi-hat pitch so that the result is mostly closed hit
with an occasional open one.

The Set Random Pitch Map button lets you
determine what pitches notes can be randomized
to:

Choose what pitches notes can be
randomized to and assign them
weight here in the random pitch map.
Weight can have a value between 0
(not used at all) and 99 (used a lot).

| Clear

Choose a pitch range in
vhkh to randomize:

If you like the random pitch map you
created, and you'll want to use it again,
name it and save it here.

omize pitches
O Airrioiw

Recall saved random pitch
maps by selecting them from
this pop-up menu.

Cti.-k a
pitch
select cr
deselect it.
Chskthe
weight to
pop edit

OK ( | Cancel |

Random Pitch Hap nxmc-: Select » Random Pitch Map.
|c Mixolydian ~| C Mixolydian v ;

Select what If desired.choose a scale in
pitches can which to randomize here.
be used here. Customize the scale by

creating your own with
the Create Scale button.

Random Pitch r-tep
men
Cl 20
Dbl 7
DI 20 .
Ebl A
El 50
Fl 60
F«1
G1 90
Abl
Al 25
Ebl
Bl 1
C2 90

The Create Scale button
The create scale button opens the create scale
dialog box. For information about this dialog, see
“Creating a Custom Scale” on page 272.

Saving, Recalling, and Deleting a Random Pitch
Map
To Save a Random Pitch Map:

1 Set up the pitch map as desired.

2 Type in a name for the Random Pitch Map.

3 Click Save.

To recall a random pitch map, select its name from
the pop-up menu.

To delete a random pitch map:

1 Select the pitch map you wish to delete from the
pop-up menu.

2 Click Delete.
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To rename a pitch map:

1 Select it from the pop-up menu.

2 Type in the new name.

3 Click Save.

4 Delete the original one.

Tempos
The Tempos sub-option randomizes existing
tempos within the selected region. Note that it does
not generate new tempo events. (To do so, use the
Change Tempo command in the Change menu.)
This option only affects tempo events that already
exist in the Conductor track. If the region you
select has no tempo events in it, this option will
have no effect. Use the Change Tempo command in
the Change menu to generate tempo events.

By___% of current value
This option randomizes the tempo of each selected
tempo event within a range that is expressed as a
percentage of the tempo value. For example, if the
tempo is 100 bpm, and you enter 10 percent, the
tempo will be randomized within a range between
90 to 110 bpm (±10 bpm).

By ±bpm
This option randomizes the tempo of each selected
tempo event within a range of beats per minute.

Emphasis
Each Humanize element has an emphasis sub­
option, which can be any value between -9 and +9.
The emphasis value causes the tendency of the
randomization to be higher or lower within the
specified range. Thus, if you wish to randomize
within a certain range, but you wish values to tend
to be higher, use a positive emphasis; use a negative
emphasis if you wish them to tend to be towards
the lower end of the range. A value of zero equals
no emphasis, which causes the randomization to
occur evenly within the range.
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Saving, Recalling, Deleting, and Renaming a
Humanize Style
To Save a Humanize style:

1 Set up the Humanize style as desired.

2 Type in a name for the style.

3 Click Save.

To recall a Humanize style, select its name from the
pop-up menu.

To delete a Humanize style:

1 Select the pitch map you wish to delete from the
pop-up menu.

2 Click Delete.

To rename a Humanize style:

1 Select it from the pop-up menu.

2 Type in the new name.

3 Click Save.

4 Delete the original one.

DEFLAM
The DeFlam command looks for groups of note
that are very close together. When such a group is
found, the average attack time of the group of notes
is computed. All notes in the group are moved such
that their attack times are aligned exactly to the
average time.

The group of notes that is deflammed is
determined by the tick value you specify. This
creates a “window” of effectiveness. Groups of
notes within that window will be deflammed.
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Basics
When chords are played in real time, the attacks of
individual notes are often splayed as in the example
below, which shows two four-note chords:

t141325 JC4 172 164 11254
1141331 /G3 .54 164 11204'
1141336 2G4 .55 164 l|1?2
1141343 >63 .74 164 1120?

'2141422 764 165 t64 11120
2.41432 2 03 165 164 11100
2141436 159 164 11123’
214143? 4B3 179 164 11100

DeFlam is useful for consolidating the attacks of
the notes in such chords. The following is the result
of using DeFlam with a tick value of 20 on the
above passage:

1141333 /G4 155 ♦64 III 92]
K4 *72 ♦64 11254
/Ao 174 164 11209
/G3 454 ♦64 11204

2|4|432 JE4 159 ♦64 11123
/E4 125 164 11120:
/Eo 179 164 11109
/Go *85 164 11108:

The quarter notes are now grouped into two
precise chords.

DeFlam averages the attack times of the groups of
notes; there is no grid involved as there is with the
Quantize command. In the above example, the
resulting attack time of each chord is the average of
the attack times of the four original notes. The
durations of the notes are left unchanged.

DeFlam attempts to detect grace notes and rolled
chords and, if found, will leave them as such.

Using DeFlam
To use DeFlam:

1 Select the region you wish to modify.

The region should include only the notes to be
deflammed.

2 Choose DeFlam from the Region menu.

A window appears.

3 Enter a tick value.

The tick value sets the “window” for the command.
Notes within this window will be deflammed.

4 Press the Apply button.

If DeFlam leaves some notes out, try using a larger
tick value; if it includes too many notes, try
decreasing the tick value. (Remember, you can
Undo and Redo the DeFlam command.) The
correct tick value depends greatly on the particular
passage you are working with. It may take several
attempts to determine the correct value.

CHANGE VELOCITY
Change Velocity is a powerful command that lets
you modify the velocities of all notes in a region.
You can remove irregularities, make passages
louder or softer and create crescendos,
diminuendos and other similar effects. Note that
not all MIDI keyboards and sound modules
respond to velocity data, and those that do may
need to be set up to respond correctly to this
information. Consult your owner’s manuals for
details.

Using Change Velocity
To use change velocity:

1 Select the region you wish to modify.

2 Choose Change Velocity from the Region menu.

A window appears.



3 Choose between modifying on (attack)
velocities or off (release) velocities.

4 Choose the desired option to alter the velocities.

Select from the Set all velocities to ,Add to all
velocities, etc. options by clicking the radio button
next to the desired option.

5 Enter the values required by the option.

Click in the box and type in the value. If there are
additional values to enter, use the Tab key to
highlight each successive box or click in each box
directly and enter or edit the value.

6 Press Apply.

You can Undo/Redo the Change Velocity
command.

There are a number of options in the Change
Velocity window. Each one allows you to modify
velocity values in a different way. Don’t let this
complexity confuse you; once you select an option,
you can ignore all information pertaining to other
options.

On Velocities or Off Velocities
On velocities control the speed at which a note is
attacked. This affects the note’s loudness most
dramatically, but on velocities can also affect other
aspects of the note event such as its timbre (e.g. the
harder the note is struck, the brighter it sounds).
Off velocities control the speed of the release of the 

note and are sometimes used to control its decay
rate. At this time, very few synthesizers utilize off
velocity information.

The Change Velocity command can be applied to
either on or off velocities: choose the type you wish
at the top of the window. The default setting
changes the on velocities.

Set all velocities to
This option sets all velocities in the selected region
to a single value. Enter a value between 1 and 127.
A result of this option is that all note events in the
region will be played back at a constant volume.

Add to all velocities
This option adds the value you enter to all
velocities in the selected region. The value must be
in the range -127 to 127. Velocities that end up less
than 0 or greater than 127 will be set to zero or 127,
respectively. A result of this option is a uniform
increase or decrease in volume of all notes in the
region, within the zero to 127 range.

Limit to a maximum of
This option modifies all velocities in the selected
region that have a velocity greater than the value
you enter, by changing them to that value. Enter a
value between 1 and 127. This option imposes a
maximum volume level on all notes in the region.
You can use it to change the velocities of notes that
“stick out”.

Limit to a minimum of
This option modifies all velocities in the selected
region that have a velocity less than the value you
enter, by changing them to that value. Enter a value
between 1 and 127. A result of this option is that
there will be a minimum volume level for all notes
in the region. You can use this option to assure that
notes that may be inaudible have sufficient velocity
to be heard.
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Change to % of current value
This option scales all velocities by the percentage
value you enter. Percentage values must be between
1 and 999. For example, if all notes in the region
have a velocity of 120 and you enter a percentage
value of 50%, the velocities will be set to 60. Thus,
to halve velocities, use a value of 50%. To double
them, use 200%. Velocities that end up less than 0
or greater than 127 will be set to zero or 127,
respectively.

Scaling by a percentage may give you better results
than using the Add to all velocities option
above since the original velocity contours are
preserved. Try both to discover which gives you the
results you want.

Change smoothly from
This option has two basic sub-options: % to

% of current value and to . Each gives
you a different way to specify the smooth velocity
changes. The first changes by percentages, creating
a smooth velocity change for notes in the selected
region while preserving some of the original
velocity characteristics (most notably the accents);
the second creates a smooth change with no
fluctuations. You can specify a curvature for the
change, which determines its contour.

% to % of current value: This sub-option
changes velocities similarly to the Change to %
of current value option described above. The
difference is that the percentage value changes from
the first to the second entered value: the first value
applies to the beginning of the region, the second
to the end. Enter a value from 1 to 999 in each box.
The curvature (see below) controls the contour of
the change.

to : This sub-option assigns the first
entered value to the first note velocity in the
selected region and the second entered value to the
last note velocity in the region. All other velocities
are calculated to make a smooth transition 

between the first and last ones. The curvature (see
below) controls the contour of the change over the
region.

Curvature: This sub-option controls the contour of
the smooth change. With a curvature of zero, the
change is linear from the first to the second entered
value. As you increase the value positively (with
values from 1 to 99), more of the change will take
place towards the end of the region. As you increase
the value negatively (with values from -1 to -99),
more of the change will take place towards the
beginning of the region.

Here are a few examples to clarify this option:

Figure 17-6: Change smoothly from 1 to 90, curvature 0. This results
in a linear increase. One effect of this is a gradual, even crescendo.

Figure 17-7: Change smoothly from 10 to 90, curvature -50. This
results in a pronounced upward curve with most of the changes
happening at the beginning. One effect of this is a crescendo that
occurs more rapidly at the beginning.
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Figure 17-8: Change smoothly from 96 to 5, curvature 45. This results
in a downward curve which is more pronounced at its end, e.g. a
diminuendo that speeds up toward its end.

Original velocities

120—j

100- I

80- I
60- VVvv*Yrv

40 =
20-
0-|___________________________________________ VTYVry

Changed smoothly from 100% to 1% with 0 curvature

Figure 17-9: Change smoothly from 100% to 1%, curvature 0. When
applied to a region in which there are several notes accented, this
results in a downward 'curve", which retains the accent structure of
the original.

The velocity values assigned to notes by this option
are calculated based on the distance of the note
from the beginning or end of the selected region. If
the first note in the region is after the start time, for
instance, it will be assigned a velocity value
somewhere between the values entered. Notes in a
chord (with simultaneous attacks) are assigned the
same velocity. If a specific change sounds too
abrupt, it is probably due to the position of the note
in the region. For instance, if notes occur at
irregular times (e.g. bunched together followed by
a sparse section), velocities will be assigned on the
basis of note placement. The result may not seem
smooth on a per-note basis.
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Randomize
The randomize option allows you to randomize the
velocities within a range of the current value, which
you specify in the box provided. The emphasis sub­
option causes the tendency of the randomization
to be higher or lower within the specified range.
Thus, if you wish to randomize the velocities
within a certain range, but you wish them to tend
to be higher, use a positive emphasis; use a negative
emphasis if you wish them to tend to be towards
the lower end of the range. A value of zero equals
no emphasis, which causes the randomization to
occur evenly within the range.

Note that the randomize option is a check box,
which means that it can be selected together with
one of the radio button options above. This allows
you to randomize at the same time as executing
one of the other Change Velocity options.

The Effect of Velocity Is Synthesizer-dependent
Synthesizers vary widely in their response to
velocity information. Some do not respond at all to
any velocity information; most do not respond to
off velocities. Some patches sound very different
when large on velocity values are used. Some
patches do not respond at all to velocity
information, even when the synthesizer as a whole
does.

Most often, you can be assured that if your
synthesizer does respond to velocity information,
you can control the loudness of note events. You
should be able to create effective crescendos and
diminuendos. This will work well for short-range
dynamic effects. For longer effects (a 30 second
fade, for instance), you might notice a “staircase”
effect, i.e. discrete changes in the volume level.

Alternative Methods for Volume Changes
Some synthesizers define one of the MIDI
controllers as the volume control. If so, you might
be able to use the Create Continuous Data
command to create smooth volume changes with a
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controller. Some synthesizers have only a few
discrete volume levels, making it hard to create
smooth changes. Consult the Hints in the Event List
Window section for details about determining the
limits of the controller values on your instrument.

It is also possible with some synthesizers to control
volume directly from an assignable controller. A
patch may use the breath controller to control its
volume, for instance. By sending this controller
data through Performer, you can control volume
changes.

There is no single solution for making volume
changes effectively with every patch on every
instrument. You must find the best way for each
given situation and use the appropriate command
(Change Velocity or Create Continuous Data) to
create the kind of volume changes you want.

CHANGE DURATION
The Change Duration command modifies the
duration of all notes in the selected region without
changing the placement of attack times. This
means that the amount of time a note is “on” or
sounding can be changed without affecting its
actual rhythmic placement in relation to other
notes and events. The Change Duration command
is useful for changing the articulation or space
between notes. You can make note events sound
connected or separate in relation to each other, for
example. It also provides some useful utility
functions.

Basics
Duration is the length of a note, i.e. the time
between its attack and release. Durations are
specified in quarter notes and ticks (e.g. a half note
would be 2|000 or two quarter notes). A note must
have a duration of at least one tick (0|001).

A note’s duration may be misleading in some cases:
what you see might not be what you hear. The
actual duration of a note event is dependent upon 

242 | _______

the synthesizer and patch used. The attack and
release sent by Performer are equivalent to
manually pressing and releasing a key on the
synthesizer. Also, some synthesizers have a sustain
pedal that can be used to hold notes, extending the
effective duration of notes far beyond the time
when the release has been sent to the synthesizer.

Using Change Duration
To use Change Duration:

1 Select the region you wish to modify.

2 Choose Change Duration from the Region
menu.

A window appears.

57| £3| Change Duration

O Sgt all to [L~ IlOOOl

O A-IJl OIOOOI to all
O Sobtract | 010001 from all

O Limit to a range
from | 010001 to | oioool

O Change to | |S5 of current value

O Move releases to the closest attack
<t> Extend releases to the next attack

□ add no more than 1100 of current value
□ add no more than | 1100~0]

□ Randomize ® by| |% of current valve
O by ± I 0|060|
Emphasis |0 | (-9 to +9)

3 Choose the option you want by clicking in the
appropriate radio button.

You can only choose one option.

4 Enter the value required by the option.

Click on the box and type in the value.

5 Press Apply.

You can Undo and Redo the Change Duration
command.
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The following options are available:

Set all to
All durations in the selected region will be changed
to the entered value. The value entered must be
between 0|001 and 9999|999.

Add to all
The value entered will be added to all durations in
the selected region. The value entered must be
between 0|001 and 9999|999.

Subtract from all
The value entered will be subtracted from all
durations in the selected region. The value range is
0|001 and 99991999. Notes which would have a
duration of less than one tick after the subtraction
are given a duration of one tick.

Limit to a maximum
of
Any notes in the selected region which have a
duration greater than the value entered will be
assigned to that value. The value entered must be
between 0|001 and 9999|999.

Limit to a minimum of
Any notes in the selected region which have a
duration less than the value entered will be
assigned to that value. The value entered must be
between 0|001 and 9999|999.

Change to % of current value
The durations of notes in the selected region are
scaled by the entered percentage value. The relative
lengths of the notes are preserved and their overall
length is modified. The percentage value entered
must be between 1 and 999. To halve durations,
enter a percentage value of 50%; to double
durations, use 200%. Using this option may yield
more of the results you want than using the Add
to all option; durations are scaled proportionally
instead of uniformly lengthened. Try both to see
which you like best.

Move releases to the closest attack
The release of each note in the selected region is
modified to occur just before the attack of the
nearest note following it in time. The duration of
the note may increase or diminish depending on
when the next note occurs. If the next note occurs
before the release of the current one, the release of
the current note will be moved back in time,
making the duration shorter. If the next note
occurs after the release of the current one, the
release of the current one will be moved forward in
time, making the duration longer. If the note
release is after the end of the selected region, the
note is left unmodified. This option creates a legato
effect, where the notes follow each other smoothly
and without a gap.

Before

Move Releases to Closest Attack

After

Extend releases to the closest attack
The duration of each note in the selected region is
extended until it ends at the same time as the next
note begins. This is very similar to the Move
releases to the closest attack option but the
durations of all notes are guaranteed to increase
since the release is always moved forward in time.
Any notes which end after the last note in the
selected region begins are left unmodified.

This option creates a legato effect, where the notes
follow each other smoothly and without a gap.
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Extend Releases to closest Attack

Extend Releases sub-options
Use these sub-options to extend releases and still
preserve rests in a region. If both sub-options are
checked, each note in the region is analyzed and
the option that results in the smallest duration
increase is used. Try using these options after
quantizing attacks and releases to improve the
notational display of the notes. Doing so adjusts
the durations of notes that were not played in a
legato style. For best results, experiment with
different values. A good setting to start with is
100%.

Randomize
The randomize option allows you to randomize
durations within a range of the current duration,
which you specify in the box provided. This range
can be specified as a absolute number of ticks, or by
a percentage of the current duration. The emphasis
sub-option causes the tendency of the
randomization to be higher or lower within the
specified range. Thus, if you wish to randomize the
durations within a certain range, but you wish
them to tend to be longer, use a positive emphasis;
use a negative emphasis if you wish them to tend to
be shorter. A value of zero equals no emphasis,
which causes the randomization to occur evenly
within the range.

Note that the randomize option is a check box,
which means that it can be selected together with
one of the radio button options above. This allows
you to randomize at the same time as executing
one of the other Change Duration options.

Hints
Some drum machines cannot receive dense bursts
of MIDI data; they will often miss data altogether,
causing drop-outs and other perplexing problems.
Since the durations of drum machine events tend
to be very short, the note releases tend to follow the
attacks very quickly resulting in a very high data
density. A problem also arises with Step Record:
the release for each note is sent immediately before
the attack of the next note. One way to improve the
situation is to delay the note releases (most drum
machines ignore these anyway since their note
events have such short decays) by making the note
durations longer. Use the Change Duration
command to set the durations of these note events
to a value somewhere around 10 to 20 ticks.

The Change Duration command is very good for
adjusting the articulation of note events.
Rendering a passage legato or staccato is simple: for
a legato effect (each note releasing just before the
next one is attacked):

1 Select the region.

2 Choose Change Duration from the Region
menu.

3 Click on the Set all to__ option.

4 Enter a value of 1 tick (0|001) and press Apply.

This insures that durations are uniform for the next
step.

5 Choose Change Duration from the Region
menu.

6 Choose the Extend releases to the next attack
option and press the Apply button.

This is useful for removing any rests or gaps
between notes.
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For a staccato effect (each note releasing well before
the next, giving the passage a rhythmically sharp,
incisive character):

1 Select the region.

2 Choose Change Duration from the Region
menu.

3 Click on the Change to__ % of current value
option.

4 Enter a value of 50% and press the Apply button.

If you enter a part in Step Record, all durations will
be as long as specified, rendering a legato effect.
You can use the Change Duration command to add
the articulation you want to these parts.

SPLIT NOTES
The Split Notes command lets you selectively cut or
copy notes in the selected region. The selection is
based upon pitch, velocity and/or duration. This
means that only notes with specific pitches, ranges,
durations and velocities from the selected region
are cut or copied. For example, all notes between
A3 and C#3 with velocities greater than 100 and
with durations above a half note can be extracted
from a region. Here are some additional things you
can do with Split Notes:

■ Use an on-screen graphic keyboard to specify
the pitches of notes you wish to split. This
keyboard allows you to pick a non-contiguous
range of pitches for splitting.

■ Automatically Paste or Merge the split notes to a
pre-existing track.

■ Automatically create a new track and Paste the
split notes to it.

■ Automatically create a set of new tracks and
Paste the split notes to each track according to their
pitch.
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Split Notes can be used to split a drum track into
separate tracks, extract or double a melody line,
separate one keyboard part into two to segregate
right and left hand activity, pick out and double
accented or long tones, and much more. See the
hints at the end of this section for some unusual
effects using the Split Notes command.

Basics
Split Notes is a highly specialized version of the Cut
and Copy commands on the Edit menu. Only notes
in the selected region and with specific properties
are affected, other events are not affected. Each
note is tested to see if it meets the requirements you
specify, including velocity, pitch, and duration.
They are then placed in a destination you select,
such as the Clipboard or a new track. If cut, they
are removed from the selected region.

<•* The Split Notes window remembers the
settings you last chose.

To use Split Notes:

1 Select the region you wish to modify.

2 Choose Split Notes from the Region menu.

A window appears.

3 Choose the Cut or Copy option at the top.

This determines whether notes are cut (removed
from the originally selected region) or copied by
the Split Notes command.
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4 Choose a destination for the notes to be split.

You have several choices here. Select the Clipboard
option to place notes on the Clipboard (for the
purpose of pasting afterwards). Select the One
track option and select a track name from the pop­
up menu to send the notes to one existing track.
Select the One new track option and type in a name
or use the default name to send the notes to a new
track that will be added to the bottom of your
tracks list. Select the Separate tracks by pitch option
to remove the notes by pitch and place them into
new, individual tracks. Each new track will contain
the pitch name in parentheses after the track name.
The track name used for this option can be entered
in the One new track option text entry box above.
This last option is ideal for splitting up a drum
track into separate tracks.

5 Choose whether you would like the split notes to
be pasted at their destination, which replaces what
is already there, or merged together with what is
already there.

6 Choose one of the five pitch selection options.

These options are discussed in detail in the next
few sections.

7 Enter the data required by the option.

Type or play in the required values.

8 Click on the check box to the left of any desired
options.

You can select a combination of pitch, velocity and
duration options.

9 Press Apply.

You can Undo and Redo the Split Notes command.

You can enter pitch and velocity values directly
from your MIDI keyboard. The note you play will
be entered directly into the value box which
contains the flashing text cursor or is highlighted.

Cut or Copy
If you choose the Cut option, the Split Notes
command will place the selected notes on the
Clipboard and remove them from the selected
region. If you choose the Copy option, the Split
Notes command will place the selected notes on
the Clipboard without removing them from the
selected region.

All Notes
All notes will be cut or copied unless excluded by
velocity or duration selections. Use this mode
when you wish to cut or copy notes based solely on
velocity or duration criteria.

Range of Pitches
All notes between the two entered pitch values will
be cut or copied. The pitch range is inclusive (it
includes the two entered pitch values and all notes
between them). You must enter a pitch in each box
for this option.

Top notes
The specified number of notes from the top of each
chord are cut or copied. A chord is defined as two
or more notes which have the same attack times. If
single notes are encountered (i.e. not in chords),
they alone are copied to the Clipboard. It is useful
to use the DeFlam command on the Region menu
to make sure that attack times of all chords line up
before using this option. Enter the number of notes
to be cut or copied from the top of each chord in
the box for this option.

Bottom notes
This option is similar to Top notes except that
the notes are cut or copied from the bottom of each
chord.
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Select Notes
Click keys on the keyboard to select and deselect
specific pitches. Click Clear Keyboard to clear the
currently selected pitches on the keyboard. Use the
scroll bar and scroll arrows to select pitches that are
above or below those pitches which are currently
displayed. You can also play keys on your MIDI
keyboard (or other controller) to select and
deselect specific pitches.

The Select notes keyboard remembers the
selected notes even when those notes are scrolled to
the left or right and are not displaying. When you
open the dialog and want to select some pitches on
the keyboard and are not sure if there are selected
notes above or below the pitches that are currently
displayed, click Clear Keyboard to be sure that
notes that are not displayed are also not selected.

The following are velocity and duration options
that can be selected in addition to pitch options.

Durations
Notes in the selected region with durations within
the specified range are cut or copied. You must
enter two durations in the boxes from 0|001 to
99991999. The duration range is inclusive (it
includes the two entered duration values and all
those between them).

On velocities
This option, when selected, allows only notes with
the specified velocity range to be cut or copied
from the selected region. You must enter two
velocities (between 1 and 127) in the two boxes.
The velocity range is inclusive (it includes the two
entered values and all those between them).

Off velocities
This mode is similar to the On velocities mode
except that notes with off velocities in the specified
range are cut or copied.

Hints for Using Split Notes
The Split Notes command by itself is not always
completely useful: it can be used in conjunction
with other region commands and operations to
fully accomplish an editing task. We therefore have
included some effective ways to use the Split Notes
command as part of more complex operations.

Splitting up a drum part into separate tracks
You can use the Separate tracks by pitch option in
combination with the Select notes option to quickly
explode tracks such as drum parts into separate
tracks so that each pitch can be treated uniquely.
This is great for being able to shift, quantize and
otherwise edit a certain percussion instrument
without affecting others.

Using a Temporary Track
You can process data independently that is cut or
copied with the Split Notes by pasting it into
another track. You can perform various operations
on the data in the temporary track (transpose,
velocity editing, etc.), then merge it back into the
original track and delete the extra track.

Extracting a Lead Line
Extracting the lead line from a passage (perhaps
from block chords where the top notes of each
chord form a melody) can be easily done with the
Split Notes command. After the lead line is
separated from the chords, it can be modified
(doubled, accented or otherwise enhanced) in an
extra track.

To extract the lead line:

1 Select the region to extract the lead line from.

2 Choose Split Notes from the Region menu.

The window appears.

3 Choose the Cut option.
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This will remove the top note of each chord and
place it on the Clipboard.

4 Choose the “One new track” option and type in
a name for the new track to be created.

5 Click the radio button next to the Top notes
option.

6 Enter a value of 1 in the box for the option.

This specifies that only the top note of each chord
will be cut or copied.

7 Press Apply.

The new track now contains the lead line. You can
now use commands from the Region menu to
modify the lead line.

Enhancing a Lead Line
Once you have the lead line separated out, you can
change it in useful ways. Two suggested
enhancements are doubling it an octave higher and
increasing its velocity values. After you have made
the modifications, you can merge the enhanced
lead line back with the original material.

1 Extract the lead line as described above.

2 Select the extra track which contains only the
lead line.

3 Enter Start and End times in the Selection Bar of
the Tracks window that will contain all notes in the
lead line.

These should be the same ones used with Split
Notes above.

4 Choose a command from the Regions menu.

To double the lead line an octave higher, choose
Transpose. To give the lead line higher velocity
values, choose Change Velocity.

5 Choose the options and values you want for the
command and Press Apply.

For Transpose, enter an octave interval (C3 to C4).
For Change Velocity, choose the Add to all
option and enter a value to increase the velocities
by (try a value between 10 and 30).

6 Choose Copy from the Edit menu.

This puts the modified lead line on the Clipboard.

7 Select the original track from which you
extracted the lead line.

Click on the track name to select the track.

8 Choose Merge from the Edit menu.

The modified lead line is now part of the original
passage.

9 Select the extra track containing only the lead
line by clicking on it.

10 Choose Delete from the Tracks window mini­
menu.

This gets rid of the extra track.

The enhancement is now complete.

A variation on the operation to double the lead line
an octave higher is to double the bass line an octave
lower. Use the Bottom notes option and
transpose it down an octave with the Transpose
command.

Some variations on the operation to increase the
velocity values of the lead line are as follows:

Make the notes of the chords softer (by decreasing
their velocities) instead of the making the lead line
louder. This would involve modifying the notes of 
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the chords after you extracted the lead line from
them and merging the (unaltered) lead line back
with the modified chords.

Use the Change to___% of current value option in
the Change Velocity window rather than adding a
constant value to the lead line. This better
preserves the dynamic contour of the lead line.

Leave the lead line on a separate track and play it
back through another synthesizer as well as on the
synthesizer playing back the chords. This
highlights the lead line through timbral or tone
color means.

Doubling Accented Notes
This procedure allows you to split out only those
notes which have a higher velocity in order to
accent them.

1 Select the region containing the lead line.

2 Choose Split Notes from the Region menu.

The window appears.

3 Choose the Copy option.

This will place the selected notes on the Clipboard.

4 Choose the All notes option.

Click in the radio button next to the option.

5 Choose the On velocities option.

Enter a range of values that will separate out
accented notes in the region.

6 Press Apply.

7 Paste the Clipboard into a new track.

At this point, you can use other Region commands
(such as Transpose) to enhance the accented notes.
Alternatively, you can simply assign the track with
only the accented notes to be played back on a
separate channel by another synthesizer.

Dividing a Keyboard Part Into Its Right and Left
Hand Components
Sometimes, it is useful to be able to treat the left­
hand and right-hand parts of a keyboard track
separately. Performer does this automatically in the
QuickScribe notation window. If you want, you can
do it manually by following the earlier procedure
for extracting a lead line but use the Notes with
pitches between___and___ option. The pitches
you enter should correspond with the range of
either the right or left hand. Since this range is
rarely consistent, you will probably have to
organize your sequence into sections according to
one hand’s pitch range and use Split Notes on each
section. You can then add a new track and paste the
notes you’ve cut into it.

MIDI EFFECTS PLUG-INS
The MIDI Effects Plug-ins hierarchical menu
supplies “special effects” processing to your MIDI
tracks. These are plug-ins written by MOTU and
other third-party developers that can be applied to
your MIDI tracks in the same fashion as
Performer’s standard Region menu operations.

Region
Transpose... 89
Quantize...
Grooue Quantize... 3SG
Create Grooue...
Smort Quantize...
Humanize...
DeFlam...
Change Deloclty...
Change Duration...
Split Notes... 3€-
MIDI Etrects Plug-ins

Thin Continuous Data...
Create Continuous Data...
Change note...
Rea*-'

These first few effects are not
actually plug-ins.They are
special effects made available
as Region ope ratio ns.Theref ore,
you will not see them in
Performer's'Plug-ins'Folder.

Echo... J
Rrpegglote...
Tronspose...
Time Shirt...

Remoue Dupllcotes...

Figure 17- 10: MIDI Effects plug-ins in the Region menu.
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An open-architecture plug-in format
Plug-ins found in this sub-menu are not actually
part of Performer itself. Instead, they reside in the
Plug-ins Folder that is located in the same Folder as
Performer on your hard drive. If you download a
plug-in from our web site or receive one on disk
from a friend, just place it in the Plug-ins Folder
and restart Performer. Just remember, it has to be a
specially programmed plug-in written specifically
for Performer. Performer’s MIDI plug-in format is
an open architecture, and our developer kit is
available to any third party who expresses a serious
desire to write plug-ins for Performer. Contact
Mark of the Unicorn if you are interested.

Using MIDI Effects plug-ins
MIDI Effects plug-in windows look very similar to
Performer’s other Region menu commands. In
fact, some — like the Transpose and Shift plug-ins
— are virtually identical to Performer’s
corresponding Region and Edit menu commands,
at least for now. In future versions, they may be
enhanced in ways that go beyond Performer’s
regular Region menu commands.

Num Repeats: I 4 Decay: I 2

□ Cycle through device group assignments

Rhythm

<t) Grid
O Custom
O Rav Ticks

□ Preview

J J JEJ Jo»|.
m iho ttrrrf of [~2~

□ Offset grid by I 0 ' ticks

Feedback Transpose
® Transpose b
O Harmonize

Transpose from

Figure 17-11: Examples of Performer's MIDI effects plug-ins.

Apply the MIDI effects plug-ins in the same
fashion as other Region menu commands.

For details regarding the options in the Transpose
plug-in window, see “Transpose” on page 227.

For details regarding the options in the Shift plug­
in, see “Shift” on page 223.

For details regarding the options in the Echo and
Arpeggiate effects, see “Echo and Arpeggiator” on
page 130.

Previewing
MIDI Effects plug-ins provide real-time
previewing, which allows you to hear the results of
the effects in real time, as the sequence plays,
before you actually apply the effect permanently
with the Apply button. To preview, check the
Preview check box in the plug-in window.

The MIDI effects plug-in window mini-menu
MIDI Effect plug-in windows have a mini-menu
with the same three choices discussed in
“Choosing What Happens When You Apply Region
Commands” on page 227. They also contain the
following addition menu items:

Preview stays on when window not in front:
Causes the previewing to continue (before actually
applying the effect) even when the window is not in
front.

Save/Edit settings: Allows you to name and save
the current settings in the effects window. The Edit
Settings command lets you rename, delete and
reorder saved settings.

Real-time processing
MIDI Effects plug-ins can also be written to
support Performer’s real-time MIDI effects
processing in the Mixing Board. If the plug-in
supports real-time processing, it will automatically
appear in the effects inserts of MIDI tracks in the
Mixing Board window. If the plug-in appears in the
Region menu, but not in the Mixing Board inserts,
then it doesn’t support real-time operation.
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CAPTURING REAL-TIME MIDI EFFECTS
The Capture Real Time MIDI Effects command in
the Region menu lets you “print” any real-time
MIDI effects processing that is currently applied to
the track via the effects inserts in the Mixing Board
window. Performer cuts the original data from the
track, runs it through the processing currently
applied to the track, and then writes the data back
to the track in its processed form.

While real-time effects operate on the entire track
as it plays, this command allows you to apply
effects to certain portions of a track.

This command is also useful when you want to
tweak a real-time effect in ways that are not
possible with the effect’s controls. For example, you
might have an arpeggiator effect applied to a track,
and you might want to tweak individual note
velocities of the notes it is generating. The Capture
Real Time MIDI Effects command writes all of the
notes permanently to the track so that you can edit
them in the usual fashion.

To capture real time MIDI effects:

1 Select any portion of a track that has real time
effects applied to it via its insert menus in the
Mixing Board.

2 Choose Capture Real Time MIDI Effects from
the Region menu.

The Print MIDI effects dialog appears.

This commv.d c*plur«s the results of the insUlhd
MIDI effects Lg replacing the selected diti vtth the
effected output

Unless you choose to Lyptss the effects efter
printing, you will heer tl-?tr influence epplted twice
when you listen •« the selected muslo.

Ill Bypass effects after printing

(11 Exp tnd loops

Figure 17-12: Capturing real-time MIDI effects.

3 Set the options as desired and click OK.

Bypassing the original real-time effect after
capturing
When you capture a real-time effect, you’ll most
often want to bypass the original real-time effect
immediately afterwards. Otherwise, you’ll hear the
effect applied twice to your original data: once
from the newly processed data generated in the
track and again by the real-time effect.

For your convenience, a check box is provided in
the Print MIDI Effects dialog box as shown in
Figure 17-12 to do this automatically for you.

Once the effect is bypassed, you can either remove
it entirely (since you may no longer need it), or
leave it bypassed if you think you might want to
apply it again later — or to another portion of the
same track.

Expanding loops
This option, when checked, makes Performer turn
loops into actual data. For example, if you have a
two-bar loop repeating 10 times, Performer will
remove the loop and paste the two bars of data ten
times in a row. The result sounds the same as if the
loop was still there; the only difference is that the
actual data is repeated for each iteration stipulated
by the original loop.

<•“ When you use this option, data that used to be
overridden by the loop (data that appeared in
italics in the event list) will be removed and
replaced by the expanded loop data.

If you are capturing real time MIDI effects on a
track that contains loops, it is usually a good idea to
check this option because if you don’t, the loop will
probably “override” at least some of the captured
data. In other words, the captured data will appear
in italics and not play because it is being
overridden by the loop and its data.
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chapter 18 IRe^non Commands 2

See the following important sections before
reviewing this chapter:

■ “Editing During Playback” on page I'Ll

■ “Selecting a Region” on page 227

■ “Region Commands Are Windows That Can
Stay Open” on page 227

THE CONTINUOUS DATA COMMANDS
Continuous data is data which changes smoothly
over time. Continuous MIDI data types include
pitch bend, mono and poly key pressure and
controller information. These types of data are
output rather quickly, resulting in a large amount
of data. Continuous data events are closely spaced,
each specifying a slightly different value for the
parameter which is changing. For instance, when
you move a pitch wheel, a different pitch bend
value might be sent every 20 ticks, resulting in 120
continuous data events per quarter note.

Continuous data is not really continuous at all: it is
approximated by large numbers of events, each of
which contain a small value change. When played
back, they create a change that seems smooth and
continuous. The closer together in time successive
values are, the smoother the change will be. If the
values are too close together, delays can occur due
to the baud rate (data transfer speed) limit of MIDI
transmission.

There are 16,384 different pitch bend values and
128 different controller and aftertouch values.
Some synthesizers do not respond to every
different pitch bend value: several successive values
may produce the same effect. The response to
different controller values may also be hard to hear.

These facts may influence your decision about how
many continuous data events to store. Performer
gives you the option to decrease or increase the
number of continuous data events in a region.

Types of Continuous Data
The continuous data commands require you to
specify the type of continuous data to be modified.
The following is a description of the different types
of continuous data and how they are produced.

Pitch Bend: On most synthesizers, this is
controlled by a wheel, joystick or ribbon controller.
When moved, it “bends” or varies the pitch either
up or down depending on the direction of
movement. Pitch bend data indicates the
movement of the pitch bend device; it does not
necessarily correspond to a musical interval. When
played back, this data controls the sound module’s
pitch bend device. Most synthesizers allow you to
specify the interval by which a maximum pitch
bend value will alter a pitch. Thus, moving the
pitch bend device to its extreme high position can
could cause a pitch to be raised by an octave, a fifth
or any other interval. All other pitch bend values
are scaled according to the interval the maximum
value produces.

Mono key pressure: Also known as aftertouch or
channel pressure, this is a special kind of controller,
which sends out values between zero and 127. If
you continue to press down a key after you play a
note, mono key pressure information is sent. The
harder you press, the higher the value. Mono key
pressure is useful for things like changing the tone
quality of a sound or controlling the amount and
depth of vibrato.



Poly key pressure: This is similar to mono key
pressure except that each key can generate its own
pressure information, instead of one pressure level
for the whole instrument based on the key most
recently pressed. Poly key pressure therefore allows
for much more subtle and complicated aftertouch
effects. Since each key can have its own set of key
pressure data, you must specify the note name by
entering a pitch value when using the Poly key
pressure option in the continuous data commands.
You can enter the pitch directly from your MIDI
keyboard. If you don’t specify a pitch, all keys will
be affected by the command.

Controller: Foot pedals, wheels, sliders and breath
controllers are common types of controller

. devices. Controllers are general purpose messages
used to control such effects as vibrato and tremolo.
They are identified by number; the number
assigned to a specific controller depends on the
synthesizer you are using. Continuous controllers
(such as wheels and sliders) are generally
numbered in the range zero to 63. Switch
controllers (on-off types like a sustain pedal) use
higher numbers. Synthesizers will often respond to
more controllers than they have physical controls
for.

When using the continuous data commands on
controller messages, you must specify the number
of the controller whose data you wish to modify.
This can be done by clicking in the box next to the
controllers option and moving the correct
controller on your MIDI input keyboard.

THIN CONTINUOUS DATA
Synthesizers tend to send continuous data as fast as
they possibly can. If you record several tracks of
this and play them all back at once, Performer, your
synthesizers, or MIDI itself may bog down. The
Thin Continuous Data command selectively
removes continuous data events,“thinning out” the
amount of continuous data while retaining all of its
essential characteristics. This allows you to 
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transmit a reasonable amount of continuous data
that can be handled easily by all components of
your MIDI system.

Basics
The Thin Continuous Data command actually
determines the contour of the continuous data in
the selected region. The continuous data in this
region is erased and new continuous data is
generated. This new data is more sparse, recon­
structing the analyzed contour with fewer events.
Unless musically necessary, successive continuous
data events will not occur closer together than the
minimum time change and will not differ in value
from adjacent events by less than the minimum
value change.

Since the continuous data is regenerated, it is
possible that this command will thicken the data
instead of thinning it. You may find this aspect of
the command useful if you have thinned out the
data too much.

The appropriate minimum time change depends
on the tempo of the sequence and the controller
device involved. Generally, a value of 10 to 20 will
work well. The minimum value change should be 1
for controllers and 4 to 8 for pitch bend. Experi­
mentation is essential to find the best values in each
instance.

Using Thin Continuous Data
To use Thin Continuous Data:

1 Select the region you wish to modify.

2 Choose Thin Continuous Data from the Region
menu.

A window appears.

REGION COMMANDS 2



3 Choose the type of data you wish to thin out.

Click in the radio button next to the type you want:
Pitch Bend, Mono Key Pressure, Poly Key Pressure
or Controller. See “Types of Continuous Data” on
page 253 for an explanation of each type.

4 Specify a minimum time change.

Click in the box for this parameter and type in a
value between zero and 999.

5 Specify a minimum value change.

Click in the box for this parameter and type in a
value.

6 Press the Apply.

You can Undo and Redo the Thin Continuous Data
command.

After you apply this command, it may take some
time to carry out the change. If you wish to
terminate the command while it is working, press
the Command and period keys together.

CREATE CONTINUOUS DATA
The Create Continuous Data command creates a
stream of continuous data events that change
smoothly over time. You can use it to create pitch
bends, crescendos and diminuendos, filter sweeps
and many other effects.

Basics
This command creates continuous data events that
change smoothly between the starting and ending
values. All values must be within the range zero to
127, except for pitch bend data which is in the
range -8192 to 8191.

The contour of the changing values is controlled by
the curvature parameter. It allows you to “weight”
the change. With a curvature of zero, the change is
linear from the first to the second entered value.
The more you increase the value positively (with
values from 1 to 99), the more the change will take
place towards the end of the region. The more you
increase the value negatively (with values from -1
to -99), the more the change will take place towards
the beginning of the region.

The number of events generated are controlled by
the minimum time change and the minimum value
specified: all events created will not be any closer
together than the minimum time change and they
won’t be separated by values smaller than the
minimum value change. Though Performer can
create a perfecdy smooth set of values, the actual
result may not be perfectly smooth due to the
minimum time and value changes you enter.
Experimentation is the key to good results.

You can Undo and Redo the Create Continuous
Data command.

Using Create Continuous Data
To use Create Continuous Data:

1 Select the region you wish to modify.

2 Choose Create Continuous Data from the
Region menu.

A window appears.
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5/|zj| Create Continuous Data

*» Pilch bend
O ± Mw» pressure

O A Controller | |
O if Poly pressure [c-2 |

Change smoothly fromfo ~1 tojo

Curvature (0 to ±39)
I linimum value ch jnye
Minimum twt- change:

□ Randomize by ± I I

Fmphasfs |O | (-9 to *9)

3 Choose the type of data you wish to create.

Click in the radio button next to the type you want:
Pitch Bend, Mono Key Pressure, Poly Key Pressure
or Controller. See “Types of Continuous Data” on
page 253 for an explanation of each type.

4 Specify start and end values for the data.

The data created will have values ranging smoothly
between the start and end values.

5 Specify a minimum time change.

Click in the box for this parameter and type in a
value between zero and 999.

6 Specify a minimum value change.

Click in the box for this parameter and type in a
value between zero and 127.

7 Press the Apply button.

After you apply this command, it may take some
time to carry out the change. If you wish to
terminate the command while it is working, press
the Command and period keys together.

Data created by the Create Continuous Data
command will replace existing controller data of
the same type.

See “Basics” on page 254 command above for
suggestions on setting the minimum time and
value change parameters.

Using the Randomize Option
The Randomize option allows you to generate
variability in continuous data that you create, as
opposed to a perfectly smooth line or curve. Doing
so can introduce extra feel and depth to the musical
effect you are creating with the continuous data.

Notice that the Randomize option is a check box,
which means that it can be used with any of the
radio button options above. Check the box to
randomize; uncheck it for no randomization.

When this command randomizes, it chooses
random values within the range that you specify.
Each continuous data event is first generated by the
rest of the parameters above, and then the event’s
value is randomized within the range you specify
in the range box. The result is a curve or line that is
not perfectly straight:

Figure 18-1: Here is a continuous data curve without randomization
(above) and with a randomization of ±5 (below).

The Emphasis sub-option causes the tendency of
the randomization to be higher or lower within the
specified range. Thus, if you wish to randomize the
continuous data events within a certain range, but
you wish them to tend to be higher, use a positive
emphasis; use a negative emphasis if you wish them 
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to tend to be towards the lower end of the range. A
value of zero equals no emphasis, which causes the
randomization to occur evenly within the range.

6 If you would like to randomize the data, check
the Randomize check box and enter a
Randomization range and emphasis.

CHANGE CONTINUOUS DATA
With the Change Continuous Data command, you
can modify existing continuous data by scaling it
or limiting it to a specific range.

Using Change Continuous Data
To use Change Continuous Data:

1 Select the region you wish to modify.

2 Choose Change Continuous Data from the
Region menu.

A window appears.

S7|a| Change Continuous Data

® - Fb'th btnd
O ± Mono pressure

O A Controller | |
O !i Poly pressure | |

® | | to oil volues
O Limit to o ronge

from | | to | |
O Change to | |$5 of current value

 R jndomfce by ± | |
Emphasis: | | (-9 to +9)

3 Choose the type of data you wish to change.

Click in the radio button next to the type you want:
Pitch Bend, Mono Key Pressure, Poly Key Pressure
or Controller. See “Types of Continuous Data” on
page 253 for an explanation of each type. Only the
type of data you select will be changed.

4 Choose the change option you want.

5 Enter the value required by the option.

Click in the box for the option and type in the value
you want. You may select only one option.

For more information about these randomization
options, see “Using the Randomize Option” on
page 256, as this option works the same as the
Randomize option in the Create Continuous data
command, except that it changes existing data
rather than newly created data.

7 Press the Apply button.

You can Undo and Redo the Change Continuous
Data command.

Add to all values
The entered value is added to all continuous data in
the selected region. Enter a positive number if you
wish to increase the values in the region or a
negative number if you wish to decrease them. If a
value exceeds the limit of its data type, it will be
truncated at the limit value (e.g. if a pitch bend
value comes out to -10,150, it will become -8192,
the minimum limit for pitch bend values).

Limit to a maximum of
Events in the selected region whose values are
greater than the entered value are changed to the
maximum value.

Limit to a minimum of
Events in the selected region whose values are less
than the entered value are changed to the
minimum value.

Set to % of current value
The values of all events in the selected region are
scaled by the entered percentage value. Thus,
specifying 50% halves the values, while 200%
doubles the values. If a value exceeds the limit of
the its data type, it will be truncated at the limit
value (e.g. if a pitch bend value comes out to
-10,150, it will become -8192, the minimum limit
for pitch bend values).
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REASSIGN CONTINUOUS DATA
With the Reassign Continuous Data command you
can convert one type of continuous data into
another. For example, you can convert pitch bend
data into modulation wheel data. This command is
very useful for changing the controller number of
continuous data when playing back a sequence on
a different synthesizer than the one it was recorded
with.

Using Reassign Continuous Data
To use Reassign Continuous Data:

1 Select the region you wish to modify.

2 Choose Reassign Continuous Data from the
Region menu.

A window appears.

S7|£!| , Reassign Continuous Data

® Change O Copy

** Pitch bend O A Controller I |
O ± Mono pressure O HPoly pressure) |

------------- to -------------

© •» Pitch bend O Jk Controller) |
O ± Mono pressure O 11 Poly pressure |C-2 |

3 Choose either the Change or Copy option.

Click in the radio button next to the option. The
Change option changes data from one type to
another. The Copy option makes a copy of the data
in the same track of the new type you specify.

4 Enter the type of continuous data to be changed.

Click on the appropriate radio button.

5 Enter the type of continuous data you wish it to
be changed to.

Click on the appropriate radio button.

6 Press Apply.

You can Undo and Redo the Reassign Continuous
Data command.

INVERT PITCH
The Invert Pitch command inverts or flips notes
around a specified axis. The inversion is chromatic,
that is, exact. For example, if the following E major
scale (starting on E3),

Track-1

is inverted around an axis of D3, the following will
result:

Basics
Inversion is an operation in which the interval
between a note and the inversion axis pitch is
measured and the note is transposed the same
interval on the opposite side of the axis pitch. Two
examples are shown below: If the note to be
inverted is F4 and the axis pitch is C4, the interval
between them is a perfect fourth. Since F4 is above
C4, it will be transposed down by the same
interval, a perfect fourth, resulting in a G3. If the
note to be inverted is C#3 and the axis pitch is A3,
the resulting pitch would be F4. In the following
picture, the axis pitch in each measure is
represented by a diamond:
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The inversion is always exact, transposing the note
the same chromatic interval above or below the
axis pitch.

Using Invert Pitch
To use Invert Pitch:

1 Select the region to be inverted.

2 Select Invert Pitch from the Region menu.

A window appears.

3 Enter the axis pitch for the inversion.

You can use your MIDI keyboard for input. This is
the center pitch around which the inversion will
take place.

4 Press Apply.

Hints
You can invert a region of notes around a pair of
axis pitches. Follow the above procedure for
normal inversion specifying the lower of the two
pitches in the Invert Pitch window. Then use the
Transpose command on the Region menu to
transpose the region by the interval between the
two axis pitches.

Example: You wish to transpose the following
passage around the axis pitch pair C3 and E flat 3.

Use Invert Pitch on the passage specifying C3. The
following is the result:

Select the region containing the passage and use
the Transpose command on the Region menu
transposing from C3 to E flat 3 (a minor third, the
interval between the two axis pitches).

This is the final result, inverted correctly around
the pair of axis pitches:

REVERSETIME AND RETROGRADE
The Reverse Time and Retrograde commands
reverse the order of events in a selected region.
However, each command reverses notes in a
slightly different way, producing much different
results.

Reverse Time
Reverse Time reverses the order of notes’ attack
times in a region. A note whose attack occurs two
beats from the beginning of the region is moved so
that its attack occurs two beats before the end of the
region. In doing so, Performer either maintains the
note’s duration or ends the duration just before the
next attack. Notice in the example below that
Reverse Time places the attack of the first note
exactly at the end of the region, extending the
duration into the next bar.

Retrograde
Retrograde inversion simply reverses the order of
notes within the region: the first note becomes the
last note, the last note becomes the first note, and
so on. This is analogous to playing a tape
backwards and recording the result.

REGION COMMANDS 2
J 259



Note: for clarity, we have shortened the
durations in the Reverse Time example so that they
don’t extend beyond the next attack. In actuality,
the notes maintain their original durations after
being reversed.

To get an exact reversal of the notes, you must
select a region of time rather than specific events. In
addition, the region of time must include the
duration of the last note in the region. In the
example above, the last note is the sixteenth note,
G4. To obtain the results shown on the bottom
staff, you would have to select the region from
1111000 to 2| 11000, where 2| 1|000 takes into
account the duration of the G4 sixteenth note.

To specify a region of time that includes the final
duration, select the region using the Selection Bar
in the Tracks window, or by dragging in the Time
Ruler of the Graphic Editing window or Tracks
Overview. Selecting specific events won’t work
because the duration of the final note is not
included. (For example, if you selected the original
phrase above in the Event List, the end of the region
would be 1 |4|361instead of 2|11000.

Using Reverse Time
To use Reverse Time:

1 Select the region you wish to modify.

2 Choose Reverse Time from the Region menu.

You can Undo and Redo the Reverse Time
command.

Using Retrograde
When using the Retrograde command, you must
select a region using the Selection Bar in the Tracks
window. The Retrograde command will have no
effect on data that has been highlighted in an Event
Editing window.

1 Select the region you wish to modify.

“Selecting a Time Range” on page 207 and “Edit
Commands That Require Time Range Selection”
on page 207 for details.

2 Choose Retrograde from the Region menu.

You can Undo and Redo the Retrograde command.

SCALE TIME
The Scale Time command expands or compresses
the duration of events in the selected region by the
specified ratio. This effectively changes the
distance between notes, making them closer
together or farther apart. Since the actual duration
of events changes, the region will become smaller
or larger after this command is invoked.

Basics
Scaling time allows you to double, halve or
otherwise alter the amount of time an event takes.
A wide range of compression or expansion of the
duration of events is possible. The amount of
change to the selected durations is specified by an
integer ratio, e.g. 3:2. If the first number in the ratio
is larger than the second, the region is expanded; if
the first number is smaller than the second, the
region is compressed. A ratio of 2:1 doubles the
duration of all events in the region (and doubles
the length of the entire region as well); a ratio of 1:2
halves the duration of all events in the region.

Events at the Start time of the region will remain in
place. Since the overall length of the region
changes, events at the end will be moved. If the end
of the region expands, events in it will be merged
with data already there.
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Original selected region:

777777A V7/7777

Scale Time cuts the selected region...

I__  ____ I
r//z/zz3 tzzzzzz\

.. .and then compressesand merges.

Y7777777 1

-Blank space

7777777

...or expands and merges.

7777777

Mixed music

V777)
All MIDI data events are scaled. The Scale Time
command does not affect loops or any event in the
Conductor track.

Using ScaleTime
To use Scale Time:

1 Select the region you wish to modify.

2 Choose Scale Time from the Region menu.

A window appears.

V|a| . .. . ,*?» Scale Time

Scale time by a factor of:
iznt°nn

(I to 2 = compress to half as long)
(2 to 1 b expand to twice as long)

3 Enter the ratio values.

The values must be between 1 and 99.

4 Press the Apply.

Examples
Here are three examples to give you a better idea of
the use of Scale Time:

Touve entered a melody in eighths but decided it
would sound better in sixteenths. Select the region
of the melody and use Scale Time with a ratio of
1:2.

Your sequence is in 4/4 time with lots of triplets, and
you want to modify it to be in 12/8, converting the
triplets to regular eighths. Select the entire
sequence. Use Scale Time with a ratio of 3:2.
Afterwards, change the meter and tempo appropri­
ately.

You've entered a melodic idea in quarter notes and
decide that it should actually be the bass line for the
sequence — and all notes should be whole notes.
Select the region with the melody and use Scale
Time with a ratio of 4:1. Then transpose it down to
the correct octave.

SCALE TEMPO
The scale tempo command provides several ways
to modify existing tempos within a selected region
in the Conductor track of a sequence or song. It
modifies existing tempo events within the region,
but it does not generate new tempo events. (To do
so, use the Change Tempo command in the Change
menu.) The Scale Tempo command is ideal for
making global changes to an existing tempo map
that you have already created with the Change
Tempo command. For example, you might have
created an elaborate tempo map with many tempo
nuances, and you would like to increase the overall
tempo while maintaining the nuances.
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Selecting a Region to Scale
The Scale Tempo command requires that you select
the tempo events you wish to scale in the
Conductor track before you select the command
from the Region menu.

*■ Note that the Scale Tempo command only
affects tempo events that already exist in the
Conductor track. If the region you select has no
tempo events in it, this command will have no
effect. If so, use the Change Tempo command in
the Change menu to generate tempo events.

There are several ways to select a region in the
Conductor track. For more information, see
chapter 15,“Selecting”.

Once you have selected the tempo events you wish
to scale:

1 Choose Scale Tempo from the Region menu.

2 Select the desired scaling option.

Each scaling option is discussed below.

3 Click Apply.

Add bpm to all tempos
This option adds the number of beats per minute
(bpm) you enter to each tempo event within the
selected region.

Subtract bpm from all tempos
This option subtracts the number of beats per
minute (bpm) you enter from each tempo event
within the selected region.

Limit to a range from to
This option searches for tempo events above or
below the specified range. When it finds one, it
changes the tempo to fall within the range. For
example, if the tempo range is from 200 to 300, a
tempo of 351 would be changed to 300 and a tempo
of 60 would be changed to 200.

Change to % of current value
This option increases or decreases each tempo
event by a percent of its current value, where the
current value is 100%. Use a percentage lower than
100% to slow down the tempo; use a value above
100% to raise it. Use this option when you wish to
maintain the degree of change between tempos
within the tempo map when you raise or lower it.

Change overall tempo from to and
scale accordingly
This option scales the tempo events by a
percentage, just like the option above it. However,
it lets you specify the change in beats per minute
(bpm) rather than as a percentage. For example,
suppose you have a piece of music with varying
tempos, but whose approximate tempo is 80 bpm.
You simply wish to change it’s overall tempo from
around 80 bpm to around 96 bpm. Rather than
figuring out what percent to type in the percentage
option to achieve this change, you can use this
option to type in the original approximate tempo
of 80 bpm and the desired increased tempo of 96
bpm, and let Performer figure out the percent
increase for you. All in all, this option provides a
more musical way of specifying a percent by which 
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you wish to scale the tempos, even though it
accomplishes the same thing as the “scale by
percent” option.

Scale all tempos to fit new end time
This option scales all existing tempo events to
increase or decrease the overall elapsed time of the
selected region. The start time of the region is
fixed, and the end time can be made earlier or later.
Times can be expressed in real time or SMPTE
frame time. Here is an example: suppose that you
have created a sequence with many tempo changes,
and it is around 3 minutes long. But you would like
to make it 3 and a half minutes long. This option
lets you select the three minute region and scale all
the tempos so that it stretches out evenly to 3 1/2
minutes.

Here’s another example: suppose you are locking a
sequence to picture via SMPTE time code. You
have composed a section of music, and you’ve
programmed all of the tempo changes. You’ve got
the section starting at the correct frame time, but it
ends with a hit that is off by several frames. With
the Scale all tempos to fit new end time option, you
can select the region with the hit as the end time of
the region and type in the new end time where the
hit should occur. This changes the elapsed time
such that the hit lands at the correct frame.

Randomize
The randomize option is a check box option that
works in conjunction with the radio button option
selected above.

By___% of current value
This option randomizes the tempo of each selected
tempo event within a range that is expressed as a
percentage of the tempo value. For example, if the
tempo is 100 bpm, and you enter 10 percent, the
tempo will be randomized within a range between
90 to 110 bpm (±10 bpm).

By ±bpm
This option randomizes the tempo of each selected
tempo event within a range of beats per minute.

Emphasis
This sub-option causes the tendency of the
randomization to be higher or lower within the
specified range. Thus, if you wish to randomize the
tempos within a certain range, but you wish them
to tend to be higher, use a positive emphasis; use a
negative emphasis if you wish them to tend to be
towards the lower end of the range. A value of zero
equals no emphasis, which causes the
randomization to occur evenly within the range.
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chapter 19 Transpose

Performer’s Transpose command, found in the
Region menu, transposes the pitches of all notes in
a selected region. With it you can:

■ transpose by interval

■ transpose diatonically to create harmonies

■ change key from any root to any other

■ change key from any mode to any other

■ map each pitch to any other pitch

■ transpose using scale sizes larger or smaller than
12 notes

■ transpose up or down, by any number of octaves

■ create and save custom transpose maps

■ create and save custom scales or keys

■ Create harmonies

When performing the above operations, you can:

■ play in pitches or entire scales from your MIDI
keyboard when setting up the transposition

■ Undo and Redo the Transpose command

See the following important sections before
reviewing this chapter:

■ “Editing During Playback” on page 217

■ chapter 15,“Selecting” (page 207)

■ “Region Commands Are Windows That Can
Stay Open” on page 227

QUICK REFERENCE
The Transpose window provides several ways of
transposing, options for each type, a Transpose
Map that shows you how each pitch will be
changed, and a Custom Maps list which can save
transposition maps.

This area presents options for the type of
transposition chosen to the left.

Once you have set up a transposition, you can
save it by typing in a name and clicking Save; it
will then appear in the list.You can use the trans­
position map at any time by clicking its name.

Create your own types of
scales with the custom
scales button.

The Transpose Map changes dynamically to reflect the trans­
position or custom map you have chosen to the left. You can
pop-edit pitches in the To column to create a custom map.
Changes in one octave are reflected in all other octaves.



The Transpose Map is discussed next, and the four
types of transposition are described in following
sections.

Harmonizing instead of Transposing
The Transpose window allows you to either
transpose or harmonize. The Harmonize option
copies the original notes, transposes the copied
notes, and the merges them together with the
original notes. This allows you to build harmonies
quickly.

TheTranspose Map
The Transpose Map displays a scrolling list of all
128 MIDI notes in a column on the left and the
pitch to which each will be transposed in a column
on the right. Notes and spellings in the map change
dynamically according to the transposition
options that you choose. In addition, you can pop­
edit values directly in the Transpose Map list as
shown below to further modify the map. Changes
in one octave are reflected in all other octaves.

Changes in each octave
are reflected in all

•other octaves as well.
Transpose

View other octaves by
using the scroll bar.

When the Diatonic or
Scale/Key transpose
option is selected, ,
scale steps in the
source key are
displayed in boldface.

You can customize the
transposition by pop­
editing destination
pitches to change
them.Usetheup/down
arrow keys to scroll
through the list.You can
play pitches in the pop­
up box from your MIDI
keyboard.

* ■„ Transpose

C3 C3 a
Db3
D3
Eb3
E3
F3

Db3
D3
Eb3
£3___
[F3 ’

F«3 Fu3
kG3 G3
Ab3
A3
Bb3

i D3

Ab3
A3
Bb3
B3

C4 C4

As soon as you pop-edit a pitch in the Transpose
Map, thus modifying it from they way it was
originally set up by the transpose options, the
Custom Map transpose option will then become
automatically selected to indicate that the
transpose map is now a custom map.

Playing In Pitches From Your MIDI Controller
When pop-editing the Transpose Map, you can
play in individual pitches or an entire scale from
your MIDI controller. To play in a scale, double­
click the first pitch to pop-edit it and then play the
scale. As you play, each pitch gets entered into the
current pop-up box, which then automatically
scrolls down to the next note in the list and enters
the next pitch you play. If you make a mistake, use
the up and down arrow keys to move the pop-edit
box.

When you are using the Custom Map option,
Performer provides another intuitive way for you
to play in pitches from your controller:

1 Select the Custom Map option.

2 Hold down the pitch you wish to transpose, and
while holding it down, play the pitch you wish to
transpose it to.

You DO NOT need to pop-edit any values to do
this.

Saving a Transpose Map
If you would like to save a transpose map, type in a
name for it and click Save as shown below. Custom
maps are saved with the file and can be loaded into
other files with the Load command in the File
menu.

') > Pelete)

Custom Maps
My map 2l
R8 to 04 map
Cross-octave
All notes to Bb3
C maj to C min

Cmi«r>m»pn»r.u: _________To save 3 transpose map, type in
| mu Transpose M»d a name and click Save.

Using Transpose Maps
To recall the map, select its name in the list. To
remove a Custom Map from the list, click its name
and click Delete.
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To make changes to an existing map:

1 Select the existing map in the list.

2 Make your changes to the Transpose Map.

3 Click Save.

The changes you made will be saved to the map.

To create a new map based on an existing map:

1 Select the existing map in the list.

2 Type in a new name.

3 Click Save.

The new map will appear in the list. 

4 Edit the Transpose Map to make your changes.

5 Click Save to save the changes you have made.

Transposing by Interval

Tr^ncpoie O Harrrwnfz*

® Interval
O Dtatonio
O Key/Scale
O Custom Map

from: |C3 | to: |F3 I

Transposing by Interval is chromatic, exact trans­
position: pitches are shifted by the number of
semitones in the interval that you choose. Literally,
it causes a mass shift of all pitch values in the
selected region, just like dragging notes up or down
in the Graphic Editing or QuickScribe notation
windows. For example, chromatically transposing
from C3 to E3 causes all pitches to shift up a major
third (four semitones).

The only option for this type of transposition is the
from and to pitches that define the interval. The
notes that you enter to define the interval are not

important: only the interval between them matters.
For example, instead of entering C3 to E3 to shift
notes up a major third, you could enter F3 to A3.

The two pitches entered also define the direction of
transposition. If the second pitch is above the first
pitch, pitches will be transposed up. If the second
pitch is below the first, pitches will be transposed
down.

Having chosen an interval, you can pop-edit the
transpose map to make modifications to it if you
like. As soon as you pop-edit a pitch in the
Transpose Map, thus modifying it from they way it
was originally set up by the Interval transpose
options, the Custom Map transpose option will
then become automatically selected to indicate that
the transpose map is now a custom map.

Transposing Diatonically

Diatonic transposition transposes notes by a
number of scale steps within the type of scale that
you choose. For example, if you transpose up 2
scale steps in the key of C minor as shown in the
above example, all C naturals (the root) will be
transposed up two steps to E flat (a minor third).
Notice that the number of scale degrees, 2 in this
example, refers to the number of scale steps to
change by; it does not refer to the destination scale
step.
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This is extremely useful for quickly creating
harmonies. For example, as shown above you can
copy and paste a melody line into another track
and transpose it diatonically up a third (two scales
degrees) to harmonize with the melody. Scale tones
in the key you choose are displayed in boldface in
the transpose map column.

To Transpose diatonically:

1 Choose the Diatonic option.

2 Choose the direction (Up or Down) and
number of octaves.

3 Type or play in the key root pitch and select a
mode from the list.

This sets up the Transpose Map. You can play in the
root pitch from your MIDI keyboard if you place
the insertion point in the From text box.

4 If you would like to transpose all non-scale
pitches into the nearest scale pitch, select the
Constrain to scale option.

5 If you would like to customize the transposition,
pop-edit values in the Transpose map.

As soon as you pop-edit a pitch in the Transpose
Map, thus modifying it from they way it was
originally set up by the Diatonic transpose options,
the Custom Map transpose option will then
become automatically selected to indicate that the
transpose map is now a custom map.

6 Click Apply.

The Up and Down options determine the direction
of transposition, and the Plus n octaves option
allows you to transpose by intervals greater than
one octave.

Remember that the key you choose is a way of
setting up the diatonic transposition in the
Transpose Map. Performer doesn’t really “know”
what key the actual data is in. In fact, just about any
musical phrase can be described in musical terms
as being in one of several different, but related,
keys. So, when transposing diatonically, it is up to
you to know which key to choose to get the results
that you want.

The above also holds true for how notes get spelled.
The key that you choose only affects the spellings in
the Transpose Map: it will not change the spellings
of the actual track data. Track note data spellings
are controlled by the current key signature in the
Conductor track.

The Constrain to Scale Option
The Constrain to scale option is available with the
Diatonic and Key/Scale transpose options. If
enabled, it causes all non-scale tones to be
transposed to the nearest appropriate scale tone, as
shown below:

□ Constrain to seile SI Constnin to scat?
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Transposing by Key/Scale

Transposing by Key/Scale transposes notes from
one key to another. For example, you can change
music that is currently in a major key to its
corresponding minor key. In the above example,
notes in the key of C major are being transposed
down to a entirely different root and key: E
Mixolydian. The Transpose Map shows each note
in the key of C Major on the left and the pitch each
will be transposed to in the key of Db Harmonic
Minor.

To Transpose by key:

1 Choose the Key/Scale option.

2 Choose the direction (Up or Down) and
number of octaves.

3 Type or play in the source key root pitch and
select a mode from the top list.

This sets up the From column in the Transpose
Map. You can play in the root pitch from your
MIDI keyboard if you place the insertion point in
the From text box.

4 Type or play in the destination key root pitch
and select a mode from the bottom list.

This sets up the To column in the Transpose Map.

5 If you would like to transpose all non-scale
pitches into the nearest scale pitch, select the
Constrain to scale option.

6 If you would like to customize the transposition,
pop-edit values in the Transpose map.

As soon as you pop-edit a pitch in the Transpose
Map, thus modifying it from they way it was
originally set up by the Key/Scale transpose
options, the Custom Map transpose option will
then become automatically selected to indicate that
the transpose map is now a custom map.

7 Click Apply.

The Up and Down options determine the direction
of transposition, and the Plus___octaves option
allows you to transpose by intervals greater than
one octave.

Remember that the source and destination keys
that you choose are a way of setting up the diatonic
transposition in the Transpose Map. Performer
doesn’t really “know” what key the actual data is in.
In fact, just about any musical phrase can be
described in musical terms as being in one of
several different, but related, keys. So, when
transposing by key, it is up to you to know which
key to choose to get the results that you want.

The above also holds true for how notes get spelled.
The key that you choose only affects the spellings in
the Transpose Map: it will not change the spellings
of the actual track data. Track note data spellings
are controlled by the current key signature in the
Conductor track.

Transposing Using a Custom Map
The Custom Map option allows you to do several
things. You can:

■ create a customized map that is based on one of
the other transpose options
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■ transpose using octave ranges other than 12
halftones

■ map each note to any other note

■ map all notes to a single pitch

Each of these operations are discussed below.

Custom Transposing Based on Another
Transposition
Often you may want to slightly modify a
transposition set up by one of the first three
transpose options. For example, you may want to
transpose diatonically up two scales steps except
for each A-flat, which you would like to maintain as
an A-flat. In this case, you can set up the Diatonic
transposition and then pop-edit the destination
pitch for A-flat so that it doesn’t change pitch.

To create a customized map that is based on the
Interval, Diatonic, or Key/Scale Transpose options:

1 Choose the Transpose option you would like to
base your custom map on.

Set up the parameters for the option as necessary.

2 To customize the transposition, pop-edit values
in the Transpose map as needed.

As soon as you pop-edit a pitch in the Transpose
Map, thus modifying it from they way it was
originally set up by the transpose options, the
Custom Map transpose option will then become
automatically selected to indicate that the
transpose map is now a custom map.

3 If you would like to save the map, type in a name
and click Save.

The map will appear in the Custom Maps list.

4 Click Apply to execute the transposition.

Custom Transposing With a Non-standard
Octave Range
Interval, Diatonic, and Key/Scale transpose
options all set up the transpose map in 12 note
octaves. Changes in one octave are reflected in all
other octaves. The Custom Map option can set up
the transpose map in octaves that are more or less
than 12 notes. For example, if you have a sampler
that has drum pitched drum sounds like tom-tom
drums every 6 notes, you can transpose that 6-note
range to the 10-note range of another sampler. Or,
you can transpose music from a 12-tone synth to a
synth that is tuned in quarter-tones.

The Custom Transpose option frees you from the
octave and diatonic restrictions of the other
transpose options.

To transpose using an custom octave range:

1 Select the Custom Map transpose option.

The Custom Transpose options will appear.

Tranypes» frUp

C3 03
Dt3 £3
D3 F"3
Eh3 Ab3
£3 Bb3
F3 C4
F“3 D4
G3 £4
Ab3 F“4
A3 AM
Et>3 E64
B3 C5
C4 03

•C

2

2 Type in the number of notes in the source and
destination octaves and a root pitch for the initial
octave.

In the example above, a standard 12-note octave is
being mapped to a 24-note octave. The scale sizes
can be any number between 1 and 128. The root
pitches can be any note. Notice that the source
octave from C3 to C4 gets mapped to the
destination two-octave range of D3 to D5. Also
notice that the root pitches do not need to be the
same. All other octaves above and below become 



mapped in the same fashion as the one you define.
If notes in other octaves get transposed to pitches
outside the 128 note MIDI range, they are
substituted with pitches inside the range.

3 If you would like to save the map, type in a name
and click Save.

The map will appear in the Custom Maps list.

4 Click Apply to execute the transposition.

Transposing All Notes to a Single Pitch
To map all 128 MIDI notes to a single pitch:

1 Select the Custom Map transpose option.

The Custom Transpose options will appear.

2 Type in 128 in the From: option.

This includes all notes into one, large octave.

3 Type in 1 in the To: option.

This maps all note in the 128-note octave to a single
note.

O lnt«rvj1
O OUtcnlc
O K«y/So»W
® Custom Map

Trwpw Mtp

C3 Cl o
Db3 Cl
D3 Cl
Eb3 Cl
E3 Cl
F3 Cl
F**3 Cl
03 Ct
Ab3 Ct
A3 Ct
Bb3 C1
03 Ct
C4 Ct Jl

4 Type in or play in a pitch in the To: option.

In the above example, all notes are being mapped
to Cl.

5 If you would like to save the map, type in a name
and click Save.

The map will appear in the Custom Maps list.

6 Click Apply to execute the transposition.

Transposing Each Pitch to Any Other Pitch
The Custom Map option can also map each pitch
to any other pitch, completely independently from
the same pitch in other octaves. This allows you to
create a transpose map to easily change drum
tracks from one drum machine to another.

To set up a drum machine transpose map:

1 Select the Custom Map transpose option.

The Custom Transpose options will appear.

2 Type in 128 in both the From: and To: options.

Since there is only one source and destination
octave, each change you make in the Transpose
Map’s To column will not be carried through to any
other octaves.

O
O Diatonic
O Key/Scd*
@ Custom Ma?

Triasptct Mtp

C3 C2
Db3 C4
D3 F°3
Eb3 03
E3 Db3
F3 G2
F°3 Db3
G3 0b3
Ab3 F3
A3 Eb2
Eb3 04
B3 C-t
C4 Eb5

3 Pop-edit the pitches in the Transpose Map’s To
column.

Notice that each pitch treated individually and
does not affect surrounding pitches or octaves.
Notice in the above example that a same
destination pitch, like Db3, can be used more than
once, such as when several pitched tom-tom
sounds are being mapped to a single tom sound.

4 If you would like to save the map, type in a name
and click Save.

The map will appear in the Custom Maps list.
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5 Click Apply to execute the transposition.

CREATING A CUSTOM SCALE
The Custom Scale option allows you to create your
own scale. To do so, you select which pitches are
diatonic and which ones are not.

After you create a custom scale, it appears in the list
of keys/scales for the Diatonic and Key/Scale
transposition options, allowing you to transpose
diatonically using your own scale and any root
pitch.

To create a custom scale:

Your custom scale appears in the key/scale list for
the Diatonic or Key/Scale transpose options.

Deleting a custom scale
To remove a custom scale from the list:

1 Click the Create Scale button in the Transpose
window.

2 In the list of scales, click the name of the scale
you want to delete.

3 Click Delete.

1 Click the Create Scale button.

The Create Scale dialog box appears.

2 Select the pitches you wish to be diatonic
pitches.

You can have as many or as few diatonic notes as
you wish. You can also select the diatonic pitches by
playing them on your MIDI controller. A pitch
turns into boldface to indicate that it is diatonic.

3 Click OK to create the scale.



chapter 20 Groove Quantize

Performer’s Groove Quantize feature is easy to use
and — from a creative standpoint — one of
Performer’s most enjoyable features.

This chapter tells you how you can do the
following:

■ Use the Groove Quantize command to control
the rhythmic depth and “feel” of your music

■ Dynamically adjust the feel of grooves with
faders while applying them

a Use Groove Quantize to apply the rhythmic feel
of a track to other tracks

a Create your own grooves, of any length, from
any music you have recorded into Performer or
loaded from a standard MIDI file

a Build a groove database from which you can
instantly call up any groove you have created

See the following important sections before
reviewing this chapter:

■ “Editing During Playback” on page 227

a chapter 15, “Selecting” (page 207)

a “Region Commands Are Windows That Can
Stay Open” on page 227

What is a groove?
In musical terms, agroove is a unique rhythmic
feel. Many artists are famous for a certain feel—or
groove—in their music that makes their sound
unique.

Performer’s Groove Quantize feature gives you
complete reign over this important aspect of your
music.

The effect of adding a groove to an otherwise
mundane track can be stunning: the music
instantly feels like it has a third dimension, and the
sensation can be similar to that moment when you
put on 3-D glasses in an old 3-D movie.
Sometimes, the effect is subtle. Often, however,
you’ll find that a groove completely transforms
music, making it sound totally different from its
original form.

The elements of a groove
To master grooves, it is important to recognize the
musical elements of a groove. A groove is generated
by variations in the timing, accent, and duration of
the notes being played. In Performer, a groove
consists of a combination of the following
elements:

■ A quantize grid that affects the timing of notes
(attacks only)

■ A note-on velocity map

■ A note duration map

■ A meter

■ A length (in measures)

■ An overall beat subdivision

For example, a swing groove is usually based on a
swung 8th note beat subdivision. If it’s a hard
swing, the eighth-note offbeats may be played quite
late. The durations of the notes in such a groove
tend to be longer, and the velocities emphasize the
offbeats. The length of the groove is usually two
bars, and it is often in 4/4 time.

When you apply a groove to some MIDI data in a
track, the selected notes are modified according to
these groove parameters.



APPLYING A GROOVE
To apply an existing groove:

1 Use Performer’s Memory-cycle feature to cycle
playback over the region you wish to apply the
groove to.

2 Start playback.

3 Select the data you wish to apply the groove to.

Make sure that what you select is within the region
Performer is currently looping. If you don’t, you
won’t be able to audition the groove before
applying it. Use any method of selection that you
prefer. You can select individual notes or an entire
region of data. The groove will be applied at the
measure boundaries of the region you select.

4 Choose Groove Quantize from the Region
menu, or press command-G.

The Groove Quantize window appears. If you get
an error message instead, then the Grooves folder
is not in the same folder as Performer. If so, switch
into the Macintosh Finder and move the Grooves
folder into the same folder as Performer.

a, Grooue Quantizepr
Pick a groove 'o epply:
Q Grooves v| Recent Fileyr

Pt OHA Groove*____________________
Hip Hop Grooves

fgfl Jazz Riffs
P~] Other Grooves

Rock 'n Roll Grooves
Straight Grooves

5 Open one of the Groove files (or folders) in the
list by either double-clicking its name or by
clicking its name once and clicking the open
button.

You now see a list of grooves stored in that groove
file.

6 Select the desired groove by clicking its name.

If the Instant Preview button is checked and
Performer is playing back the region you selected,
you’ll hear the effect of the groove right away. You
can audition as many grooves as you want without
permanently applying one.

7 If you’d like to adjust the feel of the groove, click
the More Choices button.

This option is discussed further later on in this
chapter.

8 To apply the groove, click Apply.

Instant preview
When the Instant Preview button in the Groove
Quantize window is checked, you can preview
grooves without having to click Apply to apply
them. This lets you quickly scan through a list of
grooves, auditioning each one until you find one
you like. To apply it, click Apply. When Instant
Preview is unchecked, you won’t hear the groove
until after you click Apply.

The Recent Files pop-up menu
The Recent Files pop-up menu is provided for your
convenience. It lets you go directly into recently
opened groove files.

The More Choices button
The More Choices button causes several sliders to
appear in the window. A unique and powerful
feature, these sliders let you adjust the degree to
which the groove is applied—in essence, they let 

274 L
GROOVE QUANTIZE |



you “turn up” or “turn down” the groove. For more
information, see “Adjusting groove parameters
when applying a groove” on page 276.

Locating a groove
The groove list works like a standard Macintosh
open dialog box. Use it in the standard fashion to
locate grooves.

This pop-up menu lets you go directly
into recently opened groove files.

Use this pop-up menu to navigate
through all of the groove files.

Drag the groove icon to move Option-dickthenameof
it up or down in the list the groove to rename it.

Renaming grooves
To rename a groove:

1 Select any data or time region.

It doesn’t matter what you select.

2 Choose Groove Quantize from the Region
menu.

3 Locate the groove.

4 Option-click its name to pop-edit the name,
and press return to enter the new name.

5 To exit the Groove Quantize window, click its
close box.

Deleting, moving, and duplicating grooves
Grooves can be cut, copied, and pasted in the
Groove Quantize window. This allows you to delete
them, move them from one file to another, and
duplicate them.

Duplicating is useful because you can make a copy
of a groove and then make adjustments to the copy,
which preserves the original.

To do any of these operations, you first open the
Groove Quantize window. To do so, select some
data or a region and choose Groove Quantize from
the Region menu. Locate the groove, and then do
one of the following desired operations:

Operation How to do it

To delete a groove Click it in the list to select it and
choose Cut from the Edit menu.

To move a groove from one
file to another

Cut it (as described above),
open another groove file using
the pop-up menu above the list,
and the choose Paste from the
Edit menu.

To duplicate a groove Click it to select it and choose
Copy from the Edit menu. Then
choose Paste from the Edit
menu. After pasting, rename the
copy to differentiate them.

Where grooves are stored
Grooves are stored in Performer groove files. You
can store as many grooves as you want in a groove
file. You can create as many groove files as you
want. The only requirement is that groove files
must be placed in a folder called “Grooves”, and
this folder must be placed in the same folder as
Performer. This is all taken care of for you when
you first install Performer, so, unless you have
moved the folder, you don’t need to worry about it.

275
GROOVE QUANTIZE



When you create your own groove files (discussed
later), we recommend that you organize them by
category as shown above. This will make it easier to
locate grooves.

Notice that you can further organize your groove
files by placing them in folders (as long as they
remain inside the Grooves folder). You can even
place System 7 aliases in the Grooves folder and
place the actual groove files somewhere else on
your hard disk.

Adjusting groove parameters when applying a
groove
When you apply a groove, Performer allows you to
adjust groove parameters without permanently
altering the groove itself. For example, you can
“turn up” the degree to which velocities are
affected without changing the original velocity
map in the groove. To permanently edit the groove
see “Modifying grooves” on page 280.

To adjust groove parameters while applying a
groove:

1 Use Performer’s Memory-cycle feature to cycle
playback over the region you wish to apply the
groove to.

2 Start playback.

3 Select the data you wish to apply the groove to.

Make sure that what you select is within the region
Performer is currently looping. If you don’t, you
won’t be able to audition the groove before
applying it. Use any method of selection that you
prefer. You can select individual notes or an entire
region of data. The groove will be applied at the
measure boundaries of the region you select.

4 Choose Groove Quantize from the Region
menu.

5 Click the More choices button.

Several sliders appear in the Groove Quantize
window, along with several other options.

*7|£1| *>„, Grooue Quantize

0 Save slider end beat division
jettings vith grwre

O Auditwi grieve vith current
jettings tbut don't save)

Pest Division:
16th totes vj

2 measure; of 4/4

1 "CMA Shuffles r-[ Fee ent Files—!

® Instant pre

Pick a groove to apply ’

0^ 1 • Shuffle Feel A

2 • Shuffle Feel B
£

&£♦•••
4 • Medium Shuffle

fg) 5 • Hard Shuffle
fg) 6 • Soft & Med Shuffle

7 • Med & Hard Shuffle
8 • Early Snare

F»w CUkn J

6 Select the groove you wish to apply from the list.

7 Make sure the Instant Preview check box is
checked so you get instant feedback while
adjusting the groove.

8 Adjust the groove as desired with the sliders.

These sliders are discussed in the following section.

9 If desired, try different beat divisions by
choosing them from the beat division pop-up
menu.
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Changing the beat division often has a dramatic
effect on the feel of the groove. This is discussed
further in a following section.

10 Once you like the groove, click Apply.

Fewer Choices button
The Fewer Choices button in the Groove Quantize
window removes the groove parameter sliders
from the Groove Quantize window to simplify its
appearance. Click this button if you do not wish to
adjust the groove with the sliders.

Using the groove adjustment sliders
The three groove adjustment sliders give you
complete control over the feel of a groove. They let
you dynamically control the degree to which the
timing, note-on velocities, and durations are
affected.

"•* When you move a slider, the change occurs
when you let go of the slider (as long as the Instant
Preview check box is checked). No changes occur
while you move the slider.

In essence, these sliders let you control the extent to
which you are applying the original feel of the
groove. You can either “turn up” or “turn down” its
effect. We urge you to experiment with them
because they produce interesting effects. The
sliders perform as follows:

Double (200%) Groovefeelingisexaggeratedby
a factor of 2.

Groove slider setting Result

Off (096) Velocities and durations are
unchanged. For timing, a
straight grid quantize is applied.

Full (100%) Applies the exact feeling of the
groove.

You can clearly hear the effect of one slider by
setting the other two sliders to their off position
and then trying different strengths on the
remaining slider.

One effective approach with these sliders is to set
them all to off (0%) and then increase each one in
small increments. Use the up and down arrow
buttons to make small adjustments. This lets you
gradually apply the groove to a point that sounds
best.

Saving groove settings with a groove
The option called Save slider and beat division
settings with groove does what is says. The result is
that when you first select the groove in the list, the
sliders will jump as necessary to reflect the
currently saved slider settings for that groove.

When this option is selected, slider settings are
saved immediately when you move the slider. If you
want to try changing the setting without losing the
saved settings, use the option called Audition
groove with current slider settings (but don't save),
which is discussed below.

Auditioning groove settings
The option called Audition groove with current
settings (but don’t save) lets you adjust the sliders
without affecting the settings that are currently
saved with the slider. The same goes for the Beat
Division pop-up menu. In addition, this option lets
you quickly audition a number of different grooves
with the same settings (because the settings won’t
change when you select a new groove). For
example, if you like the degree of groove you’ve set
with the sliders, but you aren’t quite satisfied with
the type of groove yet, you can try several other
grooves with the same slider settings.

If you’ve auditioned sliders settings and wish to
now save them, click the Save slider settings with
groove button.
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Using different beat divisions
The beat division pop-up menu lets you choose an
underlying quantize grid for the groove. Divisions
range from eighth notes to 32nd notes in both
straight and triplet time; several combination grids
are also provided. See “Choosing a beat division”
on page 279 for more information.

This pop-up menu allows you to try different beat
divisions without losing the original beat division
in the groove. For example, you can try applying an
8th-note division to a groove with a 16th triplet
beat division. The original beat division is
displayed in outline format as shown below:

Eighth Notes

J) 16th Notes

J) 32nd Notes

Eighth Triplets

32nd Triplets

32nd Nonuplets

3J>J) 8th Triplet & Sth

2fy) 8th Triplet «. 16th

16th Triplet & 16th

Original beat division

Notice that a groove can have more than one
original beat division, and each original beat
division can have its own unique settings. This can
be accomplished by editing the groove. See
“Adding an additional default beat division to a
groove” on page 280 for more information.

The beat division pop-up menu is governed by the
radio button options at the top of the window. (See
“Saving groove settings with a groove” on
page 277.) One option saves the beat division
setting with the groove. The other lets you audition
different grooves with a certain beat division. For
example, if you have a bunch of grooves that were
created in 16th note divisions, but the particular
section you are applying the groove to right now is
in triplets, you can set the beat division menu to
triplets, and leave it there as you audition groove
after groove.

The beat subdivision has a dramatic impact on the
groove. Try experimenting with different choices.

Grooves usually sound closest to their original feel
with the beat division at which they were created.

CREATING A GROOVE
The Create Groove command lets you create your
own Grooves from MIDI note data in any track.
The source material can come from any Performer
file or any standard MIDI file. Grooves can be any
length.

To create a groove:

1 Select the notes (or region of notes) you wish to
use as source material for the groove.

You may select them in the Track list, the Tracks
Overview, or any of Performer’s editing windows.
The groove will start at the beginning of the first
measure of your selection, and its length will be a
whole number of measures.

When you choose source material for a
groove, the data must be aligned with Performer’s
metronome (main counter). For example, you can’t
use a rubato passage, unless you first use the
Record Beats feature to align Performer’s measure
and beat boundaries with the music.

2 Choose Create Groove from the Region menu.

The Create Groove window appears.
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3 Open a groove file in which to save the groove,
or create a new groove file with the New File
button.

4 Type in a name for the groove.

5 If desired, change the meter for the groove.

This setting affects the overall length of the groove,
and it also affects how many beats are in each
measure. Try to choose a meter that most closely
resembles the beat structure of the groove you are
creating.

6 Choose a default beat division for the groove
from the pop-up menu.

See “Choosing a beat division” below regarding
this option.

7 Click OK to save the groove.

The new groove gets added at the bottom of the
groove list.

Choosing a beat division
The choice you make for a beat division when
creating a groove is an important one, for it
governs the underlying resolution of the
quantization that occurs when you apply the 

groove. The choices range from eighth notes to
32nd notes in both straight and triplet time; several
combination grids are also provided.

As a rule of thumb, when you choose a beat
division, think of how the music is notated, and use
the shortest note duration that would be used to
notate it. For example, a swing feel is customarily
written as straight eighth notes. So when you are
choosing a beat division for a swing groove, use a
straight eighth note grid.

If the groove style you are defining has both a
straight and triplet feel, use the appropriate
combination grid (the straight and triplet options
at the bottom of the menu, as shown below). For
example, swung music often includes straight
sixteenths, so you’d choose a triplet eight/sixteenth
combination.

J> Eighth Notes

Ji 16th Notes

J) 32nd Notes

2I> Eighth Triplets

2b 16th Triplets

2b 32nd Triplets

2b 32nd Nonuplets

2bj) Sth Triplet & 8th

2bj)8lh Triplet & 16th

2bj 16th Triplet & 16th

Combination beat divisions

Keep in mind, however, that the combination grid
has beat divisions for both straight time and triplet
time, so there are more grid points. If the music
you apply the groove to is not rhythmically
accurate to begin with, there is more of a chance
that notes will gravitate to the wrong grid point.
For this reason, use discretion when applying
combination grids. In some cases, it might be
better to use a non-combination grid. When in
doubt, you can make two versions of the groove:
one with a combination grid and another with a
straight or triplet grid.
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Modifying grooves
Performer provides you with the ability to modify
the timing, velocity, and duration information in
the groove itself. Fortunately, you can do so quickly
and easily, without having to switch files.

To modify a groove:

1 Select any data or time region.

It doesn’t matter what you select.

2 Choose Groove Quantize from the Region
menu.

3 Locate the groove.

4 Click the Edit button.

® Instant Previev

j - '-’2-______ -
| Edit | | Apply |

5 The Groove Editor dialog box appears.

Information about the currently selected beat division.

does not fit entirely in
the window Note

durations

6 Edit each beat division as desired.

280 L

If Instant Preview is enabled, and you are looping a
section to hear your changes, you’ll hear them right
away as you make them. Here is a summary of what
to do in this window.

To do this Do this

Increase or decrease a velocity Drag it up or down

Adjust note placement earlier
or later

Drag the note placement bar to
the left or right

Increase or decrease a dura­
tion

Drag the right side of the dura­
tion icon left or right (0 - 200%)

7 Click OK to confirm your edits, or click cancel
to withdraw the command.

Duplicating a groove before modifying it to
preserve the original
The groove editor makes permanent changes to the
groove (unlike adjusting the groove sliders, which
doesn’t affect the groove data itself). As a result, if
you want to modify a groove but preserve the
original, duplicate the groove and then edit the
copy. To duplicate a groove, see “Deleting, moving,
and duplicating grooves” on page 275.

Adding an additional default beat division to a
groove
A groove can have several default beat divisions (as
shown in the pop-up menu on page 278). This lets
you produce several permanent variations of the
groove within the groove itself. To do so, select a
non-default beat division from the beat division
pop-up menu in the Groove Quantize window
right before you click the Edit button. Doing so lets
you modify the groove based on the newly selected
beat division. The modifications you make to the
groove in the editor will be unique to that beat
division; you won’t affect the groove with its
original beat division setting. When you click OK,
the beat division you chose will become outlined,
and you’ll be able to freely change between the two
groove variations simply by selecting the outlined
beat divisions in the beat division pop-up menu.
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Obtaining grooves
There are many ways to obtain grooves. You can:

■ Use the stock grooves provided with Performer

■ Create new grooves from scratch in Performer

■ “Cop” grooves from any Performer file or
standard MIDI file

■ Purchase commercially available standard MIDI
file libraries and create grooves from the MIDI data
in them

■ Purchase commercially available groove
libraries

Commercially available MIDI groove libraries are
similar to sample libraries; they have been
painstakingly produced in the recording studio.
For example, WC Research, Inc., the producers of
DNA™ grooves, have pulled industry legends such
as Clyde Stubblefield and Bernard Purdie into the
recording studio specifically for the purpose of
encoding their unique feel. The results are
stunning, and we strongly recommend that you
check them out. A folder of sample DNA grooves is
included with Performer.

MIDI grooves are similar to digital sampling in the
sense that they present us with similar copyright
issues. If you cop someone’s groove using
Performer’s Create Groove feature, consider
handling it in the same fashion as you would for
samples.

Cubase grooves
Performer can read Cubase groove files if they are
placed in Performer’s Grooves folder. They appear
in the Groove Quantize list with a different icon
along with all of your Performer groove files. They
can be used in the same fashion as Performer
grooves.

Pick a groove to apply

€3 Graves Facw.t Ftkx

g
EP_63 GPV

EP_69_70 ------------------------------
& BP-71.GRV
[ Hip Hop Grooves ----------------------------

Jazz Riffs
P~l Old Grooves-<-----------------------------------

Rock 'n Roll Grooves
Shuffles “

Cubase groove file

Performer groove file

■Folder containing
groove files

Cubase grooves can be viewed in Performer’s
Groove Editor, but they cannot be edited directly.
To edit them, first move them into a Performer
groove file using the Copy and Paste commands in
the Edit menu (see “Deleting, moving, and
duplicating grooves” on page 275).

Applying the groove from one track to another
To apply a groove from one track to another, create
a new groove based on the original track. Once you
have created the groove, you can apply it to any
other track you wish using the Groove Quantize
command. The Groove you create can be of any
length.
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chapter 21 Patch Thru

Patch Thru allows you to hear incoming MIDI data
from your MIDI controller instrument played back
on your output synthesizers. More technically,
Patch Thru echoes MIDI data received by
Performer to any MIDI device in your studio that
you choose. You’ll want to use Patch Thru most of
the time because it allows you to hear what you are
playing on your MIDI sound modules while
recording. Patch Thru also provides an easy way to
experiment with different playback synthesizers
without having to manually reconnect patch cords
and change MIDI channels on the instruments.

Patch Thru works whether you are recording or
not. However, MIDI data will only be patched
through tracks which are record-enabled. If you
don’t hear anything on your synthesizer modules
when playing your controller, check to be sure that
the correct track or tracks are record-enabled.

Timing and synchronization data are not echoed in
Patch Thru.

Turning on Patch Thru
To turn on Patch Thru, choose it from the Basics
menu and select either Direct Echo or Auto
Channelize:

Figure 21-2: Performer's Patch Thru command offers two types of
patch thru: Direct Echo and Auto Channelize.

Direct Echo
Direct Echo causes incoming MIDI data from your
controller to be echoed back out on the same
channel it was received. For example, if your MIDI
controller is transmitting on channel 3, MIDI data
is echoed back out on channel 3 by Performer. The
Input Filter settings do not affect direct-echoed
data; information is simply echoed straight
through, bypassing most of Performer’s MIDI
processing.

Figure 21-1: Here is an overview of how Patch Thru works. You press a key on your controller keyboard. The note gets sent to Performer. Performer
determines which device (MIDI channel) the note will be echoed to by the track is currentlyrecord-enabled in the Tracks window. It then sends the
note to the device assigned to that track, which plays the note using whatever sound (patch) is currently selected on that channel.



Direct Echo is useful in situations where you want
to be able to change the channel you are echoing to
from your MIDI controller keyboard by simply
changing its transmit channel.

Auto Channelize
Auto Channelize causes incoming MIDI data from
your controller to be echoed back out to the device
and channel for the currently record-enabled track
in the Tracks window. The following sections
discuss several scenarios that affect Auto
Channelize.

Auto Channelizing in a Sequence
When a sequence is play-enabled in the Chunks
window, here is how Auto Channelize Patch Thru
works. In normal recording mode (MultiRecord
off), incoming data is echoed to the device
specified for the record-enabled track in the
currently play-enabled sequence. In the example
shown below, any incoming data received by
Performer will be sent to the Kurzweil K2500
channel one. This is because the Funk Bass track is
record-enabled, and its play destination is channel
one on theK2500:

s«i-i____________ _____________________ sL

srtwMm: a<!L*llsIilo°o ~ XtrilfaWbbo' n
r.'.T, >tc njTj eairor | nwtm»CJ»t>*MC I lev I wen

___ |_________J f .] Ccfilter ___ |___ |____
7 I _> J >1K2500JJIJ Funk Bass_______ | _____
~ ! —<1 ►■IX3DR-2 11__ | DrawbarOrgan |i *'
~ 1 ► i X5DR»3~| 1 IChvtet |r~ <'

Figure 21-3: Auto channelize is controlled by record-enabling a track
assigned to play back on the device and channel you want to hear.

Every time you change the record-enable track,
Patch Thru repatches your controller instrument to
echo out to the specified device for that track. Thus
you always hear your incoming data as it would be
played back.

If the record-enabled track is assigned to several
playback devices at the same time, all of the devices
will receive the patched thru data.

Auto Channelizing with Multi-record turned on
If MultiRecord is on, only MIDI data received on
the specified recording Device for a track will be
echoed to the corresponding playback channels for
that track. In the following example, notes played
on the Alesis QS6, channel 1 will be heard on the
K2500, channel 5. Notes played from the DrumKat
will be heard on the KORG X5DR channel 10.

S*<i-l____________ ^|_ -I
Selection ^SfertJ fSHlOOd' fed] 18141000 " _

57|(?)|£!|S|fr|.sT

KStjtCC IHfJf CH’IUff C3TPBT TFrr.TUKTl M‘MC ...........  tCV '

-I - 1 Conductor
jdn QS6 1 K2500-5 1 Fud: Base ; i~ ■

IP
_zl£J

_zJiJ

DrumKat 10

ProMr-01 1

>

>

X5DR-2
X5DR:3 ___
X5DR-10
XpDR-5____
ProMVOI-1

1 ' Drawbar Organ jl '
1 1 Clarinet_________
1__ l Drums___________ji-
1 1 Muted Gtr._______ i‘
1 Automation

X5DR-£ 1 Echo Drops
X5DR-7 t i .

Figure 21-4: In MultiRecord mode, you can choose a specific source
instrument (and channel, if desired) for each track that is record-
enabled.

In the above example, the two controller
instruments will be rechannelized separately. If two
different tracks had the same input recording
channel and had a common output channel, the
incoming data will be echoed twice to that output
channel. This may cause problems with some
synthesizers; caution is advised. Note that when in
MultiRecord mode, the recording channel
specified in the Input Filter will be ignored.

Since Patch Thru works even when you’re not
recording, you can use Performer as a
sophisticated MIDI merger, mapper, or
rechannelizer when in playback or when stopped
(as well as during recording). Patch Thru allows
you to route MIDI information from your
controller instrument to any combination of
synthesizer modules. By adding a group of tracks,
each assigned to a different MIDI channel or set of
channels, you can change the module
configuration used for playback by simply clicking
on the record-enable button for the track or tracks
with the desired channel configuration. This allows
you to experiment with channelization freely.
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Auto Channelizing and Output Effects
Processors
The Mixing Board window allows you to apply
real-time MIDI effects processors to a track. For
example, you could apply the Echo processor to a
track to apply a MIDI echo in real time on
playback.

These same processors affect Patch Thru as well.
When you record-enable a track, and the track has
a MIDI effects processor currently applied to it,
you will hear the effect on what you play.

This allows you to apply affects — in real time — to
what you are recording into (and patching thru)
Performer. For example, you can apply a Transpose
Map that makes constrains all notes to within a
certain scale — which automatically cleans up any
wrong notes that you play! Or you can apply a
MIDI echo as you record. See “The Effects
window” on page 127 for information about
applying real-time effects to the track you are
recording into.

Auto Channelizing in a Song
If a song is play-enabled in the Chunks window
instead of a sequence, the following two conditions
are necessary for Auto Channelizing to occur: 1) a
sequence within the song must be record-enabled,
and 2) a track within that sequence must also be
record-enabled. If both are true, then Patch Thru
will operate in the same manner as described
above. For information about record-enabling
sequences in a song, please refer to the Chunks
Window chapter.

Auto Channelizing and the Input Filter
The Input Filter affects incoming data in Patch
Thru mode. All data selected to be filtered out will
not be echoed to the outputs. For example, if the
pitch bend box is not checked in the Input Filter
dialog box, pitch bend information will not be
echoed through in Patch Thru.

Patching Thru in the Background
If the FreeMIDI preference called FreeMIDI
Applications Only is chosen (in FreeMIDI Setup:
File menu: FreeMIDI Preferences command),
Performer will continue to Patch Thru even when it
is in the background, i.e. not the active application.
This lets you Patch Thru, for example, if you are
running Performer with another program, such as
UNISYN, Mosaic, or Pro Tools, the other program
can be in front and you’ll still be able to patch thru
from your controller via Performer.

Be Careful
If you use Patch Thru with a drum machine or any
device that outputs timing information, the timing
information will not be echoed through. To echo
timing information, see chapter 43,“Transmit
Sync” (page 417).

Using Patch Thru will cause a small delay (up to
three milliseconds) since Performer must read all
incoming data before sending it out again.

Some MIDI interfaces, such as the MIDI Time
Piece II, have a patch thru option built into them.
The MIDI delay factor will be smaller when using
this option since it is closer to the MIDI signals. If
you choose to use the echo feature, turn off Patch
Thru on Performer or incoming data will be
echoed twice. If you choose to use Patch Thru in
Performer, turn off the echo feature on the
interface for the same reason.

PATCH THRU
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chapter 22 Markers

The Markers window allows you to display and edit
the markers for a Chunk (sequence or song). A
marker is a name attached to a particular location
in a Chunk. The Markers window can be used as a
sophisticated autolocator, allowing you to move to
a location instantly. The Markers window provides
an easy way to organize your music; markers are
visible in the Event Editing windows for each track,
and are useful in quickly specifying editing
regions. Markers are particularly useful when
working with film and video; you can record them
in real time to mark hit points, then use the
Markers window as an intelligent cue sheet. With
the commands in the Change menu you can then
adjust meters and tempos to automatically align
musical cues to the hit points.

QUICK REFERENCE

Marker name
indicator

Marker Locked FreeMIDI
location indicator seek point

Figure 22-1: Performer's Markers window.

Time display: Displays the marker locations in
your choice of measure, real or frame time. Click
on a location to change it. Select the formats you
wish to use from the bottom of the mini-menu.

Locked indicator: Indicates that the marker is
locked to real/frame time. Toggle from locked to
unlocked and back by clicking in the lock column
next to the marker name.

FreeMIDI Seek point: FreeMIDI provides eight
seek points to which it will cue all FreeMIDI
applications. You can designate up to eight markers
as FreeMIDI seek points. Type in the desired seek
point number in this column.

Names: Click on a marker’s name to select it.
Option-click on the name to change it. Drag over
several names to select several markers. Use Shift­
click to select or deselect several non-contiguous
markers.

Position indicator: Displays the current location in
the Chunk. Drag on the indicator to move it. Click
anywhere in the grey region to move the indicator
to a marker. Moving the indicator changes the
current location in the Chunk.

Mini-menu
p_____________________

Add
Loci;
Unlock
Record hits
Shift locked markers
Generate VTP streamers

-/M Measurer
©Real time
••Frames

Delete

Add: Adds a new marker at the current location.
Hold down the Option key while choosing Add to
add several markers at once. A dialog box will
appear, prompting you for the number of markers
to be added.

Delete: Deletes the highlighted markers.

I 289



Lock: Locks the highlighted markers to real/frame
time. A small lock icon appears by the marker’s
location to indicate that it is locked.

Unlock: Unlocks the highlighted markers.

Record hits: Enables a special mode such that
during playback, every time you hit a key on your
controller instrument, a marker will be added at
that location.

Shift locked markers: Shifts all highlighted locked
markers by a time offset.

Generate VTP Streamers: Causes Performer to
trigger a Video Time Piece streamer for each
designated marker in the Markers list.

Measures/real time/frames: Choosing these will
determine what type of time will be displayed in
the marker list. When chosen, the menu entry
becomes checked. Choosing it again unchecks it.

BASICS
The Markers window is used to display and
manipulate markers. Each Chunk listed in the
Chunks window has its own set of markers. The
title bar of the Markers window displays the
sequence or song to which the markers belong.
Each marker consists of a name and a time location
it is associated with. Markers are listed in
chronological order. You can display the location of
a marker in any combination of measure time, real
time and frame time.

Normally a marker remains at the same measure
time location when you change the tempo of the
sequence. In this case, changes in tempo or
structure will affect the real and frame time
location of the marker. However, when working
with film or video, it is useful to assign a marker to
a certain event in the action (termed a“hit point”).
Such markers are necessarily attached to real or
frame time locations. Since the location of the 

event in the film or video will not change, the
location of the marker must not either, even if you
change the tempo of the music. Performer lets you
‘lock’ markers to real/frame time locations. When
you change tempos or edit your Chunk, the real/
frame time location of locked markers will stay the
same and the measure location will change to
reflect the new tempo or structure.

Opening a Markers Window
Each sequence and song has its own set of markers
in the Markers window. To open the Markers
window for a Chunk:

1 Open the Chunks window.

Do so by choosing Chunks from the Windows
menu.

2 Make sure no Chunks are highlighted.

To unhighlight them, briefly click a type icon in the
left column. If a Chunk is highlighted, a Markers
window will be opened for that Chunk.

3 Play-enable the Chunk whose Markers window
you wish to open.

Do so by clicking the play-enable button to the left
of the Chunk name.

4 Choose Markers from the Windows menu, or
click the Marker window button in the Control
Panel.

The title bar displays the name of the Chunk to
which the markers belong.

Switching between sequences and songs
The Markers window shows the markers for an
individual sequence or song. If you are working
with multiple sequences and songs in a file, you can
easily switch between them by command-clicking
the name of the sequence in the Marker window
title bar as shown below:
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Scrolling During Playback
The Auto-Scroll command in the Basics menu can
make the Markers window scroll during playback.
In addition, the window will automatically open to
the current playback location of the sequence.

Adding Markers
To add a marker, choose Add from the Markers
window mini-menu. The marker’s location will be
the same as that showing in the Counter. To add
several markers at once, hold down the Option key
while choosing Add from the mini-menu. A dialog
box will appear prompting you for the number of
markers to be added.

Changing the Name of a Marker
The size of the name box is limited by the size of the
Markers window. If you wish to enter a lot of text
for a marker name, resize the window first.

To change the name of a marker:

1 Option-click on the marker name.

A small box will pop up.

2 Type in the name for the marker.

3 Press the Return key or click outside the box to
approve the change or the Command and period
keys to cancel it.

You can use the Enter or the down arrow key to
approve the entry and move to the next marker
name, or the up arrow key to approve the entry and
move to the previous marker name.

Changing a MarkerTime Location
To change the time location of a marker:

1 Click the time location you wish to change to
pop-edit the value.

2 Enter the new values.

Use the Tab key to move between time fields.

3 Press the Return key to enter the time or the
Command and period keys to cancel your change.

You can use the Enter or down arrow key to
approve the change and move to the time location
of the next marker; use the up arrow key to approve
the change and move to the time location of the
previous marker.

If you change the measure time of a marker, even a
locked marker, the real and frame times will also
change. Changing the real or frame time of a
marker will cause the measure time location to
change.

Since the markers are listed in chronological order,
a marker may seem to vanish when you edit its
location. In such cases, the marker has simply been
moved out of the visible portion of the marker list.

Setting the Counter to a Marker Location
You can easily set the current location displayed in
the Counter window to the location of a marker.
This lets you to move to a location by its name
instead of time, making it unnecessary for you to
keep track of a number of arbitrary measures and
times.

To move to the location of a marker:

** Press on the position indicator and drag it to
the marker you want. You can scroll the list up or
down by dragging the position indicator slightly
past the top or bottom of the marker list.
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Or

•" Click in the grey area of the position bar to the
left of the desired marker. The indicator will appear
at that position. The position indicator will appear
under the pointer and you can drag it to the desired
marker. This saves you having to scroll around to
find the position indicator.

Selecting Markers
To select a marker, highlight it by clicking on its
name. There are several methods for selecting
several markers at once:

To select several adjacent markers, press on a
marker name and drag over the desired names. All
markers dragged over will highlight.

To select several non-adjacent markers, hold down
the Shift key and click on the names of the markers
you wish to select. They will highlight.

To deselect markers when more than one are
highlighted, hold down the Shift key and click on
the markers you wish to deselect. They will
unhighlight.

To extend the currently selected region, shift-drag
over the desired end location.

Using Markers to Define an Edit Region
You can use markers to define a region to be edited:
instead of typing the Start and End locations in the
Selection Bar of the Tracks window, you can use the
Markers window and the Selection bar pop-up
menu.

To define a region using the Markers window:

1 Select a group of markers such that the
beginning and end marker of the group are at the
starting and end times of the region to be edited.

If the marker with the start time you want for the
edit region and the marker with the end time for
the region are not adjacent, you must select all
markers in between. Click on the starting marker
and drag down until you reach the ending one.

2 Choose “Set to Selection Bounds” from the
selection bar pop-up menu above the Tracks list.

You can now use one of the commands from the
Edit or Region menus. You can also use this
procedure to transfer marker times to the Memory
and Auto Record bars in the Consolidated Controls
panel.

Markers in the Event Editing Window
Markers appear in the Event Editing windows for
each track in a sequence. The name and location
may not be edited in any of the Event Editing
windows. However, commands on the Edit menu
may be applied to markers only in the Conductor
track Event Editing windows.

You can use the View Filter to determine whether
or not markers are displayed in the Event Editing
windows.

For more information about using the View Filter,
see “Setting the View Filter” on page 217.

Markers in the Song Window
Markers in a song are displayed in the Markers
Strip in the song window. Performer automatically
generates a column in the Song window for each
marker.

Markers can be of great help when building a song
or score because you can use the Song’s Markers
window to create a list of section markers, which
will become Chunk placement columns in the
Song window. Marker-generated columns are
particularly useful for placing Chunks at hit points,
which can be created during playback using the
Record Hits command.
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Merging Markers in the Song Window
You’ll often find when you place a Chunk into a
song that it would be useful to see the Chunk’s
markers in the context of the whole song. The
Merge Markers command in the Song window
mini-menu lets you do just that. Simply select all
the component Chunks whose markers you’d like
to copy into the song, and choose Merge Markers.
All unlocked markers in the selected Chunks now
exist in the Song, and are displayed in the Song’s
marker strip and Markers window.

Removing Merged Markers from a Song
You can just as easily delete a Chunk’s markers
from a song. Select the Chunks whose markers
should be removed from the song and choose
Delete Markers. Performer compares the song’s
markers to those of the selected Chunks, and
removes any that match up by both name and
location. The marker list of the Chunk is not
affected. Keep in mind that once you merge
markers of a Chunk into a song, dragging the
Chunk to a different location will not move the
markers. Further, selecting the relocated Chunk
and choosing Delete Markers will not have any
effect, as the markers in the song no longer match
the markers in the Chunk.

Editing Markers in the ConductorTrack
You may apply any of the Edit menu commands
(Cut, Copy, Paste, etc.) to markers only in the
Conductor track for the Chunk. Select the
Conductor track in the Tracks window and set the
Start and End times in the Selection bar before
invoking one of the Edit commands. See
chapter 26,“The Conductor Track” (page 319) and
chapter 16, “Edit Commands” (page 217) for more
information.

Locking and Unlocking Markers
Markers can be connected to a real or frame time
location such that they will retain that location if
the tempo is changed: they can be “locked” to the
location. If the tempo is changed, the measure time
location of the marker will change.

When a marker is unlocked, it sticks to a specific
measure/beat/tick, and its real time location is
flexible. When a marker is locked, it sticks to a
specific real/SMPTE time, and its measure location
is flexible.

To lock a marker, click on it to select it and choose
Lock from the Markers window mini-menu. You
can lock several markers at once. To unlock a
marker, select it and choose Unlock from the
Markers window mini-menu. To toggle a single
marker between locked and unlocked states, click
in the lock column next to the marker’s name.

Shifting Locked Markers in Time
The Shift Locked Markers command on the
Markers window mini-menu lets you shift the
times of highlighted locked markers by the amount
you specify. Unlocked markers which are selected
are unaffected by this command.

This feature can be useful if the film or video you
are working with has been recut and the locations
of the events have moved slightly. It is generally
useful when changing the real/frame time
locations of markers by a uniform amount.

To shift the times of locked markers:

1 Select the markers you wish to shift.

Unlocked markers will not be affected by this
command. You can include them in your selected
markers group without affecting them.

2 Choose Shift Locked Markers from the Markers
window mini-menu.
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A dialog box will appear.

3 Specify whether to advance or delay the
markers.

Advancing markers moves them to earlier times,
delaying them moves them to later times. Click on
the radio button next to the desired option.

4 Choose whether to enter the shift amount in real
or frame time.

Click on the radio button next to the desired
option.

5 Enter the amount of time by which you wish to
shift.

Click in the text box and type in the number.

6 Click on OK to confirm your entry or Cancel to
ignore it.

You can use the Enter or Return key to confirm the
entry or the Command and period keys to cancel
it.

Recording Hits
New markers can be entered in a sequence during
playback by striking a key on your MIDI controller
instrument. The time location of each marker
corresponds with the time in the Counter when the
key is struck. This is a very useful feature for
recording cue points or hits while viewing film or
video.

To create markers during playback:

1 Move to the location at which you wish to start
playback.

If slaved to an external master device, this step is
not necessary: Performer will locate automatically
when you start the master.

2 Choose Record Hits from the Markers window
mini-menu.

A dialog box will appear.

3 Specify whether you want the markers to be
locked or unlocked.

4 Press OK to confirm your choice or Cancel to
cancel it.

Once you press OK, Performer will start playback.
If in external sync mode, the Play button will turn
grey until the master device is started.

5 Press a key on your MIDI controller every time
you wish to enter a marker.

A marker will be entered at the current time in the
Counter.

6 To stop entering markers in this way, press the
Stop button in the main transport controls.

Using the Auto Stop feature in the Consolidated
Controls panel will also stop this type of marker
entry. If you are in external sync, note that stopping
the master device does not take Performer out of
the Record Hits mode; you must press stop in
Performer to end recording hits.

HINTS
Below are some helpful hints for using Markers.

Composing and Arranging
Markers provide a useful tool for labeling
structural sections of a piece of music. The music
can be recorded first and markers added
afterwards or markers can be entered first to lay out
the structure of the sequence before recording. In
the latter case, markers can be used as a kind of
musical outline for the structure of the piece.
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Markers can be used to quickly rewind to the
beginning of a section. They can also be used as
structural place holders to mark the ends of
unfinished sections.

Since markers can be cut, pasted, merged, etc., in
the Conductor Track, they can be moved around
with the rest of the data as a sequence grows and
changes. You can move them separately from the
rest of the data if you wish.

Use the View Filter to specify if markers can be
affected by Edit menu commands.

If you are not working with time code, you will
probably not need to display real or frame time in
the Markers window.

Film and Video Scoring
Markers make an excellent cue sheet for planning
out or displaying the structure of your score. They
can show you the relationship between time
locations in the film and measure locations in the
music. You can adjust meters and tempos until the
metrical beats of the sequence line up satisfactorily
with important visual events. This can all be done
before recording a note of music.

In addition to using markers to define the structure
of your score, you may want to add markers for
visual cues and hit points. The Record Hits feature
is especially suited for this. These markers should
be locked since their time location corresponds to a
frame location. Once locked, the measure time
location of the marker will be updated if you
change the tempo and meter. The frame location
will not change.

If the time code on the film or video should change
due to restriping after assembly or editing, you can
use the Shift Locked Markers command on the
Markers window mini-menu to adjust the times of
the hit points you’ve already labeled with markers.

If you have Mark of the Unicorn’s Video Time
Piece, you will definitely want to read the next
section, which explains how markers can be used
to trigger streamers.

Streamers and the Video Time Piece™
The Markers window has an additional capability
designed for Mark of the Unicorn’s video post­
production device, the Video Time Piece. The
Video Time Piece is a hardware device that can
superimpose graphic images on a video picture,
including streamers. A streamer is a solid white bar
that travels across a video screen from left to right
to reach the right-hand side of the screen at an
exact hit point. Streamers help studio musicians
and sound effects engineers to anticipate hit points
during video post-production.

For more information, chapter 48, “Performer &
the Video Time Piece™” (page 463).
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CHAPTER 23 Chunks

The Chunks window displays the Chunks in a
Performer file. A Chunk is either a sequence (a
collection of tracks) or a song (a collection of
sequences and other songs). A Performer file can
contain as many Chunks as memory in your
Macintosh will allow. Chunks can be cued for
playback, either automatically or manually, in
order or at random. You can also build an entire
song out of other sequences and songs by chaining
and stacking Chunks in the Song window, which
provides seamless, simultaneous playback of
Chunks in any order and combination.

QUICK REFERENCE

Figure 23-1:The Chunks window lists all sequences and songs
(categorically referred to as “chunks") in the Performer file.

Type: Displays each Chunk’s type by icon, either
Song or Sequence. This icon is used to drag
Chunks into Song windows and to change the
order of Chunks in the Chunks window.

Sequence Song

Figure 23-2: The sequence and song Icons.

Play: Shows the play-enable button for each
Chunk. When a Chunk’s play-enable button is blue
(or black), the Chunk is play-enabled. Only one
Chunk can be play-enabled at a time.

S# (Song Select Number): Displays the song select
number that will play-enable the Chunk when
received from a MIDI controller. Song select
numbers range from 0-127. If a Chunk has no song
number assigned, the column displays a single
dash (-).

If Performer receives a song select number that is
assigned to two or more Chunks, Performer will
cue the Chunk that appears highest in the list. For
this reason, it is best to assign a unique Song Select
number to each Chunk.

End time: Displays each Chunk’s End time. In
automatic mode, End time is the downbeat of the
measure following the last complete measure in the
Chunk. When a Chunk’s End time is in manual
mode, it is bold and can be pop-edited to any
length.

Name: Displays the name of the Chunk. Click the
name to select the Chunk. Option-click the name
to change it. Double-click the name to open the
Tracks or Song window belonging to the Chunk.

Because Chunks can be imported into other files,
dragged without limit into Song windows, and
duplicated very easily, always use the most
descriptive Chunk name possible to avoid
confusion.

Comments: Displays as much as possible of your
comments for each Chunk. View and edit the
comments by clicking them.
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The Chunks Window Mini-menu
The Chunks window mini-menu contains the
following commands:

P______
Ad i Sequence
Add Seng
Duphc itf Track L»yov<
Op*n Chunks
Auto/mwiusl End Time
$«i Chunk Ct»rt.

Delete

Figure 23-3: The Chunks window mini-menu.

Add Sequence: Adds a sequence to the Chunk list. To
add several sequences at once, press the Option key
while choosing Add.

Add Song: Adds a song to the Chunk list. To add
several songs at once, press the Option key while
choosing Add.

Duplicate Track Layout: Creates a new, empty
sequence with the same track layout as the selected
sequence. Select an existing sequence before
choosing this command.

Open Chunks: Opens a Song window for each
highlighted song and a Tracks window for each
highlighted sequence.

Auto/manual end time: Toggles the Auto/manual
status of the selected Chunks. Automatic mode
locks the Chunk’s End time at the downbeat of the
measure following the last complete measure in the
Chunk. Manual mode changes the time to boldface
and allows it to be pop-edited.

Set Chunk Start: Establishes the start times of the
currently selected Chunk(s) in each of Performer’s
three time formats: measures, real time, and
SMPTE time. The start times are what you see in
the Counter when you rewind back to the
beginning of the Chunk. This is the same window
that appears when you click the Start Time button
in the main counter.

Delete: Deletes the selected Chunks. If you attempt
to delete a Chunk that is part of a song in the open
file, a dialog box appears, prompting you to
confirm your decision.

BASICS
The Chunks window lists the Chunks in a file and
provides useful features to manage them, such as
adding, deleting, and other operations. In
addition, Chunks can be dragged from the Chunks
window into a Song window to build a song. For
more information, see chapter 24,“Songs”
(page 305). Chunks can also be automatically cued
to playback in the order in which they are listed in
the Chunks window. For more information about
cueing, see “The Chunk Control buttons” on
page 47. Chunks can also be cued remotely from
your MIDI controller. For more information, refer
to The Remote Controls Window chapter.

Opening the Chunks Window
To open the Chunks window, choose Chunks from
the Windows menu. The Chunks window will
appear, displaying a list of all sequences and songs
in the open file. Within the Chunks window, songs
and sequences have different icons but behave
identically.

SEQUENCES Q
A sequence is a complete MIDI performance
consisting of any number of tracks, which are listed
in that sequence’s Tracks window. Each track
contains MIDI data which may be assigned to any
combination of channels. A sequence also has a
Conductor track, which contains meter, key, and
tempo information.

Many essential operations on tracks are done in the
Tracks window: tracks are added and deleted,
editing regions within tracks are specified, Event
Editing windows for tracks are opened and much
more. See chapter 6, “The Tracks Window”
(page 59) for complete details about its operation.
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Each sequence also has its own iMarkers window.
See chapter 22,“Markers” (page 289) for details
about it.

SONGS
A song is a collection of Chunks that you organize
to playback in the preferred order and
combination. Each song has its own Conductor
track, End time, and markers. Each song has its
own Song window, where you arrange the Chunks
that comprise the song. The Song window is
described later in this manual.

Selecting Chunks
There are several methods of selecting Chunks:

To select a single Chunk, click on its name. The
name will highlight.

To select several adjacent Chunks, click a Chunk
name and drag over the desired names. All Chunks
dragged over will highlight.

To select several non-adjacent Chunks, hold down
the Shift key and click on the names of the Chunks
you wish to select. They will highlight.

To deselect Chunks when more than one are
highlighted, hold down the Shift key and click on
the Chunks you wish to deselect. They will
unhighlight.

Creating New Chunks
To create a new, empty sequence, choose Add
Sequence from the Chunks window mini-menu. To
add several new sequences at once, hold down the
Option key while choosing Add Sequence. You will
be prompted for the number of sequences to add.

To create a new sequence with the same track
layout as an existing sequence, highlight the
existing sequence and select Duplicate Track
Layout from the Chunks window mini-menu. A
new sequence will be added with the same name as
the sequence you highlighted preceded by the 

words Copy of. It will have the same track layout as
the highlighted sequence: the number of tracks, the
track names, and the track playback channel
assignments will be identical to the original.

To create a new, empty song, choose Add Song from
the Chunks window mini-menu. To add several
new songs at once, hold down the Option key while
choosing Add Song. You will be prompted for the
number of songs to add.

Duplicating Existing Sequences
Sometimes you may want to duplicate a sequence
to experiment with changes or for some other
reason. Be sure that the Memory window shows
plenty of free memory before you duplicate. To
duplicate a sequence:

1 Highlight the sequence’s name in the Chunks
window.

2 Choose Copy from the Edit menu.

3 Choose Paste from the Edit menu.

An exact copy of the sequence, including all the
data in the tracks, will be placed at the end of the
list in the Chunks window. Rename it immediately
so that you do not get the copy and the original
mixed up.

Loading and Linking Chunks from Another File
Performer’s Load command allows you to quickly
import Chunks into an open file from another,
unopened Performer file.

It’s easy to run low on memory when working with
several sequences and songs. So that you aren’t
restricted by memory when loading Chunks,
Performer lets you load either a Chunk’s actual
data, or just a Link to that data. The Data and Link
sub-options determine which will be loaded.
Loading a link to a Chunk instead of the Chunk 
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itself saves a great deal of memory, allowing even
an 8 Megabyte Macintosh to support a long list of
Chunks.

For step-by-step instructions to load and link
Chunks, please refer to the chapter Working With
Files.

Splitting Up an Existing Sequence into
Separate Chunks
The Copy selection to new sequence command in
the Tracks window sequence pop-up menu takes
the current selection in the Tracks Overview
window and turns them into their own sequence
Chunk in the Chunks List window.

The Copy to new sequence command makes it easy
to break up a sequence into separate pieces
(Chunks) in order to rearrange them more freely in
a Song window. For example, let’s say that you have
built several phrases that are a few bars long in a
Sequence. But now you want to rearrange them and
try different combinations. To do so, you can make
any selection and choose Copy to new sequence
from the mini-menu for each one. Then, you can
drag the resulting sequence Chunks from the
Chunks list window into an empty Song window to
try different orders and combinations.

Once you have arranged the Song as you like, you
can even convert it back into a sequence using the
Song window mini-menu command called Merge
Chunks to Sequence. This command takes the
separate Chunks inside the Song window and
reduces them to a single sequence Chunk.

At any time, you can take your music freely back
and forth from Sequence form to Song form with
these two commands to help you create your
music.

To create a sequence Chunk from the Tracks
Overview window:

1 Make any selection that you wish.

2 Choose Copy Selection to New Sequence from
the Tracks window sequence pop-up menu.

A dialog box appears.

3 Type in a name for the sequence.

4 Type in an End Time to determine the length of
the sequence.

By default, the end time is determined by the
length of the selected region.

5 (Optional) Type in any other information you
wish.

6 Press OK to confirm your choice or Cancel to
withdraw the command.

Deleting Chunks
To delete a Chunk, click its name to highlight it and
choose Delete from the Chunks window mini­
menu. To delete several Chunks at once, highlight
the name of each one as described in the Selecting
Chunks section above. You can Undo this
command.

Choosing the Current Playback Chunk
At any given time, one Chunk is designated as the
current playback Chunk. This Chunk is the only
one you can play and record into. Certain
functions, such as recording, are available only to
the currently play-enabled Chunk. For example, if
a sequence is play-enabled, its Tracks window has
record-enable buttons by its tracks. If a song is
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play-enabled, one of its component sequences can
be record-enabled. Only that sequence’s Tracks
window will have record-enable buttons.

You may edit any Chunk in the file at any time
regardless of whether it is play-enabled or not.

To play-enable a Chunk:

■ Click the play-enable button to the left of the
Chunk name. It will turn solid black. The play­
enable buttons of the other Chunks will be hollow.

OR

■ Click the Skip buttons as needed until the
chunk’s name is displayed in the Info bar in the
Control Panel

100:00:00:00 d|
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OR

■ Select the sequence from the sequence pop-up in
the Tracks window

Performer also provides two different methods of
play-enabling Chunks from a remote device.

The first method is with the Chunk select remote
controls found in the Remote Controls window,
where each Chunk is assigned a Macintosh key and
MIDI event. You play-enable a Chunk by pressing
its corresponding Macintosh key or sending its
corresponding MIDI event from your MIDI
keyboard (or controller). Please refer to the chapter
The Remote Controls Window for more
information.

The second method is Chunk Select, which allows
you to cue Chunks for playback by sending a MIDI
Song Select message from a MIDI controller. The
Chunks window column S# displays the Song

Select number that, when received, will cue the
corresponding Chunk for playback. If a Chunk has
no Song number assigned, the S# column displays
a single dash (-).

Most hardware sequencers and some MIDI
keyboard controllers can send and receive Song
Select messages. Simply send a Song Select message
as instructed in that module’s documentation. If
the open file contains a Chunk assigned to the Song
number in the message, that Chunk will be play-
enabled. If more than one Chunk has the same
Song number assigned, the one highest in the
Chunks list will be cued.

When used in combination with the Chunk
Chaining buttons in the Consolidated Controls
panel, a Song Select message cues the
corresponding Chunk to be play-enabled or played
back.

Opening Chunks
Each sequence Chunk can have its own Tracks
window, and each song Chunk has its own Song
window. To see a Chunk’s Tracks or Song window,
click the Chunk’s name to highlight it and choose
Open Chunks from the Chunk window mini-menu.
Or just double-click the Chunk name.

Rearranging the Order of Chunks
You may rearrange the Chunks in whatever order is
most meaningful to you. To change the position of
a Chunk in the Chunks list:

1 Press the type icon of the Chunk you want to
move.

The cursor changes into that chunk icon.

2 Drag and drop the mouse to the position where
you want the Chunk.
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Rearranging the order of the Chunks is a useful
organizational tool. In addition, it lets you
determine the Chunks’ default cueing order when
using the Skip, Cue Chunks, and Chain Chunks
buttons described later in this chapter.

Changing the Name of a Chunk
To change the name of a Chunk:

1 Option-click the name of the Chunk.

A small box will pop up.

2 Type the Chunk name in the box.

3 Press the Return key or click outside the box to
confirm the name or Command-period to cancel
it.

You can use the Enter or down arrow key to
approve the change and edit the next Chunk name
in the list. You can also use the up arrow key to
approve the change and edit the previous Chunk
name in the list.

Entering Comments
To enter or modify comments for a Chunk:

1 Click in the comments field to the right of the
Chunk name.

A box appears. If you’ve already entered a comment
for the Chunk, the entire comment appears
highlighted in the box.

2 Enter or edit the comment.

3 Click OK to confirm the changes you’ve made
and close the comments box, or click Cancel to
discard the changes.

Press the down arrow key or the Enter key to
approve the changes you’ve made and move to the
comment for the next Chunk. The up arrow key
likewise moves to the comment for the previous
Chunk.

When entering or editing a comment, the Return
key starts a new line of text instead of approving the
changes as usual in Performer’s user interface.

Auto Versus Manual End Time
The Chunks window field End Time displays either
the automatic, Performer-generated ending time of
the Chunk, or a time that you have entered
manually. It’s important to understand how this
time affects your music.

Performer offers two ways of playing Chunks
sequentially: by arranging Chunks vertically and
horizontally in the Song window, and by Chunk
Chaining using the Cue Chunks, Chain Chunks,
and Skip buttons in the Consolidated Controls
panel. The End time shown for each Chunk in the
Chunks window affects these two types of chaining
differently.

When a Chunk is in a Song window, the Chunks
window End time does not affect the playback
length of the Chunk. Within a song, a Chunk will
play every note it contains, regardless of its Chunks
window End time. What it does affect is column
placement. Columns appear automatically at the
End time of each Chunk dragged into the Song
window. This makes it easy to place Chunks end to
end.

For example, a Chunk whose last attack is at
4|41322 will have an automatic End time of 5| 11000.
When this Chunk is dragged into a Song window at
time 1111000, a column will appear at 5| 11000,
making it very easy for you to place the next Chunk
in a metrically logical location. If you prefer a 5-bar
phrase, just change the End time to 6| 11000. The
end column will appear at 6| 1 |000,even though the
Chunk only plays through four measures.

Again, remember that the Chunk End time does
not affect playback in the Song window, only the
column placement.



When using the Chunk controls in the
Consolidated Controls panel, you’ll find that each
Chunk’s End time does affect its playback length.
For example, clicking Play with the Chain Chunks
button enabled causes playback of one Chunk after
another, each Chunk playing until the Counter
reaches that Chunk’s End time. Phrases, even notes
that normally would last through the End time will
be cut off. You can avoid this by setting a Chunk’s
End time to be later, thereby building sustain into
the Chunk’s play length.

In summary: regardless of auto/manual status, in
the Song window the End time determines the
Chunk’s ending column location but not its
playback length. During Chunk Chaining,
playback actually stops at the End time.

For more information about the Song window and
Chunk cueing, see chapter 24, “Songs”
(page 305)and “The Chunk Control buttons” on
page 47, respectively.

Building a Song with Chunks
To build a Song out of Chunks in the Chunks
window, drag their type icon into a Song Window.
For complete information, please refer to the next
chapter, The Song Window.

Figure 23-4: Building a song out of sequences.

Copying tracks From One Sequence Chunk to
Another
Use the following procedure to copy between
sequences that have the same track layout (i.e. the
same number of tracks, preferably with the same
MIDI channel assignments). If the sequences have
different track layouts, this procedure will not work
correctly. See chapter 6, “The Tracks Window”
(page 59) for more information.

To copy from sequence A and paste into sequence
B:

1 Activate the Tracks window and choose
Sequence A from the Sequence pop-up menu.

2 Set the start and end times in the Selection bar
to define the region you wish to copy.

To select the entire sequence, simply double-click
the word Selection.

3 Highlight all the track names in Sequence A.

Either click and drag over them, or choose Select
All from the Edit menu.

4 Select Copy from the Edit menu.

As a short cut, press command-C.

5 Choose Sequence B from the Sequence pop-up
menu.

6 Cue the main counter to the measure at which
you want to paste the material into sequence B.

7 Select Paste from the Edit menu.

The information from Sequence A is pasted into
Sequence B at the measure location you chose.
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CHAPTER 24 Songs

In Performer, a song is a collection of Chunks. The
Chunks that make up a song are displayed in that
song’s window, plotted on a grid beneath a
horizontal, non-linear time ruler. The Song
window is the work space in which you arrange the
Chunks in time and in relation to other Chunks.

By dragging and using standard Edit commands
on the Chunks, you can arrange them to
graphically represent the order and combinations
in which you want them to play back. What you see
is what you will hear: adjacent Chunks will play one
after the other, and stacked (vertically aligned)
Chunks will play simultaneously. Arranging in the
Song window can done in real time while the song
is playing back.

QUICK REFERENCE
Chunk Grid: Serves as a workspace in which you
arrange Chunks. The grid will not scroll when you
drag a Chunk to one of the borders; this allows you
to delete a Chunk by dragging it out of the window,
or to drag a Chunk to another Song window.

Song Chunks and Sequence Chunks: Represent
songs and sequences that have been dragged into
the Song window. Click a Chunk once to select it,
twice to open its Song or Tracks window. Change a
Chunks name by option-clicking it in the Chunks
window. If a Chunk’s name is longer than its Chunk
icon, the first several letters will be followed by an
ellipsis.

A Chunk’s size in the Song window is relative to
that of the other Chunks in the window, rather than
absolute. Chunks shorten and lengthen so that
within a region, the longest Chunk always appears
longest in the Song window. A Chunk’s length can 

Figure 24-1: The Song window lets you arrange sequences and songs
graphically in a compact, non-linear display.
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be changed in the Chunks window by setting the
Chunk’s End time to manual mode and typing in
the new value.

The standard Edit commands (Cut, Copy, Paste,
Erase, and Undo) and dragging operations can be
used on Chunks in the Song window.

Marker Strip: Displays the Markers associated with
the open song. Every marker in a song
automatically produces a column at the same time
location in the Song window.

Time Ruler: Indicates the position of each Chunk
in any combination of measure|beat|tick, real, and
SMPTE time formats. The Ruler is non-linear,
meaning the ruler markings denote Chunk Start
and End times rather than regular time units.
Choose which time formats are displayed using the
Song window mini-menu selections Measures, Real
time, and Frames.

Insert button: Produces a dialog box prompting
for a measure|beat|tick, real, or SMPTE time at
which a column should be inserted. Clicking this
button is a shortcut for choosing Insert Column
from the Song window mini-menu.

Song name: Displays the name of the song to which
the window belongs. The song name can be
changed by option-clicking it in the Chunks
window.

Record-enabled Chunk: Displays a record-enable
button in its handle, indicating that if the Song is
play-enabled and the Record button is pressed, it
will begin to record data at its start time. Only
sequence Chunks can be record-enabled.

Column: Serves as a placement guide for Chunks.
Columns appear automatically at the end of each
Chunk, and can be inserted manually by choosing

Insert from the Song window mini-menu or by
clicking the Insert button in the Song window title
bar.

Selected Chunk: Appears inverted to indicate that
it has been selected. Selected Chunks are subject to
Edit commands as well as several Song window
mini-menu commands.

The Song Window Mini-menu
The Song window has the following mini-menu
items:

Copy Conductor Tracks
Edit Conductor Track
Record Enable Conductor Track

Insert Column
Set Record Sequence
Merge Markers
Delete Markers
Merge Chunks to Sequence...

✓Ei; Measures
©Real time
B9 Frames

Figure 24-2: The Song window mini-menu.

Copy Conductor Tracks: Copies the Conductor
tracks of the selected Chunks into the song’s
Conductor track. In time regions where two or
more Chunks are selected, the information from
the uppermost Chunk is used. Markers are not
included in the copy; use the Merge markers
command to copy Chunk markers into a song.

Edit Conductor Track: Opens a Graphic or Event
list editing window of the song’s Conductor track.

Record-enable Conductor: Enables the Conductor
track of the song for recording Tap Tempo
information.
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Insert Column: Produces a dialog box prompting
for a measure, real, or SMPTE time at which to
insert a new column. Clicking the Insert button in
the Song window title bar is a shortcut for choosing
this item.

Set Record Sequence: Enables or disables the
selected sequence for recording within the song.
Only one sequence can be record-enabled at a
time. Choosing this item with more than one
Chunk selected, or with a Song selected, produces
a warning message.

Merge Markers: Merges the markers of all selected
Chunks into the song’s marker list.

Delete Markers: Deletes from the song’s marker list
any markers that are identical to markers in the
selected Chunks.

Merge Chunks to Sequence...: Produces the Merge
Chunks dialog box, which contains the following
options:

■ Copy all tracks creates a sequence containing all
tracks of the selected Chunks, and places this new
sequence in the Chunks window.

■ Merge tracks with identical names creates a
sequence containing all tracks in the selected
Chunks, merges any tracks with identical names,
and places this new sequence in the Chunks
window.

Measures/Real time/Frames: Determine which
time formats should be displayed in the Song
window Time ruler. Choosing a format checks or
unchecks it; the checked formats are displayed.

COLUMNS
When you place a Chunk in the Song window, its
Start and End times are marked with columns.
Columns serve as Chunk placement guides. A 

column following a Chunk does not necessarily
mean that the Chunk will stop playing back at that
point.

For example, Sequence-1 is four measures long and
has an End time of 5| 11000. Dragging it into a Song
window produces a column at the End time, and
playback stops there as well.

Now let’s say that Sequence-1 contains ten bars of
music, but the End time has been manually set to
5| 11000. Dragging the sequence into a Song
window still produces a 4-bar Chunk and a column
at 5| 11000, but the Chunk plays back all the way to
measure ten.

Inserting Columns
Before you can place a Chunk at a time location in
the Song window, there must be a column at that
location. Columns appear automatically at the
Song’s Start time, at each marker in the Song, and
at the end of each Chunk dragged into the Song
window. You can also insert columns manually.

To insert a column manually:

1 Click the Insert button in the Song window title
bar.

You can also choose Insert Column from the Song
window mini-menu. A dialog box appears,
prompting you for a location in measure|beat|tick,
real, or SMPTE time.

2 Click the radio button next to the time format
you wish to use, and enter the time.

3 Click OK to confirm your entry or Cancel to
cancel the Insert.
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If you click OK, the dialog box disappears and a
column appears at the time you specified. If you
click Cancel, the dialog box disappears and the
Song window is unchanged.

4 Place a Chunk at the new column location.

Performer automatically eliminates columns that
do not have an associated Chunk or marker. So, if
you don’t place a Chunk at the new column you
have just inserted, the column will disappear when
the grid redraws.

CREATING A SONG
Songs are created by dragging Chunk icons from
the Chunks window into a Song window, then
arranging the Chunks in any playback order and
combination you wish. This can be done before or
during playback of the Song. To create a song:

1 Choose Add Song from the Chunks window
mini-menu.

A new, empty song is added to the Chunks list.

2 If necessary, add other songs and sequences to
the Chunks list.

For this example we’ll assume you have at least two
Chunks in addition to the song just added.

3 Open the Song window by double-clicking the
song’s name in the Chunks window.

The song’s window opens. Alternately, you can
open the Song window by clicking its name, then
choosing Open Chunks from the Chunks window
mini-menu.

4 Grab a Chunk by clicking the icon to the left of
its name in the Chunks window.

Release the Chunk in the Chunk Grid beneath the
ruler. The Chunk left-justifies to the column at
1111000, and a new column appears to the right of
the Chunk. Note that you cannot drag the song into
its own Song window.

Figure 24-3: Building a song out of sequences by dragging and
dropping them from the Chunks list window into a song window.

5 Continue dragging, option-dragging, and
editing Chunks in the Song window to arrange
them as desired.

Chunks that you place end to end will play
sequentially; stacked Chunks will play simulta­
neously.

When placing Chunks into songs, keep the
following in mind. Every Chunk has its own Chunk
Start time. Every copy of the Chunk uses this time
and will reflect any changes made to the original.
Specifically, a Chunk’s Event List window times
relate to its own start time, say 1111000, even if that
Chunk has been dragged into a song to start
playing at measure 300.
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Similarly, each sequence Chunk has its own Tracks
and Event Editing windows, and each song Chunk
has its own Song window. Every copy of a Chunk is
affected by the edits performed in these windows.

Playing Back a Song
To play a song:

1 Click the title bar of the Chunks window to
activate it.

2 Click the play-enable button of the song you
wish to play.

3 In the Consolidated Controls panel, click Play.

Adjacent Chunks in the song play sequentially;
stacked Chunks play simultaneously.

For another method of playing Chunks one after
the other, see “The Chunk Control buttons” on
page 47.

Scrolling During Playback
The Auto-Scroll command in the Basics menu can
make the Song window scroll during playback. In
addition, the window will automatically open to
the current playback location of the sequence.
Please refer to the Auto-Scrolling section in the
Playback chapter for more information.

Editing in the Song Window
Once you’ve placed a few Chunks into a song, the
Song window offers powerful editing capabilities
to help you arrange your music. These operations
can be done before or during playback.

Select the Chunk by clicking it, or by dragging a
marquee around it.

Open a Chunk’s Song or Tracks window by double­
clicking its icon.

| SONGS

The standard Macintosh Edit commands (Cut,
Copy, Paste, Erase, and Undo) can all be used on
Chunks selected in a Song window, with the
following results.

Cut: Removes each selected Chunk from the Chunk
Grid and places a copy on the Clipboard.

Copy: Places a copy of each selected Chunk on the
Clipboard.

Paste: Makes the cursor change to a mini-likeness of
the chunk to be pasted. Click at the desired column
location in a Song window to complete the paste
operation.

Erase: Removes each selected Chunk from the
Chunk Grid; nothing is placed on the Clipboard.
You can also delete a Chunk from a Song window
by dragging it out of the window.

Undo: Returns the Song window to its state prior to
the last Edit or dragging operation. For example,
dragging a Chunk to a different column enables the
Undo command and updates it to Undo Drag.
Choosing Undo Drag returns the dragged Chunk
to its original position.

Dragging the Chunk to a different column changes
its playback start time. Dragging a Chunk out of
the Song window deletes it from the Song. You can
drag a Chunk from one Song window to another.

Option-dragging, consistent with Performer’s
graphic track editing, leaves a copy of the Chunk at
its original location. Option-dragging a Chunk out
of the Song window does not affect that Song
window; you can option-drag a Chunk into
another Song window, resulting in a copy in each
window.

Dragging and Option-dragging do not cause the
Song window to scroll. This allows you to drag a
Chunk out of a Song window, either to delete it or
to move it to another song. If you need to place a
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Chunk at a time location not displayed in the Song
window, Cut or Copy the Chunk, use the scroll bars
to move to the desired location, insert a column if
necessary, and Paste.

RECORDING MIDI INTO A SONG
Performer lets you record both MIDI and tempo
information into a song. MIDI information can be
recorded into any sequence Chunk contained in
the song, and tempo information can be recorded
into the song’s Conductor track.

To record MIDI information into a song’s
component sequence:

1 In the Chunks window, play-enable the Song
into which you wish to record.

2 Double-click the song’s name to open its Song
window.

If the song’s window was already open, the window
activates.

3 In the Song window, click the sequence Chunk
into which you wish to record.

The Chunk highlights; any Chunks that were
selected are deselected.

4 Choose Set Record Sequence from the Song
window mini-menu.

The highlighted sequence now has a record-enable
indicator in its handle. If you change your mind,
choose Set Record Sequence again to disable the
Chunk.

5 Double-click the record-enabled Chunk.

The Tracks w'indow for the Chunk opens. Each
track has a record-enable button.

6 Record-enable one of the sequence’s tracks by
clicking its record-enable button.

If you wish to record on several tracks, use Multi­
Record as described in the Recording chapter.

7 Locate the point in the song at which you want
to begin recording.

Use the motion controls in the transport controls
or set the Counter directly.

8 Click Record.

The song begins to playback. Performer starts
recording at the record-enabled Chunk’s starting
time or the Auto-Record In time and continues
indefinitely or until the Auto-Record Out time.

9 When you are finished, click Stop.

To hear the recorded material, rewind as necessary
and click Play.

Recording Tempo Information into a Song
Performer also lets you record tempo information
into a song. Say you’ve created a song in which
you’d like to have several tempo changes, even
rubato passages. Tap Tempo is the most musical
way to add these changes to your song — you don’t
need to guess at the beats per minute, or even the
measure numbers where the changes should occur.

Each Chunk has its own Conductor track,
containing the tempo, key, and meter information
for that Chunk. Instead of recording MIDI events,
the Conductor track records tempo information 
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while slaved to Tap Tempo. Tap Tempo lets you
control the beat by simply playing a MIDI event
like a metronome that Performer follows and can
record. If recorded, the information becomes a
tempo map that can be edited in the Conductor
track and that Performer will follow during
subsequent playbacks of the sequence.

You can even record tempo information into the
song’s Conductor track while recording music into
one of the song’s component sequences.

To record tempo information into a song’s
Conductor track:

1 In the Chunks window, play-enable the Song
into which you wish to record.

2 Double-click the song’s name to open its Song
window.

If the song’s window was already open, the window
activates.

3 Choose Record-Enable Conductor from the Song
window mini-menu.

The song’s Conductor track is now record-enabled;
this is indicated by a check mark in the mini-menu
next to Record-Enable Conductor.

4 Choose Receive Sync from the Basics menu.

The Receive Sync dialog box appears.

5 Click the radio button next to Tap Tempo, then
choose the port, MIDI channel, MIDI event, and
countoffbeats you wish to use.

Choose an event/channel combination that you are
not using as a Remote Control. Refer to the Remote
Controls chapter for information on Remote
Controls assignments, and to the Receive Sync
chapter for specific information on Tap Tempo.

6 Optional: Click the sequence Chunk into which
you wish to record.

If you wish to record MIDI data while recording
tempo information, you must record-enable the
desired sequence within the song, and track(s)
within that sequence.

7 Choose Set Record Sequence from the Song
Window mini-menu.

The highlighted sequence now has a record-enable
indicator in its handle. If you change your mind,
choose Set Record Sequence again to disable the
Chunk.

8 Double-click the record-enabled Chunk.

The Tracks window for the Chunk opens. Each
track has a record-enable button.

9 Record-enable one of the sequence’s tracks by
clicking its record-enable button.

If you wish to record on several tracks, use Multi­
Record as described in the Recording chapter.

10 Choose Slave to External Sync from the Basics
menu.

11 Click Record and begin tapping the specified
tap event at the desired tempo.

The Play button remains grey until you have
tapped the specified number of countoffbeats.
Performer starts recording at the record-enabled
Chunk’s starting time and continues indefinitely or
until the Auto-Record Out time, whichever is
sooner.

12 When you are finished, click Stop.
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To hear the recorded material, rewind as necessary
and click Play.

SONG WINDOW HINTS
The Song window can be used to quickly create
special effects. Try some of the suggestions here to
get started.

Creating an Echo Effect
To add an echo effect to part of a song, try the
following.

1 Find the Chunk(s) that you wish to echo.

Note the starting time of each according to the
Song window Time Ruler.

2 Click the Insert button in the Song window title
bar.

The Insert Column dialog box appears, prompting
you for the measure, real, or frame time at which a
column should be inserted.

3 Enter a measure time about 50 ticks after the
original Chunk’s starting time within the Song.

To create an echo that plays in rhythm with the
original Chunk, use divisions of the beat (for
example, a quarter note=480 ticks sotry60,120,or
240). A column will appear in the Song window at
the time you specify.

4 While holding down the Option key on your
Macintosh keyboard, drag the Chunk to the new
column.

A copy of the Chunk remains at the original
location.

5 Play back the song to hear the result.

Experiment with different amounts of delay to
achieve the best effect.

Exporting a song to other music software
programs
Song Chunks cannot be directly converted to other
file formats, but you can use the Merge Chunks to
sequence command in the Song window mini­
menu to convert the song into a sequence. The
resulting sequence can be converted to any
alternative file format available in the Save As
command dialog box. See “Saving a sequence in
another format” on page 19.

Managing Markers in a Song
Every Chunk has its own Markers list. (See
“Markers” on page 289 for an introduction to
markers.) Markers serve many functions, from
simple references to auto-locators. You’ll often find
when you place a Chunk into a song that it would
be useful to see the Chunk’s markers in the context
of the whole song. The Merge Markers command in
the Song window mini-menu lets you do just that.
Simply select all the component Chunks whose
markers you’d like to copy into the song, and
choose Merge Markers. All unlocked markers in the
selected Chunks now exist in the Song, and are
displayed in the Song’s marker strip and Markers
window.

You can just as easily delete a Chunk’s markers
from a song. Select the Chunks whose markers
should be removed from the song and choose
Delete Markers. Performer compares the song’s
markers to those of the selected Chunks, and
removes any that match up. The marker list of the
Chunk is not affected. Keep in mind that once you
merge markers of a Chunk into a song, dragging
the Chunk to a different location will not move the
markers. Further, selecting the relocated Chunk
and choosing Delete Markers will not have any
effect, as the markers are no longer associated with
the Chunk.

Markers can be of great help when building a song
or score because Performer automatically
generates a column in the Song window for each 
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marker. You can use the Song’s Markers window to
create a list of section markers, which will become
Chunk placement columns in the Song window.
Marker-generated columns are particularly useful
for placing Chunks at hit points, which can be
created during playback using the Record Hits
command found in the Markers window mini­
menu for each Chunk.

Chunking and Synchronization
Chunking (arranging Chunks in the Song window)
is the ideal method of playing multiple Chunks
while slaved to external sync. Firstly, Chunking
allows seamless transitions between Chunks
within a song. What’s more, these Chunks can be
edited independently even after they have been
dragged into a song.

Secondly, rather than having a different Start time
and tempo map for each Chunk within a song, the
song itself has one Start time and one Conductor
track to govern all component Chunks. In fact,
when placing Chunks into a song you could use Set
Chunk Start, found in the Chunks window mini­
menu, to change each Chunk’s start time to
correspond with its playback location in the song.
The Chunk’s SMPTE start times will shift
accordingly, matching those in the Song window
Time Ruler. If a Chunk contains tempo changes,
you can use the Copy Conductor tracks mini-menu
command to make every SMPTE time of a
component Chunk match those of the song that
contains it.

Finally, film scoring applications benefit greatly
from the Song window. Using the Record Hits
feature in the Markers window, you can create a
series of SMPTE hit points associated with a song.
Each hit point becomes a marker. Because
Performer inserts a column in the Song window for
each Marker, you automatically have a Chunk
placement guide at each hit point in the song.

Matching chunk start times with their location
in a song
When Chunks are placed in a song, the song itself
has one Start time and one Conductor track to
govern all component Chunks. When placing
Chunks into a song, you may want to change each
component Chunk’s start time to match its
playback location in the song. Then, the SMPTE
start time of the component Chunk will be the
same as its SMPTE location with respect to the
song.

To match a component Chunk’s SMPTE start time
with the song that contains it, look at the column
where the Chunk starts in the Song window and
make a note of the SMPTE time of the column.
Then, set the Chunk’s start time to be the same
SMPTE time location. For information about how
to set the start time, see “Setting the start time” on
page 54.

If the component Chunk contains tempo changes,
you can use the Copy Conductor tracks mini-menu
command to copy all of its tempo changes into the
song’s Conductor track, making every SMPTE hit
point of a component Chunk match its SMPTE
time in the song that contains it.

Auto Versus Manual End Time
The Chunks window field End time displays either
the automatic, Performer-generated ending time of
the Chunk, or a time that you have entered
manually. It’s important to understand how this
time affects your music.

Performer offers two ways of playing Chunks
sequentially: by arranging Chunks vertically and
horizontally in the Song window, and by Chunk
Chaining using the Cue Chunks, Chain Chunks,
and Skip buttons in the Consolidated Controls
panel. The End time shown for each Chunk in the
Chunks window affects these two types of chaining
differently.
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When a Chunk is in a Song window, the Chunks
window End time does not affect the playback
length of the Chunk. Within a song, a Chunk will
play every note it contains, regardless of its Chunks
window End time. What it does affect is column
placement. Columns appear automatically at the
End time of each Chunk dragged into the Song
window. This makes it easy to place Chunks end to
end.

For example, a Chunk whose last attack is at
414|322 will have an automatic End time of 5| 11000.
When this Chunk is dragged into a Song window at
time 111|000, a column will appear at 5| 11000,
making it very easy for you to place the next Chunk
in a metrically logical location. If you prefer a 5-bar
phrase, just change the End time to 6| 11000. The
end column will appear at 6111000, even though the
Chunk only plays through four measures.

Again, remember that the Chunk End time does
not affect playback in the Song window, only the
column placement.

When using the Chunk controls in the
Consolidated Controls panel, you’ll find that each
Chunk’s End time does affect its playback length.
For example, clicking Play with the Chain Chunks
button enabled causes playback of one Chunk after
another, each Chunk playing until the Counter
reaches that Chunk’s End time. Phrases, even notes
that normally would last through the End time will
be cut off. You can avoid this by setting a Chunk’s
End time to be later, thereby building sustain into
the Chunk’s play length.

In summary: regardless of auto/manual status, in
the Song window the End time determines the
Chunk’s ending column location but not its
playback length. During Chunk Chaining,
playback actually stops at the End time.
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chapter 25 Clippings

OVERVIEW
A clipping is anything useful that you’d like to
conveniently stash for future use. It could be a
single note, a four-bar phrase, or an entire
sequence — with any number of tracks. It can be
MIDI data, audio data or both. It can even be a
word processing document on your hard drive
with some song lyrics in it. A clipping can consist
of Performer data in a portion of any size. It can
also consist of any item found on your MacOS
desktop, including folders, documents from other
applications, and so on.

Performer gives you Clipping windows to put all of
this material at your fingertips. Clipping windows
are meant to be convenient repositories for bits of
stuff — audio, MIDI or otherwise — that you’d like
to stash conveniently and recall later at your
fingertips. You can store clipping windows with a
particular Performer file, or you can store them
independently the file you have open, so that their
contents are always available.

CLIPPING WINDOW QUICK REFERENCE

Figure 25-1: A dippings window.

Clipping window title bar

A text document

A track data clipping

An audio clipping



CLIPPING WINDOWS
The following sections show you how to create,
rename, use, and otherwise get the most out of
clipping windows.

Creating a new clipping window
To create a clipping window, choose
Clippings>New Performer Clipping Window or
Clippings>New Project Clipping Window from the
Windows menu.

Here’s the difference: a Performer clipping window
will be available regardless of the file you have
open. A project clipping window is specific to the
file you create it in; it will save and close with the
file.

Figure 25-2: The Clippings menu.

A new clippings window appears.

V Untitled

You can create as many clipping windows as you
like.

Clippings windows are actually folders
Each clipping window actually consists of a folder
in either the Clippings folder in your Performer
project folder (for file-specific clipping windows)
or the Preferences folder in your start-up System
Folder (for global clipping windows).

Since Clippings windows are simply folders in the
above-mentioned locations, you can also make
clipping windows by simply creating folders (with
any name you want) in those locations. They will
then appear as clippings windows in Performer the
next time you open the project or start Performer.

Renaming a clippings window
To rename a clippings window, option click its
name, or change the name of its corresponding
folder in the MacOS Finder.

To rename the clippings window,
option-dick the name.

Opening & closing existing clipping windows
To open a clipping window or bring it to the front,
select it by name from the bottom part of the
clippings menu as shown in Figure 25-2. To close a
clipping window, click the close box.

Clipping windows remember their position on the
screen.

Opening a clipping window's folder
To open the folder for a given clipping window,
double click on the title bar of the window.

Deleting a clipping window
To delete a clipping window:

1 Make it the active window.

2 Choose Clippings>Delete Clipping Window from
the Windows menu.

Or you can trash the window’s corresponding
folder in the finder.

Viewing by name or large/small icon
The View by options in the Clippings sub-menu as
shown in Figure 25-2 let you display clippings by
name only, a small icon or a large icon.
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CLIPPINGS
The following sections show you how to create,
rename, use, and otherwise get the most out of
clippings.

Making a clipping
To make a clipping, select some data and choose
the Copy to Clipping Window command in the Edit
menu. Or you can press command-option-c to
copy to the last clipping window that you copied to.

You can also drag items from the Finder or from
any location from which soundbites can be
dragged (such as the Samplers window, the
Soundbites window and other clipping windows).

Dragging clippings into other Performer
windows
Once you’ve made a clipping by copying it to a
Clippings window, you can drag it into any other
eligible window in Performer. Eligible windows are
windows that can accept the type of data included
in the clipping. For example, you can’t drag an
audio clipping into a MIDI track. But you can drag
a clipping that contains both audio and MIDI data
into the Tracks Overview — as long as it contains
both MIDI and audio tracks.

To drag and drop a clipping, drag it by its icon (to
the left of its name) and drop it into the desired
window. Or, you can click it first to select it and
then click on it anywhere to grab it.

When you drag and drop a clipping, you are
actually making a copy of it. (The original remains
in the Clippings window.)

Apoqqiatura (**)____________
J1 Apogqiatura (b)____________

Audio Drum loop 1
Bass pop__________________

J1 Banjo roll style 1___________
J- Bass slap

Figure 25-3: To drag and drop dippings, grab their icon. Or, you can
select it first and click anywhere on it to grab it.

If the Clippings window is in Show by name
mode, there is no icon to grab. In this case,
Performer lets you click anywhere on a clipping to
drag it. Because of this, however, Performer
disallows you from dragging over multiple
clippings to select them. If you would like to do so,
simply switch to one of the show by icon modes.

Track data clippings
Anything that you can put in a track can be stored
as a track data clipping. This includes MIDI, audio
sequences, conductor data, etc.

Track data clippings appear with a note icon when
the clippings window is in small icon display mode.
These types of clippings can be dropped anywhere
that you can view MIDI data, including the Tracks
Overview, any Graphic Editor, the Event List and
QuickScribe.

Soundbite and soundfile clippings
Soundbite clippings, when dragged from a clipping
window, become soundbites. They can be dropped
anywhere in Performer that soundbites can be
dropped. Both Soundbites and soundfiles show up
with a single-waveform icon in the clippings
window for mono files or a duel-waveform icon for
stereo files.

Selecting clippings
To select a single clipping, click its name. To select
several clippings, drag across their names, or shift
click each one.

Auditioning clippings
To audition a clipping, double click the clipping. To
audition multiple clippings, select them as
described above and then double-click one of the
highlighted clippings.

If you are auditioning audio clippings and don’t
here anything, you may have soundbites whose
parent soundfile has been deleted, or they might
not match the current sample rate.
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In the case of MIDI data, you may not have a MIDI
device connected properly. Performer attempts to
play MIDI clippings on the devices that they were
originally assigned to when created. Performer
tries to find a suitable device if the original device is
not available.

If auditioning from the clippings window is not
working out, you can always drop the clipping into
a track and set up the playback settings exactly the
way you want.

Deleting a clipping
To delete a clipping, drag it to the trash, or select it
and press the delete key.

Renaming a clipping
To rename a clipping, option click the name of a
clipping.

Re-ordering clippings i n the Clippings window
You can re-arrange items in the clipping window by
grabbing their icon to the left of their name and
dragging up or down in the list as desired.

Launching other documents from the
clippings window
Double clicking on files and folders in the clippings
window to open the folder or open a document in
its native application.

Dragging items in from the Finder
A clipping window can contain any item that the
finder can contain.

Dragging clipping files in from the Finder
Clippings files (located in one of Performer’s
clipping folders) can be dragged from the Finder to
any window in Performer that accepts clippings.

Alias clippings
Alias clippings work just like the original file —
with two exceptions: rename and delete operate on
the alias and not on the original file. Otherwise,
Performer handles the alias just like the original
file.



chapter 26 The Conductor Track

The Conductor track is a special track containing
markers, meter, tempo and key change
information. Every sequence and song has a
Conductor track; it cannot be deleted. You may use
the commands from the Edit menu in the
Conductor track to Cut, Paste, Repeat, Shift, and
otherwise edit tempo, meter, and key maps, as well
as markers. In addition, the Conductor track can
be used to directly insert simple tempo, meter, and
key changes, as well as to ‘record’ a tempo map
entered in real time using Tap tempo synchroni­
zation.

The Conductor Track has two available Event
Editing windows: the Event List window and the
Graphic Editing window. The examples in this
chapter refer to the Conductor track’s Event List
window; see “Graphic Editing in the Conductor
Track” on page 182 for more information.

BASICS
The Conductor track automatically appears in the
Tracks window for each sequence. The Conductor
track cannot be deleted or renamed; it can be
moved and given comments like a standard track.
The Conductor track has a record-enable button
for use with Tap tempo synchronization, described
in the Receive Sync chapter. The Conductor track
cannot be looped.

A song’s Conductor track can be opened by
choosing Edit Conductor Track from the Song
window mini-menu.

The Conductor track contains four types of events:
Tempo changes, Meter changes, Key changes, and
Markers. These events are not MIDI data; instead,
they control or conduct your music’s performance 

during playback. The tempo, meter, and key events
can be edited like standard MIDI events, either
with the commands on the edit menu or directly in
the Conductor track Event List or Graphic Editing
window. Unlocked markers may be edited in the
Conductor Track; locked markers may only be
edited in the Markers window.

The following sections describe each type of event
in some detail; for more information on the
Change Key, Change Meter, and Change Tempo
commands, or the Markers window, see the
appropriate chapters.

Key Changes
Key change events display the name of the key.
User-defined key signatures are displayed as
‘Custom’. See chapter 27,“Change Key” (page 327)
for a full description of key signatures in
Performer.

1J.1JOOO .C Major

Also note that this section discusses the editing of
key changes in the Conductor track Event List
window. See “Graphic Editing in the Conductor
Track” on page 182.

To insert a Key change event in the Conductor
track Event List window:

1 Press the Insert button in the Event List window
title bar.

2 Select Key Change from the menu.

A new Key change event appears, with the location
field highlighted for editing.
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3 Type in the measure, beat, and tick location and
key for the event.

Use the Tab key to move from field to field. When
you highlight the key field, the Change Key dialog
box will appear. See chapter 27, “Change Key”
(page 327) for information on this dialog box.
Click OK to confirm the key; the key you specify
will be in effect until the next key change.

4 Press the Return key to confirm your choice.

You can cancel the insertion by clicking anywhere
else on the screen.

To edit a Key change event in the Conductor track
Event List window:

1 Option-dick or double-click on the Key change
event.

A pop-edit box will appear.

2 Change the location or key information.

Use the Tab key to move from field to field. When
you highlight the key field, the Change Key dialog
box will appear. See chapter 27, “Change Key”
(page 327) for information on this dialog box.
Click the OK button to confirm the key change; the
key you specify will be in effect until the next key
change.

3 Press the Return key to confirm your edit.

You can cancel the edit by clicking anywhere else
on the screen.

Meter Changes

Meter change events display the time signature (the
number of beats per bar, over the duration value
which gets the beat) and the click value, (the
duration value between metronome clicks). See
chapter 28, “Change Meter” (page 331) for more
information about these values. Moving meter
change events, or inserting them using the Insert
button, can cause unexpected results. “Meter
Changes and Partial Measures” on page 324 before
attempting to move or insert a meter change.

4/4 click J

This section discusses the editing of meter changes
in the Conductor track Event List window. See
“Graphic Editing in the Conductor Track” on
page 182 for more information.

To insert a Meter change event in the Conductor
track Event List window:

1 Press the Insert button in the Event List window
title bar.

2 Select Meter Change from the menu.

A new Meter change event will appear, with the
location field highlighted for editing.

3 Type in the measure, beat, and tick location,
meter, and metronome click value for the event.

Use the Tab key to move from field to field, and
type in the correct values. Use the mouse to select
your choice of click value.

4 Press the Return key to confirm your choice.

You can cancel the insertion by pressing the escape
key or by pressing command-period. Note that if
you typed in a tick location other than 000, the 
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meter change will show 000 after you press return.
This is because a meter change always starts a new
measure. See “Meter Changes and Partial
Measures” on page 324.

To edit a Meter change event in the Conductor
track Event List window:

1 Option-click or double-click on the Meter
change event.

The event will be highlighted.

2 Change the location or meter information.

Use the Tab key to move from field to field, and
type in the correct values. Use the mouse to choose
the click value from the pop up box.

3 Press the Return key to confirm your edit.

You can cancel the edit by pressing the escape key
or by pressing command-period. Note that if you
typed in a tick location other than 000, the meter
change will show 000 after you press return. This is
because a meter change always starts a new
measure. See “Meter Changes and Partial
Measures” on page 324.

Tempo Changes

Tempo change events display the duration value for
the tempo marking, i.e. the note value of the basic
beat, and the tempo value itself, as a certain
number of beats per minute. Tempo changes can
appear singly, indicating an abrupt change in
tempo, or as a series of events, approximating a
smooth increase or decrease in tempo. In this
regard they resemble continuous controller or
pitch bend information. For more information on
tempo events, see chapter 29, “Change Tempo”
(page 337).
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There are two ways to insert Tempo change invents
in the Conductor Track: by directly inserting them,
and by recording them while slaved to Tap tempo
synchronization. The following procedures cover
direct insertion and editing in the Conductor
Track.

For information on recording a tempo map in real
time, see “Tap Tempo” on page 393. Recording in
Tap Tempo creates normal tempo events which can
be edited as described below.

Also “Graphic Editing in the Conductor Track” on
page 182 for information on editing tempo
changes graphically.

To insert a tempo change event in the Conductor
track Event List window:

1 Press the Insert button in the Event List window
title bar.

2 Select Tempo Change from the menu.

A new tempo change event will appear, with the
location field highlighted for editing.

3 Type in the measure, beat, and tick location and
tempo for the event.

Use the Tab key to move from field to field, and
type in the correct values. Use the mouse to select
your choice of beat value.

4 Press the Return key to confirm your choice.

You can cancel the insertion by pressing the escape
key or by pressing command-period.

To edit a tempo change event in the Conductor
track Event List window:

1 Option-click or double-click on the tempo
change event.

The event will be highlighted.
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2 Change the location or tempo information.

Use the Tab key to move from field to field, and
type in the correct values. Use the mouse to choose
the beat value from the pop up box.

3 Press the Return key to confirm your edit.

You can cancel the edit by pressing the escape key
or by pressing command-period.

Viewing and typing in frame click tempos

If you write music for film, you might be
accustomed to expressing tempos in frame-clicks
as well as beats per minute. In Performer, you can
type in tempos using either format. You can also
display tempos throughout the program, including
the Change Tempo dialog, in frame click tempos
(e.g. 12-6 or 13/4). For further information about
working with frame click tempos, see “Displaying
and typing in frame-click tempos” on page 52.

Markers
Markers are visible in all Event Editing windows,
but they may only be edited in the Conductor track
editing windows. Markers cannot be created
directly in the Conductor track editing windows;
use the Markers window to insert or record new
markers, or drag and drop new ones in the Tracks
overview. Also, locked markers cannot be edited in
the Conductor track. Unlocked markers can be
edited in the Conductor track with the Edit Menu
commands. For more information on pop-editing
markers see chapter 22, “Markers” (page 289).

9 Bridge

EDITING IN THE CONDUCTOR TRACK
The Edit commands Cut, Copy, Paste, Erase,
Repeat, Merge, Snip, Splice, and Shift all function
on the events in the Conductor track. You can use
them to move tempo and meter changes together
with other tracks in a sequence, shift tempo maps
for precise alignment with synchronized video or 
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audio, or to repeat tempo, meter, and key changes
in looped sections. You can insert and edit tempos
in the Conductor track without stopping playback.

Be sure to learn how Performer’s Smart Selections
feature affects Conductor Track editing by reading
“Barlines Are Preserved in the Conductor Track”
on page 215.

To use the Edit commands on the Conductor track
of a sequence:

1 Highlight the Conductor track name in the
Tracks window and set the Start and End times in
the Selection Bar for the correct region,

OR

2 Open an Event Editing window (Event List or
Graphic Editing) for the Conductor track and
highlight the correct events.

3 Select the desired command from the Edit
menu.

To use the Edit commands on the Conductor track
of a song:

1 Open the Song window.

Do so by double-clicking the Song name in the
Chunks window.

2 Choose Edit Conductor track from the Song
window mini-menu.

The Event Editing window for the song’s
Conductor track will appear.

3 Highlight the events you wish to edit.

4 Select the desired command from the Edit
window.
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The Edit menu commands affect events in the
Conductor track in the same way as normal MIDI
data. See chapter 15, “Selecting” (page 207) and
chapter 16,“Edit Commands” (page 217) for more
on how to select regions and use these commands.

When a region is cut or copied from the Conductor
track, meter and tempo events representing the
current meter and tempo values are automatically
inserted at the beginning of the region in the
clipboard. This guarantees that the region will keep
its original meter and tempo when pasted
elsewhere in the sequence or song. These
automatically created meter and tempo change
events may be edited normally after the region is
pasted back into the Conductor track.

Note that editing meter changes can cause
unexpected results. Read the section on Meter
Changes and Partial Measures below before editing
Meter change events.

Using the View Filter with the Conductor Track

To effectively edit events in the Conductor track it
is important to understand how the View Filter
affects the commands on the Edit menu. Please
review “Setting the View Filter” on page 217 and
“The Event List View Filter” on page 142 before
working extensively with the Conductor track. The
View Filter affects the Conductor track the same
way as it does for regular tracks.

Here are some guidelines to remember when using
the View Filter:

The View Filter makes edit commands only affect
the types of data that are currently visible. For
example, pasting over existing events will erase
only those types of events that are visible (selected
in the filter); other events are retained and merged
with the pasted data.

I THE CONDUCTOR TRACK

The View Filter is important when editing the
Conductor track because it is common to want to
edit just one element, e.g. tempo changes, without
affecting the other events in the track. For example,
the tempo changes in measure two of the sequence
shown below can be moved to measure one
without moving anything else as follows:

1 Choose Set View Filter from the Basics menu.

The View Filter window appears.

2 Option-click the check box for Tempo.

This is a shortcut for deselecting everything but
Tempo change events.

3 Highlight the Conductor track in the Tracks
window.

4 Set the Selection Bar for the correct region.

In this case, the region starts at 2/1/000 and ends at
3/1/000.

5 Select Shift from the Edit menu.
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6 In the Shift dialog box, advance by 1 measure
and click OK.

7 Set the View Filter back to normal.

The Tempo changes appear in the first measure; the
Meter changes are unaffected.

El
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If the View Filter had not been set during this
example, the Meter change in the second measure
would have been shifted along with the Tempo
changes, and the Meter change in the first measure
would have been erased by the Shift operation.

Meter Changes and Partial Measures

Performer lets you to place a Meter change event
anywhere in a sequence or song. This allows a great
deal of flexibility in laying out your music, but can
produce unexpected results. For example, it is
possible to place a Meter change in the middle of a
measure, but this measure will be truncated at the
location you specify for the new meter. This
location becomes the downbeat of the first measure
in the new meter.

The following simple rule should help clarify what
happens in such situations:

A Meter change event always starts a new
measure.

For example, if the Insert button in the Event List
title bar is used to place a meter at 3| 11240, when
you press the Return key to confirm the insertion,
the meter change location will change to 3| 11000.
This is because a meter must begin a new measure,
and all measures begin at zero (000) ticks.

Here’s another example: if the Insert button is used
to place a 3/4 meter at the third beat of a 4/4
measure, the result is a two beat measure (still
marked as 4/4!) followed by a whole 3/4 measure.
Inserting the Meter change results in a partial
measure, that is, a measure lacking its full duration.

While such partial measures are not always useful,
they can be handy in lining up cues for film and
video work, since they let you start a measure
precisely at a SMPTE time by creating a meter
change at the right spot.

Partial measures may also result from using the
Edit commands to Paste, Merge, or Repeat meter
changes in the middle of existing measures. Once
again, each new meter change event will begin a
new measure.

You can help avoid partial measures by leaving the
Smart Selections command in the Edit menu
checked when you are editing the Conductor track.

Correcting Unwanted Partial Measures
It is important to remember that meter changes
only affect the way data is displayed; they never
affect the MIDI data itself or the way it sounds
when it is played back. If the meter map for a
sequence or song becomes complex or confusing
during editing, simply erase the meter changes and
re-enter them from the start of the region. See
“Erasing the meter map to start over” on page 335.

Another way to remove partial measures is to use
the Auto fix-up partial measures preference. See
“Getting rid of partial measures” on page 336.

Looping and the ConductorTrack

The Conductor track cannot be looped. If you need
to repeat tempo or meter changes in a looped
region, use the Repeat command from the Edit
menu to make consecutive copies of the Conductor
track over that region.
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When using the Memory-cycle feature to play a
section repeatedly, meter and tempo changes in the
conductor track will play as usual. When doing so,
it is often useful to switch tempo control in the
Metronome panel to the Metronome slider. Doing
so temporarily disables tempo changes so that they
don’t complicate recording.
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chapter 27 Change Key

Key signatures provide a way to interpret MIDI
note data. In music notation, there are several ways
to write every pitch. For example, although G
sharp and A flat sound the same and describe the
same pitch, a G sharp would make less sense in the
key of E flat than an A flat would. Performer allows
you to specify key signatures in your sequences,
making the display of notes in the Event Editing
windows clear and musically accurate. Key
signatures are also extremely important when
viewing a sequence in music notation with
Performer’s QuickScribe notation window; setting
the correct key signatures ensures that the music
will be properly notated.

QUICK REFERENCE

Key type

Start and
end location!

Key select
scroll bar

Keyname

Spelling
table

Spelling

pop-up
menu

Start and End Locations: Displays the region over
which the key change occurs. Click on a value to
highlight it, and type the desired starting and
ending measure locations. After each change is
made, the From location is set to the previous To
location. Click on the end of sequence button to
change key from the From location to the end of
the sequence.

Key type: Click on the appropriate radio button to
select a Major, Minor, or user-defined Custom key.

Key Signature Scroll Box: Use the scroll bar and
arrows to select the desired key signature.
Changing the key in this box automatically updates
the key name and spelling table.

Key Name: Displays the name of the key signature.
The name appears as the key change event in the
Event Editing windows. The name is set
automatically when the Major or Minor key types
are chosen. Click the name and type to change it.

Spelling Table: Displays the spelling of the twelve
chromatic notes for the currently selected key.
Change a spelling by pressing on the note letter and
selecting the desired spelling from the pop-up
menu that appears.

BASICS
Key signatures in the Conductor track of a
sequence apply to all the tracks in the sequence. At
any given location, there can be only one key
signature for all tracks. You can have as many key
changes as you like in a sequence.

Key changes appear for reference in all track Event
Editing windows. They may be edited only in the
Conductor track, either directly in the Conductor
track Event Editing window or from the Tracks
window. Each key change affects the spelling of
notes to just before the beginning of the next key
change. Key changes only affect the display of note
pitches; they do not change the actual MIDI data in
your sequence.

If there is no key signature entered at the beginning
of the sequence, the default key is C major (no
sharps or flats).
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It is possible to put key changes in the Conductor
track of a song, but they will have no effect on the
spellings of notes in sequences contained in the
song. Only key changes in the Conductor track of
the sequence will affect notes within that sequence.

Performer's Key Signatures
Key signatures in Performer actually have two
components: the standard key signature (up to
seven sharps or seven flats), and note-spelling
assignments for non-diatonic notes (notes not in
the basic scale of the key). A key has five non-
diatonic notes; Performer allows you to decide how
each of them will be spelled. In the key of D, for
instance, you can name the note that lies between B
and C sharp either B sharp or C natural.

You can choose from three types of key signatures:

■ Major: Any key from C sharp major (7 sharps) to
C flat major (7 flats)

■ Minor: Any key from A sharp minor (7 sharps)
to A flat minor (7 flats)

□ Custom: You can choose a signature with 7
sharps to 7 flats and call it what you wish. This is
useful for modal key signatures: C Phrygian, for
example, has 4 flats. The key signature name is only
for your reference: only the key signature itself is
displayed on the staff in the QuickScribe notation
window.

To set a key signature or add a key change:

1 Specify which sequence the key change affects.

If a Tracks window is active, the key insertion will
apply to that sequence. If the Chunks window is
active, the key insertion will apply to the
highlighted Chunk or, if no Chunk is highlighted,
to the current play-enabled Chunk. If an Editing
window is active, the key insertion will apply to
whatever sequence it belongs to.

2 Choose Change Key from the Change menu.
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A dialog box will appear. Notice that the name of
the sequence in which the key change will be placed
is displayed at the top of the dialog box.

3 Specify the From and To locations.

These locations specify the starting and ending
locations for the key change. Click on the fields and
enter the desired measure|beat|tick values. If you
have just entered a key change, the From location is
automatically set to the previous To location. Click
on the end of sequence button to change key from
the From location to the end of the sequence.

4 Specify the type of key signature to be inserted.

Click the options for major, minor, or custom, as
explained above.

5 Use the Key Signature Scroll bar to select the key
signature.

Use the scroll bar and arrows to choose the desired
number of sharps or flats. The key name and
spelling table are automatically updated as you
scroll.

6 (Optional) Enter a name for the key change.

If you have chosen a Major or Minor type, the
name is automatically set.

7 Choose the note spellings for each non-diatonic
note in the key.

Click on each note to select it and choose the
desired spelling from the available ones displayed.

8 Press the Change button to enter the change.

The Change button enters the key change and
leaves the dialog box open so that you can insert
more key changes.
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You can repeat this procedure to enter as many key
changes as you wish. When you are done entering
changes:

9 Click on the triangular Close box at the top left
to close the dialog box.

Viewing Key Changes
Key changes in a sequence can be viewed in two
places: in the Event Editing windows for each track
and in the Conductor track for that sequence. Key
changes can be edited only in the Conductor track:
they cannot be modified in the Event Editing
windows for standard tracks. Key changes can be
omitted from the editing windows by turning off
their display with the View Filter.

Editing Key Changes in the Conductor Track

Key changes can be edited directly in either Event
Editing window (Event List or Graphic Editing) for
the Conductor track. This section discusses the
editing of key changes in the Event List window.
See “Graphic Editing in the Conductor Track” on
page 182 for details.

In the Event List for the Conductor Track, the
location of a key change can be edited by altering
its starting time. The key change itself may be
modified by Option-clicking on it. The Change
Key dialog box appears in which you can enter the
modification. The box that appears is slightly
different than the one chosen with the Change Key
command: the Change button is replaced by OK
and Cancel buttons, and the sequence name and
From and To location fields are missing.
Otherwise, this box works exactly as described
above.

To edit a key change in the Event List window for
the Conductor track:

1 Double-click on the Conductor track in the
Tracks window.

An Event Editing window will open. If the Graphic
Editing window appears, go to the mini-menu on
its title bar and choose Event List. The Event List
window for the Conductor track will appear.

2 Option-click on the key change event that you
wish to change.

If necessary, use the scroll bar to locate the desired
key change event. The Change Key dialog box
appears.

3 Change the key type, signature, name, and
spelling as desired.

See the section above on entering key changes for
information on these fields.

4 Press OK to confirm your changes or Cancel to
cancel them.

Using the Edit Commands with Key Changes

You can apply the commands from the Edit menu
to key changes in the Conductor track: key
signatures can be cut, copied, pasted, spliced, etc.,
just like other events. The region to edit in the
Conductor track may be selected by highlighting
events in its Event Editing window or clicking on
the Conductor track to highlight it and specifying a
region in the Selection Bar. Key change
information can be included in an edit operation
involving note and other MIDI events by including
the Conductor track along with the selected tracks.
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chapter 28 Change Meter

Meters specify the way musical time is counted and
measured. In Performer, meters affect the way
measure|beat|tick locations are displayed in the
Counter, dialog boxes, and Event Editing windows.
Meters also affect the Click and countoff. In
addition, they impact the way information is
displayed in Performer’s QuickScribe notation
window. The Change Meter command allows you
to enter any number of meter changes in a
sequence.

QUICK REFERENCE

Metronome
Click value

Start and end locations

Meter Marking: Displays the meter in standard
musical format. Click on the numerator and/or
denominator and type in new values to change it.

Start and End Locations: Displays the region over
which the meter change takes effect. Click in the
From box to set the starting location. Click in the
To box to set the ending location. Click on the end
of sequence button to extend the region to the end
on the sequence.

Options: Click on the appropriate radio buttons
and/or check box to select the desired options. The
Only move barlines option does not affect the actual

events in the sequence. The Realign music
automatically and Adjust durations options erase or
change events to fit the meter.

Metronome Click value: Displays the duration
between clicks and between counter updates. Click
on the desired note value. Click on the dot for
dotted durations (i.e. one and a half times the
chosen note value).

BASICS
A meter consists of a beat value and the number of
beats per measure. The beat value is generally the
rhythmic pulse or beat of the music; a measure
consists of a certain number of these beats.
Performer displays meters in the standard musical
fashion as a fraction, with the beat value in the
denominator (on the bottom) and the number of
beats per measure in the numerator (on top). In
Performer, the numerator can be a value between 1
and 99. The denominator must be a power of 2 (1,
2,4,8,16,32, or 64).

A Meter Change event in Performer consists of a
meter displayed in this way, along with a
metronome click value. This value determines the
spacing between the sounds and MIDI events 



produced by the Click feature. It also determines
how often the Counter is updated during playback
or recording.

The meter’s denominator value, the beat value of
the current tempo and the metronome click value
are all related, though they need not be set to the
same value. You may wish to have a meter of 4/4
with a tempo of half note = 180 with the
metronome clicking every eighth note. The ability
to use separate values allows a great deal of
flexibility and accuracy during recording.

If a sequence or song contains several meters, the
resulting configuration of meters is termed a meter
map. This map is simply the complete set of
programmed meter changes for an entire
sequence. These changes are displayed in the Event
Editing windows for each track in the sequence.
The meter changes for a given sequence or song
can only be altered in its Conductor track.

It is often useful to set up the meter map before
recording the music, this way the measure
locations of the events you record will stay
consistent through the recording and editing
process. If you change meter after recording a track
or tracks, the measure|beat|tick locations of the
events may change.

Inserting a new meter may or may not have an
audible effect on the music. Depending on the
options you select for inserting a new meter, note
events may be excluded and durations may change.
These options are explained in detail below.

Performer starts a new bar at every meter change.
Thus, if a meter change is inserted in the middle of
a measure, that measure will terminate early, and a
new one will begin with the meter change
event.xxx

USING THE CHANGE METER DIALOG BOX
To enter a meter or meter change:

1 Specify which Chunk (sequence or song) the
meter insertion affects.

If a Tracks window is active, the meter insertion
will apply to that sequence. If the Chunks window
is active, the meter insertion will apply to the
highlighted Chunk or, if no Chunk is highlighted,
to the current play-enabled Chunk. If an Event
Editing window is active, the meter insertion will
apply to whatever sequence it belongs to.

2 Choose Change Meter from the Changes menu.

The Change Meter dialog box will appear. The
name of the Chunk in which the meter insertion
will be placed is displayed at the top of the dialog
box.

3 Enter the numerator and denominator of the
meter to be inserted in the boxes next to the words
Change meter to.

Click in each box and type in the numbers. The
numerator must be a value between 1 and 99. The
denominator must be a standard note value: 1,2,4,
8,16,32 or 64.

4 Choose the metronome click value.

Click on the note value you want the metronome to
click on. If you want a dotted note value, click on
the dot in addition to the note value.

5 Enter the beginning measure of the region
which the meter change should affect.

Click in the box under the word “From” and type in
the beginning measure number. When you press
the Change button the From value is automatically
set to the previous To value.
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6 If you are going to be entering a series of meter
changes quickly, choose the Next Measure option.

This option lets you press the enter key once for
each measure. If you have several measures in a row
in the same meter, just press the enter key once for
each measure. The “from” measure is automatically
updated as you do so. This lets you enter meter
changes efficiently for an entire sequence by
quickly pressing the enter key repeatedly as many
times as necessary for measures with the same
meter. When you need to change meter, type in the
new meter and press enter again as many times as
necessary for the new meter. Keep going as long as
necessary.

7 If you are entering a meter change over a fairly
long region, choose either one of the two
remaining options; if necessary type in the end
measure of the region.

There are two options here: you can either specify a
particular measure or the end of the sequence (or
song). Click on the button next to the option you
want. If you choose the specific measure option,
click in the text box next to the word measure and
type in a measure number.

8 Choose to realign music in the region and adjust
durations if you wish.

To realign the music, choose the Realign music
automatically option. If you wish to adjust the
durations of notes in the region, click in the Adjust
durations box. If you wish to leave the music
unaltered, click in the Only move barlines button. A
full explanation of these options is given below.

9 Press the Change button to enter the change.

The Change button enters the meter insertion and
leaves the dialog box open so that you can insert
more meters.

10 To close the Change Meter dialog box, click in
its close box.

The Metronome Click Value

The metronome click value you specify will be
associated with the meter change you choose. You
can specify a different metronome click value for
each meter change. For more information, see
chapter 33,“The Click”.

The Measure Range

When you enter a range of measures, Performer
will change the meter up to but not including the to
measure. The to measure does not change; it
remains in the same meter as before the operation.
This is very similar to the way most edit/region
operations work; events at the end time are not
affected. If you choose the end of sequence option,
the meter change will continue to the end of the
sequence, no matter how the sequence may change.

For example, assume a sequence is completely in 4/
4. Entering a change to 3/4 from measure 8 to
measure 12 will place a 3/4 meter change in
measure 8, and a 4/4 meter change in measure 12.
The result is that measures 8 through 11 are now in
3/4, and measure 12 remains in 4/4.

Realign Music Automatically

This option allows you to maintain the metrical
structure of each measure by deleting some note
events and changing the durations of others. There
is a sub-option, Adjust durations, which is
discussed below. The following assumes that the
Adjust durations box is not checked. When you
change the meter of a measure that contains note
events with this option on, beats are either added
or removed according to the new meter you
specify. If beats are added, rests are inserted for the
new beats. If beats are removed, any note event
occurring in the removed beat will be removed as
well. The durations of note events that start before
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the deleted beats are preserved. For example,
suppose you have the following two measure
passage in 4/4 time:

Graphically, the durations would be represented
like this:

The duration of the four-
beat whole note is
truncated to fit the new
3/4 measure.

Only Move Barlines

This option does not change any durations. It
imposes the new barline structure over the music,
keeping all durations the same. The above original
4/4 passage would look like this with the Only
move barlines option:

Changing the meter to 3/4 and using the Realign
music automatically without adjusting durations,
the fourth beats would be removed. This would
remove the quarter note in the first measure but
not the whole note since it began before the deleted
(fourth) beat:

Realigned using the Only
Move Barlina option

Original music

The B-natural that was
on beat four is removed.

The whole note is not
removed because it began
before the fourth beat.
Notice that it maintains its
duration (four beats).

Adjust Durations

The Adjust durations sub-option can only be used
when the Realign music automatically option is
selected. The Adjust durations sub-option alters
the durations of notes that begin before the
removed or added beats. The durations are altered
to conform to the new measure boundaries. In the
example above, the original version in 4/4 has a
note lasting the whole second measure. With the
Adjust durations option on, the duration of this
note is altered such that the note will last for the
entire measure in the new meter:

Viewing Meters
The meters in a sequence can be viewed two places:
in the Event Editing windows for each track and in
the Conductor track for that sequence. Meters can
be edited only in the Conductor track; they cannot
be modified in the Event Editing windows for
standard tracks.

The meters in a sequence will appear in the Event
Editing windows for all tracks in that sequence.
Meters can be omitted from the editing windows
by turning off their display with the View Filter.
Conversely, the entire meter map may be viewed
alone by turning off the display of all other types of
events.

Editing Meters in the Conductor Track
Meter changes can be edited directly in either Event
Editing window (Event List or Graphic Editing) for
the Conductor track. This section discusses the 
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editing of meter changes in the Event List window.
See “Graphic Editing in the Conductor Track” on
page 182 for details.

To edit a meter change in the Conductor track
Event List window:

1 Double-click on the Meter Change event you
wish to edit and enter the new values.

Use the Tab key to move from field to field. The
location and meter marking fields are edited like
standard event values. Editing the metronome beat
value field calls up a small pop-up box with note
symbols for the possible values. Click on the note
corresponding to the value you desire.

2 Press the Return key to confirm the changes, or
Command-period to cancel them.

Clicking anywhere else on the screen will also
cancel the edit.

Using the Edit Commands with Meter Changes

You can apply any editing command to meters in
the Conductor track: they can be cut, copied,
pasted, spliced, etc., just like other events. You can
do so using all of the same techniques for editing
MIDI events and MIDI tracks. You can even edit
meter changes along with MIDI data in other
tracks by selecting the Conductor track along with
the other tracks.

<•" When cutting, copying, and pasting meter
changes, it is strongly advised that you leave the
Smart Selections command in the Edit menu
checked. Smart Selections helps avoid partial
measures, which in most cases you do not want to
create with editing operations.

HINTS AND EXAMPLES
Editing meter changes can be confusing —
especially if you create partial measures by
unknowingly putting a meter change in the middle
of an existing measure. One way to avoid partial 
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measures is to turn on (check) the Smart Selections
command in the Edit menu. Smart Selections helps
to avoid partial measures.

Erasing the meter map to start over

If you feel that your meter map has become too
complicated, has errors that you can’t easily detect,
or has somehow become excessively complex, you
can delete it and re-enter it correctly from the start.

To erase the current meter map:

1 Activate the Tracks window for the sequence
with the meter map you wish to erase.

Click in the window to activate it.

2 Double-click the word Selection in the Selection
Bar.

This loads the start and end times of the entire
sequence in the Selection Bar.

3 Select the Conductor track by clicking on it.

4 Choose Set View Filter from the Basics menu.

5 Make sure the menu at the top of the window
says Global View Filter.

6 Uncheck all check boxes except for meter
changes.

Hold down the Option key and click on the meter
change check box. Now the Edit commands will
only affect meter changes.

7 Choose Erase from the Edit menu.

This gets rid of all the meter changes for the
sequence.

8 Restore your previous View Filter settings.

Always try to remember to reset the View Filter
immediately after using it.
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Pasting into the conductor track

Be careful when pasting into the Conductor track:
pasting replaces events of all types selected in the
View Filter. This may be what you want. If,
however, you are just rearranging meters and wish
to leave the other data where it is, make sure to set
the View Filter for meter changes only.

Inserting measures with a different meter

Here’s a method for inserting a number of new bars
with a different meter into your sequence:

1 Shift over the sequence to make room for the
new bars.

Set the Start time in the Selection Bar at the
beginning of the section and set the End time to the
end of the sequence. Then choose Shift from the
Edit menu, and enter the number of bars you want
in the current meter.

Getting rid of partial measures
There is a preference (in the Preferences dialog in
the File menu) called Auto fix-up partial measures.
If the Auto fix-up partial measures is turned on
(checked), and you open a Performer file that has
partial measures, it will automatically get rid of the
partial measures by moving meter changes as
needed to do so. After the file opens, you should
check to see if your MIDI data still lines up with all
the barlines the way you want, and make
adjustments with the Change Meter and/or Shift
features as desired. If you want to get rid of partial
measures in your files, leave this option turned on.
If you want to preserver partial measures in a file,
uncheck this option before opening the file. Don’t
worry, however: Performer presents an alert before
it corrects partial measures so that you can Revert
to Saved if you decide not to do so.

2 Choose Change Meter from the Change menu.

3 Set the From and To locations for the meter
change.

Enter the beginning location of the new bars in the
From field. Add the number of bars being inserted
to the beginning time. Enter this in the To field.

4 Click on the Realign Music Automatically
option.

Leave the Adjust durations box unchecked. This
option adds or subtracts the necessary number of
beats to ensure that new measures line up with the
new meter.

5 Click on the Change button.

This enters the meter change.

6 Click on the close button to close the dialog box.
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chapter 29 Change Temp©

Tempo is very flexible in Performer. Not only can
there be several tempos in a Chunk (sequence or
song) but they can change dynamically, resulting in
accelerandos, ritards other programmed tempo
effects.

In Performer, tempo is controlled by the
Metronome panel in the Control Panel. The
metronome provides three possible settings for
tempo control:

■ The Tempo slider

■ The Conductor track

■ An external device, such as a mod wheel on a
keyboard controller

Only one of these sources can be chosen at a time.

When Tempo Control is set to the Conductor
track, you program all the tempo changes into the
Conductor track. Collectively, these tempo
changes are called the tempo map, and they occur
automatically when you play the Chunk under
Conductor track tempo control.

Tempo maps can be programmed using the
Change Tempo command as described in this
chapter. Alternately, you can create a tempo map in
real time by slaving Performer to Tap tempo
synchronization. See chapter 39, “Receive Sync”
(page 387) to learn more about creating tempo
maps in real time using Tap tempo sync.

QUICK REFERENCE
Beat Tempo Time Tempo
value curves Display

Button
Density
Button

Chang-? tempo of seqt

|T<?mpo units...

10|3|354

0:00-11 07

options

@ Randomize tempofs) vithin a
Emphasis: | o| (-9 to +9)

Anchored Randomization

tempo
indicators

0 120.00 Start tempo
168.00] End tempo

| 10| Curvature O :QO :06 :T5
(1 to 99)

Tempo Start and
parameters end

locations

6|3|2371 Start

Beat Value: Displays the note value on which the
tempo is based. Click on the desired note to choose
it. Click on the dot to make the beat value a dotted
duration (i.e. one and one half of the chosen note’s
duration).

Start and End locations: Displays the region over
which the tempo change will take effect. Click on
the box and type in the desired values. Use the Tab
key to move from field to field.

Anchored Tempo Indicators: Click on the anchor
icon to toggle a starting or ending tempo between
anchored and unanchored. Anchored tempos are
automatically set to the current tempo in the
region, preventing unwanted jumps in tempo.



Time Display Buttons: Click on the appropriate
radio button to select real or frame time for the
tempo parameters.

Tempo Density Buttons: Click on the appropriate
radio button to choose between Coarse and Fine
tempo event densities. The Fine setting generates
12 tempo events a beat; the Coarse setting
generates far fewer events.

Tempo Curves: Click on the desired curve button
to select the type of tempo change desired. Each
curve has a set of parameters and options which
control the shape and range of the tempo change.

Tempo Parameters: The number and type of
parameters depends on the Tempo Curve selected.
Parameters outlined by a box can be set by the user;
other parameters are computed and verified by
Performer when the Compute or OK buttons are
pressed. Values that are incalculable or out of range
will highlight and cause the Macintosh to beep (or
the menu bar to flash). Press the Option button to
change the parameters that can be edited.

Randomize tempos: Check this box to randomize
tempos within a specified range, expressed as a
percent or as a number of beats per minute (bpm).

Emphasis: Type a value between -9 and +9 to
weight the randomization either lower or higher.

The Options Button: Click on this button to select
which parameters are user-definable.

The Compute Button: Click on this button to
compute the values for parameters that are not
user-definable.

The OK Button: Click on this button to enter the
tempo change and close the dialog box.

The Cancel Button: Click on this button to cancel
the tempo change and close the dialog box.

BASICS
The Change Tempo command is used to create
tempo changes. You can specify a static tempo
change (i.e. a constant tempo) or a dynamic one (a
smooth change) via a curve. A constant tempo
contains no variation of the tempo for its duration;
it is merely a change from one tempo to another. A
smooth change contains varying tempo values.
The way that these values change is specified by one
of four curves. An accelerando, for example, is a
smooth change with a linear curve in which the
tempo gradually increases. When a smooth change
is specified with a curve, Performer approximates
the smooth change with a large number of discrete
tempo changes in quick succession.

When you use Change Tempo, any existing tempo
data in the specified region is erased and replaced
by the new data generated by the command.

A tempo map is simply the complete set of
programmed tempo changes for an entire
sequence or song. These changes are displayed in
the Conductor track.

The tempo changes for a given Chunk can
only be edited in its Conductor track.

To get a clear picture of the tempo map of a Chunk,
you can use the View Filter to view only tempo
changes in its Conductor track.

The tempo map specifies the relationship between
real or frame time and measure time. Each tempo
map consists of tempo changes occurring at
measure time locations. Performer always
maintains a correlation between real and measure
times according to the tempo map. When you
move to a measure time location, the
corresponding real time is computed and vice
versa. The same measure will always occur at the
same real time location no matter where you start
playing.
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When you change the tempo map, the real times of
all markers and events (viewed in Event Editing
windows) are updated. The real time locations of
locked markers do not change in this case. Rather,
their measure times change.

Performer’s tempo capabilities were designed to be
very effective in film and video applications.
Tempo calculations are very accurate resulting in
very precise location abilities. Finding a frame time
location will bring you to the exact measure time
location consistently. Real time locations of events
and markers are completely reliable and give an
accurate representation of the timing of the music.

This precision is possible because Performer
maintains a very high degree of internal tempo
resolution, much greater than the two decimal
places that you can enter. This resolution allows
you to set the tempo for a region by specifying its
length in real or frame time: Performer will
calculate the correct tempo to make the end of the
region occur at the time you specify.

When you set the tempo control in the metronome
to the Metronome slider, the programmed tempo
map is temporarily disabled by the current
metronome slider tempo setting. When you switch
back tempo control to the Conductor track, the
programmed tempo map is re-enabled.

THE CHANGE TEMPO COMMAND
The Change Tempo command lets you create
smooth tempo changes in a defined region of time.
The start and end of the region are defined by
measure locations. With this command, you can
calculate a tempo for a region by giving a real time
length for it.

To use the Change Tempo command:

1 Choose the sequence or song in which you wish
to insert a tempo change.

If a Tracks window is active, the tempo change will
apply to that sequence. If the Chunks window is
active, the tempo change will apply to the
highlighted Chunk or, if no Chunk is highlighted,
to the current play-enabled Chunk. If an Event
Editing window is active, the tempo change will
apply to whatever sequence it belongs to.

2 Choose Change Tempo from the Change menu.

The Change Tempo dialog box appears. The name
of the selected Chunk is displayed after the words
“Change tempo of sequence (or song)” at the top of
the dialog box.

3 Choose the beat value of the tempo.

Click on the value to select it; click on the dot if you
want a dotted value. For example, a tempo of
dotted eighth = 90 would require you to click on
the eighth note and the dot.

4 Choose between displaying times in real or
frame time.

5 Choose between coarse or fine tempo changes.

Click on the appropriate radio button.

6 Choose the curve you want for the tempo
change.

The curve type you select is highlighted.

7 Enter the Start and End locations.

T\pe in the measure|beat|tick values for the start
and end of the region for the tempo change.

8 Press the Options button repeatedly until the
desired combination of Start/End tempo/times
have boxes around them.
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There are several combinations of tempos and
times that can be entered and computed. I-'or each
combination, the values you can set are enclosed by
boxes.

9 Enter all parameters enclosed in boxes.

Type in the desired values. To set a Start or Ending
tempo to the current tempo, click on the anchor
icon for the parameter.

10 Press the Compute button to calculate the
tempo and time values based upon the parameters
you entered.

If the computed values are not satisfactory, enter
new parameters and try again.

11 Press OK to enter the tempo changes or Cancel
to terminate the action without entering the
changes.

Tempo calculations may take some time after you
press the Compute or OK button. To stop
calculations in progress, press the Command and
period keys at the same time.

Selecting a Tempo Beat Value

Tempos are measured in beats per minute. You can
select any beat value for the tempo from a sixteenth
note to a whole note. The beat value can be dotted.
The number of beats per minute can be between 20
and 400. At very slow tempos, you may want to use
smaller beat values such as an eighth note. At fast
tempos, you may want to use larger values such as a
half note. Your choice of beat value does not affect
the frequency of the Click. This is set separately
with the Change Meter command.

When you type in a number of beats per minute in
Performer (in the Metronome, in a pop-edited
tempo event, or in the Change Tempo window),
you can type in a timing resolution of up to a
hundredth of a beat per minute (136.45, for
example).

Viewing and typing in frame click tempos

If you write music for film, you might be
accustomed to expressing tempos in frame-clicks
as well as beats per minute. In Performer, you can
type in tempos using either format. You can also
display tempos throughout the program, including
the Change Tempo dialog, in frame click tempos
(e.g. 12-6 or 13/4). For further information about
working with frame click tempos, see “Displaying
and typing in frame-click tempos” on page 52.

Selecting a Time Display

You can choose whether to display start and end
times in real or frame time. This is very useful for
calculating timings in film and video work.

Setting the Start and End Points

The measure time locations entered in the Start
and End boxes in the Change Tempo dialog box
delineate the region in which the tempo change
occurs. New tempo data will be inserted into this
region according to your specifications.

Using the Fine and Coarse Options
The Fine and Coarse options determine the density
of tempo change data generated. Selecting the Fine
option causes tempo changes to be generated 12
times per beat. This creates the smoothest changes
but generates lots of data, taking up memory and
possibly slowing down the display of real and
frame times in the Markers or Event Editing
windows. This option is best used over regions of
only a few measures. With the Coarse option, fewer
tempo changes per beat are generated. This is the
best option to use in a large region.

In most situations, the tempo changes generated by
the Coarse option will sound completely smooth.
The rule of thumb here is to use the Coarse option
unless the tempo changes are not smooth enough:
in this case, the Fine option can be used.
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Anchoring the Start and End Tempos

The Start and End tempo parameters have an
anchor icon next to them. When the anchor icon is
highlighted, the tempo is anchored. If the anchor
icon is unhighlighted, the tempo is not anchored.

Regular
Linear
Curve

[X]| 120.0] Start tempo

60.0 End tempo

To anchor or unanchor a tempo, click on the
anchor icon next to it.

Flipped
Linear
Curve

When a tempo is anchored, the current tempo at
that location in the Chunk is used. For example, if
you anchor the Start tempo parameter, the value
used for that parameter will be the pre-existing
tempo at the Start location.

The anchoring option is used to make sure that
tempos just before and just after the region are
matched exactly. This insures that there are no
sudden jumps in tempo at the start or end of the
region. It is best to anchor tempos when you want
this continuous tempo effect; you cannot achieve
the same degree of accuracy when entering tempos
manually.

Using Tempo Curves
The tempo curve buttons specify the values for the
individual tempo change events created by the
Change Tempo dialog box. Rather than inserting
each tempo change manually, you can select a
curve and set a few parameters; Performer will
calculate the tempo changes necessary to create the
desired effect. The flat, straight line (the constant
curve) generates just one tempo change at the
beginning of the region. The other curves — linear,
logarithmic, exponential and polynomial —
generate a number of tempo changes which
approximate the shape of chosen curve. These
curve types are described in detail below.

CHANGE TEMPO

To select a curve, click on the button containing the
picture of the curve. The currently selected curve is
highlighted. When a curve is selected, the
associated parameter fields are displayed in the
lower section of the dialog box.

The curves are all displayed as increasing values.
However, if you specify an End tempo that is less
than the Start tempo, the tempo changes generated
will decrease over time according to the chosen
curve. In effect, this flips the curve upside down.
For example, if you wanted to program a ritard
(slowing down), you’d choose the linear curve and
enter a lower ending value. This would “flip” the
effect of the curve from up to down, as shown to
the left.

Curve Parameters
Each curve has unique parameters. These
parameters are the specifications for the tempo
change data to be generated: starting time, ending
time, etc. In addition, these parameters can be
combined in several different ways for each curve.
For example, the linear curve allows you to set
different combinations of the Start tempo, End
tempo and End time. After selecting a curve,
pressing the Options button cycles through the
various combinations of parameters possible for
that curve. Parameters that you can enter are in
boldface type and are enclosed in a box;
parameters that Performer will compute (and that
you cannot enter) are in plain type without the box.
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After you enter the parameters for a curve, you
must press the Compute button for the other
parameters to be calculated. These calculations are
not automatic: you must explicitly request them by
pressing the Compute button. These calculations
can take time; if you are certain about the values
you have entered it is not necessary to use the
Compute button. To abort a calculation in
progress, press the Command and period keys at
the same time.

Each curve displays its Start time parameter. This
value is not user-changeable; it is always computed
from the starting measure time location. It is
provided as a reference for viewing the length of
the region.

The following paragraphs describe the effects of
each curve on the specified region and the
parameter options for each.

The Constant Curve
The constant curve sets the region to a constant
tempo by inserting only one tempo change at the
beginning of the region.

Parameters:

Tempo: This is the tempo for the entire region in
beats per minute. You can use one decimal place
value if you wish, e.g. 89.7. If you anchor the
tempo, it will be the same as the pre-existing tempo
at the Start location of the region.

End Time: This is the time at which the end
measure location will occur.

The Linear Curve

The linear curve creates a smooth tempo change
with no fluctuations in the specified region.

Parameters:

Start Tempo: This is the tempo at the Start location
of the curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the Start location.

End Tempo: This is the tempo at the End location of
the curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the End location.

End time: This is the time at which the End location
occurs.

The Logarithmic and Exponential Curves

These two curves are similar: they both create a
smooth change in the specified region. The
logarithmic curve changes tempo more rapidly at
the beginning of the region; the exponential curve
changes tempo more rapidly at the end.

Parameters:

io| Curvature
G to 99)

0 00 00:00 Start time
-------- End time

Start Tempo: This is the tempo at the Start location
of the curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the Start location.
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End Tempo: This is the tempo at the End location of
die curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the End location.

End time: This is the time at which the End location
occurs.

Curvature: This is a value that controls the degree
of curve in the smooth change (i.e. its non­
linearity). Enter a value between 1 and 99. Low
curvature values flatten the curve and produce a
more even rate of change. For example, a value of 1
results in a near-linear change that is similar to the
linear curve. High curvature values round out the
curve and result in more change at the beginning or
end of the region depending on the button
selected. For example, a value of 99 will cause much
of the tempo change to occur at either the
beginning (for the logarithmic curve) or the end
(for the exponential curve). The higher the
curvature value, the more pronounced the curve
shape.

The Polynomial Curve

The polynomial curve creates a change in the
specified region which starts smoothly at the
beginning of the region, changes most rapidly in
the middle and ends smoothly. Note that the
unique parameter Mid Beat is included with this
curve, allowing you to control aspects of the
middle of the curve.

Parameters:

Start Tempo: This is the tempo at the Start location
of the curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the Start location.

End Tempo: This is the tempo at the End location of
the curve in beats per minute. If you anchor this
value, it will be the same as the pre-existing tempo
at the End location.

Curvature: Allows values between 1 and 99. Low
curvature values flatten the curve; high values
round it. Values of 30 to 60 work particularly well
with this curve.

Mid Beat: This is the measure time location at
which the Mid Tempo value occurs. This is the
point at which the most rapid tempo change
occurs. This location can be any time between the
Start and End times and allows you to control
where most of the changing will occur.

End time: This is the time at which the End location
occurs.

The Randomize Option

The Randomize option causes the tempo or
tempos being generated by one of the selected
curves to be randomized within a range for the
entire region over which the tempo change is being
made. For example, if you are inserting a constant
tempo of 120 bpm without randomization, the
result is a single tempo event at the beginning of the
region as shown below:

However, with the Randomize option checked and
the range set to +25 bpm, the result is a tempo map
that constantly and randomly changes between 95
and 145 bpm:
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Randomization can be used in conjunction with
any curve
Randomization option is a check box option,
which means that it can be used in conjunction
with any of the tempo curves:

A linear tempo curve with no randomization.

The same curve with randomization set to ±10 bpm.

Controlling the degree of randomization
The Randomize option is ideal for adding “human
feel” to the tempos of a sequence. By controlling
the range over which the randomizing occurs, you
control the degree of that feel. You can specify the
range either as a percentage or as a range of bpm. In
either case, each tempo event generated is placed
randomly within the range.

Emphasis
This sub-option causes the tendency of the
randomization to be higher or lower within the
specified range. Thus, if you wish to randomize the
tempos within a certain range, but you wish them
to tend to be higher, use a positive emphasis; use a
negative emphasis if you wish them to tend to be
towards the lower end of the range. A value of zero
equals no emphasis, which causes the
randomization to occur evenly within the range.

The effect of Density on randomization
A Fine density setting causes tempo events to be
generated more frequently than a Course density
setting. Notice that these two settings have an effect
on the constant tempo curve, which normally only
produce a single tempo event.

The Options Button

Pressing the Options button cycles through the
different combinations of entered/computed
parameters for the selected curve. This allows you
to specify the curve in a variety of manners. For
example, if you select a constant curve, you can
specify just the tempo or you can specify the End
time, in which case the tempo will be calculated to
make the end measure location occur at the end
time.

If you are not working with externally imposed
timings such as are used in film and video work,
you will probably not need to use the Options
button.

The Compute Button

The Compute button calculates and displays
computed parameters (those which you cannot
enter yourself) based upon the parameters you
enter. Traditionally, these calculations are done by
the composer or arranger either with arithmetic or
by using a reference book. Performer gives you a
quick means to make these calculations with the
Compute button. Since computed parameters are
not updated automatically, you must use the
Compute button to see their current values. The
Compute button doesn’t make any internal
alterations to the tempo data; it is just a utility to let
you see all the parameters.

The OK and Cancel Buttons
Pressing the OK button computes the tempo
changes and enters them in the Conductor track.
The computation may take a while. If you want to
terminate the computation, press the Command 
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and period keys together. Pressing the OK button
automatically makes all the calculations for all the
parameters.

Pressing the Cancel button terminates the Change
Tempo command without entering any of the
changes you made.

Viewing and Editing Tempo Changes

Tempo change data is stored in the Conductor
track for the Chunk. Tempo changes look like
continuous MIDI data (such as pitch bend or
controller information) in the Conductor track
Event Editing windows. Each tempo change has a
time and a tempo value. The tempo has two parts,
the tempo value in beats per minute and the beat
value (e.g. 1/4 note, 1/8 note, etc.)

Editing tempo changes can be done in either the
Tracks window or the Event Editing windows for
the Conductor track. You can apply all the
commands on the Edit menu to tempo changes.
Make sure that tempo changes are selected in the
View Filter, available from the Tracks window
mini-menu.

Note that smooth tempo changes require a large
number of discrete tempo changes very close
together. Also note that Performer’s internal
resolution of tempo events is much higher than
that displayed in the Event Editing windows. So,
tempo events that seem identical actually represent
different tempos with higher resolutions than can
be shown.

To edit tempo changes using the Tracks window,
set the Selection Bar times and select the
Conductor track. To edit tempo changes in one of
the Event Editing windows for the Conductor
track, make sure that tempo changes are selected in
the View Filter, and then just highlight one or more
tempo change events as you normally would in any
other track’s editing window. You can also insert 

single tempo changes by using the Insert button in
the title bar. See chapter 26, “The Conductor
Track” (page 319) for more information.

Tempo Editing Resolution

Tempos can be manually edited to a resolution of a
hundredth of a beat per minute. When you use the
Compute button in the Change Tempo dialog box,
tempos are calculated to a much higher degree of
accuracy.

Changing tempo on-the-fly during playback

You can use the Change Tempo command without
stopping playback.
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chapter 30 Looping

A loop is a region of data in a track that is played
repeatedly. The result is similar to using the Repeat
command on the Edit menu to insert multiple
copies of a region. Instead of actually copying the
data, however, the loop feature simply replays the
region over and over. Looping is thus more
memory-efficient than making repeated copies of a
region. Also, making a change in a looped section
is easy: instead of changing every repeat of the data
as you would if you had copied and pasted it, you
simply change the data in the looped region. Tracks
or sections of tracks can be looped independently;
it is thus possible to build a complex sequence out
of a small number of events.

A loop is different from the Memory-cycle button
because a loop is a permanent addition to a track.
In addition, the loop only loops one track, whereas
Memory-cycle loops the entire sequence. For
information about Memory-cycle looping, see
“The Memory-cycle button” on page 42.

BASICS
A loop has three components: a start point, an end
point and a number of repetitions. When a loop
starts, it plays through its data normally. When the
end point is reached, the region is played again
from the start point. This cycle repeats for the
specified number of repetitions, or indefinitely if
an infinite loop is specified.

When the loop finishes its number of repetitions,
the next data played will correspond to the location
on the Counter. For example, the region from
measure 1111000 to 4| 11000 is looped four times.
After the loop finishes, the Counter will be at
measure 13 (four times three measures is twelve:
measure 13 comes after measure 12). The data in
the track continues playing from measure 13, not 

from measure 4. If there is any data in measures 4
through 12, it is skipped. The loop takes
precedence over any intervening data.

When moving to a location in a sequence,
Performer figures out whether any tracks are in the
middle of a loop and keeps count of where in the
looping process these tracks are. This allows you to
begin playing or recording from any location and
be sure that the loops will all play correctly.

Notes can be sustained across loop boundaries: if a
note is inside a loop, it will always sound for its
specified duration.

Tracks and Looping

Each track has its own set of loops. This means that
each track can be looped independently of others.
The Conductor track cannot be looped. (You can,
however, temporarily loop the entire sequence
using the Memory-cycle button.)

A loop starts right on its Start time and ends just
before its End time. For example, a loop set from
1111000 to 4| 11000 would play the data from 1111000
to 314|479; the next repetition would play the same
data immediately at 4| 11000. The number of
repetitions equals the total number of times you
want the region to play; this includes the first pass.

A loop need not be set on measure boundaries (i.e.
on beat one, tick zero of the measure). They can
start anywhere in a measure. We’ll use loops
starting on measure boundaries as examples to
keep things clear. In practice, any location is fine.

If you want to set a loop in several tracks at once,
just highlight all of the desired tracks at once before
you set the loop.



If a track contains loops, a looping indicator
appears in the Loop column next to the track name
and in the track segment in which it begins This
indicator can’t be used to change anything: it is
merely a reminder that the track contains loops.

Each track may can contain multiple loops. You can
even have nested loops in a track, i.e. loops within
loops. Here’s an example of nested loops, all in the
same track:

■ Bars 1 to 3 played 8 times (lasting from bar 1 to
17)

■ Bars 17 to 19 played 4 times (lasting from bar 17
to 25)

■ Bars 25 to 27 played 4 times (lasting from bar 25
to 33)

■ Then the whole 32 bar section is looped:

■ Bars 1 to 33 played 4 times (lasting from bar 1 to
129)

When bar 33 is reached, bars 1 to 3 will be played
another 8 times, bars 17 to 19 another 4 times, and
bars 25 to 27 another four times. Then this whole
process will repeat twice more until bar 129 is
reached.

When Loops Conflict

It is possible to set up loops such that they overlap
with each other or otherwise conflict in the same
track. When this happens, the first loop in the track
takes precedence. When two conflicting loops start
at the same time, the one that has a later ending
time takes precedence.

Here are some examples of the effects of conflicting
loops:

■ Bars 1 to 9 played four times, bars 5 to 13 played
four times.

The first loop takes precedence. Bars 1 to 9 are
played and the loop repeats back to bar 1. The
second loop is ignored.

■ Bars 1 to 17 played four times, bars 1 to 3 looped
infinitely.

Bars 1 to 3 are played eight times, lasting until bar
17. Then the “outer” loop (the one with the later
end time) takes over, terminating the “inner” loop.
This returns to bar 1, playing the inner loop eight
times again. This cycle repeats four times until the
outer loop is finished. At that point, the sequence is
at bar 65 and it continues playing from there, all
previous loops done.

■ Bars 1 to 5 played four times, bars 5 to 7 played
eight times.

The second loop is completely ignored since its
time is skipped while executing the first loop.
When a loop begins at a time that is skipped after
executing a previous loop, that loop is ignored (like
all other data in the skipped region).

CREATING A LOOP
There are two ways to create loops: the Set Loop
command, and the Insert button in the title bar of
Event Editing windows.

Setting a Loop
To use the Set Loop Command:

1 Activate the Tracks window for the sequence in
which you wish to set the loop.

Double-click the name of the sequence in the
Chunks window or, if it is already open, click the
window once.

2 Select the track(s) or track segments in which
you wish to set the loop.
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Highlight the desired track names, or drag over the
desired track segments. If several tracks are
selected, each will have the same loop set for it. You
may not loop the Conductor track.

3 Optional: Enter the Start and End times of the
loop region in the Selection Bar.

4 Choose Set Loop from the Change menu.

A dialog box appears.

5 Edit the Start and End times if necessary, then
enter the number of times you want the loop region
to be played.

The number you enter will be the total number of
times the region is played. If you want it to play
indefinitely, choose the Infinite loop option.

6 Press the OK button to confirm your entry or
the Cancel button to cancel it.

Inserting Loops in the Event Editing Windows

Loops can be inserted directly into a track from
either the Event List window or the Graphic
Editing window.

To insert a loop into a track using the Event List
window:

1 Open the Event List containing the passage
you’d like to loop.

2 Press the Insert button in the title bar and
choose Loop from the menu.

A new loop event pops up.

lOOO | 2111000 =2 times

3 Enter the start and end locations and the
number of repetitions for the loop.

Use the Tab key to move from field to field. If you
type“i” in the repetitions field, Performer will fill in
the word “infinite”.

4 To enter the loop, press Return. To cancel, click
anywhere with the mouse.

If you’d like to insert another loop, press the Enter
key. This enters your loop and produces another
new loop event.

To insert a loop in a track’s Graphic Editing
window:

1 Press on the Insert button in the title bar of the
Graphic Editing window and choose Loop from the
menu.

The menu will disappear and the mouse pointer
will turn into a cross-hair.

2 Click at the desired start location in the Marker
Strip, drag to the right to draw the desired length,
and release the mouse at the end location.

A loop will appear. Use the dotted hairlines in the
Time Ruler to align the beginning and end of the
loop while inserting it. Information about the loop
will appear in the Information bar.

Viewing and Editing Loops in an Event Editing
Window
Loops can be viewed and edited in the Event List
window for the track that contains them. Viewing
loops in event lists is a good way to see them in
context. This will help you to see when they occur,
what data they cause to be skipped, etc.
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Events in a loop are indented to the right in the
Event List window, as shown in Figure 30-1. Events
in nested loops are indented further to the right.
Events that are skipped due to loops are displayed
in italics. These display features will let you see
immediately which events are within loops, what
level of loop nesting is happening at any given
location and what the effect of the loop is, i.e. what
data will be skipped.

You can edit loops in the Event List window just
like any other parameter. Simply click on the data
in the loop you wish to change and enter a new
value. To clear a loop or loops from an event list,
simply highlight the loop event(s) and select Erase
from the Edit menu.

Loops can also be edited in the Graphic Editing
window for each track. For more information, see
chapter 12,“Graphic Editing” (page 153).

Editing Loops with the Edit Menu

Loops can be edited like any other event with the
commands on the Edit menu. If you Cut, Paste, or
otherwise edit a region that contains loops, the
loops will be edited along with the other events.

To edit loops using the Tracks window and the Edit
menu, first make sure Loops are checked in the
View Filter. Then select the track(s) to be edited,
define the region using the Selection Bar Start and
End times, and choose the desired command from
the Edit menu. Checking only Loops in the Filter is
useful for editing loops without altering the MIDI
data in the selected region; this is similar to using
the Clear Loops command.

To remove a loop or loops, select a region that
contains the loops and select Erase from the Edit
menu, or use the Clear Loops command.

Removing Loops Using the Clear Loops
Command

The Clear Loops command in the Changes menu is
used with the Tracks window Selection Bar, and is
a handy shortcut for removing loops.

To remove a loop or loops, select a region that
contains the loops using the Selection Bar Start and
End times, and choose the Clear Loops command
from the Change menu. Loops that begin inside the
specified region are erased; MIDI data is
unaffected.

Nested loop

6/4/121
614/240 4 8l>3 472 >95 0/112 614/332

7/1/432
7/2/04!
7/214/8
7/3/435
7/4/729

7/!/36O >Ot>3 468 11060/073
772/0X7 203 469 11030/041
7/2/240 233 459 181 0/178
7/3/360 2063 467 11070/075
7/4/000 203 464 11150029

511)000 4*> untn 7111000 i2 times ~~
____________ C*> until 6|2|240 I Infinite ...............................
________ 5111360 J1 Db3 197 >11201072 5111432
________ 5121000 /C3 165 199 01030 5121033
________ 5121240 J-E3 161 t39 01207 5121447
________ 5131360 2*003 *95 >10301079 5|3|439
________ 5141000 2*03 155 t97 01051 5141051
________ 5141240 2-E3 169 IS7 01193 5|4|438
________ 6111360 20b3 172 111301077 6111437
________ 6121000 4-03 153 t1000|031 6121031

6/2/240 233 458 '84 0/147 6/2/387
6/4/000 2363 479 188 0/121

Looped events

Skipped loop events

Figure 30-1: Data inside a nested loop is indented. Data
that won't play as a result of the loop is italicized.
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For example, Track-1 contains loops at measures 1
to 4 and measures 3 to 9. If the Selection Bar Start
and End times are 2| 11000 and 9| 1|000, only the
second loop will be cleared.

Loop Recording
“Loop recording” is the process of overdub
recording into a region over and over again to build
up a pattern. This is best done with the Memory­
cycle feature in Performer. See “The Memory-cycle
button” on page 42 for detailed information. Once
you have built a pattern using Memory-cycle, you
can insert a permanent loop over the region. See
“Quickly selecting what you have recorded” on
page 46.

By using Memory-cycle with overdub recording,
Performer can function inamanner very similar to
the way most commercial drum machine
sequencers work: by building up patterns in
multiple passes through a section.

Inserting and editing loops during playback

Loops can be inserted and edited during playback
as described throughout this chapter. Just
remember that it may take Performer a moment to
cue up data after you’ve made a change, depending
on the magnitude of what you did with your edit or
insertion.
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chapter 31 Printing

This chapter explains how to:

■ Print out the contents of a Performer list
window, such as the Event List, Tracks, Markers,
Chunks, and Remote Controls windows

■ Print one or more tracks as music notation and
display the results on the computer screen or print
them on a printer

■ Customize the page layout for notation printing

■ Get best-looking results when printing notation

Checking your serial ports before you print
Before you print anything—either a list window or
notation, consider which Macintosh serial port you
will be using for printing. To check the status of the
serial ports, choose Edit FreeMIDI Configuration
from the Basics menu and then in FreeMIDI Setup,
choose Interface Settings from the MIDI menu.
These settings reflect your current FreeMIDI
studio configuration.

In the example above, the printer port is “Not in
Use”, which means that it is OK to print if your
printer is connected to it. If your printer is 

connected to modem port in this example, you’d
need to change the way the serial ports are set up
for MIDI.

Using MIDI on one port and printing on the
other
If you plan to do a lot of printing from Performer,
your best bet is to use one serial port for MIDI and
the other for printing as shown above. Affordable
multi-port MIDI interfaces such as Mark of the
Unicorn’s MIDI Express and MIDI Time Piece II
provide a convenient connection for all of your
MIDI gear through one Macintosh serial port.

Printing when you use MIDI on both serial ports
Depending on your MIDI setup, you may require
MIDI on both serial ports. For example, you may
have a large MIDI rig that requires multi-port
interfaces connected both serial ports, or you may
have an old MIDI interface that calls for using both
ports. In either case, you probably have your
printer connected to a “thru” port on the interface.
When you want to print something, you press a
“thru” switch to temporarily suspend MIDI and
allow printing.

In this scenario, MIDI activity must be temporarily
suspended on the serial port being used for MIDI.
Use the Interface Settings command in the Basics
menu to temporarily set the port to Not In Use
while printing.

PRINTING THE CONTENTS OF A LIST
WINDOW
To print the contents of a track’s Event List window,
the Tracks Window, the Markers Window, the
Chunks list window, or the Remote Controls
window:
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1 Bring the window you want to print to the front
to make it the active window.

To do so, click its title bar or choose its name from
the Windows menu.

2 Open the Chooser from the Apple menu and
select the desired printer and serial port.

See “Checking your serial ports before you print”
on page 353.

3 Choose Page Setup from the File menu, make
any desired changes to the page settings, and click
OK to confirm the settings.

The options that appear in this dialog box depend
on the type of printer you are using. For example, if
you are printing on a laser printer, you can choose
an enlargement or reduction above or below 100%.

4 Choose Print from the File menu.

The standard print setup dialog box appears for
your printer.

5 Set up the printer options as needed, such as the
number of copies, and click OK.

The entire contents of the list is printed.

PRINTING NOTATION
Printing notation in Performer is easy, as you’ll see
in the following sections. Performer transcribes
unquantized or quantized MIDI data in a readable
fashion. You can format the music on screen
exactly as it will print, including text, page margins,
staff spacing, measure spacing, and more.

To print notation:

1 Open the Chooser from the Apple menu and
select the desired printer and serial port.

See “Checking your serial ports before you print”
on page 353.
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2 Choose Page Setup from the File menu, choose
the desired page size, make any desired changes to
the page settings, and click OK to confirm the
settings.

The options that appear in this dialog box depend
on the type of printer you are using. For example, if
you are printing on a laser printer, you can choose
an enlargement or reduction above or below 100%.

3 Select the data or the region of data that you
would like to print using any method of selection
that you prefer.

Performer is extremely flexible because you can use
any one of Performer’s many ways to select data—
from a single note to the entire piece. You can select
any portion of a track, or any portion of multiple
tracks. See “Choosing what tracks to display” on
page 193 for more information.

4 Click the QuickScribe notation editing window
button in the Consolidated Controls window.

A window appears containing staves for the track
or tracks you have selected. This window displays
the music on a page exactly as it will print out. For
information about editing music and formatting it
in this window, see chapter chapter 14,
“QuickScribe Notation”.

5 Use the QuickScribe window mini-menu and
Page Setup commands to format the music on the
page as desired.
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Summarized below, these menu commands are
discussed in detail in chapter chapter 14,
“QuickScribe Notation”.

Formatting command Brief description

Score Options
(Mini-menu)

Provides control for title page,
staff names, measure number­
ing and spacing, and staff spac­
ing.

Page Margins
(Mini-menu)

Lets you adjust top, bottom, left,
and right page margins.

6 Add text as desired with the text tools in the
Tools palette.

See “Working with text” on page 203 for more
information.

7 Choose Print from the File menu.

The standard print setup dialog box appears for
your printer. For example, if you are printing with
an laser printer in with Apple LaserWriter 8
selected in the Chooser, you’ll see the window
below:

8 Set up the printer options as needed, such as the
number of copies desired, and click Print.

Performer proceeds to print the document,
providing you with a status window as it does.
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chapter 32 Searching

OVERVIEW
Performer’s Search command provides you with a
powerful, flexible way to locate and select data. You
can select the data you find or display it in the
Search Results window, which lets you browse it,
select it, open its event list, or even export it to a
text file.

You can base your searches on as many search
criteria as you like, making them as simple or
elaborate as you want. You can also base your
searches on the chosen attributes of currently
selected data.

You can name and save search settings for later use.

You can conduct multiple successive searches to
add or subtract to the current data selection.

Search window Quick Reference.................... 357

Search window mini-menu..............................358

Basics.................................................................358

Working with search settings..........................360

The time-related search settings.....................363

The event-related search settings.....................364

Working with search results............................364

Basing settings on the current selection......... 366

The Search Results window..............................366

SEARCH WINDOW QUICK REFERENCE
Time-related Event-related Grouped
search setting search setting settings

Action

menu

Add/remove Add group
buttons button

Figure 32-1: Performer's Search window.

Time-related search setting: Lets you specify time-
related criteria for your search, such as a range of
time within the track(s) being searched, and/or the
metrical position of data within each measure
being searched.

Event-related search setting: Lets you search for
specific types of data, such as notes or pitch bend.
You can even search for specific data character­
istics, such as note-on velocity values or hex strings
inside sysex messages. You can also search for
Performer-generated events, such as tempo
changes, key changes, meter changes and markers.

Grouped settings: Lets you specify two or more
search criteria that are to be considered together as
a whole.
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Add/remove buttons (+/-): The plus-sign button
adds a new time- or event-related search setting to
the bottom of its group. The minus-sign button
removes the bottom setting (or group) from the
group.

Add group button: Adds a new group of settings,
nested within the current group. You can then use
the +/- buttons within the new group to add and
remove criteria within the group.

Action menu: Lets you choose what to do with the
search results.

‘Base settings on current selection’ option: Causes
Performer to look at the currently selected data for
search settings. This option only affects the settings
in its particular group.

SEARCH WINDOW MINI-MENU
New search: Clears the Search window of all
current search settings and restores it to its default
state, ready for you to enter new search settings.

Save search settings: Lets you name and save the
current search settings in the Search window for
later recall from the mini-menu.

Edit search settings: Opens a dialog that lets you
rename, delete, re-order and assign a hot key to
saved search settings.

Restore default search settings: Puts the factory
default search settings back in the Search window
mini-menu (and the Search sub-menu in the Edit
menu).

BASICS
The Search command is found in the Edit window
mini-menu, and it provides a hierarchical sub­
menu with several other search-related commands.
The sub-menu also displays search settings you
have created and saved.

Edit Saved Search Setting:

Search Perform Near Search,
an
an

Search Again
Next Search Result
Preu Search Result

My search settings
I6th-note offbeats
Ril notes aboue C5 end belotv CI

wflSelect RII
Deselect RII

'/Smart Selections
Cursor Selection Mode ►

Edit
Undo

Cut
Copy %C
Paste
Erase
Repeat... «R
Merge 36M
Snip «J
Splice
Shift...

Show Clipboard

Figure 32-2: The search command sub-menu.

When searching, you need to choose where to
search and what to search for. The Search
Command lets you specify both to an extremely
high degree of detail—as much detail as you like.
There is no inherent limit to the number of criteria
you can use when searching—except perhaps the
maximum number of search settings that will fit on
your computer screen in the Search window.

Searches can be simple. For example, you might
want to search for all notes in a track between G#3
and F4. Searches can also be elaborate and detailed.
For example, you might want to search for all notes
between measures 10 and 20 that fall directly on
downbeats and are between C2 and G3 with on-
velocities between 80 and 110 and with durations
greater than or equal to 240 ticks.
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The Search window, which you open by choosing
Search>Performer New Search from the Edit menu,
lets you specify the search settings (as shown in
Figure 32-1 on page 357). It also lets you choose
whether to select the data or display the results of
the search in the Search Results window.

If you choose to select the search results, you can
then apply any Performer Region menu command
to the selection.

If you choose to view the outcome of your search in
the Search Results window, you can browse the
selected data in one convenient list. You can select
any portion of the results. You can go to the data in
its editing window. You can even export the
contents of the Search Results window as a text file
for printing or importing into word-processing
programs, spreadsheets, or any other software that
can import text.

Overview of how to perform a new search

This section gives you the basic procedure for
conducting a search. Each step is discussed in
detail in the sections that follow.

To perform a new search:

1 Decide where you want to search.

There are several things you can do to control
where Performer searches, and they are discussed
in detail in the next section. In most situations, the
Search command will search in the top-most open
edit window. So if you want to search in more than
one track, bring the Tracks window to the front and
select the tracks n which you want to search. If you
only want to search in one track, bring one of its
edit windows to the front.

2 Open the Search window by choosing
Search>Perform New Search from the Edit menu.

Figure 32-3: Performing anew search.

3 Make your time- and event-related search
settings.

Add new search settings with the plus buttons. Add
a group with the “ [ ] ” button. To remove the
bottom setting in a group, use the minus button.

4 To determine what Performer will do with the
results of the search, choose the desired Action
from the Action pop-up menu.

5 Click the Search button.

If you chose to select the search results, data found
by the search will become selected. If you chose to
display the found data in the Search Results
window, it will appear.

You can leave the Search window (and Search
Results window) open to refine your search or
conduct as many further searches as you want.

Choosing where to search

There are several factors that control where
Performer will conduct the search:

1. The Search in all sequences check box option in
the Search window, if checked.

2. The top-most window behind the search
window.

3. The time-related search settings you’ve chosen.

4. The action you chosen to take.
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These factors are listed in order of precedence.
Number 1 takes precedence over number 2, and so
on. For example, if the Search in all sequences
option is checked, it won’t matter what the top­
most window is.

Here’s another example: let’s say you have a selected
some data in a bass track, and you chosen to search
within the range of the current selection as shown
below in Figure 32-4. But the piano track is the top­
most window at the time you click the Search
button. Even though the selection is in the bass
track, the search will actually be conducted in the
piano track because it is the topmost window. The
selection in the bass track does, however,
determine the time range of the search in the piano
track.

Figure 32-4: Performer always searches in the top-most window
behind the Search window—unless the 'Search all sequences'option
is checked. In this example, the selection in the bass track determines
the range of time for the search, but the actual search occurs in the
piano track, since its event list is the top-most window.

Here’s an example of how the Action option you
choose in the Search window can affect the results
of the search. Let’s say that in the example above,
the Action you’ve chosen is Select subset of current
selection. In this case, nothing will happen as a
result of the search because there is no current
selection in the piano track.

WORKING WITH SEARCH SETTINGS
The Search window’s search settings give you a
great deal of control over your searches. The
sections below will help you get the most out of
them.

Adding/removing search settings

As you can see in Figure 32-1 on page 357, Search
settings are always grouped into sections in the
Search window (as prescribed by the outline boxes
around them). Each group has Add (+), Remove (-
), and Add group ([ ]) buttons that let you add and
remove individual search settings, as well as groups
of settings, to and from the group. New items are
always added at the end of the group. The Remove
button always removes the item at the end of the
group. If you need to remove an item in the middle
of a group, you’ll have to delete the ones below it,
too, and then re-add them again afterwards.

Figure 32-5: Adding search settings. If you start with Example A
above and click the Add (+) button to the Event Attribute group four
times, you'll then have four new search settings as shown in Example
B. You can then adjust the newly added settings as desired. Also
notice the'Events may match any settings'option.
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Adding/removing a group
As discussed above, groups are added and removed
like other settings with the“[ ]”and Remove (-)
buttons, respectively. You can add as many groups
as you want, and you can nest groups within each
other (discussed later).

Matching settings within a group

When two or more search settings are present in a
group, an additional menu appears at the top of the
group. The menu has two possible settings:

■ Events may match any settings

■ Events must match all settings

When you choose Events may match any settings,
the Search command will find an event as long as it
matches at least one of the settings in the group. It
only has to match one of the settings in the group to
be included.

When you choose Events must match all settings,
the Search command will include an event in the
search results only if it matches all of the settings in
the group. In the example below, the only notes that
will be found by the search are ones whose pitch is
between C3 and C4 AND whose on-velocity is less
than 64 AND whose duration is less than 11000.

Event Attribute------------------------------------------------------------------------------------------
Events must match all settings v1
Hotes-r | Pitch Valuev | Is vilhln rangev | [ C3 To 1 C4

Tlotesv | On Velocity v | Is less thanv| f 64

Notesv| Duration’ll Is less thanv 11 HOOD I E|

I  Bast- settings c-n current selection - - | 4-101

Figure 32-6: Grouping search settings. In this example, only notes
that match all the settings will be found by the search.

Combining groups with other settings/groups

Grouping can be a powerful tool for finding exactly
what you are looking for in your searches. When
you use the Events must match all settings option in
a group, you are basically making the group act as a
single unit in qualifying data for the search. In
other words, when you combine it with other 

individual search settings within its enclosing
group — or even other groups — it will following
the same logic as if it were an individual setting.

Controlling search logic with groups

Grouping can be used to create logical distinctions
between search settings. Consider the following
example. Lets say you wanted to find all notes that
are out of range for a certain instrument. So you
enter the settings shown below.

Time |
A11Tim»v|

 Base settings on current selection - [ •» | tl |;

Event Attribute------------------------------------------------------------------------------ ,
Events may match any gettings v |
Notes'^-1 Pitch Value— | Is greater thanv1 ] C4

Notesv | Pitch Valuev | Is less thanv |4 ci

 Bese settings on current selection -- | -e-1 tl

But now lets say that you wanted to further restrict
the above search to notes with a duration less that 1
beat. If you just added a duration setting without
grouping, as shown below, you would not get the
result you want because the duration setting would
select any notes with a duration less that 1 beat, not
just ones above C4 and below Cl.

Time-----------------------------------------------------------------------------------------------
All Timev |

 Basesettingscncurrent selection ~ | +|(1|

■Event Attribute------------------------------------------------------------------------------
Events may match any settingsv |
Notesv| Pitch Valuev | Is greater thanv | [ C4

. Notesv| Pitch Valuev | Is less thanv 11 ci ~

Notesv | Duratfonv | Is less thanv 11 1|ooq] E|

 Bare settings cn current selection - | + |tl|

You would not be able to fix this problem by
changing the Events may match any settings option
to Events must match all settings because you would
end up with a invalid search: you’d be searching for
notes that are both above C4 and below Cl at the
same time — an impossibility.
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By grouping the settings as shown below, however,
you set up a search logic that is exactly what you
want:

Time----------------------------------------------------------------------------------- [
! AOT'.r,-,.-|

 Dace settings on current selectton - | +| u||

As you can see, this setup is like saying “I want all
notes whose durations are less than 1 beat AND
whose pitch is EITHER above C4 OR below Cl.”

Nesting grouped settings

Groups of settings can be nested as deeply as you
need to achieve the search logic you want, as shown
below in Figure 32-7. Just remember: to make the
group act as a whole (e.g. all of the settings within
the group must be met before data will be included
in the search result), use the Events must match all
settings option for the group. If you want the events
in the group to be considered individually, use the
Events may match any settings option.

In case you are wondering, Figure 32-7 will find
data events between measures 10-20 and 40-50
only that fall on the 1st, 2nd, 3rd, 5th, 6th or 7th
eighth-note of the measure. In addition, the data
must be a note between C3 and C4 with an on-
velocity greater than 80, or it can be a controller
#55 with a value less than 10 or greater than 90.

r/l^l%! . - - ■ -............................. .............*■„ Search

Event Attribute......... .......... ........... —------------------------------------------------------------------ ;
Events may match any settings— |

Group---------------------------------------------------------------------------------------------------------- -
Events mmt match all settings*?-1

Notes-r | Pitch Value*- | Is vi th in ranges | f C3 To . 04 '

Notesv | On Velocity*- | is grea<er than*-1 ■ go

 Base settings cn current selection - | + [li[ '

Group----------- :------------------------------------------------------------------------------------------------: |
Events must match all settings*- |
Controller^* | Number** | Ls*~ f f55—

Group---------- -- —■——-------------------------------------------------------------------------------- 1.

Events may match any settings*?* [
Controllers-1 Valuer- | ts Utt thanr-| ( 1Q

Controller** | Valuer-1 is greater than**1 < 90

 Base settings cn current selection | '
□ Base settings on current selection «■ |»|j!

 Bate settings on current selection - |

Action: Create nev selection*J

 Search tn all sequences

Figure 32-7: Nested search settings.
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THE TIME-RELATED SEARCH SETTINGS
Performer lets you specify the location of what you
are looking for by any combination of the following
time-related search settings:

✓AllTtaw
MftrfcGrM

From Counter to Chunk End
From Chunk Start to Counter

Figure 32-8: The time-related search settings.

Please note: these settings may change or be
expanded in future versions of Performer.

All time
All time means that the search will look from the
beginning to the end of sequence.

Metric grid
Metric grid lets you specify events by their position
within an evenly-spaced grid. For example, you
could choose only data that falls on the eighth-note
offbeat of the first and third beats of each measure
being searched. The grid spacing is set up similar to
the way you would specify a quantize grid in
Performer: choose a note duration that defines the
grid with the controls provided (shown in
Figure 32-9). In addition, Performer uses its Smart
Quantize engine when determining if events fall on
a grid point, so the metric grid works even on
unquantized data.

Figure 32-9: Searching using a metric grid.

The search command offers several additional
options. The Number of grid points lets you restrict
the grid to a limited size that repeats itself over the
range of the search. This lets you apply the grid to
each measure individually, or even several
measures at a time. The Restart grid at measure
boundaries option does exactly what it says,
regardless of how long the grid is. The Pairs of
checked points form ranges option creates ranges of
time instead of individual grid points. This feature
is very powerful because it lets you specify
individual ranges of time of any size at any
resolution. You can choose to either include or
exclude the start and end points of the ranges.

Value
The Value setting allows you to choose specific time
in which to search. Further choices are shown
below. The Is (with slop) option is notable because
it lets you specify a specific time with a little bit of
“give and take” before and after the time you
specify. You can choose the amount of “slop”.

Selection range
The Selection range setting lets you specify a range
of time by the current selection. Make sure you
select a time range — or some data — before you
use this option.

The counter and chunk start/end settings
The From Counter to Chunk End and From Chunk
Start to Counter options let you specify a range of
time using the current time in Performer’s main
counter and the beginning or end of the current
sequence.
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THE EVENT-RELATED SEARCH SETTINGS
The event attribute settings let you search by data
type (such as notes) and by the specific parameters
of each data type (like note-on velocities). You can
further specify value ranges of a data attribute
(velocities between 80 and 100, for example) or
qualities of a given attribute (e.g. a key signature
with 3 flats).

Event Type
Key Change
Meter Change
Tempo Change

v'Nctes
Pitch Bend
System Exclusive
Song Select
Mono Pressure
Poly Pressure
Controller
Patch Change
Made Change
Loop
Sound Bite
Audio Volume
Audio Pan
Marker

Figure 32-10: Even t types you can search for.

If you just want to search for several types of events,
regardless of their specific parameters, you can use
the Event Type>Choose option as shown below:

Event Attribute —
Event Type’ll ChooserJ 1 Cl.gr ) ( Sot All )
® / Notes @ ± Mono pressure 3 (? Markers

 i On velocities  £i Poly pressure 51 Tempo changes
 ' 0*Y velocities 51  System exclusive @ Meter changes

 *» Pitch bend  Tune request 0 Key changes
® I Patch/scng changes  Mode changes  Loops

 Soundbites  A Audio volume  A Audio pan

51 A Controllers

® All O All except: ____ ____ ____
O Only:

 Base settings on current selection -kim

If you need to further restrict your search to certain
attributes of a data type, then choose it by name
from the list shown above in Figure 32-10, and
then you’ll also have access to all of the attributes
that type of data. An example is shown below.

Event Attribute------------------------------------- ■---------
•' SUS*** Exc lusivT-1 Hex^f Ccr *. r.r.gg- j £

—
✓Contains

Starts with
Ends vith
Is
Is not
Doesn't contain
Is at offset

Figure 32-11: The event attributes forsysex data.

A few notes on sysex searches

When searching for hex data within sysex
messages, do not include the F0 or F7 as part of the
search string.

When you are using the Is at offset option shown in
Figure 32-11, offset zero is the first byte past the F0
at the beginning of the message.

WORKING WITH SEARCH RESULTS
Once you set up the search settings the way you
want, as described on the preceding pages, use the
Action option at the bottom of the Search window
to determine what will happen to the results of the
search. The Action options are shown below and
are self-explanatory:

✓Create new selection
Select subset of current selection
Add to current selection
Display in search results windov

Figure 32-12: Choose what to do with the results of your search with
the Action option.

'*■ Be careful when you are using the Select subset
of current selection option. The top-most window
behind the Search window must have a selection
for this option to do anything. For example, let’s
say that you have a selection in the Tracks window
over several tracks, but the piano track is not
included in the selection. If the event list for the
piano track is the top-most window when you click
the Search button, nothing will happen. The
current selection will remain unchanged, and there
will be no selection made in the piano track. On the
other hand, if you have a selection in the piano 
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track, the Search command will create a subset of it
(if it finds data within the selection that meets the
search criteria).

Searching again
The Search Again command in the Edit menu
(located in the Search sub-menu) re-applies the
last search you conducted. The settings used are
the ones that were in the Search window at the time
you clicked the Search button — not the settings
that are currently in the window. On the other hand,
if you’ve changed the topmost window — or any
other factor that affects where the search takes
place, the Search Again command applies the
search to the new situation. For example, if the last
search you conducted was over the entire sequence,
but you now have a single track’s event list open as
the topmost window, the Search Again command
will search that track.

Searching again in exactly the same area

The Refresh command in the Search Results
window mini-menu (explained later) lets you re­
apply the exact same search, even if you’ve change
the top-most window or any other factor that
affects where searching takes place. For details, see
“Searching again with the Refresh command” on
page 367.

Performing multiple successive searches
By leaving the Search window and Search Results
window open, you can perform multiple successive
searches. You can also use the Select subset of
current selection and Add to current selection
options with successive searches to add and
subtract from the current selection. By doing so,
you can create a selection as elaborate as you wish.

Next/Previous Search Results
The Next Search Result and Previous Search Result
commands in the Edit menu (located in the Search
sub-menu) browse through the current search
results in the editing window for their track. This is 

similar to clicking the Previous/Next Search Result
buttons in the Search Results window (as shown in
Figure 32-15 on page 366).

Saving & editing search settings

The Search window mini-menu has several
commands that let you name, save, edit, rename
and delete search settings that you create. When
you name and save a set of search settings, you are
capturing all of the settings visible in the Search
window at the time you save it.

Figure32-13: To save the search settings currently shown in the
Search window, choose Save Search Settings from the Search
window mini-menu.

C Restore Default Search Settings, k

Th Nev Search
I Save Search Setti

*»_ Search

’ I

Ev My search settings
L 16th-note offbeats

All notes above C5 and belov Cl
Nested settings

Figure32-14: the Edit Search Settings command in the Search
window mini-menu lets you rename and delete search settings, as
well as assign a hot key to them. This command is also available in
the Search sub-menu in Performer's main Edit menu.
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To assign a hot key to a saved search setting:

1 Choose Edit Search Settings from the Search
window mini-menu (or from the Search sub-menu
in the Edit menu).

2 Click on the dash to the right of its name.

3 Press the desired hot key.

4 Click anywhere outside the pop-up text box.

Restoring default search settings

Performer ships with a collection of useful search
presets, which appear in the Search window mini­
menu, as well as in the Search sub-menu in the Edit
menu. If you accidently modify or delete some of
these default search settings, you can restore them
with the Restore default Search Settings command
in the Search window mini-menu. Any custom
search settings you have created and saved will not
be modified in any way by this operation—as long
as they have names that are different from the
factory default search settings.

BASING SETTINGS ON THE CURRENT
SELECTION
Each group of settings in the Search window has an
option called Base settings on current selection.
When you check this option, the values for any
settings in the group are taken from the current
selection, if any. If there is no selection, they are
ignored. In general, when you check this option,
the settings that are taken from the current
selection are displayed differently to indicate that
the information is being taken from the current
selection. For example, they option might gray out,
or it might be displayed as a ” instead of a text
box.

There are some settings that are not taken from the
current selection when this option is checked — in
useful ways. For example, if you are using the
Time>Is (with slop) setting as shown below, the
time itself will be taken from the current selection, 

but the amount of slop is not. This allows you to
search on various time locations with the same
amount of slop each time.

Tfrr«?--------------------------------------------------- -
I !n~| --------plus or mtnus | ilooo] E]

S Gt;? settings on c wrent mIk tfcn - | ♦ | tl j.

THE SEARCH RESULTS WINDOW
To open the Search Results window, choose Display
in search results window from the Action menu in
the Search window and click the Search button.

Search results listPrevious/Next search
result buttons

Figure 32-15: The Search Results window.

Search Results window quick reference
Search results list: Displays the data found by the
last search operation.

Select button: Selects the events currently
highlighted in the Search Results window list.
Unlike the Go button, this command does not
open editing windows or the Tracks window.
Instead, it just selects the data.

Go button: Opens the editing window and selects
the data for the currently highlighted data in the
Search Results window list. If events from more
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than one track are currently highlighted, the Go
button opens the Tracks window (or brings it to the
front) and selects the highlighted data.

Previous/Next search result buttons: Does the

same thing as the Go button for the next or
previous item in the Search Results window list.

Search Results mini-menu quick reference

Refresh: Performs the exact same search as the very
last time you clicked the Search button in the
Search window, even if you’ve since changed the
top-most window, the selection being searched, or
any other aspect of the search that can affect where
it takes place.

Export: Opens a standard file save dialog box,
which lets you save the current contents of the
Search Results window as a text file.

Group: Some search settings, like the metric grid,
naturally clump data events into groups. If you use
such a setting in your search, it will appear by
name, such as Metric grid I, as a checkable item in
this sub menu. When you check it, you’ll be able to
select grouped items in the Search Results list as a
group by clicking on just one of them.

Measures/Real Time/Frames: These checkable
items at the bottom of the menu let you choose the
time format used for the display of events in the
Search Results list.

Search Results window basics

The Search Window appears when you choose
Display in search results window from the Action
menu in the Search window and then click the
Search button.

Like the Search window, the Search Results
window can stay open as you perform multiple
searches.

I SEARCHING

Data listed in the Search Results window can’t be
edited, as this window is only meant for browsing.
You can, however, highlight data in the list. Once
data is highlighted, you can either select it with the
Select button, or select it and open its event list
window with the Go button. If data from more
than one track is highlighted when you click Go, it
will select all of the data and open the Tracks
window instead (or bring it to the front if it is
already open).

The Previous/Next Search Result buttons, as shown
in Figure 32-15 on page 366, do the same thing as
the Go button for the next or previously
highlighted item in the list.

Searching again with the Refresh command

Often, you’ll conduct a search and then make
changes to your data based on the search. You
might then realize that you want to conduct the
same search again. But since you’ve been working
in many different windows, changing the current
selection, and otherwise changing the conditions
under which the original search was conducted,
you can’t just click the Search button again because
you won’t get the same results.

The Refresh command in the Search Results
window mini-menu fixes this problem by
conducting the exact same search again, regardless
of whether the factors that control where the search
takes place have changed.

Exporting search results as text
The Export command in the Search Results
window mini-menu lets you export the list in the
window as a text file for printing or importing into
word-processing programs, spreadsheets, or any
other software that can import text.

Grouping search results
Some search criteria, such as the metric grid, find
clusters of events that you might like to highlight,
select, and view as a whole. The Group item in the
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Search Results window mini-menu lets you do so.
Simply check the search criteria you’d like to group
the search results by. For example, if you’ve used a
metric grid in your search, choose it by name —
something like “Metric Grid 1”— from the Group
sub-menu. Now, when you click on an event in the
Search Results list that belongs to a cluster of events
found by the metric grid search setting, all of the
events in the cluster will highlight. Similarly, if you
click Go, they’ll all be highlighted in the event list
window that opens for them. The same goes for the
Previous/Next Search Results arrow buttons.



CHAPTER 33 The Click

The Click is the audible indication of the
Metronome beat The Click is produced on the
Macintosh’s internal speaker or through MIDI on a
drum machine or other sound module. The Click
is accessible via the Click command in the Basics
menu and the Metronome button in Performer’s
Control Panel. The Click & Countoff Options
feature in the Basics Menu allows you to control the
click’s source and volume. In addition, it provides
options for when the click occurs e.g. only while
recording or only during the countoff.

BASICS
The Click “clicks” on the beat. The beat is
determined by each meter change in the
Conductor track. If the Click is on, Performer will
click at the beginning of every measure. The first
beat of every measure is slightly accented. The
subsequent clicks in the measure depend on how
the metronome click value is set in the current
meter. To learn more about setting meters, see
chapter 28, “Change Meter”.

Enabling the Click

To turn on the Click, choose Click from the Basics
menu or press command-5. To turn off the Click,
choose it again. When the Click is on, the Click
menu item will be checked.

To adjust the Click volume independently of the
Macintosh beep sound, use the Click & Countoff
Options dialog box described in the next section.
You can also amplify the Click by routing the audio
output from the speaker jack on the rear of your
Macintosh to your sound system. See the following
two sections for more information.

CLICK & COUNTOFF OPTIONS
The Click & Countoff Options dialog box, chosen
from the Basics menu, provides several options for
controlling the click.

You can also open this dialog by double-clicking
the Count-off button.

Source of Click
Source of click specifies how the click is generated.
Select one or both options.

The Internal speaker option produces a click sound
from the computer’s internal speaker.

<•" (Note: the internal speaker click does not work
on some Macintosh models with certain system
configurations.)

The MIDI option will send a MIDI note for every
click. For this option, you must set up an
instrument to receive these notes and play a‘click’
sound of your choosing. For example, a drum
machine could play rim shots, or a synthesizer
could play short beeps.

Click options
Always click makes the click audible whenever
Performer is counting off, playing or recording.



Only during countoff makes the click audible only
during countoff measures. When playback or
recording begins, the click will fall silent. See “The
Countoff button” on page 44 for more information
about the countoff.

Only when recording makes the click audible only
when Performer is in record mode. If the Countoff
button is enabled, Performer will also click during
the countoff in this mode.

No accent removes the accent from the first click in
each measure. This option affects both the internal
speaker click and the MIDI click.

Countoff options

Countoff n measures lets you type in the number
of measures you want for the countoff. The
countoff will be in the same meter as the current
playback location in the main counter.

Countoff only when rec ording causes the countoff
to occur only before recording, not before playback
or any other function.

Data for MIDI Click

These options define what notes are played if the
MIDI option is selected. The Accented note is played
on the first beat of each measure; the Normal note is
played at all other times. Each note has four
parameters:

First, you specify the device that will play the
accented and unaccented click by choosing it from
the pop-up menu provided. The list of devices in
the menu is provided by FreeMIDI.

Pitch is the pitch of the note, expressed as a scale
letter (A-G) (use the number sign # to represent a
sharp, or a small letter ‘b’ to represent a flat) and an
octave number. For example, C3 means middle C.

Velocity is the attack (on) velocity, expressed as a
number from 0-127.
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Gate specifies the length of the note in milliseconds
(thousandths of a second).

Internal Speaker Click Volume

The Internal speaker click volume slider controls the
volume of the Macintosh speaker click. To increase
the click volume, drag the slider to the right; to
reduce volume, drag to the left. Or, press the + or -
buttons at each end of the slider.

_____123 ___________

^WrffmwfrWI>
Internal speaker click volume

Performer’s click volume is also affected by the
volume slider in the Sound Control Panel. See
“Routing the Internal Speaker Click to Your Sound
System” on page 371 for information about how to
set the system beep and speaker click to different
volumes.

On some models of the Macintosh, this slider
has no effect.

Setting Click & Countoff Options

To set the Click & Countoff Options dialog box:

1 Select Click & Countoff Options... from the
Basics menu.

2 Select Internal speaker and/or MIDI mode.

Click in the corresponding check box to select a
mode. Both modes can be selected simultaneously.
If both modes are turned off, no click will be
generated, even if Click is selected from the Basics
menu.

3 Select a preference for when the click occurs.

Refer to the beginning of the Click & Countoff
Options section for an explanation of each option.

4 Adjust the Internal speaker click volume, if
necessary.
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Drag the slider to the right to increase the click
volume; drag it to the left to decrease volume. To
further amplify or attenuate the click, use the
Volume slider in the Sound Control Panel.

5 Set the MIDI click parameters, if necessary.

To change a parameter, click in its box, then type in
the new values. You can also set the value over
MIDI from your controller keyboard.

6 Click on the OK button to confirm your
settings, or on the Cancel button to cancel the
changes.

Routing the Internal Speaker Click to Your
Sound System
You can amplify the Internal speaker click by
routing the audio output from the speaker jack on
the rear of your Macintosh to your sound system.
When this is done, however, the Macintosh
warning beep sound, which is much louder than
the click, will also become amplified. To avoid an
over-amplified beep, you can turn down (or turn
off) the beep sound using the Sound Control Panel
in the Apple menu. It provides separate volume
controls for the beep sound and other sound
output.
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chapter 34 The Counter Window

The Counter Window is identical to the main
counter in the Consolidated Controls Panel, except
that it is a large, separate window, and it can display
all three time formats at once. For complete
information about using either counter, see “The
Counter” on page 53.

Setting the Counter window display

The counter window can display one or more of the
three time formats in any combination. One format
is designated as the Main Counter. It will appear at
the top of the window. You can also specify two
“Aux” (auxiliary) Counters which appear below the
Main display. The format is identified by a small
icon positioned just to the right of it in the Counter
window:

Figure 34-1: The Counter provides a large display of any combination
of time formats you choose.

*•. Counter

3 2 HBH-
0

Counters can continuously display the current
location of the sequence or song or can update the
location only after the stop button is pressed. The
former mode requires some microprocessor
overhead; turning off the continuous update
option will improve the program’s responsiveness
during recording and playback.

To set the counter display:

1 Choose the Set Display command from the
Counter window mini-menu.

o

set Display ;

Running
Update

9□□

OjurittrsTime type: CounUr
C Mtuurts
© Real time O

Framer

□
SI
a

Figure 34-2: The Set Display mini-menu command lets you customize
the Counter as desired.

2 Choose the time display for the main counter in
the Main Counter column.

3 Choose other time formats by clicking on the
desired box(es) in the Aux Counter column.

4 Specify which of the displays will be
continuously updated by clicking in the desired
box in the Running Update column.

If the Running Update box is not checked, the
corresponding time display will change to dashes
while the sequence is playing or recording.

5 Press the OK button to confirm your choice or
the Cancel button to cancel it.

Counter window mini-menu
In addition to the Set Display command
mentioned in the previous section, the Counter
window mini-menu has two other commands.

Set Frame Rate
For complete information about setting the
SMPTE frame rate, see “Slaving to SMPTE with
MTC, DTL, or DTLe” on page 391.

Set Chunk Start
For complete information about setting the start
time of a sequence or song (chunk), see “Setting
the start time” on page 54.
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chapter 35 The Movie Window

Random access digital picture

Performer’s Movie Window provides synchronized
playback of a QuickTime Movie with both MIDI
and audio tracks in a sequence.

QuickTime movies provide a quantum leap in
flexibility and convenience over the process of
synchronizing to video decks because QuickTime
movies give you random access picture—just like
digital audio. Here are just a few example benefits.
You can:

■ Instantly locate to any spot in the movie

■ Advance forwards or backwards one frame at a
time through the picture and music

■ Scrub forward or backward (with or without
MIDI scrubbing)

■ Seamlessly loop both picture and music

And all of this can be done without the hassles of
slaving to external time code. The time you save
and the flexibility you gain more than make up for
the cost of digitizing your film, video, or other
media.

QuickTime 2.0 (or higher) is required
The Movie command is grayed out if you do not
have QuickTime 2.0 or later properly installed in
the Extensions Folder inside your System Folder.

Opening and closing movies

The Movie command in the Windows menu opens
a QuickTime movie in Performer. To open a movie,
choose this command to get a standard Macintosh
Open dialog box. You may choose any QuickTime
movie file, or any other file which QuickTime
knows how to convert to a movie.

You may close the Movie window, and Performer
will still remember which movie file you opened —
this information will be saved with the file. To
reopen the movie, just choose Movie from the
Windows menu again.

To close the movie permanently so that Performer
forgets about it, chose Close Movie from the mini­
menu.

If you have a movie open and want to choose a
different movie, choose Open Movie... from the
mini-menu. Only one movie may be open at a
time.

Movie controls
Here is an overview of the controls in the movie
window:

Buttons

The Lock button
If the lock button in the movie window’s title bar is
on, the movie is locked to Performer’s transport.
The movie will slave to Performer as you play, stop,
and locate. Conversely, you can use the movie
controls at the bottom of the movie window to
control Performer. If the lock button is off, you can
control the movie and Performer’s sequences 
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independently. This is useful if you want to preview
a movie without synths blaring, wipers scrolling,
and so on.

Volume slider
The volume control allows you to set the playback
volume for the movie’s audio track. If the movie has
no sound, there will be no volume control. Option­
clicking will mute or unmute the movie’s sound.
Shift-clicking lets you “overdrive” the volume up to
300%.

Play/Stop button

The Play/Stop control starts and stops movie
playback. Also, clicking the movie itself will stop;
double-clicking will play.

Slider

The slider shows where in the movie you are, and
can be used to “scrub” the movie or to set your
location in the movie. If Audible mode is turned on
(with the speaker button in the title bar of the
Tracks window), MIDI data will scrub along with
the movie.

Step buttons
The step buttons move forward or backward
through the movie one frame at a time. Note that
this means movie frames, not SMPTE frames. A
movie may have 15 fps, 30 fps, or even a number
which varies throughout the movie. Option
clicking moves to the beginning or end of the
movie. The left and right arrow keys will also work
if the window is in front.

Grow box

The grow box works as usual, with these additions:

■ Holding down the option key while resizing the
window constrains the window to a “good” size,
meaning one which QuickTime is able to playback
efficiently. This means one quarter, half, three
quarters, full size, double, triple, etc.

■ Holding down the shift key while resizing the
window keeps the aspect ratio correct at any size,
but the movie is not likely to play back efficiently.

Movie window mini-menu commands

Open Movie: Presents you with a standard
Macintosh Open dialog box. You may choose any
QuickTime movie file, or any other file which
QuickTime knows how to convert to a movie. You
can use this command to switch to a different
movie.

Close Movie: Closes the movie permanently, so
that Performer forgets about it.

Set Movie Start Time: Allows you to set the SMPTE
time which corresponds to the beginning of the
movie. If you want the movie to start at the
beginning of the sequence, this should be set to the
same time as the SMPTE chunk start time. You may
need to try adjusting the start time by ±40 time
code bits if you find that the frames in the movie
don't precisely line up with the frame numbers in
Performer's counter.

Use Movie’s Color Table: Movies can have preferred
color tables stored inside them. If the movie
window is on a screen in 256-color or 16-color
mode, and the movie has a color table, this item
will be enabled (not grayed out). If you check it,
Performer will use the movie’s color table whenever
the movie window is open, giving (hopefully) truer
colors.

Half Size, Normal Size, and Double Size: Resize the

window. One of these may be checked if the
window is already that size.

Scrubbing with the Movie window slider

You can “scrub” playback with the Movie window
slider. For more information, see “Scrubbing” on
page 91.
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Improving the performance of the movie
window
QuickTime can tell if it has the power to play all the
frames in the movie. If not, it drops one or more
frames, but keeps playing at full speed. So a movie
with 30 fps in it might play at 30 fps on a fast
machine, but only at 15 fps on a slow machine,
dropping roughly every other frame.

The following things may hinder the computer’s
ability to play a movie back smoothly:

■ Larger movies (in pixels)

■ Movies with higher frame rates

■ Playing the movie from slower drives, e.g. a CD-
ROM drive

■ Resizing the window to non-optimal sizes (not
double, full, or half size)

■ Having many other open windows with scrolling
wipers, auto scroll, level meters, etc.

Avoiding these things will help your movies play
back more smoothly.

Using third-party video hardware

There are a number of digital video hardware
systems available for Macintosh that provide
playback performance well beyond that which the
computer can handle on its own. Some of these
systems even provide 30 frame-per-second, full­
screen playback on a second video monitor —
some systems can even provide broadcast quality
image resolution.

Digital Performer’s QuickTime Movie window has
been successfully field-tested with the Radius
Video Vision™ system at full-screen, 30 fps
playback. It has also been successfully tested with
the Data Translation MedialOO system. Digital
Performer should work with any Macintosh-based
digital video hardware system — as long as it is
QuickTime-compatible. If possible, however, try
before you buy.

I THE MOVIE WINDOW

Movie audio while slaved to external sync

The Movie window’s audio track is automatically
disabled in Slave to External Sync mode. The
volume control will disappear in this case.
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chapter 36 The fiVD0OO Monitor

The MIDI Monitor window displays incoming
MIDI activity, broken down by input device, MIDI
channel, and type of data. This feature is handy
when testing hardware, tracing problems in your
MIDI system, or monitoring time codes or other
special MIDI data. The MIDI Monitor window will
function whether active or inactive.

Opening the MIDI Monitor Window

Choose MIDI Monitor from the Windows menu;
the window will appear. To move it, click in the title
bar and drag to the desired location. To close the
MIDI Monitor window, click in the window’s close
button.

Basics
The MIDI Monitor window consists of one panel
for each FreeMIDI system device that has its MIDI
OUT connected to the MIDI interface in your
current FreeMIDI configuration. It therefore
displays any devices that have the ability to send
MIDI data to Performer. Each panel contains 16
MIDI channel indicators that are normally unhigh­
lighted; they highlight to indicate incoming MIDI
data.

MIDI channel activity Incoming MIDI data from the
indicators KORG 01/W on MIDI channel 5.

FreeMIDI devices appear Modem and printer port real-time
here in the MIDI monitor. data lights. Displays incoming sync

Figure36-l:The MIDI Monitor window. The ’Co"lights are MIDI
system common data indicators. They light up when system exclusive
data is being received from the device.

The window includes real-time indicators for the
modem port and printer port.

<•“ The Input Filter has no impact on the MIDI
Monitor window’s display.

The MIDI Monitor window only displays
incoming MIDI activity—only data being received
by Performer from somewhere else—not outgoing
data being sent by Performer.

Channel Activity indicators display MIDI activity
by MIDI channel. Most normal MIDI data will
cause one of these indicators to light up; for
example, pressing a key or moving the pitch bend
wheel on a controller keyboard will cause the
corresponding Channel Activity Indicator to turn
black.

The System Common indicator, labelled “Co”,
indicates incoming system common data, such as
system exclusive data, tune request, Song Position
Pointer, and Song Select commands.



The System Real-Time indicator, labelled “Rt”,
includes MIDI beat clocks, DTL (Direct Time
Lock), DTLe (Direct Time Lock enhanced), and
System Reset commands. This type of data is used
to synchronize devices, and is generated by most
sequencers, drum machines, and SMPTE-to-MIDI
converters. System real-time data is not assigned to
a particular channel and therefore has just one
indicator per port.

Active sensing messages, which are sent by some
brands of MIDI equipment, are ignored by the
MIDI Monitor window. To see if your equipment is
“on-line” and working correctly, send note data
and observe the Channel Activity indicators, or test
it in the FreeMIDI Setup application.

Reordering Devices in the MIDI Monitor

To rearrange the order of the devices in the MIDI
Monitor, just drag the panels up or down.

MIDI Monitor window mini-menu

The MIDI Monitor window has the following
mini-menu commands:

Show all input devices
This command makes the MIDI Monitor display
all devices in your FreeMIDI configuration file that
have a MIDI OUT connected to a MIDI IN on the
interface.

Show controllers only
This menu command makes the MIDI Monitor
display only those devices in your FreeMIDI
configuration file that have the Controller device
property assigned to them.

Clear all devices
Removes all devices from the MIDI Monitor
display so you can start from scratch again.

Individual Device names
The mini-menu also displays the name of each
device in your studio. Select the name to
individually display it. Select it again to hide it.
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chapter 37 The Memory Window

As you record and edit music in Performer, more
and more of the Macintosh’s RAM (random access
memory) is required to store it. If a great deal of
recording or editing is done in a file, or if you are
loading sequences from other files, it is possible to
run out of memory. It is therefore desirable to
monitor how much memory is being used to keep
this from occurring.

BASICS
The Memory window displays the current amount
of free memory. It is constantly updated to supply
you with a running status of available memory.

The Macintosh’s memory usage is dynamic: it
changes according to the current task. The
memory profile will vary widely with different
activities. For instance, if you use a section of the
program for the first time, you may find that you
suddenly have 30K less of memory. This is the
space that the program utilizes for that particular
part of the program.

For these reasons, it is a good idea to keep a
watchful eye on the Memory window. If you have
150K or less memory free, save often; a long
recording or editing pass may use up all your free
memory. Also, avoid editing and recording large
regions; instead, work with smaller sections.
Performer does its best when memory is low but in
such circumstances there is a possibility of a system
crash and the loss of any work you haven’t saved.

Using the Memory Window

To open the Memory window, choose Memory
from the Windows menu. The window appears.

720K free

” Memory

To move the window, click in any part of it except
the close button and drag it to the desired location.
To save space, the Memory window has no title bar.

To close the Memory window, click in the window’s
close button.
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chapter 38 Window Sets

OVERVIEW
The Window Sets feature in the Windows menu lets
you capture, name and save your favorite window
layouts. You can create as many window sets as you
want. You can assign each window set to hot keys
on your Macintosh keyboard for instant recall.

Windows
Open
Close
Newt Edit Window

►
3€W
38'

Hi in do w Sets , ► Copture Window Set...
Edit Window Sets...

Clippings F
Consoles ► Recording— Mining wED
Audio Monitor Audio editing
Dockground Processing Euent List editing wtE
Chunks MIDI Graphic Editing •~E)

✓ Control Ponel Natation Edltlng/Printing -.-tS)
Counter
Deulce Groups
Effects
Input Quontlze
Memory
MIDI Machine Control
MIDI Monitor
Mining Doard
Movie
QulckScrlbe
Demote Controls
Samplers
Soundbites

Figure 38- J: Performer lets you save your favorite window layouts as
window sets that you can recall by name from the sub-menu shown
here or by hot keys on your Mac keyboard that you've assigned to
them.

CREATING A NEW WINDOW SET
To create a window set:

1 Arrange the windows on the screen the way you
would like for the window set.

Performer will remember the location of all
windows, including edit for tracks windows.

2 Choose Capture Window Set.

3 Type in a name for the window set in the dialog
box and click OK.

The window set will now appear by name at the
bottom of the Window Sets hierarchical menu as
shown in Figure 38-1.

CHANGING AN EXISTING WINDOW SET
This procedure is the same as the one in the
previous section, except that when you name the
window set, type in the same name as the one you
want to change and it will be replaced with the new
one you are creating.

OTHERWISE MODIFYING WINDOW SETS
Choose Edit Window Sets from the Windows menu
to do any of the following things to a Window Set:

□ Rename a window set

■ Delete a window set

■ Change the order of the window sets in the menu

■ Assign hot keys to window sets

Figure 38-2: Editing Window sets.

Renaming a window set
To rename a window set, click its name in the Edit
Window Sets dialog as shown in Figure 38-2 to
highlight it and then click the Rename button.
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Deleting a window set
To delete a window set, click its name in the Edit
Window Sets dialog as shown in Figure 38-2 to
highlight it and then click the Delete button.

Changing the order window sets in the menu

To change the order of the window sets in the
Window menu, click on the icon to the left of their
name in the Edit Window Sets dialog as shown in
Figure 38-2 and then drag them up or down as
desired in the list.

Assigning a hot key to a window set

To assign a hot key to a window set:

1 Choose Window Sets>Edit Window Sets from
the Windows menu.

2 Click on the dash to the right of the window set
name.

3 Press the desired hot key.

4 Click anywhere outside the pop-up text box.

WINDOW SET TIPS AND TRICKS
Here are a few useful things to know when using
window sets.

Closing windows before opening a window set

When you call up a window set, it opens all the
windows that you saved as part of the set, but it
doesn’t close other windows that happen to be
open. If you don’t want other windows to remain
open, use one of the following shortcuts before
opening the window set:

■ Press command-option-w to close all edit
windows.

■ Press command-control-w to close all windows
(except the control panel).

Including track edit windows in a window set

When you save a window set, only edit windows
from a single chunk are stored. The top-most open
window that belongs to a chunk (such as a Tracks
window, Event List or Song window) determines
which chunk this is. If there are no open windows
that belong to a chunk, the play enabled chunk is
used. All editing windows that belong to the target
chunk are remembered, as well as all the other non­
editing windows. Edit windows that do not belong
to the target chunk are ignored.

When a window set is recalled, a similar process is
applied in reverse. First, the target chunk is
determined by looking at the open windows — or
the play-enabled chunk, if necessary. Then for each
edit window type in the window set, Performer
looks for an existing open window belonging to the
target chunk that matches the window in the set. If
no existing open window is found, the system tries
to open one based on the name of the track in the
window when it was saved with the window set.
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chapter 39 Receive Sync

The Receive Sync dialog box, found in the Basics
menu, allows you to ‘slave’ Performer to a wide
variety of‘master’ timing sources. Performer
supports all standard MIDI synchronization
formats, including MIDI Time Code and MIDI
beat clocks with Song Position Pointer data for
synchronization with drum machines, hardware
sequencers, and other MIDI devices. With an FSK
or SMPTE to MIDI converter such as Mark of the
Unicorn’s MIDI Time Piece (MTP), Performer can
synchronize (or ‘sync’) to audio tape, video, or
film, ensuring that events in your sequence happen
at exactly the same spot on tape or film every time.
For more information about synchronizing
Performer with the MTP, see chapter 47,
“Performer & the MIDI Timepiece™” (page 459).
Performer also has a unique Tap Tempo feature for
synchronizing to prerecorded music, conducting a
sequence as it plays back, or simply recording a
tempo map in real time.

BASICS
Performer supports all standard modes of
synchronization: standard MIDI beat clocks,
Indirect Time Lock, Direct time lock/MIDI Time
Code for SMPTE time code sync, and Tap Tempo.
These modes are selected in the Receive Sync
dialog box. When Standard beat clocks, Indirect
time lock, or Tap Tempo is selected, other
parameters appear in the Receive Sync dialog box
and must be set correctly; the Direct time lock/
MIDI Time code mode has no other parameters
(except for the frame rate). The mode you use
depends on the equipment to which you are
synchronizing; the following section describes the
common forms of synchronization and the
corresponding modes in Performer.

Basic Types of Sync

MIDI Beat Clocks are produced by most MIDI
compatible drum machines and sequencers, and
by some synthesizers (particularly those with
built-in sequencers).

MIDI beat clocks are transmitted 24 times a beat. If
the master device changes tempo, the MIDI beat
clocks slow down or speed up accordingly; any
slave device will follow this tempo change. Most
devices that generate MIDI beat clocks also send
Start, Stop, and Continue messages; slave devices will
start playback, pause, rewind, or play from the
current location according to the combination of
these messages received. In addition, many devices
send Song Position Pointer data. These messages set
the current location for playback, much like setting
the Counter in Performer. To sync Performer to
devices using these MIDI messages, use the
Standard Beat clock mode in the Receive Sync
dialog box.

FSK is an audio signal which can be recorded on
audio tape. Like MIDI clock signals, it provides
metrical timing information based upon a certain
frequency of oscillations per beat. FSK does not
include any positioning information; when using
it, playback must always begin from the beginning
of the signal. If you are using Performer with an
FSK converter, you must rewind the sequence and
the tape each time to sync correctly. Performer
does not read FSK directly, a special device is
needed to read the code and convert it to MIDI
clock signals. To sync Performer to FSK converters,
use the standard beat clocks mode in the Receive
Sync dialog box.



SMPTE time code is an international standard that
was developed for film and video work but has
proven to be very useful in normal audio work as
well. This is an absolute time code, expressing
hours, minutes, seconds and divisions of the
second in digital form. It can be recorded on tape
or film and read by a special device to convert it to
MIDI. Since SMPTE has no intrinsic tempo
information, the sequencer or device converting
SMPTE to MIDI must generate its own tempi.
Performer’s flexible tempo map and frame time
display make it ideal for work with SMPTE time
code. Because of its accuracy and wide-spread
acceptance, SMPTE is the most powerful of the
time code formats. Depending on your converter,
you can use the Standard beat clock, Indirect time
lock, or Direct time lock/MIDI Time Code modes.
Direct Time Lock/MIDI Time Code is the easiest
and most accurate mode. Indirect Time Lock,
Direct Time Lock, and MIDI Time Code allow the
use of Performer’s tempo maps, and are far
superior to the Standard beat clocks mode.

Tap Tempo is Performer’s real-time tempo control
facility. This form of synchronization slaves
Performer to a ‘tap’ entered from your MIDI
controller. Performer receives a MIDI event for
each tap and computes a tempo based on the
current meter, the click value, and each event’s
distance in time from the previous event. Any
tempo information in the sequence is ignored
while Performer is slaved to Tap Tempo. Tap Tempo
supports both recording and playback, so your tap
can conduct or be recorded into any sequence,
empty or finished. When you record in Tap Tempo,
each tap becomes a tempo event in the Conductor
Track. Even if you have a minimum MIDI setup,
you have everything you need to use Tap Tempo
synchronization.

The following sections describe Performer’s sync
modes.

STANDARD BEAT CLOCKS
This is the standard form of synchronization
between two MIDI devices. When the Standard
beat clocks option is selected, Performer can sync
to a master device that is generating MIDI clock
signals. If you want to slave Performer using a
drum machine, external sequencer, FSK converter,
or other MIDI device as master, use this mode.
This mode may also be used with a SMPTE
converter that generates its own tempo map. In
Standard beat clocks mode, Performer’s tempo will
match that of the master device; Performer’s tempo
features are disabled.

When you select the Standard beat clocks option,
the Receive Sync dialog box looks like this:

Sync to port: Modem__________
□ Record vhile d ill-framed

□ Jambox

Type of sync;

■ ~ fO MTC, DTL, or DTLe
.....

(S' Standard beat clocks
O Tap tempo

SMPTE Frame Format;
O 24 fpr 029.97 fps
O 25 fps <t> 30 fps

□ Drop frame

O 24 clods; per metronome chd.
. (it 24 clocks per quarter note

□ Start on any dock
(no start/continue needed)

□ First dock is time 1
(not time 0)

Implementations of MIDI have evolved over the
years. As a result, not all devices transmit and send
MIDI clock signals in the same way. Performer
provides several options for maximum synchroni­
zation compatibility with your master device: 

24 clocks per metronome dick/24 clocks per
quarter note; Some manufacturers have begun to
make devices which send 24 clock signals per beat
(one click of the device’s metronome) instead of the
standard 24 clocks per quarter note. This new
method is very useful when there are meters which
do not use the quarter note as the beat unit: 3/8,5/
16, etc. In 6/8, for example, there might be a 
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metronome click every three eighth notes; in 4/1,
the metronome would click once every whole note.
If you were using a less common meter such as 5/32
or 3/16 + 4/16, using the quarter note as the timing
base would not be very useful. Instead, use the 24
clocks per metronome click option.

Start on any clock: When this option is checked,
Performer will automatically start if it receives a
time clock even if no start or continue command
was received. This option is necessary when using
some early MIDI devices which don’t send start or
continue commands, only timing clocks.

First clock is time 1: When this option is checked,
Performer interprets the first MIDI clock signal it
receives as the second timing clock of the sequence,
1 /24th of a beat after the beginning. Devices
manufactured recently send the first clock signal
(time 0) after the start command for the sequence.
Some earlier devices assume the start command to
be the first clock signal. The first clock signal they
send would be 1 /24th of a beat after the beginning.
If you are using one of these devices, you should
check this option.

Since manufacturers rarely explain this aspect in
their documentation, you may not know if your
device behaves this way. The best way to find out is
to experiment: set the metronome to the slowest
possible tempo, play both devices (with Performer
as slave) and listen for discrepancies in attacks and
beat alignment. The difference of 1 /24th of a beat is
very audible at a slow tempo. If Performer seems
slightly behind the master device, try checking this
option.

Default Settings

The default settings reflect the most commonly
used MIDI standards. It is best to set them this way
before choosing to alter them:

■ 24 clocks per quarter note

■ start on any clock: unchecked

I RECEIVE SYNC

■ first clock is time 1: unchecked

Using Standard Beat Clocks Mode

To put Performer into Standard beat clocks mode:

1 Select Receive Sync from the Basics menu.

2 Choose the port receiving the sync information.

Choose the port from the pop-up menu provided.

3 Click on the Standard Beat clocks button.

4 Choose between 24 clocks per metronome click
or per quarter note.

5 Select the timing options you want by checking
their check boxes.

Selecting the Start on any clock will cause
Performer to automatically start upon receipt of
any clock signals. Selecting the First clock is time 1
option will interpret the Start signal as the first
timing clock.

6 Press OK to confirm your choice or Cancel to
cancel it.

To slave Performer to an external source
transmitting MIDI beat clocks:

1 select Slave to External Sync from the Basics
menu.

This puts Performer into slave mode, waiting for
sync information from an external device.

2 Click on the Play or Record button in the main
transport controls.

The Play button will flash on and off, meaning that
Performer is waiting for sync information to start.

3 To start Performer, start the external device.
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When Performer is locked and playing, the Play
button will turn to solid black. Once locked,
Performer will follow, start, stop and rewind under
control of the master.

4 To terminate the lock up with the master, click
on the Stop button.

Clicking on the Stop button will both stop
Performer and remove it from the master’s control.
This can be done at any time. To return to normal
operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

INDIRECT TIME LOCK
Indirect time lock allows Performer to lock to time
code (such as SMPTE) using standard MIDI clock
signals. This requires a specific method of setting
your SMPTE to MIDI converter. Indirect time lock
works as follows: First, a steady tempo (60 BPM)
and a starting SMPTE frame are set in the SMPTE
to MIDI converter. The converter reads the time
code and generates MIDI clock signals at the
specified tempo. Performer reads these clock
signals and computes SMPTE frame locations
based upon the constant MIDI beat clocks it
receives: the original SMPTE frame times are
regenerated by Performer.

To use Indirect time lock, you must set the
converter to a constant tempo of 60 beats per
minute and pick a starting frame that is before the
point at which you want playback to start. The
starting frame for the converter should be at least
10 seconds before the start of the sequence and no
more than 45 minutes before the end of the
sequence, the exact time is not important.

The starting frame time must be entered into
Performer. It is important to set exactly the same
frame time in Performer and your converter, as all
subsequent frame times are computed from this
starting time. For best results, use a round number
to start from such as 1:28:00:00. This will reduce 
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the chances of rounding errors in the converter.
Once locked up, Performer follows the tempo map
you’ve programmed for the sequence. Also upon
lockup, if Click is enabled, Performer will click in
the meter specified at 1111000 or will default to 4/4.

Due to the limitations of the MIDI song position
message, Performer can only locate over a 45
minute range in this mode. If you try to work on a
longer piece, Performer will not be able to lock to it
after 45 minutes.

To put Performer into Indirect time lock:

1 Set the starting frame number on your
converter.

Make sure that this time is at least 10 seconds
before the start of the sequence and not more than
45 minutes before the end of the sequence.

2 Choose Receive Sync from the Basics menu.

A dialog box appears.

3 Choose the port receiving the sync information.

4 Click on the button next to “Indirect time lock”.

Type of sync:

MTC, DTL, or DTLe
I© Indirect time lock
O Standard belt clocks
O Tap tempo

SMPTE to MOI converter must
be set to 60 beats per minute.

Converter start frame:
I 0:00:00:00]

□ Start on any clock
(no st art /continue needed)

□ First clock h time 1
(not time 0)

5 Set the converter start frame time.

This must match the frame number you set in the
converter.

6 Set the timing options if necessary by checking
their check boxes.

RECEIVE SYNC |



If your converter outputs non-standard timing
information, you may need to check the Start on
any clock and/or First clock is time 1 options. See
“Standard Beat Clocks” on page 388 for an
explanation of these.

7 Press OK to confirm your choices or Cancel to
cancel them.

8 Set the SMPTE frame format.

SMPTE Fr»rw> Format:
O 24 fps O 29.97 fps
O 25 fps ® 30 fps
□ Crop from*

All standard SMPTE frame rates are provided,
including 29.97 Drop and 29.97 non-drop. The
Drop frame check box is available only when the
29.97 frame rate option is selected.

9 Set the start time for the counter, if necessary.

Click the Start Time button in the counter and
enter the start time in the dialog box provided.

The counter start time is different from the starting
frame number you entered in the converter and the
Receive sync dialog box: it is the time that
Performer will display as the starting time when
the sequence begins. The time you enter should be
later than the one you set on your conversion unit
or external device (a few seconds, at least):
Performer will take this amount of time to “chase”
the correct frame number to lock with it.

10 Select External Sync from the Basics menu.

This puts Performer into slave mode, waiting for
sync information from an external device.

11 Click on the Play or Record button in the main
transport controls.

The Play button will flash (or turn gray on black
and white monitors), meaning that Performer is
waiting for sync information to start.

12 To start Performer, start the external device.

When Performer is locked and playing, the Play
button will turn to solid black. Once locked,
Performer will follow, start, stop and rewind under
control of the master. Also upon lockup, if Click is
enabled, Performer will click in the meter specified
at 1111000 or will default to 4/4.

13 Click Stop to terminate lock up with the master.

Clicking on the Stop button will both stop
Performer and remove it from the master’s control.
This can be done at any time. To return to normal
operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

Don’t confuse the counter’s start time with the
converter starting time. The converter starting
time is an arbitrary number that is necessary for
Performer to calculate frame numbers from the
MIDI clock signals it receives. The sequence
starting time, set with the Start Time button in the
Counter, is the time at which the sequence will
actually begin playing.

SLAVING TO SMPTE WITH MTC, DTL, OR
DTLE
Use this mode when you are slaving Performer to
SMPTE time code via a converter that supports
one of these formats. The SMPTE time code is fed
from a master source such as a audio tape recorder,
video tape recorder, or SMPTE generator into a
SMPTE-to-MIDI converter such as a MIDI Time
Piece II, which translates the SMPTE into MIDI
timing information. This MIDI timing
information can be produced in one three popular
formats: Direct time lock (DTL), Direct time lock
enhanced (DTLe), and MIDI time code (MTC).
There are only slight differences between these 
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three MIDI timing formats. For the most part, they
produce identical results. The differences are
discussed later in this chapter.

MTC/DTL/DTLe sync mode is the simplest and
most direct way to slave Performer to an external
source generating SMPTE time code. Performer is
able to lock to the frame times of the master,
insuring precise synchronization between devices.
To use this mode, you must have a SMPTE to MIDI
converter that supports at least one of these three
sync formats, such as a MIDI Time Piece or MIDI
Express SMPTE/MIDI interfaces from Mark of the
Unicorn.

There are no special options to select in the Receive
Sync dialog box: when in MTC/DTL/DTLe mode,
Performer simply responds to timing data directly.

Once Performer is locked to the master, there is no
need to use Performer’s main transport controls
unless you wish to record. Performer will start,
stop and locate under control of the master. Also
upon lockup, if Click is enabled, Performer will
click in the meter specified at 1| 11000 or will default
to 4/4.

You can put Performer into play or record either
before or after you start rolling tape. In either case,
Performer will lock up quickly.

To put Performer into MTC/DTL/DTLe lock up:

1 Choose Receive Sync from the Basics menu.

A dialog box will appear.

2 Specify the port to receive sync information.

3 Choose the MTC/DTL/DTLe option as the
“Type of sync” by clicking its button.

Type of :

MTC,DTL,crDTLe
'.O Indirect lock
O Standard beat clockr
O Tap tempo

SMPTE Frame Format:
O 24 fps O 23.97 fps
O 2S fpc ® JOfps

LI Dr«p triffit

4 Set the SMPTE frame format.

All standard SMPTE frame rates are provided,
including 29.97 Drop and 29.97 non-drop. The
Drop frame check box is available only when the
29.97 frame rate option is selected.

5 Click OK to confirm the Receive Sync settings.

6 Set the sequence starting frame.

Click the Start Time button in the Main Counter.

7 Select Slave to External Sync from the Basics
menu.

This puts Performer into slave mode, waiting for
sync information from an external device.

8 Click on the Play or Record button in the main
transport controls.

The Play button will begin to blink (or turn gray on
black and white monitors), meaning that
Performer is waiting for sync information to start.

9 To start Performer, start the external device.

When Performer is locked and playing, the Play
button will turn to solid black. Once locked,
Performer will follow, start, stop and rewind under
control of the master. Also upon lockup, if Click is
enabled, Performer will click in the meter specified
at 1111000 or will default to 4/4.
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10 To terminate the lock up with the master, click
on the Stop button.

Clicking on the Stop button will both stop
Performer and remove it from the master’s control.
This can be done at any time. To return to normal
operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

COMPARING MTC AND DTLE
Like Direct Time Lock enhanced, MIDI Time Code
is a simple and direct way to slave Performer to an
external source reading SMPTE time code. In fact,
the only difference between MIDI Time Code and
Direct Time Lock enhanced is that MIDI Time
Code uses two bytes for each quarter-frame message,
where DTLe uses only one. Performer supports
MIDI Time Code because it was added to the MIDI
specification. However, Performer, along with
most SMPTE-to-MIDI converters, provides Direct
Time Lock as a more efficient alternative.

Which mode should you use? We recommend
Direct Time Lock enhanced because of its higher
efficiency. If your converter does not support
Direct Time Lock enhanced, then you will need to
use MIDI Time Code.

The procedure for using MIDI Time Code is
exactly the same as the procedure for Direct Time
Lock enhanced. See the previous section in this
chapter for detailed information.

COMPARING DTL AND DTLE
Direct time lock (DTL), when it was first
introduced, had only one frame-advance message
per SMPTE frame. A year or so later, Direct time
lock enhanced (DTLe) was developed. It consists
of four quarter-frame advance messages per frame,
as well as a full-frame message once per second;
these enhancements produce the highest degree of
SMPTE sync accuracy currently available with
MIDI.

MTC and DTLe both have a higher timing
resolution than DTL. If your converter supports
DTL instead of DTLe, you may want to use MTC
instead in order to take advantage of its timing
higher resolution.

TAP TEMPO
Tap Tempo is Performer’s real-time tempo control
feature. Tap Tempo lets you slave Performer to a tap
entered from any MIDI controller before, during,
or after the recording of your sequence. You can
‘conduct’ an existing sequence by tapping the
tempo, complete with accelerandos, ritards, and
rubato passages; Performer will follow precisely.
More importantly, you can record your tap into the
Conductor Track for use in subsequent playback
and recording.

Tap Tempo can be used during virtually any stage
in the creation of a sequence. For example, if you
have acoustic music on tape, two completed tracks
in Performer, and three more Performer tracks to
record, you can ‘teach’ the two existing tracks to
follow the prerecorded music. Your remaining
tracks will be recorded into a sequence that has all
of the temporal nuances of the prerecorded music.

Using Tap Tempo Mode

The following are general points to consider when
preparing to use Tap Tempo sync.

Establish a meter. When slaving to Tap Tempo,
Performer must know how many of your taps to
group as one measure. Before recording or playing
back a passage in Tap Tempo mode, make sure
you’ve entered the correct meter(s) using the
Change Meter command in the Change menu.

Establish a metronome click value. Your taps
correspond to the current metronome click value,
specified using the Change Meter command from
the Change menu. For example, the tempo of a 4/4
passage can be tapped and expressed in whole
notes, one tap per measure, or in sixteenth notes, 
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sixteen taps per measure. Each tap becomes a
tempo change event, so the smaller the click value,
the higher the resolution of the resulting tempo
map. However, tempo events in very small
increments will fill up your Conductor Track —
and your supply of RAM — fairly quickly. Choose
a click value that will give your tempo map high
enough resolution but not generate too much data
to be recorded at one time.

Choose a tap source. You can use any standard
MIDI event as your tap source. Performer will
interpret this MIDI event as a tap whenever it
occurs on the specified input channel. If you plan
to record music while slaved to Tap Tempo, choose
a combination of MIDI event and channel that
won’t be needed in the musical passage. For
example, let’s say you’re tapping C3 on a controller
keyboard, transmitting on Modem channel 1. The
result? Any other C3’s transmitted on the same
channel will not be recorded. Again, this is only
true for C3’s transmitted on Modem channel 1.
C3’s transmitted on other channels will be
recorded normally.

Note that although pitch bend and controller
events are acceptable as tap sources, the most
common controls for sending them (wheels,
joysticks) make reproduction of a single, specific
value difficult. For example, to define your tap you
enter a pitch bend value of 392 using a pitch bend
wheel. To slave Performer, you’ll need to generate
values of 392 or higher — you send a 392 value by
going precisely to it, but also by going past it. That
much is easy, but remember that Performer will
treat only the events with 392 values as taps. All
other values sent by your mod wheel will be
recorded and interpreted as normal pitch bend
events. This makes bend and controller events less
practical tap choices than events with precise
triggers or more limited values, such as a note or a
Controller #64 (sustain pedal) event.

To use Tap Tempo:

1 Ensure that you’ve established the correct
meter(s) and metronome click value(s) for the
sequence.

Use the Change Meter command in the Change
menu. See chapter 28, “Change Meter” (page 331)
for more information on establishing meters.

2 Choose Receive Sync from the Basics menu.

The Receive Sync dialog box appears.

3 Select the port that will receive the tap.

4 Click on the radio button next to “Tap Tempo”.

The right side of the box displays the Tap Tempo
parameters MIDI beat input data and Sync countoff
beats.

Type of sync:

Kg fO MTC,DTL.or DTLf
kO indirect time kck
O Standard beat clocks
(f) Tap tempo

MOI beat tfiputdata.

Source: OlV r-[

Event: |*C3 a

Syne countoffbeats |4 |

Sync recorded tempo to:
® Internal clock
O External time code

□ Caclure start tune

5 Choose the MIDI device you will be tapping
from in the pop-up menu provided.

6 Specify the MIDI event you wish to use as a tap.

Tab to the Event box or click in it, then enter a
MIDI event from any MIDI controller connected
to the specified port (play a note, tap a sustain
pedal, etc.). The event appears, highlighted; click
on the highlighted event if you wish to change it.
You can use any standard MIDI event as a tap
source.

7 Specify the number of times you wish to tap as a
countoff.
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The default number of sync countoffbeats is four,
but the countoff can be any number between 1 and
127. If you enter a number outside this range, the
Macintosh will beep (or the menu bar will flash)
when you click the OK button and the number will
be highlighted. If this happens, click on the
highlighted value and enter a new one.

8 Click OK to confirm your choices or Cancel to
cancel them.

9 Choose Slave to External Sync from the Basics
menu.

This puts Performer in slave mode; it is now
waiting for sync information from an external
source.

10 If you wish to record the tap into your sequence,
record-enable the Conductor Track.

Activate the Tracks window by clicking once on it,
then click on the Conductor Track’s Record-Enable
button. Your tap will be stored as tempo change
events in the Conductor Track and used in
subsequent playback and recording. Existing
tempo changes will be replaced. Other Conductor
Track information will be unaffected.

11 If you wish to record music into your sequence,
record-enable the desired track(s).

If you wish to record the tapped tempo and music
simultaneously, or record music onto more than
one track, choose Multi-Record from the Tracks
window mini-menu. Specify the record device for
each track that is record-enabled. The Conductor
Track will record from the device specified in the
Receive Sync dialog box.

12 Press the Play or Record button in the main
transport controls.

The Play button will flash, meaning that Performer
is waiting to receive sync information. Overdub
mode will not function on the Conductor Track;
that is, recording in either normal or overdub
mode will erase any existing tempo events.

13 If you will be tapping along with a prerecorded
passage, start playback of the recording.

Ideally, the prerecorded music will have a sufficient
countoff so that you can tap the number of countoff
beats specified in the Receive Sync dialog box.

14 Begin ‘tapping’ the MIDI event that you
designated in the Receive Sync dialog box.

Performer will listen for the specified number of
countoffbeats to predetermine the tempo for the
beginning of playback or recording. When
Performer has received the countoff, playback or
recording will begin.

15 Tap the desired tempo and tempo changes.

Make your tap as expressive and dynamic as you
wish; Performer will follow. The Counter display
will update as you tap.

16 To end recording or playback, press the Stop
button in the main transport controls.

Don’t be alarmed if the Macintosh wristwatch icon
remains onscreen for an extended period of time
after you stop recording. Performer is calculating
precise tempo changes from the taps you just
recorded.

17 Take Performer out of slave mode by choosing
Slave to External Sync from the Basics menu.

18 If you recorded your tap, you can hear the
results by rewinding the sequence, making sure the
metronome under Conductor Track tempo
control, and pressing Play.

______________ _______ ____________________  I 395
| RECEIVE SYNC



Your sequence will play back using the tempo(s)
that you tapped. If you are not satisfied with the
results, you can use the Undo Record command in
the Edit menu and then repeat the above process.
You can make adjustments by rerecording certain
sections and by editing individual tempo changes
in one of the Conductor Track’s Event Editing
windows.

Tapping to Prerecorded Music on Tape

You can use Tap Tempo to record a tempo map
while Performer is slaved to tape—or, more
accurately, referenced to external time code. You
can record a tempo map that matches the music on
tape, allowing you to perfectly synchronize your
sequence to the prerecorded music. This process is
explained in detail in the chapter called Tap Tempo
While Slaved to Tape.

Hints for Using Tap Tempo
Recording music simultaneously. If you plan to
record music simultaneously with your tap, choose
a tap event that doesn’t require use of your hands.
Controller #64, sustain, is usually triggered by a
foot pedal and is a good choice for a tap because it
has only two values: On or Off.

Further, Performer will let you use either value for
your tap.

Using alternative tap values and sources. You can set
the tap as an Off value for a particular note or
controller:

1 In the Receive Sync dialog box with Tap Tempo
chosen, Tab to the Event box.

2 Depress the note or controller, leaving it
depressed.

For example, push a modulation wheel away from
its ‘zero’ location. The controller number and its
value will appear in the box, highlighted.

3 Without releasing the note or pedal, click on the
highlighted Event value.

4 Release the note or pedal.

To continue the example, let the mod wheel spring
back to its zero location. The Event box will show
Off or 0 as the tap value.

So far, our examples of using Tap Tempo have
involved tapping a MIDI instrument to ‘teach’
Performer the temporal details of a sequence.
When you tap, you simply send a MIDI event and
Performer does the rest. This means you can use
any MIDI sequencer to load its own tempo map
into Performer — just program the sequencer to
play a song’s worth of quarter notes while
Performer is slaved to Tap Tempo sync.

Yet another way of sending Performer a tap is to use
a device that converts an audio click into a MIDI
event. A click or other regular, amplified signal (a
click track on tape, a miked rim shot, etc.) can be
fed into such a device and converted into MIDI
events from which Performer can generate a tempo
map.

Punching In a tempo. Auto-Record can be used
with Tap Tempo to ‘punch in’ tempo changes for a
section while preserving the tempi outside that
section. Enter the punch In and Out times in the
Auto-Record bar, found in the Consolidated
Controls panel, click on the Auto-Record button,
then follow the applicable steps above. (Don’t be
alarmed if both the Play and Record buttons go
grey at first; the Play button is waiting for sync
information, and the Record button is waiting for
the Counter to reach the punch In location.)

Remember also that slaving Performer to Tap
Tempo disables the sequence’s existing tempo map.
So when you start playback in Auto-Record mode,
even though Performer will only record taps from
the In location to just before the Out location, you 
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will have to tap throughout the pass. Give yourself
the most accurate temporal ‘context’ — the tempi
before and after the punch-in passage — as is
possible, so that the recorded section will fit
smoothly into the rest of the sequence. As always,
you can fine-tune all tempo change events in the
Conductor Track.

RECORD WHILE STILL-FRAMED
The Receive Sync dialog box has an option called
Record while still-framed. Without this option
checked, Performer drops out of record as soon as
you stop the tape after a record pass while slaved to
tape; Performer will not record again until you
press the Record button. This prevents
unintentional recording while cueing and
accidental loss of Undo Record. When this option
is checked, Performer stays in record when you
stop the tape so that you can record a hit while
parked on a frame. This is particularly useful when
frame-advancing using VITC and the Video Time
Piece, which provides accurate frame-advancing.
Unless you are recording while frame-advancing,
we recommend that you leave this option
unchecked.

MULTI-TRACK AUDIO RECORDING
Let’s look at an example which illustrates a number
of techniques you may find useful in the recording
studio.

You are recording a five minute song in the studio.
You’ve preproduced the drum and synthesizer
track with Performer. Now you want to record
guitar and vocal tracks using live players. You plan
to use a synchronization code conversion box (a
converter) to translate audio synchronization code
recorded on tape into MIDI timing data. Let’s start
by assuming you are using a SMPTE/MIDI
converter, then discuss what you will have to do
differently if you are using an FSK conversion box.

I RECEIVE SYNC

Synchronizing with SMPTE

The first thing you should do when you get to the
studio is to “stripe” (i.e. record) one track of your
multi-track tape with an audio sync signal. For this
example, let’s assume you are using SMPTE time
code. Start striping the tape at time 0:59:00:00. We
recommend that you use 30 frames per second, non­
drop-frame code, unless you have a specific reason
to use one of the other frame rates. Continue for at
least 7 minutes; you should always have at least a
minute of time code on the tape prior to the start of
your song, and you should record plenty of extra
time code at the end in case you decide to lengthen
the song at some point. Many people stripe the
whole reel straight out of the box with one
continuous time code track. Striping may take
some time; get it started first thing upon arriving at
the studio, so that it will be finished by the time you
get everything else set up for recording.

Now, set up Performer to play in sync with the
multi-track. Feed the time code from the tape into
your SMPTE to MIDI converter. Connect the
converter to the Macintosh; some converters
connect directly, others have a MIDI Out which
must go to the MIDI In of an interface connected to
the Macintosh. If you have a MIDI Time Piece (II)
or MIDI Express, no additional connections are
necessary beyond the normal one to the modem
(or printer) port.

If your converter supports Direct time lock, Direct
time lock enhanced, or MIDI Time Code, set the
appropriate mode on the converter (to lock to
SMPTE). Select Receive Sync... from the Basics
menu. Choose the correct port (Sync to port:) and
MTC, DTL, or DTLe (Type of sync:). OK the dialog
box.

Otherwise, you should use Indirect time lock. Set
the converter to generate a constant tempo of 60
beats per minute, and have it start at 0:59:00:00.
Select Receive Sync... from the Basics menu.
Choose the correct port (Sync to port:) and Indirect
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time lock (Type of sync:). For Converter start frame:
enter 0:59:00:00 (the same time that you set the
converter to). You won’t need to check either of the
other options unless your converter is non­
standard.

Let’s start the song at time 1:00:00:00 on the tape
(this is a minute after the start of the time code).
Click the Start Time button in the Counter. Enter
1 -.00:00:00 + 0 time code bits for the frame time. Set
the other values as you wish. OK the dialog box.

Set the frame rate correctly in Performer in the
Receive Sync dialog box. Choose the correct frame
rate; use 30 frames per second unless you have a
specific reason to use another format.

Check the Slave to External Sync entry in the Basics
menu. Press the play button in the motion controls;
it will begin to flash (or turn gray on black and
white monitors). At this point, Performer should
be slaved to the tape. Display frame time in the
counter window, and roll the tape from before the
time code. Make sure Performer starts, stops, and
follows the tape when you wind through the tape.

For overdubbing, you need to provide your players
with a reference mix of the song. You can have
Performer sync live to the tape and send the players
a cue mix. Or, you might find it easier to just place
a scratch mix on one or two of the tracks of the
multi-track. That way, you won’t have to worry
about Performer while recording. If your session is
spread out over several dates, putting a scratch mix
on the tape will save you having to set up your
computer and synthesizers every time.

When you get to the final mix, you have two
choices. You can mix from Performer playing
slaved to the tape. This provides the ultimate in
sound quality, as the synthesizers are first recorded
on the master tape. On the other hand, you may
wish to record each synthesizer part on a separate
track of the multi-track. This has several benefits.

Since the tracks are recorded one at a time, each
track can use all of your synths to create a sound.
Blending several synthesizers together often
creates a more full-bodied sound. Also, if you have
limited outboard effects gear, you can record each
track with effects, allowing you to reuse what
equipment you have.

When recording a single part to tape, we
recommend you turn off the play-enable buttons in
the tracks window for all tracks except the one you
are recording. When you do this, Performer
completely ignores the other tracks, letting it
concentrate all of the computer’s processing power
on playing one part. If you use the Solo button
instead, Performer will scan the other parts while
playing. If you have dense, complicated music, or
lots of continuous data, this may cause the
Macintosh to become bogged down during
playback.

When recording each part separately, you can slide
individual parts slightly ahead or behind to
compensate for delays in your synthesizers, or the
specific sounds. For example, string parts often
need to be attacked ahead of the beat in order to
sound on the beat.

With sampling synthesizers, you may find that
some sounds have as much as 100 milliseconds of
“dead air” at the beginning of the sample, which
results in that much delay between turning the note
on and hearing any sound.

To slide a part, just adjust the start time relative to
the start time the other parts were recorded with.
For example, if you did have a sample with 100
milliseconds of dead air at the start, you could set
the start time to 0:59:59:27 + 0 time code bits.
That’s 3 frames ahead of the other parts, and at 30
frames per second, 3 frames is l/10th of a second,
or 100 milliseconds. Your sample’s audible attack
times will now be aligned with those of the other
parts.

398 [
RECEIVE SYNC



It’s best to slide parts by ear — just keep trying
different start times until the part seems most lined
up.

Synchronizing with FSK
If you are using an FSK converter in the above
example, you can proceed in a very similar fashion.

When striping the tape, you must usually feed the
converter with MIDI beat clock information. This
information is recorded more or less directly onto
the tape. When the tape is played back through the
converter, you should receive exactly the same
MIDI beat clock information.

When synchronizing to an FSK converter,
Performer follows the tempo recorded onto the
tape; Performer’s internal tempo map is disabled.

The FSK converter usually sends out a carrier tone
when it is not receiving MIDI beat clock
information. You should record a minute or so of
this carrier tone prior to starting Performer.

When synchronizing to tape, you must use the
Standard beat clocks mode to receive synchroni­
zation. Remember that the tempo is already
recorded on the tape.

When using FSK, you must always begin playing
the tape from the beginning; FSK code does not
encode any position information on the tape.

HINTS
When locking to external SMPTE synchroni­
zation, you can shift parts forward and backward
in time to compensate for the numerous time
delays in a complex system (each device used in a
MIDI path introduces at least 2 milliseconds of
delay) or to adjust for envelope delays in certain
synthesizer patches (such as strings or any other
slow-attack patch).

When recording in external sync, the Record
button is turned off every time the master device
stops or rewinds. This is a safety precaution, to
prevent accidental erasure of previously recorded
data. To record in external sync, start the master
device, wait for Performer to lock up, and then
press the record button.

Many new digital effects devices, like reverbs,
delays, equalizers, and even mixers, allow MIDI
control. By using Performer with a time code
converter to sync to your multi-track tape recorder,
you can automate effects changes and other aspects
of mixing accurately and flexibly. Read cue points
from Performer’s counter, or use the Record Hits
feature in the Markers window to find locations to
insert patch changes and controller information to
control your MIDI devices. Alternatively, use the
sliders, switches and pedals of your controller
keyboard or MIDI mixer to record your mix in real
time, then use Performer’s editing features to
correct any problems.

Setting a Countoff Before Sequence Start
While Slaved to Tape

If you are working in a studio situation where you
need a countoff before the beginning of the
sequence while slaved to tape, here is how you can
set up the Performer’s countoff feature:

1 Choose a Click Option in the Click & Countoff
Options dialog box that will enable the click during
Performer’s countoff.

For example, choose the Always Click option or the
Only during countoff option.

2 Set the number of measures you would like for
the Countoff.

Do so by double-clicking the Countoff button and
typing in the number of measures.

3 Make sure that the Click is enabled.
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The Click item on the Basics menu must be
checked.

If you now rewind well before the sequence start
time and roll the tape, Performer, as it counts
down, will begin the countoff at the appropriate
number of measures before the downbeat of the
first measure.

Syncing to SMPTE with the Studio 5™

In general, we recommend using Direct Time Lock
Enhanced (DTLe) to lock Performer to SMPTE
time code. If you are using an Opcode Studio 5,
however, use MIDI Time Code (MTC) instead. Just
set up the Studio 5 to generate MTC instead of
DTLe. In Performer, no change is needed because
Performer uses the same settings for either type of
time code. For other hardware interfaces, including
the Opcode Studio 4, we recommend using Direct
Time Lock Enhanced.
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chapter 40 Tap Tempo While Slaved To Tape

TAPPING TO PRERECORDED MUSIC ON
TAPE
You can use Tap Tempo to record a tempo map
while Performer is slaved to tape—or, more
accurately, referenced to external time code. You
can record a tempo map that matches the music on
tape, allowing you to synchronize your sequence to
the prerecorded music.

This process can be performed in a more precise
fashion if you have an audio click track recorded on
the tape and a click-to-MIDI converter such as
Mark of the Unicorn’s Video Time Piece™. For
more information, please refer to the chapter called
Performer and the Video Time Piece.

The following are general points to consider before
tapping tempo to prerecorded music:

Before you begin, establish SMPTE synchronization
to tape. This is necessary for two reasons: 1)
Performer needs to receive a timing reference from
the tape while creating the tap tempo map, and 2)
later on, after you successfully record the tempo
map, you will be using the SMPTE to lock the
sequence to the tape. To establish SMPTE synchro­
nization, simply sync Performer to the tape in the
fashion that you normally do with Direct Time
Lock (DTL), Direct Time Lock Enhanced (DTLe)
or MIDI Time Code (MTC). If you have never
synchronized Performer to SMPTE, now is a good
time review the Receive Sync chapter. (Please note
that you must synchronize to tape via MIDI Time
Code or Enhanced Direct Time Lock.)

Once you have set up SMPTE sync, set up Tap
Tempo. To do so, simply follow the directions in the
Receive Sync chapter called Setting Up Tap Tempo.
Test it to be sure that when you tap, Performer does 

indeed follow your taps. This will ensure that you
have the proper channel and event for Tap Tempo
mode. Remember, you may also need to set up a
meter map in the sequence that matches the meter
map of the music on tape.

If possible, set up two full measures of countojf on the
tape before the first downbeat of music. This will be
extremely helpful to your accuracy when tapping
the first downbeat, which is the most important
downbeat because all subsequent taps—the entire
tempo map—will be referenced to its exact
location.

TAPPING TEMPO WHILE REFERENCED TO
TAPE
Once you have made these preparations, you are
ready to begin. To Tap Tempo to prerecorded music
on tape:

1 Open the Receive Sync dialog box from the
Basics menu.

Sync to port Modem

Type of sync;

g-gl'O MTC, DTL.tr DTLe
lO Indirect time lock
O Standard beat clocks
<t> Tap tempo

SMPTE Frame Format.
O 24 fps O 29 97 tys
O 25 fps ® JO fps

□ Drop frame

□ Jambox
□ Record vhile still-framed

MOI beat input data

Source: otv^~|

Ew.nl. i I

Sync countoffbeats [4 |

Sync recorded tempo to.
® Internal dock
O External time code

□ Capture start time

2 Set the Sync to port option to the port that will
be receiving the SMPTE sync data from tape.
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For example, if your SMPTE-to-MIDI converter is
sending Enhanced Direct Time Lock to the modem
port, select the modem port. (If the converter does
not send Direct Time Lock or Direct Time Lock
enhanced, use MIDI Time Code instead.)

3 Select the Tap Tempo option.

The tap event can be received from any controller
device on either serial port.

4 Type in a number of countoff beats.

Be sure that the number of countoffbeats you
choose here corresponds in a useful way to the
number of countoffbeats on tape. For example,
ideally, you should have 2 measures of countoff on
tape; if so, set the countoffbeats here to 1 measure.
When you roll the tape, you can get ready during
the first bar of countoff, tap along for the second
bar, and hit the downbeat right on the money. If
you don’t have an countoff on the tape, you will
have to develop a system that works best for you.
You might try just one countoffbeat.

5 Enter the beat input data.

6 Select the External time code option.

Performer will now reference your taps to
incoming DTL, DTLe, or MTC.

7 Select the Capture start time option.

This option makes Performer remember the exact
SMPTE frame of your first tap (excluding the
countoffbeats) so the sequence will start at the
correct SMPTE time.

8 Click OK to confirm your choices and close the
dialog box.

9 Record-enable the Conductor Track.

10 Choose Slave to External Sync (Basics menu).

402 |________________________________________________

11 Press the Record button.

12 Get ready to tap, and roll the tape.

13 Listen for the countoff, and ‘tap’ along with it
such that the first downbeat of the sequence
corresponds to the first downbeat of music on tape.

Performer automatically remembers the exact
SMPTE time of your tap on the first downbeat of
the sequence and saves it as the Chunk start time.
When you later slave the sequence to tape,
Performer will automatically start the sequence at
the correct SMPTE time.

14 Tap along with the music as accurately as
possible.

Remember that synchronization later on will only
be as accurate as the accuracy with which you tap
in this procedure.

15 To end recording, press the Stop button in the
main transport controls.

Don’t be alarmed if the Macintosh wristwatch icon
remains onscreen for an extended period of time
after you stop recording. Performer is calculating
precise tempo changes from the taps you just
recorded.

LISTENING TO WHAT YOU HAVE DONE
Now that you have recorded the tempo map, try
slaving Performer to the tape using your usual
method of synchronization, such as Direct Time
Lock or MIDI Time Code, in the Receive Sync
dialog box. Also, make sure that the Metronome is
under Conductor track tempo control. You will
now be able to playback, rewind, or fast forward
anywhere in the song on tape, and your Performer
sequence will exactly reproduce your tapping
performance with respect to the music on tape. If
you tapped accurately, Performer will play along
accurately. If you goofed, so will Performer. You can
always try again.

TAP TEMPO WHILE SLAVED TO TAPE



chapter 4i Record Beats

The Record Beats command, found in the Change
menu, allows you to record music without listening
to a metronome click and then afterwards realign
Performer’s internal beats and barlines with the
music you recorded.

Here’s a simple example. The Graphic Editing
window below is the tune Mary Had a Little Lamb
recorded without Performer’s metronome click:

Figure 41-1: Mary Had a Little Lamb recorded in the Graphic Editing
window without using the metronome click. Notice that the first note
is not on beat 1 and that none of the downbeats in the music match
the downbeats in the measure ruler above.

Notice that the music does not line up with the
beats and barlines in the measure|beat|tick ruler.
This prevents many useful editing tasks, such as
quantizing and easy region selection.

After using the Record Beats command,
Performer’s beats and barlines have been realigned
to match the beats in Mary Had a Little Lamb:

Figure41-2:Mary Had a Little Lamb after using the Record Beats
command. Notice that the beats and barlines In the time ruler now
match the downbeats in the music. Also note that the music plays
back exactly the same way as the original recording (as long as the
Tempo Control in the Metronome is set to the Conductor track).

It is important to note that Performer’s beats have
been realigned to the music, not the other way
around. The music plays back in the same fashion
as the original recording. When using Record
Beats, you are in no jeopardy of losing the original
feel of your performance. Performer accomplishes
this by creating a tempo map at the same time as
realigning the beats. Thus, Performer’s beats speed
up and slow down to match the original
performance.

Once beats and barlines have been realigned, many
useful editing commands can be employed that
were not possible beforehand. For example, the
above tune can now be successfully quantized for
rhythmic accuracy and transcription:

Figure41-3:After using Record Beats, music can be quantized,
groove quantized, and edited.

Using Record Beats

To use Record Beats:

1 Record music into a track.

You can play as freely as you like. Pay no attention
to Performer’s
Counter window. You can even turn off the
Metronome click.

2 Open the Event List window and make note of
the time of the first event.

In the Mary Had a Little Lamb example above, the
first note occurred at 1|2| 115:
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3 Set the Main Counter to the same time as the
first event.

In this example, we enter 112| 115 into the main
Counter.

4 Choose Record Beats from the Change menu.

The Record Beats dialog box will appear.

® OK Is first best
O Tap first beat

measure b?ot
S Shift data to: H I |1 |

When you press the "OK" button,
playback will begin automatically.
During playback you must set beats
in the sequence by playing notes on
your MIDI Input device Vhen you
stop playback. Performer vill
adjust timing in the sequence and
then return to normal operation.

5 Use the OK is first beat option.

This option means that Performer will place the
first downbeat right at the current counter location,
which is 1121115, the location of the first note in this
example.

6 Check the Shift data to option and type in the
measure and beat at which you want to place the
first downbeat.

For example, if the first note of music should be at
measure 1, beat 4, as a pickup note, type in
measure 1, beat 4. Be sure that the location you
choose here is NOT before the sequence start.

7 Prepare to tap any note on your MIDI
controller.
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Get ready to tap along with the music you played.

8 When you are ready, click OK and begin tapping
on the second beat.

With the OK is first beat option, Performer begins
playback and taps the first beat for you at the
starting location of the Counter. In this example,
Performer places the first tap at 1121115. You should
then begin tapping on the second beat. If you miss
the second beat, stop, Undo, and try again.

9 Keep tapping along with the beats in your music
as accurately as you can.

10 When you reach the end of the piece, click Stop.

Performer may take moment to realign the beats
and enter the newly generated tempo data in the
Conductor track.

After Performer calculates the changes, the
downbeat of your music will now be at the measure
and beat that you indicated with the Shift data to
option. In addition, the Counter will beat in 4/4
time on the downbeats that you tapped. To change
the meter, refer to the section later in this chapter
called Handling Odd Meters.

Listening to What You Have Done
To listen to the result of your tapping:

1 Choose Conductor track from the tempo control
pop-up menu in the Metronome panel.

Performer will now play back according to the new
tempo map in the Conductor track.

2 Press the Play button.

The music will sound the same, and the
metronome and Counter windows will line up with
the music as accurately as you tapped while
Recording Beats.

RECORD BEATS |



Using a Countoff and theTap First Beat Option

The Tap first beat option in the Record Beats dialog
box allows you to tap the first beat when you
recorded a countoff at the beginning of your
original performance, or a visual cue on film or
video at which to start tapping.

In this case, you have an aural or visual cue before
the first tap that allows you to prepare to hit the first
tap accurately.

To use the Tap first beat option:

1 Set the counter to a position several seconds
before the first tap.

This will give you enough time to prepare for the
first tap. You can have as much preroll time as you
like to get ready for the first beat.

2 Choose Record Beats and select the Tap first
beat option.

3 Click OK to begin Recording Beats.

Performer will begin playing back. Listen carefully
to the countoff or music and get ready for your first
tap. Performer will not begin recording beats until
your first tap.

4 Begin tapping on the downbeat where you
would like to begin realigning beats.

5 If you are punching out, click Stop immediately
after your last tap.

This prevents music after the punch-out time from
being realigned inadvertently. Performer may take
a moment to realign the beats.

Handling Odd Meters

The Record Beats command realigns your original
Performer into a default meter of 4/4 time.
However, if you would like the music to be 
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expressed in an odd meter or in changing meters,
you can do so by using the Change Meter
command after using Record Beats.

For example, let’s say that you would like to bar
your music in 6/8 time. After using Record Beats, it
will be in 4/4 time. To convert it to 6/8, open the
Change Meter dialog box, type in 6/8 as the meter,
set the beat value to a dotted quarter note, choose
the measure range you wish to convert to 6/8, select
the Only move barlines option, and click OK. This
will re-bar the music in 6/8 time without changing
the playback of the music. For more information,
please refer to the Change Meter chapter.

Handling Pick Up Beats with the Shift Data To
Option
The Shift data to option allows you to determine
the placement of the first downbeat of the re­
recorded beats. The most important thing to
remember is this: do not choose a beat that occurs
before the Chunk Start Time. For example, let’s say
that your music has two pickup beats and that you
would like the following downbeat to occur at
1111000. Before you use Record Beats, create a
pickup measure from 0| 11000 to 1111000 to
accommodate the two pickup beats at 0|31000 and
0|4|000.

To create a pickup measure:

1 Click the Start Time button in the main counter
to open the Set Chunk Start dialog box.

2 Set the Measure Start Time to 0.
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If you need two measures of pickup, set the
Measure start time to -1.

3 Click OK.

Now, when you press Rewind back to the
beginning of the sequence, the Counter window
will read 0| 11000.

Once you have set up measure 0, you can set the
Shift data to option in the Record Beats dialog box
to measure 0, beat 3 to accommodate the two
pickup beats in your music, and the first downbeat
will occur at l|l|000.

® OK ts first beat
O Tap first beat

measure beat
H SMfl io: |O I |3 I

Recording Beats While Slaved To Tape

Record Beats may also be used while Performer is
slaved SMPTE time code via Direct Time Lock or
MIDI Time Code. This allows you to freely record
music while slaving Performer to film or video
without being concerned with Performer’s
metronome. After recording, you can then line up
the beats and barlines afterwards with Record
Beats.

Here are a several important preparations you will
need to make to Record Beats while slaved to tape:

■ Establish lockup to tape using Direct Time Lock or
MIDI Time Code and a SMPTE-to-MIDI converter
such as Mark of the Unicorn’s MIDI Time Piece™
or Video Time Piece™. For more information,
consult the chapters called Receive Sync, Performer
and MIDI Time Piece, and Performer and Video
Time Piece.

□ Either before or after you record your music, make
sure the first downbeat of the music occurs at the very
beginning of the sequence and set the SMPTE Chunk
Start Time at so the music starts at the desired
SMPTEframe. You can either record the music this
way, or shift the music after recording. This makes
it easy to play the first beat accurately when you
Record Beats.

□ Set up a countoff before the sequence start using
Performer’s click so that you can easily record the first
downbeat. To do so, enable Performer’s click and
select Only during Countoff in the Click & Countoff
Options dialog box. To set the number of measures
for the countoff, double-click the Countoff button
in the Consolidated Controls panel.

Once you have made the above preparations, you
are ready to record beats while slaved to tape:

1 Set Performer in Slave to external sync mode.

2 Rewind the tape to several seconds before the
Chunk start time.

3 Choose Record Beats from the Change menu.

The Record Beats dialog box will appear.

4 Select the Tap first beat option, but don’t click
OK yet.

This option means that you will tap the first
downbeat (in addition to all subsequent beats).
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5 While the Record Beats dialog box is still open,
get ready to tap any note on your MIDI controller.

6 When you are ready, roll tape and immediately
click OK.

Right after the Record Beats dialog box disappears,
Performer’s play button should turn black,
indicating that it is slaved to tape. The Counter will
be counting down negative measures before the
sequence start time.

7 Listen for Performer’s countoff and begin
tapping on the first downbeat of the sequence.

8 Keep tapping along with the beats in your music
as accurately as you can.

9 When you reach the end of the piece, click
Performer’s Stop button.

Performer may take moment to realign the beats
and enter the newly generated tempo data in the
Conductor track.

Before you listen to the results, be sure that Tempo
control in the Metronome is set to the Conductor
track so that the sequence will play back with the
tempo changes generated by the Record Beats
command.
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chapter 42 MIDI Machine Control

MIDI Machine Control (MMC) is a recent and
significant addition to the original MIDI specifi­
cation. MMC consists of an extensive set of system
exclusive commands that allow multiple recording
devices to be remotely controlled from a single
source. MMC expands Performer’s ability to serve
as “a recording studio at your fingertips” by
allowing you to control the transport and
recording functions of your recording hardware
entirely from within Performer.

This chapter explains how to use Performer with
hardware devices that support the MIDI Machine
Control (MMC) specification, such as:

■ The Alesis ADAT™ digital multitrack recorder
(with the BRC or other MMC interface)

■ The Akai DR4d™ digital hard disk recording
system (with the additional card necessary for
MMC)

■ Any other MMC-compatible device

Performer serves as a computer-based front end for
MMC devices, causing them to play, stop, rewind,
and otherwise follow Performer’s transport control
functions. In addition, you can record-enable
tracks on a MMC device remotely from within
Performer (for MMC devices that support this
capability).

As you begin working with Performer and
your MMC gear, keep the following in mind.
Performer provides features that are supported by 

most MMC devices. However, not all MMC
devices support every feature explained here. In
addition, there can be slight variations in the way
each device handles MMC that cause it to behave
differently than described. Try to familiarize
yourself as much as possible with the features your
device supports via MMC. Also, check for “Read
Me” files in your Performer folder and update note
booklets that accompany your Performer manual;
they may include further information about
specific devices.

SETTING UP MMC HARDWARE
MIDI Machine Control requires two-way MIDI
communication between Performer and the MMC
device. Performer sends control commands (in the
form of system exclusive messages) to the MMC
hardware, and the MMC hardware sends SMPTE
time code back to Performer.

Some MMC devices can generate SMPTE time
code in the form of MIDI Time Code (MTC).
(Some MMC devices support other forms of MIDI
timing information as well, including standard
MIDI beat clocks, Direct Time Lock, and Direct
Time Lock Enhanced.) Other devices generate
SMPTE time code in the form of longitudinal time
code (LTC), an audio signal that must be converted
to MIDI Time Code by way of a SMPTE-to-MIDI
converter such as the MIDI Time Piece IL These
two hardware setups are shown below.
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Serial cable
MIDI Interface

IN

OUT

OUT
MMC Device

IN
MIDI cables

Figure 42-1: If the MMC device can generate MIDI Time Code (MTC), the MIDI
connections shown here are all that are necessary. Be sure the MIDI interface
internally routes the MTC to the Macintosh.

MMC Device
OUT IN

MIDI cable
SMPTE time code OUT

Audio cable

IN

Figure 42-2: If the MMC device generates SMPTE Time Code, connect its time
code output to a SMPTE-to-MIDI converter like the MIDI Time Piece II as shown
here, which converts it to MTC. Route the resulting MTC to the computer.

Serial cable
MIDI Interface

Figure 42-3: Connecting multiple MMC devices for
remote MMCcontrol from Performer.

MMC Master Device

MMC Device

MMC Device
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Connecting multiple MMC devices

If you have more than one piece of MMC gear,
decide which one will be the time code master.
Hook up the master device as shown in either or
(whichever is required by the device), and then
feed the time code from the master device to the
other MMC devices in your setup. Doing so
establishes one time code source, which keeps all
devices (and Performer) in sync with one another.
Connect the remaining devices to your MIDI
interface as shown in Figure 42-3.

Open-loop versus closed-loop systems

The hardware setups shown in Figure 42-1 and
Figure 42-2 support open-loop MMC configura­
tions. Performer does not currently support
closed-loop MMC communication. Closed-loop
communication is not necessary for accurate
synchronization between Performer and MMC
hardware.

SETTING UP PERFORMER
Setting up Performer for MMC is simple. All you
need to do is create a MMC device in your
FreeMIDI setup.

1 Open the FreeMIDI Setup Application.

If you are currently running Performer, click the
FreeMIDI button in the Control Panel, or choose
Edit FreeMIDI Configuration from the Basics
menu. Otherwise, double-click the FreeMIDI
Setup icon in the Macintosh Finder. The FreeMIDI
Setup application launches and your current studio
configuration appears.

2 If the MMC device already exists in your
FreeMIDI configuration, double-click it. If not,
add it using the Create Device command in the
Configuration menu.

The FreeMIDI Device Specification window
appears.
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3 In the Device Specification window, make sure
that “MIDI Machine” Device Property is checked
in the Device Properties pop-up menu as shown
below, as well as the “Receives MTC” and
“Transmits MTC” properties.

If any of these items are not checked, select them to
check them.

Nome:

Receiue Che

Transmit* MT I

Does no! plotj iioIps ,

Manufacturer
| metis

Controller
Receives Clock

✓Receives MTC
Tronsmlts Clock

✓Transmits MTC
✓MIDI Machine

General MIDI
Dank Select Ctrl 0
Bank Select Ctrl 32
Does not accept proq changes

Sampler
Drum Machine
Effects Unit
Miner

Is! I I I

Properties:

FreeMIDI Device Spedficotlon

(0-1261

Tronsmlt Ch

(icons... %l)

( Cancel )

4 Make sure that the Device ID setting correctly
matches the setting in the device itself.

*■ If you used FreeMIDI’s Auto Config feature to
automatically detect the MMC device, the ID
setting is already correct. The device ID setting is
important because if it is not correct, the MMC
device will not respond to Performer.

5 If you are creating the FreeMIDI device for the
first time, set the rest of the device information as
needed.

6 Click OK.

7 Make sure that both the MIDI IN and MIDI
OUT ports of the MMC device are connected to
the MIDI interface.

If not, connect them by dragging a patch cord from
the MIDI interface port to the device icon. For
more information, see “Connecting Devices to
Interfaces” on page 487.
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The presence of a MMC device in the MIDI
configuration activates the MMC features in
Performer.

The MIDI Machine Control window
The area at the top of the window contains several
important MMC-related controls.

ACTIVATING MMC IN PERFORMER
Each MMC device that you have defined in your
FreeMIDI setup appears in Performer’s MIDI
Machine Control window, which can be opened
from the Windows menu.

The MMC master button

The MMC master button
The MMC master button activates all of
Performer’s MMC features. To activate these MMC
features, click the arrow button between the
computer and tape deck icon at the top of the
window. When this button is on, MMC is activated.
In addition, Performer is placed in Slave to
External Sync mode. For more information about
external sync mode, see “Setting Performer’s
Receive Sync options” on page 414.

The Record mode pop-up menu
The Record mode pop-up menu has three modes:
Safe, rehearse, and record.

■ Safe: no recording can occur in any MMC device

■ Rehearse: this mode depends on the MMC
device. Usually, it causes the device to act as if it is
recording, punching in, punching out, etc. but no
recording actually occurs.

>•' Make sure that your deck supports rehearse
mode before attempting to use this record feature.
If it doesn’t, rehearse mode may actually record.

■ Record: allows recording on the currently
record-enabled track(s) for any MMC device. To
actually record, press the record button in
Performer’s main transport controls.

Preroll
When this option is checked, MIDI Machine
Control devices get cued to 5 seconds before the
location you specify with Performer’s transport
functions. Click the preroll value in the box to
change it (1-99 seconds).
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Preroll saves you the trouble of figuring out preroll
time in your head. Preroll lets you cue Performer to
musically intuitive locations or hit points while
giving the hardware and Performer enough time to
fully synchronize by the time they reach the cue
location you chose.

Auto Record Advance
When the Auto Record Advance button is checked,
Performer will automatically record-enable the
next higher track (or set of tracks for stereo
recording) during Memory-cycle recording. As
Performer loops the same section over and over,
each pass is recorded on a new track (or set of
tracks), preserving all previous takes. For example,
when you begin cycle-recording, you could record
a section on track 1. The second time around the
loop, Performer releases track 1 and record­
enables track 2, and the second pass gets recorded
on track 2. The third time around, Performer
record-enables track 3, and the third pass gets
recorded there. Performer will continue to record­
enable the next track until it records on the highest
available track.

“•* Make absolutely sure that the consecutive
tracks in line for recording do not have material on
them that you wish to keep.

When this check box is unchecked, the same track
(or tracks) remain record-enabled until you
change them manually by clicking the record­
enable buttons in the MIDI Machine Control
window.

The Auto Record Advance option requires the
following preparations in Performer:

1. Memory-cycle must be enabled.

2. Auto-Record must be enabled.

3. The Record mode popup in the MIDI Machine
Control window must be set to Record mode. (It
does not advance in Safe or Rehearse mode.)

4. Performer must punch-in at some point before
cycling back to the beginning of the Memory-cycle
loop.

Setting up each MMC device

The MIDI Machine Control window provides a list
of MMC devices in your FreeM IDI Setup. Any
connected device that has the MIDI Machine
device property assigned to it appears in this
window. Several settings are provided for each
device.

Device name and icon
The name and icon of the device comes from its
name in your FreeMIDI studio configuration. You
can change the name using the FreeMIDI Setup
application. To change the icon, see “Editing
FreeMIDI Icons” on page 523.

Bringing a MMC device on line
When the On line button is selected, the device is
on line, which means that it will respond to
Performer’s transport control commands. When a
device is offline, Performer won’t drive the device.

Specifying the number of tracks
The Set number of tracks... mini-menu command
sets the number of tracks that the MMC device has.
Keep in mind that in some situations, a single
device in Performer’s MIDI Machine Control
window actually represents several physical
devices. For example, an Alesis BRC may be
connected to several ADAT’s, each with 8 tracks. In
this example, you’d want to include the tracks for all
of the ADAT’s. Be sure to set the number of tracks
accordingly.
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Setting a time code track
The time code track option in the Set number of
tracks command lets you specify one of the tracks
as a time code track. The time code track becomes
record-protected, and it cannot be record-enabled
by the arrow keys (discussed below) or Auto
Record Advance. You can record-enable the time
code track manually by clicking it, but a warning
appears to confirm that you would like to do so.

Changing the order of the devices in the window
To change the order of the devices in the window,
drag the panels up or down.

Ejecting a tape
The Eject mini-menu command ejects the tape
from the currently selected MIDI Machine Control
device in the list. To select a device, click its name.
The device must be on line and the master MIDI
Machine Control button must be active for this to
work.

Keyboard shortcuts for record-enabling tracks
Option-click a track to record-enable it and at the
same time turn off all other record-enabled tracks.
Command-click a track to turn it off and record­
enable all others.

User the up and down arrow keys to record-enable
the next or previous track. This works with
adjacent pairs as well.

Selecting a MMC device in the MMC window
To select a device, click its name.

Setting Performer's Receive Sync options

While controlling external MMC devices,
Performer actually slaves to time code generated by
the MMC hardware to remain synchronized with
the hardware during playback and recording, as
explained in Figure 42-4.

Performer governs the transport control functions,
and the MMC device serves as the master timing
source to keep them synchronized.

As a result, when you activate MMC control in
Performer, Performer is automatically placed in
Slave to external sync mode, in which Performer
slaves to external time code. To successfully slave
Performer to the time code, make sure that the
settings in Performer’s Receive Sync command in
the Basics menu match the time code being
generated by the MMC master device. For 

During playback and recording,the MMC
devices sends MIDI time code back to Performer
to keep Performer in sync with the hardware.

Figure 42-4: When Performer controls the transport functions of MMC hardware,
Performer simultaneously slaves to time code from the MMC hardware.
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complete information on the Receive Sync dialog
settings, see “Slaving to SMPTE with MTC, DTL,
or DTLe’on page 391.
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Figure42-5:Make sure that Performer's Receive Sync dialog box
settings (Basics menu) match the time code generated by the master
MMC device.

Setting Performer's SMPTE start time (offset)

Because MMC control involves SMPTE synchroni­
zation, be sure to set Performer’s SMPTE start time
(SMPTE offset) to a value that is appropriate for the
time code being generated by the MMC device. To
set the start time, click the start time button in the
main counter, or select Set Chunk Start from the
Chunks window mini-menu. For more
information, see “Setting the start time” on
page 54.

Using Performer's transports to control MMC
devices

Once you activate MMC and set up each device as
described in the previous sections, Performer will
shuttle the transport controls on each on-line
MMC device in sync with Performer’s own
transport controls. For example, when you press
play, stop, and rewind in Performer’s main
transport control panel, each MMC device will do
the same.

All of Performer’s transport control functions are
supported. For example, if you use Memory-cycle
to loop over a region, the MMC device will follow.

Keep in mind, however, that Performer’s transport
functions are virtually instantaneous, whereas
MMC hardware devices are mechanical devices
that take time to cue. As a result, Performer will
stop and wait at times when the MMC device is
cueing to a new location. The longer the cue time,
the longer the wait will be. Once the MMC device
has finished cueing, Performer will resume at the
same time as the MMC device.

Transport features that are supported include: Play,
Stop, Rewind, Pause, Record and Auto-punch in/
out.

Cueing functions include the following:

■ Typing a time into the Main Counter

■ Using Fast-forward and rewind cueing buttons
below the main transports

■ Clicking a marker in the Markers window

■ Double-clicking in any time ruler

■ Memory bar features such as Auto-stop, Auto­
rewind, Memory-cycle

■ Dragging the scrolling wiper

All of these functions behave normally, except for
the waiting period mentioned above.

Recording into Performer while using MMC

Once you have set up MMC in Performer as
described in this chapter, you can record MIDI
data into Performer in the usual fashion (as
described in chapter 8,“Recording”). Record­
enable a MIDI track in Performer’s track list, press
record, and play your controller. All of Performer’s
MIDI recording features work normally, including
Multi-record, Auto punch-in, etc. Since Performer
is slaved to the external MMC device, there may be
an occasional wait during cueing.
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Using Performer to record a track on a MMC
device
To record to a track on a MMC device:

1 Make sure that the device you wish to record on
is on line in the MIDI Machine Control window.

If not, click the Off Line button to bring it on line.

2 Choose either Record or Rehearse from the pop­
up menu in the MIDI Machine Control window.

For details about Rehearse mode, see “The Record
mode pop-up menu” on page 412.

3 Record-enable one or more tracks on the device
by clicking the appropriate track button(s) in the
MIDI Machine Control window.

Note: some devices do not support remote
record-enabling. If so, record-enable the track
directiy on the device.

Until you actually begin recording, the record­
enable button flashes. When you begin recording,
it becomes solid.

4 If you would like to loop a section to record
several passes, click the Memory-cycle button in
the Main Control Panel and set the Start and End
points in the Track Overview.

For information about using Memory-cycle, see
“The Memory-cycle button” on page 42.
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5 If you are going to loop a section with Memory­
cycle as described in the previous step, and you
would like to record each pass on a new track to
preserve each take, check the Auto Record Advance
box in the MIDI Machine Controls window.

For details, see “Auto Record Advance” on
page 413. Make sure that Auto-record and
Memory-cycle are enabled. Also, make sure that
the record mode pop-up menu in the MIDI
Machine Control window is set to Record mode.
Auto Record Advances doesn’t work in Rehearse or
Safe mode.

6 If you would like to set punch-in and punch-out
points, click Performer’s Auto Punch-in button
below the main transports, and set the punch-in
and out times in the Memory bar

You can even set punch locations while looping a
section with Memory-cycle. The punch location
can be set independently from the loop points. If
you want, you can set the in and out times on the fly
by clicking the In and Out buttons in the Memory
bar during playback. For more information, see
“The Auto-Record button” on page 45.

Auto Punch-ii Auto Record bar

7 To begin recording, cue Performer’s counter to a
point that is at least 5 seconds before the punch-in
point, or set the pre-roll time in the MIDI Machine
Control window to at least 5 seconds.

The amount of pre-roll depends on the device;
some may require longer.

8 Press Performer’s record button, record at the
punch in location, and press stop to end recording.
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chapter 43 Transmit Sync

The Transmit Sync dialog box, available from the
Basics menu, allows you to configure Performer as
a master time source. When being used as a master,
Performer sends synchronization signals to which
other MIDI devices can slave. Performer can
generate two types of MIDI timing and synchroni­
zation data:

■ Standard MIDI beat clocks

■ MIDI Time Code (MTC)

For more information on synchronization, see
chapter 39, “Receive Sync” (page 387).

You may use Performer as a master of some devices
while Performer itself is slaved to another device.
This is especially useful when slaving Performer to
SMPTE time code; Performer (slaved to the tape)
can generate tempos for other sequencers slaved to
Performer.

MIDI TIME CODE
MIDI Time Code (MTC) is the MIDI equivalent of
SMPTE Time Code. It is a steady stream of MIDI
events that expresses time in hours, minutes,
seconds and frames. (For further explanation, see
“Basic Types of Sync” on page 387.) MIDI Time
Code provides the following two basic components
of synchronization:

■ Time base — a common reference for the
passage of time that devices can follow

■ Address — an indication of where playback is at
any moment

MIDI Time Code does not provide tempo or beat
information. Devices that slave to MIDI Time
Code will either have no need for tempo and beat
information, or they have their own idea of tempo
and meter. (MIDI Beat Clocks, however, do
provide tempo and meter beat information. See
“Standard beat clocks” on page 418.)

Slaving another device to Performer with MTC

When you transmit MIDI Time Code from
Performer to a device that can slave to MTC, such
as a tape deck of some kind or a mixing console,
Performer serves as the timing master and the
other device follows as the slave.

Keep in mind, too, that the other “device” doesn’t
necessarily have to be hardware: it could be other
FreeMIDI-compatible software running at the
same time as Performer.

To slave another device to Performer via MIDI
Time Code:

1 Choose Transmit Sync from the Basics menu.

2 Choose a destination for MTC from the pop-up
menu.

You can choose more than one destination by
clicking on the menu as many times as needed.
Choose the destination again from the menu to
turn off MTC transmission (and uncheck the
destination in the menu). If Inter-application MIDI
is enabled in FreeMIDI Preferences (FreeMIDI
Setup, File menu) you can send MTC to other
FreeMIDI applications (including OMS programs,
if OMS Emulator is installed).
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Figure 43-1: If you are also running another FreeMIDI program (or
OMS programs running under the FreeMIDI QMS emulator) that has
the ability to slave to MTC, it will appear in this menu, allowing you to
transmit MTC to it from Performer.

3 Choose the appropriate SMPTE format from
the Frame Rate command in the Basic menu.

Make sure both Performer and the other device are
set to the same SMPTE frame rate (30 frames per
second, 29.97,25,24, etc.).

4 Click the Start Time button in the main counter
to set the SMPTE start frame.

See “Setting the start time” on page 54 for details
about setting the sequence SMPTE start frame.
The start frame is the hour, minute, second, and
frame which Performer (and the other device)
consider to be the beginning of the sequence (on
the first downbeat). Other devices may refer to this
as the SMPTE offset.

5 Press play to make sure Performer’s MIDI Time
Code is being successfully received by the other
device.

MTC is generated at the SMPTE frame rate
specified in the Frame Rate command in the Basics
menu.

Transmitting MTC while slaved to external
Sync
When Digital Performer is set to Slave to External
Sync and is receiving MTC, incoming MTC is
echoed directly, rather than being regenerated by
Performer.

STANDARD BEATCLOCKS
When you tell Performer to transmit beat clocks on
one or both of the Macintosh’s serial ports,
Performer becomes a master time source: any
MIDI devices (that can slave to beat clocks)
connected to Performer will follow Performer’s
tempo changes, and start or stop along with the
program. If the slave devices respond to MIDI
Song Position Pointer data, then they will also
follow Performer when the Counter location is
changed or the Rewind button and Position bar are
used.

Tr inrm It MTC na port(s):
DR4d____________2J

Transmit beat clocks via port(s):

Tftont

® G Printer * ;

O 24 clacks per metronome click

Unlike MIDI Time Code, which can be routed to
specific devices on a multi-port interface like the
MIDI Timepiece, beat clocks are not channel or
port specific, as defined by the MIDI specification.
As a result, they are sent to all devices connected to
the serial port.

Echo received sync vs. Generate MIDI beat
clocks
Performer can transmit beat clock information in
two ways: it can simply pass on (or echo) any beat
clock messages it receives, or it can generate new
beat clocks based upon its own tempo map and
controls. These options are described below:
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Echo received sync
This option echoes beat clocks that are received by
Performer from some other source. No processing
is performed. The reception port must be selected
in the Receive Sync dialog box, and Performer
must be in External Sync mode for beat clocks to be
echoed. Beat clocks are echoed to the ports
selected in the Transmit Sync dialog box. There is
less delay between reception and re-transmission
using this mode than if Generate MIDI beat clocks
is selected.

Use this mode if you wish to slave Performer and
another device to a master that generates MIDI
beat clocks. However, for best results, you should
use a MIDI thru box and connect both Performer
and the other slave directly to the master. Echoing
sync through Performer results in a small delay.

Generate MIDI beat clocks
Performer generates MIDI beat clocks in tandem
with the other MIDI information being played
back. Use this mode when Performer is the master.
You may also find this mode useful when slaving
Performer to SMPTE using one of the time lock
modes. Performer will generate MIDI beat clocks
according to its tempo map in sync with the
SMPTE code, so you can slave a sequencer, drum
machine or device that doesn’t support SMPTE
through Performer.

To set Performer to transmit sync information:

1 Choose Transmit Sync from the Basics menu.

2 Select the Macintosh serial ports that the devices
you want to slave are connected to.

You can choose more than one port by clicking on
the menu as many times as needed. Choose the
port again from the menu to turn off beat clock
transmission (and uncheck the port in the menu).
If neither port is selected, Performer will not
generate or echo sync information. Choose
between echoing and generating sync information.

Click on the corresponding radio button.

3 Set any necessary options.

If you are using Generate MIDI beat clocks, set the
options 24 clocks per metronome click/24 clocks per
quarter note and First clock is time 1 as necessary.
These options have no effect when echoing
received sync.

Performer is now set to transmit sync information.
If your slave devices are set up correctly, they will
start, stop, rewind, and play in time with
Performer.

Generally, you must put the slave device in an
external sync mode before it will respond to
Performer’s transmissions. Consult the owner’s 
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manual for the device to determine the exact
procedure. The mode may be called external clock,
MIDI sync, MIDI clock, etc.

24 clocks per metronome click/24 clocks per
quarter note
Some MIDI devices expect 24 clock signals per
beat (one click of the device’s metronome) instead
of the standard 24 clocks per quarter note. This
method is very useful when there are meters which
do not use the quarter note as the beat unit: 3/8,5/
16, etc. In 6/8, for example, there might be a
metronome click every three eighth notes; in 4/1,
the metronome would click once every whole note.
If you were using a less common meter such as 5/32
or 3/16 + 4/16, using the quarter note as the timing
base is not very useful. Instead, use this option to
make the metronome click value the timing base.

First clock is time 1

When this option is checked, Performer interprets
the first MIDI clock signal it sends as the second
timing clock of the sequence, l/24th of a beat after
the beginning. Recently manufactured devices
expect to receive the first clock signal (time 0) after
the start command for the sequence. Some earlier
devices assume the start command to be the first
clock signal; the first clock signal would thus be 1/
24th of a beat after the beginning. If you are using
one of these older devices, you should check this
option.

Turn it off when you don't need it

If you are not slaving external devices to Performer,
set both of the Transmit Sync dialog menus to None
to improve performance.
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chapter 44 Remote Controls

The Remote Controls window lets you access all of
Performer’s transport functions, such as play, stop,
rewind, and so on from a MIDI controller. For
example, a note value of CO could operate the Stop
button in the Controls window; controller 64 On
could operate the Skip Forward button. In
addition, each Performer function has a
reassignable Macintosh keyboard equivalent.

The Remote Controls window also allows you to
cue sequence and song Chunks for playback from
your MIDI controller. Each Chunk in the file
appears as a Function in the Remote Control
window with a MIDI and Macintosh key to play­
enable that Chunk.

QUICK REFERENCE

Remote

control

Master

Group-
Master

Figure 44-1: The Remote Controls window allows you to customize
they keyboard assignments for many Performer features—as well as
control them from a remote MIDI source.

The Remote Controls window is opened by
choosing it from the Windows menu. For your
convenience, new Performer files contain both the
Transport and Chunk Select controls with default
MIDI and Macintosh key assignments ready to use.

Remote Master: Enables or disables all MIDI
Remote Controls and Master Controls. Remains at
the top of the list and cannot be moved or deleted.

Group Master Control: Enables or disables an
entire group of MIDI Remote Controls with a
single MIDI or Macintosh keystroke. Master
controls can be moved, added, deleted, and
renamed.

Individual Control: Displays a specific Performer
function, and the MIDI event and Macintosh key
assigned to trigger the function. An individual
control is available when the Master above it is On;
if a control has no Master, it is always on.

Master Control Status Icon: Indicates the Master’s
current status, either On or Off. The current mode
is indicated by the text and color of the status icon:
On and highlighted, or Off and grey (or white).

Function: Defines the Performer function to be
triggered.

Event: Defines the MIDI event that will trigger the
Performer function. To edit the event, click the
field and play the new event, then press the Return,
Enter, or arrow keys.

Source/Ch (channel): This is the MIDI device in
your studio from which you would like to trigger
the remote controls. A pop-up menu of devices is
provided in this column by FreeMIDI.
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Mac Key: Defines the Macintosh key (or keys) that
will trigger the Performer function. To change the
key, click it, press the new key(s), and click outside
the box to confirm your choice.

The Remote Controls Window Mini-menu

The Remote Controls window mini-menu contains
the following items.

Add...: Lets you add copies of individual remote
controls to the list.

Add Defaults: Adds the Transport Master and
group members, and the Chunk Select Master with
a control for each Chunk in the file.

Add Master: Adds a Master control to the bottom
of the functions list. This new Master can be moved
and assigned MIDI and Macintosh triggers.

Duplicate: Add a duplicate of the selected item(s)
to the bottom of the Remote Controls function list.

Delete: Deletes the highlighted Masters and
controls. Select functions by clicking them. Select
contiguous functions by dragging. Select
discontiguous functions by shift-clicking.

BASICS
The Remote Controls window lists each Performer
function along with its assignments, and allows
you to edit these assignments to completely
customize your Remote Controls. Further, you can
load the assignments you make into any other
Performer file, or even make them part of every
new file using the Save As ‘New’ Template
command.

There are two types of controls: individual, for
example Play or Stop, and Master, such as the
Transport Controls Master. Individual controls are
grouped under Master controls, which enable and
disable their group when toggled with a MIDI
event or a key on your Macintosh keyboard.

Individual controls actually operate Performer
functions, whereas Master controls make a group
of individual controls available or unavailable.

Master Controls

Every new Performer file automatically contains
several Master controls: the Remote Master, the
Transport Controls Master, the Step Record
Controls Master, and the Chunk Select Master.
Each one serves as a toggle, rendering its sub­
group of controls available or unavailable. To
customize Remote Controls, you can add your own
Masters and change their assignments whenever
you wish.

A Master’s control group is displayed as an
indented list beneath that Master. Each indented
control can be moved into another indented group,
thereby redefining which Master will affect it, by
simply dragging the control’s icon up or down in
the window. Likewise a Master can be dragged to a
different position to redefine its control group.

At any given time, a Master control is either On or
Off. Correspondingly, the Master’s status icon
displays On and is highlighted, or Off and is grey.

On and inverted means that the functions under
that Master are available. When the Master icon is
Off and highlighted, the MIDI controls of the group
under that Master are unavailable; each function’s
trigger acts as a normal MIDI event. Macintosh
controls are always available, regardless of the On/
Off status.

The combinations of Master status and individual
control status make Performer’s Remote Controls
extremely flexible. Here are some typical Remote
Controls setups:

■ The controls occupy an infrequently used range
of your MIDI controller, and are always on. You
don’t typically use this octave in your sequences.
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■ The controls occupy several keys of a MIDI
controller transmitting on one channel, and on
another channel you have a second controller for
recording.

■ The controls occupy the entire span of keys on
your controller, and you can toggle them on and off
with a single key at the very top of the keyboard.
The entire keyboard can switch instantly between
remote controls and MIDI notes.

Enabling and Disabling Remote Controls

You can turn on and off the MIDI Remote Controls
in the following ways:

■ Press option-escape (esc)

■ Click the Remote Master icon in the Remote
Controls window

■ Play the MIDI event you have assigned to it

Changing a Control's Remote Assignments

Performer comes with a pre-defined set of Remote
Controls for the Transport and Chunk Select
functions. You might find these defaults suitable for
your working style. But should you wish to
completely customize your Remote Controls,
Performer makes it easy.

To change the event assignments of a Performer
function or Chunk select control:

1 Choose Remote Controls from the Windows
menu.

The Remote Controls window opens or, if already
open, becomes active.

2 Click the MIDI assignment that you wish to
change.

The field pops up. If you wish to enter a note-off
event, you must play and hold the note, then click
the assignment.

3 Play the MIDI event on the instrument you plan
to use as the remote control device.

Any MIDI event from any connected MIDI
controller is suitable, although notes and switch
controllers are easiest to use. The highlighted field
updates to display the event you just played.

4 Type Return or click anywhere outside the pop­
up box to confirm the change.

Typing the up or down arrow confirms the change
and pops up the previous or next event,
respectively.

5 Choose the MIDI device and channel that you
will be triggering the remote from.

6 Click the Macintosh keyboard equivalent that
you wish to change.

The field highlights.

7 Type the new key combination on your
Macintosh keyboard.

Any key or combination of normal and modifier
keys is suitable.

8 Click anywhere else on the screen.

Because of its unique function, this pop-up box
cannot be confirmed using the Enter or Return key.
The box can be exited only by clicking and cannot
be canceled.

Disabling a Single Control

To turn off an individual control click the MIDI
assignment for a remote control and then
backspace in the pop-up box.

This is especially helpful with the Remote Master to
avoid enabling the remote controls by accident over
MIDI. Also, having lots of MIDI assignments in the
Remote Controls window can sometimes cause
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delays when using Patch Thru. If you delete unused
MIDI assignments from remote controls, you can
prevent delays.

Creating Custom Control Groups

Performer lets you add your own Master controls,
which you can use to toggle on and off whole
groups of individual controls. Just like the default
Masters that Performer provides (Remote,
Transport, and Chunk Select), the Master you add
governs all controls indented beneath it. You can
drag both Master and individual controls up or
down in the Remote Controls window to
determine their grouping.

To add a new Master control:

1 Click anywhere in the Remote Controls window
to activate it.

2 Choose Add Master from the Remote Controls
window mini-menu.

The added Master control appears at the bottom of
the Function list.

3 Option-click the name of the added Master to
change it.

Type Return to confirm the change.

4 Click the Event field of the new Master to assign
a MIDI event.

The field pops up.

5 Assign MIDI and Macintosh key events to the
new Master.

Refer to the section called Changing a control's
remote assignments for details.

6 As mentioned, the position of a Master
determines what group of controls it will affect.
Since a newly added Master appears at the bottom 
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of the Functions list, you will need to reposition the
added Master using its icon. You can also drag
individual controls from Master to Master.

To reposition a Master or individual control:

1 Drag the control’s icon to the desired group.

2 Release a Master just above the group; release an
individual control beneath the Master that should
control it.

An individual control dragged above the first
group’s Master will be controlled by the Remote
Master.

Deleting Controls

To delete a control or group of controls:

1 Click the name of the control to select it.

Drag to select several contiguous controls; shift­
click and shift-drag to select discontiguous
controls.

2 Choose Delete from the Remote Controls
window mini-menu.

The selected controls disappear from the list. Their
MIDI and Macintosh keyboard assignments
cannot be retrieved.

Restoring an Individual Control
You can restore any individual remote control by
using the Add... mini-menu command. Just
choose the control you want from the hierarchical
mini-menu, and it will be added to the bottom of
the list, where you can then drag it to any group
you choose.

Restoring the Factory Default Controls

In the event that you modify controls during a
session and then decide you’d like to retrieve the
factory default controls, Performer provides a
quick mini-menu command to regenerate all 
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3 Choose the Load Remote Controls option.default controls. Choosing Add Defaults places
them at the bottom of the functions list; you can
arrange, reassign, and delete them to your
satisfaction. If you truly wish to start from scratch,
you should delete all existing controls before
restoring the defaults.

The MIDI and Macintosh key event assignments of
controls that you delete are not held in memory.
Once you delete a control, restoring it using Add
Defaults will produce the default controls with the
default assignments. If you wish to save your
custom event assignments, just make sure they are
present when you close the file. The next time you
open the file, your customized controls will be
intact.

Loading Remote Controls Assignments From
Another File
Remote Controls assignments from one Performer
file can be imported into any other Performer file
using the Load command, found in the File menu.
This means you can set up the Controls the way
you like them, once, and they’ll be available for
importing into any of your files.

The Remote Controls assignments that you make
in a file are automatically saved as part of that file.
The Load dialog box, however, enables you to
extract assignments from an unopened file, then
load them into the file in which you are working.

To load Remote Controls assignments into an open
file:

1 Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2 Click the file containing the assignments you
wish to load, then click Open.

Alternately, you can double-click the file name.
Performer’s Load dialog box appears, displaying
the file name at top.

| R E M0 T E CONTROLS

4 Optional: If you wish to load any Chunks from
the selected file, choose the Load Chunks option
and the Data or Link sub-option.

If you wish to load more than one Chunk, you can
drag to select contiguous Chunks and shift-click to
select discontiguous Chunks. Deselecting this
option loads only the file’s Remote Controls
assignments.

5 Click OK to confirm your choice(s) or Cancel to
withdraw the Load command.

Clicking OK causes the selected file’s Remote
Controls assignments, as well as any selected
Chunks, to be loaded into the open file. The
imported assignments appear at the bottom of the
Remote Controls window.

REMOTE CONTROLS HINTS
Performer has a default New file format that
contains the Remote Master, the Transport
Controls Master and functions, and the Chunk
Select Master and individual functions. However,
the Save as ‘New’ Template command in the File
menu lets you define Performer’s New file as you
like.

Customizing Controls in New Files
To customize your New files:

1 Configure Performer’s windows, their contents,
and any other features as you find most useful.

This file will be your template source file:
Performer will remember your exact track setup
and layout as well as many other features. MIDI
and Conductor track data will not be included in
the New template.

2 Choose Save as ‘New’ Template from the File
menu.
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3 Click OK to confirm the command, Cancel to
withdraw it.

If you confirm the command, the New template of
the open copy of Performer is redefined based on
the current file.

Spot-erase
Performer’s spot-erase feature consists of the spot­
erase remote control. Spot-erasing works like most
conventional drum machines: you hold down the
spot-erase key and then hold down the pitch of the
note(s) you want to erase.

To spot-erase:

1 Start playback or overdub recording.

You can spot-erase while playing or overdub
recording. You can spot-erase while using
memory-cycle and while looping.

2 Record-enable the track in which you want to
spot-erase.

3 Hold down the tilde key (') — or your
customized key assignment — and, while holding
it down, hold down the notes you want to erase.

If you like, you can reassign spot-erase to a
different key. Alternately, you can hold down the
spot-erase MIDI remote, which is DO (D-zero).
Notice that you can spot-erase several notes at the
same time—as many as you can manage, in fact.

4 As Performer continues to play (or overdub
record), keep holding down the note(s) you want
to erase for as long as you want to erase them.

If you want, you can release the spot erase key, even
while you continue to hold down the notes you are
erasing. The spot-erase key only needs to be held
down when you first hold down the pitch(es) you
want to erase. Once you’ve held down a pitch, you
can release the spot-erase key.

5 Release the key(s) when you want to finish spot­
erasing.

You can freely “punch-in” and out of spot-erase
mode. Spot-erase is undoable.

You can spot-erase directly from your MIDI
controller using the MIDI event assignment for it.
If you don’t normally use Performer’s Remote
Controls feature, you can still use spot-erase
without using any other remote controls because
spot erase has its own group master. You can even
trigger the spot erase using a foot switch, a data
slider or wheel on your MIDI controller, or
anything that can send MIDI data. That way, you
can configure spot-erase as conveniently as
possible.

Switching MIDI devices,channels and patches

The Sound Selection group of remote controls lets
you choose the next or previous device, MIDI
channel, or default patch for the currently selected
track. If no track is selected, these commands affect
the currently record-enabled track. Along with the
“record next/previous track” remote, you can
easily change tracks, devices, channels and sounds,
all from your controller keyboard while recording.

[7T]i Sound Selection J'BbO i any any 8? ssin Opt -1
qvj Next Device any any Shift -1
CJ? 1 Previous Device ,*?y any shift - r
c3? | Next Channel *ny any .Opi-T_______
CJJ | Previous Channel any any ffA—Next Patch Kt'J any
CJ!- | Previous Patch any any

Creating Remote Control Macros
Several commands can be triggered in succession
with one keystroke by assigning them to the same
MIDI event. For example, you can create the
following three-step sequence of remote controls:
Stop, Chunk select, and Play. If you place them in
that order in the Remote Controls List and assign
them to the same key, Performer will execute the
topmost control first. The current sequence will
stop, and the specified Chunk will cue up and
begin playing—all with one keystroke!
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Similarly, you can assign all of your Master controls
to the same MIDI or Mac key event — that event
now turns on and off your MIDI Remote Controls.

Remote Chunk Cueing with MIDI Song Select
Messages
In addition to Chunk select Remote Controls,
Performer also allows you to cue Chunks for
playback by sending a Song Select message from a
MIDI controller. The Chunks window column S#
displays the Song Select number that, when
received, will cue the corresponding Chunk for
playback. If a Chunk has no Song number
assigned, the S#column displays a single dash (-).

Most hardware sequencers and some MIDI
keyboard controllers can send and receive Song
Select messages. Simply send a Song Select message
as instructed in that module’s documentation. If
the open file contains a Chunk assigned to the Song
number in the message, that Chunk will be play-
enabled. If more than one Chunk has the same
Song number assigned, the one highest in the
Chunks list will be cued.

When used in combination with the Chunk
Chaining buttons in the Controls window, a Song
Select message cues the corresponding Chunk to
be play-enabled or played back. The information
bar in the Consolidated Control panel indicates
which Chunk has been cued.

| REMOTE CONTROLS
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chapter 45 Custom Control Consoles

Performers custom control consoles provide a host
of control items, including:

■ Sliders

■ Knobs

■ Buttons

a Pop-up menus

Each control item can be used for virtually any
musical purpose that involves MIDI data. For
example, a control item can: 

■ Act as a “virtual” MIDI instrument, generating
continuous data which can be sent to synthesizers
and recorded into tracks

a Remap data, such as velocities into controllers

a Modify velocities of notes as you play back

■ Generate system exclusive data to modify synth
parameters on the fly

You can build customized control consoles, such
as: 

■ Mixing consoles with sliders and knobs that
control MIDI volume and pan

■ Patch editing consoles that control and shape the
sounds in your synthesizers.

The sliders, knobs, and buttons can be controlled
in real time, while Performer is playing back or
recording, to create musical effects. In addition,
they animate during playback to reflect what you
have recorded.

BASICS
Custom Control items serve two functions. First,
they monitor MIDI data being played from their
target track or MIDI channel, animating in real
time to reflect the data’s current value. For example,
let’s say you have a track containing a stream of
controller #7 (volume) data, and the controllers
increase in value (in the range from zero to 127),
making a crescendo. A control item assigned to
monitor controller #7 in the track will move as the
track is played back, reflecting the changes in the
values of the controller.

Secondly, control items generate new continuous
MIDI controller data in real time when you take
control of them, and send the data to either a
FreeMIDI device or track. When you take control
of a control item, the new data that it generates
overrides the data already in the track.

To demonstrate this, let’s return to the volume
example above with the crescendo in the track. If
you play back the track and grab the control item
with the mouse half way through the crescendo,
you will take over the volume of the track with the
control item. The crescendo still exists in the track,
but it does not get played as long as you are
gripping the control item with the mouse. If you
release the control item, it will immediately begin
monitoring the existing data in the track again.

429



In summary, control items monitor continuous
data being played back from their target track or
MIDI channel. Grabbing a control item generates
new data which overrides the data in its target
track. The new data does not modify the track; it
only temporarily overrides the continuous data in
the track.

BUILDING A CUSTOM CONSOLE
Custom controls are created and displayed in
custom console windows. You can create as many
custom console windows as you like. They save,
close, and open like other Performer windows. The
are saved with the file in which you create them —
although you can use the Load command in the
File menu to export them to other files.

If you would like to create your own customized
console, you can open a new, blank custom
console. To do so, choose Consoles>New Console
from the Windows menu.

Windows
Open ►
Close SSID
Newt Edit Window
Window Sets >

Figure 45-1: Creating a new, empty console in which you can build
controls.

Quick Reference

A new, empty console window appears. It has a title
bar, close box, push down box, mini-menu and
grow box like a standard Performer window. Drag
the title bar to move it. Click the close box to close
it.

Edit Mode
Insert buttoiK button Snapshot Control item area

\ | / button

Insert button: inserts a slider, knob, button, or
other control item.

Edit Mode button: Toggles between two modes in
the console. When Edit Mode is on (the button is
highlighted), console items can be moved, resized,
deleted, and otherwise graphically manipulated.
When Edit mode is off, control items cannot be
moved; instead, sliders slide, knobs turn, buttons
push, and so on.

Snapshot button: takes a snapshot of the current
knob, slider, and other control settings and records
the current setting in the track at the current
counter location. This can be done while
Performer is stopped or playing back.

Control Items area: this is the area where you
create and position the knobs, sliders, buttons, etc.

Mini-menu Quick Reference

Set Console Name: Provides a dialog box in which
you can change the name that displays in the title
bar of the console and in the Windows menu.

Duplicate: Makes a copy of selected control items.
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Snap to Grid: Toggles whether or not control items
snap to an invisible grid in the console when they
are moved or resized. When checked, Grid Snap is
on. When not checked, Grid Snap is off.

Set Grid Spacing: determines the resolution of the
snap grid when snapping is turned on. The
resolution is measured in screen pixels, which are
approximately 72 dots per inch (dpi).

Align controls: Lines up selected controls to one
another in a configuration that you choose. For
example, you can line up the centers of several
control items by selecting them and choosing this
command.

Background pattern: Allows you to fill the control
item area with a standard Macintosh background
pattern similar to the fill patterns found in paint
programs. Sliders, knobs, and buttons appear
superimposed on top of the background pattern.

Goto Zero: Sets the value of the highlighted control
item(s) to zero.

Goto Null Point: Sets the value of a highlighted
master control item to its null point.

Auto Punch-In/Out: A special record mode for
control items which causes them to record data
into their target track only when the control item is
moved, either with the mouse or an external
source.

Set Punch-Out Delay: Opens the Set Punch-Out
dialog box, which allows you to adjust the delay
before punch-out when you are in Auto Punch-In
mode and are controlling a control item from an
external MIDI source. The Punch-Out time is the
amount of time (in tenths of a second) between
when the last event is received by a control item
from its external source and the time at which the
control item drops out of Record.

Group: Opens the Grouping dialog box for the
highlighted control items. This command allows
you to assign control items to a group all at once
rather than one at a time.

Ungroup: Removes the highlighted control items
from their assigned group.

Control Assignment: Opens the Control
Assignment dialog box for the currently selected
control item in the console. This dialog contains all
of the settings for how the control item behaves.

Set Source: Lets you assign a remote control to one
or more selected control items together at one time.

Set Target: Lets you assign one or more control
items to a destination together at one time.

Min(imum) Time and Value Change: Lets you
control the density of the controller data generated
by a control item by increasing or reducing the
minimum allowed time and value change between
controllers.

Name item: Lets you type in a name for a currently
selected control item.

Delete Control: Removes the currently selected
control item(s) from the console.

Delete Console: removes the console from the
screen and removes its name from the windows
menu.

Creating a Slider, Knob, or Button

To create a control item:

1 (Optional) Select the Snap to Grid menu item to
turn the snap grid on or off.

This causes the control item to snap to an invisible
grid in the console window when you create it,
which can be useful for lining up multiple buttons
and sliders.
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1 Press the insert button in the title bar and
choose the item you would like to insert from the
menu.

The cursor turns into a cross-hair.

2 Drag across a blank portion of the console
window.

As you drag, the item appears. You can choose any
length or size that you like. You can also resize the
item at any time.

3 When you release the mouse, the control
Assignment dialog box appears.

Receive: Controller Controller

Control flssignmenf

© MIDI: Morphem-1

O Track; Track-I

Send:

Cont.“[HM) Volume

Assignment for Volume slider
Source

© MIDI. K2000

O Track: Track-1

Polarity;
• © Positive

by 1100I O Negative

Name:_________________ Type:
[Unnamed Slider | .Shder

Minimum time change: |o | ticks Minimum value: |o [

Minimum value change: |o | Maximum value: (127 |

Groups;
O Master Fl
• Sim  <*‘a

Relation to master:
O Match
O Offset
© Scale

4 (Optional) Choose a source data type for the
control item.

See “Making the Source Assignment” on page 433
for more information.

I

5 Choose the Target data type for the control item.

See “Making the Target Assignment” on page 433
for more information.

6 (Optional) Set the minimum and maximum
time change.

These two options (on the left) control the density
of the data that the control item generates. The
lower the values, the more dense the data. Higher
values thin out the data. Try to use as high a value
as you can while still maintaining the musical effect
you wish to achieve. If you use values that are too
high, and the data is too thinly generated, it may
not sound good.

7 Choose the minimum and maximum values for
the control item.

These are the absolute lowest and highest values
that the control item can have. For controllers, the
maximum range is 0 to 127. For pitch bend, the
range is -8192 to +8191.

8 (Optional) Assign the control item to a group.

See “Grouping Control Items” on page 442 for
more information.

9 (Optional) Type in a name for the control item.

10 If desired, change the type of item (slider, knob,
button) by choosing a different item type from the
Type pop-up menu.

11 When you have set all of the parameters as
desired, click OK.

The control item appears in the console. Notice
that it has a box around it. You can click the handle
in the lower left of the box to further reshape the
item.
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Notes and velocities

Making the Target Assignment

The target assignment is made in the Control
Assignment dialog box when you first create the
slider, knob or button as shown in the previous
section. The target can be changed at any time by
double-clicking the control item.

The target assignment consists of two things: the
type of MIDI data and the target, which is place
where the data will be sent.

Control assignment

Target

® MIDI: Morpheus:-1 v|

O Track: Track-1_________

Send: Controller_______ 2d

Cont. B!HM] Volume H

The target data type is the specific type of MIDI data
that the control item will send and monitor. A
control item only monitors one track and one data
type at a time.

Sliders, knobs, and buttons in Performer can
control just about any type of MIDI data,
including:

■ Continuous controllers

■ Switch controllers (either as switch controllers or
as continuous controllers)

■ System exclusive messages

For velocities, the slider or knob modifies the
velocities of notes in the target track as they play.

The Target is the place where the data will be sent
by the slider, knob or button. The target can be:

■ A track

■ A FreeMIDI device

When the target is a track, the data from the
control item is sent to the track, which then records
and plays the data. In turn, the control item
monitors the material it recorded in the track,
animating as it does so. However, the control item
only records into that one track in that one
sequence; it cannot control another track in
another sequence, unless you reassign it.

When the target is a FreeMIDI device, the data
from the control item is sent to the track in the
current sequence which is assigned to that device.
This is the most flexible of the target assignments
because it doesn’t matter what sequence is playing
at the time. As long as one of its tracks is assigned to
the device, the control item data will be recorded
and monitored in the track.

Making the Source Assignment

The source assignment is made in the Control
Assignment dialog box when you first create the
slider, knob or button as described in “Creating a
Slider, Knob, or Button” on page 431. The source
can changed at any time by double-clicking the
control item.

What is a source for the slider or knob? It is a device
other than the mouse which you can use to control
the slider or knob. Normally, you change the value
of a slider or knob by dragging it with the mouse.
At times, however, it might be useful to move it
from an external controller, such as the modulation
wheel or data entry slider on your MIDI keyboard 
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controller. To do so, set the Source assignment to
match the incoming MIDI channel and data type
for the controller you wish to use.

The source assignment consists of two things: a
type of MIDI data and the MIDI channel or track
from which the data is being generated.

Assignment for Volume slider
Source

® MOI; K2000 3J

O Trxk Track-1 v-|

Receive: Controller

Cent. ”|l | Motkihlbft wheel «r| I

Notice that the slider or knob can be controlled by
notes, velocities, pitch bend, controllers, or even
mono pressure.

Set the MIDI channel to match the transmit
channel of the controller, pitch bend wheel, or
whatever you are using.

Notice that the source can also be a track. Source
data in the track then controls the slider. This
allows you to create interesting effects. For
example, you can assign the source of a slider to be
the velocities of notes in track 3. You can then
assign the target to be controller number 7
(volume) and assign it to the synth playing back
the notes in track three. When you play the track,
the slider reads the velocities and sends out a
volume controllers to match the velocities, thus
enhancing the volume change effect from the
velocities.

Changing the Source or Target

To change the source or target assignment:

1 Be sure the Edit mode button in the title bar of
the console window is unhighlighted (turned off).

2 Click the knob or slider to select it.

3 Choose Control Assignment from the mini­
menu.

As a shortcut, double-click the control item.

4 Set the source or target assignments as needed.

5 Click OK.

Adding Arrows to a Slider or Knob

To connect a scroll arrow to a slider:

1 (Optional) Select “Snap to Grid” from the
Console window mini-menu to check it.

Doing so causes the arrow to be lined up with the
slider or knob. Otherwise, you may need to
manually adjust the position of the arrow to line it
up with the slider. The arrow doesn’t have to be
lined up, however; it will control the slider no
matter where you place it.

2 Insert the slider or knob.

To do so, press the insert button, choose slider (or
knob), and drag out the slider. The Control
Assignment dialog appears. Select the desired
settings and click OK.

3 Press the insert button again and choose
“Arrow” from the menu.

Once you have chosen to insert an arrow, the
cursor turns into a cross-hair.

4 Click directly on top of the slider and drag in the
direction to which the arrow should point.

Don’t worry about the exact placement of the
arrow yet. You can take care of that after you have
inserted it. Drag up or to the right to create an
increment button; drag down or to the left to create
a decrement button. Control the size of the arrow
with the size of the box that you drag out. Below, an 
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increment arrow is being inserted by dragging to
the right. Notice that tire cross-hair was initially
clicked on top of the slider.

When adding arrows to a slider,

dick on top of the slider and drag
in the direction that the arrow
should point.

Once inserted,you can adjust the
size and placement by dragging
the arrow and its size handle. Use
the Align command in the mini­
menu to quickly line thingsup.

5 Adjust the size and placement of the arrow as
needed.

Use the Align command in the mini-menu to
automatically align the arrow with the slider.

6 To use the arrow, click the edit button in the
console title bar to unhighlight it and click the
arrow button.

Adding a Value Box to a Slider, Knob, or Button

A value box displays the current value of the slider,
knob, or button, and it will update continuously as
you move the slider or knob.

If you want, you can add a value box to a button.
However, buttons can only send up to two values,
so a value box might not be useful since it will only
display two different values. (On the other hand,
you might have a situation in which it would be
useful, so that’s why we mentioned it.)

To add a value box:

1 (Optional) Select “Snap to Grid” from the
Console window mini-menu to check it.

Doing so causes the value box to be lined up with
the slider or knob. Otherwise, you may need to
manually adjust the position of the value box to
line it up with the slider. The value box doesn’t have
to be lined up, however; it will be connected to the
slider no matter where you place it.

1 Insert the slider, knob, or button.

To do so, press the insert button, choose slider, and
drag out the slider. The Control Assignment dialog
appears. Select the desired settings and click OK.

2 Press the Insert button again and choose “Value
Box” from the pop-up list.

3 Click on top of the item to which you wish to
add the value box, and drag diagonally to create the
value box.

Click on top of the
knob orslider and
drag out a box for
the appropriate size.

Once inserted,
you can adjust
the size and
placement.

If grid snapping is
enabled,dickinthe
comer to line up
the value box with
the knob orslider.

Using Value Boxes

You can enter a value into a value box just like any
text boxes in Performer, including just dragging up
or down on the value box.

Labelling a Slider, Knob, or Button

Often you will want to label the sliders, knobs, and
buttons that you create. If you didn’t set the name
when you first created the control item, set it as
follows:

1 Click the border of the control item to select it.

Alternately, you can shift-click anywhere on the
control item to select it.
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2 Choose “Name Item” from the mini-menu.

3 Type in the desired name.

4 Click OK to confirm your choice.

To add a label to the control item:

1 Press the insert button and choose “Label” from
the menu.

2 Click directly on top of the control item.

The label appears.

3 If necessary, drag the label to the desired
position.

You can do so with grid snapping enabled or
disabled.

Changing a Label

To change the text of a label:

1 Click the label to select it, or click the border of
the control item.

2 Choose “Name Item” from the mini-menu.

3 Type in the new name and click OK.

<•“ Note: as a shortcut, you can option-click the
label.

Creating a Button
Buttons send one MIDI message at a time. For
example, a button might send a patch change to a
synth or a MIDI patcher.

To create a button:

1 Press the insert button and choose “Button” or
“Text Button” from the menu.

A text button displays its label inside the button.

2 Drag the cross-hair across the console to insert
the button.

The Control Assignment dialog box appears.

3 Set the Source and Target items as desired.

See “Making the Target Assignment” on page 433
and “Making the Source Assignment” on page 433.

4 Select the type of button you wish it to be.

There are three types of buttons:

Ofi

Single­

state

CM W

Two- On/off

state

V.1uw:|D lj,„

□ Single state button: sends a single message only.

■ Two-state button: toggles between two
messages, sending the first when it is pressed and
the second when it is released. For example, you
might want to create a temporary mute button that
mutes the track only while you are holding down
the button. If you choose this type of button, you
have two values to enter to the right of the option.

■ On/off button: toggles between two messages,
sending the first when it is pressed and the second
when it is pressed again, and so on. For example,
the button might toggle between a volume
controller of zero and 127 to mute and unmute a
track. If you choose this type of button, you have
two values to enter to the right of the option.

5 If you want the button to act like a mute button,
click the “M” next to off value button as shown
below.

When this setting is enabled, the button sends the
current value of its target controller type at the time
the button is unmuted, instead of sending a specific
maximum value. This makes a button assigned to 
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controller #7 (volume) act just like a real mute
button by returning the track to the current volume
at the moment it is unmuted.

Vihw: |O I

[HI (unrmrtt)

Figure 45-2: Making a mute button.

6 If desired, choose a group for the button.

Buttons can be grouped, either by a master button
or even by a slider or knob.

7 If desired, type in a name for the button.

If it is a text button, the name will be displayed
inside the button.

8 Click OK.

Selecting Control Items

Shift-click anywhere on a control item to select it.
You can also use shift-clicking to select multiple
items.

To select a group of items, drag a selection box over
them.

To select all the items in the console, choose Select
All from the Edit menu, or press command-A.

Cutting, Copying, and Pasting Console
Controls
Console controls can be cut, copied, and pasted.
This greatly facilitates the process of building a
custom control console. For example, if you are
creating a number of items that are similar, make
one first and then copy and paste it as many times
as needed. Then make the necessary minor
adjustments to each copy.

To cut or copy a control item:

1 Select the desired item(s).

Note that you can select more than one at a time.
For information about selecting control items, see
“Selecting Control Items” above.

2 Choose Cut or Copy from the Edit menu.

To paste a control item after cutting or copying,
choose Paste from the Edit menu.

Aligning Control Items

There is an Align Controls command in the
Console mini-menu to help align selected console
controls.

To use this command:

1 Select the items to be aligned.

2 Choose Align Controls from the console mini­
menu.

The Align Controls dialog appears.

3 Choose the desired options.

\ ___
Rlignment ■

Horizontal
alignment...

Vertical
alignment,.

O Unchanged (?) Unchanged
O Left edges O Tcp edges
(*) Centers O Centers
O Right edges O Bottom edges

| 0* Cancel j

________________________
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In this example, we are aligning the centers of the
objects left-to-right.

4 Click OK.

See “Selecting Control Items” on page 437.

2 Choose “Duplicate” from the Console
mini-menu.

Nudging Control Items

Selected control items can be nudged using the
arrow keys. Be sure that the item you want to nudge
is selected. (You can nudge several at once, too.)
Also make sure that the Edit Mode button in the
title bar of the console is highlighted as shown
below. Items are nudged one screen pixel each time
you press an arrow key, unless the Snap to Grid
mini-menu command is checked. If so, the
controls are nudged by the amount of the current
grid setting.

Edit Mode button

1

Moving or Removing Control Items

Once you have selected control items as described
in the previous section, you can drag them
anywhere in the console window. You can also
remove them from the console by hitting the delete
key, by choosing Erase from the Edit menu, or by
choosing Delete control in the console mini-menu.

Duplicating a Control Item

To duplicate a control item:

Changing the Parameters of a Control Item

To change the source, target, grouping, and other
parameters for a control item, double-click it. The
Control Assignment dialog box appears. Change
what you wish and then click OK.

Moving or Resizing a Control Item

To move or resize a control item, you need to be in
edit mode. To enter edit mode, click the Edit Mode
button in the title bar so that it becomes
highlighted. When you are in edit mode, you can
only edit control items. You cannot use them, i.e.
you cannot slide a slider, turn a knob, press a
button, etc. To use the control items again,
unhighlight the edit mode button.

As a shortcut, you can enter edit mode temporarily
by holding down the command key (instead of
clicking the edit button) as you click the control
item. Doing so allows you to move it or resize it
without clicking the Edit Mode button in the title
bar.

Setting a Background Pattern for the Console
The Background Pattern command in the Console
window mini-menu opens a dialog from which you
can choose a foreground and background pattern
for the console. Click the pattern you wish for each,
and the sliders, knobs, and buttons in the console
will be superimposed on top of that pattern.

You can use this feature to visually differentiate
different types of consoles. For example, you could
give your volume consoles a different background
pattern from your effects consoles.

1 Select the control item.
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CONTROLLING KNOBS AND SLIDERS
The following sections explain how to control
sliders and knobs.

Controlling a Slider or Knob with the Mouse

Try moving the slider with the following mouse
actions to familiarize yourself with them.

Drag the handles to „ ... ...
change the slider's value Pop-edit the s ider

smoothly. value directly.

buttons to move bartosnapthesliderto buttons to move the
the slider by one. that position. slider smoothly.

To move a knob, simply click on it and drag
horizontally or vertically.

Controlling a Knob orSlider with a Mod or Pitch
Bend Wheel

Once you have made the source assignment as
described in “Making the Source Assignment” on
page 433, click the slider or knob name to highlight
it and move the mod wheel. You will see the slider
respond as you move the wheel.

** Remember, the slider or knob must be
selected for external control to work.

When a slider or knob is being controlled
externally, data from the external source is
exclusive to the slider; that is, the data is used solely
to control the slider and will not be accidentally
recorded into another track.

Remapping Data on the Fly

External control is a very powerful feature because
it allows you to reassign continuous data in real
time as you move the controller. For example, a
volume slider that is being controlled by a mod
wheel is actually receiving controller #1 data from
the wheel and then converting it into controller #7
data on-the-fly.

Performer also allows you to control sliders with
several types of data that you might not consider at
first: notes, velocities, and aftertouch.

Moving a Slider or Knob During Playback

To move the slider during playback, simply press
the play button and move the slider with the mouse
or mod wheel, while the scale is playing back.
Notice that the volume changes as you move the
slider.

Controlling a Slider or Knob with Notes

MIDI notes are numbered from 0 to 127. C3 is note
number 60, for example. Note numbers
correspond exactly to controller numbers, so
pressing a note on your keyboard will set the slider
to its corresponding value. This is useful for
creating sudden, precise changes in controller
value rather than smooth changes. Keep in mind
while you do this that most keyboards do not have
127 keys and therefore will not allow you to span
the entire zero to 127 range of the slider.

Controlling a Slider or Knob with Velocity and
Aftertouch

Note velocities can also be used to control the
slider, since they also span the range from zero to
127. The harder you strike a key, the higher (or
lower) the slider will go. This might be useful for 
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setting up a slider to send a controller that, in turn,
affects a synth in a certain way: as you strike the key
harder, the musical effect will become stronger (or
weaker).

The same applies to aftertouch data. The harder
you press on the key, the higher (or lower) the
control item will go.

RECORDING A KNOB, SLIDER, OR BUTTON
Once a control item’s target and source parameters
have been set up, you can record data generated by
it into its target track. Recording with custom
controls is specially designed so that the data from
the control item will not erase data that already
exists in the track. Instead, data generated by a
knob, slider, or button is merged with existing data.
For example, you can record a crescendo (in the
form of controller #7 data) from the control item
without erasing any of the notes in the track.

On the other hand, data from the control item
replaces any existing data of the same type. If a track
already contains controller#? data from measure 1
to measure 10, and you record briefly with the
slider in measure 5, the new data recorded from the
slider will replace the existing controller #7 data in
measure 5.

With this in mind, sliders, knobs and buttons can
be recorded in one of three ways:

■ You can record a single “snapshot” of the current
setting of all the sliders and buttons in a console. To
do so, set the Main Counter to the desired location,
set up the console the way you wish, and then click
the Snapshot button in the title bar of the console.
Or, click the Snapshot button during playback or
recording. For more information, see “Taking a
Snapshot of a Console” on page 441.

■ You can record without Punch-in mode
(unchecked in the console window mini-menu),
which causes the slider or knob to record 

continuously, even when you are not moving the
slider, so that it continually replaces its own data
type in the track.

■ You can record with Punch-in mode, which
causes the slider or knob to only record when you
move it. Punch-in mode is enabled by default.

Record-enabling an empty track

When recording console controls, a track has to be
record-enabled. Note, however, that you do not
need to record-enable the track whose fader you
want to record.

To avoid accidentally erasing notes and other data
when recording faders, do one of the following:

■ Record-enable an empty track

OR

■ Record-enable any track and turn on Overdub
Record mode

Enabling Auto Punch-In Mode

To enable Auto Punch-In mode, select it from the
mini-menu. A check appears next to it indicating
that it is activated.

To record data when punching in, press the Record
button in the Control Panel and move the control
item. When the control item moves, data in the
track of the same type as what the control item is
sending will be replaced by the new control item
data, just like normal control item recording.
When you release the control item, recording will
stop and it will return to monitoring the track.

Punch-in Recording Using an External Control
Moving the control item from an external control
while punching in works much the same way: to
punch in, the control item waits to receive an event
from its external controller. When it does, it
punches in. Punch out, however, is done 
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automatically by Performer and is determined by
the amount of time after the last event was received
from the controller.

Since controllers send data with different degrees
of sensitivity, you may find that punch out occurs
too frequently. To avoid stuttering punch out, you
can lengthen the delay before Performer punches
out with the Set Punch Out command in the
console window mini-menu.

The Set Punch Out dialog box allows you to
determine the punch out delay in tenths of a
second. Usually, values between 5 and 15 work
well.

Summary
Here are several situations and a description of
what control items will do in each case:

Performer is not playing or recording: When the
current location of the sequence is changed with
the Main Counter, all control items jump to the
value of their assigned parameter on their assigned
track. They may then be moved; as they move they
send out MIDI data of the assigned data type on
the channel(s) of their assigned track.

Performer is playing back: As Performer plays, the
control items animate to reflect the values of their
target data type from their target. A control item
may be grabbed and moved independently, either
by simply grabbing the handle or by external
control; it then transmits MIDI data that takes the
place of out-going data from its source track. The 

data it generates does not get recorded. When the
control item is released, it returns to tracking the
target track.

Performer is recording: When Performer is
recording, a control item is either in or out of
Punch-in mode. Here is what happens in each
condition:

■ With Punch-in mode, the control item simply
monitors its target, just like playback. When you
move it with the mouse, it records your movement.
Data in the target track is replaced by data
generated by the control item. (Only data of the
same type is replaced). When the control item
handle is released, the control item starts tracking
the target track again.

■ Without Punch-in mode, a MIDI event
corresponding to the current position of the
control item is inserted into the target track(s). As
recording continues, old data is either erased or
replaced by new data of the same type generated by
control item motions. Only data of the type
assigned to the control item is affected. For
example, recording a pitch bend control item
would replace any existing pitch bend data with
new data; notes, controller data, etc. would be
unaffected.

TAKING A SNAPSHOT OF A CONSOLE
Once you have created your custom console, you
can take a snapshot of it. A snapshot captures all of
the current slider and knob settings. The snapshot
is placed into the tracks of the currently play-
enabled sequence.

If you would like to record the snapshot, the target
assignment of the sliders and knobs must be either
a track or a device (instead of a MIDI channel).

To take a snapshot of the current position of the
sliders, knobs, and buttons in a console:
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1 Set the main counter to the desired location at
which you wish to record the snapshot.

You can also take the snapshot during playback or
recording.

2 Set up the sliders, knobs and other control items
the way you would like them to be in the snapshot.

3 Select the control items in the console that you
want to include in the snapshot.

See “Selecting Control Items” above.

Snapshot button

4 Click the Snapshot button in the title bar.

When you click the snapshot button, each control
item generates a MIDI event at that instant. The
value of the event, such as the level of a volume
controller, is determined by the control item’s
position at the time the snapshot is taken. The
event is inserted into the control item’s target track.
If you have taken the snapshot of many sliders,
knobs, etc., each item places its data into its own
target track.

Editing a snapshot

Once data has been inserted into one or more
tracks by taking a snapshot, the data can be edited
in the standard fashion in the track(s). For
example, if you wanted to remove the snapshot,
select the data in the tracks window and delete it.

ANIMATION DURING PLAYBACK
Unless the control item is being dragged, it
monitors its target track, animating during
playback to reflect MIDI data that it has recorded
into the track.
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In general, the control item always reflects the
current value of its target data type, even when
cueing the sequence to a different playback
location. For example, press the rewind button of
the sequence. The volume control item will snap to
zero. Now, type in measure 5 into the Counter
window and press the return key. This sets the
current playback position at measure 5. When you
do so, the volume control item will snap to
whatever the value of controller #7 is at measure 5.

USING CONTROLLERS ABOVE 63
Only controllers 0 to 63 are considered to be
“continuous” MIDI controllers—ones that can
express any value between 0 and 127. Controllers
64 to 120 are defined by the MIDI specification as
“switch” controllers—ones that are either on or off.
Controllers 121 to 127 are reserved for special
purposes.

Some MIDI hardware, however, treats controllers
64 to 120 as continuous controllers. Performer’s
control items can generate any controller from 0 to
120 as continuous data, providing you with
maximum flexibility with MIDI devices that treat
controllers 64 to 120 as continuous controllers.

GROUPING CONTROL ITEMS
Performer’s custom consoles provide the ability to
group control items together and control them
from a master control item. Grouping allows you to
control an entire bank of controls at the same time
from one control item. Up to 32 control items can
be assigned to a single group, and Performer allows
up to 26 groups, each identified by a letter from A
to Z. Any control item can be a master control item
or a grouped control item.

In addition, a master control item that controls a
group can, in turn, be a member of another group
controlled by another master. This allows you to
create sub-groups of control items, and sub-groups
within sub-groups. There is no limit to the number
of layers you can create.
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Master and Slave control items

Each control item in the group can have its own,
customized relation to the group’s master control
item. Grouping provides three ways in which a
control item (slave) responds to its group master:
the grouped control item can match, offset, or scale
values received from the master.

When matching the master, the slave simply goes to
the same value as the master. For example, if the
master control item is set to 79, the slave goes to 79
as well.

When offsetting the master, the slave can start at a
different value than the master. When the master
moves, the slave moves by the same amount, or by
a percentage of the amount. For example, let’s say
that the master is at 0, the slave is at 20, and the
slave is offsetting by 100%. If you move the master
to 50, the slave will move to 70. If the slave is
offsetting by 50%, it will only move to 45, which is
20 plus half of 50 (25).

When scaling the master, the slave can start at a
different value than the master. When the master
moves, the slave moves by a percentage of the
distance that the master moves in its relation to the
end of the control item. For example, lets say that
the master is at 0, the slave is at 64, and the slave is
scaling by 100%. When the master moves to 64,
which is half way to the top, the slave moves to 96,
which is halfway of its distance to the top. If the
master goes to 96, which is 3/4ths of its distance to
the top, the slave goes to 112, which is 3/4ths of its
distance to the top. By the time the master has
reached 127, so has the slave.

Slaves can be offset or scaled by a percentage
between 0 and 999%.

Polarity

In addition to matching, offsetting, and scaling, a
slave can react positively or negatively to its master.
Positive polarity causes the control item to move in 

the same direction as its master. Negative polarity
causes the control item to move in the opposite
direction from its master.

Negative polarity is extremely useful for many
musical effects, such as cross-fading or panning.
You can bring the volume of one track up at the
same time as you bring the volume of another track
down.

In this example, “End Part I” is the master and is
being faded down from right to left. As it does,
“Begin Part II” fades up from left to right.

Null Points

In the grouping offset and scaling examples above,
you may have noticed that an important part of
how masters and slaves work is their initial values.
In Performer, the master’s initial value is called the
null point and the slave’s initial value is called its
reference value.

A master’s null point is the value of the master
slider on which changes to slaves are based. It is
indicated on a slider as a bold hash mark behind
the slider bar.

The slave’s reference value is its value when the
master is at its null point. Whenever you would like
to see the reference value of a slave, move its master
to its null point.
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1 Select one or more control items.Null point

The slave responds to changes in the master slider’s
value, which are measured from the master slider’s
null point, and it moves from its reference point
based on those changes. As the master moves from
its null point, the slave moves from its reference
value.

Performer’s null point is similar to the null point on
most recording studio mixing consoles: it is a base
value from which slaved sliders are measured.

Hardware mixers usually have a fixed null point
somewhere near the middle of the slider’s range.
The null point of Performer’s sliders, however, can
be set to any value on the slider, from zero to 127
(or -8192 to 8191). This provides an added level of
flexibility when achieving the musical effects that
you want.

Moving Slaves Independently of Their Master

Slaves always follow their master. However, a slave
is not “locked” by the master; it can be moved
independently at any time, regardless of the
master’s current value (position). When you move
a slave, you are changing its reference point with
respect to the master. In addition, its relation to the
master is temporarily severed. The only way to
reestablish the connection is to move the master, or
reset the master to its current value.

If you move both a master and a slave at the same
time from the same external source, you will sever
the master/slave connection between them and the
slave will track the external source as if it was not
connected to the master.

Assigning a Control Item to a Group
To assign a control item to a group:

2 Choose Group from the console window mini­
menu.

The Grouping dialog box will appear.

Grouping Infcrmaljsn for Multiple controls

GroupPolarity;
1 O

Relation to master:
O Match
O Offset
©Scale

rouping

3 Type the group letter to which you want to
assign the control item.

The only restriction here is that a control item
cannot be the member of a group if it is already the
master of that group. Up to 32 control items can be
included in one group.

4 Select the polarity.

5 Choose whether to match, offset, or scale from
the master.

If you want the grouped control items to reach their
highest and lowest value at the same time as the
master, choose scale at 100%, which is perhaps the
most intuitive way to group control items.

6 Click OK to confirm your choice or Cancel to
withdraw it.

Assigning a Master Control Item

To assign a master control item:

1 Unhighlight the Edit Mode button in the
console title bar and select the control item.

2 Choose Control Assignment from the mini­
menu.
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3 Type a letter in the Group text box.

You can enter any single letter. The only restriction
is that the control item cannot be a master of its
own group.

4 Choose the Master option.

5 Click OK.

Setting a Master Slider's Null Point

To change the null point of a master slider:

1 Option-click anywhere on the slider.

The null point, which is indicated by a bold hash
mark, will snap to the location, and you can drag it
freely from there.

The null point can also be changed more precisely
as follows:

1 Select the master slider.

2 Choose Control Assignment from the console
mini-menu.

3 Make sure the Master radio button option is
selected.

4 Type in the desired null point in the box
provided.

5 Click OK to confirm your choice or cancel to
withdraw the command.

Setting a Slave's Reference Value

To change the reference value of a slave, move the
master back to its null point, and then move the
slave to the desired value. It is not mandatory to
move the master to its null point beforehand, but if
you do not, the value you are setting is the actual
reference value and does not reflect the current
difference between the master and its null point. As
soon as you move the master again, reestablishing 

the master/slave connection, the slave will pop to
its new relative position, often causing an
unexpected result.

Moving a Master to its Null Point

To move a master to its null point, either drag the
master’s handle to the bold hash mark, or highlight
the slider and choose Goto Null Point from the
Slider window or Console mini-menu.

Sending Multiple MIDI Messages At Once With
Grouped Buttons

You can group buttons to a master button to send
various messages to various destinations all at
once. Just assign each button to the same group.
Make sure each button is of the same type. Then
create a master button that is also the same type.
When you press the master button, the slaved
buttons will be pressed and released at the same
time.

Please note: if you group buttons, the slaved
buttons do not animate when you click the master
button. They do, however, transmit data.

GENERATING SYSEX WITH A SLIDER OR
KNOB
Performer allows you to generate system exclusive
data from a slider or knob. The slider generates a
continuous stream of messages, each containing a
range of bytes (up to four) that are changed
incrementally by the slider or knob.

Doing so allows you to control device-specific
parameters of MIDI hardware in ways that can not
be achieved with continuous controller data.

Please note! This section is not for the
technically faint of heart. You should have a firm
knowledge of MIDI be already familiar with your
hardware’s MIDI implementation.

Before you begin this procedure, here’s what you
need to know about the sysex message:

_______________ ____________ ____________________ _________________ ____________ I 445
I C 0 S T 0M CONTROL CONSOLES



■ The message itself, or how to dump it into
Performer

■ Whether or not the message contains a
checksum, and if so, how many bytes the checksum
consists of

■ What the data bit format is (7-bit or 4-bit nibble)

■ Which comes first, the LSB or the MSB

■ The specific bytes within the message that will be
the variable bytes controlled by the control item
(up to 4 bytes)

To set up a control item that generates sysex, you
must first enter the sysex data into Performer, and
you have two choices for how you can do so. You
can:

1. Type it in by hand

2. Type in a request message and record it from the
synth

To set up a sysex slider or knob:

1 Create the slider or knob.

If the sysex message you’d like to control was
recorded as a bulk dump into a device, be sure to
assign the target to the device.

2 Select it and choose Control Assignment from
the console mini-menu.

3 Choose system exclusive from the Target data
type pop-up menu.

4 Click the Set Sysex button.

The Assign Slider Sysex window appears.
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If you want to type in the sysex message, type the
message into the sysex editor. For more
information about how to use this editor, see
chapter 46, “System Exclusive” (page 451).

If you would like to enter a bulk dump request
message, click Transmit. Performers standard
sysex editor window appears, into which you can
type in the bulk dump message. See the System
Exclusive chapter if you need more information.

Choosing the Variable Data Bytes
Once you have the sysex message you want in the
sysex editor display, you can now select which data
bytes are to be the variables that will be controlled
by the slider.

To select the variable data bytes:

1 Choose replacement mode for the edit cursor so
that you can highlight the desired bytes.

2 Select the desired data bytes.

You can select up to four bytes.

3 Once the bytes are selected, click the Value
button.

Notice that the bytes now turn into a slider.
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Note: if the sysex message is a device bulk
dump, several sliders can edit the same bulk dump
message.

To see the values of the bytes being covered up by
the slider, use the arrow keys to scroll the insertion
cursor through the bytes. When it passes through
the slider, the slider disappears for a few seconds.

Setting the Checksum

If the synth requires a checksum, Performer must
generate the proper checksum as well, and it needs
to know an initial value to do so.

You are done! Click OK. The slider will now
generate the sysex message. If the synth does not
respond, verify the checksum values.

Monitoring a Sysex Slider During Playback

Sysex sliders cannot monitor the data they
generate. This is due to the amount of data
processing that would be required in real time.

Here is a work-around for this problem:

1 Create two sliders.

2 Make one the master and the other a slave.

3 Make the Master slider generate an unused
controller and assign its target to a track.

4 Make the slaved slider read that unused
controller from the same track as its source.

To set the initial checksum value:

1 Click the Use Checksum check box.

2 Select either the Straight sum or Sum to zero
option.

3 Type in the number of bytes for the checksum
value.

4 Identify the first data byte that is checksummed.

To do so, type in the byte number next to the
Checksum button, or place the cursor at the first
byte of checksummed data (normally the first byte
immediately after the sysex header) and click the
Checksum button.

Setting the Bit Formats

Select the appropriate bit format from the pop-up
menu and select either LSB—>MSB or MSB—
>LSB.

5 Then make the slaved slider generate the sysex
data.

In this scenario, you move the master slider. It
generates controller data at the same time that it is
controlling the sysex slider, so that the sysex slider
matches its movement. On playback, the sysex
slider monitors the controller data and generates
the sysex. Thus, the sysex data never gets recorded
in the track; only the controller data does. But the
controller data and sysex data match because the
were slaved when originally recorded. The end
result is that the sysex slider animates and plays
back exactly as it was record.

HINTS
Control items can serve many purposes. Some
suggestions are discussed below.

Remapping Continuous Data

Control items can be used for remapping
continuous controller data in real time. For
example, you may have a synth module that
responds to controller #10 (MIDI Pan), but you

J 447
| CUSTOM CONTROL CONSOLES



448

may not have any keyboards that can send this
particular controller. A control item can solve this
problem by remapping a controller that your
keyboard does send into controller #10. To do so,
assign the source of a control item to be a controller
that your keyboard can transmit, such as controller
#1 (mod wheel). Set the control item’s target to be
the Device or track that sends to the synth module.
Set the target data type to controller #10. Now,
when you send controller #1 data from your
keyboard by moving the mod wheel, you will be
controlling the Pan settings on your synth module.

Control Items also offer a way to reassign
continuous data in real time instead of using the
Reassign Continuous data command. For example,
you may have a track of controller #3 continuous
data that you wish to change to controller #7. You
can set up the source of a control item to be the
track containing controller #3. In turn, you can
assign the target data type to be controller #7, and
assign the control item to send the data to a
different target track. When you press record, the
control item will read in the controller #3’s and
generate controller #7’s, which in turn will be
recorded into the target track.

Improving Console Animation

Performer’s first priority is to keep up with the flow
of MIDI data. If it encounters a great deal of data, it
selectively ignores its graphic display until the
microprocessor load decreases. This may affect the
animation of control items, and they may not move
smoothly when lots of data is being played—
especially if there are many control items on the
screen. This is Performer’s way of keeping up and
does not necessarily mean that MIDI data is being
transmitted inaccurately.

Performer gives the currently active window
highest priority when animating control items.
Therefore, whenever you want to watch control 

items while Performer is playing back, make sure
their window is active. To activate the window,
simply click anywhere on the window.

If the control items you want to watch are in
different consoles, you may want to create another
single console that contains all of the control items
you wish to monitor during playback. You can then
make it the active window, and all of the control
items in it will animate as smoothly as possible. You
will find that as long as the console is active,
Performer does a pretty good job of animating
control items accurately.

Another way to improve control item animation is
to close as many consoles as possible.

Loading Control Items and Consoles From
Another File

Consoles from one Performer file can be imported
into any other Performer file using the Load
command, found in the File menu. This means you
can set up control items the way you like them
once, and they’ll be available for importing into
any of your files.

The Consoles that you create in a file are
automatically saved as part of that file. The Load
dialog box, however, enables you to extract them
from an unopened file, then load them into the file
in which you are working.

To load Consoles into an open file:

1 Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2 Click the file containing the assignments you
wish to load, then click Open.

Alternately, you can double-click the file name.
Performer’s Load dialog box appears, displaying
the file name at top.
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3 Choose the Loud Consoles option.

4 Optional: If you wish to load any Chunks from
the selected file, choose the Load Chunks option
and either the Data or Link sub-option.

If you wish to load more than one Chunk, you can
drag to select contiguous Chunks and shift-click to
select discontiguous Chunks. Deselecting this
option loads only the file’s Control Items.

5 Click OK to confirm your choice(s) or Cancel to
withdraw the Load command.

Clicking OK causes the selected file’s Consoles, as
well as any selected Chunks, to be loaded into the
open file. The imported consoles appear in the
Windows menu.

Sending note-ons and note-offs

When you program a button or slider to generate
notes as shown below by the “Send” pop-up menu,
you have three possibilities:

1. Send notes (both note-ons and note-offs)

2. Send note-ons only

3. Send note-offs only

For option 1, leave both check boxes unchecked. In
this case, the slider, knob, or button will send a
note-on when you click it, and it will send a note off
when you release it or move it to another note.

For options 2 and 3, click the appropriate check
box. In this case, the slider, knob, or button sends
only a note on or a note off when you click it or
move it.

*■ Please note: note-ons and note-offs by
themselves do not constitute an entire note.
Therefore, they cannot be recorded into a track.

Creating a Mute Button

To create a mute button, create a button as
described in the section “Creating a Button” on
page 436. For the maximum value, click the
“unmute button” as shown in Figure 45-2 on
page 437.

Automating a Fader Group with a Master
Control

Master console controls can control their slaves
while monitoring a target track. This means you
can automate the movement of many slave controls
at once by recording only the data of their master
control. For example, you can automate a master
fade-out at the end of a sequence by slaving
multiple sliders (one for each track or device in
your sequence) to a master slider and then
recording the master slider. When you play back
the result, the master slider monitors the data you
recorded in its target track and simultaneously
drives the volume sliders for all other tracks. To
accomplish this, make sure that the master slider
target assignment is a track (or a device which is
assigned to attack).

Remember that the master slider’s track must
be play-enabled for this to work. (It can’t be
muted.) As a result, you might consider assigning
the master slider’s track to a MIDI channel that you
don’t use. Also, since the target data type for the
master slider doesn’t matter (as long as it is some
type of continuous controller), you might consider
using a target data type for the master slider that is
unlikely to affect anything else (like controller
number 45).
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chapter 46 System Exclusive

Performer allows you to record, playback, and edit
MIDI System Exclusive messages. Common types
of System Exclusive messages include patch
dumps, preset selections, editing parameters, etc.
Performer can thus store patches, samples, and
other important information from your MIDI
equipment in system exclusive form. Patches, edit
parameters, and other special commands can be
incorporated into musical sequences, greatly
expanding the resources of your MIDI sound
modules.

BASICS
System Exclusive messages are a special type of
MIDI data. A System Exclusive message consists of
a header, body, and an ‘end of message’ byte. (A
byte is a unit of digital information, roughly
equivalent to a single character or letter.)

The header labels the following data as System
Exclusive information, and includes a code
identifying the manufacturer of the equipment
transmitting the data.

The body of the message contains the actual data
being sent. This data may take any form the
manufacturer desires. While there are some
standards for the format of System Exclusive
information, for the most part a System Exclusive
message is only understood by the type of equipment
that generated it. As a result, recording a patch
dump from one synthesizer and sending it to
another will generally not produce useful results.
Performer does not respond to or interpret System
Exclusive data; any analysis or editing of the body
of the message is the user’s responsibility.

Finally, the end of message byte, F7, marks the end
of the System Exclusive data, and signals Performer
to interpret subsequent information as standard
MIDI data.

As defined in the MIDI specification, a System
Exclusive message must begin and end with an FO
and F7 byte, respectively. In addition, only
hexadecimal values of 7F (127 in base ten) or less
are allowed. When you click the OK button after
inserting or editing the contents of a System
Exclusive event, Performer will scroll to and
highlight any bytes that violate the conditions just
stated.

Recording and Playing System Exclusive
Messages
System Exclusive messages are recorded and played
back like any other MIDI data. These messages
vary in size; information for a bank of patches, for
instance, maybe 10-20K or more. No matter how
long a message is, it is treated as a single event by
Performer. Note that a long System Exclusive
message can briefly halt recording or playback as
Performer processes the data; it is best to place
larger System Exclusive events like patch or bank
dumps in separate sequences, or at the start of a
sequence before the actual music begins.

Because System Exclusive messages have no
channel assignment, they are sent to every MIDI
device connected to a port. If you have several
devices of the same model or brand connected to
the same port they may all respond to a message
sent to or from just one of them. Conversely, some
manufacturers encode channel assignments into
the body of the System Exclusive message.
Performer is unable to access or rechannelize such
an assignment.



For example, if the playback assignment for a track
is channel 1, but a System Exclusive message full of
patches intended for that synth includes an
encoded assignment to channel 16, the synth won’t
receive the patches.

Find out if any of your equipment encodes channel
assignments in its System Exclusive messages, and
be careful about changing channel assignments on
equipment to which you intend to send System
Exclusive. If you encounter difficulty when
working with System Exclusive data, try patching
the MIDI device directly to the Macintosh MIDI
interface, to prevent interaction with other
equipment.

Note that the Input Filter, found in Performer’s
Basics menu, defaults to System Exclusive
unchecked. Unless you explicitly check the box
next to System Exclusive, you will be unable to
record System Exclusive messages.

Viewing & Editing System Exclusive Data
System Exclusive data can be viewed and edited in
the Event Editing window for the track on which it
is recorded. In an Event List, a System Exclusive
message will consist of the System Exclusive
symbol and as much data as can fit on one line:

0 FO 43 01 05 7C 28 32 F7

To see the entire message, option-click or double­
click on the System Exclusive event. A window
appears:

Insertion Replacement
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Button
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Length 8 I
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Figure 46-1: Performer's system exclusive editor. The Transmit button
transmits the message currently displayed in the upper portion of the
display. Use it to send a sysex request message to a device. The sysex
message the device sends in response will appear in the lower portion
of the window.

The window is divided into a top and bottom
portion. The bottom portion displays the system
exclusive data contained in the event. The top
portion is used to type in and transmit short
system exclusive “request” messages, which can be
sent to a synthesizer that requires a short system
exclusive bulk dump request message to initiate a
bulk dump to be recorded into the lower portion of
the window.

The System Exclusive data is displayed in
hexadecimal (base 16) numbering. Each pair of
hexadecimal digits, which include the numerals 0-
9 and the letters A-F, represents a byte of data. Each
line contains eight pairs of digits. To the left of each
line of data is a two-digit hexadecimal number
indicating the position of the first byte of data in
that row. The first row starts at position 00, the next
at 08, the third at 10 (this equals 16 in
hexadecimal), and so forth. To the right of each
row of data is its translation into alphanumeric
characters (using the ASCII standard). Most of the
time this translation will be garbled and useless,
but patch names and other text in the System
Exclusive message may be visible.
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The length of the System Exclusive message is
displayed at the top left. This is the number of bytes
of data in the message.

The scroll bars let you scroll through long
messages. The Grow box in the lower right corner
lets you adjust the size of the window. When you
press the OK button, Performer checks the changes
you have made to the data and will scroll to and
highlight any byte that does not conform to the
MIDI specification. After confirming your
changes, Performer closes the window. Pressing the
Cancel button closes the window without making
any changes to the data.

Editing Data in the System Exclusive Window

You can directly edit the hexadecimal data in the
System Exclusive window using the mouse and
Macintosh keyboard. There are two basic editing
modes: Insertion mode and Replacement mode.
The editing mode is selected by clicking on the
appropriate button at the top center of the window;
the currently selected mode is indicated with a
darkened border.

Insertion mode: This mode is similar to standard
Macintosh text entry. To insert new values, click the
mouse to position the insertion point, and type in
new values. Use the delete key to delete previous
digits. You may edit only in the hexadecimal
portion of the display.

|F0 Bi
Replacement mode: In this mode, one character is
always highlighted. Typing a new character
replaces the current highlighted character, and
then highlights the next character. Use this mode if
you are just changing a few bytes in a system
exclusive message, as the display requires less
updating while typing new values.

|F0 Bi
To edit a System Exclusive event:

1 Activate the Event Editing window that contains
the System Exclusive event.

If neither Event Editing window for the track is
open, double-click on the track name and an
editing window will appear. If one is open, simply
click on it.

2 Double-click on the System Exclusive event.

The System Exclusive window appears.

3 Select the editing mode.

Click on the appropriate button. If just a few bytes
need to be edited, use Replacement mode.
Otherwise, use Insertion mode.

4 Edit the data.

In Insertion mode, delete the incorrect bytes and
type in new data. In Replacement mode, click on
the first digit of data to be replaced and type in the
new data. The old data is written over.

5 Press OK to confirm your changes and close the
window, or Cancel to close the window without
making any changes to the data.

If you press OK, Performer will scroll to and
highlight any byte that does not conform to MIDI
specification requirements.

Cutting, Copying, and Pasting
To Cut, Copy, or Paste a region of hex data in
replacement mode:

1 Select the data.

To do so, drag over it with the mouse.
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2 Cut, copy, or replace the selected region.

t *y -;‘r. 3

0 FO CO 00 03 33 00 01^7 . .3...
0:

-
...

Length. 77 |l^®| 031

0: FO 00 03 00 02 10 01 21 ...............•
0: 00 12 .................

10: “............
10: K»WF«<ffii>rO2 10 20 12 ..............
20. 01 20 10 20k- 12 01 20 10 .................
23 20 12 01 21 00 10 21 02 . 1 . . 1.
30: 10 20 EO FO 12 10 21 02 ............ 1 .
38. 10 21 02 10 20 10 21 02 . I . .! £

To Cut or Copy, press command-X or command-C
respectively. The selected data will be placed in the
Clipboard. To replace the selected data, type in or
paste new data, which will replace the highlighted
data.

Inserting System Exclusive Data in an Event
Editing Window

You can insert system exclusive data into an Event
Editing window. This is handy for inserting a short
system exclusive message, like a parameter change
or dump request, without having to record it. The
following steps apply to System Exclusive insertion
in an Event List window. Refer also to the chapter
The Graphic Editing Window.

To insert a System Exclusive event into an Event
List window:

1 Activate the Event List window into which you
want to insert the System Exclusive event.

If the Event List window is not open, double-click
on the track name to open it. If it is open, simply
click on it.

2 Press the Insert button in the title bar of the
Event List window.

3 Select System Exclusive from the menu.

A new system exclusive event pops up.

4 Enter the location for the system exclusive event.

5 Press the Tab key to move to the data field.

The System Exclusive window appears.

6 Select Insertion mode.

Click on the left button at the top center of the
window.

|F0 Bo
7 Type in the data.

In Insertion mode, you can delete the incorrect
bytes and type in new data. See the above section
on editing System Exclusive data for more
information.

8 Press OK to confirm the insert and close the
window, or Cancel to cancel the insert and close
the window.

When confirming your insert, Performer will scroll
to and highlight any byte that does not conform to
MIDI specification requirements.

Editing System Exclusive Data With the Edit
Menu
The commands on the Edit menu work as normal
on System Exclusive events; these events can be cut,
pasted, shifted, etc. within a file or between files
just like any other Performer event. The only way to
alter the body of a System Exclusive message is to
use the System Exclusive window as described
above. In all other cases, Performer treats the
message as a single event.

Transmitting a System Exclusive Message

To transmit a system exclusive message from the
system exclusive editor window:

1 Click the insertion mode button.
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2 Click between the FO and F7 in the top portion
of the window.

This is only necessary if your synth requires it.
Many synths allow you to initiate the transfer by
pressing a button on the synth itself.

8 Initiate the system exclusive data transfer from
your MIDI device.

3 Type in the system exclusive data.

4 Click Transmit.

Recording Sysex into the Editor Window

To record system exclusive into the system
exclusive editor window:

1 Be sure that your MIDI hardware and cables are
set up properly.

Make sure there is a MIDI cable from the MIDI
OUT on the device you will be recording from to
the MIDI IN on your interface.

2 If Performer is in MultiRecord mode, switch to
regular record mode to avoid problems.

To do so, select MultiRecord in the Tracks window
mini-menu to uncheck it.

3 Open an Event Editing window for a track and
press the Insert button in the title bar.

4 Choose System Exclusive from the menu.

A system exclusive pop-up event will appear.

5 Type in the measure, beat and tick location for
the event, using the tab key to move from one field
to the next.

6 Press tab one more time to open the System
Exclusive Editor window.

The system exclusive editor window will appear.

7 If necessary, type in a bulk dump request
message in the top portion of the window.

To do so, press the button on the device—or
whatever is needed—to cause it to transmit the
desired system exclusive dump. If you typed in a
bulk dump request message, click the Transmit
button. If all is well, the system exclusive data will
appear in the lower portion of the window.

9 Click OK to save the system exclusive data or
cancel to discard it.

It is not necessary to enable system exclusive data
in the Input Filter when recording data into the
system exclusive editor window.

Recording System Exclusive into a Track

As with earlier versions of Performer, you can also
record system exclusive data into a track. To record
a system exclusive message into a track:

1 Be sure that your MIDI hardware and cables are
set up properly.

Make sure there is a MIDI cable from the MIDI
OUT on the device you will be recording from to
the MIDI IN on your interface.

2 Choose Set Input Filter from the Basics menu in
Performer and check the System Exclusive option.

If the System Exclusive option is not checked,
system exclusive data will be filtered on input and
will not be recorded.

3 If Performer is in MultiRecord mode, switch to
regular record mode to avoid problems.

To do so, select MultiRecord in the Tracks window
mini-menu to uncheck it.
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4 Record-enable a track in the Tracks window.

5 Start recording.

6 Send the system exclusive data from your MIDI
device.

To do so, press the button on the device—or
whatever is needed—to cause it to transmit the
desired system exclusive dump. If you have the
MIDI Monitor window open, you will see the
MIDI System Common light (labelled Co) turn
black while the data is being received by Performer.

7 Wait a few seconds, longer if it is a large bulk
dump, and then stop recording.

8 Open the Event List window to view the System
Exclusive event in the track.

What you should see is something like this:

S7|RjI|fS| *>,. Track-6 (Seq-1)
1131433 □ <2oT>r0 41 09 28 12 00 00 00 00 00 00 00 00 04 13 o|<

Figure 46-2: An example of a sysex message in Performer's Event List
window.

If the Event List window is empty, or you do not see
a System Exclusive event, check the Input Filter and
cable connections and try again. You may also want
to open the MIDI Monitor window to see if the
data is actually being received by the Macintosh. If
the Co light doesn’t turn yellow (or black on a black
and white screen) when you send the data from the
device, then there is a problem with the MIDI
connections or with the device that is transmitting
the system exclusive.

HINTS
Most synthesizers and many other MIDI devices
allow you to dump patch settings as System
Exclusive messages. You can use Performer to store
and organize these messages, creating a library of
patches and presets. Store each patch or bank of 

patches as a separate sequence in one or more files.
This way you can use the name and comment fields
to label your presets, and use the Load command to
quickly access them. To restore a patch or bank,
load the desired sequence and play it.

You can paste System Exclusive dumps of sounds
and settings at the start of a sequence. This lets you
use patches or settings that can’t fit into your MIDI
devices’ preset storage, and ensures that the right
sounds are loaded for the sequence. Use the
standard Copy and Paste commands to place the
system exclusive events at the start of the sequence.
It is best to leave a measure or two of space after the
system exclusive messages and the start of the
music, to allow your equipment to process the data.
Use the comments fields in the Chunks and Tracks
windows to describe the system exclusive data
you’ve pasted into your sequence; system exclusive
messages are hard to identify from their
appearance.

Some manufacturers allow you to edit patch
parameters over MIDI, using short system
exclusive messages. This can add a great deal of
expression to a sequence. For example, the attack
of a filter envelope could be controlled with system
exclusive and controller data, creating different
bowing effects for a violin patch.

Some instruments must receive a handshake
message before they will transmit a System
Exclusive message. If this is the case with one of
your MIDI instruments, first consult the user’s
manual for the instrument (or if necessary, the
manufacturer) to find out the hexadecimal string
that comprises the handshake message. Type this
message into a Performer track using the System
Exclusive editing window as described above, then
copy the track and paste it to a ‘library’ sequence
for backup purposes. Back in the original
sequence, play-enable the track containing the
handshake message and record-enable an empty
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track. Upon playback, the handshake will be
transmitted to the instrument, which will respond
by dumping to the record-enabled track.

BE CAREFUL
System exclusive data is not associated with a
channel, as defined in the MIDI specification.
System exclusive data in a track is merely sent to the
port you specify for playback; no channel number
can be attached. Some manufacturers have decided
to include a channel number in some of their
system exclusive messages. This number cannot be
changed. Therefore, even if data is being sent to
channel 3, for example, system exclusive messages
contained in that data might be sent to a channel
other than 3.

System exclusive data is complex, and varies greatly
from device to device. If you are uncertain about
your equipment’s system exclusive implemen­
tation, you should be very careful in using or
editing system exclusive data. Most of the time,
turning a piece of equipment off and then on again
will clear any strange behavior caused by incorrect
system exclusive data; however, incorrect use of
system exclusive data could permanently erase
presets from a synthesizer or other MIDI device.

SYSTEM EXCLUSIVE
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chapter 47 Performer & the MIDI Timepiece™

About this chapter
This chapter discusses how Performer and the
MIDI Timepiece (the original MIDI Timepiece,
the MIDI Timepiece II, or the MIDI Timepiece AV)
work together. This chapter also applies to the
MIDI Express and multi-port interfaces from other
manufacturers, such as Opcode’s Studio 5.

Performer relies on FreeMIDI to identify what type
of interface is connected to the Macintosh.
FreeMIDI automatically figures out what is
connected. If a MIDI Timepiece (MTP) or other
similar multiport interface is present, several
important features are automatically enabled in
Performer. The sections below refer to features that
are fully documented in other chapters of this
manual, such as the MIDI Monitor window. You
may want to review these chapters as you read this
one; this will help you understand how Performer
works with the MIDI Timepiece.

The MIDI Timepiece and MIDI Express can each
be thought of as four MIDI devices wrapped into a
single rack-space unit. Each one is:

■ a multi-port MIDI interface

■ a MIDI patch bay with routing, channelizing,
and muting

■ a SMPTE-to-MIDI synchronizer

■ a SMPTE time code (ETC) generator

Performer has three features that support them:

■ high data transfer rate with FAST mode (not
available with the MIDI Express)

■ 128 MIDI channels through data cablization (96
channels with the MIDI Express)

■ Improved SMPTE synchronization with
Enhanced Direct Time Lock™

High data transfer rate with FAST mode

When Performer and the MIDI Timepiece are set
to FAST mode, they communicate two to four
times faster than a regular interface running at 1
Megahertz. As a result, they sustain greater data
throughput to all 8 MIDI OUT cables on the MTP.
Fast mode also alleviates irregular timing problems
that occur when too much data is being
transmitted, commonly referred to as “MIDI
logjam.”

128 MIDI channels via 8 independent cables

The MIDI Timepiece is a powerful MIDI interface
because it offers eight independent MIDI INs and
MIDI OUTs. Independent means that each cable
handles its own, separate set of 16 MIDI channels.
Eight cables, multiplied by 16 MIDI channels each,
equals 128 separate MIDI channels. Performer
provides access to all 8 cables and all 128 channels.
In addition, up to four MTPs can be networked
together for a total of 512 MIDI channels.

The MIDI Express provides 96 MIDI channels (6
outputs times 16 channels each).

In either case, the primary benefit is that you’ll
never have to worry about overlapping MIDI
channels (MIDI channels that are being used by
more than one MIDI device at a time). Each device
has its own channels, so you’ll never have a conflict.

Another benefit is that both the MIDI IN and MIDI
OUT of each device can be connected at all times,
allowing easy access to and from the instrument.



This is especially useful when using an editor/
librarian software program such as Mark of the
Unicorn’s Unisyn™.

Improved SMPTE sync with Enhanced Direct
Time Lock™
Enhanced Direct Time Lock (DTLe) is an
improved form of the DTL supported in earlier
versions of Performer. Instead of one frame
advance message per SMPTE frame, DTLe consists
offour frame advances per frame. In addition,
DTL’s tape position (full frame) message has been
expanded to include the frame rate of the SMPTE
and an identification of which device in an MTP
network is sending the DTLe.

To fully support DTLe, the MIDI Timepiece sends
a tape position message approximately once every
second. This prevents even the slightest amount of
drift due to small dropouts or other inconsistencies
in the SMPTE time code.

When used with Performer, the MIDI Timepiece
provides the most reliable SMPTE-to-MIDI
lockup available. In addition, DTLe allows
Performer to establish lockup without stopping the
tape transport. While the film or video tape is
rolling, you can press Performer’s Play button and
the program will jump right into sync with the
tape.

Synchronizing to SMPTE with DTLe
Enhanced Direct Time Lock™ (DTLe) is an
improved form of DTL supported by earlier
versions of Performer. The following sections
provide a brief overview of how to sync Performer
to SMPTE time code via DTLe and the MIDI
Timepiece. If you are not already familiar with the
synchronizing process, please refer to the chapter
in the MIDI Timepiece user’s manual called
Working with SMPTE.

The principal benefits of DTLe are: 1) you are less
likely to have problems such as dropouts, drifting,
etc. and 2) lockup can be achieved while the tape
continues rolling. You no longer have to stop the
tape to reestablish lockup.

Performer still supports old DTL if you are using
an original DTL converter.The procedure for using
original DTL is the same as for DTLe.

Locking the MTP to SMPTE

To lock the MTP to SMPTE, connect an audio out
from the tape deck to the AUDIO IN jack on the
rear panel of the MTP. In the MTP Console SMPTE
Controls window, choose the DTLe option, and
make sure that DTLe is being routed to the
Macintosh.

To verify lockup, open the SMPTE Reader window
from the MTP Console and roll the tape. The
SMPTE Reader should begin to roll. Lockup is
indicated on the MTP by the LTC/LOCK light
(LED) on the front panel, which glows steadily as
long as the MTP is locked. In addition, the
POWER/TACH (tachometer) LED flashes
regularly once per second. If the LEDs flicker
erratically, the MIDI Timepiece is not locking up
consistently. Try boosting or attenuating the
SMPTE output from the tape deck.

Using the MIDI Monitor to check incoming
DTLe
To verify that Performer is receiving the incoming
DTLe properly, use the MIDI Monitor window.
When DTLe is being received, the RT light turns
dark (due to the four F8 bytes being received each
frame):

Figure 47-1: The real-time data light t'Rt") lights up when Performer
is successfully receiving DTLe.
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Locking Performer to the MTP

Once the MTP has been successfully locked to
tape, and you have verified that it is sending DTLe
to Performer, lockup is easy. Choose MTC/DTL/
DTLe in the Receive Sync dialog box, set a start
time in the counter with the Start Time button,
choose Slave to External Sync, press Play (or
Record), and roll the tape. You can press stop at any
time and reestablish lockup by pressing Play again,
even while the tape is rolling.

Troubleshooting
If you have trouble establishing lockup, refer to the
MIDI Timepiece manual SMPTE chapter for
detailed, step-by-step instructions. Also refer to
“Slaving to SMPTE with MTC, DTL, or DTLe” on
page 391.

If you continue to have problems, check out the
troubleshooting chapter at the end of the MTP
manual. It discusses solutions to common
synchronization problems.
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chapter 48 Performer & the Video Time Piece™

The Video Time Piece is Mark of the Unicorn’s
affordable SMPTE/VITC/MIDI time code
converter and character generator. VITC (Vertical
Interval Time Code) is SMPTE time code that is
recorded directly in the video signal, freeing up
both audio tracks and allowing lockup to be
maintained while freeze-framing or frame­
advancing the video.

Performer supports many of the Video Time Piece’s
unique features. With the Performer/Video Time
Piece combination you can:

■ Lock Performer to VITC and remain in sync
while frame advancing

■ Download Markers as streamers to the video
display

■ Display a Conductor Crawl Line that displays the
hit point of each downbeat in the sequence

■ Convert an audio click track into a Performer
tempo map in the Conductor track

■ Prevent dropouts during tape sync with
adjustable freewheeling

SETTING UP PERFORMER
To set up Performer for the Video Time Piece, you
need to add the Video Time Piece to your
FreeMIDI configuration using the FreeMIDI Setup
application. If Performer is currently running, you
can launch FreeMIDI setup by choosing Edit
FreeMIDI Configuration from the Basics menu.
Choose Create Device from the Configuration
menu and set up the options as needed.

When you have a Video Time Piece in your
FreeMIDI configuration as shown above, special
features for the Video Time Piece are automatically
enabled in Performer; they are discussed in this
chapter.

LOCKING PERFORMER TO VITC
Once you have installed the Video Time Piece, you
can lock Performer to video that has been recorded
with VITC or LTC.

Before attempting lockup to VITC, it is a good idea
to make sure that the Video Time Piece is
successfully converting the VITC into MIDI sync
and transmitting the sync data to Performer and
the Macintosh.

Verifying Incoming Time Code

To verify incoming time code from the Video Time
Piece:

1 Open the Video Time Piece desk accessory and
open the Convert SMPTE window.
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2 Choose the VITC option and the DTL (Direct
Time Lock) option.

Alternately,you can use MTC (MIDI Time Code)
option.

3 Roll the Video tape.

When the VITC LOCK light on the Video Time
Piece indicates that lockup has been achieved, the
COMPUTER OUT LED should begin to glow,
indicating that the Video Time Piece is sending
DTL (or MTC) to the Macintosh and Performer.

4 Open Performer’s MIDI Monitor window.

If you are using Direct Time Lock enhanced, the
“Rt” light on the port to which the VTP is
connected will turn black. In addition, the Co light
on the Video Time Piece panel will blink regularly
if DTLe is being successfully received by Performer.

The Co light will turn black if you are using MTC.

Locking Up Performer
You can now lock up Performer, even while the
video tape is still rolling:

1 Choose the MTC/DTL/DTLe time code option
in Performer’s Receive Sync dialog box.

Be sure to match the same type of sync that the
Video Time Piece is sending.

2 Enable the Record while still-framed option in
the Receive Sync dialog box.

This causes Performer to remain in record when
you are frame-advancing.

3 Choose Slave to external sync from the Basics
menu.

This puts Performer into slave mode.

4 Press the Play or Record buttons.

You can do so even while the tape is rolling.
Performer will immediately lock to the tape. If
necessary, you may have to stop and adjust the start
time in the Counter. (Click the Start Time button to
do so.)

Recording Hits While Frame Advancing

To record hits while frame-advancing:

1 Freeze the video image.

Performer will also stop at the frozen video SMPTE
frame.

2 Choose Add from the Markers window mini­
menu or play a MIDI event into the currently
record-enabled track.

The nets’ marker will be added to the list at the
current tape location. If the Markers window isn’t
already open, press stop, open it, and press play
again.

3 Advance to the next hit using your VCR’s frame­
advance button.

Performer will follow along.

4 Repeat the above two steps as many times as
necessary.
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When you are through, you can rename each
marker and lock it to its SMPTE time.

Performer remains in sync during freeze-frame
because the VCR tape heads keep spinning—even
when the tape is stopped. Thus, they continually
scan the video image (and the VITC). The Video
Time Piece, in turn, remains locked to the frozen
image as it is being continually scanned and sends
periodic tape position messages to Performer to let
Performer know where the current tape location is.
You can see these periodic tape position messages
as brief flashes on the COMPUTER OUT LED on
the Video Time Piece. To record notes, you must
have the Record while still-framed option checked
in the Receive Sync dialog box.

USING STREAMERS
The Markers window has an additional capability
designed for the Video Time Piece’s character
generator. The Video Time Piece can superimpose
graphic images on a video picture, including
streamers. A streamer is a solid white bar that
travels across a video screen from left to right to
reach the right-hand side of the screen at an exact
hit point. Streamers help studio musicians and
sound effects engineers to anticipate hit points
during video post-production.

Performer’s markers have the ability to serve as
triggers for streamers generated by the Video Time
Piece. Here is how it works: while Performer is
slaved to the video via SMPTE time code and the
Video Time Piece, it sends a message to the Video
Time Piece several seconds before playback reaches
the marker location. This message tells the Video
Time Piece the name of the marker and its exact
location. To warn the viewer of the approaching hit
point, the Video Time Piece immediately displays
the name of the marker on screen for several
seconds before the streamer. The Video Time Piece
then displays a moving streamer for the marker 

such that the streamer hits the right side of the
screen at the exact SMPTE frame location of the
marker.

Enabling Streamers

To enable streamers in Performer, check the
“Generate VTP Streamers” mini-menu command.
Then you will see the Streamers column next to the
marker names in the Markers window:

VTP Streamers

To enable a streamer for a marker, click in the
Streamer column next to the marker name and the
streamer icon will appear. The marker will then
appear as a streamer on the Video Time Piece’s
video picture. If you option-click, the marker will
be assigned a streamer and all others will not.
Conversely, if you command-click, all markers
except the one you click will be assigned a
streamer.

Streamer Hints
Remember that marker names are displayed
onscreen for approximately 3 seconds before the
streamer. If your markers are closer than 3 seconds
to one another, they may overlap onscreen; that is,
the name of the second marker may be displayed
before the first marker’s streamer.

When the Video Time Piece displays the name of
the marker, it displays up to 20 characters. Names
longer than 20 characters will be cut off. So, you
may want to keep your marker names as short as
possible.
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DISPLAYING THE CONDUCTOR CRAWL LINE
Together, Performer and the Video Time Piece have
the ability to display a crawl line on the video
screen. A crawl line is a series of white “blips” that
travel across the video screen from right to left,
striking the left-hand side of the screen in time
with each beat of music in the Performer sequence.
The Conductor Crawl Line is useful for lining up
downbeats in your Performer sequence with hit
points on the video.

Performer triggers each beat in the Conductor
Crawl line when the Click feature in the Basics
menu is enabled. To set up the click feature:

1 Choose Click & Countoff Options from the
Basics menu.

If you do not want to hear the click, uncheck both
the Internal speaker and MIDI options.

2 If you do want to hear the click, check the option
you would like and, if necessary, enter the data for
the MIDI click.

Choose the Always click option.

3 Click OK to confirm your choices.

4 Select Click from the Basics menu to enable the
click.

The Click menu item will become checked.

To display the Conductor Crawl line:

1 Choose Video Time Piece from the Apple menu
to open the VTP DA.

2 Choose Video Setup from the VTP menu.

The Video Setup window will appear.

3 Check the Conductor option.

You can choose a clear or black background for it,
and you can adjust its position on the video screen
by dragging the crawl line display up or down in
the Video Setup window.

4 To turn off the Conductor Crawl Line, simply
uncheck the option or turn off Performer’s click.

CONVERTING A CLICKTRACK INTO A TEMPO
MAP
With the Video Time Piece, you can convert an
audio click track into a MIDI event. This allows you
to convert the click track into a tempo map in a
Performer sequences Conductor track. You can
even record the tempo map while Performers time
base is referenced to SMPTE time code, allowing
you to accurately synchronize a Performer
sequence to prerecorded music.

Before attempting to convert the click track into a
tempo map, make sure that the Video Time Piece is
successfully converting the audio click into MIDI
data and transmitting the data to Performer and
the Macintosh.

Verifying Incoming MIDI Clicks with the MIDI
Monitor
To verify incoming MIDI clicks from the Video
Time Piece:
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1 Make sure that an audio cable is plugged into the
CLICK IN phonejack on the rear panel of the
Video Time Piece.

2 Choose Video Time Piece from the Apple menu
to open theVTPDA.

3 Choose Set Click to MIDI from the VTP menu.

The Click to MIDI dialog box will appear.

Click data:Convert click to:
® Note
O Controller
O Hex

MIDI Click is On
Ooff

4 Choose the MIDI data type and parameters for
the MIDI click.

Most of the time, any event will do, such as a note
like C3.

5 Click OK to Confirm your choice.

6 Roll the tape.

When the CLICK light on the Video Time Piece
indicates that the click is being received, the
COMPUTER OUT LED should begin to blink,
indicating that the Video Time Piece is sending the
MIDI click event to the Macintosh and Performer.

7 Open Performer’s MIDI Monitor window.

8 A channel light (and cable light with the MTP)
will flash if the MIDI click is being successfully
received by Performer.

If none of the channel lights flash, check your
connections and try again.

Setting Up Tap Tempo
The next step is to set up the Tap Tempo options in
the Receive Sync dialog box.

1 Choose Receive Sync from the Basics menu and
select the Tap Tempo option.

2 Choose Video Time Piece from the device pop­
up menu.

3 Press the tab key to move to the Event parameter
and play in the MIDI click event by simply rolling
the tape.

Since you have already successfully set up the MIDI
click in the previous section, as soon as you roll the
tape, Performer will receive the MIDI click event
from the Video Time Piece and enter the proper
value in the Event box.

4 Type in the number of countoff beats.

Be sure to type in the same number of countoff
beats as there are on the click track on tape.

5 If you do not need to synchronize the sequence
containing the resulting tempo map to the tape
with the audio click track, choose the Internal
clock option.

6 If, later on, you will be synchronizing the
sequencing containing the resulting tempo map to
the tape with the audio click track, choose the
External time code option and check the Capture
start time box.

These options tell Performer to reference your
clicks to time code while it is recording the tempo
map. By doing so, Performer will then be able to
accurately synchronize the resulting tempo map
with the tape.

7 Click OK to confirm your choices.
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Checking Tap Tempo
Before recording anything, check to make sure
Performer will follow the MIDI clicks sent by the
Video Time Piece.

1 Choose Slave to external sync from the Basics
menu.

2 Press the Play button.

3 Roll the tape.

After a few bars or so of countoff click, the
sequence will begin to play back, following the
clicks on tape. If not, check the MIDI Monitor
window to make sure Performer is receiving the
MIDI click. Also check the Tap Tempo options in
the Receive Sync dialog.

4 Stop the tape and rewind it to the beginning of
the cue.

You are now ready to record the tempo map.

Recording theTempo Map
If you will be synchronizing the sequence
containing the new tempo map to the click track
using SMPTE time code, make sure that you:

■ already have SMPTE time code recorded on one
track and the click recorded on another

■ already have Performer and the Video Time
Piece set up for SMPTE synchronization such that
when you roll the tape, Performer is receiving both
the MIDI click and Direct Time Lock (or MIDI Time
Code) at the same time

■ have selected the External time code and Capture
start time options in the Receive Sync dialog box

Please note: if you want to be able to
synchronize the sequence to the click track via
SMPTE, it is absolutely necessary that Performer is
receiving both the MIDI click and either DTL or
MTC when you record the tempo map.

To record the tempo map:

1 Record-enable the Conductor track in the
Tracks window.

2 Press the Record button in the main transport
controls.

3 Roll the tape.

If you chose the Capture start time option and are
referenced to time code, Performer will remember
the exact SMPTE frame of the tap that is the first
downbeat and automatically remember to start the
sequence at that SMPTE frame when you lock the
sequence to SMPTE afterwards.

4 When you are finished recording, stop the tape.

Performer may take a few moments to process the
new tempo data.

You now have a new tempo map the matches the
click track on tape.

Locking the Recorded Tempo Map to Tape

If you recorded the tempo map referenced to time
code, you can now lock the sequence to tape. Just
choose the Direct Time Lock (or MIDI Time Code)
option in the Receive Sync dialog box, make sure
the Metronome is under Conductor track tempo
control, and roll the tape. The Capture start time
option automatically sets the Chunk SMPTE start
time, so the first downbeat of the sequence should
occur at exactly the first click downbeat (not
including countoffbeats, of course).

Preventing Dropouts While Slaved to SMPTE
The Video Time Piece has an adjustable
freewheeling feature. When a SMPTE reader such
as the Video Time Piece encounters a drop-out —a
series of missing or unreadable frames—in the
SMPTE time code, it “freewheels” past them,
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pretending that they were not missing and briefly
generating its own code to make up for the missing
frames.

Most converters will freewheel for only up to 3 or 4
frames. The Video Time Piece can freewheel from 0
frames up to 127 frames (over 4 seconds). This
allows it to maintain lockup with Performer over
even the most pernicious SMPTE drop outs.

If you encounter a time code drop out while slaving
Performer to tape with the Video Time Piece, try
increasing the freewheel amount in the Convert
SMPTE window. The default value is 4 frames. Try
adding a few frames at a time when adjusting the
amount.
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chapter 49 Using Performer With Unisyn

What is Unisyn?
Unisyn is Mark of the Unicorn’s state-of-the-art
editor librarian software. Unisyn provides you with
a complete MIDI sound management
environment, coupled with powerful tools for
creating and editing sounds.

How Are Unisyn and Performer Integrated?

Unisyn and Performer are both FreeMIDI
compatible applications. As a result, they are
integrated with one another through FreeMIDI in
the following ways:

■ FreeMIDI allows Performer to play back a
sequence in the background when you switch into
Unisyn under System 7 to audition patches, edit a
patch, or perform any other task in Unisyn.

■ While you are working in Unisyn, you can start,
stop, and cue a Performer sequence without ever
leaving Unisyn.

■ Unisyn keeps all of the FreeMIDI patch lists
completely up to date. In turn, FreeMIDI shares the
patch lists with Performer and all other FreeMIDI
compatible applications. These patch lists show up
through Performer, most notably in the Tracks
window default patch and current patch columns.

Integration Happens Automatically

With FreeMIDI installed in your system, all of the
integration features above happen automatically as
you use Performer and Unisyn. No additional
effort is required on your part.

SELECTING SOUNDS
With Performer and Unisyn working together, you
have many choices for how to select sounds in your
sequences. In general, they fall into two overall
approaches:

1. Using patch change events in Performer

2. Using Unisyn for sound management

These approaches are discussed in the following
sections. Which approach you will use depends on
how you work. These considerations are also
discussed.

USING PATCH CHANGE EVENTS IN
PERFORMER
One way to select sounds is to choose them by
name from Performers patch list pop-up menus.
For example, you can select a default patch for each
track in the Performer’s Tracks window. When you
play the sequence from the beginning, the default
patch gets transmitted to the synth to recall the
patch before music begins playing. You can also
insert (or record) patch change events in the
sequence’s tracks to change sounds during
playback.

The critical concept with this approach is that you
are dealing with MIDI patch change events, which
are MIDI events numbered from zero to 127.
Unisyn provides names so that you can
conveniently refer to them by name, rather than by
number.

When managing sounds in this fashion in
Performer, Unisyn serves two purposes:

1. To provide Performer with accurate names in the
patch lists—that is, names of patches that are
currently in the synth. For example, if you send a
bank to a synth from Unisyn, the patch names
from that bank will be displayed in Performer’s
patch lists. If you then send a different bank to the
synth, Unisyn updates Performer’s patch lists to the
patches in the new bank.



2. To save the current bank in each synth in a
performance so that this same bank can be
restored when you work on the sequence at a later
time.

If you don’t save the current banks as a
performance in Unisyn, you have no easy way to
restore the banks if you need to work on the
sequence at a later date. If you don’t restore the
patch banks, the patch lists in Performer may not
be the ones you originally used, and your default
patch selections, as well as patch changes you’ve
inserted in tracks, won’t recall the correct sounds.

Advantages
As you can see, the integrity of this approach
depends on having the correct banks of sounds
loaded in the synth. If you don’t change banks in
your synths, handling sounds in this manner works
very well, and the only role Unisyn plays is to
provide accurate patch lists. This is the easiest way
to handle sound selection because everything is
done in Performer alone. Once Unisyn has
provided the patch lists, you don’t even need to run
it when using Performer.

If you do change banks in your synths, this
approach still works fine. Be absolutely sure,
however, to save the banks to disk in Unisyn and
include them in the performance that you create for
the sequence. This technique is described further
in “Using Unisyn for General Sound Management”
on page 473.

Of course, if you know you’ll never be working on
the project again, and you will never need to recall
the sound setup, you certainly don’t need to save a
Unisyn performance.

Disadvantages

When you select a patch from Performer’s patch list
pop-up menu, sometimes what you selected won’t
be what you hear. This is because many synths have
more than one “mode”, e.g. “multi” and “voice” 

mode, which have a dramatic effect on what
happens when you send a patch change to the
synth from Performer. If the synth is not in the
right mode, you won’t get the patch you expect. You
must learn enough about your synths to choose the
necessary mode, either from its front panel
controls or by selecting the appropriate module in
Unisyn’s Modules window (depending on the
synth). Refer to the synth’s documentation for
clues.

Another drawback to this method is that for many
older synths, you are limited to the zero through
127 range of patch changes allowed by MIDI. On
the other hand, most newer synths support a
recently adopted MIDI usage called bank select,
which provides direct access to many more ROM
and RAM sounds. However, if a synth is more than
a few years old, it won’t support bank select. As a
result, you are forced to go through considerable
gymnastics in the synth to have access to all your
patches via MIDI patch change events.

If a synth has many ROM and RAM sounds, and it
doesn’t support bank select, you will have an easier
time selecting sounds for it with Unisyn rather
than with patch lists in Performer.

Patch Maps
Some synths, such as the E-mu Proteus, address the
128-patch limitation by providing a “patch map”
which lets you choose from a larger set of sounds.
However, Unisyn doesn’t take patch mapping into
consideration when providing patch lists to
Performer, so once again you are left with a
situation where the patch you select in Performer
won’t be the one you hear from the synth.

Unisyn usually sets up Performer’s patch list so that
the first patch in the list selects the first patch in
Unisyn’s bank window, the second selects the
second patch, etc. If your synth has a
programmable patch map, it should be
permanently set to correspond in this fashion. If 
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you need to access patches that are not available via
the program change table, use Unisyn to copy them
into RAM locations that are available via the
program change table. If you employ this
technique, the patch list in Performer should show
the correct name.

The E-mu Proteus 1,2, or 3 are exceptions.
Patch 0 in Performer’s patch list selects ROM preset
000. Patch 64 in Performer’s patch list selection
RAM preset 064, patch 65 selects RAM present
065, etc. (This exception does not apply to the
Proteus XR.)

Updating Unisyn
Unisyn keeps Performer completely updated as far
as what patches are available in your synths.
Performer’s patch menus should always reflect the
sounds currently available via patch changes sent
from Performer.

On the other hand, Performer doesn’t have the
same powerful features as Unisyn, so it cannot
automatically inform Unisyn if you select a
different patch from its patch list. If you make patch
selections in Performer and you want Unisyn to
know about them (such as to save them in a Unisyn
performance), use the Get Group/All Patches
command in Unisyn after you make the changes to
update Unisyn. If you select patches entirely in
Performer, however, there’s no need to update
Unisyn in this fashion, unless you need to edit a
patch.

USING UNISYN FOR GENERAL SOUND
MANAGEMENT
Beyond its integration with Performer, Unisyn has
many features of its own that serve as a powerful
compliment to Performer. By following the general
guidelines below, you can select all your sounds
and banks via Unisyn and then save them as a
Unisyn performance, which captures the entire
state of your MIDI setup for the Performer
sequence you are working on. You can even save the

Unisyn Performance directly in your Performer file
for easy recall the next time you begin work on the
sequence. Using this approach, you can rely on
Unisyn to handle most, if not all, of your sound
selection needs.

The tasks below involve basic Unisyn
procedures that you will become familiar with as
you learn Unisyn. They are explained in detail in
the Unisyn manual.

Storing a Unisyn performance into a Performer
file

Create your sequence in Performer, and use Unisyn
to select the desired banks and patches for the
sequence.

After you have set up your synths with the correct
banks, and you have selected all of the appropriate
sounds for the tracks in your sequence, go into
Unisyn and create a performance. If you are using
patch change events in the tracks of your sequence
to change patches during playback, or if you used
Performer’s “Default Patch” feature, be sure to
include the necessary banks with the performance.
This ensures that the synth will have the correct
bank of sounds the next time you work on the
sequence.

Once you’ve created the performance, you have
two choices for saving it:

■ Save it in the usual fashion in Unisyn with the
Save Performance command.

■ Load it into the Performer file to save it directly
in the Performer file.

This second option is good because it saves you the
trouble of keeping track of a separate Unisyn
performance document on your hard drive.
Instead, the performance becomes part of the
Performer file instead. The next time you open the
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Performer file, you can just run Unisyn in the
background and reload the performance from
within the Performer file.

Loading the performance into Performer

You need to be running Unisyn 1.5 or later and
Performer 6 or later at the same time to do this.

Once you’ve created the Unisyn performance as
described earlier, switch into Performer and
choose Unisyn Performance>Store into 'filename'
from the File menu as shown below in Figure 49-1.

File
New 3€N
Open... ►
Load...

Close 'My PerFormer File* 036111
Saue
Saue FIs...
Revert to Saved
Saue Rs ’New’ Template

UnKyn Performance ► Store into Mij Performer File f

Page Setup...
Print Window... %P

Preferences...
Data Display Preferences...

Quit 38 Q 

Figure 49-1: Saving a Unisyn performance in a Performer file.

Recalling the performance at a later time

To recall the performance at a later time, run
Unisyn and Performer at the same time. Open the
Performer file in which you stored the
performance, and choose Unisyn Perfor-
mance>Load  from filename’from the File menu. In
doing so, you restore all of the settings and sounds
in your MIDI gear to the state they were in when
you originally saved the performance.

Advantages
Using Unisyn gives you many powerful
capabilities, such as patch editing, sound libraries,
and more. In terms of sound selection, you get the
best of both worlds: you can select sounds using
both Performer’s patch changes and Unisyn’s
sound management features. However, you need to
decide how you are going to choose default patches

for each track: either by using Performer’s default
patch feature (in the Tracks window) or by saving
patches for Unisyn’s modules in a Unisyn
performance file. You may find that the decision
differs for each synth and depends on how you use
the synth.

By using Unisyn’s libraries and powerful searching
features, you potentially have thousands of sounds
at your fingertips, as opposed to the restricted
0-127 range imposed by MIDI patch changes.

Another great advantage is that you can easily
incorporate Unisyn’s patch editing capabilities into
your sequencing. Does that bass patch need more
snap in the attack? Just open Unisyn’s Patch Edit
window and tweak away. You can even do so while
the sequence is playing.

Disadvantages

The only (small) price you pay for using Unisyn to
its fullest potential with Performer is the slight bit
of extra overhead in dealing with two programs at a
time.
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HOW UNISYN SHARES PATCH LISTS WITH
PERFORMER
When you are running Unisyn 1.5 or higher with
Performer 6 or higher, Unisyn automatically
supplies Performer with accurate, up-to-date patch
lists in Performer’s patch selection menus. Here’s
how it works.

As you sequence in Performer, you can switch to
Unisyn to edit or create patches, store them in
Unisyn’s internal bank for the device (make sure
Auto Bank Update is enabled for the device in
Unisyn's Device Setup), switch back to Performer
and immediately access the patches by name via
the Performer’s FreeMIDI-supplied patch menus.

Unisyn uses the factory default patch lists supplied
by FreeMIDI, leaving the ROM bank lists as is and
updating the RAM bank lists as you modify them
in Unisyn. If the instrument employs some sort of
bank select message scheme for choosing patches
from multiple banks of sounds, Unisyn manages all
of the bank select messages for you. You just choose
them by name in Performer and let Unisyn do the
rest.

Unisyn first engages with the FreeMIDI patch lists
for a device when Unisyn launches for the first time
under FreeMIDI. It will also do so when you
modify Unisyn’s Device Setup or if you add a new
device in FreeMIDI Setup. In either case, Unisyn
automatically maps one of its currently un­
mapped devices to the new FreeMIDI device.

Unisyn updates Performer’s patch lists when you
successfully Send Bank or Get Bank. It also updates
them when you store a patch into a bank
designated as the internal bank for a device, as long
as the Auto Bank Update option is enabled for the
device in Unisyn’s Device Setup dialog. (The
internal bank for a device has a diamond in title of
its bank window.)

If a FreeMIDI device has no factory default patch
lists—or they are missing for some reason, Unisyn
creates its own lists.

Unisyn and its profiles don’t currently deal with the
program change tables or “patch maps” used by
some older devices.

TROUBLESHOOTING
Here are a few common problems you might
encounter.

You get a “Not enough memory” message when
you try to run both Performer and Unisyn at the
same time.
Cause: There isn’t enough free RAM (random
access memory) in your computer to support the
memory requirements of both applications at the
same time. Solution: Make sure there no other
applications running. Try restarting the computer
and launching them again. If you still don’t have
enough memory, you may need to get a memory
upgrade. Contact Mark of the Unicorn technical
support.

You select a patch in Performer’s patch list, but
you don’t hear the correct sound on the synth.
Cause: There could be many causes for this. One
possibility is that the synth is in a mode that causes
it to respond to your patch change differently than
by calling up a sound. In this case, try switching
into Unisyn and selecting a different module for
the synth. Also, check the MIDI channel of the
device for the patch list. Is the device perhaps
transmitting on a channel that the synth isn’t set to
receive patch changes on? Also, have you changed
the patch map in the synth? If so, read “Patch
Maps” on page 472.

You hear a pause during Performer’s playback.
If Performer is playing back when you switch
between Unisyn and Performer, you will hear a
brief pause in Performer’s playback. Also, if you
send a bank or other data intensive operation in
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Unisyn while Performer is playing in the
background, this can also stop playback
momentarily.

You make a change to a patch in a bank in Unisyn,
but the change is not reflected in Performer’s
patch list.
Under some circumstances, changes you make to
an individual patch in the synth’s current bank in
Unisyn will not be immediately reflected in
Performer’s patch list. This includes things like
changing a patch name, moving it to a different
location in the bank, adding a new patch to the
bank, etc. To bring Performer’s patch list up to date,
use the Send Bank command in Unisyn’s MIDI
menu, which will update Performer’s patch list.
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chapter so MIDI Utilities

INTERFACE SETTINGS
The Interface Settings command in the Basics menu
allows you to set the communication speed
between Performer (actually FreeMIDI) and other
MIDI hardware and software. Use the Interface
Settings command to open the Interface Settings
dialog box. This dialog box allows you to enable
and disable the two serial ports for MIDI. If, for
instance, you have a printer attached to the Thru
port of your MTPII and the MTPII is connected to
the Printer serial port, you will need to disable
MIDI on the printer port in order to do any
printing.

EDIT FREEMIDI CONFIGURATION
The Edit FreeMIDI Configuration command in the
Basics menu opens the FreeMIDI Setup program.
Doing so lets you add, remove, and modify devices
in your FreeMIDI setup. Use this command when
you would like to make changes to the device list
pop-up menus that appear throughout Performer.

FREEMIDI SYNC
The FreeMIDI Sync command in the Basics menu,
when checked, causes all FreeMIDI programs that
are currently running to play, stop, rewind, and
locate together. When you enable it in Performer, it
automatically gets enabled in all other FreeMIDI
programs, too. Conversely, if you enable it in any
other FreeMIDI program, it gets enabled in
Performer automatically. When it is checked, it is
enabled; when it is unchecked, it is disabled. For
complete information about this command, refer
to “The Transport Controls” on page 494.

PANIC
The Panic command in the Basics menu sends an
All Notes Off MIDI message and then a note off
MIDI message for every MIDI note on every 

possible MIDI channel on every MIDI output cable
on both serial ports. It also resets MIDI buffers in
FreeMIDI software. This command can take quite
a while. If you wish to stop the operation, type
command-period on your Mac keyboard.

PREFERENCES
The Preferences command in the File menu gives
you several choices for various features in
Performer.

Startup options
© New file
O “Open..." dialog
O None

Default Editing Window
MIDI Tracks Conductor Track
© Event List © Event List
O Graphic Editing O Graphic Editing
O Notation Editing

Other
® Auto fix-up partial measures

Audio Tracks
O Event List
© Graphic Editing

V.

Start-up options
Choose how you would like Performer to open
when you first launch the application. Performer
can do one of three things: 

■ Open a new file.

■ Present you with the Open file dialog box.

■ Neither of the above. In this case, no window or
dialog box appears. Instead, Performer’s menu bar
appears at the top of the screen, and the only menu
available is the File menu, from which you can
choose New or Open.
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Default Editing Window

This setting determines what edit window you get
when you double-click a track (Event List, Graphic
Editing window, Notation Editing window, or
QuickScribe notation window). In addition to
double-clicking a track, you have the following
other choices:

Action What it opens

Double-click Opens whatever edit window
you’ve chosen in the Prefer­
ences command (the Event List
by default)

Option double-click Event List

Command double-click Graphic Editing window

Control double-click QuickScribe Notation window

Control-option double-click Notation Editing window

Settings in the Preferences window are stored in the
Performer Preferences file, which is automatically
created in the Preferences Folder in the System
Folder. They are global settings and affect all files.

Auto fix-up partial measures

A partial measure is a bar that does not have a
complete set of beats in it as determined by the
current meter. Partial measures can be created in
Performer by inserting a Meter Change event in the
middle of a measure. Since meter change events
always start a new measure, a meter change event
truncates any measure if it is inserted in the middle
of the measure. This is a powerful feature of
Performer, especially handy when scoring music to
picture because you can start a new measure at any
SMPTE frame.

If the Auto fix-up partial measures is turned on
(checked), and you open a Performer file that has
partial measures, it will automatically get rid of the
partial measures by moving meter changes as
needed to do so. After the file opens, you should
check to see if your MIDI data still lines up with all 

the barlines the way you want, and make
adjustments with the Change Meter and/or Shift
features as desired. If you want to get rid of partial
measures in your files, leave this option turned on.
If you want to preserver partial measures in a file,
uncheck this option before opening the file. Don’t
worry, however: Performer presents an alert before
it corrects partial measures so that you can Revert
to Saved if you decide not to do so.

DATA DISPLAY PREFERENCES
The Data Display Preferences command in the File
menu gives you several choices for how to display
information in Performer.

Data Display Preferences
.... .. ■ -

Pitch Display
© Standard pitch (middle C = ’C3')
O Alternate pitch (middle C = 'C4’)
O MIDI key number (middle C “ *60‘)

Tempo Display
® Beats per minute (120 bpm «= ’120W)
O Frame click with slash (120 bpm = T 2/00
O Frame click with dash (120 bpm = ' 12-0)

Pitch Representation
Lets you choose how note octaves are numbered.
Also lets you control how pitches are displayed.
Your choices are by note spelling/octave (C3) or by
MIDI note number (60).

Tempo Display
Performer can display tempos throughout the
program in beats per minute or in clicks per frame
(i.e. “frame clicks”). Frame click tempos can be
displayed with either a slash (/) or a dash (-).
Regardless of how the tempos are displayed, you
can type them in using either format.
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chapter 51 FreeMIDI Setup

This chapter explains all the major functions of the
FreeMIDI Setup application.

FreeMIDI Setup is the application that you use to
edit your FreeMIDI configuration or FreeMIDI
System Preferences. It is the application that is
launched or switched to when the Edit FreeMIDI
Configuration command is chosen in FreeMIDI-
compatible applications such as Performer,
Mosaic, or Unisyn. In FreeMIDI Setup, you can
edit the properties and connections of devices as
well as the various settings in the FreeMIDI
System, such as Inter-application MIDI and
Monitor Patch Changes. You can view the current
patch list for a device in a pop-up menu. You can
control the Transport functions of a FreeMIDI
sequencer, such as Performer. You can also use
FreeMIDI Setup to test your studio connections.

The Current FreeMIDI Configuration

There is no need to make a FreeMIDI
configuration “current”. The configuration that is
visible in the FreeMIDI Configuration window is
the current configuration that all FreeMIDI
applications will use. Whenever you launch
FreeMIDI Setup to view or edit your FreeMIDI
configuration, the configuration document with
which you were last working is opened automati­
cally. If you do not launch FreeMIDI Setup, other
FreeMIDI applications will be using the FreeMIDI
configuration that was last opened in FreeMIDI
setup.

If you open a new or existing configuration, it will
immediately become the current configuration
that all FreeMIDI applications will use.

See “Working with FreeMIDI Configurations” on
page 490 for information on working with multiple
FreeMIDI configurations.

FREEMIDI PREFERENCES
The FreeMIDI Preferences dialog box is where you
tell FreeMIDI which serial ports you will be using
for MIDI, whether you want to use Inter­
application MIDI, whether FreeMIDI should
monitor patch changes and whether FreeMIDI
should allow non-FreeMIDI applications to use the
serial ports for MIDI. See “Launching FreeMIDI
Setup” on page 31 of the Getting Started booklet for
more information on FreeMIDI Preferences.

QUICK SETUP
Use the Quick Setup command to add and delete
devices from your FreeMIDI configuration. This
command is especially good to use when you need
to add or delete more than one device from your
configuration. Quick Setup can also shorten the
process of connecting devices to interfaces, since
the connections can be specified before the devices
appear in the FreeMIDI Configuration window
and then automatically appear when the setup is
completed.

Auto Config

The Quick Setup dialog box contains an Auto
Config push button which opens the Auto Config
dialog box. Auto Config can automatically find
many of the MIDI devices in your MIDI studio. See
“Configuring Your studio automatically” on
page 33 of the Getting Started booklet for
information on using Auto Config to configure
FreeMIDI for your studio.



482 

Using Quick Setup to Add FreeMIDI Devices
To use Quick Setup to add devices:

1 Choose Quick Setup from the Configuration
menu.

The Quick Setup dialog box appears.

cz^n
Chcktnj » d«v4c* tn th* ‘Current
Confiyjrittcn* list dtfpUys Its tnfcrm*ttcn
*Sav». To »dlt tht* tnfcrm*tion, first
rtmov* th» device tnd r*-*dd tt.

Figure 51-1: Quick Setup Dialog Box.

This dialog box contains a list of all the MIDI
devices that are contained in your current
FreeMIDI configuration on the right side under the
label Current Configuration.

2 Select the correct manufacturer, model, studio
location and cable (if applicable) from the pop-up
menus on the left and then click Add.

If the pop-up menus do not contain a description
of a particular device, choose Other and click Add.
We will see how you can re-name and re-define
these devices later in this manual. For now they will
be called by the default name Device-1 for the first
such device, Device-2 for the next and so on. If you
accidentally add a device to the list that you do not
want to appear in your studio configuration, select
its name from the list on the left and click Remove.

3 When you have added all the devices to the list
that you wish to add to your studio configuration,
click Done.

New Deulce:
Monufocturer________
[ Vomatio ▼ |
Model:______________
| 76100 -r~|
Studio Locotlon:_______
| Mini Time Piece I..7~|

Coble: | 1 v |

The FreeMIDI Configuration window will appear
containing all of the MIDI devices defined in the
Quick Setup dialog box and their connections.

Figure 51 -2: FreeMIDI Configuration Window.

Using Quick Setup to Remove FreeMIDI
Devices
To use Quick Setup to remove devices:

1 Choose Quick Setup from the Configuration
menu.

The Quick Setup dialog box appears.

2 Select the device or devices you wish to remove
from the Current Configuration list and click
Remove.

The selected devices will disappear from the list.

FREEMIDI SETUP |



3 When you have finished removing devices, click
Done to close the Quick Setup dialog box.

The FreeMIDI Configuration window will appear
containing all of the MIDI devices defined in the
Quick Setup dialog box and their connections,
minus the devices which were removed.

THE FREEMIDI CONFIGURATION WINDOW
This window is where you edit your FreeMIDI
Configuration. It is the window that will appear
when you choose the Edit FreeMIDI Configuration
command in other FreeMIDI applications such as
Performer, Mosaic, and Unisyn.

This window contains a graphical representation of
your MIDI studio. It contains MIDI interfaces,
FreeMIDI devices, interface-to-device connections
and an Info Bar.

Use the title bar of the window to move it as with
any standard Macintosh window. Use the
horizontal and vertical scroll bars to view portions
of the window not currently visible as with any
standard Mac window. Use the Zoom button to
toggle the window between full size and its current
state. Use the grow handle to change the size or
shape of the window.

MIDI interface
input & output

Information about
the currently

Selected
Device

Figure 51-3: FreeMIDI Configuration Window.

In the FreeMIDI Configuration window, you can
view, edit, and rearrange your FreeMIDI
configuration in most any way that you like.

The FreeMIDI Configuration window shows your
current configuration. You can make any other
previously saved configuration the current
configuration simply by opening it.

Use the Quick Setup command along with the Auto
Config command to quickly set up a configuration
that matches your MIDI studio. For more
information, see “Configuring Your studio
automatically” on page 33 of the Getting Started
booklet.

Editing Device Info in the FreeMIDI
Configuration Window

You can edit some of the properties of devices that
appear in your FreeMIDI configuration directly in
the FreeMIDI Configuration window. The
properties that you can change are the
manufacturer name, model name, device ID,
device name, and MIDI transmit and receive
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channels. See “Editing FreeMIDI Devices” on
page 485 in this chapter for information on editing
all the properties of FreeMIDI devices.

To quickly change the manufacturer, model, device
ID or MIDI channel for a device:

1 Select the device you wish to edit by clicking its
icon.

It’s device info appears in the info bar near the top
of the window.

Figure 51-4: FreeMIDI Configuration window Info Bar.

2 Select a new manufacturer or model name from
the appropriate pop-up menus.

MHHUFfiCTURER MODEL ID TRAMS. CH fiEC. CH

Kurzweil ▼ K2000 ▼ 0 1-16 1-16

Unless you want to leave the model name blank,
you will need to change the model name for a
device if you change its manufacturer.

Other
360 Systems
ADA Signal Processors
Adams-Smith
Akai
AKO Acoustics
Alesis
ART
Baldwin
Casio
Clarity
JL Cooper
Digitech
Digital Music Corp.
DOD Electronics

Eventide
Fender
Fostex
OeneralMusio
IVL Technologies

Other
EPS
ESQ-1
ESQ-M
Miraoe

Other
Emulator
Procussion
Proteus/1
Proteus/1 XR

SD-1 Proteus/2
✓ SQ-80

SQ-1
SQ-1 Plus
SQ-2
SQ-R
VFX
VFXSD
VFX SD Version II

✓ Proteus/2 XR
Proteus/3
Proteus/3 XR
Proteus/MPS
Vintage Keys

Figure 51 -5: Pop-up menus in Info Bar.

3 Enter new device ID or MIDI transmit and
receive channels numbers in the appropriate text
entry box(es).

If you would like to enter consecutive MIDI
channel numbers, enter the numbers like this: 1-8.
If you would like to enter non-consecutive
numbers, enter the numbers like this: 1,3,5,7,10.

Editing FreeMIDI Configurations

You can add, delete, edit, rename, duplicate,
connect, disconnect, and rearrange FreeMIDI
devices in the FreeMIDI Configuration window.
Use the techniques below to add and remove
devices from your FreeMIDI configuration if you
only need to add or remove one device at a time.
Otherwise, it is usually easier to use the Quick
Setup command to add or remove multiple
devices. See “Using Quick Setup to Add FreeMIDI
Devices” on page 482 in this chapter for more
information on using the Quick Setup command.

See “Working with FreeMIDI Configurations” on
page 490 in this chapter for information on
working with multiple FreeMIDI configurations.

Adding FreeMIDI Devices

To add a single FreeMIDI device to your configu­
ration:

1 Choose Create Device from the Configuration
menu or type command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box
appears. If you do not wish to add a device at this
time, click Cancel and the FreeMIDI Configuration
window reappears.

FreeMIDI Deulce Specification I •

Manufacturer:__________ Model:
| Entonlq V I I EPS-M

(1-161

innra tps-M

Figure 51 -6: FreeMIDI Device Specification Dialog Box.

2 Select a manufacturer and model from the pop­
up menus.
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Steps 2-7 below are optional. FreeMIDI ships with
default settings for each device in it’s model list.
These default settings appear when you select a
specific model from the model pop-up menu. If
you would like to change any of the settings such as
the device name, ID, properties, MIDI channels or
icon, proceed to steps 2-7 below. Otherwise, click
OK and the new device will appear at the top of
FreeMIDI Configuration window.

3 Enter a name for the device by typing the name
into the name text box.

4 Set a device ID number by entering a new
number in the Device ID text box.

5 Select up to eight different Properties for the
device by selecting properties from the Properties
pop-up menu.

For more information, see “Device Properties” on
page 497.

6 Set transmit and receive channels for the device,
by clicking the appropriate box(es) below the MIDI
channel numbers that are displayed.

It is very important to set the MIDI channel
information correctly, since this controls the
amount of channels that appear for the device in
other FreeMIDI applications such as Performer.

7 Select an icon to represent the device in the
FreeMIDI Configuration window.

Click Icons and scroll until the icon that you wish to
use is displayed in the middle, bordered field and
click OK. For information on entering your own
icons into FreeMIDI, see chapter 54,“Editing
FreeMIDI Device Files”.

8 Indicate the studio location of the device by
selecting the appropriate MIDI interface and cable
number from the pop-up menus provided.

If you don’t have a multi-port MIDI interface like
the MIDI Time Piece II or MIDI Express, the cable
pop-up menu will not be available.

Removing FreeMIDI Devices

To remove FreeMIDI devices from your configu­
ration:

1 Select the device you wish to remove by clicking
its icon. Shift-click device icons to select more than
one device.

2 Type backspace or delete on your Mac keyboard
or choose Cut or Clear from the Edit menu or type
command-X or command-B on your Mac
keyboard.

Any of these commands removes the selected
devices.

3 If you remove the wrong devices, choose Undo
from the Edit menu and try again.

Editing FreeMIDI Devices

Once FreeMIDI devices are defined and appear in
your FreeMIDI configuration, you can change any
of their properties with the FreeMIDI Device
Specification dialog box.

To edit a FreeMIDI device:

1 Double-click the device you wish to edit.
Alternately, select the device and choose Edit
Device from the Configuration menu or type
command-E on your Mac keyboard.

The FreeMIDI Device Specification dialog box
appears. If you select more than one device in the
FreeMIDI Configuration window, the Edit Device
menu item becomes grayed-out (disabled) since
you can only edit the properties of one FreeMIDI
device at a time.

_______________________ ____________ ________ _______________________________________________ I 485
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rrecMIDI Deulco Specification

Manufacturer Model:
| Poland | JO-990

Transmit Channels:
1 2 3 4 5 6 7 8 9 ton 12 1314 1516

I H ; i 'I I ! '1 II I I I I I I
flecelue Channels:

1 2 3 4 5 6 7 0 9 1011 12 13141516
1 ; I I I T~1

Properties: [ Dank Select Ctrl 0 |

Figure 51-7: FreeMIDI Device Specification Dialog Box.

2 Make the changes you desire and click OK or
click Cancel to cancel the edit operation.

See “Adding FreeMIDI Devices” on page 484 in
this chapter for information on the various
properties you can edit in this dialog box.

Naming FreeMIDI Devices

When devices are added to your FreeMIDI
configuration using Quick Setup and Auto Config,
they are given default names that correspond to
their model names. You can easily rename these
devices if you wish. See “Editing FreeMIDI
Devices” on page 485 in this chapter for
information on one method of changing the name
of any existing FreeMIDI device with the FreeMIDI
Device Specification dialog box.

An even easier way to change a FreeMIDI device
name follows:

1 Select the device by clicking its icon.

You can skip step 2 below by clicking the device’s
name directly. The mouse cursor will change to the
text insertion I-beam to indicate that it is in text
entry mode.

2 Type the Return or Enter key on your Mac
keyboard.

3 Enter a new name for the device.

4 Type the Return or Enter key on your Mac
keyboard to confirm your choice. Alternately, you
can click anywhere in a blank part of the FreeMIDI
Configuration window to confirm the new name.

5 If you enter the wrong name, choose Undo
Rename from the Edit menu and try again.

;-r For users familiar with System 7, FreeMIDI’s
naming convention is identical to naming icons in
the Finder.

Selecting FreeMIDI Devices

To select a FreeMIDI device in the FreeMIDI
Configuration window, click its icon. To select
more than one FreeMIDI device, shift-click each
icon. To deselect a previously selected FreeMIDI
device, shift-click its icon. To deselect all selected
FreeMIDI devices, click in a blank area of the
FreeMIDI Configuration window.

Duplicating FreeMIDI Devices

You can make copies of FreeMIDI devices in two
ways. Using the Copy or Cut command along with
the Paste command, you can make copies of
devices to paste into other FreeMIDI configura­
tions. Using the Duplicate command, you can
make copies of devices in the current FreeMIDI
configuration with one command.

To copy or cut and then paste devices:

1 Select the device you wish to copy or cut by
clicking its icon. Shift-click device icons to select
more than one device.

2 Choose Copy or Cut from the Edit menu.
Alternately, you can type command-C for Copy
and command-X for Cut on your Mac keyboard.

Copy makes a copy of the selected items and places
it on the clipboard for pasting. Cut makes a copy of
the selected items and places it on the clipboard for
pasting and removes the original selection.
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3 (Optional) If you wish to paste the devices into a
different FreeMIDI configuration,close the current
configuration and open a new or existing
configuration.

For info on opening new and existing configura­
tions see “Opening Existing FreeMIDI Configura­
tions” on page 491 and “Creating a New FreeMIDI
Configuration” on page 491 in this chapter.

4 Choose Paste from the Edit menu. Alternately,
you can type command-V on your Mac keyboard.

The pasted devices will appear in some blank
portion of the FreeMIDI Configuration window.

To duplicate devices:

1 Select the device you wish to duplicate by
clicking its icon. Shift-click device icons to select
more than one device.

2 Choose Duplicate from the Edit menu.
Alternately, you can type command-D on your
Mac keyboard.

The duplicated devices will appear in some blank
portion of the FreeMIDI Configuration window.

Connecting Devices to Interfaces

Once you have added a FreeMIDI device to your
FreeMIDI configuration, you need to connect its
inputs and outputs to an interface in your configu­
ration. FreeMIDI is unable to send or receive MIDI
to or from the device unless it is connected to an
interface. FreeMIDI does not require that the input
and output cable of a device be the same number,
but, in most cases, setting up your studio this way
may be more organized and simpler to understand.

** Outputs are represented by small triangles
that are located on either side of devices and
interface ports. Inputs are represented by small
green triangles and outputs are represented by red
triangles.

I FREEMIDI SETUP

To connect a device output to an interface:

1 Drag a “patch cord” from the output of a device
to an input on an interface.

,5____ MTP AV Modem
Proteus/! I_____ qj

When you release the mouse, the connection will
appear. If you have a multi-cable interface such as
the MTP II or MIDI Express, be sure to connect the
device output to the input to which the device is
physically connected. If you are using both the
modem and printer serial ports, be sure to connect
the device output to the input on the interface on
the serial port to which the device is physically
connected.

MTP AV. Modem— $------------ ■. |f
Proteus/1 I p.Qj

Alternately, you can drag the “patch cord” from the
input of an interface to an output on the device.

2 If you connect the wrong ports for a device,
choose Undo Drag from the Edit menu and try
again.

To connect a device input to an interface:

1 Drag a“patch cord” from the input of a device to
an output on an interface.

When you release the mouse the connection will
appear. If you have a multi-cable interface such as
the MTP II or MIDI Express, be sure to connect the
device output to the input to which the device is
physically connected. If you are using both the
modem and printer serial ports, be sure to connect
the device output to the input on the interface on
the serial port to which the device is physically
connected.
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Alternately, you can drag the “patch cord” from the
output of an interface to an input on the device.

2 If you connect the wrong ports for a device,
choose Undo Drag from the Edit menu and try
again.

Making MIDI Thru Connections
When more than one MIDI device shares a single
output port from a MIDI interface, you need to
connect the MIDI Thru port of the device to the
input of the other device. This mirrors the physical
connection that you should have between the
devices.

Figure 51 -8: MIDI Thru Connection.

Making Multiple MIDI Input Connections

FreeMIDI Setup allows you to connect more than
one MIDI output from a device to a single MIDI
input on an interface. When you make such a
connection, you are telling FreeMIDI that both
devices’ MIDI outputs are connected to a single
MIDI input on an interface. Without some type of
MIDI merger, this type of connection is not
possible.

Connecting Devices to other Devices
FreeMIDI Setup allows one connection per port
(input output, or thru) on each device. You cannot
connect devices to each other except from MIDI
Thru to MIDI In of a separate device. If you would
like to make such connections, use the Cable
Routing (on MIDI Time Piece and MIDI Express
interfaces) or similar features in your MIDI
interface or MIDI patch bay/merger gear.

Removing Device Connections
Once you have made connections between devices
and interfaces, you can remove the connections to
make different connections if you physically
change the connections in your MIDI studio.

To remove FreeMIDI device connections:

1 Click at the intersection of the Device port and
the patch cord and drag the connection away from
the device and then release the mouse.

The connection is broken.

Figure 51-9: Breaking a Connection.

An alternate way to remove FreeMIDI device
connections follows:

1 Select a connection by clicking it. Shift-click
connections to make multiple selections
simultaneously.

When a connection is selected, it appears as a
thicker, heavier line. To deselect a connection, click
somewhere in a blank area of the FreeMIDI
Configuration window.

Figure 51-10: Selecting a Connection.

2 Type backspace or delete on your Mac keyboard
or choose Cut or Copy from the Edit menu or type
command-X or command-B on your Mac
keyboard.

Any of these commands will remove the selected
connections.
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3 If you remove the wrong connections, choose
Undo from the Edit menu and try again.

Arranging the FreeMIDI Configuration window

You can arrange the FreeMIDI Configuration
window any way you like. We suggest that you drag
device icons so that they appear as they do in your
studio. For instance, you can arrange all the
modules that are in a rack to the left of your Mac to
the left side of the window and place all the
modules that are in a rack to the right of your Mac
to the right side of the window. You can drag the
patch cords, which connect the devices to the
interfaces, up or down so that you can view the
connections clearly. You can drag MIDI ports in a
multi-cable interface, such as the MTP, MTPII or
MIDI Express, up or down to create more or less
space between them. You can delete input or output
cables, which are not part of your studio setup, by
clicking the patch cord to select it and typing the
backspace or delete key on your Mac keyboard.
You can also make and break connections by just
dragging the ends of the patch cords. You can use
the different options in the Views menu to change
the size of the icons and to view input and outputs
separately or together.

% MTP AV Modem
Prottus/1 II ■ g

Figure 51-11: When you arrange device icons in the window,you can
also adjust the positions of the connections by dragging them
horizontally and vertically.

The Clean Up Window Command

You can use the Clean Up Window command in the
Views menu to quickly arrange all the devices in
the window into uniform columns.

Updating Interfaces

Interfaces are an important part of the FreeMIDI
Configuration. They appear automatically when
FreeMIDI scans the serial ports for MIDI
interfaces. This happens the first time you set the
FreeMIDI System Preferences to access one or both 

serial ports for MIDI. You can use the Update
Interfaces command in the Configuration menu to
have FreeMIDI check for MIDI interfaces that you
may have installed or powered on after originally
setting the Preferences file.

To do so:

1 Choose Update Interfaces from the
Configuration menu

The Update Interfaces dialog box appears.

Serial Ports: Current Interface:
Modem
Printer

( Scan ] | MIDI Express
( Scan )[~ None

To find interfaces automatically, press the Scan button next to the desired
port. For interfaces that are presently off-line, you may choose an option
from the popup menus on the right, but you must then use the Interface
Settings dialog so FreeMIDI can communicate with the interface(s). Press
OK when the interfaces listed are correct.

Figure 51-12: Update Interfaces dialog box.

2 Click the Scan button for the Serial port(s) you
wish FreeMIDI to search for interfaces and click
OK.

Interfaces that FreeMIDI finds will appear in the
FreeMIDI Configuration window.

Adding Interfaces

You can use the Update Interfaces command in the
Configuration menu to add MIDI interfaces that
may currently be off-line (powered off or
disconnected) to the current FreeMIDI configu­
ration.

To do so:

1 Choose Update Interfaces from the
Configuration menu.

The Update Interfaces dialog box appears. See
Figure 51-12 above.
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2 Select the interface you require from the pop-up
menus and click OK.

The interfaces are added to your FreeMIDI config­
uration.

3 Choose Interface Settings from the MIDI menu.

This step is essential to ensure that FreeMIDI can
communicate with the newly-added interface(s).
The Interface Settings dialog box appears.

Figure 51-13: Interface Settings dialog box.

4 Select the appropriate settings for the
interface(s) you have added and click OK.

Moving FreeMIDI Interfaces

To move a FreeMIDI interface, drag its icon to the
desired position. Choose Undo Drag command
from the Edit menu to return the device icon to its
original position.

You can drag the input/output ports of a MIDI
interface up and down to make more room
between each port by dragging the port number
icon that you wish to move. Choose Undo Drag
command from the Edit menu to return the port
number icon to its original position.

Figure 51-14: Moving interface ports vertically.

Editing FreeMIDI Interface Names

After a FreeMIDI interface appears in the
FreeMIDI Configuration window, you can change
its name. To do so:

1 Select the FreeMIDI interface you wish to edit
by clicking its icon.

It’s info appears in the info bar. If you clicked the
interface icon’s name, the mouse cursor changes to
a text insertion I-beam and you can enter a new
name by just typing. If you did not click the icon
name, you can still edit the name by typing the
Return key on your Mac keyboard and the name
will pop-up for editing and the mouse cursor
changes to a text insertion I-beam when it is over
the icon name. If you are familiar with System 7,
this naming convention works identically to the
Finder in System 7.

WORKING WITH FREEMIDI
CONFIGURATIONS
We call the documents created by the FreeMIDI
Setup application “FreeMIDI configurations”.
When FreeMIDI Setup is open, the FreeMIDI
Setup document that is currently open and whose
FreeMIDI configuration is visible in the FreeMIDI
Configuration window is the current configuration
that all FreeMIDI applications use. Whenever you
launch FreeMIDI Setup to view or edit your
FreeMIDI configuration, the configuration
document with which you were last working is
opened automatically. If you do not launch
FreeMIDI Setup, other FreeMIDI applications use
the FreeMIDI configuration that was last opened in
FreeMIDI Setup.
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If you open a new or existing configuration, it will
immediately become the current configuration
that all FreeMIDI applications use.

Creating a New FreeMIDI Configuration

Although only one FreeMIDI configuration can be
current or active at a time, you can create as many
FreeMIDI configurations as you like. Once you
have created a FreeMIDI configuration for your
own MIDI studio, you might want to create a
FreeMIDI configuration for another studio that
you might be working at in the future or you might
want to create several variations of your home
studio for different situations.

To create a new FreeMIDI configuration:

1 If you have not done so already, open FreeMIDI
Setup by double-clicking its icon in the Finder.
Alternately, you can open FreeMIDI setup by
choosing the Edit FreeMIDI Configuration
command in any other FreeMIDI application.

The FreeMIDI Configuration window opens and
displays the current FreeMIDI configuration.

2 Choose New from the File menu or type
command-N on your Mac keyboard.

If you have made changes to the current
configuration and have not yet saved them,
FreeMIDI Setup will ask if you would like to save
these changes before the new configuration opens.

3 The Update Interfaces dialog box appears.

This dialog is shown in Figure 51-21 on page 497.

4 If you have an interface connected, click Scan on
the port it is connected to.

5 If you don’t have an interface connected at the
moment, choose an interface from the pop-up
menu and click OK.

You now see a new, window with the interface you
just found (or chose by hand).

Figure 51-15: New FreeMIDI Configuration.
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6 Use Quick Setup or Auto Config to add and
connect devices to the interface in this new
FreeMIDI configuration. Alternately, you can add
devices to the configuration individually by
choosing Create Device from the Configuration
menu.

For more information on adding and connecting
devices in this new FreeMIDI configuration, see
“Quick Setup” on page 481, “Auto Config” on
page 481, and “Editing FreeMIDI Configurations”
on page 484 in this chapter.

You now have a FreeMIDI configuration that can
be used in the studio for which it was designed. See
“Saving FreeMIDI Configurations” on page 492 for
information on how to save this configuration to
disk so that you can open it when you start work in
the studio for which it was designed.

Opening Existing FreeMIDI Configurations

Once you have saved more than one FreeMIDI
configuration to disk, you can open any existing
configuration for use in a situation such as starting
a project in another MIDI studio.
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To open an existing configuration:

1 If you have not done so already, open FreeMIDI
Setup by double-clicking its icon in the Finder.
Alternately, you can open FreeMIDI setup by
choosing the Edit FreeMIDI Configuration
command in any other FreeMIDI application.

The FreeMIDI Configuration window opens and
displays the current FreeMIDI configuration.

2 Choose Open from the File menu. Alternately,
you can type command-0 on your Mac keyboard.

If you have made changes to the current
configuration and have not yet saved them,
FreeMIDI asks if you would like to save these
changes before another configuration opens.
Otherwise, a standard Macintosh File Open dialog
box opens.

3 Select the FreeMIDI configuration that you
would like to open and click Open or click Cancel to
leave the current FreeMIDI configuration open.

The selected configuration opens and you can
proceed to use this configuration in your other
FreeMIDI applications. Use the directory pop-up
menu to navigate to a disk and folder in which the
configuration you wish to open is located. See your
Macintosh owner’s manual for more information
on saving files and navigating to disk and folders.

Saving FreeMIDI Configurations
You can save each FreeMIDI configuration that you
create to disk so that you can recall them at a later
date.

To save a FreeMIDI configuration:

1 Choose Save from the File menu. Alternately,
you can type command-S on your Mac keyboard.

If the configuration has been saved before, it
replaces the current version of the configuration. If
there are no changes since the last time the
configuration was saved, the Save menu item is
disabled (grayed-out) in the File menu. If the
configuration has never been saved before, a
standard Macintosh File Save dialog box opens.

2 Use the suggested name“FreeMIDI
Configuration” or enter another name for your
configuration if you like, and click Save or click
Cancel to cancel the operation.

Use the directory pop-up menu to navigate to a
disk and folder in which you wish to save this
configuration. If you like, you can use the New
Folder button to create a new folder in which to
save this configuration and others that you might
create in the future. See your Macintosh owner’s
manual for more information on saving files and
navigating to disk and folders.

The configuration is now safely saved and you can
recall it at a later date.

POPUP PATCH LISTS
Librarian applications, such as Unisyn or PatchList
Manager, which support FreeMIDI’s patch lists,
can be used to define patch lists for your FreeMIDI
devices. You can view the patch lists assigned to
FreeMIDI devices and send patch changes to their
default channels directly in the FreeMIDI Setup
application. For more information on how to
define patch lists for a FreeMIDI device, consult
your Librarian software’s users manual. If you use
PatchList Manager, this information is in
chapter 53, “PatchList Manager”.

To view and send patch changes in the FreeMIDI
Setup application:

1 Check to be sure that the Popup Patchlists menu
item in the MIDI menu is enabled.
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The Popup Patchlists command should have a
check next to its name. If it does not, choose it to
select it.

2 Press the mouse on a device in the FreeMIDI
Configuration window and its current patch list
appears in pop-up menu.

Figure 51-16 below shows a portion of an Ensoniq
ESQ-M popup patch list.

001 STEIN 033 WIND I
002 WAY 034 BOVS 1
003 QUIPNO*] 035 0UANT2
004 RHODES 036 ART02
005 pict reamaa
006PN0ST1 030 UTE IN
007 PN0ST2 033 KRAFTY
003HARPSI 040 QUANTA

Figure 51-16: Popup Patchlist.

3 (Optional) If you want to send a patch change
command to the device whose patch list you are
viewing, choose the patch you want to send and
release the mouse.

The patch change will be sent to the device on its
default channel.

PATCH THRU
The PatchThru command lets you send MIDI data
from one FreeMIDI device to any selected
FreeMIDI device while FreeMIDI Setup is the
current application.

Audition Channels

Before using PatchThru, be sure to set the Audition
Channels the way you need them.

To do so:

1 Choose Audition Channels from the MIDI
menu.

The Audition Channels dialog box appears.

® Use default channel only
O Use oil channels

MIDI Preferences are used for If '1
PatchThru and Check Connections V -jj

I t Cancel ]

Figure 51-17: Audition Channels Dialog Box.

2 Select one of the two options available.

The Use default channel only option is the default
setting. With this setting PatchThru sends all
incoming MIDI data to the selected device on the
first available MIDI receive channel for that device.
The Use all channels option will cause PatchThru to
send all incoming MIDI data to the selected device
on all of the selected device’s MIDI receive
channels at once. This option is mostly useful for
detecting to which channels a device is currently
responding.

3 Click OK to confirm your choice or Cancel to
leave the Audition Channels settings unchanged.

Using PatchThru

PatchThru is a checkable menu item. This means
that its state (on or off) is toggled each time you
choose it from the menu. When there is a check
next to the PatchThru menu item in the MIDI
menu, PatchThru is enabled.

To use PatchThru:

1 Check to be sure that the PatchThru menu item
in the MIDI menu is enabled.

The PatchThru command should have a check next
to its name. If it does not, choose it to select it. You
can also use the Mac keyboard shortcut to toggle
the state of PatchThru by typing command-T.

2 Select a device and play notes on your MIDI
controller keyboard.

J 493
FREEMIDI SETUP



494

You should hear the notes being played coming
from the device that is selected.

** You can only patch thru to one device at a
time. To Patch Thru to more than one device, use
Multi-record mode in Performer or cable routing
in the MTP, MTP II or MIDI Express.

MIDILOCATE
MidiLocate is a unique feature designed to make
adding devices to your FreeMIDI configuration
easier. In this mode, FreeMIDI automatically
determines the proper input cable to which a
device is physically attached and then displays this
connection in the FreeMIDI Configuration
window.

MidiLocate is a checkable menu item. This means
that its state (on or off) is toggled each time you
choose it from the menu. When there is a check
next to the MidiLocate menu item in the MIDI
menu, MidiLocate is enabled.

To use MidiLocate:

1 Select a FreeMIDI device in the FreeMIDI
Configuration window.

2 Check to be sure that MidiLocate menu item in
the MIDI menu is enabled.

The MidiLocate command should have a check
next to its name. If it does not, choose it to select it.
You can also use the Mac keyboard shortcut to
toggle the state of MidiLocate by typing command-
L.

3 Play some MIDI data from the MIDI device.

FreeMIDI will determine from where the MIDI
data is coming and redraw the FreeMIDI
Configuration window to indicate the appropriate
connection.

Here is an example of MidiLocate in action. Let’s
say you have a Kurzweil K2000 that is connected to
some MIDI input on your MTP II, but you are not
sure which input:

1 Add a K2000 FreeMIDI device your
configuration using Quick Setup or Create Device.

2 Enable MidiLocate.

3 Select the K2000 device.

4 Play some notes on its keyboard or send some
other MIDI data from it and the K2000 device
automatically is connected to the correct MIDI
input port on your MTP II in the FreeMIDI
Configuration window.

THE TRANSPORT CONTROLS
The Transport Controls window contains buttons
that can control the transport functions (Play, Stop,
Rewind, Locate) of other FreeMIDI applications
from within FreeMIDI Setup. For instance, you
might want to start a sequence playing in
Performer while you are working onsomeaspectof
your FreeMIDI setup. You do so by opening the
Transport Controls window, enabling FreeMIDI
Sync, and clicking Play. With this feature, there is
no need to switch to Performer.

Playing MIDI in the background using the
transport controls only functions when FreeMIDI
Preference’s Software Compatibility is set to allow
FreeMIDI applications only. For more information,
see “Launching FreeMIDI Setup” on page 31.

Once FreeMIDI Sync is enabled, you can also stop
Performer, rewind the sequence, or locate to up to
8 predefined positions within the sequence directly
from FreeMIDI Setup.

FreeMIDI Sync can be enabled from any FreeMIDI
application that is currently open and that supports
this feature of FreeMIDI. In Performer, this
command is in the Basics menu. When you enable
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FreeMIDI Sync in any open FreeMIDI application,
it is enabled for all FreeMIDI applications on that
Macintosh.

The state of FreeMIDI Sync (ON or OFF)
cannot be changed while a FreeMIDI application
such as Performer is playing.

To use the Transport Controls:

1 Choose Transport Controls from the MIDI
Menu or type command- = on your Mac keyboard.

The Transport Controls window appears.

□ ~ Controls _

oqodo
STOP PL*V POUSI

I t > * S 0 T ■

□ FUEM0I SYNC

Auto-locate buttons

Figure 51-18: Transport Controls Window.

2 Click FreeMIDI Sync to enable FreeMIDI Sync.

You can skip this step if FreeMIDI Sync has already
been enabled by some other FreeMIDI application.
If it is already enabled, the FreeMIDI sync check
box appears checked.

3 Click the Transport Control function that you
want to use.

Click Rewind, Play, Stop, or Pause to send those
commands to the FreeMIDI application that you
are controlling. The FreeMIDI application should
respond to these commands as if you were using its
own controls.

4 If the FreeMIDI application that you are
controlling supports their use, you can use any of
the 8 auto-locate buttons to auto-locate to some
pre-defined location in the sequence or song that is
currently playing.

In Performer, you can define these auto-locate
points in the Markers window. Assign a number
from 1-8 for a marker in the Seek column and that
marker’s location in the sequence will be defined as
one of the 8 FreeMIDI auto-locate points. Click the
corresponding button in the Transport Controls
window and Performer will locate to that point.
You can auto-locate at any time, even during
playback.

THE PANIC COMMAND
The Panic command found in the MIDI menu
sends an All Notes Off MIDI message and then a
note off MIDI message for every MIDI note on
every possible MIDI channel on every MIDI
output cable on both serial ports. It also resets
MIDI software buffers in FreeMIDI software.

This command can take quite a while. If you wish
to stop the operation, type command-period on
your Mac keyboard.

CHECK CONNECTIONS
The Check Connections command is a utility that
FreeMIDI Setup provides for troubleshooting and
testing the connections of your MIDI studio.

Check Connections is a checkable menu item. This
means that its state (on or off) is toggled each time
you choose it from the menu. When there is a check
next to the Check Connections menu item in the
MIDI menu, Check Connections mode is enabled.

Checking MIDI Output

To use Check Connections mode to check MIDI
output connections:

1 Check to be sure that the Check Connections
menu item in the MIDI menu is enabled.

The Check Connections command should have a
check next its name. If it does not, choose it to
select it. When the menu item is checked, Check
Connections mode is enabled and the mouse 
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cursor will change to the Check Connections
cursor when it is within the FreeMIDI
Configuration window as shown in Figure 51-19
below.

Figure 51-19: Check Connections mouse cursor.

2 Press a device icon and hold the mouse button
down.

While you hold the mouse button down, FreeMIDI
sends a C major chord on all MIDI channels to the
MIDI output port to which the selected device is
connected. If you have an MTP, MTPII, MIDI
Express or other interface which can show MIDI
output activity, the LED should light up on the
selected output port. Additionally, the device to
which you are playing MIDI should play the C
major chord. If you do not see MIDI activity or do
not hear the C major chord, check the connections,
cables and power switches of all your MIDI gear.

3 Press other device icons to test the rest of your
studio.

4 Uncheck the Check Connections menu item in
the MIDI menu by selecting it.

Checking MIDI Input

To use Check Connections mode to check MIDI
input connections:

1 Check to be sure that Check Connections menu
item in the MIDI menu is enabled.

The Check Connections command should have a
check next its name. If it does not, choose it to
select it. When the menu item is checked, Check
Connections mode is enabled and the mouse
cursor will change to the Check Connections
cursor when it is within the FreeMIDI
Configuration window as shown in Figure 51-19
above.
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2 Send MIDI data from one of your MIDI devices.

If the device has a keyboard, play notes on it. If it is
a rack-mount unit, you will need to find a way to
send some type of MIDI data from it. Try changing
patches or initiating a system exclusive dump from
its front panel.

3 The MIDI port to which the device is connected
should flash the eighth note icon as shown below in
Figure 51-20.

Figure 51 -20: Incoming MIDI Data indicator.

If no ports flash, this means that FreeMIDI is not
receiving the MIDI data. Check the connections,
cables and power switches of all your MIDI gear. If
a port flashes, but it is not the port you expected,
you will need to re-connect the MIDI device to the
correct port or better yet, change the connection in
your FreeMIDI configuration to match the physical
connection. See “MidiLocate” on page 494 for a
quick and easy way to re-connect a device in your
FreeMIDI configuration.

THE VIEW MENU
The View menu allows you to change the way the
FreeMIDI Configuration window displays. The
Clean Up Window command automatically aligns
devices in straight columns. For more information,
see “The Clean Up Window Command” on
page 489.

There are three size options, which control the
display of FreeMIDI device icons and four input/
output options, which control the display of the
“patch cords” that connect devices and interfaces,
as illustrated in Figure 51-21 below.

The two upper sections in this menu each have
mutually exclusive options. Choosing one of the
icon size options disables the other two icon size

FREEMIDI SETUP |



options. Similarly, choosing one of the input/
output view options disables the other three input/
output view options.

tiieu>
by Small Icon
by Icon

✓ bg Large Icon

Show Inputs Only
Show Outputs Only

✓ Show Inputs O' Outputs
Show On Select

Clean Up Window

Figure 51 -21: The View Menu.

To use the View menu to change the display of your
FreeMIDI configuration:

1 Choose an icon size option from the View menu
and the FreeMIDI Configuration window will
redraw (if necessary) to display your choice.

The choices are Small Icon, Icon, and Large Icon.
These three choices represent the three icon sizes
possible for each FreeMIDI device. See “Editing
FreeMIDI Devices” on page 485, for information
on changing the icons of your FreeMIDI devices.
These options are useful for displaying more or less
of your FreeMIDI Configuration, depending on
what you are doing at the time.

2 Choose an input/output view option from the
View menu and the FreeMIDI Configuration
window will redraw (if necessary) to display your
choice.

These choices are useful for making the FreeMIDI
configuration window display easier to read.

CHANGING INTERFACE SETTINGS
Normally, FreeMIDI finds out what your interface
settings are automatically. In this case, you should
never need to change the interface settings.

There are, however, a few situations in which you
might need to make the interface settings
manually, such as the following cases:

■ You have an interface that FreeMIDI does not
automatically recognize

■ You have just changed the communication speed
on your interface (for example, you’ve changed it
from FAST/1X speed to 1 MHz).

There are other possible situations as well. In these
cases, you can set the interface speed manually
using the Interface Settings command in the MIDI
menu.

To changing the interface settings:

1 Choose Interface Settings from the MIDI menu.

The Interface settings dialog box appears. See
Figure 51-13 on page 490 above.

2 Select the appropriate options and click OK.

DEVICE PROPERTIES
Device properties are descriptive words that can be
assigned to any FreeMIDI device. FreeMIDI
applications can use these device properties in any
way that they require. Here are two examples of the
use of device properties:

■ A FreeMIDI application which knows about the
General MIDI specification could check FreeMIDI
devices for the General MIDI device property. If
the application found this property assigned to a
certain device, it could then adjust itself to display
and send the General MIDI patch changes only to
this device, without having to know anything else
about the device (such as the device model name or
patch list).
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■ A FreeMIDI application that needs to
synchronize its timing to a certain device could
check for the Transmits Sync device property. If the
property is used by a device, the application would
know that it could successfully sync to the device.

You can assign device properties to a device when
the device is first added to your FreeMIDI
configuration or at a later time. The FreeMIDI
Device Specification dialog box is where this
assignment is made. See “Editing FreeMIDI
Devices” on page 485 and “Adding FreeMIDI
Devices” on page 484, for information on
assigning device properties to devices.
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chapter 52 FreeMIDI Setup Quick Reference

This chapter contains brief descriptions of all the
commands and dialog boxes contained in the
FreeMIDI Setup application. Use this chapter as a
reference guide for finding out how a certain
feature is used. Read the chapters that are cross­
referenced for more detailed information on these
features.

THE APPLE MENU
The Apple menu contains Desk Accessories under
system 6 and what ever is in the Apple Menu Items
folder under system 7. The first command in the
Apple Menu is About FreeMIDI Setup.

About FreeMIDI Setup

Choose About FreeMIDI Setup to display the
FreeMIDI Setup startup screen and version
number. Click the mouse anywhere to make this
display go away and return to the FreeMIDI
Configuration window.

THE FILE MENU
The File menu contains all the commands that
allow you to open, close, and save FreeMIDI
configuration files.

New
Use the New command to close the current
configuration and open a new empty configu­
ration. You will be asked if you are sure that you
want to close the current configuration, since this
will affect all FreeMIDI applications that are
currently being used. Before the new configuration
is created, the Update Interfaces dialog appears so
that FreeMIDI can establish what type of MIDI
interface you have.

Open

Use the Open to close the current configuration
and open a previously defined configuration.

Close

Use the Close command to Quit FreeMIDI Setup.

Save

Use the Save command to save changes you have
made to the current configuration file on disk.

Save As

Use the Save As command to save the current
configuration file with a new name.

To save the current configuration file with new
name:

1 Choose Save As from the File menu.

The Save As dialog box appears.

2 Enter a new name for the configuration file.

You can’t use a colon (:) in the name; however all
other characters are permitted, including spaces.
Navigate to the disk and folder to which you wish
to save the configuration file using the directory
menu at the top of the window. If you enter a name
that is already in use, a dialog box asks you to
confirm your choice.

3 Click Save.

Your configuration file is saved on the disk in its
current state under the new name.

Revert
Use the Revert command to discard any changes
you have made to the current configuration file and
restore it to the state it was in when you last saved it.



Page Setup
Use the Page Setup command to control the way
your configuration is printed when using the Print
command. See your Macintosh user’s manual for
more information on Page Setup.

Print

Use the Print command to print a picture of your
FreeMIDI configuration. See your Macintosh and
printer user’s manual for more information on
printing.

FreeMIDI Preferences
Use the FreeMIDI Preferences command to open
the FreeMIDI Preferences dialog box. This dialog is
where you control some of the global settings of
FreeMIDI such as which serial ports FreeMIDI will
use, whether Inter-application MIDI is enabled,
whether non-FreeMIDI applications will have
access to the serial ports and whether patch change
monitoring is enabled.

Quit
Use the Quit command to exit the FreeMIDI Setup
application.

THE EDIT MENU
The Edit menu contains commands for copying
and pasting FreeMIDI devices in the FreeMIDI
Configuration window. These commands also
work in the standard Mac way anywhere in
FreeMIDI Setup where you edit text.

Undo
Use the Undo command to undo the last edit or
change that you made to your FreeMIDI Configu­
ration. Generally, this command displays the
command that it will Undo, such as Undo Drag or
Undo MidiLocate. As a shortcut, type command-Z
on your Mac keyboard to invoke this command.

Cut
Use the Cut command to place a copy of the
current selection on the Clipboard and then
remove the current selection. As a shortcut, type
command-X on your Mac keyboard to invoke this
command.

Copy
Use the Copy command to place a copy of the
current selection on the Clipboard. As a shortcut,
type command-C on your Mac keyboard to invoke
this command.

Paste
Use the Paste command to insert whatever data is
currently on the Clipboard. As a shortcut, type
command-V on your Mac keyboard to invoke this
command.

Clear

Use the Clear command to remove the current
selection. No copies are placed on the Clipboard.
As a shortcut, type command-B on your Mac
keyboard to invoke this command.

Duplicate
Use the Duplicate command to make copies of the
currently selected FreeMIDI devices. This
command only works on selected FreeMIDI
devices, so it is grayed-out(disabled) unless at least
one FreeMIDI device is selected. As a shortcut,
type command-D on your Mac keyboard to invoke
this command.

Select All
Use the Select All command to quickly select all of
the current type of data. For instance, if there is no
selection in the FreeMIDI Configuration window,
Select All selects all the FreeMIDI devices,
interfaces, and connections in the window. If a text
entry box is active, such as the name field for a
FreeMIDI device, Select All will select all the text in
the name field. As a shortcut, type command-A on
your Mac keyboard to invoke this command.

500 L
FREEMIDI SETUP QUICK REFERENCE |



THE CONFIGURATION MENU
The Configuration menu provides access to
various commands for setting up and changing
your FreeMIDI configuration.

Quick Setup
Use Quick Setup to open the Quick Setup dialog
box, which allows you to quickly add and remove
devices to and from your current FreeMIDI config­
uration. For more information, see “Quick Setup”
on page 481.

Update Interfaces

Use Update Interfaces... to inform FreeMIDI of
changes you have made to the MIDI interface(s)
that you have connected to the serial port(s) on the
Macintosh. For more information, see “Updating
Interfaces” on page 489.

Create Device

Use Create Device to open the FreeMIDI Device
Specification dialog box and add a new FreeMIDI
device to your current FreeMIDI configuration.
For more information, see “Adding FreeMIDI
Devices” on page 484.

Edit Device

Use Edit Device to open the FreeMIDI Device
Specification dialog box and edit an existing
FreeMIDI device in your current FreeMIDI config­
uration. You must select a device before this
command becomes enabled. With no devices
selected, it remains grayed-out (disabled). For
more information, see “Editing FreeMIDI Devices”
on page 485.

THE MIDI MENU
The MIDI Menu contains commands which
provide control over FreeMIDI Setup’s various
MIDI settings.

Interface Settings

Use the Interface Settings command to open the
Interface Settings dialog box. This dialog box
allows you to enable and disable the two serial 
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ports for MIDI. If, for instance, you have a printer
attached to the Thru port of your MTPII and the
MTP II is connected to the Printer serial port, you
will need to disable MIDI on the printer port in
order to do any printing.

Return

Use the Return command to return to the
FreeMIDI application that was last active before
switching to FreeMIDI Setup. This command will
only have an effect if you switch to FreeMIDI Setup
with the Edit FreeMIDI Configuration command
from any other FreeMIDI application. As a
shortcut, type command-R on your Mac keyboard
to invoke this command.

Transport Controls

Use the Transport Controls command to open the
Transport Controls window. The Transport
Controls window contains buttons that can control
the transport functions (Play, Stop, Rewind,
Locate) of other FreeMIDI applications from
within FreeMIDI Setup. For more information, see
“The Transport Controls” on page 494.

Check Connections

This command, when checked, causes the arrow
cursor to change to a small keyboard cursor.

■
When you click a device in the FreeMIDI
configuration window with the keyboard cursor,
FreeMIDI sends a C-major chord to the device via
MIDI. If all is well, the device plays the chord. If
there is a communication problem between
FreeMIDI and the device (such as a loose cable or
something), the device does not play the chord.

Conversely, when this command is checked, and
you send MIDI from one of your MIDI devices to
FreeMIDI, the port to which the device is 
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connected flashes a note symbol to indicate that
FreeMIDI is successfully receiving data from the
device.

This command serves as a diagnostic tool for you
to determine if MIDI communication is OK.

MidiLocate
Use the MidiLocate command to toggle the state of
MidiLocate. When the menu item is checked,
MidiLocate is enabled. When it is unchecked,
MidiLocate is disabled. For more information, see
“MidiLocate” on page 494.

PatchThru
Use the PatchThru command to toggle the state of
PatchThru. When the menu item is checked,
PatchThru is enabled. When it is unchecked,
PatchThru is disabled. For more information, see
“Patch Thru” on page 493.

Popup Patchlists

This command, when checked, causes the arrow
cursor to change to a MIDI patch change icon
cursor.

When you then press on a device in the MIDI
configuration window with the patch change
cursor, a popup patch list appears containing a list
of the patches for the device. For more
information, see “Popup Patch Lists” on page 492.

Audition Channels

The Audition Channels command allows you to
choose how PatchThru and Check Connections
will function. For more information, see “Audition
Channels” on page 493.

Panic
Use the Panic command to send an “All Notes Off”
MIDI message and then a“note off” MIDI message
for every MIDI note on every possible MIDI
channel on every MIDI output cable on both serial
ports. This command will also reset all MIDI
buffers in all FreeMIDI software. This command
can take quite a while. If you wish to stop the
operation, type command-period, on your Mac
keyboard. For more information, see “The Panic
Command” on page 495.

THE VIEW MENU
The View menu controls the display of the
FreeMIDI Configuration window. The three
options at the top of the menu, by Small Icon, by
Icon and by Large Icon, are mutually exclusive.
Choosing one option disables the other two. When
an option is chosen from the menu, it gets a check
mark next to its menu item.

The next four options, Show Inputs only, Show
Outputs only, Show Inputs and Outputs, and Show
On Select, are also mutually exclusive. For more
information, see “The View Menu” on page 496.

Use the Clean Up Window command to quickly
arrange all the FreeMIDI devices in the window in
a neat column. For more information, see “The
Clean Up Window Command” on page 489.
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chapter 53 Patch Li st Manager

What is PatchList Manager?
This chapter explains how to use PatchList
Manager, a FreeMIDI-compatible application
included with Performer. You can find it in the
FreeMIDI Applications folder on the top level of
your hard disk (unless you have moved it since
installation).

PatchList Manager helps you create and maintain
accurate patch lists for your MIDI instruments, so
that the sound names in Performer match the
sounds in the instrument. In fact, the word patch
refers to a specific sound in your MIDI instrument.

Do you need to use PatchList Manager?

FreeMIDI automatically provides factory default
patch lists for over 100 popular synthesizers and
sound modules. If your device is one of them, the
patch lists you see in Performer’s Patch and Default
Patch pop-up menus will be accurate and 

complete, and you probably won’t need to use
PatchList Manager. To check the accuracy of a
device’s patch List in Performer, choose a sound
from a track’s Default Patch pop-up menu in the
Tracks window and then see if the track plays with
the sound you chose. If so, you are all set.

If you use Unisyn 1.5 or higher to manage your
Performer patch lists, you don’t need to use
PatchList Manager. For details, see chapter 49,
“Using Performer With Unisyn” (page 471).

Situations that call for PatchList Manager

Here are the most common situations in which you
would need to use PatchList Manager:

■ Performer is displaying generic sound names for
one of your devices as shown in Figure 53-1 on
page 503 (i.e. “Patch 1, Patch 2, Patch 3” etc.) and
you want to see actual sound names instead.

OSofoCallo 32 Epilogue 64 BellEnsemble 96 RoomOfStrings
1 ColoVfola 33 WlndStack 63 Cyberspace 97 MayicBells
2 SoloViolin 34 FrenchHcrnl 66 PlzzMoogBass 98 Regtnatron
3 Quartet 35 FrenchHom2 67 Marimba!* 99Sublt!
4 SoloChunbar 36 SecticnHoms 68 GrimReaper 100 Psychic tr on
5 ArccBasse; 37 Trumpet! 69 TtnkerBell 101 CtoudChamber
6 ArtoCelll 38 Trumpet2 70 Carousel 102 Sepulcher
7 ArcoViolas 39 TvoTrumpets 71 ExotieHarp 103 LurchPluck
0 ArcoVttlms 40 Harmonbdute 72 DarnScucers 104 Pizz/Piccolo
9 Marcatol 41 Trombone! 73 EronzePad 105 Vampirical
1OMarc*to2 42 Trombone 2 74 Vibraphone 106 StrtngThings
11 UyatoStr 43 Tub* 73 AstralFkite 107 Galapagos
12 Concerto 44 BackBrass 76 KooIBass 108 SquareOne
13 PizzBasses 43 ChamberBrass 77 ScmbreVInds 109 Squarelink
14PfczCe11i 46 BrassStrtngs 78 SpaceCowboy 110 <•>
15Pi«Vfc>l*s 47 Timapni 79 TheMachtne 111 Sardonlcus
16 Pic zVtolins 48 0ony/Cymb*1 60 Early Pero 112 MasterTron

49 Bass/Snare 61 OentlyNov 113 LoVindinst
18Ptczicato2 50 TempIcBlock 82 Piccolodeeyo 114 Sympathetic
19 TrtmjtrWjj 31 Xylcphone 83 InftniteOne 113 VtndCh tones
20 Strys/Hutes 52 Glockenspiel 84 Shimmer Vays 116BoatH»us
21 RestingPad 53 Celesta 83 TurboBass 117 OlitterOod
22 DfYertirr.cnto 54 TubularBells 86 Req-siem 118 StcryBass
23 Flute 35 Percussionl 87 VronyRoom 119 NiceNIght
24 Piccolo 56 Percussion? 63 AnalcyPad 120 ProphetLead
23 Oboe 37 Hcrp 09 Chape lOryan 121 Prophetlink
26 EnylishHorn 58 Harps trinys 90 Electrovocal 122 Vhistl'nJoe
27 Clarinet 59 Harpsikord 91 FatBoyTuba 123 Ltnk2Shimmer
28 BasrClartnet 60 NotreDame 92 SawB»ss/Le*d 124 Ascending
29 Bassoon 61 VtnterSiyns 93 VitnnaDream 125 Harpsomatto
30 Ccntrabassocn 62 DeepPad 94 VertfcjoPad 126 Phaedra
31 ChamberVtnds 63 Portamento 93 TarkusTvtn 127 Ctmb*1on

Patch 1 Patch 33 Patch 65 Patch 97
Patch 2 Patch 34 Patch 66 Patch 98
Patch 3 Patch 33 Patch 67 Patch 99
Patch 4 Patch 36 Patch 68 Patch 100
Patch 5 ^^Uh^ Patch 69 Patch 101
Patch 6 Patch 70 Patch 102
Patch 7 Patch 39 Patch 71 Patch 103
Patch 8 Patch 40 Patch 72 Patch 104
Patch 9 Patch 41 Patch 73 Patch 105
Patch 10 Patch 42 Patch 74 Patch 106
Patch 11 Patch 43 P*tch 73 Patch 107
Patch 12 Patch 44 Patch 76 Patch 108
Patch 13 Patch 45 Patch 77 Patch 109
Patch 14 Patch 46 Patch 78 Patch 110
Patch 15 Patch 47 Patch 79 Patch 111
Patch 16 Patch 48 Patch 80 Patch 112
Patch 17 Patch 49 Patch 81 Patch 113
Patch 18 Patch 50 Patch 82 Patch 114
Patch 19 Patch 51 Patch 83 Patch 1t3
Patch 20 Patch 52 Patch 64 Patch 116
Patch 21 Patch 53 Patch 85 Patch 117
Patch 22 Patch 54 Patch 66 Patch 118
Patch 23 Patch 55 Patch 67 Patch 119
Patch 24 Patch 56 Patch 69 Patch 120
Patch 25 Patch 57 Patch 89 Patch 121
Patch 26 Patch 53 Patch 90 Patch 122
P*tch 27 Patch 59 Patch 91 Patch 123
Patch 28 Patch 60 Patch 92 Patch 124
Patch 29 Patch 61 Patch 93 Patch 123
Patch 30 Patch 62 Patch 94 Patch 126
Patch 31 Patch 63 Patch 95 Patch 127
Patch 32 Patch 64 Patch 96 Patch 128

Figure 53-1: For many popular MIDI devices, Performer automatically displays sound names in its
pop-up patch lists. If not, you'll see generic names as shown on the right. PatchList Manager lets
you replace generic names with the actual names In the synth. In addition, it provides a host of
capabilities that allow you to maintain accurate patch Lists for all of your MIDI devices.
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■ The current sound names in Performer don’t
match the sounds you hear in the instrument.

■ You want to make minor changes to a patch list,
such as changing the order of the sounds in the list.

■ You have loaded a new bank of sounds into the
instrument (or have otherwise changed the
internal state of the instrument) and you want to
access them by name in Performer.

■ You want to set up, reorganize, add, or remove
multiple patch Lists for an instrument that has
multiple banks of sounds.

A brief overview of PatchList Manager
PatchList Manager has the three main windows
shown in Figure 53-2. The FreeMIDI Devices
window shows the MIDI device or devices that you
want to work with. The Patch List window shows
all of the patch lists that can be assigned to the
devices. The Programs window displays the list of
sounds contained in a particular patch list.

The information shown in these three windows is
saved in your FreeMIDI Setup document, as well as
a separate PatchList Manager document, which
you’ll save to disk when you have finished working
with PatchList Manager.
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Sfx iDrumble

Figure 53-2: An overview of PatchList Manager.
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In the Patch List column,you choose
which patch list (or patch list folder) to display
in Performer for each MIDI channel of the
device. In this example,the patch list folder

called Morpheus Banks is assigned to all
Morpheus channels. As a shortcut to assign all
channels at once, click in this column next to
the device name instead ofone of its channels.

The mini-menu
contains commands that
apply to the window.

fl Channel 1
fl Channel 2
fl Channel 3
fl Channel 4
fl Channel 5
fl Channel 6
fl Channel 7
fl Channels
fl Channels
fl Channel 10
fl Channel 11
fl Channel 12
fl Channel 13
fl Channel 14
fl Channel 15
fl Channel 16

Double-click the move
handle to open the
Programs window.

The Expand
button snowsand
hides the MIDI
channels for the
device.

The Programs window
gives you access to the sound
names inthe patch list. Use the
mini-menu commands to
arrange the list and set the
numbering scheme.

Click the patch
number to
change it.

The FreeMIDI Devices window shows
the MIDI instruments you would like to work
with, along with the MIDI channels belonging to

each device. Use the Choose Devices
command in the mini-menu to decide which
devices you want to see in this list.

Drag the Move
handles to
reorder the
channels.You can
also drag patch lists
and sounds this way.

Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks
Morpheus banks I
Morpheus banks
Morpheus banks
Morpheus banks—-4—

The Patch Lists window shows patch
Lists, which can be grouped into folders.To
place a patch List in a folder, drag its diamond
move handle and dry it on top of the folder

icon. Use the Add Folder command to
create a new one.

Patch Lists
ItnGTM ElKNK UStO CM?»C0MM(HT

®(al;H:
FtUlCM/MOCULtt <

> EQ K2000R
t> Q TS-12
t> rnaxs

/H, FreeMIDI Device?
CURRENT PwTClt COMM HI

The Close button
doses the window.

A tzQ Morpheus banks
128
128

0/
0/

♦ RAM Presets
♦ ROM Presets
♦ HyperPresets 128 0/
♦ Card Presets 128 0/
♦ Card HyperPresets 128 0/

vD K2000 banks
♦ Bank 0 100 0
♦ Bank 1 100 1
♦ Bank 2 100 2
♦ Bank 3 100 3
♦ Bank 4 100 4
♦ Bank 5 100 5
♦ Bank 6 100 6
♦ Bank? 100 7
♦ BankB 100 8
♦ Bank 9 100 9

■^0X5 banks
■tj Programs ! 100 0/
<♦ Combinations 100 0/
I ♦ GM Sounds 128 56/

♦ GM Drum Kits 64 62/

Oickthe sound

name to
rename it.

Programs
Pen nrme

■i 0
■a 1
■a 2
■a 3
■a 4
■j 5
■u 6
■a 7
■j 8
"a 9
■a 10
■a 11
"a 12
■u 13
■a 14
■u 15
■a 16
"a 17
•a 18
■a 19
"a 2Q,
•a 21
1 22
■a 23
■j 24
■a 25
5 26
"u 27
■a 28
■a 29
■a 30
■a 31
■a 32

Sunrise
Piano 16‘
AltcBreath
Tiny Dancer
Spruce Gtr
Vibra Bell

5

TheStrings
PowerSynth
Total Kit
Machine Age
Hot Keys
Brass Band
Maxi Tine
Power Rock
Tabla Talk
FingerBass
LiteVoices
Color Pad
Festival!
GUdeSweep

MagicFlute
Operators
E.Guitars
Gamelan
Zap Bass
DigitalAir
Analogist
MandoTrem
Space Wing
Gospel Org
Trumpets
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Opening PatchList Manager

To open PatchList Manager, double-click the
PatchList Manager icon on your hard disk. It is
located in the FreeMIDl Applications folder on the
top level of your hard disk (unless you have moved
it since installation). What you’ll see at first is the
Choose Devices dialog box as shown in
Figure 53-3 on page 505.

Choosing the devices you want to work with

The first thing you need to do is choose the device
or devices you need to work with. Only choose the
devices whose patchlists you need to edit.

Remember, if their patch lists are already fine, you
don’t need to do anything with them in PatchList
Manager.

1 Select each device you would like to work with
by highlighting its name; deselect devices you don’t
need to work with.

2 If Performer’s pop-up menus already display
sound names for the device, and you would like to
work with this default list of names in PatchList

Patchlist Template

Figure53-3:Choosing the
devices you want to work with.

Click the devices shown
here to select or deselect
them.lfa device's lists are
showing up in Performer
and selecting the correct
sounds, there is no need to
select it here.

Phase choose from the list of available devices by highlighting the name(s) on
the left. To configure patchlists for a device automatically, press the
PatchList Template column and choose the appropriate template from the popup
menu. Click "Auto" and devices supported by PatchList Manager templates are
automatically selected and configured.

■prf Choose Deuices

FreeMIDl Device
ProMixOl_________

_________ J E-mu Proteus/1
01/VProX

05R/W

I Kurrweil K2000
If you want to work with FreeMIDI's
default patch List(s) for a device in
PatchList Manager, choose the list by
name here. Note that some devices
aren't supported and therefore will
not have a default list, as shown in
this example by the KO RG DW-8000.

The sounds in a patch list arc the sounds that are evoked when a
MIDI program change message (sometimes called a patch change) is
sent to die device. MIDI patch change events are numbered from 0 to
127 (or 1 to 128), so patch Lists will commonly have 128 sounds in
them, although you’ll frequently encounter other sizes.

Some MIDI devices have more than 128 sounds. In this case, the
instrument either organizes them into multiple banks of sounds
(usually ranging in size from 50 to 128 each), or it allows you to
“map” sounds higher than 128 to a program change number below
128, replacing the original sound that used that number.

If an instrument has multiple banks, a separate patch list is set up for
each bank. In this case, the term patch list is pretty much synony­
mous with the word bank.

If a device has multiple banks, it often requires an additional
message, called a bank select message. To call up a sound from the
bank in this case, Performer sends several MIDI messages: a bank
select message (usually controller #0 and/or controller #32) followed
by a patch change message. Some devices use a different type of MIDI
message for bank select, such as a short system exclusive message.
FreeMIDl can handle any type of bank select message. To learn more,
see “Using multiple patch lists & bank select messages” on page 516.
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Manager, choose the list by its manufacturer and
device name in the“PatchList template” pop-up
menu to the right of the device.

3 The devices appear in the FreeMIDI Devices
window with their MIDI channels shown below
them.

The current patch list (or patch
list folder) assigned to each MIDI

channel.The K2000 Banks folder
The Device's holds all ten banks for the K2000,

Devices MIDI channels as shown below in Figure 53-5.

:<S, FreeMIDI Devices

DV-8000
t> cca Proteus/1

D33 K2500R a
p Channel 1
p Channel 2
P Channel 3
P Channel 4
P Channel 5
P Channel 6
P Channel?
P Channels
P Channels
P Channel 10
P Channel 11
p Channel 12
P Channel 13

2
3
4
5
6
7
8
9

10
11
12
13

K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks
K2000 banks

3

I
Figure 53-4: A device in the FreeMIDI Devices window.

4 If you imported FreeMIDI’s default patch lists
along with the devices, they appear in the Patch
Lists window.

Patch list Patch lists in the
folder K2000 folder

Patch Lists
\ KAMI ■ EHGIH DANK USfO CrWTCOMMEHT

Proteus Prtsrtt]
vt) K2000 banks /

♦ Bank 0 /
♦ Bank
♦ Bank 2
♦ Bank 3
♦ Bank 4
♦ Bank5
♦ Bank 6
♦ Bank?
♦ Banks
♦ Bank 9

128

100
100
100
100
100
100
100
100
100
100

0
1
2
3
4
5
6
7
8
9

A

V
-

Figure 53-5: Imported FreeMIDI patch lists appear in the Patch Lists
window.

DECIDING WHAT TO DO NEXT
What you do next depends on what the situation is
with each MIDI device. Here is a summary:

Situation

Performer is displaying
generic sound names for
one of your devices as
shown in Figure 53-1 on
page 503 (i.e. “Patch 1,
Patch 2, Patch 3” etc.)
and you want to see
actual sound names
instead.

What to do

See “Creating a new patch list”
on page 507.

Most or all of the current
sound names in Per­
former don’t match the
sounds you hear in the
instrument.

You have loaded a new
bank of sounds into the
instrument (or have oth­
erwise changed the inter­
nal state of the instru­
ment) and you want to
access them by name in
Performer.

See “Creating a new patch list”
on page 507.

See “Creating a new patch list”
on page 507.

You want to set up, reor­
ganize, add, or remove
multiple patch lists for an
instrument that has mul­
tiple banks of sounds.

“Using multiple patch lists &
bank select messages” on
page 516.

You want to make minor
changes to a patch list,
such as changing the
order of the sounds in the
list or renaming a few
sounds.

See “Making changes to a
patch list” on page 513

PATCHLIST MANAGER |



CREATING A NEW PATCH LIST
If your MIDI instrument doesn’t have a patch list
yet, or if the current patch list is inaccurate for
some reason (i.e. more than just a few sound names
are incorrect), your next step is to create a new
patch list for the device. There are several ways to
do so. They are summarized below in the order in
which you should try them.

Ways to create a Explanation
patch list

Load the
Device’s patch
list (or lists) from
old Performer or
Digital Per­
former files

If you already
have patch lists
for the device in a
Performer 4.2 (or
earlier) or Digital
Performer 1.4 (or
earlier) file, you
can import the
list(s) into
PatchList Man­
ager.

Where to go

“Importing
patch lists,yon
page 507

If PatchList Man-
agersupportsthe
device, it can get
a “patch dump”
from the device
to automatically
extract accurate
patch lists from it

PatchList Man­
ager gets a sys­
tem exclusive
bulk dump from
the device,
extracts the
patch names, &

fgenerates a patch
ist for each Dank.

“Using PatchList
Manager to load
patch names” on
page 508

If PatchList Man­
ager doesn’t sup­
port the device,
you can use Uni-
syn, Mark of the
Unicorn’s uni­
versal editor/
librarian soft­
ware, to extract
an accurate patch
list for each Dank
in the device

Get banks using
Unisyn and then
import the Uni-
syn-generated
patch list for the
Dank into
PatchList Man­
ager.

“Getting patch
lists with Uni­
syn” on page 510

If none of the
above methods
apply, you can
type in the patch
names by hand

You add a new,
generic patch list
and type the
names in by
hand.

"Creatingapatcl
list by hand’’ on
page 511

f~P A T C H L I S T MANAGER

IMPORTING PATCH LISTS
You can import patch lists from Performer 4.2 (or
earlier) or Digital Performer 1.4 (or earlier) files.
You can import the patch lists from either complete
sequence files or configuration files. You can also
import them from other PatchList Manager files
you may have saved on disk.

To import patch lists from a Performer or Digital
Performer file:

1 Choose Import Patch Lists from the File menu.

A standard Mac open file dialog appears.

2 Select the Performer or Digital Performer file
that contains the patch list you wish to import and
click Open.

Use the directory menu as needed to navigate on
your hard disk in order to find the file. You can
select either configuration or complete sequence
files.

3 If the Patch Lists window isn’t already open,
choose it from the Windows menu to view the
imported list(s).

4 (Optional)Ifseveraloftheimportedlistsbelong
to the same MIDI device, create a folder in the
Patch Lists window and place them in the folder.

See “Grouping patch lists in a folder” on page 514.
If the MIDI device supports some form of bank
select, you will want to set up the bank select
message for each list so that you can effortlessly
choose sounds from any bank. See “Using multiple
patch lists & bank select messages” on page 516.

5 To make the imported lists appear in Performer,
assign them to their appropriate device in the
PatchList Manager Devices window.

See “Getting patch lists to appear in Performer” on
page 512.
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USING PATCHLIST MANAGER TO LOAD
PATCH NAMES
For some MIDI devices, PatchList Manager can get
a system exclusive bulk dump — also called a patch
dump — from the instrument to extract an
accurate patch list (or lists). (See the side-bar on
page 508 for an explanation of this term.) The most
common situation in which you would want to do
this is when you have changed the sounds or banks
in the instrument (so that it is no longer in its
factory default state), and you would like the patch
lists in Performer to reflect those changes.

For example, if you have an E-mu Proteus, and you
have changed the patch map in order to access
sounds above 128, you can use PatchList Manager
to get a new patch list with names that match the
current patch map. As another example, you may
have loaded a new bank of sounds into your Korg
Ml and you would like the new bank to appear as a
patch list in Performer instead of the factory bank.

Determining if PatchList Manager supports
your device

PatchList Manager can only get patch dumps from
devices that it specifically supports. To see if your
device is supported, look at its icon in the Devices
window as shown below:

rreeMin
yr 'ts/x me; <■ <l>>

Not supported-------------------------->->O ov-eooo ■
G_____________ _  't' CD3 K2500RSupported >CEsProteus/l i

If your device is not supported, chances are good
that you can use Unisyn, Mark of the Unicorn’s
universal editor/librarian software, instead. Unisyn
currently supports 224 MIDI devices (with more
on the way). See “Getting patch lists with Unisyn”
on page 510. If you don’t have Unisyn (yet), your
only recourse at this point is to type in the patch
names by hand. See “Creating a patch list by hand”
on page 511.

Getting device help

If your device is supported by PatchList Manager,
check its Device Help window for important
information about how to use PatchList Manager
with the device. This window often contains
information about settings that you need to enable/
disable in the MIDI device to successfully get a
patch dump from it. It may also contain other
important and relevant information about the
device.

To check Device Help:

1 Click the device in the FreeMIDI Devices
window to select it.

2 Choose Device Help from the Devices menu.

The phrase system exclusive refers to a certain kind of MIDI message.
Without getting too technical, system exclusive messages are used to
communicate information that is unique to a specific MIDI instru­
ment or device. System exclusive messages have a special format that
allows them to hold a varying amount of information.They can be so
small that they are transmitted in a fraction of a second; they can be
so large that they take minutes to transmit.

The term bulk dump is used to refer to system exclusive messages
containing large amounts of information. Often, a bulk dump repre­
sents the complete internal state of a MIDI device. In other words, the
bulk dump serves as a “snapshot” of the current state of the instru­
ment. PatchList Manager usually deals with bulk dumps that consist
of one bank of sounds. For some devices, it gets the entire internal
state. Either way, you’ll probably wait at least a few seconds for the
transmission to be completed.
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The Device Help window appears. This is the
Device Help window for the KORG 05R/W:

Deuice Help
Korq 05R/V
Before using the Get Patch Dump command, use the
05R/Ws front panel to manually turn off protection for
Programs and Combis (menu pages 03A and 03B), and
enable system exclusive tn the Global MIDI filter menu (it
should read 'EXXNA' on page 02C if you set it correctly).
You only have to set these once because the 05R/W
remembers the settings unless you change the battery or
perform a Preset Data Load from page 05C.

FreeMIDI automatically sets the 05R/W to Combination
mode the first time you choose a patch from the
Combinations patch list. This combi mode MIDI message is
not sent again unless you quit all FreeMIDI applications,
open a FreeMIDI application, and then choose a patch from
the Combinations patch list again.

H
l________________

1>1®
I

Make sure the device has both its MIDI IN and
MIDI OUT connected

Before you go further, make sure that the device
has both its MIDI IN and MIDI OUT connected to
your MIDI interface. Otherwise, PatchList
Manager won’t be able to get the patch dump
successfully. If you add a connection at this time,
use the Edit FreeMIDI Configuration command in
the MIDI menu to make sure both connections are
present in your FreeMIDI configuration.

Getting a patch dump from a device

Once you have checked device help and MIDI cable
connections, you are ready to get a patch dump
from the device. By doing so, PatchList Manager
will automatically extract a patch list for each bank
in the device. To get a patch dump:

1 Click the device in the FreeMIDI Devices
window to select it.

2 Choose Get Patch Dump from the Devices
menu.

3 The Patch Dump progress dialog appears while
PatchList Manager receives the patch dump.

Depending on the format of the MIDI device’s
sysex data dump, this progress bar may fill up
slowly or all at once when the dump is complete.

( Cancel ]

Current Deuice: 05R/LLI
Click Cancel or press command-period (.) to
cancel.

1
055

1
2595

1
5095

1
7595

_______ 1
1

10095

Two things happen when the patch dump is
complete:

■ The factory default patch list is updated, and the
updated lists will automatically appear in
Performer.

■ The device’s move handle icon changes slightly
to indicate that it contains a sysex data dump.

Patch

dump
indicator

FreeMIDI Deulces
OEUICEJZMOPULEJ CM. PATCHLIST Cuhent P»:Ch CM

> EraK2500R
> Era Proteus/1
xz==D5R/W

0 Chahoel 1
fl Channel 2
/J Channel^
fl Channel \

1
2
3
4

05R/W banks
05R/W banks
05R/V banks
05R/W banks

Sunrise
Sunrise i
Sunrise i
Sunrise

Sending the dump back after editing it

For most instruments, PatchList Manager will
allow you to edit the patch lists (change names of
sounds, etc.) and then send the bulk dump back to
the instrument to update the device itself. See
“Sending a patch list back to a configured device
after editing it” on page 514.

Editing the bulk dump in its raw hex form

If you enjoy doing such things, PatchList Manager
lets you view and edit bulk dump in its raw
hexadecimal form. To do so:

1 Click the device in the FreeMIDI Devices
window to select it.

2 Choose Edit patch dump from the Devices
menu.
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Use this section to trans­
mit any sysex message
you want to the device.

If the bulk dump consists of
several separate sysex messages,
use these buttons to scroll
through them.

Edit the hex data
directly here.

05R/UI
length: 2 ( Transmit )

X 0: fO F7

IO
! W

Length: 10750 ( << ) 1/4 ( ) (. Sar» )
0: fO 42 30 36 4C 00 00 53 .B06L.S
8: 75 6E 72 69 73 65 20 20 unrlse

10: 20 20 01 00 22 00 03 7F
18: 41 00 01 OC 08 06 21 ID A..........1 .
20: 59 63 62 63 ID 00 00 00 Ycbc....
28: 00320000 00004000 .2....8.
30: 00JJ2 00 00 00 00 00 39 .............. 9

3
a

GETTING PATCH LISTS WITH UNISYN
If you have a synthesizer or sound module that is
not supported by PatchList Manager, Unisyn can
save you the trouble of typing in the patch lists by
hand. Unisyn is Mark of the Unicorn’s Universal
Editor/Librarian software. Unisyn supports 224
MIDI devices (more are on the way) with complete
library and editing functions. If PatchList Manager
doesn’t support one of your MIDI devices, chances
are that Unisyn does. Contact Mark of the Unicorn
to see if your device is supported.

Unisyn specializes in getting banks from synths.
When it gets a bank, it automatically publishes the
patch list for the bank to all FreeMIDI-compatible
programs. If you want to work further with it in
PatchList Manager, you can load this Unisyn-
generated patch list into PatchList Manager as
follows:

1 Establish a bank for the synth using Unisyn’s Get
Bank command.

Consult the Unisyn manual if you need help with
this step. As soon as Unisyn gets (or sends) a bank,
it “publishes” an updated patch list for the bank to
all FreeMIDI programs. If the synth has more than
one bank, Unisyn updates all RAM banks.

2 Back in PatchList Manager, select the device by
clicking its name in the FreeMIDI Devices window.

V.'AEg] FreeMIDI Device?

3 Choose Load FreeMIDI Patch Lists from the
Devices menu.

One or more patch lists are added to the bottom of
the list in the Patch Lists window.

The imported patch list----------

4 (Optional) Rename the newly loaded patch
list(s) by clicking its name in the Patch Lists
window.

This step is especially recommended if you are
loading multiple lists for a single device because it
helps you better identify each bank.

5 (Optional) If Unisyn produced several separate
patch lists for the device (one for each bank), create
a folder in the Patch Lists window and place them
in the folder.

See “Grouping patch lists in a folder”on page 514.
If the MIDI device supports some form of bank
select scheme for multiple banks, the patchlist for
each bank will already have the appropriate bank
select data assigned to it.

6 To make the imported list (or newly created
folder) appear in Performer, assign it to the
appropriate device in the PatchList Manager
Devices window.

510 L
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See “Getting patch lists to appear in Performer” on
page 512.

7 If the device has other banks that you want to
import, repeat this procedure for each bank.

For example, Unisyn may be able to import data
card banks for the device. In this case, you can
import a patch list for each data card. In fact, you
can import as many banks as you want into
PatchList Manager and then place them together in
a folder so that you have all the names at your
fingertips in Performer. If you do, however, you’ll
need to keep track of which banks are actually
loaded into the instrument at any given moment.

CREATING A PATCH LIST BY HAND
If none of the methods discussed in the previous
sections for creating a patch list apply to you, you
can create a new patch list manually and type in the
patch names by hand.

To create a new patch list:

1 Choose Add Patch List from the Patch Lists
menu.

A new patch list appears at the bottom of the list. It
is named “PatchList 1”.

2 Click its name and enter an appropriately
descriptive name for the patch list.

UPatchtist 1

vD General MIDI Lists
♦ Strings
♦ Basses
♦ Guitars
♦ Brass

Piano*

3 Double-click the new patch list’s move handle
icon to open its patch list window.

The sound names window appears. Alternately,
you can choose the patch list’s name from the
Windows menu to open its window.

SZ'HaEHh, Patchlist 1
MTCM H«M»

1 Patch 1 a
2 Patch 2 J
3 Patch 3
4 Patch 4
5 Patch 5
6 Patch 6
7 Patch 7
8 Patch 8
9 Patch 9

10 Patch 10
11 Patch 11
12 Patch 12
13 Patch 13
14 Patch 14
15 Patch 15
16 Patch 16
17 Patch 17
18 Patch 18
19 Patch 19
20 Patch 20
21 Patch 21 a

4 Choose Set Numbering Format from the patch
list window mini-menu to set the numbering of the
patch list.

See “Setting the numbering format for a patch list”
on page 513 for more information.

5 Click the first patch name in the list, “Patch 1 ”
and type in a new name.

6 Press the Return key on your Mac keyboard to
confirm the edit, or press the Enter key to move to
the next name in the list.

Similarly, you can move up and down between
patch names with the up and down arrow keys.

Patchlist 1
% i ex
•j 2 Patch 2
■u 3 Patch 3
■j 4 Patch 4
1 5 Patch 5
1 6 Patch 6

7 If you’d like to list the names alphabetically,
choose Sort by name from the mini-menu.

I PATCHLIST MANAGER
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8 (Optional) If you are creating several separate
patch lists for the device (one for each bank), create
a folder in the Patch Lists window and place them
in the folder.

See “Grouping patch lists in a folder” on page 514.
If the MIDI device supports some form of bank
select, you will want to set up the bank select
message for each list so that you can effortlessly
choose sounds from any bank. See “Using multiple
patch lists & bank select messages” on page 516.

9 To make the new list (or folder) appear in
Performer, assign it to the appropriate device in the
PatchList Manager Devices window.

See “Getting patch lists to appear in Performer” on
page 512.

GETTING PATCH LISTS TO APPEAR IN
PERFORMER
To make a patch list or patch list folder show up in
Performer’s pop-up menus, you need to assign it to
the device in PatchList Manager’s Devices window.
You can assign the patch list to all of the device’s
MIDI channels, or you can assign it to individual
channels. You can even assign different lists to
different channels. For example, you might assign a
drum kit list to channel 10 and a list of all other
sounds to channels 1 -9 and 11-16.

To assign a patch list or patch list folder to all of a
device’s MIDI channels at once:

1 In the FreeMIDI Devices window, press in the
Patch List column to the right of the device name.

A pop-up menu of patch lists appears.

V-zLff [D| FreeMIDI Deuices

A

✓None

*

r>ga»-2500P

K2000 banks
5
6

fl
fl
fl
fl
fl
fl
fl
fl
fl

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9

8
9

DW-8000 Programs
Proteus/1 Presets

V
S]

■jQ DV-S000
fl Channel 1

vQ Dtf-8000
fl Channel 1

T7 E2 K2500R
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl
fl

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9
Channel 10
Channel 11
Channel 12
Channel 13
Channel 14
Channel 15
Channel 16

t> (33 Proteus/1

Click here

2 Choose the desired patch list.

FreeMIDI Deuices
ttUICfS/TumifS CM PATCHLIST CLMCHT PmTCM C'.M

•vQ DW-8000
fl Channel 1

XZEEDK2500R
fl Channel 1
fl Channel 2
fl Channel 3
fl Channel 4
fl Channel 5
fl Channel 6
fl Channel 7
fl Channel 8
fl Channel 9
fl Channel 10
fl Channel 11
fl Channel 12
fl Channel 13
fl Channel 14
fl Channel 15
fl Channel 16

> ECD Proteus/I

1

1 K2000 banks
2 K2000 banks
3 K2000 banks
4 K2000 banks
5 K2000 banks
6 K2000 banks
7 K2000 banks
8 K2000 banks
9 K2000 banks
10 K2000 banks
11 K2000 banks
12 K2000 banks
13 K2000 banks
14 K2000 banks
15 K2000 banks
16 K2000 banks

A 1

V
0

To assign a patch list to an individual MIDI
channel:

1 If the MIDI channels for a device are hidden,
click the Expand button to display them.

'SZ tElilSl B'S, FreeMIDI Deulcei
et'MictS/wiuits cm tutomn tuxtNi

2 Press in the Patch List column next to the MIDI
channel and choose the desired list from the pop­
up menu.
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MAKING CHANGES TO A PATCH LIST
In a patch list, you can:

■ Edit the names of the sounds

■ Change their order in the list by dragging them
up and down

■ Sort them by numerically or alphabetically

■ Change the numbering scheme

■ Change the patch change number for any sound

Opening up a patch list

To open a patch list, double-click the patch list’s
name or move handle icon to open its patch list
window.

NAME
♦ K2000 Programs
♦ Proteus/1

^^•sProteus/2

199
128
128
128

\JPsQ-M

Roland JV880 Perform
128

16 V.'gT[S]\UJauestation SB
♦ \Roland JV880 Patch 64 FATEH NAME

vQ &5R/V Banks
♦ \ym Kits
♦ BarXO

8
128

"u 00
i 01
a 02
a 03
a 04
a os
a 06
a 07
a os

Layers Of Funk
Leaving the Pod
Vocal Highlands
MIDI Piano
OD Mini 2
Saw Bass
Bliss Pad
AFT Vocal Pad
Guitaro

5

The sound names window appears. Alternately,
you can choose the patch list’s name from the
Windows menu to open its window.

Editing a patch list

Here is a summary of what you can do in the patch
list:

To do this

Change the name
of a sound

Do this

Click the patch name in the list that
you wish to edit, enter a new name
and press the Return key on your
Mac Keyboard to confirm the edit.
The new name appears. If you press
the Enter key instead of Return, the
edit is confirmed and the next patch
name is ready for editing. Similarly,
you can move up and down between
patch names with the up and down
arrow keys.

To do this Do this

To move a sound
up or down in the
list

Drag its handle

To sort the sounds
alphabetically

Choose Sort by name from the mini­
menu

To sort the sounds
numerically

Choose Sort by number from the
mini-menu

To change the
numbering scheme

Choose Set Numbering format from
the mini-menu. For more informa­
tion, see “Setting the numbering for­
mat for a patch list” on page 513.

To create a custom
numbering scheme

Choose Show ASCII String from the
mini-menu. For more information,
see “Creating a custom numbering
format” on page 514.

To change the
overall number of
sounds

Accomplished with the Set Number­
ing Format mini-menu command.

To make the num­
bering start at 0
instead of 1 or vice
versa

Accomplished with the Set Number­
ing Format mini-menu command.

To set up a bank
select message for
the list

See “Using multiple patch lists &
bank select messages^’ on page 516

To change a
sound’s patch
number

Click its current patch number

Setting the numbering format for a patch list

Most MIDI devices number the sounds in a bank
using one of several common conventions. For
your convenience, PatchList Manager lets you
choose the numbering scheme that most closely
matches the instrument. To set the numbering
format, choose Set Numbering format from the
sound names window mini-menu or click in the
Length column. Choose the appropriate options
and click OK.
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You can always change the format, but you
can’t change the number of patches in the list after
it has been assigned to a device MIDI channel. If
you need to do so, you have to temporarily de­
assigned it, make the change, and then reassign it.

Set Numberpng Format
Set Bank S-^ct..
Set MIDI Message...
Got Cbaooul Mask.

Sliow Book SeUot
✓ Show Program Change
✓Show ASCII String

GuitarPiano
HonkTonkPno
Clavinet

om-8000

-------— Sort by Itant
Bj 1 Sort by Number

Figure 53-6: Setting the numbering format.

Creating a custom numbering format

If your device has a specialized numbering scheme,
use the Show ASCII String command in the mini­
menu instead. This displays a column in the patch
list in which you can type any number or text string
next to each patch. This gives you complete
flexibility in setting up the patch numbers. Use the
Show Program Change and Show ASCII String
commands to hide the program change column
and display the ASCII numbers.

Sending a patch list back to a configured
device after editing it
If the patch list you are editing is one that you
loaded from a configured device using the Get
Patch Dump command, making changes in the
patch list may also change the patch dump,
depending on the device. Check the device’s
Device Help (see “Getting device help” on

page 508) to see what the patch dump actually
contains (it varies by instrument). If the patch
dump only contains the patch names, then you can
only change the names of the sounds when you
send it back to the instrument. If the patch dump is
a complete bulk dump of the whole instrument,
you may be able to control other aspects of the
bank. Device Help will give you specific advice for
your instrument.

Duplicating a patch list

At times, you may need to duplicate a patch list to
make a separate copy of it. For example, you may
want to place the list in more than one folder. To
duplicate a patch list:

1 Click the patch list move handle to select it.

2 Choose Duplicate from the Patch Lists menu.

GROUPING PATCH LISTS IN A FOLDER
A patch list folder allows you to group several patch
lists together. You can then assign the folder to a
MIDI channel, which makes all of the lists available
to it. The resulting pop-up patch list for the MIDI
channel is hierarchical and shows each patch list as
shown below.

Al5 Deep Breath Ped

AieClaciVoicei

A26 Ag>p Rhode> *66 Fingered Bail

Ata Hc-cce Du«

A51 12 String Guitar
A32 Cling Guitar

A22 Ao Plans Hybrid
A23 Cry rial Rhode* 2

A23 Vhispery Piano
AS I Pipe Organ

A62 Yoody Bui
A63 Veb-Svitch Bui
A64 Slap Bus

I'ASa YfieV* PGrlTT"
A55 China Guitar
A56 Reso Str at
A57 Big Country
A53 Veto-Cnxdh

Al J Killer Ped
A12PuUePad

FreeMIDI Deiflces*

fl Channel 2 JD-990 Folde
Preiet B ►
Internal I

fl 3 3 JD-990 Folde-
fl Channel 4 JG-9,0 Folder PafchK
fl 5 JD-990 FoHer PatchSS
fl Channels 6 JD-990 Folder Patch 65
fl Channel 7 7 JD-990 Folder Patch 65
fl Channel 10

Ml
fl Channel 1

10 JD-990 Folder Patch 65

Folders are ideal for handling devices that have
multiple banks, and therefore multiple patch lists.
For more information about multiple banks, see
“Using multiple patch lists & bank select messages”
on page 516.
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To group patch lists in a folder:

1 Choose Add Folder from the Patch Lists window
mini-menu.

The folder appears at the bottom of the list.

2 Click its name to rename it.

♦ Wavestation SR
♦ ESQ-M
♦ Drum Kits
♦ Bank A
♦ Bank G
♦ Roland JV880 Patch

t> r*l General MIDI Lists_____

128
128

8
100
128
64

V*

3 Drag each list on top of the new folder by
dragging the diamond list icon.

Once inside the folder, the lists are indented to the
right to indicate that they are inside the folder, just
like the System 7 Finder. Use the show triangle to
show or hide the patch lists in the folder. You can
put as many patch lists as you like in the folder. You
can use this feature to help organize patches.

4 Assign the folder to the device it is intended for.

sWx Patch Lists
NAME ENGTH BANK USED COMMENT

♦ K2000 Programs 199 y* A
♦ Proteus/1 128
♦ Proteus/2 128
♦ Roland JV880 Perform 16
♦ Wavestation SR 128
♦ ESQ-M 128

Drum Kits 8
♦ Roland JV880 Patch

>  General MIDI Lists
64

IIGLlOSP/V Banks 1 ....—,
Bank A 100

♦ Bank G 128

See “Getting patch lists to appear in Performer” on
page 512 for information about how to do this.

5 (Optional) If you want a particular bank in the
folder to appear on only certain MIDI channels for
the device, use the Set Channel Mask command in
the patch list’s mini-menu.

See the next section for more information.

Making a patch list appear on only certain MIDI
channels

When you place multiple patch lists in a folder and
then assign the folder to the entire device as
described in “Getting patch lists to appear in
Performer” on page 512, all of the patch lists in the
folder will appear on all the device’s MIDI
channels. In some cases, however, you may want to
limit the channels on which a particular patch list
appears. For example, if your MIDI instrument
only plays drum kits on channel 10, you’d want the
drum kit patch list to appear on channel 10 only,
and you’d want all of the other patch lists to appear
on channels 1-9 and 11-16. To do so, you can set
the channel mask for each patch list in a folder. The
channel mask lets you choose which channels the
patch list will appear on. This can only be done on
patch lists that currently reside inside a folder.

To set the channel mask for a patch list:

1 Open the patch list by double-clicking its
diamond move handle in the Patch Lists window.

2 Choose Set Channel Mask from the mini-menu.

GM Drum Kits
— Sort by Name

( Sort by Number

Set Numbering Format...
« Set Bank Select..
■ Set MIDI Message...

2. Show Bank Select
J ✓ Show Program Change
2( Sh°w ASCII String

■u 0 00 GM Kit
32 32 Jazz Kit

■- 48 48 Orch Kit
■u 16 16 Power Kit

3 If this command is grayed out, the patch list is
not in a folder yet.
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4 Click the channels as necessary so that the
channels on which you want the list to appear have
a black dot.

Channel Mask k

12 5 1 5 6 7 6

9 1011 12 1314 1516

CM Drum Kits

Please choose the channels on which
this bank can appear. The bank will
not show up on any channels that
are not checked above.

USING MULTIPLE PATCH LISTS & BANK
SELECT MESSAGES
For devices that support MIDI bank select
messages, set up a folder containing one patch list
for each bank. (See the earlier sections of this
chapter to learn how to do this.)

Once you’ve arranged all the banks into a folder
and assigned the folder to the MIDI channels for
the device, all that is left to do is assign the
appropriate bank select number to each patch list.

Determining your device's bank select
implementation

Once you’ve set up a device in FreeMIDI for bank
select, you need to find out is how your MIDI
device handles bank selection. This can get a little
tricky because all MIDI devices that support bank
select do so a little differently. Often, you’ll have to
wade through the MIDI implementation charts in
the back of the manual to find the correct bank
select messages.

The following sections tell you what you should
find out about your synth.

Which banks can be accessed via bank select?

The most important thing to know about a bank is:
can it be called up with a bank select message and
can items within the bank be called up with a MIDI
program change event?

Try to get a feel for what the banks are. Some banks
are not actually sounds. Instead, they consist of
internal configurations for the synth, such as
multi-timbral setups (like Yamaha and Korg
multis) or multiple layers of sounds (such as
combis). Some banks represent a card slot and are
therefore only available when a card is present.
Banks can be designated as General MIDI, which
means that they contain a standard set of sounds or
drum kits. Some banks are drum kits only and may
only be available on certain MIDI channels
(usually channel 10).

Does the device use one controller or two for
the bank select message?

Some devices use a single MIDI controller, either
#0 or #32. Others use both.

What is the controller value for each bank?

MIDI controllers have a number that identifies
them (such as #32), but they also have a value
between 0 and 127. The controller number
identifies the controller as a bank select message,
and its value calls up a specific bank. Here’s an
example:

Bank Controller used to call it up

Bank A Controller #32, value 0

Bank B Controller #32, value 1

Bank C Controller #32, value 2

If your device uses both controller #0 and #32, be
sure to obtain the value for both for each bank.
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The fun part about this is that often the device’s
manual gives you this information in hexadecimal
form. Don’t worry. PatchList Manager lets you use
the hexadecimal numbers without even knowing
what they are.

Once you are armed with the information above,
you are ready to proceed.

Setting up bank select devices in FreeMIDI

To use bank select messages with a MIDI device,
you first need to tell FreeMIDI which MIDI
controller the device uses for bank select:

If the synth uses both controllers for bank select,
choose both bank select properties. See
“Determining your device’s bank select implemen­
tation” on page 516 if you need help with this step.

4 Click OK to confirm your choice.

5 Repeat this procedure for each device in your
FreeMIDI setup that uses bank select.

Assigning a bank select number to a patch list

Now you are ready to assign the bank select
controllers to each patch list:

1 Open FreeMIDI Setup.

If you are running Performer or PatchList Manager,
choose Edit FreeMIDI Configuration from the
Basics menu or MIDI menu, respectively. If are
running neither, double-click the FreeMIDI Setup
program in the FreeMIDI applications folder on
your hard disk.

2 Double-click the icon for a MIDI device that
supports bank select.

The Device Specification window appears.

Name:

Transmit Ch

( Cancel )

✓ Controller 52 -Dank select

Manufoctur,
I K°ni

l*7"l'Tl :
Receive Che

Properties:_________________ _____________
O*n*r*l MIDI, ControlWr 0 ■ B»nk f»Uct/Ccntrolkr 32 ■ Ou* j»Wct

FreeMIDI Djulce Specification .

(icons... 8€l)

Controller
Receives Clock
Receives MIC
Transmits Clock
Transmits MTC
MIDI Machine

✓ General MIDI
✓ Controller 0 - Dank select

(1 -16)

-1

s
E

3 Choose the appropriate bank select device
properties from the Properties pop-up menu.

1 Places all of the patch lists together in a folder.

See “Grouping patch lists in a folder” on page 514.

2 Click in the Bank column to the right of the
Patch List name.

The Bank Select dialog box appears.

3 Choose the necessary number format, and type
in the correct bank select number or numbers.

If the bank number information you got from the
device’s manual is in hexadecimal format, you’ll
need to choose the Hexadecimal option.
Otherwise, use decimal format.

4 Click OK when you are done.
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S Repeat this procedure for each bank.

6 Assign the folder to the MIDI channels for the
device.

See “Getting patch lists to appear in Performer” on
page 512.

What to do if bank select doesn't work

Once bank select messages are assigned as
described in the previous section, you can choose
any patch from the pop-up patch lists in Performer,
PatchList Manager, and FreeMIDI setup, and doing
so should call up the correct sound from the
correct bank.

If it doesn’t, check to make sure that the device has
been given the proper Bank Select device property
in your FreeMIDI setup. To do so, choose Edit
FreeMIDI Configuration from the MIDI menu.

Next, check the synth. Sometimes they have a
mode that makes them ignore bank select or
program changes. Still no response? Then the
controller information you have is probably
incorrect, or perhaps the instrument still isn’t in
the correct mode. Or the actual MIDI connections
between FreeMIDI and the synth are somehow not
working correctly.

Assigning additional MIDI messages to a bank

Some devices don’t use controller #0 or #32 for
bank select and use another type of MIDI message
instead. For these devices, you can type in any
MIDI message the device calls for. This includes
system exclusive data, a MIDI program change
event with certain value, or any other type of event.

To assign a MIDI message to a patch list:

1 Open the patch list by double-clicking its icon in
the Patch Lists window.

2 Choose Set MIDI Message from the mini-menu,
or click in the “CM?” column in the Patch Lists
window next to the patch list.

Kurzivell 1000PH
Rnrt hii Mam# dZZZ

MCI IU»>g»
t aiT•j Al5
5 Al6
1 Al7

Deep Breath Pad
Pure Glass
Cherish

—sOrt by Name
Sort by Number

°J Al | Set Numbering Format

1 Al8
■u A21
■u A22
1 A23
1 A24
5 A25
i A26
% A27
1 A28

GlassVoices
Ao. Piano 2
Ao. Piano Hybrid
Crystal Rhodes 2
E. Piano 1
E. Piano 2
Agogo Rhodes
Seq E. Piano
Whispery Piano

3 Choose the desired number format (either
decimal or hexadecimal) and type in the MIDI
message.

4 Click OK when you are done.

Now, the MIDI message you entered will be
automatically sent whenever necessary to call up
the bank (such as at the beginning of a session or
when you change banks).

SAVING YOUR PATCH LISTS
When you are done setting up your patch lists, you
need to save your work:

1 Choose Save from the File menu.

2 Type in a name for the patch list file.

3 Click Save.

PatchList Manager then saves the entire contents of
the FreeMIDI Devices and Patch Lists windows in a
file on your hard disk. In addition, PatchList
Manager tries its best to stay in sync with the
FreeMIDI devices in your current FreeMIDI
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Configuration. Each PatchList Manager document
is associated with a specific FreeMIDI Configu­
ration. If you change FreeMIDI Configurations,
PatchList Manager will close the current file and
open the file associated with the new, current
FreeMIDI Configuration. If you change back to a
FreeMIDI Configuration, PatchList Manager will
automatically use the corresponding PatchList
Manager file.

HOT TIPS
Here are some things you can do with PatchList
Manager.

Splitting up a patch list into instrument
categories

PatchList Manager allows you to organize the
sounds in a device into instrument categories as
shown below in Figure 53-7. To do so, you will
make one copy of the patch list for each category. In
the list, you’ll move the patches that you want to
appear in the category to the top of the list, and
then hide the rest. Finally, you’ll group the lists into
a folder and give them an appropriate name for
each category.

P-001 Pitno 1

3

10

12

p Ch»nn»l 2
P Channel 3
P Channel 4
P Channels
P Channel 6
P Channel?
P Channel 8
P Channel 9
P Channel 10
P Channel 11
P Channel 12
P Channel 13

003 Piano 3
004 Hanky Took Piano
005 E. Piano 1
006 E. Piano 2
007 Harpsichord
008 Clavinet

Chromatic Percussion
Organ
Guitar
Bass
Strtngs/Orchestra
Ensemble
Brass
Retd
Pipe
Synth Lead
Synth Pad
Synth FX
Ethnic
Percussive
Sound FX
Drum Kits
SFX

SoundCanvas I i

FreeMIDI Deulces~

Figure 53-7: Patch lists that have been organized into instrument
categories.

To split up a patch list into instrument categories:

1 Duplicate the original patch list.

For information on duplicating a patch list, see
“Duplicating a patch list” on page 514.

2 Rename the duplicate list with the category
name, such as Pianos or Basses.

Click the name of the patch list in the Patch Lists
window to pop-edit the name.

3 Double-click the move handle of the list to open
it.

4 Drag the sounds that belong to that category to
the top of the list.

A short cut for this is to type in a space at the
beginning of the name of each sound and then
choose Sort by name from the mini-menu. When
you are done, you can remove the spaces.

5 Count the number of patches that are now at the
top of the list that you want to include in the
category.

6 Choose Set Numbering Format from the patch
list mini-menu and type in the number of patches
you just counted.

The list now displays only the patches you chose for
the category.

7 Repeat this procedure, starting at step 1, for
each category you would like to create.

8 After you have created a separate patch list for
each category as described in this procedure, place
them together in a folder.

See “Grouping patch lists in a folder” on page 514.

Getting back the factory default patch Lists
provided by FreeMIDI
There may be times when, after assigning your own
patch list (or folder) to a device, you want to return
to the factory default patch lists that were originally
provided for the device by FreeMIDI. To restore the 
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Shift-click modules to select more than one.factory default patch lists, choose None from the
Patch List column next to the device name in the
Devices window as shown below.

X3 b*r.kj
OSR/Wtur.H

Figure 53-8: Restoring FreeMIDI's original factory default patch lists
for a device.

Duplicating MIDI channels in a device

In PatchList Manager, the MIDI channels listed
below a device are called modules. Modules are
added to Devices automatically by PatchList
Manager. The number of modules added and their
MIDI channel assignments are based on the
number of MIDI receive channels specified for the
device in FreeMIDI Setup.

There is rarely a need to do so, but you can add,
edit, and delete modules for a device.

To add modules:

1 In the FreeMIDI Devices window, select a
device to which you wish to add a module.

2 Choose Create Module from the mini-menu.

The new module appears at the bottom of the
selected devices module list.

3 [Optional] Assign a MIDI channel for the
module by selecting it from the pop-up menu in
the CH column.

4 [Optional] Enter a name for the module by
clicking its name and then typing.

To delete a single module:

1 In the FreeMIDI Devices window, select the
module you wish to delete.

2 Choose Delete Module from the mini-menu.

To delete all modules for a device:

1 Select the device itself (not one of its modules).

2 Choose Delete Module from the mini-menu.
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chapter 54 Editing FreeMIDI Device Files

This chapter explains how to:

■ Edit the icons that FreeMIDI uses to display
devices in the FreeMIDI Configuration window.

■ Add devices to the FreeMIDI Devices file so that
MIDI devices that are in your studio but not
already defined in the current version of FreeMIDI
will appear in the manufacturer and model name
pop-up menus in places such as the Quick Setup
dialog box and the FreeMIDI Device Specification
dialog box.

WORKING WITH FREEMIDI ICONS
You can add, delete, and edit icons that ship with
FreeMIDI so that you can customize the look of
your FreeMIDI configurations.

Adding or Replacing Icons to FreeMIDI

To add icons to FreeMIDI’s icon list:

1 Copy the icon you wish to add from your icon
editor to the Clipboard, so that it will be ready to
paste.

When you create an icon, note that there are
actually three sizes for the display in FreeMIDI:
small, medium, and large. If you make an icon for
each size, you’ll need to paste in the three icons one
at a time using this procedure.

2 If you have not done so already, open FreeMIDI
Setup by double-clicking its icon in the Finder.
Alternately, you can open FreeMIDI Setup by
choosing the Edit FreeMIDI Configuration
command in any other FreeMIDI application.

The FreeMIDI Configuration window will open
displaying the current FreeMIDI configuration.

3 Choose Create Device from the Configuration
menu or type command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box
appears.

FreeMIDI Deuice Speclflcotlon I . . '

Nome: |

Receive Channels:

ControlWr, R»c«lv»i Clock, TrtnimlU Clock [Icons... 3£I)

[ Cancel ]

llPS-M

Manufacturer:
| Ensonlq

Studio Locotlon:
| MIDI Time Pieces, Mod..7~)

Model:
i ftmh

Properties: | Controller,...

Transmit Channels:

Figure 54-1: FreeMIDI Device Specification Dialog Box.

4 Click Icons or type command-I on your Mac
keyboard.

The Device Icons dialog box appears.

: Deuice Icons ’—..........

Deuice Name: Proteus/2

— 1=1 3/19

I CUt J

[ Copy )

[ Paste j

|[ OK )|

J......................I* ( Cancel ]

Figure 54-2: Icons Dialog Box.

5 If you want to replace an existing icon, scroll to
it now.



6 Click one of the three boxes shown to select the
size of the icon that you are pasting.

FreeMIDI has three possible sizes at which it can
display the device icon. Each size is shown in the
boxes. Click the box into which you want to paste.

7 Click Paste to paste the icon from the Clipboard
into FreeMIDI’s icon set.

If there is an icon currently selected, you are asked
whether you want to replace the current icon or
create a new icon.

8 If you want to add a new icon, choose the create
option and the new icon options.

The icon is added to FreeMIDI’s icon set and you
can assign it to any FreeMIDI device.

9 If you want to replace the existing icon, choose
the replace option.

The icon replaces the currently selected icon. For
more information, see“Editing FreeMIDI Devices”
on page 485.

10 Click OK to close the Icons dialog box.

The FreeMIDI Device Specification dialog box
reappears.

11 Click Cancel to close the FreeMIDI Device
Specification dialog box.

If you do not cancel the FreeMIDI Device
Specification dialog box, you are adding a
FreeMIDI device to your FreeMIDI configuration.

Deleting FreeMIDI Icons
To delete icons from FreeMIDI’s icon set:
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1 If you have not done so already, open FreeMIDI
Setup by double-clicking its icon in the Finder.
Alternately, you can open FreeMIDI setup by
choosing the Edit FreeMIDI Configuration
command in any other FreeMIDI application.

The FreeMIDI Configuration Window opens
displaying the current FreeMIDI configuration.

2 Choose Create Device from the Configuration
menu or type command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box
appears as shown in Figure 54-1 on page 521.

3 Click Icons or type command-I on your Mac
keyboard.

The Icons dialog box appears as shown in
Figure 54-2 on page 521.

4 Use the horizontal scroll bar and arrows to scroll
the FreeMIDI icon list until you see the icon you
wish to delete in the center panel.

Alternately, you can click icons to the left or right of
the center panel and they will be scrolled to the
center panel.

5 Click Cut.

Since this operation cannot be undone, you are
asked to confirm this deletion.

6 Click OK to close the Icons dialog box.

The FreeMIDI Device Specification dialog box
reappears.

7 Click Cancel to close the FreeMIDI Device
Specification dialog box.

If you do not cancel the FreeMIDI Device
Specification dialog box, you are adding a
FreeMIDI Device to your FreeMIDI Configura­
tion.
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Editing FreeMIDl Icons
To edit icons in FreeMIDI’s icon set:

1 If you have not done so already, open FreeMIDl
Setup by double-clicking its icon in the Finder.
Alternately, you can open FreeMIDl setup by
choosing the Edit FreeMIDl Configuration
command in any other FreeMIDl application.

The FreeMIDl Configuration window opens
displaying the current FreeMIDl configuration.

2 Choose Create Device from the Configuration
menu or type command-K on your Mac keyboard.

The FreeMIDl Device Specification dialog box
appears as shown in Figure 54-2 on page 521.

3 Click Icons or type command-I on your Mac
keyboard.

The Icons dialog box appears as shown in
Figure 54-2 on page 521.

4 Use the horizontal scroll bar and arrows to scroll
the FreeMIDl icon list until you see the icon you
wish to edit in the center panel.

Alternately, you can click icons to the left or right of
the center panel and they will be scrolled to the
center panel.

5 Click Copy to copy the icon to the Clipboard.

6 Click OK to close the Icons dialog box.

7 Click Cancel to close the FreeMIDl Device
Specification dialog box.

8 Launch your icon editing program and paste the
icon into your editing program.

9 Make the icon look the way that you want and
then copy it back to the Clipboard.

10 Choose Create Device from the Configuration
menu or type command-K on your Mac keyboard.

The FreeMIDl Device Specification dialog box
appears.

11 Click Icons or type command-I on your Mac
keyboard.

The Icons dialog box appears.

12 Click Paste to paste the icon from the Clipboard
into FreeMIDI’s icon set.

You are asked whether you want to replace the
current icon or create a new icon. The new icon is
added to FreeMIDI’s icon set and you can assign it
to any FreeMIDl device. For more information, see
“Editing FreeMIDl Devices” on page 485.

13 Click OK to close the Icons dialog box.

The FreeMIDl Device Specification dialog box
reappears.

14 Click Cancel to close the FreeMIDl Device
Specification dialog box.

If you do not cancel the FreeMIDl Device
Specification dialog box, you are adding a
FreeMIDl device to your FreeMIDl configuration.

Preserving Your Custom Icons
Icons are stored in a file called FreeMIDl Icons,
which is located in the FreeMIDl Folder in the
System Folder. If you create your own icons and
paste them into FreeMIDl as described in this
chapter, make a copy of the FreeMIDl Icons file as a
backup copy so you don’t lose your work.

EDITING TEXT FILE
Edit the text within the FreeMIDl Devices text file
so that FreeMIDl can have more information about
various MIDI devices than the information that
was shipped with your version.
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To edit the text in the FreeMIDI Devices file:

1 Open your text editor application.

You can use any text editor which can save files in a
“text only” format. Even the TeachText application
from Apple will work.

2 Open the FreeMIDI Devices file.

This file is found within the FreeMIDI Folder that
is located inside your System Folder.

3 Enter the information that you wish to add.

The file contains a description of the data format
that is required by FreeMIDI. Enter the
information about devices following this format. If
you do not understand this format by reading these
descriptions, we suggest that you have someone
else do this type of editing for you.

4 Save the file in the “text only” format.

TeachText does this automatically.

5 The next time you open FreeMIDI Setup your
changes appear in the various pop-up menus.
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appendix a Troubleshooting and Customer
Support

PREVENTING CATASTROPHE
Keep up-to-date backups of your sequences as you
work, so that you always have copies of the most
recent work you have done. Almost any software
problem is survivable as long as you have kept
backups of your work. Refer to Helpful File and Disk
Hints in the chapter Working With Files for detailed
suggestions about file management.

Keep plenty of free space (20K or more) on any disk
containing sequences which you are actually
working on. This will prevent the Macintosh from
attempting to save your file onto a disk that doesn’t
have enough space for the whole file. Running out
of disk space while saving can result in an
unreadable and irretrievable sequence.

Keep track of your RAM (Random Access Memory)
usage with the Memory Window, and save often.
Recording and editing both use a great deal of
RAM. Also watch the Message Center — it will
sometimes warn you that a recording pass or a
requested edit operation requires more memory
than is available. In this situation, try recording or
editing the region in smaller sections; for example,
transpose a 20-track, 200-measure sequence 5
tracks at a time.

Keep your Mark of the
Unicorn master disks
locked (write-
protected) at all times
by sliding the tab on the
back of the disk open so
that light can be seen
through the rectangular 

aperture. We recommend that you use the master
disks only as resources from which you can make
installed copies, and as key disks with which to 

start the program when you are working with an
unauthorized copy. Should your working copy of
Performer become damaged, you will always be
able to go back to the master disk for fresh working
copies.

TROUBLESHOOTING
Troubleshooting is always simplest and most
effective when the exact problem can be specified
clearly and concisely. If you are surprised by an
error message or by seemingly erratic behavior in
the program, take a moment to jot down the
relevant details: exactly what the error message said
(including any error ID numbers), what actions
were done on-screen just before the problem
occurred, what kind of file you were working with,
how you recovered from the problem, and any
unusual conditions applying during the
occurrence of the problem. This may not enable
you to solve the problem at once, but will greatly
aid in isolating the problem should it reoccur.

If the problem you are encountering seems
inconsistent, try to determine what the necessary
pattern of actions are that will cause it to occur.
Genuine bugs in application software like
Performer are almost always consistent in their
manifestation: the same set of actions under the
same conditions invariably brings about the same
results. Determining the exact cause of a bug often
requires experiments which replicate the problem
situation with one factor changed: starting the
program from a different disk drive, restarting the
Macintosh with a system folder containing
different versions of the System File and the Finder,
working with a new sequence instead of an existing
one, etc.
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If the problem is truly inconsistent, then it is likely
to be a hardware problem: improper disk drive
alignment, a loose connection, overlong cables,
signal ‘aliasing’, etc. For example, if you play a
sequence several times consecutively from 1111000
without making any changes to it, and on one pass
you hear a wrong note at 3| 11043, and on another
pass you hear a different wrong note at 6121332, and
the other times it plays back without any errors, the
problem is almost certainly external to Performer.
At this point you will want to experiment with
changes in your hardware configuration (where
possible) to attempt to isolate the source of the
problem.

The most important tools for tracking down
problems are the MIDI Monitor window and the
Event List windows. The MIDI Monitor window
indicates the type and channel assignments of all
MIDI data being sent to Performer. If there is a
hardware problem, or if your channel assignments
are wrong, the problem should be apparent in the
MIDI Monitor window.

On the other hand, the Event List windows show all
the MIDI data being sent from Performer. If you’re
hearing something unusual in your sequence, the
first thing to do is to bring up the Event List
windows for the tracks in question. Go to the
points in the track at which you are hearing the
discrepancy and look for events that may
correspond to what you are hearing. Use the View
Filter if necessary to clearly isolate the events you
are interested in. If the problem is visible in the
event list, you can erase or edit the events in
question. If an audible problem does not
correspond to anything in the event list, its cause is
likely to be something external to Performer: the
Macintosh, interface, cables, instruments, or other
equipment.

If the Counter or Click move irregularly, or if
playback is erratic or seems to stall and skip: the
problem may be a “MIDI logjam”, in which the

Macintosh is asked to process too much MIDI
information too quickly. This is not a serious
problem if the actual playback timing is not
affected; Performer gives priority to sending and
receiving MIDI data over most screen redisplay.
However, with enough of an overload you may hear
delays or erratic timing in your music.

Usually the overload is caused by vast reams of
aftertouch (mono or poly key pressure), controller,
or pitch bend events in one or more synthesizer
tracks. Open Event List windows for the tracks in
question and look for large amounts of data of this
type.

To solve the problem, you must reduce the amount
of MIDI information being passed through the
modem and/or printer port in the following ways:

■ Slow down the tempo of the sequence during the
problem passages.

■ Delete a track or tracks from the sequence.

a Turn off the play-enable buttons for one or more
tracks. When you do this, Performer completely
ignores these tracks, letting it concentrate all of the
computer’s processing power on playing one part.
Do not use the Solo button instead; if you do,
Performer will scan the other parts while playing
and the problem will remain.

■ Use the View Filter and the Cut or Erase
commands to remove some data from one or more
of the tracks. See “Setting the View Filter” on
page 217 for help with this. Remember to set the
View Filter back to its default setting before going
on with your work.

■ Use the Thin Continuous Data command to
reduce the amount of continuous data in one or
more tracks. This command preserves the original
contour and basic effect of the controllers you are
editing, while thinning out unnecessary
information.
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■ Reassign some of the tracks to be output through
the other serial port. There is a limit on the amount
of information which can be passed through each
port individually; balancing your output through
both ports can eliminate the overload.

If Performer starts correctly, but you are unable to
record (or play) anything: double-check your
cable connections and synthesizer settings. Check
the MIDI interface dialog box, and be sure you
have chosen to receive data at the correct frequency
through the correct serial port (modem and/or
printer) on the back of the Macintosh. Often only
A/B tests will reveal the source of the problem. It
may be necessary to switch your MIDI cables, and
if possible, to try using a different MIDI interface
or synthesizer for input/output. The easiest way to
test if MIDI data is actually getting to Performer is
to open the MIDI Monitor window. Make sure that
any recording channel assignments in the Tracks
window and Input Filter correspond to the MIDI
channels set in the controlling keyboard or device.

If you cannot open a particular file: first try
opening other existing files, or a new file, to be sure
Performer is working at all. Refer also to the list of
disk and file errors in the chapter Working with
Files. If a file is opened and seems damaged, will
not let you save changes, etc., you still may be able
to save some or all of its musical information by
using the Clipboard to copy the tracks and paste
them into another file on another disk.

If Performer will not start up at all, or always
brings up an irregular or damaged file when the
Performer icon is opened from the Finder, your
working copy may be damaged. Make a fresh
working copy from one of your master disks. To be
thorough, make this new working copy by
dragging the Performer program icon from
another master disk (i.e. not from the key disk
from which the original working copy was made).
Restart the Macintosh and try opening another
(new or existing) file with your new working copy 

to see if you have the same problem. Check also to
see if other applications (Professional Composer,
MacWrite, MacPaint, etc.) are working properly.

If one of your key disks becomes damaged and
fails to work as a key, our Customer Support
Department will be glad to replace it. See
“Technical support” below for more information.

If you’re having problems synchronizing
Performer with other equipment: refer carefully to
the chapter called Receive Sync and the section
called Variations in MIDI Implementation in
Appendix A. Remember that Performer inputs and
outputs only MIDI, and that the MIDI beat clock
specification consists of only five different types of
messages. Try to deduce exactly which signal(s) are
not being sent or are being misinterpreted by
which piece(s) of equipment. The MIDI Monitor
window is helpful in determining if timing
information is being sent: the RT (real time)
indicator will highlight for the port(s) receiving
beat clocks or other timing data.

TECHNICAL SUPPORT
We are happy to provide customer support to our
registered users. If you haven’t already done so,
please take a moment to complete the registration
card in the front of the manual and send it in to us.
When we receive your card, you’ll be placed on our
mailing list and sent a free backup key disk.

Registered users who are unable, with their dealer’s
help, to solve problems they are encountering with
Performer may contact our technical support
department in one of the following ways:

■ Technical support phone: (617) 576-3066

■ Tech support fax: (617) 354-3068

■ Tech support email: techsupport@motu.com

■ Web site (for information and downloads):
http://www.motu.com
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■ AOL (America Online): keyword MOTU (for
downloads)

■ AOL tech support: MotUTec@aol.com

■ CompuServe: 71333,3666 or go motusupport

Technical support is staffed Monday through
Friday 9 AM to 8 PM, Eastern Time.

If you decide to contact technical support, please
have your Performer manual at hand, and be
prepared to provide the following information to
help us solve your problem as quickly as possible:

■ The serial number of the program. This is printed
on the cardboard page (at the front of the manual)
which holds the registration card. Be sure to retain
this page in the manual for your reference. You must
be able to supply this number to receive technical
support.

■ The version of Performer you are working with. This
is displayed briefly in the start-up screen when
Performer is started; it is also available through the
About Performer command on the Apple menu
from within Performer.

■ A brief explanation of the problem, including the
exact sequence of actions which cause it, and the
contents of any error messages which appear on the
screen. It is often very helpful to have brief written
notes to refer to.

■ The pages in the manual which refer to the parts of
the program which you are having trouble with.

■ The version or creation date of the system software
you are using to run the Macintosh (in the About This
Macintosh command in the Apple menu).

We’re not able to solve every problem immediately,
but a quick call to us may yield a suggestion for a
problem which you might otherwise spend hours
trying to track down.

Our technical support telephone line is dedicated
to helping registered users solve their problems
quickly. In the past, many people have also taken
the time to write to us with their comments,
criticism and suggestions for improved versions of
our software. We thank them; many of those ideas
have been addressed in this version of Performer. If
you have features or ideas you would like to see
implemented in our music software, we’d like to
hear from you. Please write to the Performer
Development Team, Mark of the Unicorn Inc.,
1280 Massachusetts Avenue, Cambridge, MA
02138.

Although we do not announce release dates and
features of new versions of our software in advance,
we will notify all registered users immediately by
mail as soon as new releases become available. If
you move from the address indicated on your
registration card, please send us a note with your
change of address so that we can keep you
informed of future upgrades and releases.
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tempo 337,340
Beats per minute 51
Beep

Macintosh 371
bpm 50
Break Phrases After____ Ticks option 78
Byte 451

A
About FreeMIDI Setup command 499
About Help 12
About Performer

Version number 530
About this Manual 10
Accelerando 339-340,393
Action menu (Search window) 358
Active sensing 380
Activity Meters 67
ADAT™ 409
Add

Chunks window 298,299
Defaults 422,424-425
Markers window 289,291
Master 422,424
Tracks window 72

Add MIDI Track 72
Add Sequence 298,299
Add Similar Tracks 73
Add Similar Tracks (Tracks window) 62
Add Song 298,299,308
Adding measures 222-223,336
Adjust durations 331,334
Akai DR4d™409
Alesis ADAT™ 409
Align controls 431
Always click option 369
Anchoring tempos 337,341
Apple Menu

About FreeMIDI Setup command
499

Apple menu 371,371,499
Arpeggiator effect 130
Articulation 244-245
Assign Target 433
Attach MIDI Controller command 118,

126
Attack times

Shift 225
Audible button in Step Record 101,108
Audible Mode

Event List window 139,149-150
Graphic Editing window 173
Scrubbing Movies with 376
scrubbing with 92
speaker icon 139,149,150,150
System Exclusive 150
Tracks window 60

Audio
adding an audio track 62

Audition Channels command 493,502
Auto button 50,126

in Mixing Board window 122
Auto Channelize 286
Auto Config button 481
Auto Punch-In/Out 431
Auto Punch-In/Out command 118
Auto Punch-Out Delay command 118,127
Auto Record Advance option 413
Auto Resize command 118
Auto Rewind button 40
Auto/Manual end time 47,297,298,
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302-303,313-314
Auto-fixup partial measures 336,478
Auto-locating 34
Automated mixing 124,125
Automatic tempo mode 337
Auto-Record 38,41,45,48-49

Bar 38,41,45,48,49
loading remembered times

212
Button 38,41,45,48-49
Tap Tempo 396

Auto-Rewind button 39,40,42,48-49
Auto-Scroll 90-91,141-142,190

Tracks window 79
Auto-Step button 101,107
Auto-Stop button 39,42,48-49
Auxiliary Counters 373
Auxiliary Time rulers 155,161-162

B
Background pattern 431
Backstep button 101,107,109
Backup copies of files 18,527
Backup Master disk 527
Backup master disk 7
Bank select 144
Base settings on current selection option

358
Basics menu

Click 369
value 320,331,333,369
volume 369,371

Click 8< Countoff Options 369
Click 8< Countoff options 371
Edit FreeMIDI Configuration com­

mand 477
FreeMIDI Sync 477
Input Filter 98

Patch Thru 286,287
System Exclusive 452

Interface Settings 477
MIDI interface

echo options with Patch Thru
287

Patch Thru 287
Panic 477
Patch Thru 285-287
Receive Sync 387-400
Remember Times 292
Slave to External Sync 389,391,392,

395,398
Step Record 98,101-113
System Reset 380
Transmit Sync 417-420

Beat button 101,109
Beat clocks 380,387,388-390

converted from SMPTE 388
start/stop clocks 387,389,420
transmitting 417-420

Beat division (in Groove Quantize) 278
Beat value 51

Counter window 56
meters 331

c
Cablization 459
Capture start time 402,467
Capture Window Set 383
Chaining

Chunks 38,47-48,305-314
sequences and songs 38,47-48,

305-314
Change Continuous Data 257
Change Duration 242-245
Change Key319-320,327-329

custom key signatures 328
Step Record 104

Change menu
Change Key 319-320,327-329
Change Meter 320-321,331-336
Change Tempo 321-322,337-345
Clear Loops 350-351
Set Loop 348-349

Change Meter 320-321,331-336,405
Adjust durations 331,334
denominator 331
meter maps 324,332
numerator 331
Only move barlines 331,334
partial measures 324
Realign music automatically 331,

333-334
Step Record 104

Change Tempo 321-322,337-345
Anchor indicators 337,341
beat value 337,340
Compute 338,344
curves 341-343
density 338,340
mid-beat 343
Options 338,344

Change Velocity 134,238-242
limiting velocities 239
Step Record 113

Channels 63
activity 379
playback 63,68,85-86,94
recording 97-98,98,285
Tap tempo 394

Character generators 463
Check Connections command 495,501
Chords 150

Inserting 170-171,189
Chunk

Control Buttons 38,47-48
Controls 38,47-48
loading 16-18,299-300
merging to sequence 17,307,312
naming 297,302
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overview 9
play-enabling 38,47-48,297,300-301
size in Song window 305
skipping 47,48
synchronization 313

Chunk select 427
Chunks window 297-303

Add 299
adding sequences & songs 298
Auto/Manual end time 47,297,298,

302-303,313-314
comments 297,302,456
copying 299

Tracks between Sequences 303
current playback Chunk 297,

300-301
Delete 298,300
Duplicate Track Layout 298,299
End time 297,298,300,302-303
loading Chunks 299-300
loading Chunks into 16-18
mini-menu 298
naming 297,302
Open Chunks 298,301
opening 298
play-enabling 38,47-48,297,300-301
printing 353
rearranging Chunks 301-302
selecting 299
Set Chunk Start 298
song select message 297,301
type icon 297,301-302,303

Clean Up Window command 489
Clear all devices command 380
Clear command 500
Clear default patch 63
Clear Keyboard button 247
Clear Loops 350-351
Clear MIDI Controller

command 118
Click 369-371

accented 369,370
value 320,331,333,369

Tap Tempo 393-394
volume 369,370-371

Click & Countoff Options
Accented click 370
gate 370
pitch 370
velocity 370

Clicks per frame (display) 52,322,340,478
Click-to-MIDI converter 401
Clipboard 219,223

Show/Hide Clipboard 223
Clippings 315-318
Close 22
Close All Edit Windows command 31
Close All Windows command 31
Close box 29
Close command 499
Close command (Windows menu) 31
Closed-loop (MIDI Machine Control) 411
Cntrl column in Tracks window 70

Co light 464
Color 29
Columns 306,307,307-308
Columns setup 62
Comments

Chunks window 297,302,456
Conductor Track 319
Tracks Window 62,70,456

Compute 338,344
Conductor Crawl Line 463
Conductor crawl line 466
Conductor Track 60,76,319-325

Copy Conductor Tracks 306,313
Delete Markers 307,312
Edit commands 322-323
Edit Conductor Track 306
Graphic Editing window 182-184
key changes 319-320
looping 324-325
Markers 322
meter changes 320-321

partial measures 324
meter maps 324,332
Record-enable Conductor 306,

311-312
recording 395
tempo changes 321-322
tempo maps 310-312,337,338-339
View Filter 335-336

Configuration menu

Edit Device command 501
Create Device command 501
Quick Setup command 481,501
Update Interfaces command 501

Consoles 429-449
deleting 431
loading from another file 448
opening 39

Consoles command (Windows menu) 31
Constrain to scale 268-269
Continuous data 253-254

Change Continuous Data 257
Create Continuous Data 255-256
icons 174,181
Reassign Continuous Data 258
Remapping in real time w/sliders

447-448
Ruler 174-175
scaling 179-180
setting initial values in tracks 89
Thin Continuous Data 254-255

Control Assignment 431
Control Panel 37-57,371

Auto-Record 38,41,45,48-49
Auto-Record Bar 38
Auto-Rewind 39,42,48-49
Auto-Stop button 39,42,48-49
Chunk Control Buttons 38,47-48
countoff 38,44-45
Current Beat 37
Current Meter 37
Current Tempo 37

Events List window button 38
Graphic Editing button 38
keypad controls 49
Main Counter Display 38
Memory Bar 39,42-43,48-49
Memory-shuttle 39,42-43,48-49
Notation Editing button 38
Overdub 41
Pause button 40
Play button 39-40
Position bar 39,41-42
Position bar arrows 39,41-42
Record button 41,45
Remote Controls for 49
Rewind button 40
Set Countoff 44-45
Set Loop button 38
Stop button 40,41
Tempo Slider 37
Tempo Slider Remote Control 37
Tracks Window button 38
Wait button 38

Controller chasing 89,90
Controllers

see Continuous Data
Controls window

Message Center 301
Remote Controls for 421,421,

422-423
Convert SMPTE window 463
Converters 387-388,397
Copy 220

Chunks in the Song window 309
text between Perf and other pro­

grams 219
Tracks between Sequences 303

Copy all tracks option 307
Copy command 486,500
Copy Conductor Tracks 306,313
Copy selection to new sequence 300
Copy to New Sequence

Tracks window 81
Copy to new sequence command 300
Counter 53-57

display 54
formats 53
screen update 56-57

Counter window 38-373
auxiliary 373
editing 34
frame time 34,54-55
Looping 347
measure time 33,54-55
real time 34,54-55
Set Chunk Start 54-55
Set Display 373

Countoft'44-45
beats 402
indefinite 45
While slaved to tape 399-400

Countoff button 38
Countoff n measures 370
Countoff only when recording 370
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Crawl line option 466
Create Continuous Data 135,255-256
Create Device command 484,501
Create Groove command 278
Create Group command 118,126
Crescendos 238,241
Cubase

grooves 281
Cue sheet 289,295
Cueing 39,41-42

Chunks 38,47-48,300-301,421,427
sequences 38,47-48,300-301,421,

427
songs 38,47-48,300-301,421,427
using the counter 53-54

Current Configuration 481,482
Curvature 240-241,341-343

editing in Graphic Editing window
178-180

Curves
Change Tempo 341 -343
Change Velocity 240-241
Create Continuous data 255
Graphic Editing window 178-180

Custom consoles 429-449
deleting 431

Custom Maps list 265
Custom Scale button 272
Custom transpose map 269-271
Customer support 7,529
Customizing

key signatures 328
New file 22-23
Remote Controls 422-424,425-426

Cut 309
Cut command 486,500
Cycle-recording 96
Cycle-recording (Memory-cycle) 42

D
Data sub-option 299-300
Decrescendos 238,241
Default patch 61,70
DeFlam 232,237-238
Delete

Chunks window 298,300
Markers 293,307,312
Markers window 289
Remote Controls window 422,424
Tracks window 63,73

Delete Board Layout command 118
Delete Group command 118,126
Delete Mix command 136
Denominator 331
Density Threshold 77
Device

Default Patch 61
group 86,87
Patch 69-70

Device column 86
Device Icons window 521
Device properties 497
Dialog boxes 31

Diatonic transposition 267-268
Digital Performer

exchanging files with 21
opening 1.6 and 1.71 files 16
Saving files in Version 1.6/1.7 format

19
Digital video (see Movie Window)
Diminuendo 238,241
Direct Echo 285
Direct Time Lock 460,460-461

view with MIDI Monitor 463-464
Direct time lock 380,388,391-393
Disks

errors 23-24
keeping enough free space 527
key disk 7
master disk 7
protecting 527
saving files to 18-21

Display Resolution 185,187, 193-194
DNA™ grooves 281
Does not play notes attribute 90
Dot boxes 101,104
DR4d™ (Akai) 409
Drop frame

29.97 391,392
Dropouts 463,468-469
Drum machine

loop recording as 351
Patch Thru 287
short note durations 244
transposing 271-272

DTL and DTLe 393
Duplicate 422

Track Layout 298,299
Duplicate command 486,500
Duplicate Mix command 136
Duplicate Take 69
Duplicate Tracks (Tracks window) 62,73
Duration 141,144,168,172

adjusting short durations 244
Change Duration 242-245
changing individual note 148
drum machines 244
editing

Notation Editing window
189-190

Scale Time 260-261
Step Record 101

Dynamic Phrase Parsing option 78

E
Echo

applying to your playing 287
creating echo effect 224-225

Song window 312
MIDI echo 285-287
synchronization 287,418-419

Echo effect 130
Edit Bar

looping 349,350
Edit commands

Clipboard 219,223

Edit Conductor Track 306
Event List window 147,208
Graphic Editing window 165
Markers 292
selecting region 165,171,207-212
Song window 217,306,309

Edit Conductor Track 306
Edit Device command 485,501
Edit FreeMIDI Configuration 477
Edit FreeMIDI Configuration command

88,483
Edit Group command 118,126

Rename Group sub-menu com­
mand 126

Edit menu 217-225
Copy 220,309
Copy command 500
Cut 220,309
Cut command 500
Duplicate command 500
Erase 221
Merge 222
Paste 220-221,224
Paste command 500
Perform New Search 359
Repeat 221-222

Conductor track 324-325
Event List window 147
versus looping 225,347

Search 357
Search Again 365
Select All 224
Select All command 500
Shift 223

attack times 225
Show/Hide Clipboard 223
Snip 222
Song window- 217,306,309
Splice 222
Undo command 500
Undo/Redo 219-220

Edit resolution box 154,160-161,165
Edit Window Sets command 383
Editing

Chunks 298-299,300,301-303,303
Counter 34,38
during playback 24,35,40,88,217,

227
Edit Conductor Track 306
Key change events 319-320
Markers 291,292,293,322
Meter change events 320-321
MIDI events 147-149,208
selecting 202
System Exclusive 145-146,148,

452-454
Tempo events 321 -322
tracks74,80,210,211,224,303

Effects window 127
and Patch Thru 287
applying effects 127
copying & pasting parameters 129
opening 128



opening existing 128
quick reference 128

Eject command 414
Emphasis 263

Humanize 237
quantizing 232
tempos 344
velocities 241

End time 307
Auto/Manual 47,302-303,313-314
Chunks window 297,298,300,

302-303
Enhanced Direct Time Lock 460,460-461
EQ 127
Erase 221

Song window 309
Error messages 23-24,527,529
Errors

disk 23-24,527,529
file 23-24,527,529
fonts 205
system 527,530

Escape key 423
Event

Chasing 89-90
Editing windows 74,139
information box 154,160

Event Chasing
audio tracks 137
importance for automated mixing

124
Event List window 8,139-151

Audible Mode 139,149-150
Conductor track 146-147,319
editing 147-149,208
Goto 140,143
Goto Counter 140,142-143
Graphic Editing window 143,153,

158
Insert 147-148
key changes 147
Legend 140,143
loops 147,349-350
Markers 146,292
meters 146
mini-menu 140
note events 143-144
opening from Tracks Window 74
patch change 144
printing 353
Reinsert 140,143
selecting a region 142,147
System Exclusive 145-146,454
tempo changes 147
View Filter 142

Events
Event List window 139,143-147
Graphic Editing window 153
Tap Tempo 394

Events List window button 38
Events may match any settings option 361
Events must match all settings option 361
Expand loops and print effects option 20

Exporting
search results as text 367

Extend releases to closest attack 243-244
External sync

Tap Tempo 401-402
External time code option 402
Extracting parts 247-248

Faders
recording 125
temporarily removing from group

126
Fast mode 459
Fast-forwarding 41 -42
Fewer Choices button 277
File

Help 11-12
icon 15

File menu
Close 22
Close command 499
FreeMIDI Preferences command

481
Load 16-18,299-300,425
New 15,22-23
New command 499
Open 15-16
Open command 499
Preferences 23,477

Pitch representation 478
Quit 23
Quit command 500
Revert command 499
Revert to Saved 21
Save 18
Save As 18-21
Save As ‘New’ Template 22-23
Save As Composer 21,312
Save command 499

Files 15-24
errors 23-24,527,529
loading

Chunks 16-18,299-300
Remote Controls 425

opening existing file 15-16
opening MIDI files 16
opening new file 15
opening Performer files 16
opening Performer Version 1 files 16
opening Professional Composer files

16
Revert to Saved 21
Save As 18-21
Save As ‘New’ Template 22-23
Save As Composer 21,312
Save As MIDI File 19-21
Save As Performer 2.41 21
saving files 18-21
saving sequences 18-21

Film/video
hit points 289,292,294,295
Markers 289-295

partial measures 324
Song window 313
synchronization 293-294,313,388,

390-393,397-399
tempo maps 313,338-339

Filters
Input Filter 98

Patch Thru 287
System Exclusive 452

Quick-Filter 160,174,176,176,180
View Filter 142,165,168,174,

335-336
Conductor Track 323-324
Markers 295
meter changes 335-336
MIDI controllers 218-219

Find (see Search command)
Fonts

installing in text menu 205
Frame advancing 464-465
Frame click metronome values 51
Frame time 33-34,54-55
Frame-click tempo display 52,322,340,

478
FreeMIDI

Configuration file 490,491,492
Configuration Window 483
Configuration window 482,483,489
current configuration 481
Devices

connecting 487
duplicating 486
editing 485
naming 486
removing 485
selecting 486

Devices file 523
Edit FreeMIDI Configuration com­

mand 477
FreeMIDI Syme command 477
how it provides playback devices 88
playback devices 68,85
Preferences 481
Remote control devices 421
seek points 289

FreeMIDI Setup
Device properties 411

FreeMIDI Sync 494
Freewheeling 468
Freeze-frame 465
FSK9,387,388-390

standard MIDI beat clocks 387,
388-390

G
Gain (in velocity compressor) 129
Gate

Click & Countoff Options 370
Generate VTP Streamers option 290
Goto

Event List window 140,143
Graphic Editing window 158
Tracks window 63
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Goto Counter
Event List window 140,142-143
Graphic Editing window 158
Tracks window 63

Goto Null Point 431
Grand staff

bracket 196
Graphic Editing window 153-184

Audible Mode 173
Auxiliary Time rulers 155,158,

161-162
Conductor Track 182-184
Continuous data

grid 173-181
icons 174,181
Ruler 173,174-175

editing 164-165
Event List window 158
example of 403
Goto 158
Goto Counter 158
Information bar 154,159-161

Edit resolution box 155,
160-161

Event information box 155,
160

Pointer coordinates box 154,
159-160

Insert button 154,158-159
Legend 158
Loops 166
Main ruler selector 155,162
Marker strip 155,165-167
Median strip 155,181-182

Conductor Track 183
Move handles 167,181

MIDI Edit 158,170-171,172,177
mini-menu 158
note events 155,168,169-173
Notegrid 155,167-173
opening from Tracks Window 74
opening from Tracks window 156
overview 8
Pitch ruler 156,163,169

listening to 169
selecting all notes of one pitch

171
Quick-Filter 160,174,176,176,180
Reinsert 158
scaling 179-180
scrubbing with the wiper 92
selecting events

Continuous Data grid 175-177
Note grid 165,171

Set Pointer Coordinates 158,159-160
Set Rulers 158,162
shift key 164
Time ruler 155,161-162,165
View Filter 165
viewing 156
zooming 162-163,169,175

Graphic Editing window button 38
Grayed menu items 13
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Grid
Chunk Grid 305
Continuous data 173-181
Graphic Editing window Note Grid

155,167-168
offset 230
Quantize 227,229-230
Step Record 110-112

Groove Editor 280
Groove Quantize 273-281

applying a groove 274
creating a groove 278
deleting,moving,duplicating 275
Groove folder 275
grooves defined 273
renaming a groove 275

Grouping
faders and knobs 125
temporarily overriding 126

Grouping Sliders 442-445
Grow box 30

H
Half solo mode 72
Handshake 456-457
Hardware requirements 7
Harmonic transposition 269
Harmonies

creating 268
Harmonizing 266
Help 11-13

cursor 11
File 11-12
loading file 12
Menu 12

Hexadecimal 451,452
Hide Balloons 13
Hide Clipboard 223
High-density track segment 77
Hit points 289,294,295
Hits

recording 464-465
Humanize 235-237

existing tempos 263
tempos 343-344

I
Icons 521
Ignore mistakes option 197
Indirect time lock 388,390-391,397-398
Information bar 154,159-161

Edit resolution box 154,160-161, 165
Event information box 154,160
Pointer coordinates box 154,

159-160
Input Filter 98

Input from MMC devices option 99
Patch Thru 286,287
System Exclusive 452

Input from MMC devices option 99
Input Quantize 234-235
Insert

Conductor Track 319-320,320-321,

321
Event List window 139,147-148
Insert button 306,307-308
inserting multiple events

Event List window 143,151
Graphic Editing window 178

Notation Editing 188-189
Song window 307-308

Insert button
Chunks window 306,307,312

Insert column 306,307,307-308
Inserting measures 222-223,336
Inserts 121

choosing an effect 128
opening the current effect 128

Instant 274
Instant Preview 274
Interface

echo options with Patch Thru 287
Interface Settings command 477,497,501
Interfaces

moving 490
naming 490

Interval transposition 267
Invert Pitch 258-259

K
Key changes 319-320,327-329

Conductor track 319-320,329
custom key signatures 328
editing 329
Event List window 147,329
Graphic Editing window 166,183,

329
Key disk 7

protecting 527
Key/scale transposing 269
Keyboard commands 32-33,422,423,

426-427
Keyboard controller 285,422-423,427

changing values from 149,172,177
Keyboard durations diagram 112
Keyboard parts, splitting into right/left

hand 245,249
Keypad 54

controls 112
Keypad controls 49

L
Last Window command 31
Lead line

enhancing 248-249
extracting 247-248

Legato 243-244
Legend

Events List window 140,143
Graphic Editing window 158

Level Meter Setup 62
Level meters 67

Mixing Board window 123
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Link sub-option 299-300
Linking 17-18,299-300

Link sub-option 299
Live performance

cueing Chunks 47-48,300-301,421,
427

linking Chunks 299-300
Load 299-300

Chunks 16-18
Consoles 448
Help file 12
Remote Controls 425

Load Board Layout command 118
Local control 146
Locate menu 60
Lock 289,290,293
Locking

Markers 289,293
locking

Markers 290
Loop Indicator 62
Loop recording (Memory-cycle) 42
Loops 347-351

Clear Loops 350-351
compared to Memory-cycle 347
Conductor Track 324-325
conflicting 348
editing

Event List window 349-350
Graphic Editing window 166

editing during playback 351
end time 347-349
Event Chasing 90
indicator 73,348
inserting 166-167,349
inserting during playback 351
meter changes 324-325
nested 348
recording (See Cycle-recording)
recording while looping 351
repetitions 347,349
Set Loop 348-349
start time 347-349
Tracks window 81
Tracks window indicators 67
versus Repeat 225
viewing

Event List window 349-350
Low-density track segment 77

M
MacDraw 203
Macintosh

color monitors 29
II7
Ilex 7
11x7
keyboard equivalents 49,422,423,

426-427
mouse 32
SE/307
user interface 29-33

Macintosh Keyboard Controls 49
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Macros 426-427
Manual button 50
Manual end time 47,297,298,302-303,

313-314
Manual tempo mode 337
Margins 198
Marker strip

Graphic Editing window 155,
165-167

Song window 306,312-313
Markers 289-295

Add 289,291
changing font in notation window

196
changing location 183,291,293-294
Conductor Track 183,293,322
creating in Tracks window 61
Delete Markers 307,312
Deleting 289,293
deleting in Tracks overview window

60
displaying in notation window 196
Event List window 146,292
Graphic Editing window 166,183,

292
hit points 289,294
locating with 291 -292
Lock 289,290,293
Marker well in Tracks window 61
Merge Markers 312
mini-menu 289-290
naming 289,291
Notation Editing window 292
opening Markers window 290
position indicator 289,291-292
printing 353
Record hits 290,294
selecting 292
setting Counter location 291-292
Shift locked markers 290,293-294
Song window 306,307,312-313
streamers 465
time display 289
Tracks window 60
Unlock 290,293

Markers window
Generate VTP Streamers 290

Markers window button 39
Master Control 421,422-423
Master disk 7
Master sliders 442-445
Matching sliders 443
Measure button 101,109
Measure numbers

display options 197
Measure range

Change Key 327,328
Change Meter 331,333
selecting 74-76,147

Measure spacing 197
Measure time 33

Events List window 140
Graphic Editing window 158,162

Median strip 155,181-182
Conductor Track 183

Melody
enhancing 248-249
extracting 247-248

Memory
Message Center 527
RAM 381
running out of 23,24,381
saving with the Link feature 299-300

Memory'Bar 39,42-43,48-49
loading Remembered Times 212

Memory' window 381
Memory-cycle

compared to loops 347
loop points 60
repeat barlines 43
selecting the region 44
setting end points 44,46
when applying a groove 274

Memory-shuttle 42-43,48-49
Memory-shuttle button 39
Merge 222
Merge Chunks to Sequence 17,307,312
Merge Markers 307,312
Merge Tracks with identical names option

307
Message Center 301

RAM available 527
Meter

display 51
Meter changes 320-321,331-336

Conductor Track 320-321
editing 335
Event List window 146,320-321,

334-335
Graphic Editing window 166,183
inserting measures 336
looping 324-325
partial measures 324
View Filter 335-336

Meter maps 324,332
Metronome 50-51

beat value 51
button 39
marking 196
slider 51,52-53

remote control 50-51
Metronome window

Automatic tempo mode 337
Click 369
Click value 320,331,333,369

Tap Tempo 393-394
Manual tempo mode 337

Mid-beat 343
MIDI

Activity’ meters 67
arpeggiator 130
beat clocks 380,387,388-390

converted from SMPTE 388
start/stop clocks 387,389,420
transmitting 417-420

channels 63,67
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activity 379
playback 63,68,85-86,94
recording 63,67,97-98
Tap tempo 394

controller
instruments 7

controllers 253-254
Audible Mode 150
controlling volume 241 -242
Event List window 145,145,

149,150-151
Input Filter 99
Tap tempo 394,396
View Filter 142,218

data stream 89
delay 528-529

Patch Thru 287
echo 285-287
echo options with Patch Thru 287
Edit 158,170-171,172,177
Effects plug-ins 249
events

Event List window 143-147
Graphic Editing window 160

interface 459-461
logjam 528-529
mapper 286
merger 286
Monitor window 379-380
rechannelizer 286
Song Position pointer 379,387,390
Song Select 297,301,427
System Reset 380
thru 285-287
Thru connections 488
Time Code 388,393
Time Piece 459-461
timing clocks 387,388-390

transmitting 417-420
transmission rate 254,528-529

MIDI Activity Meters 61
MIDI Configuration

window
button 39

MIDI Express
SMPTE sync with 392

MIDI files
opening 16

MIDI Machine Control
Auto Record Advance option 413

MIDI machine control 409-416
MIDI menu

Audition Channels command 502
Check Connections command 495,

501
Interface Settings command 497,501
MidiLocate command 494,502
Panic command 495,502
PatchThru command 493,502
Popup Patchlists command 492,502
Return command 501
Transport Controls 501
Transport Controls command 494

MIDI Monitor window 379-380,463,528
MIDI processing 127

arpeggiator 130
as region operations 249
echo 130
quantizer 129
time shift 130
transposer 129
velocity compressor 129

MIDI Sequencer
description 7

MIDI Time Code
transmitting from Performer 417
view with MIDI Monitor 463-464

MIDI Time Piece 406,459-461
SMPTE sync with 392

MIDILocate command 494
MidiLocate command 502
Min Time and Value Change command

119
Min Time and Value Range command 125
Min(imum) Time and Value Change 431
Mini-menu 30

Chunks window 298
Event List 140
Graphic Editing 158
Markers 289-290
MIDI Monitor 380
Mixing Board window 118
Notation Editing 186
Remote Controls window 422
Song window 306-307
Step Record window 102
Tracks 62-63

Mini-menus
Movie Window 376

Mix Mode
pop-up menu 116

Mix mode 135
Mixdowns (see Mix mode)
Mixing Board window 115-137

auto buttons 122
automated mixing 124,125
grouping faders and knobs 125
inserts 121
level meters 123
mute buttons 121
opening 119
pan knobs 122
quick reference 116
renaming board layouts 120
re-ordering tracks 119
saving custom layouts 120
showing/hiding sections 118,119
showing/hiding tracks 119
solo buttons 121
switching board layouts 120
switching sequences 120
track strip described 121
volume faders 123

Mode changes
Event List window 146
Graphic Editing window 182

Modem port 379
Modes

transposing 269
Module 285,286
Monitor Patch Changes FreeMIDI option

69
Mono key pressure 253
Mono mode 146
More Choices button 274
Mosaic 101

Edit FreeMIDI Configuration com­
mand 483

Mouse techniques 32,164-165,180
dragging in Song window 309-310

Move handle
Chunks window 297,301-302,303
Median strip 167,181
Track Window 62,67

Move releases to closest attack 243
Movie Window 375-377

controls 375
improving performance 377
mini-menu 376
opening & closing 375

Movie window
scrubbing with the slider 92

MTC417
MultiRecord 63,97-98

Tap Tempo 395
Multi-track audio recording 397-399
Muting

mute buttons in mixing board 121

/V
Naming

Chunks 297
Files 18-19
Markers 289,291
Song window 306
Tracks 59,69

New 15,22-23
New command 499
New device group command 86
New Mix command 136
New search command 358
New Take 69
Next Window command 31
No accent option 370
Notation (see QuickScribe notation win­

dow)
Notation Editing Window 185-190

inserting notes 188-189
Notation Editing window

overview 8
scrubbing with the wiper 92

Notation Editing window button 38
Note events

doubling 249
Event List window 143-144
Graphic Editing window 155,168,

169-173
mapping to single pitch 271
randomizing 235-237
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setting preference for the display of
477

Note grid
Graphic Editing window 155,

167-173
Step Record 110-112

Nudging
in the Graphic Editing window 172
in the Tracks Overview 79

Null points 443-444,445
Numerator 331
Numericals 33

o
Octave range

transposing 270-271
Octave Up/Down buttons 186,187-188
Odd Meters 405
Off velocities 239,247

Event List window 144
Graphic Editing window 168,175

Offset
grouped sliders 443
SMPTE

bit 55
Chunk start time 54-55,308,

391,392,398
converter start frame 390,

397-398
Offset grid option 230
Offset option (Step Record) 102
OK is first beat option 404
Omni mode 146
On velocities 239,247

Event List window 144
Graphic Editing window 168,175

One new track option 246
One track option 246
On-line Help 11-13
Only during countoff option 370
Only move barlines 334
Only when recording option 370
Opcode

Studio 5™ 400
Opcode Studio 5

syncing to SMPTE with 400
Open 15-16
Open Chunks 298,301
Open command 499
Open command (Windows menu) 30
Open Edit Windows command 63
Open-loop (MIDI Machine Control) 411
Options 338,344
Overdub 41

looping 351
Overdub record

button 38

P
Page numbers 204
Page size 198
Palette 199
Panic command 477,495,502

Panning 122
Partial measures 324
Partial solo mode 72
Parts per quarter note 33
Paste 220-221,224

Conductor track 322-323
Event List window 147
measure relative pasting 213,220
Smart Selections 213,220
Song window 309

Paste command 486,500
Patch change

Event List window 144
Patch chasing 89-90
Patch List

window 69-70
Patch list

printing 353
Patch Lists 69-70
Patch lists 492

published from Unisyn 475
Patch Thru 285-287

applying MIDI effects 128
Audition Channels setup 493
Auto Channelize 286
Direct Echo 285
Input Filter 286,287
MIDI delay 287
MIDI interfaces 287
MIDI merge 286
MultiRecord mode 286
Song Window 287
timing information 287

Patch Thru command 493
PatchList Manager 492,503

add Patch List command 511
bank select 516
create module command 520
creating a new patchlist 507
creating patchlists by hand 511
delete module command 520
device help command 508
editing a patchlist 513
grouping patchlists into a folder 514
importing patchlists 507
importing Performer/Digital Per­

former patch lists 507
loading patch names 508
multiple patchlists 516
overview 504
re-initializing 519
saving patchlists 518
set numbering format command 511

PatchThru command 502
Patterns

see Memory-cycle
see the Song window

Pause button 40
Perform New Search command 359
Performer

as master sync device 417-420
as MIDI merger 286
Cycle-record 97

Edit FreeMIDI Configuration com­
mand 483

files
opening 16

Hardware requirements 7
MIDI Time Piece 459-461
overview 7-10
user interface 29-35
Version 1 files

opening 16
version number 530

Phrase Detail option 78
Phrase Setup 63,77
phrases

playing 150
Piano parts

splitting into right/left hand 245,249
piano roll 7
Pick-up

beats 405
measure(s) 405

Pick-up measure(s) 56
Pitch

Click & Countoff Options 370
Pitch bend 253

determining value range 150-151
Event List window 144
Graphic Editing window 173,174,

174-175
Pitch representation 478
Pitch ruler 156,163,169

listening to 169
Play button 39-40
Play Selection command 88,150,208
Playback 68,85-91

channels 68,85-86,94
chasing during 89-90
Chunk 300-301
controller chasing 89-90
Event List window 149-150
features active during 40,88
locating with mouse 78,161
scrubbing 91
selecting a device 86
sequence 300-301
song 300-301,309
System Exclusive 451-452
track play assignment 86

Play-Enable button 60,68,71,85,85
Chunks window 297,300-301

Play-enabling chunks 38
player piano 7
Play-Select button 60,68,71,85

Chunks window 297,300-301
Plug-ins

MIDI effects 249
Pointer coordinates box 154,159-160

Set Pointer Coordinates 158,159-160
Polarity 443
Poly key pressure 254

Event List window 145
Popup Patchlists 492
Popup Patchlists command 493,502
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Preferences
Auto-fixup partial measures 336,478
pitch representation 478
Startup options 23

Preferences command 477
Preroll option 412
Preserve realtime performance option 223
Printer port 379
Printing 191-206,353-355

instrument parts 205
keyboard part 206
list windows 353
margins 198
page size 198
score 206
title page 195

Pro Tools
patching thru in Performer 287

Professional Composer 312
files

opening 16
opening files from 16
Saving As 21
separating keyboard part for

247-248,249
Properties 497
Punch-In

recording with sliders 440-441
Pushdown box 30

Q
Quantize 227-233

Attacks 228
Don't change duration option 228
Durations 228
for notation 193
freely played music 403
grid 227,229-230
Input 234-235
non-destructive (without changing

actual data) 129
Offset grid option 230
Releases 228
Sensitivity option 230-231
Strength 231-232
Swing 230
tuplets 229,229

Quantizer (MIDI effects processor) 129
Quick Setup command 481,501
Quick-Filter 160,174,176,176,180
QuickScribe notation window 191-206

date 204
displaying markers 196
inserting notes 199
margins 198
measure numbers 197
page numbers 204
page size 198
Score Options 195
scrubbing with the wiper 92
Text 203
Tool palette 199
track splitting 198

transcription explained 194
QuickScribe window

Ignore mistakes option 197
QuickTime video (see Movie Window)
Quit command 500
Quitting Performer 23

R
Radio buttons 31
RAM 381,527
Random Pitch Map 236-237
Randomize

quantizing 232
tempos 263,343-344
velocities 241

Ratio (in velocity compressor) 129
Real time 33-34

building a song 308
editing 24,35,40,88,217,227

Realign music automatically 333-334
Reassign Continuous Data 258
Receive Sync 387-400

MIDI Machine Control414
Recent Files pop-up menu 274
Record Beats 403-407
Record hits 290,294
Record while still framed 99
Record while still-framed 397,464,465
Record-enable Conductor 306,311-312
Recording 41,45,48-49,93-99

Auto-Record 38,41,45,48-49
Bar41,45,48-49
button 41,45,48-49
Tap Tempo 396

Chunk 300-301
Conductor Track 395
faders 125
hits 290,294,464-465
in a sequence 300-301,306,307,310
in a song 310
in external sync 99
Input Filter 98,286
memory allocation 527
MultiRecord 93-98,286

Tap Tempo 395
quantizing on input 234-235
real-time 93-98
Record channels 97-98,98
Record-Enable button 61-62,67,94
Set Record sequence 307,310
Sliders 440-441
step recording 98,101-113
System Exclusive 451-452,455-456
Tap tempo 395,396
Undoing 41
while looping 351

Recording on option (Step Record win­
dow) 101

Redo/Undo 219-220
Graphic Editing window 165
Song window 309

Refresh command 367
Region menu 227-251

Change Continuous Data 257
Change Duration 242-245
Change Velocity 238-242

limiting velocities 239
Create Continuous Data 255-256
DeFlam 232,237-238
Groove Quantize 274
Invert Pitch 258-259
MIDI Effects Plug-ins 249
Quantize 227-233
Reassign Continuous Data 258
Retrograde 259-260
Reverse Time 259-260
Scale Time 260-261
Split Notes 245-249
Thin Continuous Data 254-255
Transpose 227,265
windows that stay open 227

Region selection
Event List window 142
Graphic Editing window 165,171
Tracks window 210
using Markers 292
with the Tracks window 76,80-211

Registration
card 7,530
number 530

Rehearse mode 412
Reinsert

Event List window 140,143
Graphic Editing window 158

Releases
Extend Releases to Closest Attack

243-244
Move Releases to Closest Attack 243
Quantize 228

Remember Times 212,292
Remote Controls 421-427

Add Defaults 422,424-425
Add Master 422,424
Add... 422
cueing with 301,421,427
customizing 422-424
Cycle-record control 97
Delete 422,424
Duplicate 422
Enter Counter options 75
Loading 17,425
Macros 426-427
Master 421,422-423
Master Control Status icon 421
opening Remote Controls window

421
Play-enabling chunks 47
Play-enabling with 301,421,427
printing 353
Saving 422,425,425-426

Remote Master 421,422-423
Rename Mix command 136
Rename Take 69
Repaginate command 199
Repeat 221-222

Conductor track 324-325
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Event List window 147
versus looping 225,347

Repeat barlines 43
Resolution 33
Restoring

deleted Remote Controls 424-425
Retrograde 259-260

Event List window 147
Return command 501
Reverb 127
Reverse Time 259-260
Revert command 499
Revert to Saved 21
Rewinding 40,41-42,42-43,48-49

Markers 289,291-292
Ritard 393
Rt light 464
Rubato 393
Rulers 63
Running update option 373

s
Safe option in MMC window 412
Save 18
Save As 18-21
Save As ‘New’ Template 22-23
Save As command 499
Save As Composer 21,312
Save As MIDI File 19-21
Save As Performer 2.41 21
Save Board Layout command 118
Save command 499
Saving

files 18-21
Remote Controls setup 422,425
sequences 18-21
Transpose maps 266

Scale Tempo command 261-263
Scale Time 260-261
Scale/key transposing 269
Scaling

Sliders 443
Score Options 195
Screen updating 56-57
Scroll bar 29

Tracks window 71
Scrubbing 91

with Movie window slider 376
Seamless chaining 47,48,48,305-314
Search Again command 365
Search command 357-368

Search in all sequences option 359
Search Results window 366
Seek (Markers window) 289
Segments 77,80-211
Select All 224
Select All command 500
Select Notes 247
Selecting 202

all notes of a single pitch 171
Chunks 299,305,309
events

Continuous Data grid 175-177

Event List window 142
Notation Editing window 189,

202
Note grid 155,165,171

Markers 292
Notation window 202
Search command 357
Select subset of current selection op­

tion 360
Song window 212
Tracks 73,76,80,210-211

Selecting a region 207-212
all notes of a single pitch 171
Event List Window 142
Graphic Editing window 165,171
Markers 292
Song window 305,309
Tracks window 76,80-211

Selection Bar 60,292
Selection pop-up menu 60
Sensitivity 230-231
Separate tracks by pitch option 246
Sequence

creating a new sequence 64
-deleting 64
duplicating 64
renaming 64

Sequence controls 47-48
Sequence pop-up menu (in Tracks win­

dow) 60
Serial number 530
Set Chunk Start 54-55,313,373,391,392,

398,405
Chunks window 298

Set Console Name 430
Set Countoff 44-45
Set Display 57,373
Set Grid Spacing 431
Set Level Meter Range mini-menu com­

mand 123
Set Loop 348-349
Set Loop button 38
Set number of tracks command 413
Set Pointer Coordinates 158,159-160
Set Punch-Out Delay 431
Set Record sequence 307,310
Set Rulers 63,158,162
Set Source 431
Set Target 431
Shift 223

attack times 225
non-destructive (without changing

actual data) 130
Shift data to option 404
Shift locked markers 290,293-294
Shortcut commands 33
Show all input devices command 380
Show controllers only command 380
Show/Hide

Balloons 12
Clipboard 223

Skip buttons 38,47,48
Slave sliders 442-444

Slave to External Sync 389,391,392,398
Tap Tempo 401-402

Slave to external sync
Record Beats 406-407

Sliders 429-449
loading from another file 448

Smart Quantize 233-234
Smart Selections 212-215,220

helping with editing conductor track
324

helping with meter editing 335
how it affects pasting 213,220

SMPTE 33-34,388,397-399
29.97 drop & non-drop 391,392
bit offset 55
bits per frame 55
converter start frame 390,397-398
converters 387-388,397,459-460
Direct time lock 380,388,391-393,

460,460-461
Drop frame 391,392
Enhanced Direct time lock 460,

460-461
frame time display 33-34,57,158,

159,162
Indirect time lock 388,390-391
multi-track audio recording 397-399
offset 55,57
overview 9
Set Chunk Start 54-55,313,391,392
Slave to External Syme 391,392,398
sliding synchronized parts 398-399
standard MIDI beat clocks 388
start time 313
syncing with the Studio 5 400
tape striping 397

SMTPE
start time 415

Snapshot button 117,430
to set initial levels with 124

Snip 222
Event List window 147

Solo button
in Mixing Board 121
in Tracks window 60

Solo Playback option (Step Record) 102
Solo Setup 62
Soloing tracks 71-72,88

partial solo mode 72
Song Change 145,379
Song Position pointer 9,379,387,390
Song Select 297,301,427
Song window 305-314

Add Song 298,299
chasing 90
Chunk Grid 305
Chunk size 305
Columns 306,307,307-308
Copy all tracks option 307
Copy Conductor Tracks 306,313
creating a song 308-309
Delete Markers 293,307,312
dragging in 309-310
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echo effect with 312
Edit commands 306,309
Edit Conductor Track 306
End times 307,313-314
event chasing 90
Insert column 306,307,307-308
Markers 306,307,307,312-313
matching chunk times 313
Merge Chunks to Sequence 17,307,

312
Merge Markers 307,312
Merge Tracks with identical Names

307
mini-menu 306-307
name 306
names 305
opening 298,301,308
Patch Thru 287
playing a song 309
Record-enable Conductor 306,

311-312
recording into a sequence 306,307,

310
selecting 309
Set Record sequence 307,310
song description 299

Song window button 39
Sound Control Panel 370
Sound module 286
Speaker volume 370-371
Splice 222
Split Notes 245-249
Spot-erase 97,426
Staccato 245
Staff names

changing font in notation view 196
Staff system

bracket 196
spacing 196

Standard beat clocks 380,387,388-390
converted from SMPTE 388
start/ stop clocks 387,389,420
transmitting417-420

Standard MIDI beat clocks 9
Startup options 23
Step button 101,107
Step Duration buttons 101
Step Record 98,101-113

Audible button 101,108
Auto Step 101,107
Backstep button 101,107,109
Beat button 101,109
dot boxes 101,104
duration 101
keyboard diagram 112
manual stepping 107,113
Measure button 101,109
Mini-menu 102
Offset Option 102
remote controls 422
selecting durations 104-105,110-112
Solo Playback option 102
Step button 101,107

Step Duration buttons 101
Tick box 101
tick box 105
Transport Lock button 101
tupletbox 101,104-105

Stop button 40,42
Straighten Swing 196
Streamers 465
Strength 231-232
Striping SMPTE 397
Studio 5

syncing to SMPTE with 400
Studio 5™

Syncing to SMPTE with 400
SuperPaint 203
Sustain pedal 145

Tap Tempo 396
Swing Quantize 230
Synchronization

basic types 387-388
Chunks in Song window 313
Direct time lock 380,388,391 -393,

460,460-461
Enhanced Direct time lock 460,

460-461
FSK 387,388-390
Indirect time lock 388,390-391,

397-398
MIDI Monitor window 379-380
MIDI Time Piece 460,460-461
multi-track audio recording 397-399
overview 9
Record Beats 406-407
recording in external sync 99
Slave to External Sync 389,391,392,

395,398
SMPTE 34,388,397-399
Song window 313
Standard beat clocks 380,387

converted from SMPTE 388
start/ stop clocks 387,389,420
transmitting 417-420

Tap tempo slaved to tape 401-402
Tempo Slider 52-53
VITC 463-465

System
compatibility with Performer 369
troubleshooting 527

System common MIDI data 379
System errors 527,530
System Exclusive 451 -457

Audible Mode 150
editing

Event List window 145-146,
148,454

Graphic Editing window 182
sysex editing window 453-454

generating with slider 445-447
handshake 456-457
Input Filter 452
inserting in Event Editing windows

454
insertion mode 453,454

playback 451-452
recording 451 -452,455-456
replacement mode 453-454
viewing

Event List window 145-146
System real time MIDI data 380
System Reset 380

T
Takes 61,68

Duplicate Take command 69
New Take command 69
Rename Take command 69
while cycle recording 43

Tap first beat 405
Tap Tempo

slaved to tape 401-402
Tap tempo 388,393-397

channel 394
click value 393-394
Conductor Track 395,396-397
countoff 394
event 394
overview 9
recording 310-312,395
recording music 395
tap source 394
tempo maps 310-312,337,396

Target track 433
TDM 127
Technical support 7,529
Template files 22-23
Tempo

Anchor indicators 337,341
automatic mode 337
basics 51
Change Tempo 337-345
curves 341-343
density 338,340
display preferences 52,322,340,478
editing conductor track during play­

back 322
frame-dick display 52,322,340,478
humanize 263
in a Song 310-312
manual mode 337
maps 337,338-339,396
mid-beat 343
randomize 263
randomizing 343-344
recording 395
resolution 51,340
scaling 261-263
setting 51
synchronization 393-397

Tempo changes 321-322,337-345
Anchoring tempos 337,341
beat value 337,340
Change Tempo 321-322,337-345
display preferences 52,322,340,478
editing 345
Event List window 147,321-322
Graphic Editing window 183-184
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modifying during playback 322
recording into a song 310-312
resolution 51,340

Tempo Slider 37,51,52-53
Remote Control 37
remote control 50-51
resolution 51,340

Text 203
box

defined 203
copy between Perf and other pro­

grams 219
pasting into QuickScribe from other

programs 205
typing and editing 204

The 59
The Page Setup command 500
The Print command 500
Thin Continuous Data 254-255,528

MIDI logjam 254,528-529
Threshold (in velocity compressor) 129
Thru connections 488
Tick box 101,105
Ticks 33-34
Time

display 54
Event List window 140,141
formats 53
frame time33-34,54-55,140,141,

306
Graphic Editing window 155,

161-162
measure|beat|ticktime33,140,141,

306
real time 33-34,140,141,306
specification 33-34
step time 93,98,101-113

Time Ruler 60
Time ruler

Graphic Editing window 155,
161-162,165

locating playback 161
Song window 306,307
Tracks window 77

locating playback 78
Time Shift (MIDI effects processor) 130
Timecode bits 55
Timecode track option 414
Timing clocks 380,387,388-390

transmitting 417-420
Timing resolution

beats per minute 51,340
frames 55
ticks 33

Title page 195
Tool palette 199
Tracks

naming 61
splitting in notation window 198

Tracks Overview 59,77-84
controlling phrasing 77
scrubbing with the wiper 92

Tracks window 59-84

adding audio tracks 62
adding tracks 62,72
Audible Mode button 60
Auto-Scroll 79
blocks, controlling phrasing 77
comments 62,70
Conductor Track 60,319-325
Copy to New Sequence 81
Copy to new sequence 300
copying Tracks between Sequences

303
creating a new sequence 64
customizing 82
Default Patch 61
deleting 63,73
Device Patch 69-70
duplicating tracks 62,73
editing multiple tracks 224
ellipsis in play assignment 88
Goto 63
Goto Counter 63
hiding columns 65
Locate menu 60
Loop Indicator 62
loop indicator 73,348
Loops 81
Markers 60
Move handle 62,67
MultiRecord 63
naming 59,69
opening a Graphic Editing window

156
opening a new Tracks window 64,

298,301
opening an Event List window 140
opening in Song window 305
partial soloing 72
pasting 303
playback channels 63,85-86,94
playback devices 68
Play-Enable button 60,68,71
Play-Select button 60,68,71
printing track list 353
Record-Enable button 61-62,67,94,

97
recording channels 63,97-98,98
renaming a track 61
re-ordering columns 67
scrubbing with the wiper 92
selecting 73-76,80,210-211
selecting a region 74-76
Selection Bar 60
Selection pop-up menu 60
sequence pop-up menu 60
Set Rulers 63
soloing 71,88
switching sequences 63
Takes 61,68
Time Ruler 60,77
View Filter 81
Wiper 61
Zoom buttons 61

Tracks window button 38

Transcription 403
T ransmit Sync 417-420

echoing sync 418-419
generate sync 419
generating MIDI Time Code 417
generating standard beat clocks 418

Transport Controls 494
Transport Controls command 501
Transport Lock button 101
Transpose 265-272

key/scale transposing 269
Map 266-267
non-destructive (without changing

actual data) 129
saving maps 266

Transposer (MIDI effects processor) 129
Triplets

notating 194
Quantize 229,229
Step Record 104-105

Troubleshooting 527-530
checking MIDI input/output 495
disk errors 23-24,527,529
error messages 23-24,527,530
file errors 23-24,527,529
fonts 205
Help feature 11-13
MIDI Monitor window 379-380
system errors 527,530

Tune request 146,379
Tuplet box 101,104-105
Tuplets

notating 194
Quantize 229,229
Step Record 101,104-105

Type icon 297,301-302

u
Undo command 500
Undo/Redo 219-220,220,265

Graphic Editing window 165
Record 41
Song window 309

Unisyn 471-476
Edit FreeMIDI Configuration com­

mand 483
managing patches and banks with

471,473
sharing patch lists with Performer

475
Unlock 290,293
Unlocking markers 290,293
Update Interfaces command 489,501
Use all channels 493
Use default channel only option 493
User Interface 29-35
Utilities disk 11

V
Velocities

Change Velocity 238-242
Click & Countoff Options 370
compressing 129



limiting 239
Off Velocities 144,168,175,239,247
On Velocities 144,168, 175,239,247
randomizing 241

Velocity compressor (MIDI effects processor) 129
Version numbers

Performer 530
Vertical Interval time code 463-465
Video Time Piece 401,406,463-469

Generate VTP Streamers option 290
Video Window (See Movie Window)
View Filter 142,165,168, 174,217,218,224,528

Conductor Track 323-324
Markers 295
meter changes 335-336
MIDI controllers 218-219
Tracks window 81

View menu 496,502
V1TC 463-465
Volume

Click 370-371
creating volume changes 241-242
drawing audio volume curves 135
faders 123
generating volume curves 135
recording on-screen audio faders 135

VK
Wait button 38

indefinite countoff 45
WC Music Research, Inc. 281
Window menu 30
Window mini-menu 30

Window Sets 31,383
Windows 29-30
Windows menu

Capture Window Set 383
Close 31
Close All Edit Windows 31
Close All Windows 31
Consoles 31
Edit Window Sets 383
Last Window 31
Next Window 31
Open 30
Window Sets 31,383

Wiper
scrubbing with 92
Tracks window 61

Y
Yamaha

ProMix 01126

z
Zoom box 30
Zoom buttons

Tracks window 61
Zooming

Continuous Data Grid 175
Graphic Editing window 162-163
Pitch ruler 169
shortcuts 164,190
Time Ruler 162
Tracks window 79-80
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Cambridge, MA 02138

PHONE 617 576 2760

FAX 617 576 3609
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